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Overview of AFT Fathom
Welcome to AFT Fathom™ - a visual platform for modeling incompressible flow in pipe net-
works! See what's new in this version.

AFT Fathom brings increased productivity to the pipe flow engineer by combining traditional 
engineering hydraulic analysis with an intuitive graphical user interface. By implementing a drag-
and-drop method of pipe flow modeling, AFT Fathom simplifies the pipe network modeling pro-
cess.

AFT Fathom can show both input data and analysis results in visual form, allowing rapid analysis 
of a model's validity. Identifying poor assumptions, catching typographical or modeling errors, 
and re-running models are all accelerated because of AFT Fathom's graphical environment.

Whether your pipe system model will be used to evaluate and improve an existing system or to 
design a new one, AFT Fathom increases your productivity in the modeling process.

What Can AFT Fathom Do?

AFT Fathom can be used to model a wide variety of incompressible flow systems, including:

 l Open and closed (recirculating) systems
 l Network systems that branch or loop, with no limit on the number of loops
 l Pressure fed systems and gravity fed systems
 l Pumped systems, including multiple pumps in parallel or in series
 l Pumps with variable speed, controlled pressure, controlled flow, and viscosity corrections
 l Systems with pressure and/or flow control valves
 l Systems with valves closed and pumps turned off
 l Heat Transfer and system energy balance
 l Systems with variable density and viscosity
 l Multiple design cases in a single model file (Scenario Manager)
 l Non-Newtonian fluid behavior
 l Cost calculation of pump energy usage

AFT Fathom provides many standard loss models for pipe system components, but also allows 
you to enter your own loss data. Variable loss models that depend on flow are supported.

AFT Fathom's powerful solution engine is based on standard techniques used for many years in 
industry. The Newton-Raphson method is used to solve the fundamental equations of pipe flow 
that govern mass and momentum balance. Solutions are obtained by iteration, and matrix meth-
ods optimized for speed are employed to obtain convergence.
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Where to Start

The best place to start learning about AFT Fathom is to work through our example problems and 
video tutorials found in the Fathom Learning Resources.

Add-on Module Capabilities

AFT Fathom has several Add-on Modules that extend modeling capabilities. The modules can 
be used individually or together.

 l The Extended Time Simulation (XTS) module allows the engineer to model time varying 
system behavior.

 l Pump starting and stopping over time
 l Valve opening and closing over time
 l Tank liquid level changes automatically calculated

 l The Goal Seek & Control (GSC) module allows the engineer to perform multi-variable 
goal seeking and simulate control system functions.

 l The Settling Slurry (SSL) module allows the engineer to perform the complex property 
and system interaction calculations associated with settling slurry flows.

 l Modeling of homogeneous and pseudo-homogeneous slurry mixtures
 l Slurry pump performance de-rating

 l The Automated Network Sizing (ANS) module automates the process of sizing pipes and 
ducts in a complex network based on required conditions, such as maximum pressure or 
minimum flow, to reduce cost or weight.

Who Can Use AFT Fathom

AFT Fathom assumes that the user possesses a good general knowledge of engineering pipe 
system hydraulics. Even the most advanced and easy-to-use software package cannot make up 
for a lack of fundamental knowledge on the part of the user. The level of knowledge assumed by 
AFT Fathom is consistent with that obtained in a typical engineering undergraduate course in 
fluid mechanics.

Related Topics

FAQ - Frequently Asked Questions 48
Engineering Assumptions 21
Fathom Learning Resources 58
Startup Window 59
New in Version 13 21
New in Version 12 32
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New in Version 11 35
New in Version 10 40
New in Version 9 46

Engineering Assumptions
AFT Fathom is based on the following fundamental fluid mechanics assumptions:

 l Incompressible flow
 l Steady-state conditions (the XTS Module allows transient modeling through steady-state 

snapshots)
 l One-dimensional flow
 l System is fluid-full
 l Fluid properties are single phase
 l No chemical reactions

Related Topics

Overview of AFT Fathom 19
FAQ - Frequently Asked Questions 48
Fathom Learning Resources 58
Startup Window 59
New in Version 13 21
New in Version 12 32
New in Version 11 35
New in Version 10 40
New in Version 9 46

New in Version 13
View the links below for key updates from past versions:

New in Version 12, New in Version 11, New in Version 10, New in Version 9

Workspace Layers

The Workspace Layers feature provides a powerful new tool for customizing and viewing model 
appearance, input data, and results - all in one place. The Workspace Layers toolset significantly 
enhances the model building process, providing unparalleled customization options. You can 
easily update pipe/junction size, color, display text, visibility, and more from a centralized loc-
ation on the Quick Access Panel. Workspace Layers surpass the capabilities of the previous 
Visual Report feature. With Layer Settings, you now have easy control over Color Mapping and 
the visibility of both Input and Output parameters. Any change you make to these settings will 
have an immediate impact on the model’s display, providing real-time feedback. The dynamic 
combination of unique Layers offers an incredibly flexible framework, allowing you to display 
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precisely what you desire on the Workspace. You can easily toggle the visibility of individual lay-
ers on or off, and the state of all layers can be saved to a Layer Preset for future use.

Figure 1: Workspace Layers can display input and output values superimposed over the model, 
show Color Maps, and control visibility of objects

4-Component Slurry Model

A new 4-Component Slurry Model for the SSL module, developed by leading industry experts, 
captures complex slurry regimes more accurately. The 4-Component Model introduces a divi-
sion of slurry solids into four distinct groups, or components, based on the particle size dis-
tribution. Each component corresponds to a specific slurry behavior; Carrier Fluid, Pseudo-
homogeneous, Heterogeneous, or Fully Stratified. Unlike simpler models that account for only 
one or two slurry regimes, the 4-Component Model greatly enhances modeling flexibility by auto-
matically determining the effects contributed by each component regime. The model was 
developed by industry-leading experts and is respected for its accuracy in part because the indi-
vidual components are based on well established sub models. The 4-Component Model offers a 
comprehensive and advanced approach to slurry modeling, enabling more accurate and 
detailed analysis of slurry behavior in various particle size distributions.
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Figure 2: The 4-Component Slurry Model considers combined effects from four slurry regimes

Improved Valve Properties Window

The new Valve Properties window greatly enhances clarity and usability when it comes to mod-
eling valves. The window now clearly distinguishes between different data sources such as User 
Specified, Characteristic, or Handbook, making it easier to understand the available options. The 
form has been streamlined to focus on the most essential data, providing a clear understanding 
of what is required to define a valve accurately. Valve Characteristics, represented by an Open 
Percent vs. Flow Coefficient table, have been brought front and center. While using a Char-
acteristic is optional, it is highly recommended as it ensures that the valve behavior aligns with 
real-world scenarios, particularly for valve transients. The process of selecting a pre-defined 
Characteristic Source has been simplified, which helps obtain more accurate values in case man-
ufacturer data is unavailable.
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Figure 3: Redesigned Valve Properties window

Streamlined Design Alerts

The Design Alert Manager has been reorganized to improve the process of creating and apply-
ing user-defined alerts. Now, you can effortlessly create or edit a Design Alert with just a few 
clicks. As you modify settings, you will immediately see the criteria you are applying, ensuring a 
transparent experience. We have also reduced the amount of text on the form, while ensuring 
grammatical clarity. These improvements aim to make it easier to understand the limits being 
placed on the design.
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Figure 4: Steamlined Design Alerts Manager

Other Notable Features

 l Custom Junction Icons - Use your own images for junction icons.
Utilize any image as a junction icon, simply by right-clicking on the Toolbox icon for the 
junction, selecting Add Image, and browsing to the image file. This functionality enables 
you to use standard P&ID icons or custom images to visually represent your equipment. 
By using recognizable icons, you can improve the clarity and comprehension of model res-
ults, especially for those who may not be familiar with the default AFT junction icons.
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Figure 5: The Customize Icon window allows a custom image to be applied to any junction

 l Isometric Freeform Drawing Mode - Draw on the isometric grid without forcing any par-
ticular pipe routing.
The Isometric drawing tools have been enhanced by adding a new Isometric Freeform 
drawing mode. This new drawing mode allows you to snap junction and pipe anchors to 
the Isometric grid, while having the flexibility to draw pipes that do not necessarily align 
with the isometric gridlines. This allows you to easily draw complex systems where not all 
piping follows a Cartesian direction.

Figure 6: Isometric Freeform drawing mode does not force pipes to follow gridlines

 l New Annotations - There are new shapes and a line tool, along with a more advanced 
Annotation editing panel.
New Annotation shapes and a line tool have been introduced to allow more flexible 
markup such as revision numbers or change requests. Editing of Annotations has been 
revamped with the introduction of a live-edit Quick Access Panel, which provides 
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immediate visual feedback of the changes you make, and simple global editing of all 
selected Annotations. The new edit panel also offers expanded functionality, providing 
you with more customization than was possible in the past.

Figure 7: New Annotation options

 l Set Workspace Print Area - Show printing page borders on the Workspace and cus-
tomize the printing area.
The new Printer Page Layout tool offers a convenient and effortless way to adjust the 
printing area according to your preferences. With a clear and intuitive visual rep-
resentation, you can easily identify where page breaks will occur. Now, you can con-
fidently print a specific section or the entire model at your desired scale, eliminating the 
need for trial and error.
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Figure 8: The Printer Page Layout feature allows the user to set the Workspace print area

 l Customize Parameters Available to Graph from the Workspace - New User Options 
allow custom selection of any graph parameter on the right-click Workspace context 
menu.
Did you know you can easily graph results from the Workspace by right-clicking on a pipe 
or junction? This functionality has existed for a long time, but it was previously limited to a 
predefined set of parameters. Now, you can specify what graph types you would like to 
see in these menus to simplify your analysis process.

Figure 9: The right-click context menu for pipes on the Workspace can have the graphing parameter 
options modified
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Miscellaneous Improvements

 l Modeling Additions and Improvements
 l Laminar Corrections - Laminar corrections are now off by default, messages 

indicate if they were applied or are recommend, and output parameters indicate 
the correction strength.

 l Prevent Backflow at Sprays - New "No Inflow" Special Condition for Spray junc-
tions.

 l Zero-Length Connectors - Zero-Length Connectors now behave like standard 
pipes for most features, including selection and graphing tools.

 l Distinguish User and AFT Fluids - New category for user-defined fluids, making 
it easier to find custom entries.

 l Importing of PCF, EPANET, GIS, and CAESAR II Models
 l Bend r/D - Import PCF bends with appropriate r/D values.
 l Speed Increase - Importing is up to 10x faster in some cases.
 l Defaults and Display - Better defaults and display options for imported models.
 l Pipe Materials - Improved ability to link AFT pipe materials to imported pipes.
 l CAESAR II Node Names - Display imported CAESAR II node names as junction 

names.
 l Behind the Scenes Improvements

 l Graphing Optimization - Significant improvements to backend graphing code 
which provides additional stability now and more capabilities in the future.

 l eLicense Access Improvements - Added a "heartbeat" functionality to eLi-
censes which improves security and the release of license seats not in use.

 l Output - Significant improvements to backend output code which provides addi-
tional stability now and more capabilities in the future.

 l Timed Recovery File - Automatically generate a backup of your unsaved model 
that can be used to recover unsaved work in the event of unexpected application 
closure. This is separate from the *.bak files which are only generated after saving 
a model.

 l New and Improved Output Parameters and Messages
 l Pump RPM - Report pump speed in RPM, in addition to percent.
 l Dimensionless Heat Transfer Parameters - Grashof, Nusselt, Prandtl, and 

Rayleigh Numbers have been added as Output parameters.
 l Deep Laminar Caution - Simple loss models do not account for exceptionally low 

laminar flow, this new message provides a caution if you enter this range.
 l POR/AOR in Pump Summary - Show the values for Preferred and Allowed 

Operating Ranges in the Pump Summary.
 l Event Messages in New Format - Events are now shown in a cleaner, col-

lapsible format similar to Warnings.
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 l XTS Module Tank Overflow and Drain Warnings - New messages to clearly 
indicate if a Tank has overflowed or drained during the transient.

Related Topics

Overview of AFT Fathom 19
FAQ - Frequently Asked Questions 48
Engineering Assumptions 21
Fathom Learning Resources 58
Startup Window 59
New in Version 12 32
New in Version 11 35
New in Version 10 40
New in Version 9 46

Interface Improvements for Fathom 12
There were many improvements made to the interface in Fathom 12. These changes primarily 
involve consolidating inputs with the new Analysis Setup window, and updating the functionality 
of databases, which have been renamed as libraries.

Analysis Setup Sources in Fathom 11

 l System Properties: The System Properties window has been split up into the Fluid 
Properties group and the Environmental Properties group. The System Properties 
icon is still available from the Analysis menu and toolbar to directly open the Fluid Prop-
erties panel. 

 l Solution Control: The Solution Control parameters have primarily moved to the Steady 
Solution Control group. The Special Controls have moved to the Advanced Para-
meters panel under the Miscellaneous group

 l Checklist: The checklist which was shown in the Quick Access Panel has been replaced 
by the status icons in the Analysis Setup window. Red exclamation marks denote which 
inputs are incomplete

 l List Undefined Objects: The undefined objects list has been moved to the Pipes and 
Junctions group. The undefined objects list can also still be viewed next to the Work-
space by opening it from the View menu.

 l Cost Settings: Cost calculations were previously enabled from the Analysis menu and 
defined in the Cost Settings window. Enabling and defining cost settings has now been 
moved to the Cost Settings group

 l NFPA Configuration: Enabling NFPA reports has moved from User Options to the 
NFPA panel under the Miscellaneous group. In addition selecting an NFPA group has 
moved from the Tools menu to the NFPA panel.

 l Extended Options: Enabling loss model options such as equivalent length that was pre-
viously in the Extended Options window has been moved to the Junction Loss Models 
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panel under the Miscellaneous group
 l Add-on Modules Activation: The activation window for add-on modules has moved to 

the Modules panel
 l Goal Seek & Control Manager (GSC Module Only): Settings have been moved to the 

Goal Seek and Control group
 l Transient Control (XTS Module Only): Settings have been moved to the Transient Con-

trol group
 l Slurry Data (SSL Module Only): Settings have been moved to the Fluid Properties 

group
 l Sizing Summary (ANS Module Only): The Sizing Summary has been added to the Siz-

ing Summary panel in Analysis Setup. The Sizing Summary can also still be viewed 
from the Sizing window. No other ANS module interface changes have been made.

Database Improvements

 l Databases have been renamed as libraries throughout the interface to better reflect their 
functionality

 l Connecting, creating, and transferring content between libraries can all be done from the 
Library Browser, rather than switching between tabs in the Database Manager to do this

 l Viewing the contents of libraries can also be done directly in the Library Browser, rather than 
opening a separate Browse Database Content window

 l Windows to edit and add components to libraries can all be accessed directly from the 
Library Manager rather than having to navigate solely through the Library menu
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New in Version 12

Analysis Setup

Analysis Setup window consolidates windows for System Properties, Solution Control, Activate 
Modules, Extended Options, Goal Seek & Control Manager, and Transient Control all into one 
location. This allows users to activate and enable modules, specify fluids, select a viscosity 
model, enable heat transfer, change solution tolerances or iterations, and so on, all from a single 
window. For a list of windows that have merged into the Analysis Setup window see the topic on 
Interface Improvements for Fathom 12.

Libraries

The database feature interface was completely overhauled to improve workability. The new sys-
tem is called the Library Manager and significantly improves the ease and workability for users to 
browse and connect input information, now called libraries, into their model. For a list of dif-
ferences between the Database and Libraries interfaces see Interface Improvements for Fathom 
12.
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Multi-Scenario Graphing

Profile graphs (and Transient Graphs in the XTS module) can now include output from multiple 
scenarios, making it easy to compare the results along a flow path for different scenarios. See 
the Creating Multi-scenario Graphs tutorial.

Improved Organization of the Warnings in the Output

An improved display of the warnings and design alerts makes it easier to review and understand 
information in the following ways:
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 l Critical Warnings, Warnings and Cautions are color-coded and grouped by type  in col-
lapsible sections

 l Design Alerts are now shown on a separate tab in the General Section
 l Double-clicking messages will take user to the related pipe/junction in the Workspace
 l Warnings, Cautions and Design Alerts are now displayed for all scenarios when using the 

Multi-scenario Output feature

Miscellaneous Improvements

 l Pipes/Junctions
 l Pipes can be defined as zero-length connectors to connect two junctions which are 

directly flanged together
 l Submerged pump can now be defined using surface pressure and pump depth
 l New Pump As Turbine (PAT) option on the Pump Properties window
 l Valve transients in the XTS module can be defined as open percent vs time

 l Workspace and Interface
 l Pipes and Junctions can be set the Same as Parent directly from the Workspace
 l Custom Unit names can be defined in the Unit System section of the User Options 

window
 l Pipe/Junction notes can be searched in Select Special
 l Special Conditions can be directly changed from the toolbar for junctions that have 

multiple special condition options
 l Output and Reporting

 l Show the number of warnings and design alerts in the batch run window
 l Heat Transfer output parameters added to Visual Report

 l Miscellaneous

 l Herschel-Bulkley non-Newtonian viscosity model added for representing Power 
Law fluids which have an apparent yield stress

 l List Junctions that have Special Conditions change in Solution Progress Window
 l Silent Batch runs can be enabled to prevent notifications from appearing over 

other active windows

- 34 -



Overview of AFT Fathom
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New in Version 11

Scenario Comparison Tool

 l Quickly get a comparison of different scenarios within a model file
 l Useful to double-check input results for old models, or for troubleshooting purposes
 l For a detailed description, see Scenario Comparison Tool Overview

Multi-scenario Pump vs. System Curves

 l Pump vs System curves from different scenarios can be plotted on the same graph within 
AFT Fathom

 l Easily compare changes to pump operation in different cases
 l For more information see Multi-Scenario Pump vs. System Curves Tutorial
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Junction- specific Parameters in Visual Report

 l Output such as the percent of BEP for a pump or the Cv of a control valve can now be dis-
played in the Visual Report
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Notes in Output

 l Notes can be added to any cells in the Output to save observations and comments dir-
ectly with the model file

New Workspace Functionality

 l Multi-level Undo - Drawing, arranging and moving objects in the Workspace now allows 
for multiple levels of undo

 l Workspace Magnifier - The magnifier tool provides an enlarged view of sections of the 
model to make it easier to manage and navigate large models
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 l Automatic Junction Rotation - Fathom will automatically rotate junctions to visually 
align with neighboring pipes to speed-up model formatting

 l Combine Pipes - a series of pipes and junctions can be combined to simplify a model, 
with any losses being imported to the Pipe Fittings and Losses tab, and any elevations 
being imported as Intermediate Pipe Elevations

 l Split Pipes by Intermediate Elevations - Pipes with intermediate elevations can be split 
with branches at intermediate elevation points (see Joining and Splitting Pipes)

 l Select Shortest Flow Path - The shortest path between two selected junctions can be 
found using this feature in the Edit menu

Diagnostics Window

 l Provides a list of features and settings which might cause issues as a starting point for 
model troubleshooting

 l See the Diagnostics Window topic for more information

More Improvements

 l Overall Performance
 l Improved intelligence on when a model needs to be saved and re-run to preserve 

the output
 l Faster model loading speed
 l Improved language refresh speed
 l New and updated themes

 l Workspace
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 l The Undefined Objects panel remains open when pipes/junctions are being edited
 l Double-clicking a junction allows more than one of that junction to be placed in the 

Workspace at a time
 l Snapping can be turned off for pipes when the isometric drawing mode is enabled

 l Output
 l Output parameters can now be filtered/searched for simpler selection
 l The average thermal conductivity used for calculations can be displayed in the Out-

put
 l Visual Report

 l Visual Report Control has been redesigned to better filter parameters
 l Pipes

 l Heat tracing now allows the entry of power/length and number of turns to allow 
Fathom to calculate the heat flux directly

 l Junctions
 l Updated Tee/Wye Properties window which clarifies the input and automatically 

defines the pipe arrangement according to the direction and orientation on the 
Workspace

 l Built-in K values are now included for bends with r/D between 0.5 and 1
 l Notes can be globally edited for junctions

 l Design Alerts
 l Design Alerts can be saved to and loaded from a file to quickly apply common 

Design Alerts to multiple models
 l Ability to import custom Fittings & Losses from a file

Related Topics

Overview of AFT Fathom 19
FAQ - Frequently Asked Questions 48
Engineering Assumptions 21
Fathom Learning Resources 58
Startup Window 59
New in Version 13 21
New in Version 12 32
New in Version 10 40
New in Version 9 46
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New in Version 10

New & Improved Microsoft Excel Integration

 l Improved keyword based method for importing model changes from an Excel Worksheet
 l Use the included template Worksheet to quickly and easily define model changes
 l Change multiple scenarios at once
 l For a detailed description see Importing From Excel

 l New feature for directly exporting specified Output data to new or existing Excel Work-
books.

 l Export only the data that is desired - no need to sort through unnecessary data
 l Specify exactly where the data will end up - insert data into a pre-formatted Work-

book
 l Automatically export after a model run
 l Export data from multiple scenarios with a batch run
 l For a detailed description see Exporting To Excel

New Isometric Drawing Mode

 l New Isometric Pipe Drawing Mode
 l Show and Snap to an isometric grid on the Workspace
 l View models in an intuitive 3D layout, and easily build from existing isometric draw-

ings
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NIST REFPROP Fluid Database Now Included

 l Over 150 fluids from the National Institute of Standards and Technology (NIST) Refer-
ence Fluid Thermodynamic and Transport Properties Database (REFPROP) Version 10

 l Select a NIST REFPROP fluid directly on the Fluid panel in Analysis Setup
 l Use accurate and complete fluid information in your models without the need to loc-

ate and enter fluid properties manually

New Pump Features and Improved Pump Window

 l New Interstage Bleed Pump Model
 l No need to manually calculate pump curves - enter pump curves directly from a 

pump's datasheet
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 l New Positive Displacement Pump Model
 l Clarifies the specification of Positive Displacement Pumps
 l Include Acceleration Head Loss calculations

 l Added Pump Curve and Sizing Analysis Types to Centrifugal Pump Model
 l Clarifies required data and model intention
 l For a detailed description see Pump Properties Window

 l Specify a centrifugal pump's Preferred Operating Region (POR) and Allowable Operating 
Region (AOR)

 l Quickly determine if a pump's behavior is acceptable
 l Automatically calculate a POR from ANSI/HI 9.6.3-2017 - Rotodynamic Pumps - 

Guideline For Operating Regions
 l For a detailed description see Pump Configuration > Configuration Data

New Thermal Models

 l Two new Heat Transfer Models for Pipes
 l Convective Heat Transfer With Heat Tracing - model the addition of heat between 

a pipe wall and an insulation layer
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 l Buried Pipe - model the thermal effects of burying a pipe
 l Calculate a Forced Convection Coefficient from ambient fluid velocity and temperature 

with the Churchill-Bernstein correlation

New Multi-Condition Events for XTS Module

 l Create complex triggers for transient events in the eXtended Time Simulation (XTS) Mod-
ule

 l Only start a transient event when multiple conditions are met
 l Utilize logical conditions - AND, OR, and NOT - to capture the effects of complex 

control systems
 l For a detailed description see Multi-Condition Events

Improved Startup Window

 l Improvements to the capability and usability of the Startup Window
 l Set modeling preferences including - active modules, working fluid, units, lan-

guage, 2D or Isometric drawing mode, default pipe material, and NFPA settings

- 43 -



Overview of AFT Fathom

 l Displayed units can now be easily refined by selecting Common Units and 
Industry-Specific Units

New Integration with Common Piping Layout formats

 l Save modeling time by importing existing Piping Layouts from various neutral file types
 l Import CAESAR II Neutal Files (.cii)
 l Import Piping Component Files (.pcf)
 l Import and Export EPANET Files (.inp)
 l These common file formats are generated from many common engineering pro-

grams such as AutoCAD Plant 3D, SmartPlant, PDS, CadWorx, and many more.

Updated Standards

 l Output displays Applied Standards - standards that were used in calculation of model res-
ults

 l Relief Valve loss can be specified with Designation Size per API 526 - Flanged Steel Pres-
sure Relief Valves

 l Updates to Standards
 l Updated to HI/ANSI 12.1-12.6-2016 Rotodynamic (Centrifugal) Slurry Pumps for 

Nomenclature, Definitions, Applications, and Operation for use in Slurry De-rating
 l Updated to HI/ANSI 9.6.7-2015 Rotodynamic Pumps - Guideline for Effects of 

Liquid Viscosity on Performance for use in Viscosity Corrections
 l Updated MIT Equation for Crude Oil to latest version specified in Pipeline Rules of 

Thumb for use as an additional pressure loss model

More Improvements

 l General
 l Many new default Pipe Materials
 l Intermediate pipe elevations can now be entered as Length Along Pipe
 l Control Valve setting for Always Control (Never Fail) can be set to a default to off
 l Increased the loading speed for large models
 l Applying Design Alerts when using the XTS module now shows Design Alert Viola-

tions in transient Output tables, and all time steps that violate the Design Alert are 
highlighted

 l Workspace
 l The Workspace background color can be changed based on the level of the cur-

rent scenario - additional levels have been added
 l Annotation background opacity can be changed
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 l New keyboard shortcuts to zoom (CTRL + +/-) and pan (CTRL + arrow keys) the 
Workspace 

 l Full Scenario Path Name can be copied to clipboard by right-clicking a scenario
 l Selection box visually indicates the behavior of the selection - select everything 

intersecting (right to left) or only objects completely inside (left to right)
 l Pipes with Fittings & Losses defined now display a special character next to their 

number (default of &)
 l Output

 l Design Alerts can be created directly from the Output by right-clicking on a result - 
immediately select the appropriate object and parameter.

 l Model Data
 l Quickly locate a specific object on the Workspace by right-clicking the item in 

Model Data
 l Added additional parameters such as insulation thickness

 l Visual Report 
 l Reworked Display Option controls for Pipes and Junctions in Visual Report Control

Related Topics
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Overview of AFT Fathom 19
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New in Version 9 46

New in Version 9

General Interface

 l Improved tab interface and enhanced Quick Access Panel functionality
 l Improved search includes pipe and junction notes, names and numbers
 l Output reports in German and Chinese languages
 l Files are automatically locked when opened to prevent multiple users from accidentally 

opening the same file
 l Global edit select all items within a section

Graph Results

 l Multiple Graphs Sets can be added to Graph Groups for easy generation and display
 l Multiple graph tabs on main Graph tab
 l Multiple graphs tiled on same Graph Group tab
 l Easy formatting of titles, axis  labels, and plot lines 
 l Plot series lines can be turned on/off for quick inspection
 l Graph controls now located on the Quick Access Panel for easy graph definition and 

changes
 l Junction location shown on profile plots
 l Annotations can be placed on graphs

Scenario Manager

 l Scenario manager shows which scenarios have output
 l Ability to create child scenarios without results saving duplication and load time
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Workspace

 l Scenario manager shows which scenarios have output
 l Ability to create child scenarios without results saving duplication and load time

Output

 l Results Diagrams which graphically show data for pipe heat transfer, pumps and heat 
exchangers

 l Default colors for multi-scenario output.
 l Support for NFPA output reporting

Visual Report

 l Automatic Color Map generation

Pipes

 l Design Alerts are specified and named globally and applied to pipes
 l New Design Alerts available

Junctions

 l Improved Relief Valve specification
 l Improved clarity for data entry in the Reservoir/Tank Property window
 l Submerged pumps
 l When the speed is set for a pump, both the original and modified pump curves are shown 

on the Pump Property window
 l New Weir junction
 l Design Alerts can be applied to junctions

Solver

 l 3-K method for laminar flow through fittings
 l Equivalent Length option available for pipes, valves and bends
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Modules

 l GSC
 l Pipes now have GSC variables available such as roughness, design factor, insu-

lation thickness, Reynolds number
 l New and improved searching method for multi-variable goal seeking – useful for 

model calibration
 l Variables and goals can be reordered
 l New goals and variables added

Related Topics

Overview of AFT Fathom 19
FAQ - Frequently Asked Questions 48
Engineering Assumptions 21
Fathom Learning Resources 58
Startup Window 59
New in Version 13 21
New in Version 12 32
New in Version 11 35
New in Version 10 40

Related Blogs

Using Equivalent Lengths in AFT Fathom

FAQ - Frequently Asked Questions
 l How has AFT Fathom been verified?
 l Can AFT Fathom be used to model gas systems?
 l Can AFT Fathom model two-phase flow?
 l How does AFT Fathom account for heat transfer in pipe systems?
 l Does AFT Fathom perform an energy balance across each junction in the model?
 l Does AFT Fathom model transient system behavior?
 l Can I model a non-Newtonian fluid in AFT Fathom?
 l Can AFT Fathom model fire sprinkler systems?
 l Can AFT Fathom model ducting system like those in HVAC, ventilation and dust col-

lection systems?
 l Can I keep all of my design cases together in a single file?
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 l What is the difference between using a junction to input pressure loss data and the fittings 
& losses in pipes?

 l What is the difference between a Reservoir junction and an Assigned Pressure junction?
 l How does AFT Fathom account for pressure losses at tees and wyes?
 l How do I size a pump when there are not any flow control valves?
 l How do I size a pump when there are flow control valves?
 l How do I model a variable speed pump?
 l How do I find the pump speed to obtain a desired flow or pressure?
 l How do I close a valve, pump or pipe?
 l How do I model the pressure drop across a component when there is only one data point?
 l How do I model a relief valve in a system?
 l How do I show the pipe or junction names on the Workspace?
 l How do I change the display of pipe or junction names on the Workspace after the model 

has been built?
 l How do I set my preferred engineering units as defaults?
 l How do I change the input data for multiple pipes or junctions all at one time?
 l How do I create a liquid mixture?
 l How do I merge two models together?
 l How do I automatically run multiple scenarios or models right after each other?
 l How do I enable or disable the Highlight feature in the Pipe and Junction Properties Win-

dows?
 l How do I automatically save my results after the model is run?
 l How do I quickly find a particular pipe or junction on the Workspace?
 l How do I change the reference positive flow direction for one or more pipes?
 l How do I access pipe and junction Properties Windows from the Model Data window?
 l How do I display only selected pipes or junctions in the output?
 l How do I quickly change the units for an output parameter?
 l How do I model elevation changes in my pipe system?
 l How do I show data for only selected pipes or junctions in Workspace Layers?
 l How do I make the Pipe Drawing Tool stay active so that I can continue to draw pipes 

without having to click it each time?
 l How do I add graphical segments to a pipe so it is not constrained to a single straight line?
 l How do I set up custom libraries on my local PC?
 l How do I set up custom libraries on our local or wide area network?
 l How do I change the icon for a junction in AFT Fathom?
 l Can I customize the junction icons in AFT Fathom?
 l What is the limit to the size of model I can create with AFT Fathom?
 l Can AFT Fathom model reacting flows?
 l Can I install AFT Fathom onto a local or wide area network?
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 l Where can I find pipe material reference information?
 l What kind of transients can Fathom XTS model?

How has AFT Fathom Been Verified?

There are several aspects to AFT Fathom verification.

First, AFT Fathom has been compared to a wide variety of published results. Models, com-
parisons, and explanations for such published predictions are given in the Verification section of 
this site and the Verification folder installed with AFT Fathom.

Second, it can be verified that the AFT Fathom predictions agree with the fundamental equations 
for networks. See the Network Solution Methodology topic.

Finally, AFT Fathom predictions have been compared to test data and other analytical methods 
on numerous occasions and good agreement has been shown.

Can AFT Fathom Be Used to Model Gas Systems?

Yes, depending on the gas system (see Walters, 2000). For incompressible gas systems, AFT 
Fathom is perfectly appropriate. For compressible flow gas systems, a more sophisticated tool 
such as AFT Arrow should be considered.

Can AFT Fathom Model Two-Phase Flow?

No, AFT Fathom only models single phase flow and assumes all pipes are liquid full.

How Does AFT Fathom Account for Heat Transfer in Pipe Systems?

Heat transfer effects show up in several places in AFT Fathom. First, for pipes users can input 
pipe and insulation data thermal conductivity data and thickness, as well as external convection 
coefficients. The thermal conductivity data can be constant or temperature dependent. These 
heat transfer calculations and the associated physical properties are determined for each pipe. 
Second, heat transfer can occur in Heat Exchanger junctions. Here the user assigns a heat load 
or chooses a heat transfer model for the heat exchanger. AFT Fathom performs the appropriate 
energy balance calculation across the heat exchanger. Third, heat transfer occurs in pumps due 
to inefficiencies.

Finally, at each branching location in the network an energy balance is performed so that energy 
is balanced from one pipe to the next.
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Does AFT Fathom Perform an Energy Balance Across Each Junction in 
the Model?

Yes, every junction except for heat exchanger and pumps is assumed to be adiabatic.

Does AFT Fathom Model Transient System Behavior?

Yes, in the optional XTS Add-on Module.

Can I Model a Non-Newtonian Fluid in AFT Fathom?

Yes, AFT Fathom offers several non-Newtonian fluid models including Power Law and Bingham 
Plastic.

Can AFT Fathom Model Fire Sprinkler Systems?

Yes. The Spray Discharge junction is perfectly appropriate for fire sprinklers. The fire sprinkler K 
values can be entered in directly into the Spray Discharge. In addition, Spray Discharge junc-
tions can be turned on or off with a single mouse click. Evaluating multiple fire location scenarios 
is easily done, and use of the Scenario Manager allows all cases to be kept in the same model 
file.

Can AFT Fathom Model Ducting System Like Those in HVAC, Ventilation 
and Dust Collection Systems?

Yes, AFT Fathom can model ducts. The rectangular geometry is modeled as a non-cylindrical 
pipe using a hydraulic diameter. Since ducting systems are usually incompressible, the solution 
methodology is appropriate.

Can I Keep All of My Design Cases Together in a Single File?

Yes, the Scenario Manager lets you create dependent design cases where changes are inher-
ited by children.
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What Is the Difference Between Using a Junction to Input Pressure Loss 
Data and the Fittings & Losses in Pipes?

A junction has several advantages. First, solutions are given at all junctions, so the user can 
check the results at the junction. In contrast, Fittings & Losses are lumped into the pipe and it is 
not possible to give results at the loss. Second, many junctions (such as valves) have the ability 
to specify a Restricted Flow Area for cavitation calculations. No such ability exists for Fittings & 
Losses; thus, cavitation is always ignored for Fittings & Losses. Third, when using a junction the 
location in the pipe system of the pressure loss is specified. In other words, the upstream and 
downstream pipe lengths are specified. In the case of Fittings & Losses, it assumed to act like a 
friction factor and be evenly distributed along the pipe. The Fittings & Losses approach has the 
advantage of being able to specify multiple losses quickly and easily, and not cluttering up the 
model Workspace with numerous junctions.

What Is the Difference Between a Reservoir Junction and an Assigned 
Pressure Junction?

There is an overlap in capability between the Reservoir junction and an Assigned Pressure junc-
tion and frequently they are interchangeable. Here are the differences. The Reservoir junction 
input pressure and temperature always corresponds to stagnation properties. In the Assigned 
Pressure junction, they can correspond to either static or stagnation properties. If static, only one 
pipe can be connected. If the stagnation option is used in the Assigned Pressure junction, it will 
behave identically to a Reservoir junction. Finally, the Reservoir junction allows pipes to connect 
at different elevations (i.e., depths), and also allows pipes to discharge above the liquid surface 
level.

How Does AFT Fathom Account for Pressure Losses at Tees and Wyes?

AFT Fathom uses sophisticated models to calculate losses at tees and wyes. The methods, 
which come from Idelchik, take into account losses that depend on the flow split, area change 
and angle of the branch pipe.

How Do I Size a Pump When There Are Not Any Flow Control Valves?

See the Pump Sizing topic.

How Do I Size a Pump When There Are Flow Control Valves?

See the Pump Sizing topic.
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How Do I Model a Variable Speed Pump?

Enter the pump data as a polynomial in the Pump Properties Window and then set the pump 
speed directly. No entry is assumed to be 100% speed. If you enter something other than 100%, 
AFT Fathom uses the Affinity Laws to adjust the curve. If a control setpoint is entered, AFT 
Fathom will determine the speed necessary to meet that setpoint.

How Do I Find the Pump Speed to Obtain a Desired Flow or Pressure?

Enter the pump curve data in the Pump Properties Window and set the desired flow or pressure 
on the "Variable Speed" tab using the Controlled Pump option. AFT Fathom will calculate the 
pump speed required to produce the flow or pressure conditions specified and display the speed 
in the Pump Summary report.

How Do I Close a Valve, Pump or Pipe?

Select the pipe or junction you want to close and choose Special Condition from the Edit menu. 
By default, AFT Fathom will display a red "X" next to the pipe or junction label on the Workspace. 
It will also redraw your Workspace and show the closed sections of the model with dashed lines 
for the pipes and dashed outlines for each junction. Some special condition settings do not close 
the junction but have different purposes. For example, the normal condition for a relief valve is to 
be closed, so its special condition causes it to be open.

How Do I Model the Pressure Drop Across a Component When There Is 
Only One Data Point?

Use the Resistance Curve Loss Model.

How Do I Model a Relief Valve in a System?

You can model a relief valve using either a Relief Valve junction or a regular Valve junction. The 
Relief Valve junction is always closed when you run the model (unless you set its Special Condi-
tion), and AFT Fathom will run the Solver to determine if sufficient pressure exists to crack it. If 
so, it will run the Solver again with the relief valve open. If you know the condition you are mod-
eling will crack the relief valve, it is more efficient to just use a regular valve junction. In this case, 
AFT Fathom assumes the valve is open from the start, and does not have to go through the extra 
step of solving the network to check for sufficient system pressure to crack it.
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How Do I Show the Pipe or Junction Names on the Workspace?

Open the pipe or junction Properties Window, click the Optional tab, and check or clear the 
check boxes for showing the number or name. This will affect the current pipe or junction. You 
can set the default behavior in the Workspace Preferences window available in User Options.

How Do I Change the Display of Pipe or Junction Names on the Work-
space After the Model Has Been Built?

You can use the Global Edit windows to change the current model settings for all pipes or junc-
tions or only selected ones. See the Global Pipe Edit or Global Junction Edit window for more 
information.

How Do I Set My Preferred Engineering Units as Defaults?

From the Tools menu, select User Options. Then select Preferred Units under Unit System. Drop 
down the list of units for each Unit  Family to select the Preferred Unit. At this point, the preferred 
unit applies only to the current model. To make this the default for all models, click the Save as 
New User Defaults button at the bottom. The preferred units for a model can also be set in the 
Startup window.

How Do I Change the Input Data for Multiple Pipes or Junctions All at One 
Time?

The Global Pipe Edit and Global Junction Edit windows offer tremendous power and flexibility in 
changing all or parts of your model input all at once. See Global Pipe Edit and Global Junction 
Edit  topics for more information.

How Do I Create a Liquid Mixture?

You can create mixtures with the NIST REFPROP or Chempak libraries (Chempak is an addi-
tional add-on). The AFT Standard fluid library does not support mixing. To create a mixture, go to 
the Fluid panel in Analysis Setup and choose either the Chempak or NIST REFPROP library, 
and then click the “Create New Mixture and Add…” button. Here you can specify the mixture 
components and percentages.

How Do I Merge Two Models Together?

Use the Merge feature on the File menu to merge models together.
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How Do I Automatically Run Multiple Scenarios or Models Right After 
Each Other?

Multiple scenarios or models can be run sequentially using the Batch Run feature.

How Do I Enable or Disable the Highlight Feature in the Pipe and Junc-
tion Properties Windows?

There are three ways to enable or disable the Highlight feature. The first is toggling the option on 
the Options menu. The second is pressing the F2 function key while in a Pipe and Junction Prop-
erties Window. The third is double-clicking in the blank space at the top of the Pipe and Junction 
Properties Window.

How Do I Automatically Save My Results After the Model Is Run?

Open the Output Control window from the Analysis menu, change to the Format & Action tab, 
and choose to select the Transfer Results to Initial When Done, Transfer Valve States When 
Done, and Save Model When Results are Transferred options.

How Do I Quickly Find a Particular Pipe or Junction on the Workspace?

Use the Find feature to quickly find a pipe or junction.

How Do I Change the Reference Positive Flow Direction for One or More 
Pipes?

Select the pipe or pipes and choose the Reverse Direction feature on the Arrange menu.

How Do I Access Pipe and Junction Properties Windows from the Model 
Data Window?

In the Model Data tabular displays, double click on a row to automatically launch that pipe/junc-
tion's Properties Window.

How Do I Display Only Selected Pipes or Junctions in the Output?

Open the Output Control window from the Tools menu, change to the Show Pipes/Jcts tab, and 
select the pipes and or junctions you want to display.
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How Do I Quickly Change the Units for an Output Parameter?

Whereas the Output Control window allows you specify units for all parameters, when in the Out-
put window viewing results you can quickly change the units for parameters in the tabular dis-
plays by double-clicking the column header.

How Do I Model Elevation Changes in My Pipe System?

Set the elevations in the elevation fields for each junction. Pipes are assumed to be straight 
between junctions. If you need to model a system other than a stationary earth-based system, 
the gravitational acceleration can be changed on the Environmental Properties panel of Analysis 
Setup.

How Do I Show Data for Only Selected Pipes or Junctions in Workspace 
Layers?

This is controlled via the Label Control group of the Layer Settings window.

How Do I Make the Pipe Drawing Tool Stay Active so That I Can Continue 
to Draw Pipes Without Having to Click It Each Time?

If you hold down the CTRL key when completing the pipe drawing (just before releasing the 
mouse button), the Pipe Drawing tool remains active, and you can draw a series of pipes without 
returning to the Toolbox each time. If you double-click the Pipe Drawing tool it remains active 
until you click it again a single time. This allows you to draw a series of pipes without returning to 
the Toolbox each time.

How Do I Add Graphical Segments to a Pipe so It Is Not Constrained to a 
Single Straight Line?

Use the Add/Remove Segments tool found on the Arrange Menu.

How Do I Set Up Custom Libraries on My Local PC?

See the Libraries topic.
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How Do I Set Up Custom Libraries on Our Local or Wide Area Network?

See the Network Libraries Overview topic.

How Do I Change the Icon for a Junction in AFT Fathom?

Open the Junction Properties Window, click the Optional tab, and then click the Change Icon but-
ton.

Can I Customize the Junction Icons in AFT Fathom?

No, AFT Fathom icons are in a resource file that cannot be edited by the user.

What Is the Limit to the Size of Model I Can Create with AFT Fathom?

There are no theoretical limits to model size, but there are a few practical limits. First, AFT 
Fathom accepts pipe and junction ID numbers up to 30,000. This limits the model size to 30,000 
pipes and 30,000 junctions. Before you reach that limit, however, you will likely encounter a lim-
itation of your available RAM to hold all of the solver parameters. To determine how much RAM 
you need, add up the number of branches and tees in the model. Take the square of this num-
ber. Then multiply it by 32 to get the amount of RAM that must be available. For example, with 
1,000 branches and tees, the square is 1 million, and after multiplying by 32 you need 32 million 
bytes of RAM (i.e., 32 MB).

Can AFT Fathom Model Reacting Flows?

No, AFT Fathom only models non-reacting flows.

Can I Install AFT Fathom Onto a Local or Wide Area Network?

Yes, AFT Fathom can run off the network or local PC. When installed on a network, the number 
of concurrent users is limited to the number of licenses purchased. See the Information on Soft-
ware Installation topic.

Where Can I Find Reference Information About Pipe Materials?

See the Pipe Material Library References topic.
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What Kind of Transients Can Fathom XTS Model?

A wide range, including liquid levels, valve open/close, pump speed changes, relief valve open-
ing and more. Just as important, Fathom XTS can model time transients, event transients and 
inherent transients. Time transients are changes that are specified to occur based on the model 
time. Event transients, on the other hand, are triggered by an event that occurs in the system. 
Many kinds of events can be used, such as pressure, flow, velocity and liquid level. Inherent tran-
sients are changes that occur by the very nature of a system component. One example would be 
the liquid level change that occurs in a finite reservoir (or tank), while another would be a check 
valve opening and closing as a result of flow reversals.
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Fathom Learning Resources

Online Resources

Additional resources can be found in the Learning Center on our website. Resources found there 
include:

 l Training Seminar information
 l Free Webinars
 l Flow Expert Package information
 l Case Studies
 l Video Tutorials
 l Tips & Tricks Blogs
 l Quick Start Guides
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Online Quick Start Video Tutorial

The Quick Start video tutorial series provides a short introduction to the interface of AFT Fathom 
using a simple example model.

 l Online Quick Start Video Tutorial Series

Beginner: Three Reservoir Problem

This is a simple example model which is recommended as a starting point for brand new AFT 
product users.

 l Beginner: Three Reservoir Problem

Walk Through Examples

This links to a variety of example problems for beginning to advanced users which showcase dif-
ferent features and applications of AFT Fathom.

 l Walk Though Examples

Module Walk Though Examples

A list of examples using the add-on modules of AFT Fathom to solve a variety of problems.

 l Module Walk Through Examples
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Startup Window
The Startup Window is displayed when AFT Fathom is opened. This window allows the user to 
quickly access files and resources, as well as define a basic starting point for a new model.
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 l Open a Model
 l My Files - AFT Fathom keeps a list of recently opened model files. The most 

recent files can be opened with a single click here.
 l Other Files - Browse to any other model file, or open the built-in Examples folder.

 l Start a New Model
 l Activate Modules - Any licensed Module can be activated immediately. Checking 

these boxes will search for an available license.
 l Select Working Fluid

 l I Will Select Fluid Later - No fluid will be defined, one will need to be 
defined in Analysis Setup on the Fluid panel before running the model.

 l Use ASME Water - Selects ASME Water to be used as the working fluid of 
the model which requires the definition of Pressure and Temperature, and 
optionally can have Heat Transfer modeling enabled.

 l Select A Recently Used Fluid - Allows the selection of a recently used 
fluid from the dropdown menu and also requires Temperature.

 l Modeling Preferences - Displays various settings for the application, such as spe-
cifying the units to use, which grid to use, or whether to enable NFPA. These 
options can be modified later. Click the Modify button to reveal the following set-
tings, as shown in Figure 2. Click the Remember My Preferences and Hide but-
ton to update the modeling preferences for the model and to update the default 
settings for the application.

 l Units - US, Metric, or both sets of units with one as default can be dis-
played. Additionally, the displayed units can further be reduced to only show 
common units and those used by a certain industries.

 l Language - Select a language for the display of the Menus, Workspace Lay-
ers, Output, Graph Results, and the Startup Window.

 l 2D or Isometric Workspace - Set up the grid.
 l Default Pipe Material - Set the pipe material that is initially selected for 

new pipes.
 l NFPA Settings - Enable NFPA.

 l Resources
 l Current Version - Open the AFT website to view the latest AFT Fathom release, 

or sign up for notifications of new releases via email.
 l Learning Center - Provides links to various Learning Resources that are designed 

to help get a new user up and running with AFT Fathom as quickly as possible. The 
resources include the Quick Start Guide PDF, Examples, and video tutorials.
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Figure 1: Startup Window in AFT Fathom

Figure 2: Startup Window showing Modeling Preferences
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Fundamental Modeling Concepts
This section focuses on the critical concepts and theories that comprise the model building pro-
cess in AFT Fathom. Topics include discussions on the role of pipe and junction objects, descrip-
tions of how boundary conditions and flow direction are specified, and instructions on how to 
model closed systems.
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Pipes and Junctions
AFT Fathom employs two fundamental pipe system constructs: pipes and junctions.

Pipes are conduits for incompressible, one-dimensional fluid flow. The flow rate through the 
entire length of the pipe is always constant in steady-state simulations, but can vary if the XTS 
module is enabled. Because pipes have constant diameters, the fluid velocity is also constant. 
Pressure drop due to friction occurs in pipes. Heat transfer may or may not occur depending on 
the type of model you select. 

Junctions are connector points for pipes and are elements at which flow balances are made. 
Some junction types can only connect to one pipe; others can connect with up to twenty-five. 

In addition to balancing flow, junctions also influence the flow or pressure behavior of the sys-
tem. For example, a reservoir junction applies a constant pressure at a location, and the flow 
there is free to adjust in whatever manner is consistent with the governing equations. In contrast, 
an assigned flow junction applies a known flow rate at its location, allowing the pressure to adjust 
to that level dictated by the governing equations. The various junction types allow you to specify 
special kinds of irrecoverable pressure losses for fluid behavior. 

Junctions communicate with each other through the pipes connecting them. Each pipe must be 
connected to two junctions. There are no exceptions to this rule. 
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A pipe differs from a junction in that it has a reference positive flow direction. To say a pipe has a 
flow rate of 1 lbm/sec is meaningless unless the flow direction is specified. 

In general, you do not need to specify the actual flow direction in a pipe, because AFT Fathom 
sorts out the true physical flow directions of the system you define. For example, if you specify 
the reference positive flow direction from left to right, and the solution is in fact the opposite dir-
ection, then that information will be presented in the output as a negative flow rate. Inlet and out-
let conditions correspond to the reference positive flow direction, not the actual flow direction.

However, it is important to specify the proper flow direction for pipes which connect to junctions 
such as pumps or valves. AFT Fathom uses the flow direction of the pipes to determine in which 
direction to increase or reduce pressure.
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Reference Positive Flow Direction

Reference Positive Flow Direction

Next to each pipe's ID number is an arrow that indicates the reference positive flow direction for 
the pipe. AFT Fathom assigns a flow direction corresponding to the direction in which the pipe is 
drawn. You can reverse the reference positive flow direction by choosing Reverse Direction from 
the Arrange menu or selecting the reverse direction button on the Toolbar. With exception to 
some junctions, the reference positive flow direction is used for reference purposes only and 
does not need to correspond with the real direction of flow calculated by the Solver (the part of 
AFT Fathom that applies the governing incompressible flow equations to obtain a solution to the 
pipe system). If the flow direction obtained by the Solver is opposite of the reference positive flow 
direction, then the output will show the flow rate as a negative number.

Note: The reference positive flow direction is important for pumps because the pipe directions 
will define which side is suction vs discharge. Furthermore, reverse flow through com-
ponents may result in a Caution message which may or may not be valid depending on 
the intended direction of flow.
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Convention for Flow Entering and Exiting

Many of the junction types permit fluid flow to come into or pass out of the system in a prescribed 
manner. The most obvious of these is the Reservoir junction. Reservoirs maintain a constant 
pressure at a node, and the flow adjusts according to the governing equations. While in principle 
the fluid is stored or removed from the reservoir, AFT Fathom considers the fluid as coming into 
or going out of the system. The stored reservoir fluid is not part of the system.

The convention for defining inward or outward flow for the system or any AFT Fathom object is 
that flow in is positive (that is, the object/system gains the flow) and flow out is negative (the 
object/system loses the flow).
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Features for Modeling Irrecoverable Losses
AFT Fathom works almost exclusively with the concept of the loss factor, also known as the K-
factor or resistance factor. In some Properties windows, other popular methods for specifying 
loss information are provided where they are consistent with the loss factor method. For 
example, you will find Cd (discharge coefficients) for orifices.

AFT Fathom has methods available for modeling irrecoverable losses with the Equivalent 
Length method with either user-defined equivalent lengths  or NFPA 13 table data (which is the 
table on the Fittings & Losses tab on the Pipe Properties window). In order for the fittings and 
losses to be modeled as equivalent lengths, the toggle switch must be set to use Equivalent 
Lengths. Refer to the NFPA panel topic for more information on generating an NFPA Output 
Report.
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Curve Fitting 74
Stagnation vs. Static Pressure Boundaries 75

Philosophy of Computer Modeling
Some might say that a "good" computer model is one that accurately predicts the response of a 
system, but this is only partly true. The practicing engineer generally must weigh the accuracy of 
the model against the risk, schedule, and/or budget involved. Through experience, an engineer 
learns where to focus resources and when an answer is good enough to base important 
decisions on.

Although AFT Fathom is designed to speed up the modeling process, it should never be used as 
a "black box." Your model input and output should always be carefully reviewed.

To make the most effective use of AFT Fathom, you should follow these guidelines:

 l Be aware of what AFT Fathom can and cannot do and the assumptions it makes.
 l Learn and use the tools in AFT Fathom that are appropriate for the specific analysis you 

want to perform. Detailed and accurate answers demand detailed and accurate input. 
Quick and dirty answers require less detailed input.

 l Learn and use the tools in AFT Fathom that allow you to process information in the 
formats that mean the most to you. Because pipe flow applications vary so much within dif-
ferent industries, AFT Fathom is customizable for the way you want to do your pipe flow 
work. Understanding the tools will help you gain greater conceptual control over your pipe 
flow analyses and reduce modeling errors.

 l Check your input data. Use the features available in AFT Fathom to review your results 
for input errors. Pay attention to the information in the output. Don't neglect warnings in 
the output. Perform hand analysis checks of results.

 l Bound your problem. Instead of trying to calculate the exact resistance in a network, or 
the right loss factor for an orifice, use your judgment, guided by data, on how much vari-
ation might occur. By running your model at the upper and lower limits, you can obtain 
answers, for example, on the maximum and minimum possible pressure drops in the sys-
tem. If the results at the maximum and minimum are acceptable, your analysis is probably 
finished. If they are not acceptable, you can further refine the input model.

 l Recognize whether your problem is one of maximization or minimization. That is, recog-
nize whether the design goal is to minimize the flow rate, for example, or maximize the 
flow rate. Then make your assumptions conservative enough to provide high confidence 
that your design requirements are being satisfied.

Related Topics

Fundamental Modeling Concepts 63
Pipes and Junctions 63
Reference Positive Flow Direction 64
Features for Modeling Irrecoverable Losses 65
Role of Pressure Junctions and How They Work 67
Open vs. Closed Systems 70

- 66 -



Fundamental Modeling Concepts

Curve Fitting 74
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Role of Pressure Junctions and How They Work

Role of Pressure Junctions

In modeling a generalized pipe network, it is possible to construct models that do not have a 
unique solution. A common occurrence of this is when a model contains one or more sections 
which are completely bounded by known flow rates. 

The simplest example is the system shown in Figure 1. In AFT Fathom terms, the system has 
two assigned flow junctions. 

 
Figure 1: Model with two assigned flows. This model does not have a unique solution.

Obviously, the flow in the pipe is known. But what is the pressure at the inlet? At the outlet? It can-
not be determined because there is no reference pressure. The reference pressure is that pres-
sure from which other pressures in the system are derived. There can be more than one 
reference pressure, but there always has to be at least one.

The model in Figure 1 can be built with AFT Fathom and if you try and run this model, AFT 
Fathom will inform you that it cannot run it because of the lack of a reference pressure (Figure 2). 
In AFT Fathom there are several junctions that can act as a reference pressure: the reservoir, 
assigned pressure, valve (with the exit valve option), orifice (with the exit orifice option), spray 
discharge, relief valve junctions which are open to an external pressure, and pressure control 
valves.

When you try and run a model that has one or more sections completely bounded by known 
flows (or Flow Control Valves or Pumps operating in fixed flow mode), the Need Reference Pres-
sure window (shown below) is displayed. This window informs you which junctions bound the 
sections where a reference pressure is needed to obtain a unique solution.

In multi-pipe systems there are a host of other possibilities that present themselves. All other 
configuration possibilities which lack a reference pressure ultimately boil down to the 
same problem that exists in Figure 1.

See Role of Pressure Junctions - Detailed Discussion for more information.
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Figure 2: AFT Fathom message when you try to run a model without sufficient reference pressures

How Pressure Junctions Work

Pressure junctions (e.g., reservoirs or assigned pressures) in AFT Fathom are an infinite source 
or sink of fluid. This means that they can draw or discharge as much fluid as is necessary to main-
tain the specified pressure. This section offers a physical example of how pressure junctions 
work.

Consider the physical pumping system shown in Figure 3. This system pumps water from Lake 
Ontario to Lake Huron. 

Figure 3: Physical pumping system to transfer water from shoreline supply tank (J1) to discharge 
tank (J2) at top of hill

An engineer is tasked with sizing the pump for this system. The engineer has an idea of the dis-
charge head needed for the pump, and so builds an AFT Fathom model as shown in Figure 4. 
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The Figure 4 model is attempting to represent the physical system in Figure 3, but it in fact rep-
resents the physical system in Figure 5.

Figure 4: Model to size pump attempting to represent system in Figure 3. It does not accurately rep-
resent Figure 3

Figure 5: Physical system represented by model in Figure 4

Why? Because the reservoir junction (J3), which is an infinite source of fluid, has been located 
between the pump (J2) and Lake Huron (J4). The J3 reservoir isolates Lake Ontario and the 
pump (J1 and J2) from Lake Huron (J4). The J3 reservoir is very much like placing Lake Erie 
between the supply and discharge piping. 

If the engineer changes the surface elevation in J3, it is like changing the surface elevation of 
Lake Erie. It will change the flow rate in the pipes, but no matter how high the water level of Lake 
Erie, it does not change the fact that the pumping system is isolated from Lake Huron. The flow 
rate in the piping from J4 to J3 is entirely dependent on the difference in surface elevations 
between J3 and J4, and is not influenced by the J2 pump in any way.

How then should the physical system in Figure 3 be modeled? It should be modeled as shown in 
Figure 6.

- 69 -



Fundamental Modeling Concepts

Figure 6: Proper model of physical system shown in Figure 3

If the goal is to size the pump at J2, the model in Figure 6 can be used with the pump modeled as 
a fixed flow pump.
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Related Blogs

Reference Pressure Needed: Where It Comes from and How to Address it

Open vs. Closed Systems

Model a Closed Loop System

A closed circulating system can easily be modeled with AFT Fathom by locating a Reservoir junc-
tion anywhere in the system and setting the pressure to the known pressure at that point. Inflow 
and outflow pipes will then need to be connected. The Reservoir junction merely acts as a "ref-
erence pressure" against which all other pressures in the system are compared. Because there 
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are no other inlets or outlets to the system, then whatever is delivered by the Reservoir junction 
to the system will also be received from the other pipes, thus achieving a net zero outflow rate for 
the system.

When using a Reservoir junction as a reference pressure for a closed system, you should select 
the Balance Energy in Reservoir option, which will allow the reservoir temperature to vary and be 
calculated in a manner consistent with the overall energy balance.

Balancing Mass

In order to model a closed system, only one pressure junction is used in the model. Typically this 
would be either a Reservoir or Assigned Pressure. Pressure type junctions are an infinite source 
of fluid and do not balance flow. How then can one be used to balance flow in a closed system?

To answer this question, it is worth considering how AFT Fathom views a closed system model. 
AFT Fathom does not directly model closed systems, and in fact does not even realize a closed 
system is being modeled.

Consider the system shown in Figure 1. This is an open system. Fluid is taken from J1 and 
delivered to J4 and J5. Because AFT Fathom's solution engine solves for a mass balance in the 
system, all flow out of J1 must be delivered to J4 and J5. Because the flow is steady-state, no 
fluid can be stored in the system; what goes in must go out.

Figure 1: Open system - Flow out of J1 equals the sum of J4 and J5

Now consider the systems in Figure 2. The first system appears to be closed, while the second 
appears to be open. If the same boundary condition (i.e., surface elevation and pressure) is used 
for J1, J11 and J12 in the second system, it will appear to AFT Fathom as an identical system to 
the first system. The reason is that AFT Fathom takes the first system and applies the J1 reser-
voir pressure as a boundary condition to pipes P4, P9 and P10. The second system uses three 
reservoirs to apply boundary conditions to P4, P9 and P10. But if the reservoirs all have the 
same elevation and pressure, the boundary conditions are the same as J1 in the first system. 
Thus the same boundary condition is used for P4, P9 and P10 in both models, and they appear 
identical to AFT Fathom.

But how is the flow balanced at J1 in the first system? Looking at the first system, one sees that 
to obtain a system balance, whatever flows into P10 must come back through P4 and P9. 
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Because there is overall system balance by the solver, it will give the appearance of a balanced 
flow at the pressure junction J1. If there is only one boundary (i.e., junction) where flow can enter 
or leave the pipe system, then no flow will enter or leave because there isn't anywhere for it to 
go. Thus the net flow rate will be zero at J1 (i.e., it will be balanced). But recognize that AFT 
Fathom is not applying a mass balance to J1 directly. It is merely the result of an overall system 
balance. 

Figure 2: The first system is closed, and the second open. In both systems the flow into P10 is the 
same as sum of P4 and P9. If the second system has the same conditions at J1, J11 and J12, the two 

system will appear identical to AFT Fathom.
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Balancing Energy

Here  the thermal aspects of open and closed systems are discussed.

Consider the system shown in Figure 3 .The flows are balanced at J1, but how can the energy be 
balanced? For example, assume the user sets a temperature of 100° F at J1. This temperature 
will be the inlet pipe temperature for all pipes that flow out of J1. In this case, the 100° F will apply 
only to pipe P10.

The pipes flowing into the reservoir (P4 and P9) will have their own temperatures that are 
obtained by balancing energy along their individual flow paths. This could include heat 
exchanger input and heat transfer to or from pipes, as well as any heat added to the fluid from 
pumps.

The only way to obtain an overall system energy balance is for the J1 reservoir temperature to 
adjust to the mixture temperature of all inflowing pipes. This is the function of the "Balance 
Energy At Junction" feature in the reservoir and assigned pressure junctions. The junction tem-
perature (input as maybe 100° F) is allowed to "float" and find its own equilibrium. Each iteration 
the floating reservoir temperature is passed into pipe P10 until convergence. When passed into 
P10, this will affect the return temperatures of P4 and P9. There is a unique "mixture tem-
perature" (or mixture enthalpy) that will yield an energy balance at J1. This will be the tem-
perature/enthalpy from Equation 3 in the Network Implementation topic.

Figure 3: Example of balancing energy in a closed system
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Curve Fitting
There are many places within the interface where the user may be asked to define how a prop-
erty changes in relation to another. Some examples include:

 l Pump Curves
 l Junction Resistance Curves
 l Custom Fluids
 l Pipe Physical Properties

These properties are entered in a tabular format, relating a particular property to one or several 
others. For example, see the below definition of a custom fluid:

Figure 1: Custom Fluid Definition

There are several parameters that control the behavior of the fluid and they are entered as they 
relate to temperature.

However, it is important to recognize that these values in particular are not directly used in the 
solution. Instead, the data is used to create a best-fit curve. This curve is then used in the solu-
tion process. This is an important step to take because there must be a continuous relationship 
between the independent variable (e.g. temperature) and the dependent variable (e.g. density). 
Even if the final solution was close to one of the defined points, the Solver needs continuous data 
to proceed.

There are some options for how the data is curve fit. First, there are two Curve Fit Types:

 l Polynomial - The data is best fit to a polynomial of order 0,1,2,3, or 4. Note that a 0th 
order polynomial is a constant value, and a 1st order is a linear fit.

 l Interpolated X-Y Data - The data has a linear interpolation drawn between every data 
point.
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One of the critical items to note with any curve fit is that you may not be operating close to one of 
your defined points if the data does not conform well to a polynomial relationship. For example, 
the above fluid has a rapidly decaying viscosity that does not follow a polynomial relationship. Fit-
ting the data to the standard 2nd order polynomial results in the following:

Figure 2: Using a Polynomial Curve Fit on Non-Polynomial Data

The viscosity relationship in the model will use the blue curve, and not the user-defined black 
points. Depending on the operating range of the system, this may significantly impact the results! 
For this data in particular, using the Interpolated X-Y Data option may be a better choice.

After data has been curve fit, the constants for the resulting curve are displayed in the lower-right 
of the associated window.
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Flow solution for Junction X is above/below the maximum/minimum value spe-
cified for the resistance curve. Flow rate: Y 789

Stagnation vs. Static Pressure Boundaries
With two exceptions (to be discussed), all pressure-type boundary conditions in AFT Fathom are 
stagnation. This works very well for things such as storage tanks, cooling ponds, lakes, etc., 
where the volume associated with a pressure is large and will not change (significantly) with 
time. These boundaries have no velocity associated with them, and using stagnation pressure is 
thus appropriate. These boundary conditions are most clearly rendered in AFT Fathom by use of 
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a Reservoir junction.

Consider the reservoir and connected pipe in Figure 1. When the liquid in a reservoir flows into 
connecting pipes, the static pressure immediately drops due to the increase in velocity.

It is tempting to say that because there is no velocity in the reservoir, then it does not matter 
whether the reservoir boundary pressure is considered as a static or stagnation pressure 
because they are equal. This is a misconception. The pressure boundary condition in an AFT 
Fathom model is applied at the exit of the reservoir, not within the reservoir itself. Inside the reser-
voir, the static and stagnation pressures are the same, but they are not the same at the exit - they 
differ by the amount of the dynamic pressure.

    
Figure 1: Pressure profile along horizontal pipe shown

The choice of either stagnation or static pressure as a boundary condition depends on whether 
there is a velocity associated with the pressure that is specified. If the pressure is in a vessel or 
large (lower velocity) header, then a stagnation pressure is appropriate. If the pressure is in a 
pipe somewhere in the middle of a system, static pressure is more suited.

Pressure boundary conditions with no velocity are more common across all piping industries, 
and are usually appropriate. However, this is not always the case.

When to use Static Pressure 

Now let's consider the application of a true static pressure boundary condition. A static boundary 
condition has a unique velocity associated with it. The Bernoulli equation, which in this integrated 
form applies only to incompressible flow, is given by:

From this equation it can be seen that application of the static pressure is not sufficient to specify 
location 1. The velocity and elevation is also required.

In AFT Fathom, elevation data is entered for junctions. The pipes adopt the elevation of the junc-
tion to which they are connected.
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But where does the velocity information for the Bernoulli equation come from? One might 
respond that it can be obtained from the flow rate. But this raises another question: what if the 
flow rate isn’t known? Put another way, what if the flow rate is what we are solving for?

When the user supplies a stagnation pressure boundary condition, AFT Fathom can use Equa-
tion 6 in the Network Solution Methodology topic. Here, no velocity information is required. A 
stagnation pressure boundary can thus be supplied to multiple pipes that might have different 
velocities. That is why the same reservoir junction can connect with multiple pipes.

However, if the user specifies a static pressure as the boundary condition, to apply Equation 4 in 
the Network Solution Methodology topic, a unique velocity must be supplied. Thus, it is only pos-
sible to connect a static pressure to a single pipe with a unique velocity.

Important: A static pressure boundary has a unique velocity associated with it, and can thus 
connect to only one pipe.

Where would one find a static pressure boundary? The best example is when the boundary con-
dition is inside a pipe. A pipe system model can start and end anywhere it is convenient for the 
user. It may be convenient to not start the model at the physical boundary (such as a tank) but at 
a particular location in the pipe system. This could be, for example, at the location of a pressure 
measurement. Or it could be at the boundary of the pipe system for which your company is 
responsible, with another company responsible for what is on the other side of that boundary.

If one needs to model such a situation, the Assigned Pressure junction allows one to model 
either a static or stagnation pressure. The default stagnation pressure allows connection of up to 
25 pipes. If static pressure is chosen, only one connecting pipe is allowed.

Static Pressure at Pressure Control Valves

Another example of static pressure is at pressure control valves. For pressure control valves 
(i.e.,  PRV’s and PSV’s) the default control pressure is static pressure. The reason is that the 
measured pressure that provides feedback to the controller will typically be a static pressure 
measurement. You have the option of modeling pressure control valves as either static or stag-
nation pressure.

Related Topics

Fundamental Modeling Concepts 63
Pipes and Junctions 63
Reference Positive Flow Direction 64
Features for Modeling Irrecoverable Losses 65
Philosophy of Computer Modeling 66
Role of Pressure Junctions and How They Work 67
Open vs. Closed Systems 70
Curve Fitting 74
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Analysis Setup Overview
Analysis Setup contains all of the settings which the user must define to run the model, including 
fluid properties, pipe and junction status, environmental properties, and other related options. 
Open Analysis Setup from either the Common Toolbar or the Analysis menu.

The controls in Analysis Setup are divided into different groups in the navigation pane on the left 
side of the window (Figure 1). Each group has one or multiple items. Clicking on an item opens 
the panel for that item.

A group is not fully defined until each item in that group is defined. Each group will have either a 
green check mark, indicating that all required items have been defined, or a red exclamation 
point, indicating that some or all of the required inputs are missing. Note that some groups will 
have a green checkmark by default, indicating that the required inputs have default settings 
already applied, or all inputs for that group are optional. Groups that are undefined will change to 
a green check mark when the required inputs for that group are entered, and the user navigates 
to a different panel. Note that none of the changes will be applied to the model until OK is selec-
ted. Clicking Cancel will discard all changes made in the window.

The groups in Analysis Setup are listed below:

 l Modules Group
 l Fluid Properties Group
 l Pipes and Junctions Group
 l Transient Control Group - (XTS Module only)
 l Goal Seek and Control Group - (GSC Module only)
 l Steady Solution Control Group
 l Environmental Properties Group
 l Cost Settings Group
 l Automatic Sizing Group - (ANS Module only)
 l Miscellaneous Group
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Figure 1: Default state of Analysis Setup in a new blank model

Modules Group
AFT Fathom has four optional add-on modules which extend its modeling capabilities into other 
areas. The modules allow multivariable goal seeking and control simulation, settling slurry mod-
eling, time varying simulation, and full system sizing. The Modules panel within the Modules 
group in Analysis Setup allows you to activate and enable any of the four AFT Fathom add-on 
modules. An additional license to the base AFT Fathom license is required to use a module. 
These modules include:

 l GSC (Goal Seek & Control) - Identifies input parameters that yield desired output values 
and simulates control functions.

 l SSL (Settling Slurry) - Models the effects of pumping fluids containing settling solids using 
the Wilson/GIW method.

 l XTS (Extended Time Simulation) - Models dynamic system behavior and how critical sys-
tem parameters vary over time.

 l ANS (Automated Network Sizing) - Evaluates the complex interaction of system variables 
to reveal combinations of cost savings.

Related Topics

Modules Panel 80
Add-on Modules 547
Analysis Setup Overview 78
Fluid Properties Group 85
Pipes and Junctions Group 138

- 79 -



Fundamental Modeling Concepts

Transient Control Group 140
Goal Seek and Control Group 146
Steady Solution Control Group 159
Environmental Properties Group 166
Cost Settings Group 168
Automatic Sizing Group 171
Miscellaneous Group 172

Modules Panel
The Modules panel allows users to activate and enable the optional add-on modules.

Activating a module checks out a license seat for the module.

Enabling a module turns on all functionality for the module. By default activating a module will 
also automatically enable the module for use. Disabling a module keeps the license seat 
checked out but the module calculations are not applied to the model. Disabling a module may 
be desired for various reasons, as is discussed further for each module below.

Note:  A module specific license is required to activate the GSC, SSL, XTS, or ANS Add-on 
Modules.

Figure 1: The default state of the Modules panel

GSC (Goal Seek & Control)

Activate the Goal Seek & Control module by checking the box next to Activate GSC. Once activ-
ated,  enable it by selecting Use or disable it by selecting Ignore.  When the GSC module is activ-
ated, the Goal Seek and Control Group appears in the Analysis Setup window. The Goal Seek 
and Control group has three items: Variables, Goals, and Numerical Controls.

- 80 -



Analysis Setup Overview

The GSC module can be enabled before or after a model is built. Pre-existing models built with 
the base AFT Fathom application  can have the GSC module activated.

Setting the GSC module to Ignore causes the GSC module to function like the base AFT 
Fathom application. One difference is that users are still able to enter goal seeking data with this 
data retained in the model. If the model is opened in the base AFT Fathom application, this data 
will be lost. Table 1 relates the differences  between using AFT Fathom without the GSC module 
activated, using it with the GSC module activated but disabled (Ignore mode), and using it with 
the GSC module activated and enabled. 

The GSC module  can also be toggled between Use and Ignore from the Analysis menu in the 
Goal Seek & Control  option as shown in Figure 2. Use this feature to quickly toggle the GSC 
module between Use and Ignore without opening the Modules panel in Analysis Setup. 

Table 1: AFT Fathom feature accessibility based on the GSC module activation and  enablement

Features GSC Not 
Activated

GSC Activated

GSC Disabled GSC Enabled

Goal Seek and Control Group in Analysis 
Setup Not Visible Visible                             Visible

Goal Seek and Control in Analysis menu Not Visible Visible Visible

Goal Seek and Control tab in General Sec-
tion of Model Data window Not Visible Visible Visible

GSC Variables and GSC Goals tabs in Gen-
eral Section of Output window Not Visible Not Visible Visible

Figure 2: Select Use from the Goal Seek & Control option in the Analysis menu to  perform goal seek-
ing when running the model

SSL (Settling Slurry)

Activate the Settling Slurry module by checking the box next to Activate SSL. Once activated,  
enable it by selecting Settling or disable it by selecting Disable.  When the SSL module is activ-
ated, the four standard items in the Fluid Properties group are replaced with the three SSL 
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module fluid properties items as shown in Table 2 below. These items are Carrier Fluid, Solids 
Definition, and Slurry Definition. Additionally, the Library menu will have a Solids Library option. 
These items are present while SSL is activated and enabled, but will be switched back if SSL is 
disabled.

Table 2: Analysis Setup items in Fluid Properties group with and without SSL active

Without SSL Active With SSL Active

Activating the SSL module  can be done before or after a model is built. If activated after, then 
additional input will be required for solids data. Pre-existing models built with standard AFT 
Fathom can be opened with SSL and settling slurry data added. 

Settling slurry calculations can be turned off at any time by selecting Disable. The Disable mode 
causes the SSL module to function like standard AFT Fathom. If a model with SSL activated is 
opened in standard AFT Fathom without SSL activated, then the SSL data will be lost once the 
model is saved. Table 3 relates the differences between not using SSL and using it in Disable 
mode. The purpose of Disable mode is that it allows standard clear fluid calculations to be per-
formed without deactivating SSL. Deactivating the SSL module will cause the loss of the slurry 
input data for the active scenario.

The SSL module can also be toggled between Settling and Disable from the Analysis menu in 
the Slurry option as shown in Figure 3. Use this feature to quickly toggle the SSL module 
between Settling and Disable without opening the Modules panel in Analysis Setup.
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Table 3: AFT Fathom feature accessibility based on the SSL module activation and  enablement

Features SSL Not 
Activated

SSL Activated

SSL Disabled SSL Enabled

SSL items in Fluid Properties group Not Visible Not Visible Visible

Slurry in Analysis menu Not Visible Visible Visible

Solids Library in Library menu Not Visible Visible Visible

Flowrate specified in terms of slurry, solids or 
clear liquid in several junctions Not Visible Not Visible Visible

Slurry data in Output Not Visible Not Visible Visible

Initial Velocity Guess Ratio V/Vsm in 
Advanced Parameters panel Not Visible Not Visible Visible

Figure 3: Select Settling from the Slurry option in the Analysis menu to perform  settling slurry cal-
culations when running the model

XTS (Extended Time Simulation)

Activate the Extended Time Simulation module by checking the box next to Activate XTS. Once 
activated, enable it by selecting Transient or disable it by selecting Steady Only. When the XTS 
module is activated, the Transient Control group appears in the Analysis Setup. The Transient 
Control group has one item: Simulation Duration. 

Activating the XTS module can be done before or after a model is built. If activated after, then 
additional input will be required for transient junctions. Pre-existing models built with the base 
AFT Fathom application can have the XTS module activated.

Transient modeling can be turned off at any time by selecting Steady Only. The Steady Only 
mode causes the XTS module to function like standard steady-state AFT Fathom. One dif-
ference is that users can still enter transient data and this data is retained in the model. If the 
model is opened in standard AFT Fathom, this data will be lost. Additionally, the Transient Con-
trol group and Simulation Duration panel are still accessible. Table 4 relates the differences 
between not using XTS and using it in Steady Only mode.
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The XTS module can be toggled between Steady Only and Transient from the Analysis menu in 
the Time Simulation option as shown in Figure 4. Use this feature to quickly toggle the 
XTS module between Steady Only and Transient without opening the Modules panel in Analysis 
Setup.

Table 4: AFT Fathom feature accessibility based on the XTS module activation and enablement

Features XTS Not Activ-
ated

XTS Activated

XTS Disabled XTS Enabled

Transient Control Group in Analysis 
Setup Not Visible Visible Visible

Time Simulation in Analysis Menu Not Visible Visible Visible

Transient tab in junction properties win-
dows Not Visible Visible Visible

Transient Pipe and Jct tabs in Output Not Visible Not Visible Visible

Transient tab in junction section of Model 
Data Not Visible Visible Visible

Time control slider and buttons in Output                                 Not Visible Not Visible Visible

Time control slider and buttons in Work-
space Not Visible Not Visible Visible

Transient tab on Select Graph Data Not Visible Not Visible Visible

Animation controls in Graph Results Not Visible Not Visible Visible

Figure 4: Transient mode is enabled from the Analysis menu

ANS (Automated Network Sizing)

Activate the Automated Network Sizing module by checking the box next to Activate ANS. Once 
activated, enable it by selecting Network or disable it by selecting Not Used. When the ANS 
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module is activated, the Automatic Sizing group appears in the Analysis Setup. The Automatic 
Sizing group has one item: Sizing Summary. Additionally, the Sizing Window  becomes available 
when ANS is activated.

Activating the ANS module can be done before or after a model is built. If activated after, then 
additional sizing data will be required to run the model. Pre-existing models built with the base 
AFT Fathom application can have the ANS module activated. 

ANS can be disabled at any time by selecting Not Used from the same menu. The Not Used 
mode causes the ANS module to function like the base AFT Fathom application. However, all 
ANS data and settings in the model will still be retained. If the model is opened in the base AFT 
Fathom application, this data will be lost. The purpose of Not Used mode is that it allows ANS to 
be quickly turned off and on without having to change data in the Sizing Objective.

The ANS module can be toggled between Network and Not Used from the Analysis menu in the 
Automated Sizing option as shown in Figure 5. Use this feature to quickly toggle the ANS module 
between Network and Not Used without opening the Modules panel in Analysis Setup.

Figure 5: Enabling Automated Sizing from the Analysis menu

Related Topics

Modules Group 79
Add-on Modules 547

Fluid Properties Group
The Fluid Properties group in Analysis Setup gives you control over the fluid properties that influ-
ence your pipe system analysis.              

While there are a four panels available to input the fluid properties, only one panel is required to 
run the model. The rest of the panels offer optional input.

Note: If the SSL module is activated the panels in the Fluid properties group will change to 
show the slurry panels. See SSL Module Fluid Properties for more information.

 l Fluid panel  - Required panel. Allows the user to define the fluid properties directly, or from 
one of the available fluid libraries.
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 l Viscosity Model panel - Optional panel. Allows user to define a non-Newtonian viscosity 
model.

 l Heat Transfer/Variable Fluids panel - Optional panel. Allows user to enable one of the 
heat transfer property options.

 l Laminar and Non-Newtonian Corrections panel - Optional panel. Allows the user to 
choose what correction factors to apply for laminar or non-Newtonian flow and to which 
objects the corrections should apply.

Related Topics

Fluid Panel 86
Viscosity Model Panel 94
Heat Transfer/Variable Fluids Panel 118
Laminar and Non-Newtonian Corrections Panel 121
SSL Module Fluid Properties Group 130
Analysis Setup Overview 78
Modules Group 79
Pipes and Junctions Group 138
Transient Control Group 140
Goal Seek and Control Group 146
Steady Solution Control Group 159
Environmental Properties Group 166
Cost Settings Group 168
Automatic Sizing Group 171
Miscellaneous Group 172

Related Blogs

Get More Flexible With Your Fluids

Fluid Panel
The Fluid panel controls the properties of the fluid in the model. A default fluid is not selected - 
one must be defined to run any simulation unless one was previous defined on the Startup Win-
dow.

The first selection that must be made is what Fluid Library to use. The default selection of User 
Specified requires the manual definition of Density, Dynamic Viscosity, and Vapor Pressure 
(optional if cavitation detection is not required). The available Fluid Libraries are:

 l AFT Standard - Common fluids from various industry standard sources have been curve 
fit to optimize calculation speed. This fluid library offers the best balance between accur-
acy and computation time. Many of these fluids have thermal property information that 
allows for the calculation of heat transfer.
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 l ASME Steam/Water - Properties are calculated via the Equations of State which were 
used to generate the classic steam/water tables in the IAPWS Industrial Formulation 
(1997).

 l NIST REFPROP - The Reference Fluid Thermodynamic and Transport Properties 
(REFPROP) Database is licensed from the National Institute of Standards and Tech-
nology (NIST) where properties for approximately 150 fluids are calculated via Equations 
of State. REFPROP supports user-specified fluid mixtures. For more info see the fol-
lowing sources: Program Summary, REFPROP FAQ, NIST Chemistry WebBook, NIST 
Chemical Name Search.

 l Chempak Fluid - Optional add-on for purchase which contains data for approximately 
700 fluids and supports user-specified fluid mixtures. Chempak is licensed from Madison 
Technical Software.

 l User Library Fluid - If the desired working fluid is not available via the other sources, cus-
tom fluid properties can be entered and saved to the User Library for repeated use in the 
future. Fluids can be created using the Fluid Libraries menu.

Select a library by clicking the radio button next to the name of the library. After selecting a lib-
rary, the Fluids Available in Library list is populated. One of the fluids can be selected and used 
with the Add To Model button.

Note: All fluids in Fathom are treated as incompressible as stated in the Engineering Assump-
tions. This includes fluids in the gas phase and fluids above the critical point.

AFT Standard Fluid Library

Common fluids from various industry standard sources have been curve fit to optimize cal-
culation speed. This fluid library offers the best balance between accuracy and computation 
time. Many of these fluids have thermal property information that allows for the calculation of 
heat transfer.

Generally, fluids in the AFT Standard library are assumed to have properties that only vary with 
temperature which follows the incompressible engineering assumption of Fathom.

To add a fluid into your model, select it from the Fluids Available in Library list  and click the Add 
to Model button. The fluid will appear in the  Fluids in Current Model area. Once the fluid is added, 
specify the temperature in the Fluid Properties area on the right to calculate values of density, 
dynamic viscosity, and vapor pressure, as shown in Figure 1.

Vapor pressure is listed as optional since it is only needed to check if cavitation exists in the 
pipes/junctions.
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Figure 1: Fluid panel in Analysis Setup with the AFT Standard fluid library selected

ASME Steam/Water Library

Properties are calculated via the Equations of State which were used to generate the classic 
steam/water tables in the IAPWS Industrial Formulation 1997 for the Thermodynamic Properties 
of Water and Steam (ISPWS-IF97), see ASME Press in References.

After selecting ASME Steam/Water, "ASME '97 Water" is automatically added to in the Fluids in 
Current Model area. Select the Fluid Phase and enter a Pressure and Temperature to calculate 
the properties as shown in Figure 2.

Detailed fluid property information from SteamCalc can be calculated using the AFT SteamCalc 
Viewer, which can be accessed from Tools > Fluid Property Viewers > SteamCalc. The 
SteamCalc Viewer will be launched as a separate application, which can then be used to cal-
culate fluid properties at various conditions.

For more information on AFT SteamCalc Viewer see the SteamCalc Help File.
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Figure 2: Fluid panel in Analysis Setup with the ASME Steam/Water fluid library selected

NIST REFPROP Library

The Reference Fluid Thermodynamic and Transport Properties (REFPROP) Database is 
licensed from the National Institute of Standards and Technology (NIST) where properties for 
approximately 150 fluids are calculated via Equations of State. The data comes from Version 10 
of the library. For more info see the following sources: Program Summary, REFPROP FAQ, 
NIST Chemistry WebBook, NIST Chemical Name Search.

Add a fluid from the Fluids Available in Library list by selecting it and clicking Add to Model.  
Select the Fluid Phase and enter both a Pressure and Temperature in the Fluid Properties area 
on the right, as shown in Figure 3.

Fluids from the NIST REFPROP library support fluid mixtures, but no chemical reactions are 
modeled as listed in the Engineering Assumptions.
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Figure 3: Fluid panel in Analysis Setup with the NIST REFPROP fluid library selected

Chempak Fluid Library

Optional add-on for purchase which contains data for approximately 700 fluids. Chempak is 
licensed from Madison Technical Software.

Fluids from the Chempak library  support fluid mixtures, but no chemical reactions are modeled 
as listed in the Engineering Assumptions.

Add a fluid from the Fluids Available in Library list by selecting it and clicking Add to Model.  
Select the Fluid Phase and enter both a Pressure and Temperature in the Fluid Properties area 
on the right, as shown in Figure 4.

Information on the theory and calculation methods used in Chempak is given in the Chempak 
Technical Information topic.

Detailed fluid property information from Chempak can be calculated using the AFT Chempak 
Viewer, which can be accessed from Tools > Fluid Property Viewers > Chempak. The Chempak 
Viewer will be launched as a separate application, which can then be used to calculate fluid prop-
erties at various conditions. A Chempak Database license is required to use the Chempak 
Viewer.

For more information on AFT Chempak Viewer see the Chempak Viewer Help File.
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Figure 4: Fluid panel in Analysis Setup with the Chempak fluid library selected

State Property Accuracy Options

The State Property Accuracy options are applicable only to Chempak fluids and  are located on 
the Fluid panel below the Fluids in Current Model area. 

The State Property Accuracy influences the number of elements used in curve fits for calculating 
property data. There are two accuracy options: Standard and High. You will usually want to start 
with standard accuracy, which is selected by default, and use high accuracy for final runs, 
depending on the importance and run time for the model. The high accuracy option will increase 
run time by about a factor of two.

When performing interpolations for properties, a 4 point or 16 point interpolation scheme can be 
used. The 4 point scheme implemented in AFT Fathom is the Standard Accuracy option. The 16 
point scheme is the high accuracy option. Use of the High accuracy option will roughly double 
the run times for models.

Related Topics

Fluid Properties Group 85
Viscosity Model Panel 94
Heat Transfer/Variable Fluids Panel 118
Laminar and Non-Newtonian Corrections Panel 121
SSL Module Fluid Properties Group 130
Creating Liquid Mixtures 92
Transport Properties 94
Chempak temperature and or pressure is out of range for the following 782
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Static pressure lower than vapor pressure at inlet/outlet of pipe/junction X 786
Temperature at inlet/exit of pipe X is above/below max/min fluid temperature 
range 786
Temperature is above the saturation line for the following... 787

Creating Liquid Mixtures
You have the option of creating a mixture of fluids with the NIST REFPROP or Chempak fluid lib-
raries.

To create a mixture, first select NIST REFPROP or Chempak Fluid on the Fluid panel in Analysis 
Setup. Once this has been selected, the option to Create New Mixture and Add button becomes 
available. Click this button, then locate and select the first fluid in the mixture you wish to specify 
(the Search button can be used to search for a name or synonym). Enter the mass or mole frac-
tion of the fluid in the mixture, and click Add Fluid to Mixture. Repeat this process for all fluids in 
the mixture as shown in Figure 1.

Note: The fraction basis of all mixtures is either mass or mole, and it is specified on the Fluid 
panel itself. If you would like to change the fraction basis for the mixture (from mass to 
mole or from mole to mass), click on the desired fraction basis located at the bottom of 
the Fluid panel below Fraction Basis for Mixture. Note that this option is only available 
after you specify the model fluid as a mixture.
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Figure 1: The Create Mixture window (opened from the Fluid panel) allows you to create predefined 
mixtures for the model

To add the mixture to the Fluid panel, the Total Fraction for the table must equal 100%. To help 
achieve this, the Set as Remainder button can be used to add the remaining percentage to the 
selected component in the table so that the fractions in the table will add up to 100%. Altern-
atively, the Ratio Fractions to Total button will scale up the fractions in the table so that they will 
add to 100%.

Components can be deleted from the table by using the Remove Component or Clear All Com-
ponents buttons.

Mixture data can be exported to a file which can then be imported into other AFT applications, or 
shared with other AFT application users by using the Export Mixture to File and Import Mixture 
from File buttons in this window.

Note: The NIST REFPROP fluid library is not able to calculate the mixing parameters for most 
mixtures containing water, helium, hydrogen, neon, carbon monoxide, fluorine, meth-
anol, or ethanol.

Related Topics
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Fluid Panel 86
Transport Properties 94

Transport Properties
The transport properties in AFT Fathom (specific heat, dynamic viscosity, and thermal con-
ductivity) are assumed to be functions of temperature only. In general this is a good assumption, 
although systems at very high pressure usually start to show some pressure dependence. These 
properties are modeled as polynomial curve fits of temperature or interpolated.

Related Topics

Fluid Panel 86
Creating Liquid Mixtures 92

Viscosity Model Panel
AFT Fathom can model systems with Newtonian or non-Newtonian fluids. A Newtonian fluid is 
one where the fluid viscosity is fixed and independent of fluid velocity, while a non-Newtonian 
fluid is one where the fluid viscosity is variable and dependent on fluid velocity. Most industrial flu-
ids are Newtonian fluids, although there are important applications for non-Newtonian fluids. By 
default, AFT Fathom has the Newtonian viscosity model selected.

AFT Fathom offers several viscosity models:

 l Newtonian (default)
 l Paper Stock - Duffy
 l Paper Stock - Brecht & Heller
 l Power Law
 l Bingham Plastic
 l Herschel-Bulkley
 l Homogeneous Scale-up

Modeling non-Newtonian fluids is a complex task. A myriad of theoretical models and test equip-
ment exist, and each have various names unique to an industry or application. Each of the non-
Newtonian viscosity models require rheological inputs to be defined. Those inputs are detailed 
on the pages for each model as well as an explanation as to what the viscosity model is meant 
for, how to use the model, and how the model calculates hydraulic behavior in a system.

Frictional Losses

Each non-Newtonian fluid model adjusts the frictional losses in the system from the Newtonian 
fluid model. The equations and correlations used to determine pipe frictional losses are detailed 
on each model’s page. These methods to determine frictional losses replace the pipe friction 
model specified in the Pipe Properties window. For pipe Fittings and junction-specific losses, all 
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non-Newtonian models use the same method, as detailed in the Laminar and Non-Newtonian 
Corrections panel topic.

Related Topics

Fluid Properties Group 85
Fluid Panel 86
Heat Transfer/Variable Fluids Panel 118
Laminar and Non-Newtonian Corrections Panel 121
SSL Module Fluid Properties Group 130
Duffy Method (Pulp and Paper Stock) 95
Brecht & Heller Method (Pulp and Paper Stock) 98
Power Law Model 100
Bingham Plastic Model 103
Homogeneous Scale-up Method 110
Herschel-Bulkley Model 106
Using Rheological Data 113

Related Blogs

Non-Newtonian Fluids - How to Model the Soap, Silly-Putty, or Shampoo in Your Pipe Network

Duffy Method (Pulp and Paper Stock)
The Duffy method is a system developed by G.G. Duffy at the University of Auckland, New Zea-
land and formalized by the Technical Association of the Pulp and Paper Industry (TAPPI). The 
model uses correlations based on data obtained from laboratory flow loops and real-world pulp 
mill piping systems.

TAPPI states that the correlations behind this model do not necessarily provide the actual design 
value of friction loss. Instead, it provides a means to determine the minimum value of pipe friction 
loss an engineer can expect. Each system designer must determine and apply a safety factor as 
they deem necessary. 

Fathom contains data on 21 different stock fluid selections that can be used with the Duffy 
method. The constants used for each stock fluid are displayed in the General Results section of 
the output. Additionally, the Vmax and Vwater terms, the dryness coefficient, and the Safety 
Factor can all be displayed in the Pipe Output. 

Note: The Duffy method is only valid for pulp consistencies between 2% and 6%.

Duffy Method Interface

The Viscosity Model panel appears as shown below in Figure 1 when the Duffy method is selec-
ted.
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Figure 1: Viscosity Model panel for the Duffy Method

Users must select a type of pulp to model and define a pulp consistency. The user must also 
choose to correct the Duffy method parameters based on temperature automatically or via a 
user-specified correction. The constants used by Fathom are based on a pulp temperature of 35 
deg. C. The Automatic Based on Temperature will use the temperature specified on the Fluid 
panel (or the temperature in each pipe in the case of Variable Fluid Properties) to determine the 
pulp temperature.

There are 21 pulp types to choose from:

 l Bleached kraft pine dried and reslurried - PVC pipe
 l Bleached kraft pine dried and reslurried - SS pipe
 l Bleached straw - copper pipe
 l Bleached sulfite - copper pipe
 l Hardwood NSSC CSF = 620 - PVC pipe
 l Kraft - copper pipe
 l Kraft birch dried and reslurried - PVC pipe
 l Long-fibered kraft dried and reslurried - PVC pipe
 l Long-fibered kraft never dried CSF = 260 - PVC pipe
 l Long-fibered kraft never dried CSF = 550 - PVC pipe
 l Long-fibered kraft never dried CSF = 650 - PVC pipe
 l Long-fibered kraft never dried CSF = 725 - PVC pipe
 l Long-fibered kraft never dried CSF = 725 - SS pipe
 l Newsprint broke CSF = 75 - PVC pipe
 l Refiner groundwood CSF = 150 - PVC pipe
 l Refiner groundwood (hardboard) - PVC pipe
 l Refiner groundwood (insulating board) - PVC pipe
 l Stone groundwood CSF = 114 - PVC pipe
 l Unbeaten aspen sulfite never dried - SS pipe
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 l Unbleached straw - copper pipe
 l Unbleached sulfite - copper pipe

Theory and Correlations

AFT Fathom models frictional losses for the Duffy method using correlations taken from the 
TAPPI Generalized Method for Determining the Pipe Friction Loss of Flowing Pulp Suspensions. 

The maximum velocity (m/s) for the Duffy model is given by:

The velocity at which pulp effects are negligible and the frictional losses of the pulp mixture are 
the same as the frictional losses of pure water:

In the case where V < Vmax:             

Where:

 l dH/L = head loss per length (m water/100 m pipe)                     
 l C = pulp consistency (% dryness)                     
 l D = inner pipe diameter (mm)                     
 l F = correction factor for temperature or pipe roughness (dimensionless)                     
 l K', K, σ, α, β, γ = constants depending on pulp type and pipe material (dimensionless)                     
 l V = actual pipe velocity, when Vmax > V (m/s)                     
 l V = Vmax, when Vwater > V > Vmax

When pipe velocity is larger than Vwater, standard pipe friction models are used, treating the pulp 
mixture as pure water. 

Related Topics

Viscosity Model Panel 94
Brecht & Heller Method (Pulp and Paper Stock) 98
Power Law Model 100
Bingham Plastic Model 103
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Homogeneous Scale-up Method 110
Herschel-Bulkley Model 106

Related Blogs

Non-Newtonian Fluids - How to Model the Soap, Silly-Putty, or Shampoo in Your Pipe Network

Brecht & Heller Method (Pulp and Paper Stock)
The Brecht and Heller method is a system developed by Brecht and Heller at the University of 
Maine and formalized by the Technical Association of the Pulp and Paper Industry (TAPPI) and 
the Cameron Hydraulic Handbook. The model uses correlations based on data obtained from 
laboratory flow loops and real-world pulp mill piping systems.

This method is considered more conservative than the Duffy method, meaning the Brecht and 
Heller method will predict larger pressure losses in a system, all else constant.

Fathom contains data on eight different stock fluid selections that can be used with the Brecht 
and Heller method. The constants used for each stock fluid are displayed in the General Results 
section of the output. Additionally, the pseudo-Reynolds Number (Ré) and Friction Factor terms 
can be displayed in the Pipe Output. 

Brecht and Heller Method Interface

The Viscosity Model panel appears as shown below in Figure 1 when the Brecht & Heller method 
is selected.

Figure 1: Viscosity Model panel for the Brecht & Heller Method

Users must select a type of pulp model and define a pulp consistency. There eight pulp types to 
choose from:
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 l Bleached sulfite - SW, CSF = 560
 l Pre-steamed groundwood - SW, CSF = 200
 l Reclaimed fiber
 l Soda - HW
 l Stone groundwood - SW, CSF = 70
 l Unbleached kraft - SW, CSF 730
 l Unbleached sulfite - SW, CSF = 640
 l Unbleached, unrefined sulfite SW

Theory and Correlations

AFT Fathom models frictional losses for the Brecht and Heller method using correlations taken 
from the Cameron Hydraulic Handbook, pg 3-88. 

The pseudo-Reynolds number for the paper stock (Ré) is:

The pipe friction factor is:

The friction loss in feet along the pipe is:

Where:

 l D = inner diameter (feet)                     
 l L = pipe length (feet)                     
 l V= average velocity (feet/sec)
 l ρ= stock fluid density (lbm/ft3)
 l C = pulp consistency (% dryness)                     
 l K = friction factor constant, specific to pulp type (dimensionless)                     
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Related Topics

Viscosity Model Panel 94
Duffy Method (Pulp and Paper Stock) 95
Power Law Model 100
Bingham Plastic Model 103
Homogeneous Scale-up Method 110
Herschel-Bulkley Model 106

Related Blogs

Non-Newtonian Fluids - How to Model the Soap, Silly-Putty, or Shampoo in Your Pipe Network

Power Law Model
The Power Law model for non-Newtonian fluids is one of the most common viscosity models 
used in hydraulic analysis. This model states that the shear stress required to shear a fluid at a 
given rate can be described by the following equation:

Where τ is the shear stress, du/dy is the shear rate (or velocity gradient), and K and n are the 
Power Law constants.             

The Power Law model defines η, the apparent viscosity of the fluid as:             

In the Power Law model, a value of n=1 corresponds to a Newtonian fluid, while 0 < n < 1 is a 
Shear Thinning (pseudoplastic) fluid and n > 1 represents a Shear Thickening (dilatant) fluid. 

To employ this model, users must have values for K and n, or have rheological test data. 

Power Law Interface

The Viscosity Model panel  appears as shown below in Figure 1 when the Power Law model is 
selected.
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Figure 1: Viscosity Model panel for the Power Law model

Users must enter values for the Power Law constants, K and n. If the user has raw rheological 
test data instead, they can enter that directly using the Calculate from Rheological Data option.

Theory and Correlations

AFT Fathom models the frictional losses due to a Power Law fluid using correlations taken from 
Darby, pg. 166-167. Note that the original equations in Darby use the Fanning friction factor, 
while AFT software uses the Moody friction factor. The equations below have been modified 
from the original accordingly. 

Where:
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The Reynolds number for power law fluid (Repl) is defined as:             

The critical Reynolds number for power law fluid (Replc) where laminar flow ceases is defined as:

The friction factor calculated using this correlation is then used to determine pressure loss fol-
lowing Equation 3 in the Network Solution Methodology topic. 

These correlations are valid across the full range of Reynolds number. The applicability of this 
method to highly turbulent flow is limited only by the test data used to determine the Power Law 
constants. 

Related Topics

Viscosity Model Panel 94
Duffy Method (Pulp and Paper Stock) 95
Brecht & Heller Method (Pulp and Paper Stock) 98
Bingham Plastic Model 103
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Homogeneous Scale-up Method 110
Herschel-Bulkley Model 106
Using Rheological Data 113

Related Blogs

Non-Newtonian Fluids - How to Model the Soap, Silly-Putty, or Shampoo in Your Pipe Network

Bingham Plastic Model
The Bingham Plastic model for non-Newtonian fluids is one of the most common viscosity mod-
els used in hydraulic analysis. This model states that the shear rate resulting from a given shear 
stress applied to the fluid can be described with the following piecewise equation:

Where du/dy is the shear rate (or velocity gradient), τ is the applied shear stress, τo is the yield 
stress, and μ∞ is the plastic viscosity or coefficient of rigidity.             

The Bingham Plastic model describes η, the apparent viscosity of the fluid as:             

The Bingham Plastic model uses a constant value for plastic viscosity, meaning a value for μ∞ of 
0 would result in a Newtonian fluid. Some fluids may see Bingham Pseudoplastic behavior, 
where shear stress and shear rate do not have a linear relationship. These fluids can be 
modeled using the Herschel-Bulkley viscosity model.

To employ this model, users must have values for τo and μ∞, or have rheological test data.             

Bingham Plastic Interface

The Viscosity Model panel appears as shown below in Figure 1 when the Bingham Plastic model 
is selected.
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Figure 1: Viscosity Model panel for the Bingham Plastic model

Users must enter values for the Bingham Plastic constants, μ∞ and τo. If the user has raw rhe-
ological test data instead, they can enter that directly using the Calculate from Rheological Data 
option instead.             

Theory and Correlations

AFT Fathom models the frictional losses due to a Bingham Plastic fluid using correlations taken 
from Darby, pg. 168-169. Note that the original equations in Darby use the Fanning friction 
factor, while AFT software uses the Moody friction factor. The equations below have been mod-
ified from the original accordingly. 

Where:
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The Reynolds number for a Bingham Plastic fluid is defined as:

The Hedstrom number for a Bingham Plastic fluid is defined as:

The friction factor calculated using this correlation is then used to determine pressure loss fol-
lowing Equation 3 in the Network Solution Methodology topic. 

These correlations are valid across the full range of Reynolds number. The applicability of this 
method to highly turbulent flow is limited only by the test data used to determine the Bingham 
Plastic constants. 

Related Topics

Viscosity Model Panel 94
Duffy Method (Pulp and Paper Stock) 95
Brecht & Heller Method (Pulp and Paper Stock) 98
Power Law Model 100
Homogeneous Scale-up Method 110
Herschel-Bulkley Model 106
Using Rheological Data 113
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Related Blogs

Non-Newtonian Fluids - How to Model the Soap, Silly-Putty, or Shampoo in Your Pipe Network

Herschel-Bulkley Model
The Herschel-Bulkley model for non-Newtonian fluids  states that the shear rate resulting from a 
given shear stress applied to the fluid can be described with the following  equation:

Where du/dy is the shear rate (or velocity gradient), τ is the applied shear stress, τo is the yield 
stress, K is the consistency coefficient, and n is the flow behavior index. 

The Herschel-Bulkley model describes describes η, the apparent viscosity of the fluid as:             

In the Herschel-Bulkley model a value for τo of 0 and a value for n of 1 would result in a New-
tonian fluid. The Herschel-Bulkley model is equivalent to the Bingham Plastic model if n = 1, and 
is equivalent to the Power Law model if τo = 0.

To employ this model, users must have values for τo, K and n, or have rheological data.

Herschel-Bulkley Interface

The Viscosity Model panel  appears as shown below in Figure 1 when the Herschel-Bulkley 
model is selected.
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Figure 1: Viscosity Model panel for the Herschel-Bulkley model

Users must enter values for the Herschel-Bulkley constants, K, n, and τo. If the user has raw rhe-
ological test data instead, they can enter that directly using the Calculate from Rheological Data 
option.

Theory and Correlations

AFT Fathom models the frictional losses due to a Herschel-Bulkley fluid using correlations as are 
summarized in Garcia & Steffe   (1986). Note that the original equations in the reference use the 
Fanning friction factor, while AFT software uses the Moody friction factor.

The laminar flow friction factor is defined as

with

and ξo, the dimensionless unsheared plug radius:
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The turbulent flow friction factor can be calculated as follows

where

Where He is the Hedstrom number for Herschel-Bulkley fluids and is defined as

Re is the Reynolds number for Herschel-Bulkley fluids, and is equivalent to the Reynolds num-
ber for Power Law fluids:

The critical Reynolds number, which represents the transition from laminar to turbulent flow 
for Herschel Bulkley fluids is defined as
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Where n is the flow behavior index, Ψc is equivalent to Ψ with ξo = ξoc, and ξoc is defined impli-
citly as follows

The friction factor calculated using this correlation is then used to determine pressure loss fol-
lowing Equation 3 in the Network Solution Methodology topic. 

These correlations are valid across the full range of Reynolds number. The applicability of this 
method to highly turbulent flow is limited only by the test data used to determine the Herschel-
Bulkley constants. 

Curve Fit Methodology

Unlike the Power Law and Bingham Plastic models the Herschel-Bulkley method uses three 
parameters, so a simple linear regression cannot be used to curve fit all three constants.

Instead Fathom employs the method discussed in Mullineux (2008), which first solves a root-find-
ing equation to determine n, then performs a non-linear regression of τ vs xn to determine the 
constants K and τo. 

The curve fit results using this method have been proven to be identical to the results of a non-lin-
ear least squares regression, which is one of the most common methods used to curve fit the 
Herschel-Bulkley parameters.

If a different curve fitting method is preferable to represent the fluid being modeled the User 
Entered Constants option should be selected instead.

Related Topics

Viscosity Model Panel 94
Duffy Method (Pulp and Paper Stock) 95
Brecht & Heller Method (Pulp and Paper Stock) 98
Power Law Model 100
Bingham Plastic Model 103
Homogeneous Scale-up Method 110
Using Rheological Data 113

Related Blogs

Non-Newtonian Fluids - How to Model the Soap, Silly-Putty, or Shampoo in Your Pipe Network
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Homogeneous Scale-up Method
The Homogeneous Scale-up method for non-Newtonian fluids is based on the idea that test data 
for velocity and pressure drop along pipes of a given diameter can be scaled up to model the 
velocity and pressure drop for a pipe of a large size. 

This scale-up is similar to using the affinity laws to predict pump behavior. Instead of scaling pres-
sure rise and volumetric flowrate for a pump, the Homogeneous Scale-up method scales the fric-
tional gradient (jm) and mean velocity (Vm) for a pipe.             

To employ this method, users must have test data from the same Tube Flow Rheometer as is 
available when entering rheological data for the Power law, Bingham Plastic, and Herschel-
Bulkley models.

Homogeneous Scale-up Interface

The Viscosity Model panel  appears as shown below in Figure 1 when the Homogeneous Scale-
up method is selected. Click the Enter Scaled Data button to enter data.

Figure 1: Viscosity Model panel for the Homogeneous Scale-up method

The Homogeneous Scale-up window is shown below in Figure 2. Here, the user must specify 
information about the pipe used to obtain the test data along with the test data itself. The flow 
data can be entered as mass flowrate, velocity, volumetric flowrate, or shear rate data as determ-
ined by a tube flow rheometer. The Head/Pressure data can be entered in terms of Head gradi-
ent, Pressure gradient, or shear stress data as determined by a tube flow rheometer. 

Each data point must also be marked as laminar or turbulent flow. 
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Figure 2: Homogeneous Scale-up Data entry window

The user can also generate a graph of their data plotted against other viscosity models and lar-
ger scaled pipe sizes. This interface is shown in Figure 3 below. Note that generating a cross-
plot for the Power Law or Bingham Plastic models does not mean Fathom will use those models 
in the system. The cross-plot is intended only to give a visual comparison of the data. 
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Figure 3: Graphed data for the Homogeneous Scale-up method

Theory and Correlations

The Homogeneous Scale-up methods are based on Chapter 3 of Wilson, et al, 2006, page 67. 

Laminar data scales as follows:

Turbulent data scales as follows:
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Where: 

 l Data point 1 is the test data
 l Data point 2 is the larger system
 l τ is the shear stress at the pipe wall                     

The pressure drop calculated using these methods is then substituted into the network solution 
and iterated upon until a converged solution is available. 

These correlations are valid across the full range of Reynolds number. The applicability of this 
method to highly turbulent flow is limited only by the test data the user has available.

Related Topics

Viscosity Model Panel 94
Duffy Method (Pulp and Paper Stock) 95
Brecht & Heller Method (Pulp and Paper Stock) 98
Power Law Model 100
Bingham Plastic Model 103
Herschel-Bulkley Model 106
Using Rheological Data 113
Affinity Laws 329

Related Blogs

Non-Newtonian Fluids - How to Model the Soap, Silly-Putty, or Shampoo in Your Pipe Network

Using Rheological Data
For the Power Law, Bingham Plastic and Herschel-Bulkley viscosity models, users are expected 
to define constants for each model. If the user already has these constants, they can be entered 
directly into the software. If the user only has the original rheological data, Fathom can calculate 
the viscosity model constants from that data. 
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The interface used to enter this data and the processes Fathom employs to manipulate it are sim-
ilar for all of the viscosity models mentioned above. This page discusses rheological data only in 
the context of the Power Law model for simplicity. Unless specified otherwise, the content dis-
cussed here is applicable to all models. 

Calculate from Rheological Data Interface

The Calculate from Rheological Data option can be accessed from the Viscosity Model panel in 
Analysis Setup. Click the Calculate from Rheological Data radio button and click the Calculate 
Constants button as shown below in Figure 1. 

Figure 1: Power Law viscosity model using the Calculate from Rheological Data option

The Calculate Power Law Constants window will open  to enter rheological data. This window is 
shown below in Figure 2. In this window, users are asked to enter Shear Stress (τ) vs. Shear 
Rate data in units of pressure and inverse time, respectively. 

Two Raw Data Type options are presented above the table, Tube Flow Rheometer Data (8V/D) 
and Shear Rheometer Data (du/dy). These options refer to the experimental setup used to 
obtain the shear stress vs shear rate data entered in the table. Fathom version 11 and earlier 
assumed all entered data was the Tube Flow Rheometer Data (8V/D) type. Refer to the Types of 
Rheological Data section below for more information on which option to use.

Note: For Herschel-Bulkley fluids only the Shear Rheometer Data option is available at this 
time. This is because the method employed in Fathom to convert from Tube Flow Rheo-
meter Data to Shear Rheometer Data has unknown accuracy for use with the Herschel-
Bulkley model.
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Figure 2: Rheological data input form

The user can click Generate Curve Fit Now to curve fit the data and obtain the viscosity model 
constants. Generating the curve fit will show the user a plot of their data along with the fitted con-
stants, as shown below. Clicking OK will transfer those constants to the Viscosity Model panel 
and display the resultant Shear Stress vs Shear Rate curve fit graph. 
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Figure 3: Curve fit rheological data and constants

Types of Rheological Data

Two major types of rheological test data exist. Many names and potential test devices exist for 
each type. For the purposes of this discussion, we must pick a single name for each type. One 
experimental setup is a tube flow rheometer while the other is a rotational rheometer.

Tube Flow Rheometer

A tube flow rheometer system consists of a pipe of some diameter and length connected to a 
high pressure source and a low pressure source. Varying the high pressure source drives flow 
through the pipe at different velocities. This experimental setup allows the engineer to obtain 
data on the pressure gradient (pressure drop per length) along the pipe for a given velocity. The 
engineer could also obtain this type of rheological data by directly measuring pressure and velo-
city along a pipe in an existing facility.

This data is then manipulated into shear stress and shear rate data, respectively. Specifically, 
the tube flow rheometer gives shear rate data where the shear rate is the bulk shear rate of the 
fluid. The measured velocity is the bulk velocity of the fluid, meaning only bulk shear rate can be 
calculated. Bulk shear rate can be calculated from bulk velocity using the equation 8V/D.

This type of rheological data may be more common in industries considering slurry applications 
or when the process facility is already in operation and data is obtained via direct measurements 
of the system operations.
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Rotational Rheometer

A rotational rheometer system consists of a rotating device in contact with the fluid being studied. 
Common examples of this system include the cup and bob (couette) rheometer and the cone 
and plate rheometer. Varying the angular rate of the rotating device creates different shear rates 
in the fluid. This experimental setup allows the engineer to obtain data on the torque required to 
achieve a given angular rate of rotation.

This data is then manipulated into shear stress and shear rate data, respectively. Specifically, 
the rotational rheometer gives shear rate data where the shear rate is the wall shear rate of the 
fluid. The angular rate of rotation and equipment geometry are directly known, and thus the 
shear rate is calculated at the wall of the rotating device.

This type of rheological data is more common when data is obtained via small-scale, laboratory 
tests. If rheological data is presented with information about rate of rotation (RPM, revolutions 
per second, Hx, etc.), the data was likely obtained from a rotational rheometer.

Finally, modern rotational rheometers will commonly manipulate the directly measured torque 
and angular rate of rotation data for the engineer, returning the raw data along with shear stress 
or viscosity vs. shear rate data. Note that Fathom requires the user to define shear stress vs. 
shear rate data when entering rheological test data. If the user only has viscosity vs. shear rate 
data, they should curve fit the constants for the desired viscosity model manually.

Converting Between Types of Rheological Data

Although two types of rheological data exist, most viscosity models expect rotational rheometer 
data. Fathom employs the Rabinowitsch-Mooney technique to convert from tube flow rheometer 
data to rotational rheometer data when necessary.

The Rabinowitsch-Mooney technique can be applied to obtain rotational rheometer data from 
tube flow rheometer data as follows:

 1. Plot the tube flow rheometer data on a log-log scale.
 2. Determine the slope of the data. The slope is represented by n’. 
 3. Multiply the tube flow rheometer data by the value:

Fathom now has rheological data in the form of rotational rheometer (rheogram) data, which can 
be used to directly fit the viscosity model constants.

Related Topics

Viscosity Model Panel 94
Power Law Model 100
Bingham Plastic Model 103
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Herschel-Bulkley Model 106

Related Blogs

Non-Newtonian Fluids - How to Model the Soap, Silly-Putty, or Shampoo in Your Pipe Network

Heat Transfer/Variable Fluids Panel
The Heat Transfer/Variable Fluids panel, shown in Figure 1, allows users to define how the fluid 
properties will vary. The fluid selected on the Fluid panel must have data entered for the heat 
transfer parameters, such as specific heat, for the Heat Transfer options to be available, as is dis-
cussed further in the Custom Fluids topic.

Note: Only Newtonian fluids can be modeled when heat transfer is enabled.

 l Constant Fluid Properties - All fluid properties are the same for every pipe and are as 
specified on the Fluid panel. Note that non-newtonian viscosity models will still cause the 
viscosity to vary if the constant fluid properties option is selected.

 l Variable Fluid Properties - The values for density and viscosity on the Fluid panel are 
the default fluid properties. You can enter different fluid property values, if desired, for any 
pipe in the Pipe Properties window. This does not mean that fluid properties can vary on 
their own in the model - they are constant in each pipe and must still be directly specified 
by the user.
This option may be useful to model different pipes carrying different fluids, or to model 
changes in temperature across a component. Fathom cannot perform dynamic mixing; 
however, fluid properties of pure components may be individually specified in upstream 
pipes, and the resulting mixture properties can be individually specified in downstream 
pipes.

 l Heat Transfer With Energy Balance (Single Fluid) - All fluid properties are determined 
dynamically during the run based on the most recent solution for temperature and pres-
sure - thus they are inherently variable. Only one fluid is used in the model. Additional 
inputs will be required in the pipes and junctions which are specified to model heat trans-
fer.

 l Heat Transfer With Energy Balance (Multiple Fluid) - All fluid properties are determ-
ined dynamically during the run based on the most recent solution for temperature and 
pressure - thus they are inherently variable. Piping loops with different fluids can be 
modeled using Fluid Groups to input multiple fluids into the model, such as to represent 
different sides of a heat exchanger. However, dynamic mixing of fluids is not supported. 
Additional inputs will be required in the pipes and junctions which are specified to model 
heat transfer.

Always Use Constant Density - Only applicable to Variable Fluid Properties and Heat Transfer 
With Energy Balance (Single Fluid). This option forces the fluid density to remain constant 
throughout the model. This can be convenient when density variations due to temperature are 
minimal but viscosity changes are significant. Enabling this option has only minimal impact on 
results in these cases, and can greatly simplify and clarify the head and gradeline values which 
would otherwise change by some minimal amount.
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Figure 1: Heat Transfer/Variable Fluids panel

Related Topics

Fluid Properties Group 85
Fluid Panel 86
Viscosity Model Panel 94
Laminar and Non-Newtonian Corrections Panel 121
SSL Module Fluid Properties Group 130
Modeling Heat Transfer 119
Fluid Groups 120
HGL, EGL and head loss results may not be meaningful for variable density sys-
tems 784
Junction X has a density change across it 790

Modeling Heat Transfer
AFT Fathom can model heat transfer simultaneously with the hydraulic calculations. Since many 
pipe flow design calculations neglect heat transfer, this capability is turned off by default. Hence 
temperature and heat loss information is not required to specify a model.

Heat transfer modeling is enabled on the Heat Transfer/Variable Fluids panel by selecting one of 
the two Heat Transfer With Energy Balance options. Once selected, temperature input is 
required at boundary junctions such as reservoirs. By default pipes are adiabatic, but different 
heat transfer models can be selected such as Convective Heat Transfer and Constant Heat Flux. 
With Convective Heat Transfer pipes can be assigned insulation and convection coefficient data 
to calculate heat loss or gain.

In addition, heat exchangers provide input for heat transfer with eleven heat exchanger thermal 
models available. Thermal linking with other heat exchangers is also provided to model cases 
such as heat transfer between both sides of a heat exchanger.
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Finally, heat addition at pumps can also be modeled.

As heat transfer takes place during the system hydraulic solution, physical properties (such as 
viscosity) are dynamically updated based on resulting temperatures and a system energy bal-
ance is performed as part of the simulation.

Related Topics

Heat Transfer/Variable Fluids Panel 118
Fluid Groups 120

Fluid Groups
The purpose of fluid groups is to allow heat transfer calculations in different loops which have dif-
ferent fluids. When enabled, a new menu item called Fluids appears on the Edit menu Groups fly-
out menu. Here is how this feature is enabled and used:

 1. On the Fluid panel, select a base fluid
 2. On the Heat Transfer/Variable Fluids panel, select Heat Transfer With Energy Balance 

(Multiple Fluids)
 3. Select each pipe in the fluid loop on the Workspace and go to the Edit menu, Groups 

option, then Create to give the group a name. At this point the pipes and junctions are 
standard AFT Fathom groups.

 4. Go to the Heat Transfer/Variable Fluids panel
 5. Check the Use As Fluid Group box for the desired fluid group
 6. Specify what fluid is to be used in each fluid group.
 7. Click OK

Now when you run the model, each of the pipes and junctions in each group will take on the fluid 
properties assigned to that fluid group. 

Note: If you are using a custom fluid in your model and make changes to it in the fluid library, 
you will need to save and re-open the model for the changes to be applied to any fluid in 
a Fluid Group.

Here are some guidelines for use:

 l A pipe or junction can belong to one and only one fluid group
 l Every pipe and junction must belong to a fluid group

Use with Heat Exchangers

Fluid groups allow heat exchangers to be modeled with thermal links to other heat exchangers 
carrying different fluids.
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Thermal Links

When modeling convective heat exchangers (such as parallel or counterflow) two heat 
exchanger junctions can be linked thermally.  A thermal link is when two heat exchanger junc-
tions, which are hydraulically isolated, can exchange heat with each other. Typical use is when 
the two heat exchangers represent two sides of the same physical heat exchanger. When 
thermal linking specified in a heat exchanger properties window, the user must specify the heat 
transfer area and overall convection coefficient. AFT Fathom will force the two heat exchanger 
junctions to use the same value.

Related Topics

Heat Transfer/Variable Fluids Panel 118
Modeling Heat Transfer 119

Laminar and Non-Newtonian Corrections Panel
AFT Fathom uses the methods and correlations discussed for each viscosity model only to 
model frictional losses for pipes. Frictional losses due to pipe fittings or junction losses are 
modeled using the methods discussed on this page regardless of viscosity model.

It is generally believed that the pressure drop through valves, fittings, etc. derive from bulk fluid 
motion, wall separation, turbulence, etc and hence are not affected by non-Newtonian fluid beha-
vior in turbulent flow. Thus, pressure loss due to pipe fittings or junction-specific losses during tur-
bulent flow are modeled using the same methods employed for Newtonian flow.

During laminar flow, pipe fittings and junction losses may not be similar for both Newtonian and 
non-Newtonian fluids. AFT Fathom offers two options to model these losses during laminar flow. 
The correction options are:

 l Use Adjusted Turbulent K Factor Method (ATKF) - derived from the Crane hydraulic hand-
book (Crane 1988).

 l Also Apply in Turbulent Region
 l Use Improved Method

 l Use Non-Newtonian to Newtonian Pipe Friction Ratio Multiplier

Modifying Losses for Fittings and Junctions Interface

The options listed above to modify losses at fittings and junctions can be found on the Laminar 
and Non-Newtonian Corrections panel in the Fluids Properties group of the Analysis Setup, as 
shown in Figure 1 below.
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Figure 1: Options to modify fitting and junction losses on the Laminar and Non-Newtonian Cor-
rections panel

These corrections are off by default and "Apply Corrections" must be selected to access them. 
Users can select which correction method is applied and can select which junction types the loss 
model will be applied to. Fathom Default can be selected at any time to reset the selected junc-
tion types.

Non-Newtonian to Newtonian Pipe Friction Ratio Multiplier

One approach to modeling losses associated with fittings and junction losses is to assume that 
the ratio of those losses in a non-Newtonian and Newtonian fluid is equivalent to the ratio of pipe 
friction in a non-Newtonian and Newtonian fluid. One can write:

This approach uses the pipe friction at the adjacent upstream pipe and the uncorrected loss 
factor in a Newtonian fluid to model the losses associated with the fitting or junction for a non-
Newtonian fluid.

Related Topics

Fluid Properties Group 85

- 122 -



Analysis Setup Overview

Fluid Panel 86
Viscosity Model Panel 94
Heat Transfer/Variable Fluids Panel 118
SSL Module Fluid Properties Group 130
Adjusted Turbulent K Factor Method (ATKF) 123
Improved ATKF Method 126
Note about Laminar Corrections for Fittings 129
3-K (Darby) Method 268

Related Blogs

Applying the Improved ATKF Method for Laminar and Non-Newtonian Flow

Adjusted Turbulent K Factor Method (ATKF)
Crane (1988) includes an equivalence between equivalent length methods and K-factor on the 
nomograph chart on page A-30. This nomograph is based on theory as discussed below.

The basic law of pressure drop for friction factor is

(1)

For K-factors the pressure drop is given by

(2)

From equations 1 and 2 it can be seen that there is an equivalence between f*L/D and K.             

The equivalent length method works by adding to the physical length as follows:

(3)

Hence the pressure drop due to the methods can be related as follows:
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(4)

An appropriate equivalent length can be determined from standard AFT Fathom K-factor data by 
looking at large Reynolds number and hence fully turbulent conditions

(5)

And finally a general K-factor which is based on equivalent length can be found in the following:

(6)

To apply the method, take the AFT Fathom K-factors (Kturb) and multiply them by the relevant 
pipe friction factor, f, at actual conditions (and Reynolds number) and divide them by the tur-
bulent friction factor, fturb, evaluated at very large Reynolds number.             

Improved ATKF Method

For the Improved ATKF method, the turbulent friction factor in equation 6 is is replaced with the 
turbulent friction factor calculated for commercial steel at very large Reynolds numbers,which is 
about 0.023 for a roughness of 0.0018 in. This allows the adjusted K factor to be independent of 
pipe roughness in the laminar flow region so that it more closely mimics the expected behavior 
for the 3K method from Darby and the equivalent length method.

Comparison of Equation 6 to Published Data 

A study was performed to evaluate how Equation 6 compares to published data (Wood 2012). A 
comparison for a 10 foot long, 2 inch in diameter pipe flowing water was performed with the fol-
lowing:

 1. No fittings in the pipe                     
 2. Fittings of 12 elbows of 1.5 r/D with a total K of 3.17 but no corrections (this is the way 

standard AFT Fathom works)                     
 3. Darby 3-K method for 12 elbows (see Darby, 2001, pp.209)                     
 4. Equivalent length of 12 elbows with Leq/D = 16 (see Darby, 2001, pp.209)                     
 5. Use Equivalent Length in Pipe Diameters (L/D) Derived From K-Factors, Eq. 6                     
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Figure 1 shows the results on a log-log plot. One would not expect the first case to match the oth-
ers as no fittings were included. Hence the head gradient was less than the other cases. 
However, Case 1 does illustrate how Case 2 works in the standard AFT Fathom. Case 2 agrees 
with Cases 3-5 at high Reynolds Number but agrees with Case 1 at low Reynolds number. This 
is a result of using turbulent, high Reynolds Number K-factors for low Reynolds Number applic-
ations.

Cases 3, 4 and 5 all agree well throughout the entire range of Reynolds Numbers. There is some 
small discrepancy at high Reynolds Number which is merely a result of various reference dif-
ferences over the exact pressure loss through a 1.5 r/D elbow.             

The conclusion from Figure 1 is that the Equation 6 method allows reliable adjustment of tur-
bulent pressure loss data for fittings and junctions to laminar applications.

Figure 1: Log-log plot of dimensionless head gradient vs. Reynolds number for various fitting loss 
models

Related Topics

Laminar and Non-Newtonian Corrections Panel 121
Improved ATKF Method 126
Note about Laminar Corrections for Fittings 129
3-K (Darby) Method 268

Related Blogs

Applying the Improved ATKF Method for Laminar and Non-Newtonian Flow
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Improved ATKF Method
For commercial steel pipe and pipes with a similar roughness, it has been shown that the equi-
valent length, Darby 3-K, and Adjusted Turbulent K Factor (ATKF) methods will all produce sim-
ilar results in the laminar flow region (see Adjusted Turbulent K Factor (ATKF) Method).

However, this is not the case when the pipe roughness varies significantly from that of com-
mercial steel. At different roughness values the predicted head loss with the original ATKF 
method varies inversely with pipe roughness, so that smoother pipes will experience higher head 
loss in the laminar regime as is shown in Figure 1. The Darby 3-K method shows no dependence 
on pipe roughness in the laminar regime, as is shown in Figure 2. It would be expected that head 
loss in the laminar regime would behave as predicted by the 3-K method, based on the fact that 
the laminar friction factor is independent of pipe roughness.
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Figure 1: Head Gradient calculated with the original ATKF method at different roughness values, 
showing differences in the laminar region
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Figure 2: Head Gradient calculated with the 3-K method at different roughness values, showing no 
differences in the laminar region

To remove the dependence on pipe roughness in the ATKF method, the Improved ATKF 
method uses a fixed turbulent friction factor value calculated for commercial steel pipe (rough-
ness 0.0018 in) at very large Reynolds numbers. The Improved ATKF method can be written as 
follows, replacing fturb with the reference turbulent friction factor, fturb,ref :

With the Improved ATKF factor it can be seen that the head loss is no longer dependent on pipe 
roughness (Figure 3).

Figure 3: Head gradient calculated with the Improved ATKF method at different roughness values

Related Topics

Laminar and Non-Newtonian Corrections Panel 121
Adjusted Turbulent K Factor Method (ATKF) 123
Note about Laminar Corrections for Fittings 129
3-K (Darby) Method 268
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Related Blogs

Applying the Improved ATKF Method for Laminar and Non-Newtonian Flow

Note about Laminar Corrections for Fittings
There is ambiguity in the literature about how to calculate fitting pressure loss for fittings. Here is 
a quick summary of different views:

No Laminar Correction Required

Crane (1988) suggests no correction is required. On pages 2-8 through 2-11 Crane discusses 
this. Worked examples 4-7, 4-8 and 4-9 use this assumption. 

This assumption is the same as method 2 in the ATKF comparison section and Figure 1 (in the 
aforementioned topic), and is consistent with how AFT Fathom has always performed laminar 
calculations. This assumption is available by merely not applying the laminar methods discussed 
in this chapter.

Laminar Correction is Required

Publications such as Darby (2001) discuss the necessity for laminar corrections for fitting K-
factors. On pages 209-214 “2-K” and “3-K” methods are discussed that purport to cover the 
entire range of Reynolds number.

Based on Equation 6 and Crane’s (1988) nomograph of page A-30 a laminar correction based 
on equivalent length methods can be applied. This gives similar pressure drop results as the 3-K 
method and is available through the Adjusted Turbulent K Factor method.

Low Reynolds Number Flow

In addition to the discussion above, there is a separate debate over whether flow at very low 
Reynolds numbers (less than 100) should be treated separately when determining if corrections 
are needed for fittings and losses. There are conflicting CFD studies and lab tests showing that 
corrections are needed, or are not needed. For additional details please see the below journal 
articles:

 l No corrections needed at low Re
 l Liou, R. J., et.al,  “Numerical Analysis of Steady Flow in a 90-deg Circular Section 

Bend”,  J. Eng. Mech., v. 114 (1988), p. 1871.
 l Berger, S. A., et.al, “Flow in Curved Pipes”, Ann. Rev. Fluid Mech., v. 15 (1983), p. 

461.
 l Corrections needed at low Re
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 l Edwards, M. F., et.al,  “Head Losses in Pipe Fittings at Low Reynolds Numbers”, 
Chem. Eng. Res. Des., v. 63, (Jan 1985), p. 43.

 l Kittredge, C. P. and Rowley, D. S., “Resistance Coefficients for Laminar and Tur-
bulent Flow Through One-Half-Inch Valves and Fittings”, Trans. ASME, v. 79, 
(Nov. 1957), p. 1759.

Related Topics

Laminar and Non-Newtonian Corrections Panel 121
Adjusted Turbulent K Factor Method (ATKF) 123
Improved ATKF Method 126
3-K (Darby) Method 268

Related Blogs

Applying the Improved ATKF Method for Laminar and Non-Newtonian Flow

SSL Module Fluid Properties Group
(SSL Module Only) When the Settling Slurry (SSL) Module is activated on the Modules panel, 
the items in the Fluid Properties Group change to allow slurry physical property calculation.

Engineers who are new to slurry calculations may not recognize some of the properties in the fol-
lowing panels. These properties all relate to the theory of slurry calculations, which is discussed 
in the Slurry Calculation Methods section.

 l Carrier Fluid panel - Define the Carrier Fluid Properties
 l Solids Definition panel - Define the Slurry Calculation Method and Solids Specifications 

such as M (Stratification Ratio Exponent), Terminal Velocity Parameter, density, d50, and 
d85

 l Slurry Definition panel - Define the Slurry Model and Slurry Properties

Related Topics

Fluid Properties Group 85
Fluid Panel 86
Viscosity Model Panel 94
Heat Transfer/Variable Fluids Panel 118
Laminar and Non-Newtonian Corrections Panel 121
SSL - Settling Slurry 560
Carrier Fluid Panel 131
Solids Definition Panel 132
Slurry Definition Panel 135
SSL Nomenclature 571
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Carrier Fluid Panel
(SSL Module Only) On the Carrier Fluid panel, users select and define the carrier fluid for the 
slurry. The available options are:

 l Basic (Water)
 l Advanced

Basic (Water) Carrier Fluid

The Basic (Water) option uses the Water (liquid) fluid from the AFT Standard fluid library as the 
carrier fluid and treats all pipes as having constant slurry properties (Figure 1).

Specify the water temperature for the slurry property calculation.

Figure 1: Carrier Fluid panel with the Basic (Water) carrier fluid option selected

Advanced Carrier Fluid

The Advanced option  allows the user to specify any fluid as the carrier fluid, and will allow the 
slurry properties to vary among pipes.

The Carrier Fluid panel looks very similar to the Fluid panel when the SSL module is not activ-
ated. Specify the fluid, its temperature (and pressure in some cases), and fluid property variation 
on this panel. Users can access data from all fluid libraries. The User Specified Fluid option is dis-
abled because it is not saved in a library. Custom fluids should be saved to a library and selected 
using the User Library Fluid option.
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Figure 2: Carrier Fluid panel with the Advanced option selected

Related Topics

SSL - Settling Slurry 560
SSL Module Fluid Properties Group 130
Solids Definition Panel 132
Slurry Definition Panel 135
SSL Nomenclature 571

Solids Definition Panel
(SSL Module Only) On the Solids Definition panel, users define the Slurry Calculation Method 
and Solids Specifications. These inputs are the same for both the Basic (Water) and Advanced 
carrier fluid options.

Override options are provided for a number of parameters that allows users to modify data pulled 
from libraries should modeling requirements need this.
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Figure 1: Solids Definition panel when Detailed Slurry Calculation Method and Calculated M are 
selected

Slurry Calculation Method

There are three calculation methods available to model slurry. Each method requires different 
amounts of input data resulting in the use of different calculations. These calculations are 
described in the Slurry Calculation Methods section.

 l Minimal Method - Used in the preliminary design phase where only rough data are avail-
able. The solids density, sliding friction coefficient, and solids concentration are the only 
parameters needed. However, due to the minimal data the calculations should only be 
used for early stage approximations because it often over-predicts losses. This is a con-
servative method that assumes a fully-stratified sliding bed.

 l Simplified Method - Additional information is required and gives a better solution. This 
method requires the solids density, d50 particle size, a user-specified M exponent, and 
the solids concentration. This method assumes heterogeneous flow with suspended 
particles. This is a more accurate model than the Minimal method because it accounts for 
more slurry definition.

 l Detailed Method - The default and provides the most rigorous solution methodology. The 
solids density, d50 particle size, terminal velocity parameter, and the solids concentration 
are required. Additionally, if the M exponent is to be calculated, the d85 particle size is 
also required. As with the Simplified Method, this method also assumes heterogeneous 
flow with suspended particles.
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Solids Specifications

In the Solids Specification area, select from the following options for solids:

 l No Solids Added - The model will run using the carrier fluid without any solids, no further 
input is required.

Note: The No Solids Added option is only compatible with the Newtonian Slurry Model 
option on the Slurry Definition panel. The other Slurry Models imply that solids 
are present in the fluid, therefore, the Slurry Definition panel will be undefined 
until the Solids Specifications is changed to one of the options below.

 l User Specified Solids Added - Define the solids using the Solid Properties fields.
 l From Library - Use solids already defined in the Solids Library. Note no default solids lib-

rary is provided by AFT, library items must be defined first in the Library Manager to be 
available here.

Solids Properties

By selecting User Specified Solids Added, the Solids Properties fields become available to 
define the solids. Depending on the Slurry Calculation Method selected at the top of the Solids 
Definition panel, certain fields are required:

 l Minimal
 l Density

 l Simplified
 l User Specified M (Stratification Ratio Exponent)
 l Density
 l d50

 l Detailed
 l M (Stratification Ratio Exponent)
 l Terminal Velocity Parameter
 l Density
 l d50
 l d85 - if Calculated M (Stratification Ratio Exponent) is selected

The M (Stratification Ratio Exponent) is a parameter in the stratification ratio equation. The 
user can allow AFT Fathom to calculate M based on best available methods, or input M directly. 
The process of estimating M from recorded data is discussed elsewhere.

The Terminal Velocity Parameter must be entered when using the Detailed calculation 
method. This can be entered as either a Shape Factor (K) or the ratio of the particle’s terminal 
velocity (Vt) to that of a sphere (Vts), designated as Vt / Vts (Xi). If a Shape Factor is entered, it is 
used in conjunction with the graph shown in Wilson, et al. 2006, on page 47, to obtain a value for 
Xi. Typical shape factors are given in Wilson, et al, 2006, on page 46 where K = 0.26 for sand.
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In the lowest area, enter the required values for mean density of the solid particles, d50 (mass-
median particle diameter) and d85 (diameter for which 85% by mass of the particles are finer).

4-Component Slurry Model

The 4-Component Slurry Model requires a d100 and Particle Size Distribution.

Related Topics

SSL - Settling Slurry 560
SSL Module Fluid Properties Group 130
Carrier Fluid Panel 131
Slurry Definition Panel 135
SSL Nomenclature 571
Velocity in pipe X is less than the deposition velocity 788

Slurry Definition Panel
(SSL Module Only) The Slurry Definition panel allows selection of the Slurry Calculation 
Method, as well as input of solids concentration relative to the carrier fluid and estimation of bulk 
slurry properties, as shown in Figure 1.
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Figure 1: Slurry Definition panel when Detailed Slurry Calculation Method and User Specified Solids 
Added are selected

Slurry Calculation Method

There are three calculation methods available to model slurry. Each method requires different 
amounts of input data resulting in the use of different calculations. These calculations are 
described in the Slurry Calculation Methods section.

 l Minimal Method - Used in the preliminary design phase where only rough data are avail-
able. The solids density, sliding friction coefficient, and solids concentration are the only 
parameters needed. However, due to the minimal data the calculations should only be 
used for early stage approximations because it often over-predicts losses. This is a con-
servative method that assumes a fully-stratified sliding bed.

 l Simplified Method - Additional information is required and gives a better solution. This 
method requires the solids density, d50 particle size, a user-specified M exponent, and 
the solids concentration. This method assumes heterogeneous flow with suspended 
particles. This is a more accurate model than the Minimal method because it accounts for 
more slurry definition.

 l Detailed Method - The default and provides the most rigorous solution methodology. The 
solids density, d50 particle size, terminal velocity parameter, and the solids concentration 
are required. Additionally, if the M exponent is to be calculated, the d85 particle size is 
also required. As with the Simplified Method, this method also assumes heterogeneous 
flow with suspended particles.

Slurry Definition

The Concentration Type is used to specify a value in the Amount Solids Added field. The 
available options for Concentration Type are:

 l Grams per Liter of Mixture
 l Volume Fraction
 l Mass Fraction
 l Solids Ratio (M-solids/M-liquid)

There are a few Slurry Model options to choose from. These options determine the calculations 
used in the Solver.

 l Newtonian - Functionally disables most of the SSL module calculations and preserves 
only the viscosity properties of the fluid in the model.
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Note: The No Solids Added option from the Solids Definition panel is only compatible 
with the Newtonian Slurry Model option. If you have already specified solids on 
the Solids Definition panel, you must select one of the other Slurry Models 
below.

 l Settling Slurry - Wilson, Addie, Clift - Default option, applies slurry calculations from 
Wilson.

 l 4-Component Model - GIW Industries Inc. - A more complex model that takes into con-
sideration the contribution of different size particles in the slurry flow.

The Sliding Friction Coefficient (μs) is the coefficient of mechanical sliding friction between 
the granular mass and the boundary - where the boundary is where the motion takes place 
between the mass and a rigid boundary, i.e. the pipe wall. As  the Sliding Friction Coefficient 
increases, so does the friction and thereby the pressure drop through the pipe. This field is only 
available when the Minimal Slurry Calculation Method is selected at the top of the panel.

The Bed Concentration (Cvb) is an optional parameter and is only used to determine the actual 
settling velocity (Vs) shown in the output. These calculations are described in Wilson (1986) and 
are functions of the pipe diameter, particle size (d50), particle density and relative concentration. 
If no value is entered for this parameter then a default of 0.60 is used. The maximum value of 
these settling velocities (Vs) is denoted Vsm and is the usual parameter of interest in designing a 
system to avoid operating with a stationary bed. This field is only available when the Simplified 
and Detailed Slurry Calculation Methods are specified at the top of the panel.

Deposition Velocity (Vsm)

The Deposition Velocity (Vsm) can be determined using one of the options below. This is useful 
when the calculation method yields a slightly different value than, say, test results.

 l Nomograph - Equation Limited - This option is the default and uses the nomograph 
from Wilson (1986) page 111. The nomograph is noted to be conservatively high by 
Wilson, so an equation that calculates the max Vsm is used to limit the value of Vsm.
The results calculated from the nomograph will be checked against Equation 5.11 from 
Wilson (1986) as is shown below. If the value from the nomograph exceeds Vsm,max cal-
culated from Equation 5.11, then the Vsm,max from Equation 5.11 will be used instead.

Note: If the Vsm is calculated as a negative value using Equation 5.11 from Wilson then the 
Vsm will be displayed as 0 in the Output. If the Vsm is shown as 0, the inputs for the fluid 
and solid should be verified, and the user should consider calculating the Vsm using a 
separate method.
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 l Equation Only - This option will cause the Vsm to be calculated solely using Equation 
5.11.

 l User Specified - This option allows the user to directly specify Vsm.

As Wilson describes there are times where operating at a velocity lower than Vsm is eco-
nomically attractive and is without a stationary bed. These cases include a system where the 
solid concentration at the desired operating point is very different than that at the Vsm conditions. 
Wilson points out that this is rarely the case, and so the use of Vs instead of Vsm should be done 
with caution.

Related Topics

SSL - Settling Slurry 560
SSL Module Fluid Properties Group 130
Carrier Fluid Panel 131
Solids Definition Panel 132
SSL Nomenclature 571

Pipes and Junctions Group
The Pipes and Junctions Group in Analysis Setup has one item: the Pipes and Junctions panel. 
When the Pipes and Junctions group has a green checkmark next to its name, all pipes and junc-
tions are fully defined. When a red exclamation point is next to its name, there is at least one pipe 
or junction that is undefined. The model cannot run until all pipes and junctions are defined.

Related Topics

Analysis Setup Overview 78
Modules Group 79
Fluid Properties Group 85
Transient Control Group 140
Goal Seek and Control Group 146
Steady Solution Control Group 159
Environmental Properties Group 166
Cost Settings Group 168
Automatic Sizing Group 171
Miscellaneous Group 172
Pipes and Junctions Panel 138

Pipes and Junctions Panel
The Pipes and Junctions panel within Analysis Setup displays the status of pipes and junctions 
within the model. 
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Figure 1: Default state of the Pipes and Junctions panel

This panel is made up of three sections:

 l Undefined Pipes
 l Undefined Junctions
 l Undefined Properties

The Undefined Pipes and Undefined Junctions sections displays the number and name of all 
pipes and junctions, respectively, that are not fully defined. If all pipes and junctions in the model 
are fully defined, the messages "All Pipes Are Defined" and "All Junctions Are Defined" will be 
displayed. Clicking on the undefined pipe or junction will display the undefined properties in the 
list below, as shown in Figure 2. All undefined data for all objects can be saved to the file or 
copied to the clipboard. Any undefined object's Properties window can be launched by double-
clicking the object's name in the list to finish defining the object.

Figure 2: Pipes and Junctions panel with one pipe undefined and undefined properties displayed

Related Topics

- 139 -



Fundamental Modeling Concepts

Pipes and Junctions Group 138

Transient Control Group
The Transient Control Group in Analysis Setup is where settings pertaining to a transient sim-
ulation using the XTS Module are managed. The Transient Control Group will have a green 
checkmark next to its name when the XTS Module is disabled (Steady Only mode) or when all 
required fields on the Simulation Duration panel are defined. The model cannot run until the Tran-
sient Control Group has a green checkmark.

Related Topics

Analysis Setup Overview 78
Modules Group 79
Fluid Properties Group 85
Pipes and Junctions Group 138
Goal Seek and Control Group 146
Steady Solution Control Group 159
Environmental Properties Group 166
Cost Settings Group 168
Automatic Sizing Group 171
Miscellaneous Group 172
XTS - Extended Time Simulation 587
Simulation Duration Panel 140

Simulation Duration Panel
(XTS Module Only) When the XTS module is activated, the Transient Control group appears in 
Analysis Setup. Whether the XTS module is enabled (Transient mode) or disabled (Steady Only 
mode), the Simulation Duration panel can be opened and modified.
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Figure 1: Simulation Duration panel fully defined with example values

The transient simulation is controlled by information the user enters in the Simulation Duration 
panel of the Transient Control group of the Analysis Setup window. This panel is used to specify 
the start and stop time of transient simulation, the size of the time step, and the frequency of the 
data saved to the transient output file.

Also available is Forward Difference and Central Difference options for Finite Tank Liquid Level 
Adjustments. If finite tank reservoirs are not used in the model, then there is no difference 
between the two options. However, there is an impact when one or more finite tanks do exist in 
the model.

Related Topics

XTS - Extended Time Simulation 587
Transient Control Group 140
Finite Tank Liquid Level Adjustments 141
Transient data did not extend to Stop Time at Junction X 796
System Life specified in Cost Settings is different from the XTS time 794

Finite Tank Liquid Level Adjustments
(XTS Module Only) The Simulation Duration panel allows one to set forward and central dif-
ference options. The forward and central difference options are only relevant when finite tanks 
are modeled. They relate to what liquid levels are used in the tank for each time step calculation. 
If the assumed time step is small enough, then the two methods yield virtually the same results. 
However, as the time step is increased, the central difference method is much more accurate. 
The drawback is that the central difference method is iterative and takes more computation time. 
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Forward Difference Method

The forward difference method solves the pipe system as if all tank levels remain at the same 
value as the beginning of the time step. Since the liquid level is known at the beginning of the 
time step, no time-based iterations are required. (The iterations for flow and pressure common to 
steady-state modeling still occur).

Once the solution is complete for the time step, the solved flowrates are used to update the tank 
liquid level for the next time step. Figure 1 depicts how this works.

Since in reality the tank level changes during the time step, precision is lost by using the liquid 
level at the beginning of the time step. As discussed earlier, making the time steps shorter helps 
alleviate this problem.

 
Figure 1: Forward difference method for time calculation assumes liquid level stays constant during 

each time step, allowing a direct calculation for each time

Central Difference Method

The central difference method solves the pipe system using tank liquid levels which represent 
the average over the time step (see Figure 2). Since the liquid level changes during the time 
step, it is more accurate to use the average over the time step. However, the difficulty is that the 
average is taken between the liquid level at the beginning and end of the time step and, while the 
liquid level is known at the beginning, it is not known at the end. That is what we are trying to 
solve for. Hence the transient solution must assume a liquid level at the end of the time step and 
iterate on that value until convergence.
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Figure 2: Central difference method for time calculation uses average liquid level during time step 

for calculation, requiring iteration for each time

There are several iteration control parameters needed by the central difference method, and 
these are input in the Simulation Duration panel(Figure 3). The central difference method 
attempts to converge on the liquid height at the next time step for each finite tank. 

Relative and Absolute Tolerance

The relative and absolute tolerance inputs influence when AFT Fathom concludes it has con-
verged on the new liquid height. Both of these criteria are applied, and if either one is satisfied 
then convergence has occurred. 
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Figure 3: Iteration control parameters are required for the central difference method

The relative criteria is how much the liquid level calculation changes between iterations on a rel-
ative, or percentage basis. The absolute criteria relates how much the liquid level changes 
between iterations on an absolute basis of height. Hence the absolute tolerance has units of 
length associated with it.

The default values for relative tolerance is 0.00001, and the absolute tolerance is 0.0001 feet. 

Relaxation

The relaxation applies to how fast AFT Fathom allows the liquid level to change during time 
steps. See the Iterations panel topic for a general discussion of relaxation.

Relaxation values must be greater than zero and less than or equal to 1. By default a value of 1 is 
used. This in fact means no relaxation. 

Setting values closer to zero will improve convergence but slow the calculation. Values less than 
0.01 should never be used unless directed by Applied Flow Technology.

Caution: The iteration control parameters for central difference time calculations should not 
be changed by the user unless they clearly understand their use or it has been recom-
mended by Applied Flow Technology support. If changed indiscriminately, there is a 
danger of incorrect results being generated.

Maximum Iterations

This is the maximum number of attempts allowed for each time calculation iteration. If it reaches 
this value, the transient solution will stop due to failure to converge.
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Changing Parameters During the Run

The Solution Progress window displays while the transient simulation is being performed. If a 
central difference method is used, because of its iterative nature the simulation can get stuck. If 
this happens then the simulation can be paused and Central Difference iteration parameters 
changed (such as reducing the relaxation parameter). With forward difference there are no para-
meters to change and hence this option is not available.

Output Values Displayed with Forward Difference

One advantage of the forward difference method is that it is easier to reconstruct the calculation 
for a given time step. For example, assume you want to run a separate steady-state AFT Fathom 
model to represent a particular time step calculation.

To do so, just look at the reservoir levels for that time step, enter these as the reservoir levels in 
the steady-state model, and all results should be the same as in the transient solution.

Output Values Displayed with Central Difference

When using the central difference method a somewhat strange result is that the reservoir liquid 
levels displayed in the output are never directly used to solve any time step (except for the initial 
“time zero” step). As discussed earlier, each time step is solved using an average liquid level. 
But this average liquid level is not displayed in the output. Instead, the liquid levels upon which 
the average was derived are displayed. This is depicted in Figure 3 where the liquid levels in the 
output do not correspond directly with the assumed liquid level for calculation. The squares rep-
resent the actual liquid level output values for central difference. 

If for some reason you would like to construct a steady-state model to represent a time step from 
a transient simulation which used central difference, you must enter reservoir liquid levels which 
are the average of the desired time step and the previous time step.

Related Topics

Simulation Duration Panel 140
XTS Module 
Extended Time Simulation Mod-
ule
An optional add-on module to AFT 
Fathom which allows users to sim-
ulate system transient behavior.
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Goal Seek and Control Group
(GSC Module Only) The GSC module is controlled through the Goal Seek and Control items in 
the Analysis Setup window. In these panels, the user specifies all of the system variables, as 
well as the desired goals. As the user adds variables and goals to the model, AFT Fathom will 
display a symbol beside the pipes and junctions that have variables or goals applied to them. 
The default is a V for variables, and a G for goals. The goal symbol is not displayed next to 
objects that are part of a group goal.

The Goal Seek and Control Group has three panels:

 l Variables panel - Allows users to define and apply variables to be used for the GSC run.
 l Goals panel - Allows users to define and apply goals to be used for the GSC run.
 l Numerical Controls panel - Allows GSC search engine parameters to be adjusted for 

troubleshooting purposes.

Related Topics

Analysis Setup Overview 78
Modules Group 79
Fluid Properties Group 85
Pipes and Junctions Group 138
Transient Control Group 140
Steady Solution Control Group 159
Environmental Properties Group 166
Cost Settings Group 168
Automatic Sizing Group 171
Miscellaneous Group 172
GSC - Goal Seek & Control 547
Variables Panel 146
Goals Panel 152
Numerical Controls Panel 158

Variables Panel
(GSC Module Only) The Variables panel is where variables are defined and applied for use with 
the GSC module (Figure 1). Variables are input parameters that the GSC module will change to 
achieve the user's desired goals. Generally, there must be one variable applied for each goal 
that is applied. 
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Figure 1: GSC Variables are input parameters to be automatically varied

Types of Variables

All variables are junction or pipe parameters. The variables that are available for each object 
type are shown in Table 1. There are over 30 types of variables.
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Table 1: List of object types with available variables 

Object Type Variables Restrictions

Pipes Design Factor

Friction

ID Reduction (Scaling)

Insulation Thickness

 

Assigned Flow Flow

Elevation

Temperature

 

 

Only with 
Heat Transfer

Assigned Pres-
sure

Pressure

Elevation

Temperature

 

 

Only with 
Heat Transfer

Branch Imposed Flow  

Check Valve Loss Value  

Control Valve Control Setpoint  

General Com-
ponent

Loss Factor  

Heat 
Exchanger

Loss Factor

Heat Rate

Discharge Temperature

Temperature Rise

Enthalpy Rise

Heat Transfer Area

Overall Heat Transfer Coefficient

Secondary Flow

Secondary Inlet Temperature

 

Only with 
Heat Transfer

Only with 
Heat Transfer

Only with 
Heat Transfer

Only with 
Heat Transfer

Only with 
Heat Transfer

Only with 
Heat Transfer

Only with 
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Heat Transfer

Only with 
Heat Transfer

Orifice Diameter/Area

Loss Factor

Elevation

 

Pump Speed

Flow

Head Rise

Impeller Size

Control Setpoint

 

Relief Valve Loss Value  

Reservoir Liquid Level

Surface Pressure

Temperature

 

 

Only with 
Heat Transfer

Screen Open Area

Loss Factor

 

Spray Dis-
charge

Spray Area

K (Fire Sprinkler)

Number Sprinklers

Number Sparger Holes

Elevation

 

Three-Way 
Valve

Open Percentage  

Valve Loss Value

Elevation (Exit Valves)

 

Only for Exit 
Valves

Creating and Deleting Variables

To create a variable, click the New Variable button on the Variables panel (Figure 1). This will 
insert a new item into the variable list. After the variable has been added, the variable data is 

- 149 -



Fundamental Modeling Concepts

defined by entering the necessary data in each of the data columns.

Variables may also be added by duplicating an existing variable, then modifying the data for the 
new variable. To duplicate a variable, select the variable to be duplicated from the variable list, 
and click the Duplicate Variable button.

To delete a variable, select the variable by clicking on the appropriate row in the variable list. 
After selecting the variable to be deleted, click the Delete Variable button. If you want to delete all 
of the variables in the list, click the Delete All Variables button.

Defining Variables

For each variable the following settings can be defined:

 l Object type - The Object Type defines whether the variable applies to a pipe or a junc-
tion.

 l Junction type - The Junction Type column is used to define the type of junction to which 
the variable is being applied. 

 l Object number and name - The specific junction to vary is selected in the Junction Num-
ber and Name column. The list will only display junctions of the type selected in the Junc-
tion Type column.

 l Variable parameter - Each junction type has a specific set of parameters that are avail-
able as variables (Table 1). The list will only display parameters that are available for the 
junction type selected in the Junction Type column.

 l Linking variables - The Link To column is used to force a variable on multiple junctions 
of the same type to solve to the same value. 

An example where this would be desirable would be when using pump impeller 
trim as a variable for several pumps in parallel. It is often desirable to solve for a 
condition where the pump impeller trim is the same for all of the pumps. This can 
be accomplished by using variable linking. A pump impeller trim variable would be 
defined for each of the pumps. Then, one of the pumps would be selected as the 
basis pump, which just means no linking is specified for this pump. The other 
pumps would be linked to the basis pump by selecting the basis pump from the list 
in the Link To column.

 l Variable bounds - During a goal search, the GSC module will modify the values for the 
defined variables. Sometimes it is helpful to specify upper and lower bounds for variables 
to provide logical extremes during the goal search. Some examples of logical bounds that 
can be applied would be lower and upper bounds on valve open percentage of 0% and 
100%, respectively.

Note that bounds can have engineering units, but these units are not displayed. It 
is assumed the units are the same as the junction input parameter Properties Win-
dow.
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Organizing Content

The lower left corner of the panel features options for rearranging and selecting variables and 
goals. All will select all available variable or goals. None will deselect all variables or goals. Invert 
will invert which variables and goals are selected. There are also options to show all variables or 
goals and to show only the applied variables or goals. The goals and variables can also be 
reordered using the turquoise arrows to change their position.

The Same As Parent button allows the variables, goals, numerical control, or all of the para-
meters (in regards to the Goal Seek and Control group) of the parent scenario to be copied down 
to the child scenario.

Reviewing Pipe/Junction Data

Data for the selected objects in the Variables panel can be reviewed and edited without having to 
close the Analysis Setup window.

 l Reviewing object input data - If you would like to see the input data for the junction 
selected as a variable, press the right mouse button on the far left column in the Variables 
table. The inspection window will display, showing you the input data.

 l Editing object input data - Similar to the inspection feature just described, you can 
open the Pipe or Junction Properties window by double-clicking the far left column in the 
Variables table. From there you can change any data desired.

Applying Variables

Once a variable has been created, the user must specify if a variable is to be used when the 
GSC module is run. To apply a variable, select the checkbox in the Apply column.

Using the Apply feature allows the user to define multiple variables that can be used in alternate 
cases or analyses. Any of the variables that are not being used for a particular analysis can 
remain in the list for later use. Click the Apply checkbox for the variables that are to be used in 
the current analysis.

Related Topics

GSC - Goal Seek & Control 547
Goal Seek and Control Group 146
Goals Panel 152
Numerical Controls Panel 158

GSC Module
Goal Seek and Control Module
An optional add-on module to AFT 
Fathom which allows users to per-
form multi-variable goal seeking 
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and simulate system control func-
tions.

Goals Panel
(GSC Module Only) The Goals panel is where goals are defined and applied for use with the 
GSC module (Figure 1). Goals are output values you would like to achieve. The GSC module 
adjusts the applied variables until the applied goals are met.  Generally there should be one goal 
applied for each applied variable.

Figure 1: GSC Goals are output parameters to be achieved by changing the variables

Types of Goals

The GSC module offers over 150 goals applied to pipes, junctions or groups of pipes and/or junc-
tions. Table 1 lists all of the types of goals.
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Table 1: List of object types with available goals

Object Type Goals Restrictions/Comments

Pipe Energy Gradeline

Head Gradient

Head Loss

Heat Rate Into 
Pipe*

Hydraulic Gradeline

Mass Flow Rate

Pressure Drop Fric-
tion

Pressure Gradient

Pressure Stag-
nation

Pressure Static

Pressure Static 
Maximum

Pressure Static Min-
imum

Temperature*

Temperature Insu-
lation #1 Surface*

Temperature Insu-
lation #2 Surface*

Temperature Insu-
lation #3 Surface*

Temperature Loss*

Temperature Outer 
Surface*

Velocity

Volumetric Flow 
Rate

Wall Temperature*

 

 

 

*Only With Heat Transfer

 

Area Change Energy Gradeline  
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Bend

Check Valve

General Com-
ponent 

Jet Pump

Orifice

Relief Valve

Screen

Valve

Venturi

Volume Balance

Hydraulic Gradeline

Mass Flow Rate

Pressure Stag-
nation

Pressure Static

Temperature*

Volumetric Flow 
Rate

 

 

 

 

*Only With Heat Transfer

 

Branch

 

Energy Gradeline

Hydraulic Gradeline

Mass Flow Rate*

Pressure Stag-
nation

Pressure Static

Temperature**

Volumetric Flow 
Rate*

*Net Flow Rate

**Only With Heat Transfer

Assigned Flow Energy Gradeline

Hydraulic Gradeline

Pressure Stag-
nation

Pressure Static

 

Assigned Pres-
sure

Reservoir

Mass Flow Rate 
Net into Jct*

Vol. Flow Rate Net 
into Jct*

*Net Flow Rate

Control Valve Cv*

Energy Gradeline**

Hydraulic 
Gradeline**

*If Open Percent Data Exists

**Only for FCV

***Only for PRV, PSV

^Not PDCV
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Kv*

Mass Flow Rate***

Open Percentage*

Pressure Loss^

Pressure Stag-
nation**

Pressure Static**

Temperature^^

Volumetric Flow 
Rate***

^^Only with Heat Transfer

Dead End Pressure

Hydraulic Gradeline

 

Heat Exchanger Energy Gradeline

Heat Rate In*

Hydraulic Gradeline

Mass Flow Rate

Pressure Stag-
nation

Pressure Static

Temperature**

Volumetric Flow 
Rate

 

*Only with Heat Transfer. For 
non-fixed heat rate 
exchanger models.

 

 

 

 

**Only with Heat Transfer. 
For non-controlled tem-
perature models.

 

Pump % of BEP

Energy Gradeline

Head Rise*

Hydraulic Gradeline

Mass Flow Rate**

NPSH Margin Abso-
lute

NPSH Ratio

Power Overall

 

 

*Only for non-fixed head rise 
pumps

 

**Only for non-fixed flow 
pumps
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Pressure Rise*

Pressure Stag-
nation

Pressure Static

Temperature***

Volumetric Flow 
Rate**

 

 

 

 

***Only with Heat Transfer

 

Spray Discharge Mass Flow Rate 
Out*

Volumetric Flow 
Rate Out*

*Net Flow Rate

Tee or Wye

Three Way Valve

Energy Gradeline

Hydraulic Gradeline

Pressure Stag-
nation

Pressure Static

Temperature*

 

 

 

 

*Only With Heat Transfer

Creating and Deleting Goals

To create a goal, click the New Goal button on the Goals tab. This will insert a new item into the 
goals list. After the goal has been added, the goal data is defined by entering the necessary data 
in each of the data columns.

Goals may also be added by duplicating an existing goal, then modifying the data for the new 
goal. To duplicate a goal, select the goal to be duplicated from the goal list, and click the Duplic-
ate Goal button. 

To delete a goal, select the goal by clicking on the appropriate row in the goal list. After selecting 
the goal to be deleted, click the Delete Goal button. If you want to delete all of the goals in the list, 
click the Delete All Goals button.

Defining Goals

For each goal the following settings can be defined:

 l Goal Type - Select the type of goal to be used from the following:
 l Point Goal  - A point goal is specified when the desired goal can be specified at a 

specific object location in the model.
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 l Differential Goal  - A differential goal is used when the goal value is actually 
determined by the difference in values between two specific object locations. An 
example of a differential goal might be the pressure difference between two loc-
ations in the model.

 l Group Goal  - A Group goal is used when a goal is to be applied to a group of 
objects at the same time. In order to use a Group goal, all of the objects must be 
added to a Group by using the Groups command on the Edit menu.

 l Object Type - Select the type of object to which the goal is to be applied. See the section 
below for further description of the object types.

 l Goal Parameter - Select the type of goal to be applied to the selected object, such as 
pressure, flow rate, or temperature.

 l Criteria - Specify the criteria which is to be met for the specified goal parameter, such as 
equals, greater than or equal, or less than or equal.

 l Goal Value/Units - Specify the value and units for the goal parameter.
 l Object ID - Specify the pipe, junction, or group name to which the goal applies.
 l Object Location - Specify, as appropriate, whether the goal applies to the inlet or outlet 

of the selected object or group.

Organizing Content

The lower left corner of the panel features options for rearranging and selecting variables and 
goals. All will select all available variable or goals. None will deselect all variables or goals. Invert 
will invert which variables and goals are selected. There are also options to show all variables or 
goals and to show only the applied variables or goals. The goals and variables can also be 
reordered using the turquoise arrows to change their position.

The Same As Parent button allows the variables, goals, numerical control, or all of the para-
meters (in regards to the Goal Seek and Control group) of the parent scenario to be copied down 
to the child scenario.

Object Types

For Point and Differential goal types, the object type indicates whether the goal is to be 
applied to a pipe or a junction object. If the goal is to be applied to a junction, the type of junction 
is selected from the list.

For the Group goal type, the user must select between a Group Max/Min or a Group Sum object 
type. 

A Group Max/Min goal allows a single goal to be applied to a group of objects. The GSC mod-
ule applies a Group Max/Min goal by ensuring the final goal value is either greater than or equal 
to (a Min goal) or less then or equal to (a Max goal) the specified value for each object in the 
group. For example, a Group Max/Min goal can be applied to ensure a minimum flow rate out of 
each spray discharge nozzle in a group of nozzles. Group Max/Min goals only work for groups 
where all group members are of the same type (i.e., all pipes or all valve junctions).
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A Group Sum goal is used to set the sum of the goal parameter for all the members in a group 
to a specified value. For example, the Group Sum goal can be applied to set the sum of the volu-
metric flow rates through all of the nozzles in a group of spray discharge nozzles to a particular 
value. Groups used in Group Sum goals can consist of pipes and/or junctions, with junctions of 
different type.

Applying Goals

Once a goal has been created, the user must specify if a goal is to be used when GSC is run. To 
apply a goal, select the checkbox in the Apply column.

Using the Apply feature allows the user to define multiple goals that can be used in alternate 
cases or analyses. Any of the goals that are not being used for a particular analysis can remain 
in the list for later use. Click the Apply checkbox for the goals that are to be used in the current 
analysis.

Reviewing Pipe/Junction Data

Data for the selected objects in the Goals panel can be reviewed and edited without having to 
close the Analysis Setup window.

 l Reviewing object input data - If you would like to see the input data for the junction 
selected as a goal, press the right mouse button on the far left column in the Goals table. 
The inspection window will display, showing you the input data. This feature does not 
work for group goals.

 l Editing object input data - Similar to the inspection feature just described, you can 
open the Pipe or Junction Properties Window by double-clicking the far left column in the 
Goals table. From there you can change any data desired. This feature does not work for 
group goals.

Related Topics

GSC - Goal Seek & Control 547
Goal Seek and Control Group 146
Variables Panel 146
Numerical Controls Panel 158
When Goals Cannot Be Achieved 554
GSC Goal may not be valid. User goal = X. Final goal result = Y. 784

Numerical Controls Panel
(GSC Module Only)

Numerical control of the GSC search engine parameters can be adjusted on the Numerical Con-
trol tab. It is recommended the user avoid changing these parameters unless the user under-
stands their purpose or it has been recommended by AFT technical support.
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Figure 1: Default Numerical Controls panel setup in the Goal Seek and Controls Group

Related Topics

GSC - Goal Seek & Control 547
Goal Seek and Control Group 146
Variables Panel 146
Goals Panel 152

Steady Solution Control Group
The user has control over a number of parameters that influence numerical convergence.

Note: These values should only be changed by experienced users or under advisement by 
the AFT Support Team. Poorly defined Solution Control settings can cause the 
model to converge on an incorrect solution without warning messages.

 l Tolerance panel - The iterative tolerances that define convergence can be defined on this 
panel.

 l Iterations panel - Additional iteration controls that can affect whether or not a model con-
verges, or how quickly it will converge, can be defined here. Most settings on this panel 
will not affect the final result.

 l Temperature Limits panel - Options to limit the temperature results in the Solver when 
heat transfer is enabled.
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Related Topics

Analysis Setup Overview 78
Modules Group 79
Fluid Properties Group 85
Pipes and Junctions Group 138
Transient Control Group 140
Goal Seek and Control Group 146
Environmental Properties Group 166
Cost Settings Group 168
Automatic Sizing Group 171
Miscellaneous Group 172
Tolerance Panel 160
Iterations Panel 163
Temperature Limits Panel 165

Related Blogs

Having model convergence problems? Start here!

Tolerance Panel
The iterative tolerances that define convergence are defined on the Tolerance panel in Analysis 
Setup, shown in Figure 1. These values can be modified for Pressure Tolerance, Flow Rate Tol-
erance, and Temperature Tolerance (when Heat Transfer is enabled).

Figure 1: Tolerance panel in Analysis Setup

An iterative approach is used to obtain pipe flow solutions. When approaching any analysis iter-
atively, a stopping point must be defined. The simplest approach is to stop after a certain number 
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of iterations. However, this either causes uncertain results because the result is still changing, or 
wasted processing time because there are too many iterations.             

A solution is to use iterative tolerance. This tolerance is related to the change between iter-
ations. When this change is smaller than the iterative tolerance, the solution is said to be con-
verged.

Tolerance and Solution Accuracy             

Iterative tolerance does not have any relationship to an engineering tolerance.             

An engineering tolerance is a familiar term to most engineers - it is a permissible limit in vari-
ation of a parameter. A simple example is the length of a steel bar - an engineer might specify 
that this length must be 3 ± 0.01 meters. A steel bar manufactured by this specification is known 
to be within the engineering tolerance of the "true" or desired length. In other words, engin-
eering tolerance describes an accuracy.             

Iterative tolerances do not directly describe an accuracy. Convergence only means that the 
change between iterations was within the specified limit.             

With sound iterative methods, and an appropriately specified iterative tolerance, the iterative 
solution will be close to the true solution. However, even with good settings, the iterative tol-
erance does not define how close the results are to the true solution.             

If there is concern that the results may not be close enough to the true answer, the tolerances 
could be tightened and the results compared. If the results do not change appreciably, an appro-
priate tolerance was likely selected.             

Avoiding False Convergence             

It is important to keep the tolerance at least one order of magnitude smaller (two orders or more 
is recommended) than the relaxation. A false convergence can occur when the change from the 
old value to the new value is small enough to be within the tolerance because it is restricted by 
the relaxation.             

Absolute Tolerance             

Absolute tolerance looks at the absolute change in quantity of a given parameter. If the change 
is smaller than the directly specified value, the parameter is considered converged.             

This approach works equally well for both small and very large values, making iterative solvers 
more likely to find convergence. However, specifying an appropriate absolute tolerance requires 
some knowledge of the true solution. The tolerance should be set 3 or 4 orders of magnitude 
below the solution, if there are near zero flows in the system, this will require a very low tol-
erance.             
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Relative Tolerance             

Relative tolerance, on the other hand, checks the relative change of a given parameter. Each 
change is divided by the number itself, giving a change proportional to the magnitude.    

This approach does not require any knowledge about the true solution, and for that reason is the 
default method.             

Table 1 shows the difference between relative and absolute change while iterating. Notice that 
the absolute change has units, while relative change does not.             

Convergence criteria can also be based on either (or both) absolute or relative change. Table 1 
shows how this is applied.             

Table 1: Example of four tolerance methods for a mass flow rate example. Absolute tolerance = 
0.0005 lbm/s, Relative tolerance = 0.0001 

Iter-
ation #

Mass 
Flow 
Rate 

(lbm/se-
c)

Relative 
Change

Abso-
lute 

Change 
(lbm/se-

c)

Meets 
Abs. Tol-
erance?

Meets 
Rel. Tol-
erance?

Meets 
Abs. 

OR Rel. 
Tol-

erance?

Meets Ab-
s. 

AND Rel. 
Tol-

erance?

1 20.0000 - - - - - -

2 12.0000 0.66666-
7

8.00000-
0 NO NO NO NO

3 14.0000 0.14285-
7

2.00000-
0 NO NO NO NO

4 13.5000 0.03703-
7

0.50000-
0 NO NO NO NO

5 13.6000 0.00735-
3

0.10000-
0 NO NO NO NO

6 13.5900 0.00073-
6

0.01000-
0 NO NO NO NO

7 13.5913 0.00009-
6

0.00013-
0 NO YES YES NO

8 13.5907 0.00004-
4

0.00060-
0 NO YES YES NO

9 13.5909 0.00001-
5

0.00020-
0 YES YES YES YES

Related Topics
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Steady Solution Control Group 159
Iterations Panel 163
Temperature Limits Panel 165
Try Absolute Tolerance 807
Setting relaxation lower than relative pressure/flow tolerance gives unreliable 
results 781

Related Blogs

Having model convergence problems? Start here!

Iterations Panel
Relaxation, iteration limits, and matrix method settings are defined on the Iterations panel in Ana-
lysis Setup. Most settings on this panel will not affect the final result. The default state of the Iter-
ations panel is shown in Figure 1.

Figure 1: Iterations panel in Analysis Setup

Relaxation

Relaxation slows iterative progress toward a solution reducing the destabilizing effect of non-lin-
ear systems.

 l Automatic - Implements an adaptive relaxation scheme that reduces the relaxation 
dynamically in response to highly non-linear features of the problem.

 l Fixed - Allows for user specified Flow Rate and Pressure Relaxation

When applied to the flow solution, relaxation r is used as follows:
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A relaxation of 1 is the same as no relaxation. Each iteration's prediction is used directly in the 
next iteration.

A relaxation of 0 is not allowed, as this would prevent the parameter from changing.

 l Flow Rate Relaxation - For highly non-linear systems, a flow rate relaxation of 0.1 is 
advised. Experience shows that using flow rate relaxation factors between 0.5 and 1 has 
limited usefulness. If a flow rate relaxation of 1 does not work, you should generally try 
flow rate relaxation parameters between 0.1 and 0.5. In more extreme cases, a flow rate 
relaxation factor smaller than 0.1 may be required.

 l Pressure Relaxation - Because of the nature of the matrix solver, experience indicates 
that if pressure relaxation is used, it should always be set to 0.5 or 1 to maintain stability.

Iteration Limit

 l Maximum Iterations - 50000 by default, sufficient for the vast majority of models. Most 
models converge in a relatively small number of iterations. This limit does not directly 
affect the solution.

 l Iteration Span for AutoDetect - 100 by default, if the Solver detects that no meaningful 
progress has been made to convergence within this many iterations, relaxation is auto-
matically lowered. This also automatically adjusts tolerance.

Matrix Method

Network analysis requires solving complex matrices potentially thousands of times. Different 
methods may solve faster or slower, but have no bearing on results. The default method of Gaus-
sian Elimination is highly robust and usually provides the fastest convergence. The available Mat-
rix Methods are:

 l Gaussian Elimination
 l Gaussian Elimination With Pivoting
 l LU Decomposition

Iteration History

Iteration History shows a history of which pipe or junction is most out of tolerance, which is help-
ful for troubleshooting. After enabling Iteration History on the Iterations panel in Analysis Setup, 
the Iteration History can be viewed from the Solution Progress window by pausing the cal-
culation and selecting the Other Actions button.

Related Topics
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Steady Solution Control Group 159
Tolerance Panel 160
Temperature Limits Panel 165
Lower the Flow Rate Relaxation 806
Review the Iteration History 808
Setting relaxation lower than relative pressure/flow tolerance gives unreliable 
results 781
Solution Progress Window 387

Related Blogs

Having model convergence problems? Start here!

Temperature Limits Panel
The Temperature Solver Limits panel allows users to set boundaries for temperature within the 
solver. These limits are intended to help with convergence and prevent the solver from providing 
unrealistic results. These limits are intended to keep the solver within physical restraints, such as 
temperatures that can't be produced on Earth. This is most useful when operating near the edge 
of available physical property data. During iteration, the Solver may attempt to extrapolate past 
the available data, returning an error. Limiting the allowable range can keep the search within the 
proper bounds. 

The Temperature Limits Panel is available if heat transfer is enabled. 

For design requirements and limitations, use Design Alerts to signify when the solvers values are 
beyond a desired range yet is still physically possible to occur.

 
Figure 1: Temperature Limits panel in the Analysis Setup window

Related Topics
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Steady Solution Control Group 159
Tolerance Panel 160
Iterations Panel 163
Pipe X temperature is equal to or greater/less than the maximum/minimum tem-
perature limit of... 785

Environmental Properties Group
The Environmental Properties Group in Analysis Setup has one item: Environmental Properties 
panel. By default, the Environmental Properties Group is fully defined and will have a green 
checkmark next to its name.

Related Topics

Analysis Setup Overview 78
Modules Group 79
Fluid Properties Group 85
Pipes and Junctions Group 138
Transient Control Group 140
Goal Seek and Control Group 146
Steady Solution Control Group 159
Cost Settings Group 168
Automatic Sizing Group 171
Miscellaneous Group 172
Environmental Properties Panel 166

Environmental Properties Panel
The Environmental Properties panel, shown in Figure 1, controls the definition of the atmo-
spheric pressure, gravitational acceleration, and transition Reynolds number used to model the 
system.
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Figure 1: Default state of the Environmental Properties panel

Environmental Properties

Specify the ambient pressure and gravitational acceleration values for the solver to use in the cal-
culations. By default, these values are 1 atm and 1 g, respectively.

Ambient Pressure

AFT Fathom uses a default atmospheric pressure of 1 standard earth atmosphere, or 14.696 
psia. This pressure is also used to convert absolute pressures to gauge pressures. Keep in mind 
that atmospheric pressure varies with altitude. A project at Sea Level should not have the same 
atmospheric pressure as a project at 8500 feet. Fathom can automatically adjust atmospheric 
pressure using the Ambient Pressure vs. Elevation Table found in the Analysis Setup window. 
Here, users can input a pressure profile that will change the ambient pressure depending on a 
junction's elevation.

Gravitational Acceleration

The default for gravitational acceleration is 1 standard earth gravitational acceleration, or 32.174 
feet/sec2. You can change this to a multiple of standard earth accelerations (that is, number of 
g's) according to the design environment for your system. In principle, the body force on a fluid 
system does not have to be due to gravity.
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Transition Reynolds Number

AFT Fathom allows you to modify the transition Reynolds numbers. The default values assume 
that a Reynolds number of less than 2300 is laminar and a Reynolds number of greater than 
4000 is turbulent. In the transition zone, a linear interpolation is assumed. This applies for friction 
factors and convection heat transfer.

You can modify these transition Reynolds numbers if you choose by manually typing in the val-
ues on the Environmental Properties panel in the Analysis Setup window.

Related Topics

Environmental Properties Group 166
Head rise across fixed flow pumps is referenced to system g level... 790
Head loss, head rise, hydraulic gradeline and energy gradeline output does not 
have meaning for zero g systems 790

Cost Settings Group
The Cost Settings Group in Analysis Setup has one item: the Cost Settings panel. This group is 
always present regardless of whether or not cost calculation is enabled. When all fields are 
defined, the Cost Settings Group will have a green checkmark next to its name.

Related Topics

Analysis Setup Overview 78
Modules Group 79
Fluid Properties Group 85
Pipes and Junctions Group 138
Transient Control Group 140
Goal Seek and Control Group 146
Steady Solution Control Group 159
Environmental Properties Group 166
Automatic Sizing Group 171
Miscellaneous Group 172
Cost Settings Panel 168
Cost Calculation 525

Cost Settings Panel

Note:This topic does not apply for the ANS module. To set up cost calculations with ANS, 
see the Assign Cost Libraries topic.

- 168 -



Analysis Setup Overview

The Cost Settings panel must be defined in order to run a model. By default, cost calculation is 
not enabled and no further input is required to define the panel.

Figure 1: The Cost Settings panel

Enable Cost Calculation

The first step in any cost calculation is to enable it in the Cost Settings panel. The following 
options are available:

 l Do not calculate - Selected by default.
 l Pump Energy Only - Only calculate the costs associated with the power consumption of 

pumps. The energy cost and system life must be entered in Cost Settings.
 l Calculate - Enable full calculation of costs. In addition to defining Cost Settings, Cost 

Libraries must be defined to use this feature.

Including Objects in Cost Report

Workspace objects must be included in the Cost Report to have their costs calculated. This 
allows only analyzing the cost of certain parts of the model - useful if only one pump is being 
replaced, or if an expansion to an existing system is being considered. To include the objects in 
the Cost Report simply select "Include Cost in Report" on the object's Cost tab, as shown below. 
Finer detail in how the Cost is included can be set by clicking the Cost Application button.
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Figure 1: Include Cost in Report

Energy Cost

Energy cost data can be specified through an Energy Cost Library, or by directly entering an 
energy cost on the Cost Settings panel. Using an energy cost library allows you to specify mul-
tiple energy costs, such as energy costs at both peak and off-peak rates.

Cost Definitions

The Cost Definitions section allows you to specify the type of costs to be determined. Check the 
boxes next to the items that are of interest. The options are:

 l Material
 l Installation
 l Maintenance
 l Operation/Energy

Cost Time Period

When Cost calculations are enabled the System Life is required. Interest Rate and inflation rate 
will default to zero, and may be changed by the user.
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The System Life affects all recurring costs. It can also affect non-recurring costs if the Service 
Duration is used.

See Cost Libraries for detailed discussions regarding recurring and non-recurring costs.

Related Topics

Cost Settings Group 168
Cost Calculation 525
System Life specified in Cost Settings is different from the XTS time 794

Automatic Sizing Group
(ANS Module Only) The Automatic Sizing Group in Analysis Setup only appears when the 
ANS Module is activated from the Modules panel. The Automatic Sizing Group has one panel: 
the Sizing Summary panel.

Related Topics

Analysis Setup Overview 78
Modules Group 79
Fluid Properties Group 85
Pipes and Junctions Group 138
Transient Control Group 140
Goal Seek and Control Group 146
Steady Solution Control Group 159
Environmental Properties Group 166
Cost Settings Group 168
Miscellaneous Group 172
ANS - Automated Network Sizing 623
Sizing Summary Panel 171

Sizing Summary Panel
The Sizing Summary panel in Analysis Setup displays the Sizing Summary when the 
ANS module is active. The Sizing Summary can also be viewed in the Sizing Window .
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Figure 1: Sizing Summary panel with all tree nodes expanded

Related Topics

ANS - Automated Network Sizing 623
Automatic Sizing Group 171

Miscellaneous Group
The Miscellaneous group contains settings that are used infrequently. By default, the Mis-
cellaneous Group is fully defined, with a green checkmark next to its name, without any addi-
tional input from the user.

The Miscellaneous group contains the following panels:

 l NFPA panel - Allows NFPA to be activated to generate NFPA reports
 l Heat Transfer Sectioning panel - Contains advanced settings for heat transfer cal-

culations for troubleshooting purposes
 l Advanced Parameters panel - Contains advanced parameters that can be used for 

troubleshooting purposes

Related Topics

Analysis Setup Overview 78
Modules Group 79
Fluid Properties Group 85
Pipes and Junctions Group 138
Transient Control Group 140
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Goal Seek and Control Group 146
Steady Solution Control Group 159
Environmental Properties Group 166
Cost Settings Group 168
Automatic Sizing Group 171
Heat Transfer Sectioning Panel 176
Advanced Parameters Panel 177
NFPA Panel 173

NFPA Panel
The NFPA panel allows the user to enable NFPA settings, set the Hazen Williams factor, and 
define an ambient pressure for NFPA calculations.

NFPA stands for the National Fire Protection Association. This association develops codes and 
standards that are used by engineers designing safety related systems related to fire protection. 
AFT Fathom provides users the ability to specify remote paths and automatically calculate the 
hydraulics through that path as is recommended in NFPA 15 Section 8.5.3.1 (NFPA 15 (2012), 
pg 23). When coupled with the GSC module (Goal Seek and Control), AFT Fathom includes the 
ability to determine the hydraulically most remote path automatically.
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Figure 1: NFPA panel

NFPA Report

In order to generate the NFPA report, a group must be created using the Group Manger. This 
group must contain at least one spray discharge. It is best practice for this group to be a single 
continuous flow path connecting the most hydraulically remote spray discharge to the pressure 
source for the system. Once the group is created, a user will need to select the group on the 
NFPA panel above. Multiple groups can be created, but only one can be selected per run. To 
see how this is done, see the NFPA Firewater System Example. For more detail on NFPA 
reports consult the NFPA standard.

Terminology

The table below shows equivalent naming conventions between Fathom and the NFPA stand-
ard. Stagnation (total) pressure is equal to static (normal) pressure plus dynamic (velocity) pres-
sure.

AFT Fathom NFPA Standard

Stagnation Pressure (Po) Total Pressure (Pt)

Static Pressure (P) Normal Pressure (Pn)

Dynamic Pressure Velocity Pressure (Pv)

Differences Between Fathom and NFPA Standards

The NFPA standard was built as a method that engineers could use to solve complex fire water 
networks via hand calculations. To accomplish this the NFPA standard uses certain assump-
tions which differ from the computational methods and precise solution methodology that 
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Fathom uses in its Solver. Therefore, it is expected that Fathom and NFPA hand calculation res-
ults may differ. Some key differences are listed below:

 l Matrix Methods for Flow Splits - Fathom uses a matrix of equations to calculate the 
exact flow splits, whereas the NFPA Standard uses conservative estimates for flow splits.

 l Velocity Changes at Flow Splits - Fathom accounts for velocity changes at flow splits 
due to diameter changes and mass leaving the system at other nozzles.

 l Stagnation Pressure at Nozzle Exits - Fathom uses stagnation pressure as the driving 
force for flow out of all nozzles (inline and end nozzles), whereas the NFPA standard uses 
static pressure for inline nozzles (total pressure minus velocity pressure). Therefore, 
Fathom does not adhere to NFPA 15 (2012) Section A.8.5.1.2 (pg 48).

Related Topics

Equivalent Length 270
Hazen-Williams NFPA 175
Miscellaneous Group 172
Heat Transfer Sectioning Panel 176
Advanced Parameters Panel 177

Related Blogs

Putting Out Fires with AFT Fathom's NFPA Calcs & GSC

Hazen-Williams NFPA
Some in industry use an alternate form of the Hazen-Williams formula which has this form (NFPA 13, 
1999):

(1)

where:

 l p = Pressure drop gradient (psi per foot)
 l C = friction loss coefficient
 l Q = Volumetric flow rate (gpm)
 l d = Internal diameter (inches)

This differs slightly from the Hazen Willams version used in AFT Fathom.
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While both Equation 6 (and its variant Equation 7) in topic Pressure Drop in Pipes and Equation 
1 (in this topic) are used heavily in industry, surprisingly they are not equivalent. The reason 
relates to Equation 1 being in terms of pressure drop but not having a fluid density in the equa-
tion. Equation 1 is intended for water, but it says that the pressure drop is independent of fluid 
density. This is contrary to Equation 2 and almost all other references.

The definition of pressure loss as it relates to head loss is

If this equation is used to equate Equations 1 and 2, the density must be 62.0933 lbm/ft3 to 
achieve equality. Hence any other density used in AFT Fathom will result in a pressure drop 
which does not equal to that of the Equation 1 NFPA formulation. Using the ASME Steam 
Tables, a density of 62.0933 lbm/ft3 at 1 standard atmosphere occurs at a temperature of 91.78 
F.

Matching AFT Fathom Hazen Williams to NFPA Hazen-Willams

Users who want their results to match the NFPA version in Equation 1 can do so by one of the 
following two options:

 l Use a density of 62.0933 lbm/feet3 in all calculations, or
 l Use the desired density and then apply a design factor on each pipe to correct the pres-

sure drop for density. The design factor should be equal to 62.0933 lbm/feet3 divided by 
the density on the Fluid panel in Analysis Setup. If variable properties are used, the 
design factor must be varied on a pipe-by-pipe basis.

Related Topics

NFPA Panel 173
Equivalent Length 270

Related Blogs

Putting Out Fires with AFT Fathom's NFPA Calcs & GSC

Heat Transfer Sectioning Panel
If heat transfer is enabled, the number of thermal sections that are used to calculate heat transfer 
in Pipes and Heat Exchangers can be modified in the Heat Transfer Sectioning panel, shown in 
Figure 1.

Because the amount of heat transfer is dependent on the temperature difference at any given 
point, an overall average would not give an accurate estimate. Sectioning heat transfer com-
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ponents increases the accuracy of the calculation due to the changing thermal profile. Very large 
thermal changes may require additional sections.

Figure 1: Default state of the Heat Transfer Sectioning panel

Related Topics

Miscellaneous Group 172
Advanced Parameters Panel 177
NFPA Panel 173

Advanced Parameters Panel
The Advanced Parameters panel, shown in Figure 1, of Analysis Setup offers various settings 
intended only  for troubleshooting purposes.

These parameters should not be changed under normal circumstances and will significantly 
impact results.
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Figure 1: Default state of the Advanced Parameters panel

Related Topics

Miscellaneous Group 172
Heat Transfer Sectioning Panel 176
NFPA Panel 173
Global energy balance disabled by user in Advanced Parameters Panel 780
Global mass balance disabled by user in Advanced Parameters Panel 780
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This section focuses on interactions with the Pipe and Junction objects in the AFT Fathom work-
space. Topics include how to create pipe and junction objects, how to alter junctions already on 
the Workspace, and how to ensure the inputs for objects are both correct and complete.

Contents

Selecting and Finding Objects 179

Pipe Drawing Modes 183

Selecting and Finding Objects
AFT Fathom has a number of methods to assist in selecting multiple objects at once as well as 
finding objects for recall later. The contents of this section can be broken down into the two cat-
egories shown below. Follow the links to learn more.

 l Methods for selecting objects
 l Select Flow Path
 l Select Special
 l Groups

 l Methods for finding objects
 l Workspace Find
 l Workspace Search
 l Find from Model Data or Output
 l Jump Feature
 l Bookmarks

Selecting Objects
A single left click on any object will select that object. Selecting multiple objects can be accom-
plished by:

 l Holding the shift or control key and left clicking on objects
 l Dragging the cursor over the objects, creating a selection area

 l Dragging left-to-right creates a selection area that will only select objects entirely 
bounded by the area

 l Dragging right-to-left creates a selection area that selects any objects completely 
or partially inside the area

 l Using Select All from the Edit Menu, right-clicking on Workspace to open context menu, 
or keyboard shortcut (Ctrl-A)
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 l Using Select Last Selection from the Edit Menu or with F12 to reselect the previously 
selected objects

 l Using Select Flow Path
 l Using Select Special
 l By selecting a Group

Select Flow Path

A flow path is a sequence of pipes and junctions where there is no branching or flow sources or 
sinks.

The pipes and/or junctions in a flow path may all be easily selected using the Select Flow Path 
item on the Edit menu, Toolbar, or the right-click context menu.

If a junction is selected which has multiple flow paths attached to it (e.g., a branch with 3 or more 
pipes) then objects in each of the connected flow paths will be selected. This feature is very use-
ful in duplicating or deleting sequences of pipes and junctions. It can also be used to quickly 
define groups for graphing or for selected Output or Model Data listings.

Select Special

Select Special is a tool for selecting or deselecting objects based on certain criteria. It can be 
opened from all windows/menus that give you the option to choose what pipes and/or junctions 
are selected. These windows/menus include the Output Control window, the Model Data win-
dow, the Layer Settings window, the Select Graph Data window, the Edit menu, right clicking on 
the Workspace, or pressing F6 on the keyboard.

Once Select Special is open, all pipe names and numbers and junction names and numbers are 
shown in numerical order under Pipe Selections and Junction Selections, respectively. At the top 
of the Select Special window is the Selection Type option. This option allows you to choose what 
criteria you would like to use to select certain pipes and junctions. You can choose from the fol-
lowing criteria to select certain pipes and/or junctions.

 l Selected on Workspace
 l Closed in Model
 l Special Conditions Set
 l Number Range
 l Junction Type
 l Pipe Input Properties
 l Zero-Length Connectors
 l Notes
 l Undefined Objects
 l User-Colored Pipes
 l Transient Data Exists (XTS only)
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 l Groups
 l Used as Goal or Variable
 l Variable Fluid Properties
 l Pipe Output Properties (Only available when output is available)
 l Junction Output Properties (Only available when output is available)

Choosing certain Selection Types will prompt a second or sometimes third option below the 
Selection Type to allow you to further specify the type of pipe or junction you want. For example, 
selecting Junction Type in the Selection Type box will prompt the Junction Type box to appear. 
The Junction Type box will allow you to specify what type of junctions you would like to select. 

By default, the Selection Type is Selected on Workspace and any pipes or junctions selected on 
the Workspace are selected in the Select Special window with a black check mark next to the 
box corresponding to the pipe or junction. 

Once you have fully specified the Selection Type, you must click Select Pipes and/or Select Junc-
tions to automatically select the corresponding objects.

The selected pipes and junctions under Pipe Selections and Junction Selections do not auto-
matically become unselected when you switch from one Selection Type to another. Therefore, 
you must first choose Deselect Pipes and/or Deselect Junctions located above the Pipe Selec-
tions and Junction Selections boxes, respectively. For example, if you select all of the pipes on 
the Workspace prior to opening the Select Special window, all of the pipes will be selected in the 
Select Special window when you open it. If you then choose Junction Type as the Selection Type 
and then specify All Junctions as the Junction Type, all junctions will be selected under Junction 
Selections, but all pipes previously selected will also remain selected. In this example, if you 
would like only junctions to be selected with none of the selected pipes on the Workspace to be 
selected in the Select Special window, first click the Deselect Pipes button, which is located 
above the Pipe Selections list. 

Options to select all pipes/junctions, to deselect all pipes/junctions, and to invert the selected 
pipes/junctions are located below both Pipe Selections and Junction Selections boxes. Inverting 
the pipes/junctions deselects all currently selected pipes/junctions and selects all currently 
deselected pipes/junctions. This feature is helpful if you want to select all pipes/junctions that do 
not fit a certain criteria. For example, if you want to select all open objects in the model, you 
could specify Closed in Model in the Selection Type box, then click Select Pipes and Select Junc-
tions. All pipes and junctions that are closed in the model will be selected. Because you want to 
select all open pipes and junctions in the model but only the closed pipes and junctions are selec-
ted, you would simply click Invert below both the Pipe Selections and Junction Selections lists to 
deselect all closed pipes and junctions and select all open pipes and junctions.

Related Topics

Selecting and Finding Objects 179
Finding Objects 182
Groups 183
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Finding Objects

Workspace Find

The Find window utility helps you find a particular pipe or junction by its ID number and name. 
The Find utility becomes more useful for large models.

You can access the Find utility by selecting Find on the View menu, by clicking the binocular but-
ton on the Toolbar, or by pressing the CTRL + F keys on the keyboard. After you double click on 
the pipe or junction you are searching for in the Find utility or when you click the Find button, the 
Workspace is moved so that the pipe or junction is located near the center of the screen. Addi-
tionally, the pipe or junction you are searching for is selected in the Selected Items color spe-
cified in the User Options window in the Tools menu. By default, this color is red.

Workspace Search

The Search window utility helps you search for a particular pipe or junction by its ID number, 
name, or notes you have inputted in the properties window. The Search utility becomes more 
useful for models that expand over multiple Workspace pages.

You can access the Search on the Common Toolbar. The search feature will list all objects 
related to your search term beneath itself in a list of search results. You can hover over each 
search results to see a preview of input and output (if the model has been run). Clicking on or 
pressing enter while the object is highlighted in the search results will select the object in the 
workspace and center the focus of the workspace on the object.

Find From Model Data or Output

Objects can be quickly located on the Workspace by right-clicking on a cell in Model Data or row 
header in Output and selecting "Find on Workspace..." the view will change to show the Work-
space, with the object of interest selected.

Jump Feature

By clicking the Jump button in a Properties window, you can move directly to the Properties win-
dow of another a pipe or junction that you specify. The Jump button is located in the upper-right 
corner of any Properties window.

Bookmarks

Use the Bookmark tools on the View menu to set Bookmarks and to display different book-
marked pipes or junctions.
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Bookmarks can be added on the Workspace in relation to individual pipes or junctions. You can 
quickly navigate around the Workspace by moving from Bookmark to Bookmark.

Related Topics

Selecting and Finding Objects 179
Selecting Objects 179
Groups 183

Groups
Groups of pipes and junctions can be named for later recall. This is done using the Group tools 
on the Edit menu. The easiest way to create a named Group is as follows:

 1. First select the pipes and junctions you want in the group.
 2. Choose Groups -> Create from the Edit menu or Toolbar.
 3. You will be prompted for a name for the group. Enter a meaningful name and click OK.
 4. The Group Manager then opens. The selection of pipes and junctions in the Group will 

match those currently selected on the Workspace. If you want to modify the selections fur-
ther, you can do it here. 

You can include Subgroups inside of your Groups. Subgroups are existing Groups. If a Group 
contains one or more Subgroups and the Group is selected on the Workspace, then all pipes and 
junctions in the Group and Subgroup(s) will be selected. Additionally, if you include a Subgroup 
in your Group and then later change the contents of the Subgroup, the Group that contains the 
Subgroup will also be changed.

After you have created a Group, you can then quickly reselect that Group of pipes or junctions on 
the Workspace by choosing Group -> Select from the Edit menu or Toolbar and choosing the 
name of the Group.

The Group Manager can be opened by choosing Group -> Manager from the Edit menu or Tool-
bar. The Group Manager allows you to modify, create, delete or rename Groups.

Another place that Groups can be selected from is in the Select Special window.

Related Topics

Selecting and Finding Objects 179
Selecting Objects 179
Finding Objects 182

Pipe Drawing Modes
AFT Fathom has a selection of pipe drawing modes. To select or change a pipe drawing mode, 
navigate to Arrange -> Pipe Drawing Mode. These pipe drawing modes are:
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 l 2D Freeform
 l 2D Orthogonal
 l Isometric

A second function called Snap to Grid is highly integrated with Pipe Drawing Modes and will 
alter how each pipe drawing mode works. To select or change a Snap to Grid option, navigate to 
Arrange -> Snap to Grid. The Snap to Grid options for the 2D modes are on and off. Snap to Grid 
options for Isometric are more extensive. These snap to grid options are:

 l Snap to Isometric Grid Lines
 l Snap to Grid Points
 l Do Not Snap

2D Freeform

This Pipe Drawing Mode allows placing pipes or junctions anywhere on the Workspace, with 
pipes at any angle. Snap to Grid can be turned on with this mode to force the junctions to be at 
grid intersection points.

Figure 1: 2D Freeform with Snap to Grid off
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Figure 2: 2D Freeform with Snap to Grid on

2D Orthogonal

The 2D Orthogonal Pipe Drawing Mode forces all pipes drawn in the model to be either hori-
zontal or vertical. Segments are automatically inserted into pipes to enforce drawing only along 
the horizontal and vertical directions.
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Figure 3: Model in 2D Orthogonal mode with Snap to Grid on

Orthogonal drawing can create some confusion for the user because segments from different 
pipes may overlap each other and hence become indistinguishable.

 l Use the Add/Remove Segments button to add new segments
 l Use a fine grid and the Snap to Grid features
 l If you have a junction with several connecting pipes that interfere, enlarge the junction to 

150% or 200% of normal size using the Workspace Layers

Isometric

When modeling, it may be convenient or desirable to demonstrate the three dimensional nature 
of a system. A typical 2D grid has two sets of grid lines representing the x and y axes. An iso-
metric grid has three sets of grid lines that are offset by 60°, representing the x, y, and z axes. It 
is ideal to set the grid type desired before building a model to avoid the pipe and junction loc-
ations from being rearranged in undesired ways. It is also very helpful to show the Grid (Arrange 
-> Show Grid) when building an isometric model.
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Figure 4: 2D (left) and isometric (right) grids

Drawing Pipes in Isometric Mode

How pipe drawing in isometric mode functions will change depending on the selected snap to 
grid option. When Snap to Isometric Grid Lines is selected, the pipes are automatically seg-
mented to lie on the grid lines as shown below. Dragging one of the handles on the pipe shows a 
preview line of where the pipe will be placed if adjustment needs to be made. The placement of 
the preview line can be cycled through all possibilities by pressing the arrow keys or by scrolling 
the mouse scroll wheel. Holding the alt key while dragging a pipe endpoint will automatically add 
a new segment to the pipe - the placement of the line can be controlled with the arrow keys or 
scroll wheel as before.
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Figure 5: Automatic layout of isometric pipes

The Snap to Grid Points option will force the end points of the pipes to snap to the points where 
the grid lines intersect without adding segments to it. This is akin to the 2D Freeform mode while 
Snap to Grid is on.

The Do Not Snap option will allow the end points of the pipes to placed anywhere within the 
Workspace.
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Placing Junctions

Placing junctions onto the Workspace follows the usual rules; however, the visual appearance of 
the icon is more complex than in an orthogonal grid. When icons are added after pipes are 
placed, AFT Fathom will rotate the icon automatically following the Workspace arrangement. 
When pipes are connected to icons already placed on the Workspace, right-click and select 
Auto-rotate Icon to adjust the icon. For manual control of icon appearance, right-click the junction 
and select Customize Icon to choose the desired appearance.

Note: The Rotate button in the Customize Icon window can be used to find the appropriate 
icon orientation.
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Figure 6: Icon rotations in isometric space

Related Topics

Working with Pipe and Junction Objects 179
Selecting and Finding Objects 179
Global Edit 191
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AFT Fathom has the powerful capability to apply input parameters across a wide range of 
objects. This can be done for pipes by using the Global Pipe Edit or across junctions  by using the 
Global Junction Edit.

Related Blogs

Mass Modify your Model with Global Edit

Global Pipe Editing
The Global Pipe Edit window allows you to edit data for multiple pipes at the same time. A Guide 
is available at the top of the Global Edit window to walk you through the global edit process.

Here is how you use it:

 1. Open the Global Pipe Edit window from the Edit menu, from the Workspace toolbar, or 
from the right-click menu on the Workspace.

 2. Select the pipes you want to edit from the Pipe list on the left (if pipes were selected in the 
Workspace, they will be automatically selected here).

 3. Click the Select Pipe Data button. This will open a template Pipe Properties Window in 
which you can enter the data you want to change on each of the selected pipes. Altern-
atively, if you want to copy the data from an existing pipe, you can choose "Existing Pipe", 
then select the desired pipe number and skip to step 5.

 4. Enter the pipe data you want to change and click the OK button in the Pipe Properties win-
dow.

 5. The Global Pipe Edit window now lists the parameters to change in a list on the right. 
Select the parameters you want to change. 

 6. Click the Apply Selections button.

Note: You cannot change some data, like the pipe ID number, using this global method.             

Note:There is no undo for global pipe editing. Therefore, you cannot revert your changes 
once you have exited the Global Edit window. However, hitting Cancel on the Global 
Edit window will undo any changes that were just applied.             

Related Topics

Global Edit 191
Global Junction Editing 192
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Related Blogs

Mass Modify your Model with Global Edit

Global Junction Editing
The Global Junction Edit window allows you to edit data for multiple junctions at the same time. A 
Guide is available at the top of the Global Edit window to walk you through the global edit pro-
cess, or the instructions are provided below in this topic.

Junction data falls into the following two broad categories: 

 l Common Data- data that applies to all junctions regardless of junction type; examples 
include elevation and initial pressure data. 

 l Junction Specific Data- data that applies only to certain junctions; examples include pump 
curves and number of heat exchanger tubes.

To open the Global Junction Edit window, browse to the Global Junction Edit option on the Edit 
menu or the right-click menu. From there, choose the category of junction you want to edit. The 
available categories include those junctions selected on the Workspace, any junction type used 
in the model, and common junction data. Global Junction Edit can also be launched by right-click-
ing on the Workspace.

Note: There is no undo for global junction editing. Therefore, you cannot revert your changes 
once you have exited the Global Edit window. However, hitting Cancel on the Global 
Edit window will undo any changes that were just applied.             

Editing Common Junction Data

You can open the Global Junction Edit window for common data editing in two ways. First, you 
can choose Common Data from the Global Junction Edit menu selection on the Edit menu, or 
you can choose one of the other specific junction types on the menu and then choose the Com-
mon option for the Junction Template in the upper left.

Here is how to globally edit junction common data:

 1. Open the Global Junction Edit window.
 2. Select the Common option for Junction Template in the upper left.
 3. Select the junctions you want to edit from the Junction list on the left. Note that all junc-

tions in the model are shown, no matter what the junction type.
 4. Click the Select Common Junction Data button. This will open the Common Junction Data 

Edit window in which you can enter the data you want to change on each of the selected 
junctions.

 5. Enter the junction data you want to change and click the OK button in the Junction Prop-
erties Window.
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 6. The Global Junction Edit window now lists the parameters to change in a list on the right. 
Select the parameters you want to change. 

 7. Click the Apply Selections button.

Note: You cannot change some data, like the junction ID number, using this global method.             

Editing Specific Junction Data

You can open the Global Junction Edit window for specific data editing in two ways. First, you 
can choose the junction type from the Global Junction Edit menu selection on the Edit menu, or 
you can choose Common Data on the menu and then choose the desired junction template, or 
Existing Junction data for the desired junction type.

Here is how to globally edit specific types of junctions:

 1. Open the Global Junction Edit window.
 2. Select the Junction Template option in the upper left. Alternatively, if you want to copy the 

data from an existing junction, you can choose "Existing Junction", then select the desired 
junction number and skip to step 6. 

 3. Select the type of junction you want to edit in the dropdown list in the upper left. For 
example, you could select the Spray Discharge junction.

 4. Click the Select Spray Discharge Data button (the button name will change based on the 
type of junction selected). This will open the appropriate junction Properties Window, in 
this case the Spray Discharge Properties Window. 

 5. Enter the junction data you want to change and click the OK button in the Spray Dis-
charge Properties Window (or whatever window type is displayed).

 6. The Global Junction Edit window now lists the parameters to change in a list on the right. 
Select the parameters you want to change. 

 7. Select the junctions you want to edit from the Junction list on the left. Note that only junc-
tions of type selected in the upper left are shown (Spray Discharge junctions in this case).

 8. Click the Apply Selections button.

Related Topics

Global Edit 191
Global Pipe Editing 191

Related Blogs

Mass Modify your Model with Global Edit

Toolbox
The Toolbox is located on the left of the Workspace window by default, but can be undocked by 
either dragging or right-clicking the heading and selecting Float. The assortment of tools allows 

- 193 -

https://www.aft.com/support/product-tips/mass-modify-your-model-with-global-edit


Global Edit

you to create pipes, junctions, and annotations.
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Figure 1: Toolbox items

Custom Junction Icons

Right-clicking a junction icon in the Toolbox will open the Customize Icon window. A different 
icon can be selected from the predefined assortment, or a custom image can be uploaded using 
the  Add Image button. This functionality enables you to use standard P&ID icons or custom 
images to visually represent your equipment. By using recognizable icons, you can improve the 
clarity and comprehension of model results, especially for those who may not be familiar with the 
default AFT junction icons.
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Note: The Annotation Tool also supports triangle and cloud shapes which can be used in com-
bination with the Notes section on the Scenario tab of the Quick Access Panel to des-
ignate revisions of the model file, similar to a typical P&ID drawing.

Figure 2: The Customize Icon window allows a custom image to be applied to any junction

Related Topics

Creating Pipes - the Pipe Drawing Tool 196
Creating Junctions 201
Keyboard Shortcuts for Workspace 408

Creating Pipes - the Pipe Drawing Tool
The tool in the upper left corner of the Toolbox is the Pipe Drawing tool. With this tool you can 
draw new pipes on the Workspace, starting and ending at any desired location. 

To draw a pipe, click the Pipe Drawing tool. The mouse pointer will change to a crosshair when 
you move it over the Workspace. Position the cursor at the pipe's starting point, hold down the 
left mouse button while dragging the cursor to the pipe end point, then release the mouse button. 

To draw multiple pipes, double click the Pipe Drawing tool. This will keep the tool engaged until 
you click the Pipe Drawing tool again or press the escape key.

The length of the line on the Workspace has no relationship to the physical length of the pipe. 
The Workspace pipe is merely an abstract representation of a pipe, however, each pipe drawn 
must have a visible length on the Workspace. If the pipe drawn does not have a visible length, 
AFT Fathom eliminates the line immediately after you release the mouse.

When a single pipe is selected, two black squares (or more if the pipe is segmented), called 
handles, appear. When the cursor is placed over a pipe handle it changes to a crosshair and the 
pipe handle can be moved or stretched by dragging with the left mouse button.

Another way to create new pipes is to duplicate existing pipes with the Duplicate or the Copy and 
Paste features found on the Edit menu. These features can also be accomplished both from the 
right-click menu on a selected pipe as well as the Workspace toolbar. When a new pipe is 
derived from a previous pipe, the new pipe retains the input associated with the original pipe.
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Each pipe must be connected to two junctions. There are no exceptions to this rule.

Pipe ID Numbers

When a new pipe is created, it is assigned a default ID number. When the pipe is displayed on 
the Workspace, the ID number is preceded by the letter "P" to indicate that it is for a pipe. From 
the Pipe Properties Window, you can change the ID number to any desired number greater than 
zero and up to 99,999, but the number must be unique to the pipe and cannot be replicated in 
any other pipes on the  Workspace. The pipe number remains with the pipe in descendant scen-
arios in the Scenario Manager. An arrow near the ID number indicates the reference flow dir-
ection for the pipe. The reference positive flow direction can be reversed by choosing Reverse 
Direction from the Arrange menu or by selecting the reverse direction button on the Toolbar. 

Tip: The pipe or junction ID number text can be dragged to a new location to improve visibility. 
The new location is saved with the model. If you want the text of one or more pipes 
and/or junctions returned to the default location, select those pipes/junctions on the 
Workspace and choose Reset Label Locations from the Arrange menu. This will open 
the Reset Label Locations window. From the Reset Label Locations window, click the 
Reset Labels For Currently Selected Pipes and Junctions. If you want all pipe and junc-
tion text returned to the default locations, choose Reset All Labels from the Reset Label 
Locations window.

Pipe Segments

A pipe can be segmented or "bent" into numerous sections. This only affects the visual rep-
resentation and does not affect the calculated results. It does not add an "elbow" to the model or 
the resulting pressure drop effects of an elbow. This feature is useful in graphically bending the 
pipe around another part of the model or graphically showing that there are embedded elbows as 
fittings & losses.

You can add a segment to a pipe in several ways. The easiest way to add a pipe segment is to 
first select the pipe, then click on the +/- image on the Add/Remove Segment icon from the Tool-
bar. A segment will automatically be added. One or more segments can be added by clicking on 
the down-facing arrow on the Add/Remove Segment icon from the Toolbar, and then choosing 
the number of segments to be added. Alternatively, you can first select the pipe, then select Pipe 
Segments in the Arrange menu. A dropdown list will appear that allows you to choose Add a Seg-
ment or Add Multiple Segments.

The easiest way to remove a segment is to first select the pipe, then click on the down-facing 
arrow on the Add/Remove Segment icon from the Toolbar. A drop down list will appear that will 
allow you to choose Remove Segment. If you wish to remove all segments, click Remove All 
Segments. Alternatively, you can first select the pipe from which you want to delete one or more 
segments, then select Pipe Segments in the Arrange menu. A dropdown list will appear that 
allows you to remove one or all segments by clicking on either Remove Segment if you want to 
remove one segment, or by clicking on Remove All Segments if you want to delete all segments.

Related Topics
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Highlight Required Input 207
Inspecting Objects 208
Notes 209
Status 210

Joining or Splitting Pipes
When pipes are present in the Workspace, users can both combine and split up pipes. This can 
be done either to clean up the model visually or to further manipulate the model.

Joining Pipes

When multiple pipes are placed in the workspace separated by junctions without having other 
flowpaths splitting off, those pipes and intermediate junctions can be combined into a single 
pipe. The new pipe will have a total length equal to the sum of the combined pipe lengths, and 
any losses associated with the intermediate junctions will be summed and entered as additional 
Fittings & Losses. It will also have the elevation profile of the original pipes and junctions entered 
as Intermediate Pipe Elevations.

The pipes being combined must have the same material, size, type, and friction model to be com-
bined. In addition, the pipes must be pointing in the same direction.

Joining pipes may cause some junction data to be lost such as special conditions, loss factors for 
reverse flow, and ignored transients (XTS module).

To join pipes and junctions in the model, select the "Join Pipes/Junctions" option from the Edit 
menu. The Join Pipes window will be shown with more information on pipes that can be com-
bined in the model. The behavior of the Join Pipes/Junctions window will vary depending on if 
junctions are selected on the Workspace when the Join Pipes/Junctions option is selected.

Note: For maintenance releases prior to September 2022 the Join Pipes/Junctions window 
did not exist. Instead pipes and junctions selected in the Workspace would be joined 
automatically when the "Join Selected Pipes/Junctions" option was selected in the Edit 
menu.

 l If junctions are selected on the Workspace, the Join Pipes/Junctions window will open 
with only the selected junctions shown in the list.

 l If no junctions are selected on the Workspace, the Join Pipes/Junctions window will open 
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with all junctions that can be combined shown in the list. Any junctions that can be com-
bined and won't cause a loss in data at that junction will be selected automatically.

Once the Join Pipe/Junctions window is opened the selections can be modified before joining 
the pipes. The options below the table can be enabled/disabled in order to filter the shown junc-
tions based on if they are selected on the workspace, if they will loose data when combined, or if 
they can't be combined.

If any junctions are selected that would loose data when combined, an additional button will 
appear near the bottom of the window that allows junctions that would have data loss to be 
deselected. It is recommended to select this button before joining the pipes/junctions unless you 
are certain the lost data is no longer required.

To join the pipes at the junctions selected in the Join Pipes/Junctions window, click the Join 
Selected Junction(s) button at the bottom of the window.

Splitting Pipes

An existing pipe in the workspace can be split into multiple pipes two different ways. First, hold-
ing the Shift key while placing a junction along the pipe will split the pipe in two and insert the 
selected junction at the specified length. Any Fittings & Losses defined in the pipe can be placed 
in either of the split pipe segments.

Second, pipes with Intermediate Pipe Elevations can be split into separate pipes at any or all of 
those intermediate elevations. This can be done by selecting a pipe with Intermediate Pipe Elev-
ations and clicking Edit -> Split Pipe at Intermediate Elevations. A window will open to select 
which intermediate elevations to make into new junctions.

The pipe can be split at all intermediate elevations, or at selected locations. This is specified by 
checking the box next to each elevation point the pipe should be split at. When the pipe is split, a 
branch will be created for each of the selected elevation points. If desired, a name can be 
entered for each new branch in the New Junction Name column of the table. Any points not selec-
ted will be retained in the intermediate elevation table of the appropriate pipe in the Workspace.

Note: When splitting a pipe at intermediate elevations, the pipe in the Workspace must be 
long enough to place the necessary number of branches in the pipe before the split can 
be completed. If insufficient space is available, the user will be required to exit the Split 
Pipe at Intermediate Elevations window and rearrange the model to create space 
before Fathom can perform the split action.
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Figure 1: Split Pipe at Intermediate Elevations window

For pipes with a large number of intermediate elevations, it may be more convenient to define 
the split points in a spreadsheet. This can be done from the Edit Table button at the bottom of the 
window by selecting Export to File. This will export the table to a *.csv table which can be opened 
in Excel, as is shown in Figure 2.

The table can be updated by changing the "Split At" column value to Yes for each location that 
the pipe will be split at. Branch names can also be entered under "New Junction Name" column 
for the appropriate points. Note that it is important to not change any of the Length or Elevation 
columns in the *.csv file, as this will prevent the file from being imported. To import the file into 
Fathom, select "Import From File" from the Edit Table button, then browse to the updated *.csv 
file.
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Figure 2: Exported *.csv file for splitting a pipe at intermediate elevations

Related Topics

Pipes 213
Creating Pipes - the Pipe Drawing Tool 196
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Moving Objects 203
Editing Objects 204
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Inspecting Objects 208
Notes 209
Status 210

Creating Junctions
Below the pipe drawing and the annotation tools on the Toolbox are junctions, which allow you to 
model a large variety of pipe system components. To add a junction to a model, drag the desired 
icon from the Toolbox and drop it anywhere on the Workspace. 

To add multiple of the same junctions to a model, double click the desired icon and click the work-
space to add the icon to the desired location. The selected junction icon will remain engaged 
until you click the junction icon again or press the escape key.

As you move the mouse pointer over the Toolbox, a tooltip identifies the type of junction under 
the mouse pointer. 

When you duplicate a junction using the Duplicate, Copy, or Paste features on the Edit menu, 
the new junction retains the input associated with the original junction.
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Junction ID Numbers

Junctions are shown on the Workspace with default ID numbers, which you can change in the 
Junction Properties Window. The letter "J" precedes the ID number to signify that it is for a junc-
tion. From the junction's Properties window, you can change the ID number to any desired num-
ber greater than zero and up to 99,999, but the number must be unique to the junction and 
cannot be replicated in any other junctions on the Workspace. The junction number remains with 
the junction in descendant scenarios as long as the junction type is not changed.

Identical ID numbers can be assigned to both a pipe and a junction because the "P" or "J" will dis-
tinguish the two.

Unlike pipes, junctions do not have reference positive flow directions. Junctions for which the 
flow direction is important (such as control valves) derive the flow direction from the flow dir-
ection of the connecting pipes.

Related Topics

Toolbox 193
Creating Pipes - the Pipe Drawing Tool 196
Keyboard Shortcuts for Workspace 408

Connecting Objects
During construction of a new model, objects can be placed anywhere on the Workspace. In order 
to assemble a model that is ready to submit to the Solver (the part of AFT Fathom that applies 
the governing incompressible flow equations to obtain a solution to the pipe system), you must 
connect the objects properly.

Remember that connectivity only exists between junctions and pipes. There are no junc-
tions that connect to junctions, and no pipes that connect to pipes. 

However it is possible to represent two junctions that are directly connected, such as two com-
ponents that are welded together by using a pipe with the Model As Zero-Length Connector 
option. 

AFT Fathom will attempt to automatically connect pipes and junctions when they are moved. 
This eliminates unnecessary opening of the pipe and junction Properties windows. If Fathom can-
not make the connection automatically, then the following three steps may be required to estab-
lish a connection between a junction and a pipe: 

 1. Graphically connect the objects on the Workspace. The pipe endpoint must terminate 
within the boundaries of a junction icon. 

 2. After the pipe is graphically connected to two junctions, double-click the pipe to open its 
Properties Window, then click OK to accept the connected junctions as determined by 
AFT Fathom. It is most efficient to do this when you are entering the pipe's data in its Prop-
erties Window.

 3. Open the Properties Window of the corresponding junction and accept the pipe con-
nectivity determination. In most junctions, this pipe connectivity determination will be 

- 202 -



located in the upper right hand corner of the Properties Window. In a few junctions, such 
as the Assigned Pressure Junction and Reservoir Junction, the pipe connectivity will be 
shown under the tab containing Loss Coefficients. You can do this as you enter the junc-
tion's data in its Properties Window.

If the model seems to not be connected properly, you can also use the Extended Model Check 
feature on the View menu.

When you accept AFT Fathom's connectivity interpretation, the connection advances from a 
graphical connection to a model connection.

The model connectivity you establish on the Workspace is retained only as long as you maintain 
the graphical objects in their current visual relationship to each other. If you move a pipe or a 
junction and break the graphical connection, AFT Fathom disconnects the two objects. However, 
if you move a group of connected objects, their model connectivity is maintained.

Related Topics

Pipes 213
Creating Pipes - the Pipe Drawing Tool 196
Joining or Splitting Pipes 198
Moving Objects 203
Editing Objects 204
Defining Objects 205
Highlight Required Input 207
Inspecting Objects 208
Notes 209
Status 210
Junctions 251
Morphing Junctions 205
Moving Pipe and Junction Labels 211

Moving Objects
Objects on the Workspace can be moved individually or as groups. Clicking a Workspace object 
selects it. Pipe objects change color when selected. Junction objects are outlined in red when 
selected. These colors are configurable in the Workspace section of User Options (Tools menu) 
.

To move an object, select the object, drag it within the Workspace, and drop it in the desired loc-
ation. When an object is dragged beyond the existing Workspace area, the Workspace is expan-
ded accordingly.

A pipe object can be stretched by grabbing the handles (small red squares) at the pipe endpoints 
and moving an endpoint to a new location. To make these handles visible, select the pipe you 
want to move.

There are numerous ways to select a group of objects for movement or other operations.

To prevent accidental movement of objects on the Workspace, lock the objects. A lock symbol 
appears next to locked pipes or junctions when an attempt is made to move the pipe or junction. 

- 203 -



Global Edit

The Lock feature is accessed from the Arrange Menu or the lock button on the Toolbar. To lock 
an object on the Workspace, select it and then activate the Lock feature either from the Arrange 
menu or from the lock button on the Toolbar. If you would like to lock multiple objects at the same 
time, ensure that all of the objects are selected prior to activating the Lock feature.

Keyboard Modifiers

If you hold down the CTRL key when dragging a junction, the endpoints of any connected pipes 
are not moved with the junction, thus breaking the graphical connection.

Related Topics

Pipes 213
Creating Pipes - the Pipe Drawing Tool 196
Joining or Splitting Pipes 198
Connecting Objects 202
Editing Objects 204
Defining Objects 205
Highlight Required Input 207
Inspecting Objects 208
Notes 209
Status 210
Junctions 251
Morphing Junctions 205
Moving Pipe and Junction Labels 211

Editing Objects
The pipes and junctions you place on the Workspace can be edited with the editing commands 
from the Edit menu or the Toolbar. Objects can be cut, copied, pasted, duplicated, and deleted. 
These operations can be performed on individual objects or on groups. The Edit menu provides 
multiple levels of undo for each editing operation. Alternately, you can use the Undo button on 
the Toolbar. Note that not all Arrange actions can be undone.

The Copy Graphics feature on the Edit menu will copy the Workspace objects to the Windows 
clipboard. This image can then be pasted into other Windows applications.

Related Topics

Pipes 213
Creating Pipes - the Pipe Drawing Tool 196
Joining or Splitting Pipes 198
Connecting Objects 202
Moving Objects 203
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Morphing Junctions
Occasionally, you may want to change a junction's type in your model. You can do this by morph-
ing the old junction into a new one.

If you hold down the CTRL key, select a junction from the Toolbox, and then drop it onto an exist-
ing Workspace junction, the old junction will morph into the new one. The junction type will 
change to the new junction type, and data that can be kept will be copied into the new junction.

Related Topics

Junctions 251
Connecting Objects 202
Moving Objects 203
Editing Objects 204
Defining Objects 205
Highlight Required Input 207
Inspecting Objects 208
Notes 209
Status 210
Moving Pipe and Junction Labels 211

Defining Objects
To specify the required property data for an object, open its properties window. This can be done 
in six ways: 

 l Double-click the object on the Workspace
 l Select the object (by clicking on it once, or using the Selection Box) and press Enter
 l Select the object and click the Open Pipe/Jct Window icon on the Workspace Toolbar
 l Double-click the left column of the appropriate table in the Model Data window (where the 

object ID number is shown)
 l Jump from another Properties Window
 l Double-click the connected pipe or junction number in a Properties Window

Parameters that functionally describe the pipe or junction are entered in the Properties Window. 
Some parameters in the Properties Windows are required and others are optional. The optional 
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parameters offer you added control over your model and the ability to obtain specialized inform-
ation.

The highlight feature shows the required input in pipes and junctions.

Undefined Objects Window

You can open the Undefined Objects window to view all undefined objects and the undefined 
properties. This is available on the View menu.

Use Status Feature

Each pipe and junction Properties Window has a Status tab. The Status tab shows what required 
information for the pipe or junction is missing.

Satisfying Connectivity Requirements

In addition to entering the required information for each object in the model, you must satisfy 
these connectivity requirements:

 l You must accept the connectivity information shown in each object's Properties Window 
 l Each junction must have the appropriate number of pipes connected to it. For example, a 

valve must have exactly two connecting pipes, whereas a reservoir may have one to 
twenty-five connecting pipes. 

 l Pipes must always be connected to two junctions, one at each pipe endpoint.

Should you ever delete any of the required information in the Properties Window or move a con-
nected object from its connection, the object's status reverts to undefined.

For example, say you place a heat exchanger on the Workspace. A heat exchanger requires 
inlet and outlet piping. AFT Fathom reflects this by requiring each heat exchanger to be assigned 
an upstream pipe and a downstream pipe. Entering only the heat exchanger constants and set-
ting an elevation is necessary but not sufficient information to define the heat exchanger 
according to AFT Fathom's requirements. Once you have entered the heat exchanger data and 
properly connected it, the heat exchanger is defined.

Show Object Status

The Show Object Status feature helps you identify which objects on the Workspace are defined 
and which are not. This feature can be toggled on and off by selecting it from the View menu or 
by clicking the floodlight button on the Workspace toolbar. 

Turning Show Object Status on displays the undefined junction and pipe ID numbers in the 
Undefined Color, which is red by default. The color can be changed through the User Options 

- 206 -



window on the Tools menu. Show Object Status helps you rapidly assess where your model 
requires additional information.

Leaving Show Object Status always toggled on is not recommended for large models, as it will 
slow the Workspace graphics response. When this feature is on, every Workspace graphical 
operation you perform must be accompanied by a check of all pipe and junction connections. 
This check takes time, and could degrade your graphics performance. 

Related Topics

Pipes 213
Creating Pipes - the Pipe Drawing Tool 196
Joining or Splitting Pipes 198
Connecting Objects 202
Moving Objects 203
Editing Objects 204
Highlight Required Input 207
Inspecting Objects 208
Notes 209
Status 210
Junctions 251
Morphing Junctions 205
Moving Pipe and Junction Labels 211

Highlight Required Input
The highlight feature functions to identify required input data for the Properties Window for each 
pipe and junction. You can toggle the highlight feature on and off in the following ways:

 l From the Properties Window
 l Double-click anywhere above the tab interface in the Properties Window
 l Press the F2 function key

 l From the View Menu
 l Toggle the Highlight in Pipe and Jct Windows to Off

The highlighting feature may be especially useful when you are first learning to use AFT Fathom 
or when you are having difficulty obtaining a defined object status.

Related Topics

Pipes 213
Creating Pipes - the Pipe Drawing Tool 196
Joining or Splitting Pipes 198
Connecting Objects 202
Moving Objects 203
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Inspecting Objects
The Inspection feature displays data associated with a Workspace object in read-only fashion 
via a pop-up overlay (see Figure 1). Inspecting is faster than opening the Properties window if 
you only want to review the data and no edits need to be made. Inspecting can be done directly 
from the Workspace and provides a quick summary of the parameters that appear on the Model 
Data Primary Window.

To inspect an object, position the mouse pointer on the object and hold down the right mouse but-
ton.

The Inspection feature is also available inside each pipe/junction's Properties window. This is 
useful if you want to check the input data of objects connected to the one you are viewing. The 
upstream/downstream pipes or junctions are listed, and holding the right mouse button on the lis-
ted ID number will open the associated inspection overlay.  For example, when working in an Ori-
fice Properties window, you may wish to quickly check the upstream and downstream pipe 
diameters previously defined. Holding down the right mouse button on each connected pipe ID 
number will show you that pipe's primary input parameters.

Judicious inspecting can save you time when assembling or debugging a model.

Note: Output data will be shown on the inspection overlay only if a valid Output File is present 
for the current scenario.
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Figure 1: Holding the right mouse button on a Workspace object displays the associated data
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Notes
Each object can have notes associated with it. This is useful for listing assumptions, reference 
documents, drawings, measurements, etc.

Related Topics
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Status
The status tab lists all undefined parameters that are required to define the pipe or junction.

Related Topics
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Workspace Pan
The user can use Workspace Pan mode to move around, or pan, the model. If the Workspace 
has been enlarged beyond the default one screen size (Workspace scrollbars will be visible), 
then the Workspace can be panned by activating Workspace Pan mode. There are several ways 
to activate Workspace Pan Mode:

 l Click the Workspace Pan button (represented with a hand icon) on the toolbar
 l Select the Workspace Pan option in the View menu
 l If your mouse has a center button (a scroll wheel), hold the scroll wheel button down
 l Hold CTRL and use the arrow keys
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Once in pan mode, the cursor will change to an open hand that can be used to grab and move a 
point in the Workspace. The Workspace can be panned by holding down the left mouse button (if 
the Workspace Pan mode has been activated using the Workspace Pan button on the toolbar or 
the Workspace Pan option has been selected in the View menu) and moving the mouse in the 
desired direction, or by holding down the mouse scroll wheel (if using the scroll wheel to keep 
Workspace Pan mode activated) and moving the mouse in the desired direction. 

To switch off the pan mode, click the mouse scroll wheel or the Workspace Pan button on the 
toolbar a second time. If Workspace Pan mode is maintained using the mouse scroll wheel, it will 
automatically turn off once you release the mouse scroll bar.

Related Topics

Moving Pipe and Junction Labels 211

Related Blogs

AFT Responds to 2020 Customer Survey Feedback

Moving Pipe and Junction Labels
Each pipe and junction on the Workspace also displays a label.  A label refers to any text asso-
ciated with an object - pipe numbers, names, flow rates, and so forth. The label will display a 
unique combination of defined display text items from each visible Workspace Layer.  This label 
can be dragged to improve model aesthetics. The relative location of the label to the object is 
linked so that if the object is moved, the label moves with it.

Returning Label to Default Location

To return the label to its default location, you can:

 l Right-click the label for an individual object and choose Reset Label Location
 l Use Arrange -> Reset Label Locations and respond to the dialog
 l Click Reset Label Locations in the Label Control group of the Layer Settings window to 

reset all label locations

Related Topics

Junctions 251
Connecting Objects 202
Moving Objects 203
Editing Objects 204
Morphing Junctions 205
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Global Edit

Defining Objects 205
Highlight Required Input 207
Inspecting Objects 208
Notes 209
Status 210
Workspace Pan 210

Special Conditions
Some junctions have Special Conditions which alter the normal state of the junction. For 
example, a valve can be closed, a pump turned off, or a relief valve opened. Pipes can also be 
set closed which will effectively close the pipe to flow at both ends.

The special conditions are set in one of three ways:

 l By selecting the junction(s) or pipe(s) on the Workspace and choosing Special Conditions 
from the Edit menu

 l By selecting the junction(s) or pipe(s) on the Workspace and clicking the Special Condi-
tion icon on the Toolbar

 l By opening the junction's or pipe's Properties window and clicking the appropriate con-
dition on the Optional tab

The pipes or junctions which have special conditions set are shown using a special symbol 
before the ID number (an "X" by default). This symbol can be customized in the User Options.

When the special condition results in a section of the model being closed or "turned off", the 
pipes which will have zero flow are display as dotted lines. This indicates visually that they are 
cut off from flow; the junctions are outlined with a dotted line. The default dotted line can be 
changed in the User Options.

The user can specify Special Conditions for Control Valves to be either closed or fully open. Sim-
ilarly, Pumps can be turned off and either allow flow through or stop the flow.

Related Topics

Optional Input for Junctions 258
Optional Input for Pipes 239
Turn Off Parts of the Model 808
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This section focuses on specifying and modifying the Pipe object in the AFT Fathom Workspace. 
Topics include an overview of the Pipe Properties window, how to input pipe specification data, a 
description of the methodology used for heat exchange within pipes for AFT Fathom, and how to 
insert fittings and losses within the pipes.

Contents

Pipe Properties Window 213

Common Pipe Input Parameters 214

Pipe Model 215

Fittings & Losses 217

Heat Transfer in Pipes 219

Insulation for Pipes 237

Fluid Properties for Pipes 238

Optional Input for Pipes 239

Add/Remove Pipe Segment 243

Reverse Direction 243

Pressure Drop in Pipes - Detailed Discussion 244

Pipe Properties Window
Each pipe on the Workspace has engineering information associated with it. Each pipe must 
have an ID number, a length, a diameter, a roughness specification, heat transfer conditions (if 
modeling heat transfer), and two connecting junctions. If the pipe is not purely cylindrical, addi-
tional geometry information is also required.

Related Topics

Pipes 213
Common Pipe Input Parameters 214
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Pipe Model 215
Fittings & Losses 217
Heat Transfer in Pipes 219
Insulation for Pipes 237
Fluid Properties for Pipes 238
Optional Input for Pipes 239
Add/Remove Pipe Segment 243
Reverse Direction 243
Pressure Drop in Pipes - Detailed Discussion 244
Pipe X length is shorter than the elevation change 793

Common Pipe Input Parameters
The common input parameters are located above the tabs in the Pipe Properties window.

Number

Every pipe must have a unique ID number. When new pipes are created, a pipe number is auto-
matically allocated.

The pipe number can be changed by the user to any unique value greater than zero and less 
than 100,000. Pipe numbers are only identifiers and have no affect on the model behavior.

Name

A name can be assigned to each pipe for reference purposes. The default name is simply "Pipe". 
Names do not need to be unique. The name can be shown on the Workspace and in the Output 
window.

Copy Data From Pipe...

The Copy Data From Pipe dropdown list allows you to copy all or some of an existing pipe's prop-
erties to the current pipe. Selecting an existing pipe will prompt the user on what parameters 
should be changed. The Copy Previous button functions similarly, copying parameters from the 
previously edited pipe.

In a child scenario, Copy Data From Pipe lists "Parent Pipe Data," allowing the user to copy all or 
some parameters from the parent pipe.

Connected Junctions

All pipe objects have a reference positive direction, as indicated on the Workspace by an arrow 
in the center of the pipe. The upstream and downstream junctions are identified with this dir-
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ection. The connected junctions area displays these junctions. Every pipe must be connected to 
two junctions in order to be completely defined.

Related Topics

Pipes 213
Pipe Properties Window 213
Pipe Model 215
Fittings & Losses 217
Heat Transfer in Pipes 219
Insulation for Pipes 237
Fluid Properties for Pipes 238
Optional Input for Pipes 239
Add/Remove Pipe Segment 243
Reverse Direction 243
Pressure Drop in Pipes - Detailed Discussion 244

Pipe Model

Size

The size section of the Pipe Model tab specifies the pipe geometry.

 l Pipe Material
 l User Specified - If selected, the geometry of the pipe must be directly specified.
 l Library Material - Many common pipe materials are included in the standard pipe 

material library. These and any other accessible library materials can be selected. 
When a library material is selected, the parameters defining the geometry cannot 
be modified.

 l Pipe Geometry - Several pipe geometries can be modeled. The critical value for flow cal-
culations is hydraulic diameter, based on cross-sectional area Ac and wetted perimeter 
Pw:

 l Cylindrical Annulus - Flow in an annulus or "ring" pattern. This requires both an 
outer and inner diameter to calculate hydraulic diameter.

 l Cylindrical Pipe (default) - A typical pipe. The hydraulic diameter and inner dia-
meter are identical
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 l Helical Tube - Requires hydraulic diameter and coil diameter. Specification of this 
geometry affects the friction model pressure loss.

 l Noncylindrical Pipe -  Requires flow area (cross-sectional area) and wetted peri-
meter to calculate hydraulic diameter.

 l Rectangular Pipe - Requires width and height to calculate hydraulic diameter.
 l Size - Select from a list of defined nominal sizes for the selected Pipe Material. Only avail-

able for library materials.
 l Type - Select from a list of defined types (classes/schedules) for the selected Pipe Mater-

ial. Only available for library materials.
 l Geometric Specification - Several required fields that change depending on the selec-

ted Pipe Geometry. Only editable for User Specified Pipe Material.
 l ID Reduction (Scaling) - Reduction in hydraulic diameter due to scaling can be accoun-

ted for by entering a percent reduction in this field. Zero represents no reduction.

Length

The Length is defined as the distance between the two connecting junctions. This length has no 
relationship to the visual length of the pipe drawn on the Workspace.

Model As Zero-Length Connector can be checked to turn the pipe into a lossless connection 
between two junctions, such as for two components that are directly welded together. Zero-
Length Connectors (ZLCs) are denoted by a red C icon next to the pipe name on the Workspace. 
Intermediate branching flow is not allowed between two ZLCs.

ZLCs are hidden by default in the Model Data and Output. Generally the output for ZLCs is not of 
interest because they will have the same inlet and outlet properties.

You can enable ZLCs to be shown in the Model Data by opening the Model Data Control, going 
to the Show Selected Pipes/Junctions tab, and selecting the Show Zero-Length Connectors 
checkbox under the list of pipes. The same checkbox is present in the Output Control on the 
Show Pipes/Jcts tab. You will then need to click on the pipe numbers in the list to make them vis-
ible in the Model Data or Output, or you can use the All button to select all pipes in the model.

Friction Model

Multiple friction data sets can be compiled for each library pipe material. These different data 
sets are then made available in the Data Set drop down list. For AFT standard materials, the fric-
tion data set is generally "Standard."

The Friction Model can be modified for any individual pipe, and the default friction model can be 
set in Parameter Options. The Friction Model for a library material can be modified by selecting 
the User Specified radio button in Data Set, and must be directly specified for User Specified 
materials.

Theses models apply to Newtonian viscosity models. If a non-Newtonian model is selected in 
Analysis Setup, the below friction models may not be used.
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 l Absolute roughness (default) - Absolute average roughness height. Values of pipe 
roughness can be found in many pipe handbooks or from manufacturer's data.

 l Relative roughness - Relative roughness is the absolute roughness divided by the pipe 
diameter.

 l Hydraulically smooth - Hydraulically smooth implies that roughness is negligible. This is 
not the same as frictionless.

 l Explicit Friction Factor - Friction factor for the pipe, you can enter the value explicitly.
 l Frictionless - For troubleshooting purposes, it is occasionally useful to model a pipe as 

having no friction. There are limitations to where such a pipe can be located in your 
model.

 l Hazen-Williams - A method using an empirical factor to relate flow and pressure drop, 
common in water distribution and NFPA fire protection.

 l MIT Equation - A model appropriate for crude oil.
 l Miller Turbulent - A model appropriate for light hydrocarbons.

For detailed information on how these Friction Models are defined, see Pressure Drop in Pipes - 
Detailed Discussion.

Related Topics

Pipes 213
Pipe Properties Window 213
Common Pipe Input Parameters 214
Fittings & Losses 217
Heat Transfer in Pipes 219
Insulation for Pipes 237
Fluid Properties for Pipes 238
Optional Input for Pipes 239
Add/Remove Pipe Segment 243
Reverse Direction 243
Pressure Drop in Pipes - Detailed Discussion 244

Fittings & Losses
Fittings & Losses allows the user to define additional losses directly in a pipe. This is useful to 
account for pressure losses without modeling large numbers of elbows or similar fittings. To spe-
cify losses, open the Pipe Properties window, click the Fittings & Losses tab, then click Specify 
Fittings & Losses to open the Pipe Fittings & Losses window. An Additional K Factor loss can 
also be user specified.

Pipe Fittings & Losses

The Fittings & Losses library contains many standard loss values. Because many of these val-
ues are dependent on pipe diameter, a pipe diameter must be specified to open the Pipe Fittings 
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& Losses window.

Losses are divided into several categories represented by tabs. To add fittings to the pipe, select 
the type, and adjust the quantity column next to the desired fitting.

After accepting the changes by clicking OK, a summary of the pipe's Fittings & Losses will be dis-
played in the Pipe Properties window.

Note: Area Change fittings do not change the size of the pipe, they only represent the loss 
factor based on the pipe diameter and the area ratio of the loss. When including area 
changes, notice the illustration of how the loss is defined, where Apipe is the area of the 
pipe and As is the area of the loss. These area changes are useful to model fittings 
between a pipe and another junction like a pump.

If you are using Equivalent Lengths, the table displayed will be a simpler form that allows the 
addition of specific bends and valves (the equivalent lengths displayed here are taken from 
NFPA13). You can also simply type in additional equivalent length.

The bottom of the table will show a Total Applied value which is a count of the number of losses 
that have been specified for the currently selected tab.

Figure 1: Pipe Fittings & Losses window
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Fittings & Losses Workspace Symbol

When a pipe has any loss value assigned through the Fittings & Losses tab, a symbol (default of 
&) is added before the pipe number.

Favorite Fittings & Losses

In the Pipe Fittings & Loses window, there is a column labeled Favorite for each of the loss types. 
Check the box for favorite to add it to the list of favorite fittings and losses. On the left side of the 
window there are several options to filter the list. For example, one may only want to see Crane 
fittings. In which case, Crane should be checked, and all others unchecked on the left hand side 
of the window. If a list of only favorite fittings is desired, check the box to "Show Favorites Only".

Related Topics

Pipes 213
Pipe Properties Window 213
Common Pipe Input Parameters 214
Pipe Model 215
Heat Transfer in Pipes 219
Insulation for Pipes 237
Fluid Properties for Pipes 238
Optional Input for Pipes 239
Add/Remove Pipe Segment 243
Reverse Direction 243
Pressure Drop in Pipes - Detailed Discussion 244
Fittings & Losses Library 723
Equivalent Length 270

Heat Transfer in Pipes
The Heat Transfer tab is only visible when heat transfer is being modeled. Heat transfer mod-
eling is enabled in Analysis Setup on the Heat Transfer/Variable Fluids panel.

Each pipe responds thermally to the environment outside of the pipe. AFT Fathom offers several 
models that allow you to model the heat transfer characteristics of a pipe:

 l Adiabatic (Perfectly Insulated) - An adiabatic pipe is one that has perfect insulation and 
thus no heat transfer takes place. This model differs from Isothermal in that the tem-
perature into the pipe is taken from the upstream junction. This is the default model. Insu-
lation data can be entered but is not used for thermal purposes.

 l Isothermal - The Isothermal model maintains the pipe at the specified temperature. Insu-
lation data can be entered but is not used for thermal purposes.
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 l Convective Heat Transfer - This model allows you to specify heat transfer data for the 
internal fluid, pipe wall, three layers of insulation and external convection.

 l Convective Heat Transfer and Heat Flux - This model allows you to model convective 
heat transfer while also specifying a constant heat flux.

 l Convective Heat Transfer with Heat Tracing - This represents adding some type of heat-
ing layer onto the pipe's outer surface. The amount of heating may be entered as a con-
stant heat flux or by providing information on the power and number of wire turns. 
Insulation layers can then be added on top of the heat tracing (heat flux source).

 l Constant Heat Flux - The constant heat flux model is useful in cases where the tem-
perature difference between the fluid and the ambient environment is extremely large or 
in cases where a large radiant heat flux exists. Insulation data can be entered but is not 
used for thermal purposes.

 l Constant Heat Rate – This model allows you to specify a constant heat rate into or out of 
the pipe.

 l Buried Pipe - This model allows you to specify that the pipe is buried in a thermally con-
ductive medium.

Note that similar to flow rate definition, heat flow is positive when flowing into the pipe, and neg-
ative when flowing out.

Viewing Calculated Thermal Results in Output

A table is displayed in the Output window Pipe area showing the temperature distribution in the 
pipe and insulation.

Figure 1: Thermal Data table in Output window Pipe area shows temperature distribution in pipe

Clicking the button next to Show brings up a Results Diagram for that particular pipe:
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Figure 2: Pipe Heat Transfer Results Diagram

Related Topics

Pipes 213
Pipe Properties Window 213
Common Pipe Input Parameters 214
Pipe Model 215
Fittings & Losses 217
Insulation for Pipes 237
Fluid Properties for Pipes 238
Optional Input for Pipes 239
Add/Remove Pipe Segment 243
Reverse Direction 243
Pressure Drop in Pipes - Detailed Discussion 244

Related Blogs

Let the Heat Flow: Modeling Heat Transfer in Pipes in AFT Fathom and AFT Arrow
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Constant Heat Transfer
There are several thermal models for pipes in AFT Fathom which fix the thermal behavior of the 
pipe to some constant value:

 l Adiabatic (Perfectly Insulated) - The heat transfer between the pipe and the envir-
onment is fixed to zero. The entire length of the pipe will have a stagnation enthalpy equal 
to that of the upstream junction. The actual fluid temperature depends on the system.

 l Isothermal - The fluid temperature is set to a specified value. Heat transfer is still 
modeled in this case - instead of varying the fluid temperature, the heat rate into or out of 
the pipe is found that satisfies the isothermal constraint.

 l Constant Heat Flux - A constant heat flux (heat rate per area) is applied to the pipe. Pos-
itive values indicate heat entering the pipe. Flux is often a more readily available and flex-
ible value for some conditions, such as radiation heat transfer. For this model, the heat 
flux is applied to the area defined by the ID of the pipe. To model a heat flux underneath 
insulation, use the Convective Heat Transfer with Heat Tracing model.

 l Constant Heat Rate - It may also be known that a certain pipe transfers (or needs to 
transfer) a specific heat rate, regardless of the size of the pipe. This model allows the spe-
cification of a constant energy per time into or out of the pipe.

The above models follow a common format on the Pipe's Heat Transfer tab, as shown below. 
There is only one required value input unless insulation is added. One layer of insulation 
(external or internal) can be added, with conductivity values from a library or User Specified in 
this window.

Note: The Heat Transfer tab will not be present unless heat transfer has been enabled from 
the Heat Transfer/Variable Fluids panel of the Fluid Properties group in the Analysis 
Setup window.

Figure 1: Constant Heat Flux

Related Topics
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Heat Transfer in Pipes 219
Convective Heat Transfer 223
Heat Tracing Flux based on Wire Turns and Length 226
Buried Pipe Heat Transfer 226
Heat Transfer in Pipes - Detailed Discussion 230

Related Blogs

Let the Heat Flow: Modeling Heat Transfer in Pipes in AFT Fathom and AFT Arrow

Convective Heat Transfer
There are 3 convective based models for pipe heat transfer:

 l Convective Heat Transfer - Represents a pipe thermally affected solely by convection.
 l Convective Heat Transfer and Heat Flux - Behaves the same as the Convective Heat 

Transfer model, but also includes the effect of an external heat flux such as radiation.
 l Convective Heat Transfer with Heat Tracing - Similar to the Convective Heat Transfer 

and Heat Flux model, but instead of applying the flux on the outermost surface of the 
pipe/insulation, the flux can be applied directly to the pipe. As the name suggests, this rep-
resents a device such as a heated wire. If the flux is not known directly, it is easy to 
determine based on Wire Turns and Length.

Defining the Convective Model

When one of the convective heat transfer models is selected, there are a number of items that 
must be defined:

 l Resistance Geometry - Radial or Linear.
 l Number of Insulation Layers - There can be up to three layers of insulation defined, in 

any combination of internal or external.
 l External Heat Flux - Only available if Convective Heat Transfer and Heat Flux is selec-

ted. A constant flux applied to the outermost layer of resistance.
 l Heat Tracing on Pipe (Flux) - Only available if Convective Heat Transfer with Heat Tra-

cing is selected. A constant flux is applied at the outer wall of the pipe.
 l Ambient Conditions - The temperature and velocity of the fluid around the pipe. The 

fluid can be either air or water. These values are used for calculating the convection coef-
ficient if correlation is selected as the convection Data Source. This correlation can be 
used for pipes over which boundary layers develop freely, free of constraints imposed by 
other surfaces. All of the external fluid properties are evaluated at the film temperature 
using data from the NIST REFPROP fluid library.

 l Resistance Table - The table at the bottom of the window defines all of the resistance lay-
ers used in the thermal model.
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 l Rows
 l Units - This special row defines the units of any value in the column below a 

cell.
 l Fluid Internal - The fluid itself has a convection coefficient that affects the 

transfer of energy to the pipe wall. By default, the Gnielinski Correlation is 
used to determine this value. Alternatively, the Dittus-Boelter Correlation 
can be used, or a User Specified value can be entered.

 l Pipe Wall - The wall of the pipe has a thermal conductivity that affects the 
heat transfer. The built-in pipe materials have thermal conductivity values 
defined, and this value is automatically selected. If a User Specified pipe is 
used, the conductivity will need to be entered.

 l Insulation - There can be several insulation rows, depending on the selec-
tion of Number of Insulation Layers. The Insulation can be selected from the 
Insulation library, in which case the conductivity is read from the library. 
User Specified insulation requires this value to be defined.

 l External - Convection occurring external to the pipe and any insulation lay-
ers. By default the Convection Coefficient is calculated with the Churchill-
Bernstein Correlation. The Correlation can also be set to Free-Horizontal or 
Free-Vertical which requires only an ambient temperature, and no fluid velo-
city. The Free Horizontal and Free Vertical orientations are in reference to 
the orientation of the pipes. If the convection coefficient is known, a value 
can be entered by the user.

 l Columns
 l Apply - This can allow enabling/disabling of including certain layers in the 

calculation. This is useful for comparing states or scenarios without rede-
fining the thermal model.

 l Conductivity/Convection Data Source - Specifies from where relevant 
information is attained. This can be a Library, Correlation, or User Specified.

 l Conductivity - Applies to the Pipe Wall and Insulation. If Data Source is a 
Library, the particular insulation must be selected. If User Specified, the con-
ductivity must be entered. Note that obtaining the thermal conductivity from 
an insulation or pipe material library permits temperature dependent 
thermal conductivity to be employed. With this option, AFT Fathom dynam-
ically selects the insulation thermal conductivity during model solving based 
on the local temperatures that exist. Conversely, user specified values are 
always constant.

 l Thickness - Applies to Pipe Wall and Insulation. If a Library is used for the 
Pipe Material, this value is automatically populated. All insulation layers 
require a thickness. If a Pipe Material is chosen on the Pipe Model tab, and 
that material has insulation data sets associated with it, an option is 
provided in the Conductivity/Convection Data Source column to select that 
insulation data set. The insulation data sets include the insulation thickness, 
and value is displayed in the thickness column.

 l HT Area Ratio - Multiplier for the value of surface area used in the heat 
transfer calculations (default value of 1). In general, this represents any 
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"extra" heat transfer area that may exist. For example, cooling fins on the 
outside of the pipe could be modeled by entering a value larger than 1 on 
the External resistance row.

 l Convection Coefficient - Applies to Fluid Internal and External. Both val-
ues can be either Correlation or User Specified.

Figure 1: Convective Heat Transfer Layout

Modeling a Constant Wall Temperature

Assign an ambient temperature and disable the External Resistance by unchecking the box in 
the Apply column. This will force the outside wall of the pipe to be equal to the ambient tem-
perature. Note that this differs from isothermal in that the fluid temperature can still change - only 
the outside wall of the pipe has a fixed temperature.

Related Topics

Heat Transfer in Pipes 219
Constant Heat Transfer 222
Heat Tracing Flux based on Wire Turns and Length 226
Buried Pipe Heat Transfer 226
Heat Transfer in Pipes - Detailed Discussion 230
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Buried Pipe Heat Transfer
Buried Pipe Heat Transfer follows a form very similar to the Convective Heat Transfer models.

Figure 1: Buried Pipe Window

The differences between convective heat transfer and buried pipe heat transfer are:

 l The Ambient Conditions are now the Soil Surface Temperature and Buried Pipe Depth. 
Specifically, the Soil Surface Temperature asks for the temperature of the soil at the 
ground surface (as opposed to the ambient air temperature), while the Buried Pipe Depth 
asks for the distance between the ground surface and pipe centerline.

 l The External Resistance Type is replaced with Soil. This requires a User Specified value 
of conductivity for the soil 

Related Topics

Heat Transfer in Pipes 219
Constant Heat Transfer 222
Convective Heat Transfer 223
Heat Tracing Flux based on Wire Turns and Length 226
Heat Transfer in Pipes - Detailed Discussion 230

Heat Tracing Flux based on Wire Turns and Length
The Convective Heat Transfer with Heat Tracing model requires the user enter additional inform-
ation to represent the thermal effect of a heat tracing.

Fathom allows users the ability to model Heat Tracing by either entering the heat flux directly, or 
by providing information on the number of turns and power per unit length of wire, which Fathom 
will use to determine the heat flux as described below.
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Figure 1: Pipe Properties window with the Conv. Heat Transfer with Heat Tracing model enabled

Power and Turns - Detailed Discussion

When you select the option to model Heat Tracing based off a heated wire, Fathom models that 
heat flux based on the theory described below.

Figure 2: Wire tracing geometry

Length of Wire

First, it may be necessary to determine the length of the wire itself, based on a number of turns.
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 l N - total number of turns on the pipe
 l n - number of turns per unit length
 l LPipe - total length of the pipe
 l r - external radius of the pipe
 l LWire - length of the wire
 l LTurn - length of one wire turn

The above figure shows a pipe with heat tracing that has been "split open" and laid into a flat rect-
angle to make these equations more intuitive.

The total turns and turns per length are related by the pipe length:

Each turn of the wire creates a right triangle on the "flattened" pipe, so we can find the length of 
each segment by the Pythagorean theorem.

The total length of the wire is related to the number of turns and the segment length.

Incorporating this relationship and rearranging:

Using the number of turns per unit length:

or:
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Flux of Wire

With the length of the wire found, the flux based on power per length can be found.

 l PTotal - total power usage of the wire, along the entire pipe length
 l p - power per unit length
 l Q'' - heat flux
 l A - area heat flux is applied to

The heat flux is defined as the heat delivered per area. Here, we assume that the "total power" 
used by the heat trace is equivalent to the total heat delivered. Therefore:

The total power is equal to the power per length times the length, and area is related to pipe geo-
metry:

Substituting in for LWire:

 
Simplifying:

Related Topics

Heat Transfer in Pipes 219
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Constant Heat Transfer 222
Convective Heat Transfer 223
Buried Pipe Heat Transfer 226
Heat Transfer in Pipes - Detailed Discussion 230

Heat Transfer in Pipes - Detailed Discussion

Figure 1: Diagram of a pipe with Heat Tracing and Insulation

There are many possible combinations of heat transfer that can be defined in AFT Fathom. In 
any of these models there are various heat flows that can be considered.

Figure 1 shows the heat rates for one of the more complex cases – convective heating with a 
heat trace on the outer face of the pipe wall. Because this is a steady-state problem, any control 
volume that is drawn around sub-sections or the entire section must have entering heat equal to 
leaving heat.

Balancing these heat rates and temperatures via iterative methods allows AFT Fathom to come 
to a unique solution.

Heat Rates

As a hydraulic solver, the primary heat rate of interest is , the heat added to the fluid itself. 
Adding heat to the fluid has the effect of raising its temperature.

We can derive an expression for  with the first law of thermodynamics. For convenience, 
we use specific quantities (per unit mass)

The energy e is composed of internal energy u and kinetic energy V2/2. Note that the gravity 
term gz is neglected from this equation to simplify the derivation.
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The work done by the fluid is comprised of pressure work pv and shaft work wshaft

Combining and rearranging

Using the definition of enthalpy

In this analysis, we consider that the velocity through the control volume remains constant. In 
reality, changing temperature will cause the density of the fluid to change, and thus the velocity. 
For this reason, pipes in AFT Fathom are thermally sectioned. This means that certain properties 
are considered constant throughout the section as an approximation – having several sections in 
a pipe helps increase the accuracy of this approximation.

There is also no shaft work being done on the fluid.

We further assume that this can be treated thermodynamically as a constant pressure process. 
That is, cp is constant in the thermal section, like density. With this assumption we can use the 
relationship
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To find that

Rather than using specific quantities, it is useful to relate heat rate and mass flow. Multiply both 
sides by ṁ

The other heat rates in the system can be related to  and other user defined values like 

 or   by examining various control volumes and surfaces:

We now have a system of equations that allow us to determine all the heat rates in the system 
given a mass flow (determined hydraulically), a specific heat (defined versus temperature) and a 
change in temperature. However, we do not know what this change in temperature is. To find it, 
we need to relate the surface temperatures to the heat rates.

Surface Temperatures and Resistance

Thermal resistances are useful because they directly relate the heat rate between two points 
with the temperature between those points.

The value of resistance depends on the mechanism of heat transfer
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For conduction, the area and thus resistance changes with increasing r, so an integration must 
be done

These resistances can all be calculated with user-defined data. AFT Fathom helps simplify this 
by offering several correlations that can be used to determine the heat transfer coefficients in the 
above equations from more readily available parameters.

With resistances and , all the surface temperatures can be determined. By bounding the 
system with a given Tambient we can work outside in to find the required Tfluid to obtain those 
heat rates.
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If the result for Tfluid matches the values used for ΔTfluid used for determining , the correct 
solution has been found. If they are different, ΔTfluid needs to be adjusted and the process 
repeated until reaching a stable solution.

Overall Heat Transfer

Wherever there are sequential thermal losses, it is convenient to combine these losses. This is 
straightforward:

Additionally, an overall heat transfer coefficient U can be defined which behaves similarly to h or 
k

Using the heat rate and resistance relationship, as well as the fact the heat transfer is into the 
fluid
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Transforming the equation into a differential form on radius and length

Rearranging and integrating

We arrive at an expression relating the temperature change along the pipe and temperature 
change through the pipe:

Correlations

Thermal resistances depend on the conduction and convection coefficients k and h which can be 
directly specified or calculated via a correlation.

The convection coefficient for internal fluid convection can be calculated with the Gnielinski Cor-
relation or the Dittus-Boelter Correlation found in Incropera. These correlations determine the 
Nusselt number of the fluid – a ratio of convective to conductive heat transfer. Conductive prop-
erties are required input – with a Nusselt number and conductivity defined, the convection coef-
ficient can be calculated.
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These correlations also make use of the Prandtl number, a ratio of viscous diffusion to thermal 
diffusion.

Gnielinski

 
Dittus-Boelter

External convection behavior differs from the above. AFT Fathom provides the Churchill-Bern-
stein correlation for determining a convection coefficient from ambient temperature and fluid velo-
city. This correlation can be used for pipes over which boundary layers develop freely, free of 
constraints imposed by other surfaces. All of the external fluid properties are evaluated at the 
film temperature.

 

Buried Pipe Heat Transfer

Buried Pipe heat transfer is modeled by solving directly for the thermal resistance of the soil 
layer. AFT Fathom uses a model developed by Eckert and Drake to directly calculate the thermal 
resistance of soil on top of a pipe for use in the overall thermal resistance network:
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In this model, z is the distance between the ground surface and the pipe centerline, while r is the 
outside radius of the pipe.

Related Topics

Heat Transfer in Pipes 219
Constant Heat Transfer 222
Convective Heat Transfer 223
Heat Tracing Flux based on Wire Turns and Length 226
Buried Pipe Heat Transfer 226

Related Blogs

Let the Heat Flow: Modeling Heat Transfer in Pipes in AFT Fathom and AFT Arrow

Insulation for Pipes
In general, insulation data can be entered either on the Insulation tab or Heat Transfer tab. Only 
one of these tabs displays at a time. Insulation input depends on whether or not heat transfer is 
being modeled, and is an optional input. Insulation data is from the Nayyar Piping Handbook 
2000 pages B.325-B.344.

If Heat Transfer Is Not Modeled

If heat transfer is not modeled, then a separate Insulation tab appears on the Pipe Properties 
Window. The insulation will have no thermal effect.

 l Insulation on Outside of Pipe or Duct - If the insulation is on the outside of the pipe or 
duct, it will have no hydraulic effect, and will only affect cost calculations if they are 
enabled.

 l Insulation on Inside of Pipe or Duct - If the insulation is on the inside of the pipe or 
duct, it will reduce the flow area and change the pressure drop calculations. AFT Fathom 
accounts for this diameter reduction in such cases. The user must enter the insulation fric-
tion characteristics.

If Heat Transfer Is Modeled 

When heat transfer is modeled, insulation input occurs on the Heat Transfer tab. There is no 
Insulation tab in this case.

 l Convective Heat Transfer Not Used - If a heat transfer model other than convective 
heat transfer is selected, the effect of insulation is the same as discussed above for the 
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non-heat transfer case.
 l Convective Heat Transfer Is Used - If convective heat transfer is selected, the effect of 

insulation is the same as discussed above for the non-heat transfer case except now the 
thermal effect of the insulation is accounted for.

Related Topics

Pipes 213
Pipe Properties Window 213
Common Pipe Input Parameters 214
Pipe Model 215
Fittings & Losses 217
Heat Transfer in Pipes 219
Fluid Properties for Pipes 238
Optional Input for Pipes 239
Add/Remove Pipe Segment 243
Reverse Direction 243
Pressure Drop in Pipes - Detailed Discussion 244

Related Blogs

Let the Heat Flow: Modeling Heat Transfer in Pipes in AFT Fathom and AFT Arrow

Fluid Properties for Pipes
This folder tab is only visible when variable properties are being modeled. Variable property mod-
eling is enabled in Analysis Setup on the Heat Transfer/Variable Fluids panel.

For models with variable fluid properties, you can assign different fluid properties to each pipe in 
the model. This is convenient for modeling systems that are subject to temperature variations 
and systems that have multiple fluids. The pipe fluid properties are displayed in the Pipe Prop-
erties Window, and can be modified by selecting the Fluid Properties button. Besides varying the 
fluid properties, the viscosity model can be varied from pipe to pipe. Thus some pipes in the 
model can be modeled as Newtonian, while others as non-Newtonian.

Related Topics

Pipes 213
Pipe Properties Window 213
Common Pipe Input Parameters 214
Pipe Model 215
Fittings & Losses 217
Heat Transfer in Pipes 219
Insulation for Pipes 237
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Optional Input for Pipes 239
Add/Remove Pipe Segment 243
Reverse Direction 243
Pressure Drop in Pipes - Detailed Discussion 244

Optional Input for Pipes

Initial Flow Guess

The Initial Flow Guess for a pipe can be specified. An appropriate initial guess can decrease the 
number of iterations required to arrive at a converged solution.

The Solver generates initial guesses on its own, which is usually sufficient to get the Solver going 
in the right direction so a converged solution results. If this is not the case, user defined guesses 
can help obtain a solution.

Parallel Pipes

A single pipe object can be specified as a number of parallel pipes. When multiple pipes are 
defined, the parameters in the pipe properties window represent only one of the parallel pipes.

Special Condition

The Special Condition for the pipe can be set to None or Closed. Setting this to closed prevents 
flow through the pipe, like closing a valve. A symbol (default of "X") will be placed before the pipe 
label and the pipe will appear dashed, indicating that it is closed.

Design Factors

A design factor can be used to add safety margins into the hydraulic analysis. For pipes, three 
design factors exist:

 l Pipe Friction - friction factor is multiplied by the design factor assigned to the pipe.
 l Pipe Fittings & Losses - total loss factor (K factor or Equivalent Lengths) is multiplied by 

the design factor assigned to the pipe.
 l Pipe Heat Transfer - the thermal resistance for each heat transfer layer is divided by the 

design factor assigned to the pipe.

Intermediate Pipe Elevations

The inlet and exit elevations of a pipe are equal to the elevations of the upstream and down-
stream junctions. The pipe elevation is assumed to vary linearly between the junctions. In other 
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words, the pipe is assumed to be perfectly straight.

Modeling a large number of elevation changes with straight pipes would require a large number 
of junctions, as shown below:

Figure 1: Accounting for elevation changes with many pipes and junctions

This is tedious and not required for overall hydraulic calculations - only the elevation change 
across a (fluid full) pipe is needed. However, intermediate pressure results along the pipe will be 
affected.

For example, Figure 1 shows elevation extremes both lower and higher than the elevations at 
the ends of the pipeline. Low points may exceed maximum allowable pressures, and high points 
could drop below vapor pressure. If this is modeled as a single straight pipe these issues would 
not be easily identified. In fact, if these pipes were replaced with a single pipe it would show no 
elevation change at all!

Instead of using a large number of pipes, these effects can be accounted for in a single pipe 
using intermediate pipe elevation feature.

With length defined, check Use Intermediate Pipe Elevations, choose the elevation units, the 
number of intermediate elevations (a 2 segment pipe has 1 intermediate elevation), and whether 
the entered values are Point to Point or Length Along Pipe.
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Figure 2: Intermediate Elevations - Identical Profiles defined with both methods

AFT Fathom will ensure the total length matches the length on the Pipe Model tab. It does so by 
fixing the length of the final section to the difference between the sum of the lengths in the table 
and the actual length entered by the user. The end elevation is also fixed by the downstream 
junction. If the user later modifies the downstream junction elevation, the pipe's final elevation 
section will be automatically updated.

After the intermediate elevations have been entered, a graph showing the data can be displayed. 
Below is the profile graph of the pipe described above.
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Note that a pipe with intermediate elevations entered can be split into multiple pipes connected 
with branches at the intermediate elevation points. See Joining and Splitting Pipes for more 
information.

Figure 3: Intermediate Elevation Graph

Related Topics

Special Conditions 212
Optional Input for Junctions 258
Turn Off Parts of the Model 808
Pipes 213
Pipe Properties Window 213
Common Pipe Input Parameters 214
Pipe Model 215
Fittings & Losses 217
Heat Transfer in Pipes 219
Insulation for Pipes 237
Fluid Properties for Pipes 238
Add/Remove Pipe Segment 243
Reverse Direction 243
Pressure Drop in Pipes - Detailed Discussion 244
Pipe X segment length Y is shorter than the elevation change 793
Transfer Results to Initial Guesses 802
Make Initial Flow Rate Guesses for Pipes 807
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Related Blogs

Intermediate Elevations and Splitting Pipes

Add/Remove Pipe Segment
Visual segments can be added to pipes.

To add or remove segments, use the Arrange Menu, Add/Remove Segments submenu. These 
options are also available on the Workspace Toolbar.

Note: These segments are useful for creating a clear layout of the system, but have no impact 
on the solution - a visual bend is not the same as adding a Bend junction.

Related Topics

Pipes 213
Pipe Properties Window 213
Common Pipe Input Parameters 214
Pipe Model 215
Fittings & Losses 217
Heat Transfer in Pipes 219
Insulation for Pipes 237
Fluid Properties for Pipes 238
Optional Input for Pipes 239
Reverse Direction 243
Pressure Drop in Pipes - Detailed Discussion 244

Related Blogs

Intermediate Elevations and Splitting Pipes

Reverse Direction

Reference Positive Flow Direction

Next to each pipe's ID number is an arrow that indicates the reference positive flow direction for 
the pipe. AFT Fathom assigns a flow direction corresponding to the direction in which the pipe is 
drawn. You can reverse the reference positive flow direction by choosing Reverse Direction from 
the Arrange menu or selecting the reverse direction button on the Toolbar. With exception to 
some junctions, the reference positive flow direction is used for reference purposes only and 
does not need to correspond with the real direction of flow calculated by the Solver (the part of 
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AFT Fathom that applies the governing incompressible flow equations to obtain a solution to the 
pipe system). If the flow direction obtained by the Solver is opposite of the reference positive flow 
direction, then the output will show the flow rate as a negative number.

Note: The reference positive flow direction is important for pumps because the pipe directions 
will define which side is suction vs discharge. Furthermore, reverse flow through com-
ponents may result in a Caution message which may or may not be valid depending on 
the intended direction of flow.

Related Topics

Pipes 213
Pipe Properties Window 213
Common Pipe Input Parameters 214
Pipe Model 215
Fittings & Losses 217
Heat Transfer in Pipes 219
Insulation for Pipes 237
Fluid Properties for Pipes 238
Optional Input for Pipes 239
Add/Remove Pipe Segment 243
Pressure Drop in Pipes - Detailed Discussion 244

Pressure Drop in Pipes - Detailed Discussion
Depending on the viscosity model and pipe friction model selected, the calculation of pressure 
drop in a pipe differs.

Darcy-Weisbach Loss Model

AFT Fathom utilizes the Darcy-Weisbach loss model to relate the Darcy Friction Factor, the pipe 
geometry, fluid density, and fluid velocity to pressure drop in the pipe. The Darcy Friction Factor 
differs from the Fanning Friction Factor by a factor of 4.

(1)

This model requires the calculation of a friction factor, as described below.

 l Roughness-Based Methods - This method calculates the friction factor based on the 
roughness of the pipe wall. Different equations are used based on flow regime - laminar 
flow uses the standard laminar relationship, while turbulent flow uses the implicit 
Colebrook-White equation. In the transition range between laminar and turbulent flow, a 
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linearly interpolated value is used. The default transition Reynold's Numbers can be mod-
ified in the Environmental Properties panel.

(2)

 l Absolute Roughness (default) - The absolute average roughness height ε is spe-
cified directly.

 l Relative Roughness - The roughness is specified as a ratio ε/D.
 l Hydraulically Smooth - The ratio ε/D is set equal to zero.

 l Explicit Friction Factor - The friction factor to be used in the Darcy-Weisbach equation 
is specified directly.

Frictionless

The pipe will not have any pressure drop across it. This is inherently unrealistic behavior, but can 
be useful for troubleshooting purposes.

Resistance

The pipe resistance relates head loss to volumetric flow rate. In equation form, the head loss is: 

(3)

Using standard relationships, the friction pressure drop is related to volumetric and mass flow 
rate as follows:

(4)

Non-Newtonian Pressure Loss

The pressure loss behavior for Non-Newtonian fluids depends on the specific viscosity model 
selected in Analysis Setup. See Non-Newtonian fluids for more information.
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Helical Tubes

For helical tubes the pressure drop is modified from the equivalent "straight pipe" pressure drop 
via the following relationship (Ito 1959):

(5)

Hazen-Williams Method

AFT Fathom also offers the Hazen-Williams method of specifying irrecoverable loss information. 
The traditional Hazen-Williams formula (Zipparro and Hasen editors, 1993, page 2.7) 

(6)

where

 l V        = Velocity (ft/s)
 l CHW        =  Hazen-Williams factor
 l Rh        = Hydraulic Radius (cross-sectional area divided by wetted perimeter)
 l S        = Hydraulic Gradient (ΔH/L)

can be modified to a more convenient head loss form for AFT Fathom:

(7)

where

 l V        = Velocity (ft/s)
 l CHW        =  Hazen-Williams factor
 l D        = Inner Diameter in feet (four times Rh for circular pipe)
 l L        = Length of Pipe (feet)

Also see Hazen Williams NFPA
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MIT Equation for Crude Oil

The MIT Equation is appropriate for crude oil and is given by the following equation (Pipe Line 
Rules of Thumb Handbook):

 

(8)

(9)

(10)

where:

 l dP       = pressure drop (psi)
 l L       = length (miles)
 l f       = friction factor, MIT
 l Q       = volumetric flow rate (barrels/day)
 l s       = specific gravity
 l d       = inside diameter (inches)
 l ν       = kinematic viscosity (centistokes)

The friction factor calculated by the MIT equations is not the same as the Darcy friction factor. 
Once the pressure drop (dP) in the pipe is determined, AFT Fathom uses the Darcy equation to 
back calculate the equivalent Darcy friction factor.

The MIT equation defines the lower bound for the laminar equation as r=0.1, but offers no explan-
ation as to the validity of calculations below this point. AFT Fathom continues to use the laminar 
flow equation for Reynolds numbers below 0.1. The older version of the MIT equations did not 
have this lower limit, and the results from AFT Fathom 11 agree closely with values from the 
older equations at these lower Reynolds number values.
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For Reynolds numbers in the Indeterminate flow regime, the value for the MIT friction factor is 
determined by linearly interpolating between the friction factors for the highest laminar Reynolds 
number and the lowest turbulent Reynolds number.

Miller Turbulent Method

The Miller Turbulent method is appropriate for light hydrocarbons and is given by the following 
equation (Pipe Line Rules of Thumb Handbook):

(11)

where:

 l dP       = pressure drop (psi)
 l L       = length (miles)
 l Q       = volumetric flow rate (barrels/hour)
 l ρ       = density (lbm/ft3)
 l ρwater       = density of water (62.3 lbm/ft3)
 l d       = diameter (inches)
 l μ       = dynamic viscosity (centipoise)

Design Factors

In each pipe you can specify a Design Factor for the pipe friction. This is a multiplier that is 
applied to the friction factor calculated with the preceding methods.

Related Topics

Pipes 213
Pipe Properties Window 213
Common Pipe Input Parameters 214
Pipe Model 215
Fittings & Losses 217
Heat Transfer in Pipes 219
Insulation for Pipes 237
Fluid Properties for Pipes 238
Optional Input for Pipes 239
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Add/Remove Pipe Segment 243
Reverse Direction 243

SSL Module 
Settling Slurry Module
An optional add-on module to AFT 
Fathom which allows users to sim-
ulate settling slurries.
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This section focuses on the Junctions in the AFT Fathom Workspace as well as the theories that 
govern the junctions. Topics included discuss the types of junctions that AFT Fathom provides, 
the required inputs for each junction, and theory topics that indicate how the inputs to the junc-
tion are used.

Contents

General Junction Information 252

Junction Loss Models 264

Area Change 271

Assigned Flow 273

Assigned Pressure 274

Bend 275

Branch 280

Check Valve 280

Control Valve 281

Dead End 284

General Component 285

Heat Exchanger 285

Jet Pump 290

Orifice 291

Pump 294

Relief Valve 335

Reservoir 338
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Screen 340

Spray Discharge 342

Tee/Wye 346

Three Way Valve 350

Valve 351

Venturi 354

Volume Balance 354

Weir 356

General Junction Information
The different types of junctions on the Toolbox offer a great degree of freedom in assembling a 
pipe network model. While there is some redundancy in capabilities between the junctions, each 
of the junctions offers specialized features to allow you to prepare a good conceptual model of 
the physical system of interest. Table 1 compares the features of the junction types.

There is a junction properties window for each junction type. Each junction Properties window 
falls into one of two basic window formats, depending on the number of connecting pipes 
allowed for that junction type.

Note: AFT Fathom does not prevent negative flow through junctions. Should this occur, AFT 
Fathom will use the same loss factor or pressure drop data referenced to the defined 
upstream pipe, just as in forward flow. Because it is possible that the loss factor or pres-
sure drop data would not be the same for both flow directions, the flow solution could be 
misleading. For this reason, it is important that you either properly define the pipe flow 
directions for junctions or pay close attention to the flow directions that result. Should 
negative flow occur in any junction, AFT Fathom will give a caution in the output.
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Table 1: Comparison of junction capabilities

Junction 
Type

Connecting 
Pipes

Special 
Conditions

Restricted 
Area

Custom Library Window 
Format

Area Change 2   Yes 1

Assigned Flow 1 Yes  Yes 1

Assigned Pres-
sure*

1/1-25   Yes 1

Bend/Elbow 2  Yes Yes 1

Branch 2-25 Yes  Yes 2

Check Valve 2 Yes Yes Yes 1

Control Valve 2 Yes  Yes 1

Dead End 1    1

General Com-
ponent

2 Yes  Yes 1

Heat 
Exchanger

2 Yes  Yes 1

Jet Pump 2 Yes  Yes 1

Orifice 2  Yes Yes 1

Pump 2 Yes  Yes 1

Relief Valve 1-2 Yes Yes Yes 1

Reservoir 1-25   Yes 2

Screen 2  Yes Yes 1

Spray Dis-
charge

1-4 Yes Yes Yes 2

Tee/Wye** 3    2

Three-Way 
valve**

3 Yes  Yes 2

Valve 1-2 Yes Yes Yes 1

Venturi 2  Yes Yes 1

Volume Bal-
ance

2    1

Weir 2 Yes Yes Yes 1
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*Assigned Pressure junction connects to only one pipe for static pressure, and up to 25 for stag-
nation

**Tee/Wye and Three-way valve junctions have a unique format closer to Format #2 than Format 
#1

Related Topics

Two Window Formats 254
Common Junction Input Parameters 257
Optional Input for Junctions 258
Specifying Losses 260
Conventions for Specifying Basis Area 260
Reference Density 261
Equal Percentage Valves 263

Two Window Formats

Format #1: Junctions with One or Two Connecting Pipes

The first basic window format is for junction types that allow only one or two connecting pipes 
(see Figure 1). While junctions do not have an explicitly defined flow direction like pipes do, typ-
ically those with two pipes or less adopt a direction from the connecting pipes. For these junction 
types, upstream and downstream pipes are recognized by AFT Fathom based on the reference 
positive flow direction of the connecting pipes. The upstream and downstream pipes are dis-
played separately near the top of the window.

In this first basic window type, it is generally important to have the pipe’s reference positive flow 
directions specified in the physically correct directions. A good example of this is a pump 
junction. A pump will add pressure to the system, but it does so only in the direction of positive 
flow through the connecting pipes. The Pump junction interprets where to add the pressure 
based on the directions of the connecting pipes.
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Figure 1: Properties window format #1 (fixed connecting pipe display)

Format #2: Junctions with More Than Two Connecting Pipes

The second basic window format for junction Properties Windows is for junctions that allow more 
than two connecting pipes (see Figure 2). These junctions typically allow up to twenty-five con-
necting pipes; the exceptions are the Three-Way Valve and Tee/Wye junctions, which allow only 
three.

Because the number of pipes connected to a junction may vary, the second basic format uses a 
table sized according to the number of connecting pipes.

An example of this second window format is the Branch Properties window, shown in Figure 2, 
which has three connecting pipes. To determine AFT Fathom's interpretation of the model con-
nectivity for this second window format, you can review the contents of the table areas.

K factors in the first column will be applied for flow into the pipe and out of the junction, while K 
factors in the second column will be applied for flow out of the pipe and into the junction. 
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Figure 2: Properties window format #2 (pipes displayed in a table)

Related Topics

General Junction Information 252
Common Junction Input Parameters 257
Optional Input for Junctions 258
Specifying Losses 260
Conventions for Specifying Basis Area 260
Reference Density 261
Equal Percentage Valves 263
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Common Junction Input Parameters

Number

Every junction must have a unique ID number. When new junctions are created, a junction num-
ber is automatically allocated.

The junction number can be changed by the user to any unique integer value greater than zero 
and less than 100,000. Junction numbers are only identifiers and have no effect on the model 
behavior.

Name

A name can be assigned to each junction for reference purposes. Names do not need to be 
unique. The name can be shown on the Workspace and in the Output window.

Library List

A list of all available custom components. It displays components from any connected library.

Selecting a component from this list automatically retrieves the junction settings and populates 
the properties window. Changing the input manually will deselect the component in the list.

Copy Data From Junction

The Copy Data From Junction dropdown list allows you to copy all or some of an existing junc-
tions' properties to the current junction. Selecting an existing junction will prompt the user on 
what parameters should be copied over.

In child scenarios, Copy Data From Junction lists "Parent Junction Data," allowing the user to 
copy all or some parameters from the parent junction.

Pipe Connectivity

The connected pipes are displayed. This is helpful to determine potential connection issues and 
easily identify which pipes are upstream and downstream of the junction.

Elevation

Every junction must have an elevation reference. This value is the centerline elevation of the con-
nected pipe(s).
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If multiple pipes are connected to a single junction, there are multiple elevations that must be 
defined. By default, all connected pipe centerlines are assumed to be at the same elevation. A 
different inlet/outlet elevation can be specified by unchecking the "Same as Inlet" box for junc-
tions with only two connecting pipes.

For junctions with more than two pipe connections, these elevations can be specified in the Pipe 
Depth or Loss Coefficients tab, depending on junction.

Elevations are used to account for pressure changes due to gravity. There can be a pressure 
changes due to elevation change in a pipe or a junction. Junction elevation changes will have no 
effect on the flow solution, but will offset the local static pressure by the hydrostatic pressure dif-
ference.

A default elevation can be specified in Parameter Options, automatically setting new junctions to 
the specified elevation.

Jump Feature

Quickly move to the next junction. See Jump Feature.

Related Topics

General Junction Information 252
Two Window Formats 254
Optional Input for Junctions 258
Specifying Losses 260
Conventions for Specifying Basis Area 260
Reference Density 261
Equal Percentage Valves 263
Pipe X length is shorter than the elevation change 793

Optional Input for Junctions

Initial Guesses

A user defined initial guess can be entered for pressure (or head) and temperature (if heat trans-
fer is modeled) for most junctions. This is only an initial guess for the Solver - the solution will 
vary from this value, and the value has no effect on the end solution.

A good initial guess can be helpful to decrease the number of Solver (the part of AFT Fathom 
that applies the governing incompressible flow equations to obtain a solution to the pipe system) 
iterations required, and potentially help with convergence issues.
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Special Conditions

The Special Condition can be changed for some junctions. For example, a valve can be set to 
closed, preventing all flow. A symbol (default of "X") will be placed before the junction label indic-
ating that a special condition is applied.

Design Factor

A design factor can be used to add safety margins into the hydraulic analysis. For junctions, 
three types of design factors exist:

 l Pump Junctions - head rise at the pump is multiplied by the design factor assigned to 
the pump.

 l Heat Exchanger Junctions - total rate of heat transfer is multiplied by the Heat Transfer 
design factor assigned to the heat exchanger. The total loss factor is multiplied by the Fric-
tion Loss design factor assigned to the heat exchanger.

 l All other junctions - total loss factor is multiplied by the design factor assigned to the 
junction.

Note: The design factor for pumps has the opposite effect on a system that the design factor 
for other junction types has. A design factor of 1.1 for junctions with a pressure loss will 
give an extra 10% pressure drop at that junction, adding resistance to the system. A 
design factor of 1.1 for the pump junction will give an extra 10% pressure rise, effect-
ively modeling the pump as having extra capacity than expected. To add a 10% safety 
margin to the pump junction, a design factor of 0.9 should be used.

Workspace Icon

The junction icon can be changed to better represent a specific junction type. This is accom-
plished by clicking the Change Icon button. Custom images can be added by clicking the Add 
Image button. The size of the junction can be changed via Workspace Layers.

Restricted Area

This is an optional parameter in several junction Properties windows which describes the effect-
ive flow area through the junction. This is done for the purpose of assessing cavitation. In most 
cases, information on the size of the restricted area must be obtained from handbook or test 
data.

Related Topics

Special Conditions 212
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Optional Input for Pipes 239
Turn Off Parts of the Model 808
General Junction Information 252
Two Window Formats 254
Common Junction Input Parameters 257
Specifying Losses 260
Conventions for Specifying Basis Area 260
Reference Density 261
Equal Percentage Valves 263
Transfer Results to Initial Guesses 802
Make Initial Flow Rate Guesses for Pipes 807
Cavitation May Exist at Junction X 782

Specifying Losses
Local losses can be specified in two ways. The most flexible way of including a loss factor in an 
AFT Fathom model is to associate it with a junction specifically defined for that type of loss. This 
allows you to define a loss as a function of a flow parameter such as Reynolds number or volu-
metric flow rate, or as a function of the area change ratio between the upstream and downstream 
pipes. This method results in the greatest clarity.

Secondly, you can include loss factors with pipes. When you specify Fittings & Losses in the 
Pipe Properties Window, the loss is assumed to be distributed evenly along the pipe length, 
much like friction losses. For this reason a pipe-associated loss factor is referred to as a dis-
tributed loss. The losses at junctions, on the other hand, are point losses.

Related Topics

General Junction Information 252
Two Window Formats 254
Common Junction Input Parameters 257
Optional Input for Junctions 258
Conventions for Specifying Basis Area 260
Reference Density 261
Equal Percentage Valves 263

Conventions for Specifying Basis Area
Loss factors are area dependent. When specifying a loss factor at a junction, the base area is of 
critical importance. By default, AFT Fathom adheres to the following convention: whenever it 
makes sense physically, the basis area is always the upstream pipe flow area. However, this can 
be modified by the user. In most junction Properties windows (on the Loss Model tab), the basis 
area can be specified as the upstream pipe, downstream pipe, user specified area, or user spe-
cified diameter.

However, some junction types, especially those that allow three or more connecting pipes, spe-
cify loss factors based on each connecting pipe flow area, whether upstream or downstream. An 
example of this is a Wye in which each of the connecting pipes has a different diameter. The idea 
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of specifying a loss factor based on upstream flow area loses meaning because there may be 
more than one upstream pipe. In these cases the loss factor is referenced to the base area of the 
actual downstream pipe(s) where it connects to the junction. The types of junctions that do not 
always follow the upstream pipe area convention are the Tee/Wye, Branch, Reservoir, Assigned 
Pressure, and Assigned Flow. Other exceptions are Valves and Relief Valves specified as exit 
valves, and Orifices specified as an exit.

Related Topics

General Junction Information 252
Two Window Formats 254
Common Junction Input Parameters 257
Optional Input for Junctions 258
Specifying Losses 260
Reference Density 261
Equal Percentage Valves 263

Reference Density
A relationship can be drawn for many components between flow energy and flow rate. This 
can be a decrease (e.g., a loss across a valve) or increase in energy (e.g. energy added by a 
pump). The specific parameter used to represent flow energy can vary depending on applic-
ation. It can be given in terms of pressure change or head change, and there is a critical dif-
ference between the two.

Consider a centifugal turbomachine (a pump or radial compressor): Kinetic energy is imparted to 
the fluid by accelerating it along the radius of the impeller. If the rate of rotation is held constant, a 
denser fluid will have more energy imparted to it than a lighter weight fluid. This would give rise to 
higher pressures. In other words, the pressure change depends on the density of the fluid.

Pump curves are generally provided in terms of head. This is convenient because head is a unit 
of specific energy - or energy per weight. Therefore, it does not vary with fluid density like pres-
sure does. The head added to a fluid by a pump at a fixed speed, for example, will be the same 
for water and liquid mercury.

However, head relationships are not always available or meaningful. If a pressure vs flow rela-
tionship is used, a reference density must be specified. This is the fluid density used during test-
ing and creation of the curve.
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Figure 1: Visual comparison of Pressure Loss Curves for differing densities. Head curves would be 
identical for this component

Affected Parameters

There are several parameters that are affected by the density of the fluid:

 l Pressure - As discussed above
 l Mass Flow - The mass term contains information about the density of the fluid
 l Power - More power is demanded by a pump to meet the head curve for a denser fluid. 

While head is independent of density and therefore often reported by manufacturers, 
power is not independent of density. Therefore, a proper specification sheet that includes 
power must also include the reference fluid density.

Accounting for Reference Density

Pumps and Resistance Curves allow for the specification of a reference density if one of the 
above parameters is selected. The selection appears below the curve fit area as shown in Figure 
2.

Figure 2: Reference Density Selection

- 262 -



Junctions

There are three options:

 l No Correction (default) - This selection assumes that the component was tested with 
the fluid defined in Analysis Setup on the Fluid panel.

 l Water @STP - This selection assumes the reference density - the density of the test 
fluid - is that of water at standard temperature and pressure. If the System Property fluid 
differs, the entered curve will be corrected.

 l User Specified - This directly specifies the reference density. If the System Property fluid 
differs, the entered curve will be corrected.

Related Topics

General Junction Information 252
Two Window Formats 254
Common Junction Input Parameters 257
Optional Input for Junctions 258
Specifying Losses 260
Conventions for Specifying Basis Area 260
Equal Percentage Valves 263

Equal Percentage Valves
Equal Percentage valves have a valve plug shaped so that each increment in valve percent open 
(lift) increases the flowrate by a certain percentage of the previous flow.

The relationship between valve lift and orifice size is not linear but logarithmic.

It is expressed mathematically as follows:

where:

 l τ = valve rangeability (ratio of the maximum to minimum controllable flowrate)
 l H = valve percent open or lift (0 = closed; 1= fully open)
 l Cv,max = full open valve loss value

Related Topics

General Junction Information 252
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Two Window Formats 254
Common Junction Input Parameters 257
Optional Input for Junctions 258
Specifying Losses 260
Conventions for Specifying Basis Area 260
Reference Density 261

Junction Loss Models
There are a number of loss models available in AFT Fathom to account for frictional losses at the 
junctions in the system. See the below topics for more information on how losses are calculated 
for each of the available models.

K Factor Loss Model
AFT Fathom models K-factor component losses according to the following equation:

where K is commonly referred to as the loss factor.

Table 1 lists the sources for the loss models used in AFT Fathom. The losses implemented dir-
ectly in the code were chosen on the basis of ease of use. Many loss factor types are functions of 
the flow, and thus too general to be easily incorporated (see the Resistance Curve topic for flow 
dependent loss applications).

Table 1: Loss model references

Junction Type References

Bend Crane 1988, A-29
Miller 1990, 207-209                         

Area Change Crane 1988, A-26
Idelchik 2007, 246 & 254                         

Orifice Idelchik 2007, 258-259 & 262

Screen Idelchik 2007, 598

Tee/Wye Idelchik 2007, Chapter 7
Miller 1990, 315-316 & 323                         

Valve Ingersoll-Rand 1970
Crane 1988, A-29                         
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Crane (1988) offers good general purpose correlations for modeling irrecoverable losses in pipe 
systems.

Another lesser known source of loss factor information is Idelchik's Handbook of Hydraulic 
Resistance (2007). This reference is indispensable for the engineer who must make detailed 
hydraulic assessments of pipe systems in which so-called minor losses play a significant role. 
The reference is voluminous in scope and full of tables, charts and equations for calculating loss 
factors for almost any pipe arrangement.

Miller's Internal Flow Systems (1990) is another reference offering good general purpose 
hydraulic data.

Related Topics

Flow is negative through Junction X. Loss factors may be in error. 789
Junction Loss Models 264
Kv and Cv Loss Model 265
Resistance Curve Loss Model 267
3-K (Darby) Method 268
Equivalent Length 270
Bend Loss Model 276
Area Change Loss Model 272
Orifice Loss Model 292
Screen Loss Model 341
Tee/Wye Loss Model 347
Valve Modeling Closures with K Factors 353

Kv and Cv Loss Model
AFT Fathom allows the user to enter valve coefficient data in terms of Kv or Cv. Conversions are 
handled seamlessly in the background. Kv is the metric equivalent to Cv.

Manufacturer Testing in Standard Units

Cv (Coefficient of flow for Valves) is a single parameter which relates fluid density (given in units 
of specific gravity), pressure drop (in psi), and flow rate (in gallons per minute).

One can get a better understanding of the role of Cv by setting the pressure drop (dP) and SG to 
1, in which case Cv is equal to flow in gallons per minute. Cv could be considered the flow capa-
city (in gpm) of a given fluid (i.e. a given SG) for a given pressure drop. Or, one may wish to cal-
culate the pressure drop through a valve, with a given Cv at a given flow rate.
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Manufacturer Testing in Metric Units

If the engineer is provided with valve data in metric units, they are also likely to be provided a 
value for Kv and not Cv.

The only difference is the units used for Q and dP. Kv uses flow units of m3/hr and pressure drop 
units of bar.

If one wishes to calculate pressure drop through a valve, with a given Kv, at a given flow rate, the 
same relationship applies.

Related Topics

Junction Loss Models 264
K Factor Loss Model 264
Resistance Curve Loss Model 267
3-K (Darby) Method 268
Equivalent Length 270
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Resistance Curve Loss Model
The resistance curve loss model is available in many different junctions. It is useful when meas-
ured flow vs pressure loss data is available for a component.

Clicking Enter Curve Data will open a new window where the input can be entered into a table. 
Several options for the Flow Parameter are available using the dropdown in the column header, 
and the appropriate units can be selected. Pressure loss can be alternatively entered as a head 
value.

Fill As Quadratic (Using a Single Known Data Point)

It is not uncommon to obtain only a single data point from an equipment manufacturer. For 
example, the data might be 3 psid pressure drop at 1 lbm/sec. In this case, the known data point 
can be entered into the first row of the data table. Then, selecting Fill As Quadratic will auto-
matically insert another two data points to be used with a quadratic curve fit. The first data point 
will be zero pressure loss at zero flow which is physically realistic for a static component. Note 
that elevation differences within a junction are accounted for externally by the Solver. The last 
data point will be a quadratic extrapolation using the zero point and the originally provided data 
point. Clicking Generate Curve Fit Now will create the curve fit constants and complete the res-
istance curve definition.

This method is often a reasonable approach to define a static component because the pressure 
drop characteristics of most equipment follows the square law. As the flow rate increases, the 
pressure drop increases with the square of the flow rate. Defining the component with a curve fit 
provides a robust solution where the junction can still provide a reasonable pressure loss even if 
the flow rate in the model is changed. This also aids in numerical convergence when running a 
transient simulation with the XTS Module.

In our example, an increase in the flow rate to 2 lbm/sec would result in a pressure drop of 12 
psid. Although this may not be exactly correct depending on the component, it is much better 
than assuming a flat 3 psid drop for all flow rates, which we know for certain is not correct.

Table 1: Example data points for pressure drop modeling using manufacturer data

Data Point Flow Rate
(lbm/sec)

Pressure 
Drop
(psid)

Comment

1 0 0
Always valid 
for passive 
equipment

2 1 3 Given by man-
ufacturer

3 2 12
Extrapolated 

assuming 
square law
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Curve Fitting

Curve fitting can be performed via a polynomial or interpolated data. The Curve Fit Order can 
also be changed to achieve a better fit to the data, and the curve fit constants are displayed in a 
table.

Note: Unrealistic behavior could occur if the curve fit does not pass through the origin of the 
graph. This may negatively impact convergence when running transient simulations 
that have zero flow through the component at a point in time. See the Troubleshooting 
Resistance Curves topic for more information.

Reference Density

Options to correct for a reference density are available when using mass or pressure para-
meters. This is useful for when the pressure loss data was measured with a different working 
fluid than what is used in the model. See the Reference Density topic for more information.

Related Topics

Junction Loss Models 264
K Factor Loss Model 264
Kv and Cv Loss Model 265
3-K (Darby) Method 268
Equivalent Length 270
Troubleshooting Resistance Curves 804
General Component 285
Heat Exchanger 285

3-K (Darby) Method
The 3-K method described in Darby, 2001, pp. 209-211, is used for high accuracy of predicted 
loss factors at low Reynolds numbers.  The 3-K loss model is available in the valve and bend junc-
tions where there is a dropdown menu to select from standard types of elbows and valves. After 
selecting an option in this menu, the 3 K's will be displayed at the bottom of the properties win-
dow. These values come from the chart in Darby on pages 210-211. The user can also select 
User Specified in the 3-K (Darby) dropdown menu to input their own values for K1, Ki, and Kd.

Where:
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 l Kf = Resistance coefficient
 l K1 = 3-K method constant
 l Ki = 3-K method constant
 l Kd = 3-K method constant
 l Re = Reynolds Number
 l Dn,in = Inner diameter

Figure 1: Bend Properties window when the 3-K (Darby) method is turned on

Related Topics

Laminar and Non-Newtonian Corrections Panel 121
Adjusted Turbulent K Factor Method (ATKF) 123
Improved ATKF Method 126
Note about Laminar Corrections for Fittings 129
Junction Loss Models 264
K Factor Loss Model 264
Kv and Cv Loss Model 265
Resistance Curve Loss Model 267
Equivalent Length 270
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Equivalent Length
The use of equivalent lengths is supported by AFT Fathom in the Valve junction, Bend junction, 
and the pipe Fittings & Losses. The options for bends and valves come from table 23.4.3.1.1 in 
NFPA 13. If you are not using the NFPA 13 standard then using a user-specified equivalent 
length is recommended. To enable NFPA reporting for use with equivalent length losses see the 
NFPA panel topic.

The loss factors in table 23.4.3.1.1 assume that a Hazen-Williams C-Factor of 120 and schedule 
40 steel piping are being used. If your reference pipe is defined using a different Hazen-Williams 
factor or different pipe schedule, then the equivalent length will be adjusted by equation 6.2 
(Equation 1 below) on page 103 of Brock, Pat D. 2012.

(1)

Where:

 l Leq = new equivalent length
 l L1 = original length
 l Deq = diameter of new equivalent length
 l D1 = original diameter
 l Ceq = C-Factor for new equivalent length
 l C1 = original C-Factor

This equation is intended for taking an equivalent length and adjusting for a new equivalent 
length based off changes to diameter and C-Factor. This is a general equation, but NFPA table 
data from table 23.4.3.1.1 is only for schedule 40 steel and a C-Factor of 120. Therefore, the 
adjusted equivalent length can be written as shown in Equation 2.

(2)

Equation 2 (adjusted from Brock et. al. Equation 6.2) will predict an adjusted equivalent length 
that coincides with the NFPA 13 equivalent length modifier 23.4.3.1.3.1 and the C-Value Mul-
tiplier from table 23.4.3.2.1. Note that if the reference piping is using a friction model other than 
Hazen-Williams, Ceq is assumed to be 120 and the equivalent length will not be adjusted due to 
friction.

Related Topics
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NFPA Panel 173
Hazen-Williams NFPA 175
Fittings & Losses 217
Fittings & Losses Library 723
Junction Loss Models 264
K Factor Loss Model 264
Kv and Cv Loss Model 265
Resistance Curve Loss Model 267
3-K (Darby) Method 268

Area Change
The Area Change junction type must always have two connecting pipes. This junction type 
allows you to model the irrecoverable loss that occurs at the area transition between two pipes, 
whether expansion or contraction.             

The Area Change Properties Window follows the first of the two basic Properties Window 
formats, displaying the connecting pipes in a fixed format. A flow direction through the junction is 
adopted from the defined directions of the two connecting pipes.             

The Area Change Properties Window offers two standard types of area change losses: the Con-
ical Transition and the Abrupt Transition.             

The critical parameter that influences the magnitude of the area change loss is the area ratio 
between upstream and downstream pipes. Until you have input the information for the upstream 
and downstream pipes that allow for flow area determination, the standard Area Change junction 
loss factor is not calculated. For conical transition geometries, you also need to specify the con-
ical angle. This angle has a range of 0-180 degrees, with a 0 degree angle representing a trans-
ition taking place over an infinitely long length, and a 180 degree angle representing an abrupt 
transition. A depiction of the angle is shown in Figure 1.             

If the standard loss factors provided are inadequate for your application, you may specify your 
own custom loss factor referenced to the basis area you specify. 

Figure 1: Angle for an area change

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264
Area Change Loss Model 272
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Area Change Loss Model
Two standard area change loss geometries are available: the conical transition and the abrupt 
transition.             

The conical expansion correlation (Crane 1988, A-26) is             

The conical contraction correlation (Crane 1988, A-26) is             

The abrupt expansion correlation (Idelchik 2007, 246) is             

The abrupt contraction correlation (Idelchik 2007, 254) is             
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Note: While a 180 degree conical transition is the same as an abrupt transition, Crane's con-
ical contraction equation gives a different result at 180 degrees compared to Idelchik's 
abrupt contraction equation. Therefore, it is up to the user to determine which one to 
use. 

All K-factor equations are provided here in terms of the upstream pipe. The K-factor in terms of 
the downstream pipe can be found as follows:             

Related Topics

K Factor Loss Model 264
Bend Loss Model 276
Orifice Loss Model 292
Screen Loss Model 341
Tee/Wye Loss Model 347
Valve Modeling Closures with K Factors 353
Area Change 271

Assigned Flow
The Assigned Flow junction type allows you to connect one pipe and to input a known flow rate 
entering or leaving at a particular location. An irrecoverable loss can also be included.

The Assigned Flow Properties window follows the first of the two basic Properties Window 
formats, displaying the connecting pipe information in a fixed format. Depending on whether you 
specify the junction as an inflow or outflow type, the required connecting pipe (upstream/inlet or 
downstream/outlet) will be enabled while the other pipe is disabled. Note that if the flow is spe-
cified as Inflow (to the system), then the reference positive flow direction of the connected pipe 
must be away from the junction (i.e. the junction is upstream of the pipe).
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The Assigned Flow junction will automatically switch the inflow/outflow parameter based on the 
reference flow direction of the connected pipe.

The Assigned Flow junction type allows you to specify positive flow rates as volumetric or mass 
flow rates. Negative flow rates are not accepted. If, for example, you have an outflow type junc-
tion and your system is physically flowing in, you cannot assign a negative flow rate to the junc-
tion. You must reverse the connecting pipe flow direction to be consistent with the actual 
direction and change from an outflow type to an inflow type.

Transient             

(XTS Module Only) On the Transient tab, a flowrate transient can be entered. For more inform-
ation on transient data, including event transients, see Junction Transient Data.

Special Conditions             

You can set a Special Condition for an Assigned Flow junction, which will turn the flow off and 
make it act like a Dead End.             

Loss Factor             

On the Optional tab, a loss factor can be entered to account for losses due to fittings or com-
ponents at the entry/exit to the connected pipe. 

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264

Assigned Pressure
The Assigned Pressure junction allows for the specification of a fixed boundary pressure and 
temperature (if heat transfer is enabled).

This junction is very similar to the Reservoir in that it fixes a pressure at a boundary. However, 
the Assigned Pressure allows the definition of either a static or stagnation pressure boundary, 
whereas Reservoirs are always stagnation pressure. Typically, any pressure gauge on a pipe 
will be reporting static pressure - it is important to select static pressure if this is the actual bound-
ary in the real system. A Reservoir would be inappropriate to represent such a piping connection 
with non-zero flow.

If stagnation is selected, the Assigned Pressure accepts the connection of up to twenty-five 
pipes. Static selection limits the connection to one pipe.
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When heat transfer is modeled, a temperature must also be specified. There is also the option to 
Balance Energy in the junction - this adjusts the temperature in order to make incoming and out-
going energy balance. This option is only appropriate for closed loop systems, read more here: 
Open vs Closed Systems - Balancing Energy.

Loss Factor

On the Loss Coefficients tab, loss factors can be entered to account for losses due to fittings or 
components at the entry/exit to each of the connected pipes.

Transient

(XTS Module Only) On the Transient tab, a pressure transient can be entered. For more inform-
ation on transient data, including event transients, see Junction Transient Data.

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264

Bend
The Bend junction type must always have two connecting pipes. This junction type allows you to 
model the irrecoverable loss that occurs when the flow direction changes through a bend or 
elbow. The Bend Properties window follows the first of the two basic Properties Window formats, 
displaying the connecting pipes in a fixed format. A flow direction through the junction is adopted 
from the defined directions of the two connecting pipes.

Standard Loss Types

The Bend Properties window offers several standard types of bend losses: the Smooth Bend, 
the Standard Elbow (the standard short radius threaded elbow), the Mitre Bend, and the User 
Specified K-factor. The window shows a schematic of the selected geometry for these three 
standard loss types. Until you have input the information for the upstream pipe that allows flow 
area determination, the standard Bend junction loss factor is not calculated. For smooth radius 
bends, you also need to specify r/D, which is the radius of curvature divided by the pipe dia-
meter. At r/D values less than one, the Reynolds number must be known to calculate the loss 
factor, and therefore cannot be displayed until output is available.

For bends that are not at a 90-degree angle, you can select the radio button for Non-90 Degrees, 
enter the angle (0-180 deg), and the standard loss factor will be calculated.
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Special Loss Types

The Bend also offers specialized loss types: the 3-K (Darby) method and Equivalent Length.

Additional Options

Basis Area for Loss Model - By default, the loss will be referenced to the upstream pipe area. 
This can be changed using the Basis Area for Loss Model dropdown.

Note: In principle, the upstream and downstream pipe diameters should be the same. 
However, the Bend junction only uses the reference area specified under Basis Area for 
Loss Model, even if the physical flow is in the opposite direction. If you are working with 
a user-specified loss, your geometry may have different diameter pipes connecting to 
the elbow. In this case, you would purposely define different upstream and downstream 
pipe areas. However, you would still want to be careful that the custom loss factor you 
assign is referenced to the correct area that is specified in Basis Area for Loss Model.

Restricted Flow Area - Optional input that is used only for checking if cavitation exists in the 
Bend junction.

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264
Bend Loss Model 276

Bend Loss Model

90 Degree Bends

The three Bend loss correlations are all for turbulent Reynolds numbers (Crane 1988, A-29).             

The K-factors for a smooth flanged bend with r/D ≥ 1 are provided in Table 1.             
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Table 1: K values for 90 degree smooth flanged bends with r/D > 1                 

The standard threaded elbow is given by             

where fT is the turbulent friction factor given in Table 2.             

Table 2: Pipe friction factors used for Crane formulas             

The Mitre bend is given by             
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Non-90 Degree Bends             

The two non-90 degree bend loss correlations are for turbulent Reynolds numbers (Crane 1988, 
A-29).             

A smooth flanged bend with r/D ≥ 1 is given by             

where n is the number of 90 degree bends, K is the loss factor for one 90 degree bend (Table 1), 
and fT is given by Table 2.             

The Mitre bend is given by Table 3.             

Table 3: K values for Mitre bends             

Smooth Flanged Bends, r/D < 1             

The smooth flanged bend with r/D < 1 loss factor uses a correlation applicable for turbulent Reyn-
olds numbers (Miller 1990, 209)             

The loss coefficient is calculated based on Miller's class 2 bend model, which is sufficient for gen-
eral design purposes, and is given by             

C0 and Cf are assumed to be 1 for class 2 bends. K*b is given by the nomograph on page 207 of 
Miller.             

For r/D > 0.7 or K*b < 0.4, CRe is given by Miller Figure 9.3. Otherwise, CRe is given by the equa-
tion below.             
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where the CRe for r/D = 1 is also found from Miller Figure 9.3. 

Related Topics

K Factor Loss Model 264
Area Change Loss Model 272
Orifice Loss Model 292
Screen Loss Model 341
Tee/Wye Loss Model 347
Valve Modeling Closures with K Factors 353
Bend 275
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Branch
The Branch junction allows up to twenty-five connecting pipes. The Branch junction is the most 
flexible junction type for building network models that have flow splits. Other significant features 
are the ability to impose a flow source or sink at the junction and the ability to specify separate 
loss factors for each connecting pipe. The Branch junction must have at least two connecting 
pipes.             

The Branch Properties Window follows the second of the two basic Properties Window formats.             

A table on the Loss Coefficients folder tab displays the connecting pipe information. The pipe 
table grows in size to accommodate up to twenty-five connecting pipes. For each connecting 
pipe, the pipe table lists the reference flow direction and up to two loss factors. The first loss 
factor is for physical flow out of the branch and into the pipe. The second is for physical flow into 
the branch and out of the pipe. The loss factors can be specified independently or left as zero. 
The distance of each connecting pipe (if any difference exists) from the Branch elevation can be 
entered in the pipe table.             

The Branch junction also offers you the option of specifying a flow source or sink at the junction 
in the Optional tab. According to AFT Fathom's convention, a source of flow into the system is 
defined as positive, while a flow out of the system (a sink) is defined as negative. Along with the 
flow rate, you must specify the temperature when heat transfer is modeled.             

Transient             

(XTS Module Only) On the Transient tab, a transient source or sink flowrate can be entered. For 
more information on transient data, including event transients, see Junction Transient Data. 

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264

Check Valve
The Check Valve junction type requires two connecting pipes. This junction type allows you to 
model valves that prevent reverse flow.             

The Check Valve Properties window follows the first of the two basic Properties window formats, 
displaying the connecting pipes in a fixed format. The Check Valve junction does not have an 
explicit flow direction, but adopts a flow direction from the connecting pipes.             

AFT Fathom assumes that the check valve is initially open. If the flow solution indicates that the 
specified Forward Velocity to Close is not met, AFT Fathom closes the valve and solves the flow 
distribution again. By default, the Check Valve will close at a velocity of 0. If a negative velocity 
value is specified, some amount of reverse flow will be allowed to occur before the valve closes. 
A positive velocity value means that the check valve will close while there is still forward flow 
through the valve.             
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Note: If the check valve closes during the simulation, it will not re-open. If there is an unsteady 
situation in which the check valve would continuously open and close, there may be 
unexpected results. It is good practice to close check valves with a Special Condition if 
it is known that they will be closed. This event can be seen in the Solution Progress win-
dow as "Re-running Solver because one or more special junction states changed..."             

A check valve Special Condition can be either open or closed.             

Specifying Losses             

You specify the losses for the Check Valve on the Loss Model tab in the Properties window. 
When you select Resistance Curve, the Check Valve Properties window makes additional fea-
tures available. Using these features, you can input Check Valve pressure drops that vary with 
flow. To enter these factors, you can specify polynomial constants, fit a curve to available data, 
or use interpolated x-y data. When a variable loss is specified, AFT Fathom dynamically modifies 
the loss factor in the Solver to agree with your input. You can choose any of the optional flow and 
pressure parameters provided; you can also specify the most convenient units. 

An optional input in the Check Valve Properties Window is the Restricted Flow Area. This para-
meter describes the effective area restriction in the valve. This is done for the purpose of assess-
ing cavitation. In most cases, information on the size of the restricted area must be obtained from 
the manufacturer or from test data. 

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264
Kv and Cv Loss Model 265
Check Valve closed at Junction X 789

Control Valve
Control Valve junctions are always internal to the system, with two connecting pipes. This junc-
tion type allows modeling of valves that offer special pressure or flow control characteristics at a 
location in the pipe system.

The Control Valve Properties Window follows the first of the two basic Properties Window 
formats, displaying the connecting pipes in a fixed format. The Control Valve junction does not 
have an explicit flow direction, but adopts a flow direction from the connecting pipes.

Control Valve Types

You can model four types of control valves: Pressure Reducing Valves (PRV), Pressure Sus-
taining Valves (PSV),  Flow Control Valves (FCV), and Pressure Drop Control Valves (PDCV). 
Loss information for a control valve is not required, because control valves are dynamic devices 
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that change their geometry in response to the pipe system behavior. The loss that results is that 
required to maintain the control parameter. You can, however, specify the full open loss. This is 
the loss that will occur should the valve fail to a full open state.

 l A PRV is a device that controls the pressure in a pipe system. The PRV maintains a con-
stant control pressure downstream of the junction as long as the upstream pressure 
exceeds the control pressure. If the upstream pressure is lower than the control pressure, 
the ability to control pressure is lost.

 l A PSV is similar to a PRV in that it controls pressure in a pipe system. While the PRV 
maintains a constant downstream pressure, the PSV maintains a constant upstream 
pressure. If the downstream pressure rises higher than the control pressure, the ability to 
control pressure is lost.

 l A FCV is a device that maintains a constant flow rate in a pipe system. By setting the junc-
tion to an FCV type and entering a flow rate, the junction will limit the flow through the con-
necting pipes to be equal to the control flow rate. The FCV can lose its ability to control 
flow when the pressure drop across it becomes zero or backward flow begins.

 l A PDCV is a device that maintains a constant (stagnation) pressure drop. For this option, 
the valve is never allowed to not meet its setpoint. An indicator that an unrealistic pres-
sure drop has been demanded is a failure to obtain a converged solution.

PRV/PSV Static vs. Stagnation Pressure

The control pressure for a PRV or PSV can be either static or stagnation. The default selection 
is static, as this is the most frequent application in industry.             

Action if Setpoint not Achievable

 l Always Control (Never Fail) - It is possible that a control valve cannot achieve a given 
set point. By default this option is on - to change this, uncheck the box and click Set as 
Default. For additional information, see Control Valve Setpoint Not Achievable.

 l Use Default Actions - The behavior of the control valve when it cannot meet its setpoint 
can be modified by unchecking this option. The default behaviors represent the normal 
behaviors for the standard valve types.

Special Conditions

Control Valves have two Special Conditions: to open fully and not control, or to close.

Open Percentage Table

The Optional tab allows data to be entered for special control valve characteristics. Specifically, 
the valve Cv and Flow Area can be specified vs. the Open Percentage of the valve. This data 
does not affect AFT Fathom’s flow solution. However, engineers frequently desire to know the 
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valve’s open percentage during operation to ensure it meets design requirements. The Valve 
Summary (in the Output window) always displays the valve Cv, and if data is specified for open 
percentage and flow area it will also display open percentage and flow area at the operating 
point. Tabulated data can be pasted or imported to the table by using the Edit Table menu to the 
right of the table. A graph of the open percentage, Cv, and flow area data can be displayed by 
selecting Show Graph to the right of the Open Percentage Data table.

A Cv vs Open Percentage table can be generated quickly for common Cv vs Open Percent pro-
file types by choosing the Create Cv/Open %... button next to the table. This then opens a win-
dow in which a curve can be defined using one of the following options:             

 l Transferred - If a table has already been defined on the Optional tab of the Properties 
window, it can be copied over

 l User Defined - Data can be entered directly into the table, or imported from existing data
 l Linear - A linear curve is generated based on the user defined full open Cv and percent 

increment
 l Equal Percentage - Generated as an equal percentage curve
 l Pre-Defined - Pre-defined curves for several common valve Cv vs Open Percent profiles 

can be chosen and adjusted for a defined full open Cv value based on data from Val-Matic 
2009.

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264
Kv and Cv Loss Model 265
Control Valve Setpoint Not Achievable 283
FCV/PRV/PSV could not control pressure - Pressure was added to achieve con-
trol flow/pressure 780
FCV could not control flow at Junction X 783
PRV could not control pressure at Junction X 786
PSV could not control pressure at Junction X 786
Default control valve actions at Junction X used when setpoint not achievable 
because analysis is transient 789
Control valve open percentage outside valid range of 0-100% at Junction X 782

Control Valve Setpoint Not Achievable
It is possible that the control valve cannot achieve the specified control setpoint. There are sev-
eral actions the valve can take in such cases. By default, the Always Control (Never Fail) feature 
is selected. This option is physically unrealistic but useful for modeling purposes. The reason this 
option is physically unrealistic is that the valve can add pressure to maintain control, thus acting 
like a pump. If this occurs, the user is clearly warned in the output. The Always Control option is 
useful because it gives a clear indication to the user of how far away the valve is from being able 
to control. The pressure added to control can be seen in the Warnings section, or in the Valve 
Summary table on the Output window.             
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Flow Control Valves             

For flow control valves, other options for valves which cannot achieve control are to have the 
valve Open Fully or Close. By default the valve fully opens. Once the control valve loses control, 
whether open or closed, AFT Fathom will solve the model again.             

Pressure Control Valves             

Pressure control valves are more complicated. These valves have two potential actions when 
control cannot be achieved. The first action is when the control cannot be achieved due to insuf-
ficient upstream pressure. The second is due to excessive downstream pressure. The default 
behavior for pressure reducing valves is to Open Fully due to insufficient upstream pressure, and 
close due to excessive downstream pressure. The defaults for pressure sustaining valves are 
the opposite. You can override the default behavior by clearing the Use Default Actions selection 
and specifying the desired actions.             

AFT Fathom will determine if the valve can maintain control based on the Loss When Fully Open 
value. If this fully-open pressure drop is greater than the pressure drop which balances the sys-
tem, the control valve can't achieve its setpoint. In other words, the control valve can’t open wide 
enough (becoming less restrictive) to achieve control, and will revert to using the Loss When 
Fully Open specified by the user. If you enter data in the Open Percentage table on the Optional 
tab, you can select to have the data taken directly from the table for the 100% open case. You 
can also choose to not have any losses associated with the valve in the full-open state by select-
ing None.

Related Topics

Control Valve 281
FCV/PRV/PSV could not control pressure - Pressure was added to achieve con-
trol flow/pressure 780
FCV could not control flow at Junction X 783
PRV could not control pressure at Junction X 786
PSV could not control pressure at Junction X 786
Default control valve actions at Junction X used when setpoint not achievable 
because analysis is transient 789

Dead End
The Dead End junction must always have only one connecting pipe. This junction type is one 
way to define flow in a pipe as truly zero. Use of this junction allows AFT Fathom to skip the flow 
solution, since the flow is known to be zero.             

The Dead End Properties window follows the first of the two basic Properties window formats, 
displaying the connecting pipes in a fixed format. The only required information is the connecting 
pipe and the elevation. 
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Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264

General Component
The General Component junction type is internal to the piping system and requires two con-
necting pipes. This junction type allows you to model the irrecoverable loss that occurs through 
equipment that may not be explicitly represented on the Toolbox and to specify loss factors as a 
function of a flow parameter.

The General Component Properties window follows the first of the two basic Properties window 
formats, displaying the connecting pipes in a fixed format. The flow direction through the junction 
is determined by the defined directions of the connecting pipes.

When you select Resistance Curve, the General Component Properties Window makes addi-
tional features available. You can specify polynomial constants, fit a curve to available data, or 
use interpolated x-y data.

When a variable loss is specified, AFT Fathom modifies the loss factor in the Solver to agree with 
the solution. You can choose any of the optional flow and pressure parameters provided, and 
you can specify the most convenient units.

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264
Resistance Curve Loss Model 267
Troubleshooting Resistance Curves 804
Heat Exchanger 285

Heat Exchanger
The Heat Exchanger junction type is internal to the piping system and requires two connecting 
pipes. This junction type allows you to model the irrecoverable loss that occurs through heat 
exchanger equipment. You also have the ability to specify loss factors as a function of a flow 
parameter.

The Heat Exchanger Properties window follows the first of the two basic Properties Window 
formats, displaying the connecting pipes in a fixed format. The flow direction through the junction 
is determined by the defined directions of the connecting pipes.

When you select Resistance Curve, the Heat Exchanger Properties Window makes additional 
features available. Using these new features you can input heat exchanger pressure drops that 
vary with flow. To enter these factors, you can specify polynomial constants, fit a curve to avail-
able data, or use interpolated x-y data. 
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When a variable loss is specified, AFT Fathom modifies the loss factor in the Solver to agree with 
the solution. You can choose any of the optional flow and pressure parameters provided, and 
you can specify the most convenient units.

Tube Configuration Model

The Heat Exchanger junction offers a special model for tube side pressure drop. The tube con-
figuration model allows the user to specify tube properties and quantities, scaling and frictional 
characteristics, multiple passes, blocked tubes and K factors for turnarounds. The pressure drop 
is then calculated based on this data.

Heat Transfer

When heat transfer is modeled, the Thermal Data tab becomes active. See Heat Exchanger 
Heat Transfer to read about how this is modeled, and how to specify various configurations.

Special Conditions

The Special Condition for a Heat Exchanger junction functions differently than other junctions. 
Here you can turn off the heat transfer for the heat exchanger.

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264
Resistance Curve Loss Model 267
Troubleshooting Resistance Curves 804
General Component 285
Heat Exchanger Heat Transfer 286

Heat Exchanger Heat Transfer
There are eleven different heat exchanger models available in AFT Fathom. 

 l NTU-Effectiveness Models
 l Counter-Flow
 l Cross Flow, Both Fluids Unmixed
 l Cross Flow, Secondary Fluid Mixed
 l Cross Flow, System Fluid Mixed
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 l Parallel
 l Shell & Tube, 1 Shell Pass, Mult. of 2 Tube Passes

 l Directly specified thermal property
 l Controlled Downstream Temperature
 l Enthalpy Stagnation Rise
 l Specified Heat Rate In Constant
 l Specified Heat Rate In vs Flow
 l Temperature Stagnation Rise

Figure 1: Heat Exchanger Thermal Data

All of the NTU-Effectiveness models require the same 5 parameters as input (shown in Figure 1), 
but calculate the resulting heat transfer slightly differently. The direct specification models only 
require that the associated property be entered.

Thermal results are displayed along with pressure results in the Heat Exchanger Summary in the 
output, as well as information on secondary fluid conditions and log mean temperature dif-
ference.

Thermal Link

When modeling convective heat exchangers (such as parallel or counterflow) two heat 
exchanger junctions can be linked thermally.  A thermal link is when two heat exchanger 
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junctions, which are hydraulically isolated, can exchange heat with each other. Typical use is 
when the two heat exchangers represent two sides of the same physical heat exchanger. When 
thermal linking specified in a heat exchanger properties window, the user must specify the heat 
transfer area and overall convection coefficient. AFT Fathom will force the two heat exchanger 
junctions to use the same value.   

This capability can also be used to model heat transfer between loops with different fluids (see 
Fluid Groups).

NTU-Effectiveness Method

The NTU-Effectiveness method is used when the fluid inlet and outlet temperatures for the heat 
exchanger are not known.

To start, the NTU-Effectiveness method requires that the maximum possible heat transfer be 
found. Theoretically, the maximum heat transfer would occur in a counterflow heat exchanger of 
an infinite length. In this scenario, the maximum possible temperature difference is the difference 
between the inlet temperature of the hot fluid and the inlet temperature of the cold fluid:

The minimum heat capacity rate can then be found by multiplying the mass flow rate by the spe-
cific heat for the hot fluid and the cold fluid:

The fluid with the higher heat capacity rate changes temperature more quickly along the length 
of the heat exchanger, but the fluid with the lower heat capacity rate actually sees the maximum 
possible temperature change. Based on this, the maximum heat transfer between the two fluids 
in the theoretical heat exchanger is the minimum heat capacity rate multiplied by the maximum 
temperature difference:

The effectiveness of a heat exchanger is the ratio between the actual heat transfer rate and the 
maximum possible heat transfer rate:
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If the effectiveness and the inlet conditions are known, the amount of heat transferred between 
the two fluids can be calculated without knowing anything about either fluid’s outlet temperature:

The key to the NTU method becomes calculating the effectiveness, which is a function of the 
heat capacity ratio, C, and the number of transfer units, NTU:

Each heat exchanger configuration has a unique relation used to calculate the effectiveness. 
These become the fundamental equations for the six thermal models that use the NTU method:
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Related Topics

Heat Exchanger 285

Jet Pump
The Jet Pump junction is internal to the system and requires two connecting pipes, representing 
the suction and the discharge. The supply flow is specified explicitly and modeled internally in 
the junction type.

The Jet Pump Properties window follows the first of the two basic Properties Window formats, 
displaying the connecting pipes in a fixed format. The flow direction through the junction is 
determined by the defined directions of the connecting pipes.

The Jet Pump junction is useful for modeling jet pumps, also known as eductors. Jet pumps are 
devices which use a high pressure injected fluid to entrain a lower pressure fluid and induce 
motion, thus pumping the lower pressure fluid. The high pressure fluid is referred to as the sup-
ply fluid, the low pressure fluid is the suction fluid, and the combined mixture is the discharge 
fluid. If the supply and suction fluid are different, the variable physical properties model should be 
used (selected in Analysis Setup on the Heat Transfer/Variable Fluids panel). In such a case, the 
data for the jet pump will be best entered on a mass flow rate basis, which includes the effect due 
to density.

To describe the performance characteristics, data must be entered for the pressure ratios at max-
imum and minimum flow, as well as the flow ratio at maximum flow. Additionally, the supply fluid 
pressure and flow rates are required.

If the pipe flow model includes heat transfer, a supply temperature is required.

More information on Jet Pump calculations can be found in Karassik, et. al, 1986 on pages 4.2-
4.9.

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264
Flow rate at drop off point at Junction X 784

Related Blogs

The Eductor Educator
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Orifice
The Orifice junction type requires two connecting pipes, unless you specify it as an exit orifice, in 
which case only one connecting pipe is allowed. This junction type allows you to model the irre-
coverable loss that occurs through a plate-type flow restriction. It also allows you to specify loss 
factors as a function of a flow parameter and an orifice loss for pipes with an area change.

The Orifice Properties window follows the first of the two basic Properties Window formats, dis-
playing the connecting pipes in a fixed format. The Orifice junction does not have an explicit flow 
direction, but adopts a flow direction from the connecting pipes.

Orifices that are located at an exit are specified as exit orifices. These orifices require an asso-
ciated back pressure definition. Exit orifices can only be connected to a single upstream pipe. To 
specify an exit orifice, select the Exit Orifice checkbox, then specify the exit pressure and, if a 
heat transfer fluid model is used, the exit temperature.

Orifice Types

AFT Fathom provides two standard orifice types: sharp-edged and rounded. These loss factors 
are calculated based on correlations. In addition to the standard orifices that AFT Fathom 
provides, you may enter your own custom orifice loss factor that is consistent with the applic-
ation.

For convenience, you can specify constant loss characteristics of an orifice as a discharge coef-
ficient (Cd) or as a loss factor (K). The standard orifice geometries include a functional depend-
ence on the upstream and downstream pipe areas, which may be different.

When you select Resistance Curve, the Orifice Properties Window makes additional features 
available. Using these new features, you can input orifice loss factors or pressure drops that vary 
with flow. To enter these factors, you can specify polynomial constants, fit a curve to available 
data, or use interpolated x-y data. When a variable loss is specified, AFT Fathom modifies the 
loss factor in the Solver (the part of AFT Fathom that applies the governing incompressible flow 
equations to obtain a solution to the pipe system) to agree with the solution. Here you can spe-
cify any of the available optional flow and pressure parameters using your preferred units.

An optional input in the Orifice Properties window is the Restricted Flow Area. This parameter 
describes the effective area restriction in the orifice. This is done for the purpose of assessing 
cavitation. In most cases, information on the size of the restricted area must be obtained from 
handbook or test data.

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264
Orifice Loss Model 292
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Orifice Loss Model

Sharp-Edged Orifice with Identical Upstream and Downstream Diameters

The orifice loss factors are all for turbulent Reynolds numbers. The sharp-edged orifice shown in 
Figure 1, is given by the following (Idelchik 2007, 259):

Figure 1: Sharp-edged orifice (in this case Aup = Adown)

Round-Edged Orifice with Different Upstream and Downstream Diameters

When the upstream and downstream pipe diameters are different for a round-edged orifice as 
shown in Figure 2, the round-edged orifice equation for different pipe areas is used and is given 
by the following (Idelchik 2007, 258)

where
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Figure 2: Round-edged orifice with different upstream and downstream pipe areas

Round-Edged Orifice with Identical Upstream and Downstream Diameters

When the upstream and downstream pipe diameters are the same for a round-edged orifice as 
shown in Figure 3, the round-edged orifice equation for the same pipe areas is used and is 
given by the following (Idelchik 2007, 262)

where

 

 
Figure 3: Round-edged orifice with the same upstream and downstream pipe areas

For other orifice configurations, see Chapter 4 of Idelchik's Handbook of Hydraulic Resistance 
(2007).             

Orifice Discharge Coefficient

The relationship between orifice CD and K is given by Crane A-20:
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where β is the diameter ratio of the orifice diameter to the upstream pipe diameter, or

Related Topics

K Factor Loss Model 264
Bend Loss Model 276
Area Change Loss Model 272
Screen Loss Model 341
Tee/Wye Loss Model 347
Valve Modeling Closures with K Factors 353
Orifice 291

Pump
The Pump junction allows you to model the pressure added to a system by a pump, fan, or 
blowers (ignoring compression effects). Because all pumps are different, AFT Fathom does not 
provide any standard pump types. Pressure and flow data that describes the pump must be 
obtained from the manufacturer or from test data. To reduce repeated data entry, frequently-
used pumps can be added to the Component library.

Common Input Information

Like all junctions, pump junctions require a junction number, junction name, and inlet and outlet 
elevations. Similar to other junctions, pumps can have Design Alerts and Notes applied to them. 
They require two connecting pipes, unless the Submerged Pump option is enabled. Note that the 
direction of the connected pipes define what side of the pump is suction and which is discharge.

Pump Model

This tab requires the selection and definition of what type of pump the junction represents. There 
are three models available:
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 l Centrifugal (Rotodynamic) - Represents a typical centrifugal pump where the head 
added to the fluid is related to the flow through the pump via a pump curve.                     

 l Interstage Bleed/Takeoff Flow - Represents a multiple stage pump that has 
some amount of flow removed between the upper and lower stages. Centrifugal 
(Rotodynamic) must be selected to enable this model.                         

 l Positive Displacement - Represents a steady state approximation of a positive dis-
placement pump. The flow is fixed to a constant value, and whatever head is necessary to 
obtain that flow will be supplied.      

 l Pump As Turbine - Represents a pump as a turbine which allows the pump to produce 
electrical power when the pump sees reverse flow. 

Variable Speed

This tab allows the speed of the pump to vary either by a fixed amount, or dynamically. These 
options are only available for a centrifugal pump. A minimum speed can be entered to limit how 
much the speed is varied.

 l Fixed Speed (%) - Directly modify the pump curve according to the Affinity Laws. The 
Pump Curve entered in Pump Configuration is always assumed to be the 100% speed 
curve.                     

 l Controlled Pump (Variable Speed) - Dynamically change the speed of the pump to 
meet a specified control setpoint. Instead of allowing the flow or head to vary with a fixed 
speed, the speed of the pump (and thus Pump Curve, according to the Affinity Laws) var-
ies to meet a fixed flow or head. If modeling a suction or discharge pressure, control can 
optionally be enforced only if the value is above/below the setpoint.                     

Thermal

If heat transfer modeling is enabled, the Thermal tab will appear and heat added to the fluid by 
the pump due to inefficiency can be modeled. Three options are available: 

 l Percent of Ideal Efficiency - Enter the percentage of ideal energy required by the pump 
that goes into heat addition. Typically, this would equal the actual efficiency subtracted 
from 100%. For example, if the pump was 70% efficient, the entry here would be 30%.

 l Percent of Inefficiency - Enter the percentage of the lost energy (i.e., the inefficiency) 
that goes into fluid heating. Typically, this would be 100%, which says that all inefficiency 
goes into heat.

 l User Specified Heat Rate - Directly enter a heat load which goes into the fluid.

Slurry De-Rating

(SSL Module Only)             
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Pump head degradation occurs when pumping solids. This is known as de-rating. See the Slurry 
Pump De-rating topic for more information.

Transient

(XTS Module Only)

The pump junction allows modeling of transients to occur in the following pump parameters:             

 l Speed (if using a pump curve) for both Pumps and Pump as Turbine
 l Flow rate (if modeling a fixed flow rate)
 l Pressure/head (if modeling a fixed pressure or head rise)
 l Control setpoint
 l Load Rejection for Pump as Turbine

For more information on transient data, including event transients, see Junction Transient Data.

Optional

There are several optional parameters that can be defined for a pump. Some of these are avail-
able to most junctions such as Initial Guesses, Display on Workspace, Design Factor, and Work-
space Icon.

Also present are several pump junction specific options:

 l Special Condition
 l None - The pump operates normally.
 l Pump Off No Flow - The pump is shut off and blocked. This is identical to a 

closed valve in Fathom.
 l Pump Off With Flow Through - The pump is shut off but allows flow to continue 

through. This is identical to a lossless connection in Fathom.
 l Number of Pumps at This Location - Several pumps can be represented by one pump 

junction. This simplifies the model by reducing the number of pipes and junctions present, 
as well as automatically calculating the resulting composite pump curve based on the 
user-defined curve. When this option is selected the pump summary will show the total 
flow/head from the combined pumps.

 l Use Viscosity Correction - Pump performance changes if the system fluid viscosity is 
different than the pump test fluid viscosity. Viscosity Corrections allow the user to account 
for these changes.

 l Additional Efficiency Data - Power and efficiency information for each stage in a VFD-
Motor-Pump assembly.

Related Topics
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Junctions 251
General Junction Information 252
Junction Loss Models 264
Centrifugal (Rotodynamic) Pump 298
Pump Configuration 300
Multiple Configurations 305
Pump Sizing 312
Positive Displacement Pump 318
Interstage Bleed/Takeoff Flow 313
Pump Efficiency Data 333
Viscosity Correction 317
Submerged Pump 331
Affinity Laws 329
Pump Reliability Factors 309
Junction X had reverse flow - Pump head could not be predicted 781
Junction X exceeded runout flow rate 785
Junction X %BEP (Y%) is above/below the POR range 784
Junction X flow (Y gal/min) is above/below the AOR range (Z gal/min) 785
Junction X has insufficient pump NPSH/NPSP… 785
Negative added pressure by pump at Junction X 785
Pump X has no efficiency curve data. Nominal efficiency was used in viscosity 
correction calculations 793
Pump X has no efficiency curve or nominal efficiency data... 794
Pump X properties were outside of the valid range for the viscosity correction 
calculations. Results may be invalid. 794
Poor Pump Curve Fits 803

SSL Module 
Settling Slurry Module
An optional add-on module to AFT 
Fathom which allows users to sim-
ulate settling slurries.
XTS Module 
Extended Time Simulation Mod-
ule
An optional add-on module to AFT 
Fathom which allows users to sim-
ulate system transient behavior.
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Centrifugal (Rotodynamic) Pump

Analysis Type

This topic pertains to the Pump Curve Analysis Option which represents the real behavior of a 
centrifugal pump. For Sizing Analyses, see Pump Sizing.

Pump Curve

A Pump Curve is required to model a centrifugal pump. This is the typical Head or Pressure vs. 
Flow information that will be available from any pump manufacturer. Certain features also 
require the definition of an NPSHR curve, and Power or Efficiency curves.

To enter curves, click Enter Curve Data. Once this data has been defined, previews of the 
applied curves can be seen here.

Impeller Modifications

These values allow representation of different impeller trims without the need to input new 
curves.

 l Ratio as Percent - This option assumes that the pump curve represents 100% trim. 
Entering different values adjusts the pump curve with the Affinity Laws.

 l Actual Impeller - Only available if Multiple Configurations are defined. In this case, a 
dimensional value for impeller size can be entered here.

Submerged Pump

Represents a pump with a fixed head or pressure at suction. See Submerged Pump.

Check Valve at Discharge (No Backflow Allowed)

Model a check valve that can be considered part of the pump itself. If using the XTS Module, a 
check valve junction will not close until the time step after the reverse flow occurs. However, 
when used as part of the pump junction it will never allow backflow at any time step.

 l Forward Velocity to Close - The flow velocity, in the forward direction, that causes the 
check valve to close preventing any further flow. A negative value in this field indicates 
reverse flow through the pump. 

 l Delta Head to Re-Open - The differential head or pressure (upstream minus down-
stream) required to re-open the check valve.

- 298 -



Junctions

Figure 1: Centrifugal model with a pump curve defined

Interstage Bleed/Takeoff Flow

Represents a multiple stage pump that has some amount of flow removed between the upper 
and lower stages. See Interstage Bleed/Takeoff Flow.

Related Topics

Pump 294
Pump Configuration 300
Multiple Configurations 305
Pump Sizing 312
Positive Displacement Pump 318
Interstage Bleed/Takeoff Flow 313
Pump Efficiency Data 333
Viscosity Correction 317
Submerged Pump 331
Affinity Laws 329
Pump Reliability Factors 309
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Junction X had reverse flow - Pump head could not be predicted 781
Junction X exceeded runout flow rate 785
Pump X has no efficiency curve data. Nominal efficiency was used in viscosity 
correction calculations 793
Pump X has no efficiency curve or nominal efficiency data... 794
Pump X properties were outside of the valid range for the viscosity correction 
calculations. Results may be invalid. 794

Related Blogs

Back to the Basics: Calculating and Defining Head

Not a Leak! Modeling Multi-stage Pumps with Discharge Flow Between Stages

Determine Your Pumps BEP and Know API-610's Recommendations

Pump Configuration
The pump configuration window is used to define the specific operation of a centrifugal pump. It 
is opened with the Enter Curve Data button from the Pump Properties Pump Model tab when 
Centrifugal is selected. 

Figure 1: Enter Curve Data

Configuration Method

By default a pump is defined as a Simple configuration. This indicates that the pump junction can 
represent only one pump - defined by the curves in pump configuration.

If the Configuration Method is changed to Multiple, additional input becomes available on the 
right of the configuration window. This allows defining different operating speeds or impeller dia-
meters for this pump, along with those configuration's specific curves. See a detailed description 
in Multiple Configurations.

- 300 -

https://www.aft.com/support/product-tips/back-to-the-basics-calculating-and-defining-head
https://www.aft.com/support/product-tips/interstage-pumps
https://www.aft.com/support/product-tips/are-you-operating-your-pump-off-bep


Junctions

Pump Data

The first tab of the pump configuration controls the pump's most basic behavior - the pump 
curves. 

Figure 2: Pump Data

A Pump can have three curves defined:

 l Flow vs. Head/Pressure - Required. This is what is commonly referred to as the "pump 
curve" and defines how much head a pump can add to a fluid at any given flow rate.

 l Flow vs. NPSHR - Optional. The NPSHR varies with flow and can be specified for a 
pump. Without specifying this curve, it is impossible to determine if cavitation may exist 
within the pump.

Note: NPSHR calculations require a reference elevation, which is defined in the Pump Prop-
erties window. For most pumps, the NPSH Reference elevation is the centerline of the 
suction of the pump. However, this should be checked with the pump manufacturer to 
determine where the NPSH curve is referenced.
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 l Flow vs. Efficiency/Power - Optional. The efficiency or power curve can be used to cal-
culate the Best Efficiency Point (BEP), which is used for a variety of purposes. The defin-
ition of this curve also allows for the calculation of the actual power used or efficiency of 
the pump at its operating point. Without this curve, pump efficiency is assumed to be 
100%.

After entering the raw values into the table, the data needs to be curve fit.

If Mass Flow, Pressure, or Power are used in the curve definitions, Reference Density becomes 
an additional required input.

Configuration Data

This tab controls some additional behavior or input for a pump junction. Entering or changing val-
ues on this tab is optional. 

Figure 3: Configuration Data

 l Best Efficiency Point (BEP) - The Best Efficiency Point (BEP) by default is calculated 
from the entered efficiency or power curve. This is generally the preferred option as it best 
relates to the true meaning of BEP. A User Specified value can be entered if no efficiency 
or power curve is available, or if it is desired to force the BEP to a certain flow.

 l End Of Curve Flow Rate (optional) - This value is used to create a warning in the output 
if it is exceeded. It does not affect the solution - the model will behave identically however 
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this value is defined.
 l NPSHR Affinity Exponent At Operating Speed - Pump curves - flow, head, and power 

- generally follow the affinity laws. However, NPSHR does not always follow a standard 
relationship. The default is to assume the NPSHR varies with the square of the operating 
speed. If this is not the case, the value can be adjusted here.

 l Preferred Operating Region (POR) - The region where the pump operates  most effect-
ively. Percent of BEP values falling outside of the defined range will generate a warning 
in the model output. This range can be taken from HI 9.6.3-2017 based on the specific 
speed of the pump, from ANSI/API 610 (2010), or can be defined by the user.

 l Allowable Operating Region (AOR) - When an AOR is defined a warning will be cre-
ated in the output when the user specified flow range is not adhered to. This is usually 
provided by the manufacturer.

Graphs

The following tabs display the curves that have been fit to the given data. If multiple curves are 
defined, the Composite Graph tab becomes available. The other graph tabs show the individual 
curves, along with points representing the raw data. It is a good idea to check that these graphs 
to confirm the curve fit is reasonable for any potential operating region.
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Figure 4: Composite Graph

Related Topics

Pump 294
Centrifugal (Rotodynamic) Pump 298
Multiple Configurations 305
Pump Sizing 312
Positive Displacement Pump 318
Interstage Bleed/Takeoff Flow 313
Pump Efficiency Data 333
Viscosity Correction 317
Submerged Pump 331
Affinity Laws 329
Pump Reliability Factors 309
Junction X %BEP (Y%) is above/below the POR range 784
Junction X flow (Y gal/min) is above/below the AOR range (Z gal/min) 785
Junction X has insufficient pump NPSH/NPSP… 785
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Poor Pump Curve Fits 803

Related Blogs

Back to the Basics: Calculating and Defining Head

Determine Your Pumps BEP and Know API-610's Recommendations

Multiple Configurations
A single pump junction can contain information for multiple pump configurations - impeller trims 
and operating speeds. This is useful to compare different variations of a pump without needing to 
redefine a new pump junction for every case. The configuration of the pump can easily be 
changed without losing any information.

Multiple configurations also allow for an analysis of pump reliability factors.

Defining Multiple Configurations

When opening the pump configuration, change the Configuration Method from Simple to Mul-
tiple. When doing so, an additional user input panel appears on the right hand side of the win-
dow.

Figure 1: Multiple Configuration Method Selected
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In order to make use of the multiple configuration feature, an RPM and Impeller Diameter under 
Configuration Information should be filled in. A Description can optionally be added. After modi-
fying any information that affects the definition of this configuration the Update Configuration box 
turns yellow:

Figure 2: Update Configuration

Clicking Update Configuration Now adds the Configuration to the Pump Configurations listed in 
the top-right.

- 306 -



Junctions

Figure 3: Current Pump Configurations

To create an additional configuration, click Create.

Figure 4: Creating a new Configuration
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The pump curves must be created and curve fit, as with a single configuration pump. After com-
pleting this and clicking Update Configuration Now, the new configuration will be created and 
shown in the Pump Configurations area. Configurations can be edited by selecting them in this 
area.

Figure 5: Editing a Configuration

Now that multiple configurations are available, they can be selected on the Pump Model tab:

Figure 6: Selection of a Configuration

Related Topics

Pump 294
Centrifugal (Rotodynamic) Pump 298
Pump Configuration 300
Pump Sizing 312
Positive Displacement Pump 318
Interstage Bleed/Takeoff Flow 313
Pump Efficiency Data 333

- 308 -



Junctions

Viscosity Correction 317
Submerged Pump 331
Affinity Laws 329
Pump Reliability Factors 309

Pump Reliability Factors
Reliability factors from Bloch & Geitner (1994) can be used to help assess the long-term reli-
ability of pumps.

Setting up a Pump to Calculate Reliability

In order to calculate overall reliability, three pieces of pump data are needed:

 l Efficiency vs. Flow
 l Speed in RPM
 l Actual, maximum, and minimum impeller diameters

Figure 1 shows the Pump Configuration window which is opened from the Pump Specifications 
window. In the table at the left of Figure 1, you can see where efficiency data is entered. The best 
efficiency point (BEP) is computed based on this data. If you would rather enter the BEP directly 
you can do so on the second tab Configuration Data. The BEP data is used to compute the reli-
ability factor based on BEP. AFT Fathom calls it Reliability Factor BEP or Reliability BEP.             

Figure 1: Pump Configuration window opened from Pump Specifications window
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At the top left of Figure 1 you can see options for Configuration Method. To calculate the reli-
ability factors for speed and impeller you need to use the Multiple Configurations option as 
shown in Figure 1. When you choose this, the window expands to the right and you can see the 
areas at the right of Figure 1 where RPM and impeller size are specified. Each RPM and impeller 
size combination is referred to as a pump configuration. To make the reliability factor cal-
culations work correctly here is the data that must be entered for the pump:

 l One configuration for the maximum impeller diameter must be entered                     
 l One configuration for the minimum impeller diameter must be entered                     
 l One configuration for the maximum speed in RPM must be entered                     

Using these three configurations, AFT Fathom searches all configurations for the pump and 
finds the maximum and minimum diameters to use for the impeller diameter based reliability 
factor which we call Reliability Factor Diameter. AFT Fathom also searches for the highest 
RPM value and assumes that as the design value. This value is then used for the Reliability 
Factor Speed calculation.             

The Reliability Factor Total is simply the product of the BEP, Speed, and Diameter reliability 
factors.             

Setting Pump Reliability in Output

The reliability factors can be selected for viewing using the Output Control window. Choose Out-
put Control from the Tools menu or click the Output Control button on the toolbar. 

Choose the Pump button at the top of the Display Parameters tab, and from the list on the left 
select the reliability parameters you want to see in your output. Add them to the list on the right. 
When you run your model you will see the reliability factor output as in Figure 3.
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Figure 2: Output Control Window with Reliability Factors added

Figure 3: Reliability Factors in the Pump Summary

Related Topics

Pump 294
Centrifugal (Rotodynamic) Pump 298
Pump Configuration 300
Multiple Configurations 305
Pump Sizing 312
Positive Displacement Pump 318
Interstage Bleed/Takeoff Flow 313
Pump Efficiency Data 333
Viscosity Correction 317
Submerged Pump 331
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Affinity Laws 329

Pump Sizing
The Centrifugal (Rotodynamic) Pump Model offers the option of Sizing a pump. By entering a 
Pump Sizing Parameter, the corresponding operating conditions are calculated and displayed in 
the Pump Summary section of the Output window . By inputting a flow at a pump, determining 
the pump size requirements is straightforward. The Walk Through Examples have an example of 
using AFT Fathom to size a pump.

Pump Sizing with a Flow Control Valve

Using the sizing feature on a pump (fixing the flow rate) with a Flow Control Valve (which also 
fixes flow rate) downstream results in a Reference Pressure error - the system no longer has a 
unique solution. While the pump is being sized, the control valve must be temporarily defined as 
a Constant Pressure Drop Control Valve to avoid these errors. Read more about this in Role of 
Pressure Junctions - Detailed Discussion.

Suggest Pump & Intelliquip™

Once you have sized a pump, you can use the Suggest Pump feature which is opened from the 
Library menu > Suggest Pump or the Output Toolbar to find an actual pump that meets the 
requirements. The Suggested Pumps window allows you to specify search criteria and to select 
the libraries you want to search. Search criteria includes pump head, NPSH, and BEP prox-
imity.

If you or a colleague has previously saved various manufacturer pump models and performance 
curves to a junction library that you have connected in the Library Manager, you can search this 
library to see if any saved pump curves meet the requirements. This is useful if an Enterprise-
Wide Network Library System is set up for your company.

Click Search once the criteria and Source Library are defined (see below for instructions on 
using the Internet Library Source). Pumps that meet the criteria will be shown in the table below. 
The table can be sorted by proximity to operating head, BEP, or alphabetically.  The Show Pump 
Curve button allows for quick viewing of the composite curve for a selected pump. The operating 
point is overlaid on the graph such that you can determine if the pump is a good fit. If the per-
formance curve is determined to be appropriate for the model, the Apply Pump Data button can 
be used to open the Apply Pump Data window where one or more pump junctions can be 
updated to use the performance curve.

Intelliquip™ - In addition, the Internet Library Source allows you to pass operating point data to 
Internet hosted pump supplier websites which use Intelliquip™.

 1. Select the Internet radio button under Source Library, and select Intelliquip from the drop-
down menu.

 2. Click Search to open the Intelliquip Search window.
 3. Select Display Units and the Frequency of the electrical grid that the pump will operate on 

(60 Hz or 50 Hz).
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 4. Click Open Web Browser to be taken to the AFT Intelliquip landing page.
 5. Select a pump supplier website.
 6. Browse the catalog and adjust the search filters. Each supplier's website may operate dif-

ferently and might require different data inputs to be adjusted.
 7. Once a pump model is found to be appropriate, look for a download button and download 

the *.iqx file.
 8. Return to the Intelliquip Search window in Fathom, click the radio button for Step 2, and 

click Open File(s).
 9. Select the *.iqx file for the pump. The pump will now appear in the table.

 10. Select the pump in the table, click Apply Pump Data, and update the desired junctions in 
the model. The Add to Library option allows you to save the pump curve to a connected lib-
rary for future use.

For an example of pump sizing in Fathom, see the Sizing a Pump example.

Related Topics

Pump 294
Centrifugal (Rotodynamic) Pump 298
Pump Configuration 300
Multiple Configurations 305
Positive Displacement Pump 318
Interstage Bleed/Takeoff Flow 313
Pump Efficiency Data 333
Viscosity Correction 317
Submerged Pump 331
Affinity Laws 329
Pump Reliability Factors 309

Interstage Bleed/Takeoff Flow
Some multiple stage pumps can have flow removed at some intermediate point. For such 
pumps, the manufacturer provides two pump curves:

 l Overall Pump Curve - The total dynamic head from the suction of the first stage to the 
discharge of the last stage when the takeoff flow is zero.

 l Takeoff Pump Curve - The total dynamic head of the stages before the takeoff point.

Note: The Overall Pump Curve is an effective curve that describes the operation of all pump 
stages together. This curve cannot be directly used to determine the overall head when 
the takeoff flow is anything other than zero.             
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Defining the Model

First, place two pump junctions onto the Workspace, representing the upstream and down-
stream stages of the multistage pump.

Figure 1: Example Workspace layout - color for emphasis only

Both pumps need to be defined as "Interstage Bleed/Takeoff Flow" as shown below. The 
"Upstream Stages" pump should have the Takeoff Curve entered. The "Downstream Stages" 
pump should have the Overall Pump Curve entered.             

Keep in mind that the pipes connecting the two pumps do not exist in reality. For this reason, it 
is reasonable to make these pipes have as little impact as possible. This can be done by making 
them short and/or frictionless. Otherwise, there will be some nominal frictional head loss in the 
section where effectively none would exist in the real system.             

Additionally, the two pumps need to be "connected" by setting the junction of the corresponding 
pump junction in this area.             

- 314 -



Junctions

Figure 2: Interstage Configuration

Methodology

As can be seen in Figure 3, the Suction Flow is always equal to the sum of the Takeoff and Dis-
charge Flows. Also important to note is that the Suction Flow is always equal to the discharge 
flow of the upstream stages - that is, adjusting the takeoff flow does not directly affect the beha-
vior of the upstream stages.

From this, we can determine the head that is added by the upstream stages by examining the 
Takeoff Pump Curve at the Suction Flow. This is shown in Figure 4 as Upstream Stages Head.

Next, we need to determine the head contributed by the Downstream Stages. However, we do 
not know the pump curve for these stages! By subtracting the Takeoff Pump Curve from the 
Overall Pump Curve, we can determine the Downstream Stages Pump Curve. Knowing the Dis-
charge Flow (Suction Flow - Takeoff Flow), we can now look up the Downstream Stages Head, 
as shown in Figure 4.

Adding these two values brings us to the Overall Effective head across the entire pump at the 
given Discharge Flow. This value will be smaller than the Overall Pump Curve value due to the 
head lost to the Takeoff Flow.

Similarly, adding the overall power calculated at each of the pump junctions will give the ideal 
Overall Effective power for the entire pump. 
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Figure 3: Interstage Diagram

Figure 4: Interstage Curves

Related Topics

Pump 294
Centrifugal (Rotodynamic) Pump 298
Pump Configuration 300
Multiple Configurations 305
Pump Sizing 312
Positive Displacement Pump 318
Pump Efficiency Data 333
Viscosity Correction 317
Submerged Pump 331
Affinity Laws 329
Pump Reliability Factors 309
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Related Blogs

Not a Leak! Modeling Multi-stage Pumps with Discharge Flow Between Stages

Viscosity Correction
Most pump curves are developed with pure water; however, pumping a fluid more viscous than 
water will result in a reduction of pump performance - even if the fluid reference density is the 
same as water. The Viscosity Correction feature employs the methods described in ANSI/HI 
9.6.7-2021 Rotodynamic Pumps - Guideline for Effects of Liquid Viscosity on Performance to cor-
rect for losses in performance due to viscosity.

Viscosity Corrections should only be used if the pump curve entered into the Pump 
Properties window is a water curve, since this is the only situation covered by ANSI/HI 
9.6.7-2021. Viscosity Corrections will effectively transform a water pump curve into a viscous 
pump curve. If the manufacturer provides a pump curve for your working fluid at your desired vis-
cosity, then it should be entered directly and the Viscosity Correction feature should remain dis-
abled, otherwise the effects would be double counted. If the manufacturer provides a pump 
curve based on your same working fluid, but at a different viscosity, then the Viscosity Correction 
feature should still remain disabled because unfortunately that case falls outside the scope of the 
ANSI/HI 9.6.7-2021 standard.

Correction factors referred to as CH (for head rise), CQ (for volumetric flow), and CE (for effi-
ciency) are defined and can be displayed in the Pump Summary section of the Output:

To calculate the correction factors, the water BEP (head and flow at BEP) and rated pump 
speed are required.

 l Assume Pump is Operating at BEP - This option is useful when the pump is in Sizing 
mode, and will assume that the head rise and flowrate calculated by the model are at 
BEP. This option is also useful when a water pump curve is entered but no efficiency data 
is present.

 l Use Water BEP
 l From Pump Configuration - The water BEP flowrate can be determined from the 

pump curve data entered on the Pump Configuration window. This option will be 
disabled if efficiency data is not present.

 l User Specified - Alternatively, the user can directly specify the water BEP 
flowrate.

Scope of Correction

It is important to keep in mind that, like all mathematical models, this standard is not universally 
applicable. Below are the primary requirements:
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 l Single or multistage centrifugal pump
 l Essentially radial discharge with specific speed under 3000 (US units)
 l Newtonian Fluid
 l Kinematic viscosity between 1 and 4000 cSt

For detailed information regarding these limitations and the application of the standard, please 
consult ANSI/HI 9.6.7-2021.

Related Topics

Pump 294
Centrifugal (Rotodynamic) Pump 298
Pump Configuration 300
Multiple Configurations 305
Pump Sizing 312
Positive Displacement Pump 318
Interstage Bleed/Takeoff Flow 313
Pump Efficiency Data 333
Submerged Pump 331
Affinity Laws 329
Pump Reliability Factors 309
Pump X has no efficiency curve data. Nominal efficiency was used in viscosity 
correction calculations 793
Pump X has no efficiency curve or nominal efficiency data... 794
Pump X properties were outside of the valid range for the viscosity correction 
calculations. Results may be invalid. 794

Positive Displacement Pump
Positive Displacement pumps can be used to provide a fixed flow for steady state analysis.

Parameter

 l Volumetric Flow Rate - Fix the volumetric flow rate through the pump.                     
 l Mass Flow Rate - Fix the mass flow rate through the pump.                     

Fixed Condition             

 l Fixed Flow Rate  - The value and unit of the fixed flow amount.                     
 l Nominal Efficiency - A fixed efficiency, useful to calculate power requirements. This is 

an optional input.                     
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 l Nominal NPSHR - Net Positive Suction Head Required for the pump at the specified 
flow. This is an optional input.                     

Acceleration Head/Pressure Parameters

Acceleration head is the energy required to change the velocity of the fluid in the system from 
zero to some non-zero velocity. This requires additional energy beyond the amount required 
simply to overcome the frictional losses in a system. This is reflected when starting a centrifugal 
pump - the peak power requirement is higher than during steady operation. Similarly, positive dis-
placement pumps are constantly accelerating and decelerating the fluid in the suction line. The 
value for acceleration head can be added to the Pump Summary via Output Control, and is vis-
ible in the Applied Standards tab.

 l Type of Pump (C) - The type of Positive Displacement Pump, for the purposes of cal-
culated the acceleration head pump type coefficient, as described below. If no predefined 
types are applicable, a user specified value must be entered.                     

 l K - The compressibility factor of the fluid, as described below.                     
 l Pump Speed - The nominal RPM of the Positive Displacement Pump.                     

This suction line acceleration head can by calculated with the method defined in ANSI/HI 6.1-
6.5-2015. This method requires the user definition of pump speed, pump type coefficient, and a 
fluid compressibility factor. Suction line length and fluid velocity are also required and are cal-
culated by AFT Fathom.

 l hacc - Acceleration head (ft)                     
 l l - Length of suction line (ft)                     
 l v - Fluid velocity in suction line (ft/s)      
 l n - Pump speed (rpm)                     
 l C - Coefficient determined by type of reciprocal pump:      

 l Simplex (Single-acting) = 0.628                         
 l Simplex (Double-acting) = 0.200                         
 l Duplex (Single-acting) = 0.200                         
 l Duplex (Double-acting) = 0.115                         
 l Triplex = 0.066                         
 l Quintuplex = 0.040                         
 l Septuplex = 0.028                         
 l Nonuplex = 0.022                         
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 l K - Factor representing relative compressibility of fluid. Some common compressibility 
factors are provided.

 l Hot Water = 1.4                         
 l Hot Oil = 2.5                         

 l g - Gravitational constant (ft/sec2)                     

AFT Fathom calculates the total acceleration head by summing the calculated acceleration head 
for each individual pipe. The solver will attempt to automatically determine the pipes in the suc-
tion line by tracing the flow upstream of the pump back to an Assigned Pressure or Reservoir 
junction. If at any point upstream of the pump there is more than one potential path (for example, 
two inflows merging together), this calculation will not proceed because the suction line is inde-
terminant. However, the flow can split into multiple outflows. As long as there is one continuous 
and unique inflow path to the pump, acceleration head can by calculated.

Note: Though the ANSI/HI 6.1-6.5-2015 standard states that the NPSHA should be cor-
rected to account for acceleration head, Fathom will not adjust the NPSHA shown in 
the output. The user should subtract the acceleration head from the displayed NPSHA 
to comply with the standard.

Submerged Pump

Represents a pump with a fixed head or pressure at suction. See Submerged Pump.
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Figure 1: Positive Displacement Pump Model

Related Topics

Pump 294
Centrifugal (Rotodynamic) Pump 298
Pump Configuration 300
Multiple Configurations 305
Pump Sizing 312
Interstage Bleed/Takeoff Flow 313
Pump Efficiency Data 333
Viscosity Correction 317
Submerged Pump 331
Affinity Laws 329
Pump Reliability Factors 309

Related Blogs

Learn About the Acceleration Head and How To Model It
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Pump as Turbine Overview
Running a pump as a turbine allows the pump to produce electrical power when the pump sees 
reverse flow. During reverse flow, the motor coupled to the Pump as Turbine (PAT) spins in 
reverse, causing the magnetic rotor to induce a current in the motor coils, turning the motor into a 
generator.

Note: The positive flow direction for the pipes connected to the PAT should be the direction in 
which flow will travel when the pump is operating as a turbine, rather than the direction 
in which flow will travel when the pump is operating as a pump. Thus, while the physical 
pump equipment will see reverse flow while operating as a turbine, the pump as a PAT 
will see positive flow.

Standard Turbine Curve

A Standard Turbine Curve is required to model a PAT and must include both head and power 
data. The head loss vs flow curve defines the head loss seen at the PAT while coupled to the 
motor and generating power. The power versus flow curve defines the power generated by the 
PAT while coupled to the motor and generating power.

To enter these curves, click Enter Curve Data. Previews of the applied curves can be viewed in 
the Standard Turbine Frame once the data has been defined.

Figure 1: Standard turbine curve

Flow Directional Behavior

A visual representation of the modeled PAT is presented in the lower right of the properties win-
dow to provide immediate feedback on what the various options represent. In the PAT depicted 
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in Figure 2, head loss and power information have been defined, and the PAT is in normal oper-
ation, with reverse flow seen at the pump. 

Figure 2: Flow Directional Behavior image for an example PAT

Related Blogs

It's a Pump! It's a Turbine! It's a Pump as Turbine!

PAT Configuration
The Pump as Turbine Configuration window is used to define the specific operation of a Pump as 
Turbine. It is opened by clicking Enter Curve Data from the Pump Properties window on the 
Pump Model tab when Pump as Turbine is selected. 

Figure 1: Enter Curve Data on the Pump Model tab

Turbine Data

The first tab of the PAT configuration defines the PAT's most fundamental behavior - the turbine 
curves. 
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Figure 2: Pump as Turbine Configuration window

A PAT can have two curves defined: 

 l Head or Pressure vs. Flow: Required. This curve is commonly referred to as the “tur-
bine curve” and defines the head loss across the PAT at any given flowrate. 

 l Power vs. Flow: Required. The power curve is used for two purposes for the PAT. First, 
it is used to determine the power generated while the pump is operating as a turbine. 
Second, it is used to determine if or when the pump and motor decouple. 

Graphs

The following tabs display the curves that have been fit to the given data. 

 l Composite Graph: Shows the curve-fit PAT Performance and Power curves. 
 l Performance Graph: Shows the curve-fit PAT Performance curve overlaid on the raw 

data points. The solver will ignore the raw data points and operate on the curve fit. 
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 l Power Graph: Shows the curve-fit Power curve overlaid on the raw data points. The 
solver will ignore the raw data points and operate on the curve fit. 

Related Blogs

It's a Pump! It's a Turbine! It's a Pump as Turbine!

PAT Operation as a Turbine
The main function of the PAT model is to allow a pump to operate as a turbine. In this mode of 
operation, the PAT generates power by removing energy in the form of a head loss across the 
pump, compared to normal centrifugal pump operation where the pump adds energy in the form 
of a head rise across the pump.

The turbine operating point is determined using the Turbine Performance Curve defined by the 
user. This curve relates head loss to flow rate similar to how the Pump Curve relates head rise to 
flow rate. Note that the PAT uses the turbine’s frame of reference for this data rather than the 
pump’s. Head loss and flow rate should be entered as positive values for the PAT. The Turbine 
Performance Curve should have a head loss greater than zero at zero flow  and should see 
increasing head loss with increasing flow. An example Turbine Performance Curve is shown in 
Figure 1 below.

Figure 1: Example Turbine Performance Curve

The power generated by the PAT is determined by the user-defined Turbine Power Curve. This 
curve relates power generated to flow rate, similar to how the Pump Curve relates pump power 
to flow rate. Note the PAT uses the turbine’s frame of reference for this data rather than the 
pump’s. The Turbine Power curve should have zero power generated at some non-zero flow rate 
and should see increasing power output with increasing flow. An example Turbine Power Curve 
is shown in Figure 2 below. 
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Figure 2: Example Turbine Power Curve

The flow rate at which the PAT generates zero power is called the ‘no load’ point. At this flow 
rate, the pump impeller is spinning with the fluid, neither adding nor removing energy from the 
fluid. At higher flow rates, the impeller’s speed is resisted by the motor, removing energy from 
the fluid and generating electricity. At lower flow rates, the impeller’s speed is resisted by the 
fluid, requiring energy to be added via the motor. These operating conditions are shown in Figure 
3 below. 

Figure 3: General turbine operating conditions
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Related Blogs

It's a Pump! It's a Turbine! It's a Pump as Turbine!

PAT Operation While Decoupled
Operation as a Turbine means the PAT is coupled to the motor, but the PAT can also operate 
while decoupled from the motor, meaning the pump’s impeller is spinning freely in the fluid 
stream. The PAT will be decoupled from the motor when it is operating below the No Load point 
(the flow rate with zero power generation) on the Turbine Curve, since below that flow rate the 
motor would be required to input power to the system.

Figure 1 below shows these operating conditions. Since the PAT is decoupled from the motor, 
the generator does not impart a torque on the pump impeller to counteract the torque applied  by 
the fluid, and the pump impeller becomes free-spinning.

Figure 3: General turbine operating conditions

While the PAT is free-spinning, the impeller will spin at a speed dictated by the fluid such that no 
torque is applied on the impeller by the fluid. This speed may change based on other transients 
in the system and is called the runaway speed.

The pressure loss of a free-spinning PAT is determined by the Turbine Performance curve, 
adjusted by the Affinity Laws. The user-defined Rated Turbine Speed is considered 100% 
speed, and the Affinity Laws are used to adjust the curve based on speed. The Affinity Laws 
adjust the Turbine Performance curve in the same direction they adjust a Pump Performance 
curve (i.e., head loss and power increase with impeller speed). 

The speed of a free-spinning impeller is determined  by the system flow rate and the No Load 
Curve.
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No Load Curve

Each runaway speed of the PAT has a different No Load point, meaning a No Load Curve can be 
created to describe how head loss is related to flow across the range of potential runaway 
speeds. Each point on the curve represents a different runaway speed and different steady 
state. Figure 2 below shows an example No Load curve overlaid with a Turbine Performance 
Curve and a Turbine Power Curve. Notice how the No Load curve intersects the Turbine Per-
formance Curve at the point where the Turbine Power Curve has zero power. 

This No Load curve can be created by plotting the head loss for multiple Turbine Performance 
Curves (adjusted for speed) at the flow where their corresponding Turbine Power Curves cross 
the zero power line. Note that AFT Fathom does not calculate, use, or require the No Load curve 
for its calculations. Rather, the No Load curve is merely an observable consequence of the phys-
ics the PAT follows. 

Figure 2: Example No Load Curve showing general turbine operating conditions

Related Blogs

It's a Pump! It's a Turbine! It's a Pump as Turbine!

PAT Operation During Decoupling
The PAT transitions between the turbine and decoupled operating conditions in two situations: 
when manually decoupled or whenever the power generated is equal to zero. The PAT cannot 
recouple after becoming decoupled during a simulation. 
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The first transition from coupled to decoupled is referred to as Load Rejection and can be set as 
a transient event in the Transient tab of the Pump Properties window. 

When this transient event is initiated, the PAT is immediately uncoupled from its motor at the 
onset of the transient simulation, the speed is allowed to change as dictated by the fluid, and the 
PAT speed is determined for each time based on the No Load Curve. The uncoupling event 
occurs instantaneously and the PAT will immediately begin operating on the No Load Curve at 
steady-state.

The second transition from coupled to decoupled occurs when the PAT reaches the No Load 
point due to other transient events in the system. This transient event is always ready to occur 
regardless of the transients defined for the PAT. When the flow rate through the PAT becomes 
low enough such that zero power is generated by the PAT, the PAT will immediately become 
uncoupled from the motor and become free-spinning with its speed determined by the system 
flow rate and the No Load Curve. 

Related Blogs

It's a Pump! It's a Turbine! It's a Pump as Turbine!

Affinity Laws
Pumps can operate at variable speeds (adjustable in the Variable Speed tab in the Pump Prop-
erties window). Affinity laws (also called homologous laws) allow an estimation of the pump per-
formance at speeds other than the design speed.

To a somewhat lesser degree, impeller diameter changes (Impeller Modifications) follow the 
same laws as speed changes. Substituting impeller changes for speed changes below can be 
used to see the effect of an impeller change or for a small impeller trim (larger trims deviate sig-
nificantly from this estimation).

Before discussing the affinity laws, it should be noted that the affinity laws are an approximation. 
In many cases, pump manufacturers will have performance data for a number of speeds. Man-
ufacturer-provided data should be used if available. Multiple Configurations can be entered to 
save pump curves at different speeds. When data is not available for varying speeds/impeller 
trims, the affinity laws can be used with an understanding that an approximation is being made.

Pump curves can generally be curve fit to a polynomial:

The speed ratio is defined in terms of the design impeller speed, N1 and the desired operating 
speed N2 as:             
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Affinity Laws

For the following ratios, subscript 1 represents the parameter from the defined curve (assumed  
to be at 100% speed). Subscript 2 represents the given parameter at the desired operating 
speed N2.             

 l Flow rate -                      

 l Pump head -                      

Note: By default NPSHr will follow the same relationship as pump head rise. The speed ratio 
exponent used for NPSHr can be changed on the Configuration Data tab in the Pump 
Configuration window.

 l Power consumption - 

 l Efficiency - 

Related Topics

Pump 294
Centrifugal (Rotodynamic) Pump 298
Pump Configuration 300
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Multiple Configurations 305
Pump Sizing 312
Positive Displacement Pump 318
Interstage Bleed/Takeoff Flow 313
Pump Efficiency Data 333
Viscosity Correction 317
Submerged Pump 331
Pump Reliability Factors 309

Related Blogs

To Affinity and Beyond!

Submerged Pump
A pump junction can be defined as submerged by clicking the Submerged Pump check box in 
the Pump Properties window on the Pump Model tab. This is convenient to avoid the need of 
modeling suction piping when the suction head or pressure is a known and fixed value.

There are three options to choose from to define a submerged pump: Head (HGL), Pressure, 
and Surface Conditions.

Head (HGL)

With the Head (HGL) option selected, the only required value is Liquid Surface HGL. This value 
refers to the liquid surface elevation relative to the reference elevation, as can be seen in Fig-
ure 1.  This is important when the elevation of the pump is a non-zero value. The specified elev-
ation for the pump is then used to determine the depth of the submerged pump.

Figure 1: Diagram of Submerged Pump, Liquid Surface HGL input
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Pressure

With the Pressure option selected, the only required value is Suction Pressure. This value refers 
to the fluid pressure at the inlet of the submerged pump.

Figure 2: Diagram of Submerged Pump, Pressure input

Surface Conditions

With the Surface Conditions option selected, there are two required values: Surface Pressure 
and Liquid Depth. Similar to how a reservoir junction is defined, the Surface Pressure is the pres-
sure of the fluid at the surface, which is helpful when the liquid surface is not at atmospheric pres-
sure. The Liquid Depth is the distance between the liquid surface and the inlet of the submerged 
pump.

Figure 3: Diagram of a Submerged Pump, Surface Conditions input

Related Topics

Pump 294
Centrifugal (Rotodynamic) Pump 298
Pump Configuration 300
Multiple Configurations 305
Pump Sizing 312
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Positive Displacement Pump 318
Interstage Bleed/Takeoff Flow 313
Pump Efficiency Data 333
Viscosity Correction 317
Affinity Laws 329
Pump Reliability Factors 309

Related Blogs

What Does “Head (HGL)” Mean for Submerged Pumps and Exit Pressures?

Back to the Basics: Calculating and Defining Head

Pump Efficiency Data

Best Efficiency Point (BEP)

By defining an efficiency or power curve, the Best Efficiency Point of the pump can be found. 
Optionally, the calculated value can be overridden with a user-defined value in the Pump Con-
figuration window. It is generally desirable to operate pumps as close to the BEP as possible. 
The Pump Summary tab in the Output can display the BEP, and the % of BEP which indicates 
how close the operating point is to the BEP.

Power and Efficiency Calculations

Various stages of power or efficiency data relating to a pump assembly can be added to a pump 
junction.

The most basic value that can be accounted for is the pump efficiency or power curve. This 
curve, entered in the Pump Configuration window, is used to determine the power/efficiency 
being delivered to the pump itself - the Shaft Power.

The Solver will determine the total dynamic head (ΔH) and flow (Q) through the pump via iter-
ation for the unique system. Then, the Ideal Power (also called hydrodynamic power) can be dir-
ectly calculated using the equation below:

where ρ is the fluid density at the pump and g is the gravitational acceleration. When a pump effi-
ciency or power curve is entered on the Pump Configuration window, the power supplied to the 
pump, or Shaft Power, can be calculated:
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where the pump efficiency comes from the pump curve at the given flow. On a pump's optional 
tab, further efficiency information can be defined:

Figure 1: Additional Efficiency Data

Entries in this table must come in pairs - both Power and Efficiency values must be present. For 
example, if Motor Power is entered, the Motor Efficiency column must also be entered. You can 
enter only motor data, only VFD data, or both.

Motor Power in this instance refers to the output power of the motor, which is equal to the Shaft 
Power calculated previously. This is because the motor driver is mechanically coupled to the 
shaft and impeller. Because the Shaft Power is already known, it can be looked up inside this 
table using linear interpolation, and the corresponding Motor Efficiency is used to calculated the 
Motor Input Power:

VFD Power is used in a similar fashion. The VFD Power in Figure 1 refers to the output power of 
the VFD, which is identical to the Motor Input Power (but instead of being mechanically coupled, 
this is represented by an electrical connection). Because Motor Input Power was calculated, 
VFD Efficiency can be found from the table using linear interpolation, and  VFD Input Power 
can be calculated:

VFD Input Power is equivalent to the Overall Power, viewable in the Pump Summary along with 
the other above values. Whenever an efficiency value is left undefined, it is assumed to be 1 (per-
fectly efficient).
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Related Topics

Pump 294
Centrifugal (Rotodynamic) Pump 298
Pump Configuration 300
Multiple Configurations 305
Pump Sizing 312
Positive Displacement Pump 318
Interstage Bleed/Takeoff Flow 313
Viscosity Correction 317
Submerged Pump 331
Affinity Laws 329
Pump Reliability Factors 309
Junction X %BEP (Y%) is above/below the POR range 784
Poor Pump Curve Fits 803

Relief Valve
The Relief Valve junction allows users to model a valve that opens at a specified pressure in the 
system. Depending on how the relief valve operates, that pressure could either be the pressure 
at the relief valve inlet or the pressure at some remote point in the system. The differences 
between those valves are discussed below. 

The Relief Valve Properties window follows the first of the two basic Properties Window formats, 
displaying the connected pipes in a fixed format. The Relief Valve junction adopts a flow dir-
ection from the connecting pipes. 

There are three types of relief valves available:

 l Internal Relief Valve: contains two connecting pipes and relieves into the downstream 
pipe. This type of relief valve acts like a regular valve that is closed until the specified pres-
sure is reached. 

 l Exit Valve: contains one connecting pipe and relieves to an external ambient pressure 
when the specified pressure is reached. 

 l Inline Exit: contains two connecting pipes and relieves to an external ambient pressure 
when a specified pressure is reached. This type of relief valve acts as a lossless con-
nection when closed and allows flow between the connecting pipes. 
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Opening and Closing Profiles

The Relief Valve junction has several methods by which the valve can open and close. These 
options are:

 l Instant: the relief valve opens fully or closes fully from one time step to the next as the 
opening or closing conditions are met. 

 l Pressure: the valve passively opens or closes according to a Cv vs. Pressure profile as 
the opening or closing conditions are met. The Cv vs. Pressure profiles are based on the 
Valve Setpoints and the data entered in the Loss Model tab. Maximum Cv vs. Time rate 
limits can be applied.

 l Never: the valve never closes. This method cannot be applied to the valve opening.

Balanced vs Unbalanced Valves

Relief valves can either be hydraulically balanced (constant backpressure) or non-hydraulically 
balanced. This characteristic of the valve is determined by how the dome of the relief valve is 
pressurized. 

For an unbalanced valve, the dome of the valve is pressurized via the fluid downstream of the 
valve. Since the downstream pressure can change during the transient, the valve position is 
based on a pressure differential between the upstream and downstream pipes rather than based 
solely on the upstream pressure. 

For the balanced valve, the dome of the valve is pressurized to a constant pressure, often by 
attaching some type of bellows device. With this system, the valve position is based only on the 
actual upstream pressure. 

Valve Setpoints

The valve setpoints determine when the relief valve will open and when it will be closed. These 
setpoints can be defined using either pressure or head. 

There are four possible valve setpoints the user needs to define:

 l Exit Pressure: the ambient pressure downstream of the relief valve for the Exit or Inline 
Exit valve types. This pressure will only be used to determine when the valve opens and 
closes when the relief valve is unbalanced.

 l Overpressure: the upstream pressure at which the valve is fully open. This input is only 
needed when the valve opens or closes based on pressure. 

 l Set Pressure: the upstream pressure at which the valve opens. This input must be spe-
cified for all valve profiles and is replaced by the High Pressure Setpoints when Remote 
Sensing is enabled. 

 l Blowdown Pressure: the upstream pressure at which the valve is fully closed. All 
options for valve opening and closing require this input, with the exception of the Never 
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profile. If the relief valve closes at the same pressure where it opens, the Set Pressure 
and the Blowdown Pressure should be set to the same value. 

Remote Sensing

The Relief Valve junction gives users the ability to model Remote Sensing Relief valves. This 
option is available anytime the valve operates as a pressure/pressure valve. 

A Remote Sensing Relief Valve is a relief valve that opens based on the pressure at a specified 
location in the system other than the upstream side of the valve. In a transient system, this 
design allows the relief valve to be more responsive to surge events by opening the valve before 
the pressure surge arrives at the valve itself. In a steady state system, this design allows the 
valve to open at some remote pressure while the degree to which the relief valve is open is 
determined by the pressure at the valve. 

Loss Model

The Relief Valve loss information is entered on the Loss Model tab. The available options 
change depending on how the valve opening and closing are defined. For all options, the Base 
Area for Loss Model can be specified, with the upstream pipe being used by default. 

The following loss model options are available depending on which profiles are selected:

 l Instant Profiles
 l Cv (Constant): the relief valve instantly changes from closed to a fixed Cv.
 l Kv (Constant): the relief valve instantly changes from closed to a fixed Kv.
 l CdA (Constant): the relief valve instantly changes from closed to a fixed CdA. This 

CdA is defined as the product of an Orifice Effective Area (A) and a Discharge Coef-
ficient (Cd).

 l The Orifice Effective Area can come from an API 526 letter designation or it 
can be User Specified. 

 l The Discharge Coefficient must always be specified by the user. The value 
is typically specified by the manufacturer. 

 l K-Factor: the relief valve instantly changes from closed to a fixed K-Factor. 
 l Resistance curve: the relief valve instantly changes from closed to a resistance 

curve. 
 l Pressure Profiles

 l Cv (Variable): the relief valve moves between the closed and open states with the 
Cv varying between 0 and the Fully Open Cv value. 

 l Kv (Variable): the relief valve moves between the closed and open states with the 
Kv varying between 0 and the Fully Open Kv value. 

The Variable Data option for the Relief Valve Loss Model allows users to model the valve losses 
based on where the valve is between fully open and fully closed. The Linear based on setpoints 
option has Impulse determine those losses solely based on the setpoints the user has specified. 
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If the user knows enough about the valve to describe a detailed loss profile, they can select the 
Non-linear option. The first data point must have a loss value of 0 at the Blowdown pressure. The 
final data point must have a loss value equal to the Fully Open loss value, at the Overpressure. 
The entered data is interpolated during the transient simulation. 

Restricted Flow Area

An optional input in the Relief Valve Properties Window is the Restricted Flow Area. This para-
meter describes the effective area restriction in the valve. This is done for the purpose of assess-
ing cavitation. In most cases, information on the size of the restricted area must be obtained from 
the manufacturer or from test data.

Special Conditions

The relief valve has two Special Conditions:

 l Failed Open: the valve is forced to remain open regardless of pressure conditions.
 l Ignore Relief Valve: the valve is forced to remain closed regardless of pressure con-

ditions.

For more information see Special Conditions.

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264
Kv and Cv Loss Model 265
Unique solution not possible - Relief valve cycles 788

Reservoir
The Reservoir junction type allows you to connect up to twenty-five pipes. At least one con-
necting pipe is required. The Reservoir junction is convenient for specifying a fixed pressure in 
your system.

A Reservoir junction applies a defined pressure and temperature (if using heat transfer) in the 
model at the junction location. When solving a pipe flow system, a Reservoir causes the rest of 
the system to distribute the flow in a manner consistent with the defined pressure.

The Reservoir Properties Window follows the second of the two basic window formats for junc-
tions. 

The Liquid Surface Elevation of the Reservoir must be defined - this value will be used along with 
the Pipe depth to determine the hydrostatic pressure contribution at the pipe inlet.

Surface Pressure is required, and fluid temperature is required when heat transfer is modeled.
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Specifying Pipe Connectivity

If there is a single pipe connected to the junction, its elevation can be directly specified on the 
Reservoir Model tab. The elevation can be specified either as an absolute Elevation, or as a 
depth below the liquid surface. This means there are two ways to define the same pipe elevation.

If multiple pipes are connected, they can each have a unique elevation. This is displayed on the 
Pipe Depth and Loss Coefficients tab. In this table, all elevations must be specified as either 
depth or elevation, as is specified by the radio button selection below the table. Additionally, 
losses such as re-entrant losses can be added to the pipe connections in this table. Loss factors 
can optionally be specified for flow into and flow out of the pipe. 

Pipes Connected Above Liquid Surface

A pipe elevation can be specified higher than that of the liquid surface. Pipes that empty into the 
Reservoir above the liquid surface are assumed to have liquid free fall to the liquid surface. AFT 
Fathom applies the proper boundary condition for above the liquid surface.

If the pipe is above the liquid surface, the only physically realistic condition is for the fluid to be 
flowing from the pipe into the reservoir. However, AFT Fathom will assume the fluid flowing into 
the pipe is the same as the reservoir fluid in order to solve the system. If this occurs a warning 
will be shown in the Output.

Infinite and Finite Reservoirs with the XTS Module 

With the standard AFT Fathom, all reservoirs are treated as infinite. With the XTS Module, reser-
voirs can be infinite or finite.             

 l Infinite reservoir
 l If modeling an infinite reservoir, the user can vary the surface level or surface pres-

sure with time. Note that the liquid level is not calculated in this case, but is input by 
the user.

 l Finite tanks
 l Finite tank reservoirs can be open or closed. Finite reservoirs require specification 

of tank geometry. Typically, the liquid level and surface pressure are defined ini-
tially, and then calculated over time based on the tank geometry.

 l Open tanks do not vary the surface pressure unless the user does so through the 
Transient tab. Closed tanks vary the surface pressure in accordance with gas ther-
modynamic laws and a user specified polytropic constant.

 l For closed tanks, users can enter maximum and minimum pressures. These rep-
resent pressure control systems on the tank such as relief valves. Liquid overflow 
lines can be modeled with normal pipes. In such cases use of valves with event 
transients can be used.

 l Known parameters initially
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 l In some cases, the initial liquid level or pressure may not be known, and it is 
desired to have this calculated based on a mass balance in the system. This can 
be selected using the check box options provided.

If an XTS model is run, and the pipe is no longer submerged with flow into the pipe, AFT Fathom 
will stop the flow in that pipe on subsequent time steps because there is no liquid to supply it.

A potential confusion exists when pipe connection data is entered as depth below the liquid sur-
face, and then the liquid surface changes during a transient. This is not an issue in that all depth 
data is converted internally to absolute elevation at the beginning of the run so that liquid level 
changes will be handled properly.

Tip: Since transient models allow the liquid level to change, and the user may desire to run dif-
ferent scenarios with different initial liquid levels, it is better to specify reservoir pipe con-
nections based on elevation and not depth.

Energy Balance

The energy balance feature is displayed only when heat transfer is being modeled. For an open 
system, most users desire that the temperature remains fixed, like the pressure does. However, 
for closed, recirculating systems, you will usually want the temperature to vary. The temperature 
can be allowed to vary at a junction by checking the Balance Energy option. See Open vs. 
Closed Systems - Balancing Energy for detailed discussion.

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264
Finite and Infinite Reservoirs 603
Pipe X elevation of Y is below Reservoir Z tank bottom elevation... 792
Tank Junction X began overflowing at Y seconds 786
Tank Junction X completely drained at Y seconds 786
Flow is into system at Reservoir Junction X 783

Screen
The Screen junction type requires two connecting pipes. This junction type allows you to model 
the irrecoverable loss that occurs through a screen, mesh, or filter flow restriction. It also allows 
you to specify loss factors as a function of a flow parameter.

The Screen Properties Window follows the first of the two basic Properties Window formats, dis-
playing the connecting pipes in a fixed format. The Screen junction does not have an explicit flow 
direction; it adopts a flow direction from the connecting pipes. 

AFT Fathom provides four standard screen types for your use:
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 l Sharp-edged perforated plate
 l Round-edged perforated plate
 l Circular wire screen
 l Silk thread screen

The loss factors for these screens are taken from handbook values. In addition to the standard 
screens that AFT Fathom provides, you may enter your own custom screen loss factor that is 
consistent with the application.

When you select Resistance Curve in the Loss Model section on the Loss Model tab, the Screen 
Properties window makes additional features available. Using these features, you can input pres-
sure drops that vary with flow. To enter this information, you can specify polynomial constants, fit 
a curve to available data, or use interpolated x-y data.

When a variable loss is specified, AFT Fathom modifies the loss factor in the Solver to agree with 
the solution. You can choose any of the optional flow and pressure parameters provided, and 
you can specify the most convenient units.

An optional input in the Screen Properties Window is the Restricted Flow Area. This parameter 
describes the effective area restriction in the screen. This is done for the purpose of assessing 
cavitation. In most cases, information on the size of the restricted area must be obtained from 
handbook or test data.

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264
Screen Loss Model 341

Screen Loss Model
The screen loss factors have much in common with orifice loss factors. In fact, the sharp-edged 
perforated plate and round-edged perforated plate screen losses are the same as for orifices 
with similar area ratios and equal upstream and downstream areas. Refer to the orifice loss 
factor equations for these relationships. The relationships are good for screen area Reynolds 
numbers above 100,000.

The circular metal wire screen, shown in Figure 1, is given by the following equation for screen 
area Reynolds numbers above 1000 (Idelchik 2007, 598):
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Figure 1: Circular metal wire screen

The silk thread screen, shown in Figure 2, is given by the following equation for screen area 
Reynolds numbers above 500 (Idelchik 2007, 577):

For other screen configurations, see Chapter 8 of Idelchik's Handbook of Hydraulic Resistance 
(2007).

Figure 2: Silk thread screen

Related Topics

K Factor Loss Model 264
Bend Loss Model 276
Area Change Loss Model 272
Orifice Loss Model 292
Tee/Wye Loss Model 347
Valve Modeling Closures with K Factors 353
Screen 340

Spray Discharge
The Spray Discharge junction must have at least one connecting pipe, and it allows up to four. 
This junction offers a flexible way of modeling a flow exiting the system through a nozzle or spray 
device.
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The Spray Discharge Properties window follows the second of the two basic Properties Window 
formats. A table displays the connecting pipe information. The pipe table grows in size to accom-
modate up to four connecting pipes.

The exit pressure to which the Spray Discharge junction discharges must be entered. If a heat 
transfer fluid model is used, then exit temperature must also be entered.

Two geometries can be modeled. The first is a normal, one hole spray, where the discharge flow 
area of the hole is entered. The second is a sparger which, in principle, works in the same way as 
a spray. For the sparger, the flow area of a single hole and the number of holes are entered. This 
assumes that the holes are hydraulically close in proximity and are the same area.

For each connecting pipe, the pipe table on the Pipe Losses tab lists the reference flow direction 
and two loss factors. The first loss factor is for physical flow out of the pipe and into the junction, 
the second is for physical flow into the pipe and out of the junction. The loss factors can be spe-
cified independently or left as zero. To edit within the pipe table, click in the appropriate column 
and row.

The distance of each connecting pipe (if any difference exists) from the specified junction elev-
ation can be entered in the pipe table.

Loss Model

The discharge coefficient for the junction is entered under the Loss Model tab in the box near the 
bottom of the window. The physical area of the exit flow can also be entered under the discharge 
coefficient input box. These two parameters are used to calculate the discharge flow rate, which 
depends on the difference between the internal pressure in the system and the specified exit 
pressure.

The K Fire Sprinkler model uses the K value as defined by the fire sprinkler industry. Whereas 
the standard K loss value is dimensionless, the K Fire Sprinkler has units associated with it. You 
can adjust these units according to your data.

If you select to model the spray discharge pressure losses with a Resistance Curve, the Spray 
Discharge Properties window makes additional features available. Using these features, you can 
input the spray pressure drop that varies with flow. To enter these factors, you can specify poly-
nomial constants, fit a curve to available data, or use interpolated x-y data. 

Special Conditions

Spray Discharge junctions have the following Special Conditions on the Optional tab:

 l None - Flow is allowed to enter/exit the system at the junction as determined by the sys-
tem hydraulics and external pressure.

 l Closed - Flow is not allowed to enter/exit the system at the junction, but flow can still go 
in/out of the connected pipes as determined by the system hydraulics.

 l No Inflow - Flow is not allowed to enter the system from the surroundings, but is allowed 
to exit the system as determined by the system hydraulics and external pressure.

- 343 -



Junctions

Flow Net vs Through

The Output Control allows reporting of Mass/Volumetric "Flow Rate Net At Junction" or "Flow 
Rate Through Junction". Depending on the number of connected pipes and flow directions 
determined by the Solver, the Flow Rate Through Junction may report values of N/A. This is 
because there may not be a unique flow path "through" the junction.

 l Net At Junction - Generally this parameter is measuring the flow entering/exiting the sys-
tem. It is calculated by summing the flow into the junction and subtracting the sum of flow 
out of the junction. A positive value indicates flow exiting the system, and a negative value 
indicates flow entering the system.

 l Through Junction - Generally this parameter is measuring the flow through a unique 
path in the junction if one is available. A unique flow path could include a scenario where 
the Special Condition is set to Closed, but flow enters from one upstream pipe, passes 
through the junction (lossless), and exits into one downstream pipe. Another example of a 
unique flow path is if the Spray has only one connected pipe.

Note: Pipes with inverted Reference Positive Flow Directions and negative flowrates can 
cause confusion when interpreting results with the Flow Rate Net At Junction and Flow 
Rate Through Junction parameters. Care should be taken when observing the signs of 
the parameters.

Transient 

(XTS Module Only) On the Transient tab the CdA or K data can be varied with time to simulate 
the opening or closing of the junction. For more information on transient data, including event 
transients, see the Junction Transient Data topic.

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264
Spray Discharge Fire Sprinklers 344
Spray Discharge CD (Discharge Coefficient) 345

Spray Discharge Fire Sprinklers
The definition of K value for fire sprinklers is:             
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where Q and ΔP can be in the units of your choice. The preference in the USA is gal/min for 
flowrate and psid for pressure. In Europe it is frequently liter/min for flow rate and bars for pres-
sure. Note that Ksprinkler is not dimensionless, but has units associated with it. Also, note that 
sprinkler vendor values for Ksprinkler implicitly assume that water is the fluid, so there is a built-in 
density of 62.3 lbm/ft3 or 1,000 kg/m3. If this sprinkler is used for something other than water, the 
Ksprinkler value will need to be adjusted.

Also note that if the spray is into the atmosphere, as is typical, the ΔP is the same thing as the 
gage pressure. That is why the previous equation is stated by some vendors as just P in the 
denominator, rather than ΔP. When stated as just P, the pressure is gage.             

Finally, note that the Exit Pressure, as defined by AFT Fathom, is different than the concept of 
Discharge Pressure, an often used parameter in the Fire Protection industry. AFT software 
defines exit pressure as the pressure of the ambient surroundings, which in an unpressurised loc-
ation at sea-level, is 1 atm.             

Note: The fire sprinkler K is not the same as the dimensionless K value as given by Equation 
1 in the Loss Model Summary topic and used extensively throughout AFT Fathom.             

The Ksprinkler is related to the discharge coefficient. It can be shown that the relationship is given 
by             

Related Topics

Spray Discharge 342
Spray Discharge CD (Discharge Coefficient) 345

Spray Discharge CD (Discharge Coefficient)
The pressure drop across a spray discharge which uses a discharge coefficient is discussed 
here. The mass flow rate through a restriction is given as follows:

The pressure drop across a discharging restriction is given as:

Combining the two yields:
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or

This equation is used for spray discharge junctions in AFT Fathom, with the ΔP being the dif-
ference between stagnation pressure at the spray discharge inlet and the exit pressure specified 
for the junction.

Related Topics

Spray Discharge 342
Spray Discharge Fire Sprinklers 344

Tee/Wye
The Tee/Wye junction type requires three connecting pipes.

Loss Model

There are two Loss Models available for Tee/Wye junctions: Simple and Detailed. If you choose 
the Simple type of Tee/Wye, no loss factors will be calculated. This is equivalent to a branch with 
no loss factors entered for the connecting pipes. In some systems, the losses associated with a 
Tee/Wye are small compared to the overall loss in the system. To avoid unnecessary cal-
culations, you should choose the Simple type of Tee/Wye unless you need the actual losses.

If the Detailed loss model is chosen, additional features will become available to define the 
arrangement of the pipes connected to the tee/wye, as well as information on the tee/wye geo-
metry. By default, Fathom will automatically define the straight and branch run pipes based off of 
the arrangement in the Workspace. If Fathom cannot determine an arrangement, the user will be 
required to define the pipe arrangement in the Tee/Wye Properties window. The arrangement 
defined in this window will affect the calculated loss factors.

The Detailed type of Tee/Wye will calculate the loss factors as they depend on the flow split as 
well as the geometry. Because of the dependence on the flow split, loss factors usually cannot 
be calculated before performing an analysis. AFT Fathom incorporates four models to calculate 
tee and wye loss factors during the actual solution. These calculations account for the developed 
flow pattern, requiring additional iteration. See Tee/Wye Loss Model and Tee/Wye Junction Com-
plexity for a detailed discussion of Detailed Tee Losses.
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If you have specific loss factors that you want to use for a Tee/Wye junction, you should use a 
Branch junction instead and enter the appropriate K factors on the Optional tab.

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264
Tee/Wye Loss Model 347
Tee/Wye Junction Complexity 806

Related Blogs

Having model convergence problems? Start here!

Give me some details about Detailed Tees!

Tee/Wye Loss Model
The loss factors calculated for tee and wye junctions set to use the detailed loss model involve 
complicated correlations that depend on the flow split, the ratio of flow areas, and the angle of 
the connecting pipes. The models used by AFT Fathom are taken mostly from Chapter 7 of 
Idelchik's Handbook of Hydraulic Resistance (Idelchik 2007). The equations will not be shown in 
this topic, but the references are given in the table below.

All tees and wyes have either diverging or converging flow streams. Two sets of equations are 
required for each configuration.

Figure 1 depicts the nomenclature. K-factor subscripts refer to base area reference and location 
in the Tee. For example, Kc,s represents the K-factor for the side branch (s) referenced to the 
combined (c) pipe flow area.

Figure 1: Idelchik’s nomenclature for diverging and converging flow through Tee/Wye junction

In the AFT Fathom Tee/Wye window, a simpler and more general nomenclature is used. AFT 
Fathom refers to the a, b, and c pipes. This allows AFT Fathom to cover all the possibilities in 
Table 3 without specifying exactly which pipe is combined flow pipe. In some cases, you may not 
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know all the flow directions in a system, and might not be able to specify which is the combined 
flow pipe. 

AFT Fathom's input method allows you to specify which pipe is the branch pipe. Idelchik calls 
this the s pipe for "side branch". AFT Fathom calls it the c pipe. If the tee angle is 90 degrees, it is 
not important which pipe you call the a pipe and which the b pipe. The distinction between a and 
b takes on more importance for non-90 degree pipes. In this case, AFT Fathom allows you to 
specify the angle of the branch pipe.

For tees/wyes the correlations used to calculate loss assume that the angle between the side 
branch and straight through flow pipes (labeled as As and Ast in Figure 2 above) can be at max-
imum 90 degrees. If the angle entered in the tee/wye junction exceeds 90 degrees between the 
side branch and straight through flow pipe, then the loss factor will be assumed to be equivalent 
to the loss with a 90 degree angle.

Figure 2 shows the Tee/Wye Properties window, with the Arrangement information at the bottom 
of the window. The a angle itself is specified on the Tee/Wye Model tab, where there are other 
options for how to model the tee.

Figure 2: Tee/Wye Properties Window allows you to specify the a, b and c pipes. The c pipe is always 
the branch pipe. This general method means you do not need to know the flow direction ahead of 

time.
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Table 3: References for Tee/Wye junction correlations

Related Topics

K Factor Loss Model 264
Bend Loss Model 276
Area Change Loss Model 272
Orifice Loss Model 292
Screen Loss Model 341
Valve Modeling Closures with K Factors 353
Tee/Wye 346
Tee/Wye Junction Complexity 806

Related Blogs

Having model convergence problems? Start here!

Give me some details about Detailed Tees!
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Three Way Valve
The Three Way Valve junction type always connects to three pipes. This junction type allows you 
to model the irrecoverable losses that occur through a valve with multiple inlets or outlets.

The Three Way Valve Properties Window does not follow either of the two basic Properties Win-
dow formats, but instead shows the connecting pipes in drop-down lists. This allows spe-
cification of which pipe is the combined flow pipe and which two are the split flow pipes.

All losses in a Three Way Valve are based on Cv (or Kv). The Cv data is entered for various per-
cent open positions, and the user ultimately specifies the actual percent open to be used in the 
model. The resulting Cv values for the two flow directions are calculated and displayed. A graph 
of the open percentage, Cv, and flow area data can be displayed by clicking the Show Graph... 
button located below the Open Percentage Data table.

Special Conditions

When the specified percent open value input into the Actual Percent Open box corresponds to a 
Cv of one or both flow directions to be zero, a Special Condition is applied to the corresponding 
flow direction(s), causing the valve to close in any direction in which the Cv is zero.

Transient 

(XTS Module Only) On the Transient tab, a transient open percent can be entered to simulate 
the position changes of the valve over time. For more information on transient data, including 
event transients, see Junction Transient Data.

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264
Kv and Cv Loss Model 265

XTS Module 
Extended Time Simulation Mod-
ule
An optional add-on module to AFT 
Fathom which allows users to sim-
ulate system transient behavior.
XTS Module 
Extended Time Simulation Mod-
ule
An optional add-on module to AFT 
Fathom which allows users to sim-
ulate system transient behavior.
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Valve
The Valve junction type requires two connecting pipes, unless you specify it as an exit valve, in 
which case only one connecting pipe is allowed. This junction type allows you to model the irre-
coverable loss that occurs through a flow control component. The Valve Properties window fol-
lows the first of the two basic Properties window formats, displaying the connecting pipes in a 
fixed format. A flow direction through the junction is adopted from the defined directions of the 
connecting pipes.

Loss Source

In order to completely define a valve junction, you must specify the valve loss source by clicking 
on the appropriate radio button under Loss Source:

 l User Specified -  This is the best option if manufacturer data is known. Manually input the 
loss information using one of the Loss Models listed in the next section.

 l From Characteristic - This option is useful if no information about the valve is known 
aside from the type, and an estimate needs to be made. Automatically calculate Cv based 
on the selection of a common valve geometry type and a Full Open Cv value. With the 
exception of the User Defined characteristic from the dropdown, the window will auto-
matically populate an Open Percent vs Cv data table by scaling the shape of the char-
acteristic curve to fit the provided Full Open Cv. Then, choose an Open Percentage under 
the Loss Parameters area to automatically calculate a Cv. The data for the characteristic 
shapes comes from Val-Matic 2009.

 l Handbook - Uses standard valve loss models from Idelchik, Miller, and Crane.

Loss Model

Depending on the selection of the Loss Source, various loss models will be displayed:

 l Flow Coefficient - Cv for English units or Kv for Metric units
 l K Factor
 l Resistance Curve
 l Equivalent Length
 l 3-K (Darby)

A special Reduced Port configuration is available when using the Handbook loss source, and 
requires the selection of a valve type and several geometric inputs. Once specified, a K Factor 
from the Handbook source will be calculated.

Exit Valves

Valves that are used as exit flow control mechanisms are specified as Exit Valves. These valves 
require an associated ambient pressure definition (also called a back pressure). Exit Valves can 
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only be connected to a single upstream pipe. To specify an Exit Valve, select the Exit Valve 
checkbox, and input the required Exit Pressure. If a heat transfer fluid model is used, the Exit 
Temperature must also be specified to define the thermal boundary condition.

Restricted Area & Optional Losses

The Restricted Area is optional input available for the User Specified and Handbook loss 
sources which describes the effective area restriction in the valve for the purpose of assessing 
cavitation. By default, Fathom will check for cavitation in pipes since an area is specified as part 
of the required pipe properties. Cavitation in a junction can only be checked if a Restricted Area 
is provided. In most cases, information on the size of the restricted area must be obtained from 
the manufacturer or test data.

Note: Fathom does not model cavitation but can provide a warning if the static pressure is 
below the vapor pressure. If a User Defined fluid is used, the optional input parameter 
for Vapor Pressure must be defined in the Fluid Properties. Fathom only models single 
phase flow, and assumes all pipes are fluid-full as stated in the Engineering Assump-
tions.

The Basis Area is available for the K Factor, Resistance Curve, Equivalent Length, 3-K (Darby), 
and Reduced Port loss models and describes the area from which loss factors are referenced 
from.

Open Percentage Data

Optional data may be entered for special valve characteristics. Specifically, the Open Per-
centage vs Cv and Flow Area can be specified. This data does not affect the Solver’s flow solu-
tion; however, engineers frequently desire to know the valve’s open percentage during operation 
to ensure it meets design requirements. The Valve Summary in the Output window always dis-
plays the valve Cv, and if data is specified for open percentage and flow area it will also display 
open percentage and flow area at the operating point. A graph of the open percentage, Cv, and 
flow area data can be displayed by selecting the Characteristic Graph tab below the table.

The Characteristic Source parameters can be used to create an Open Percent vs Cv curve that 
follows the shape of several common valve types including Ball, Butterfly, Equal Percentage, 
Globe, Linear, Plug, and Quick Opening.

Transient (XTS Module Only)

The Transient tab is only visible if the XTS Module is active, and a transient Cv or K Factor vs 
time table can be entered to simulate the opening or closing of the valve. If the optional open per-
centage table is entered, it can also be used to specify an open percent vs time transient. For a 
closed valve, the K Factor is infinite. To account for this, a K Factor of -1 (negative one) can be 
used in the transient data table. For more information on transient data, including event tran-
sients, see the Junction Transient Data topic.
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Special Conditions

The Special Condition on the Optional tab allows the valve to be specified as Closed, which is 
useful to turn off a valve while retaining the input data for future use.

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264
Kv and Cv Loss Model 265
Valve Modeling Closures with K Factors 353

Valve Modeling Closures with K Factors
A closed valve would have an infinite K-factor. Since infinity is not a possible input, AFT Fathom 
uses the convention of K = -1 (negative one) to represent a closed valve. 

This input is only valid when defining a valve transient while using the Fathom XTS Module. To 
represent a valve that is closed in steady state, use the valve Special Conditions in the Optional 
tab. 

Related Topics

K Factor Loss Model 264
Bend Loss Model 276
Area Change Loss Model 272
Orifice Loss Model 292
Screen Loss Model 341
Tee/Wye Loss Model 347
Valve 351

Related Blogs

That Valve's Got Character - Applying Pre-defined Characteristic Curves
XTS Module 
Extended Time Simulation Mod-
ule
An optional add-on module to AFT 
Fathom which allows users to sim-
ulate system transient behavior.
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Venturi
The Venturi junction type requires two connecting pipes. This junction type allows you to model 
the irrecoverable loss that occurs through a venturi area change, which is frequently used in con-
junction with pressure taps in flow measurement devices. It also allows you to specify loss 
factors as a function of a flow parameter.

The Venturi Properties window follows the first of the two basic Properties Window formats, dis-
playing the connecting pipes in a fixed format. The Venturi junction does not have an explicit flow 
direction, but adopts a flow direction from the connecting pipes.

Loss Models

AFT Fathom does not provide any standard venturi loss models. Venturi flow characteristics vary 
from vendor to vendor, so it is difficult to find generally applicable models. You must enter your 
own custom venturi loss factor that is consistent with the application. This information should be 
obtained from the manufacturer or from test data.

For convenience, you can specify constant loss characteristics of a venturi as a discharge coef-
ficient (Cd) or a loss factor (K).

If you would like to model the pressure loss through the Venturi as varying with the flow rate, 
select the radio button next to Resistance Curve under the Loss Model tab of the Venturi Prop-
erties window. Once Resistance Curve is selected, additional features appear that allow you to 
input pressure drops versus flow data. To enter this data, you can specify polynomial constants, 
fit a curve to available data, or use interpolated x-y data. 

When a variable loss is specified, AFT Fathom modifies the loss factor in the Solver to agree with 
the solution. You can choose any of the optional flow and pressure parameters provided, along 
with the most convenient units.

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264

Volume Balance

Note: The Volume Balance junction must be used with great caution. It is only intended to 
model specific situations and when used incorrectly will give incorrect results. When 
modeling mixing fluids with varying fluid properties, the Output may show a Caution 
message about the density change. This does not necessarily mean that a Volume Bal-
ance should be used at the mentioned location. Refer to Figure 1 below for an example 
of when the Volume Balance junction can be used appropriately.

The Volume Balance junction type is internal to the piping system and requires two connecting 
pipes.
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The Volume Balance Properties window follows the first of the two basic Properties window 
formats, displaying the connecting pipes in a fixed format. The flow direction through the junction 
is determined by the defined directions of the connecting pipes.

The Volume Balance junction is useful for modeling pipelines with a moving interface between 
fluids of different density. Such a scenario is, in reality, a transient application, because the mass 
in the system is not steady with time. Fathom is designed to balance mass at all branches, 
except for the Volume Balance junction. For the Volume Balance, the volume is balanced 
between the upstream and downstream pipes. This is consistent with the fact that an equal velo-
city exists at the interface, resulting in a volume balance at the interface.

Volume Balance junctions should be used in conjunction with the Variable Fluids feature, without 
heat transfer, but with variable density (see Heat Transfer/Variable Fluids panel in Analysis 
Setup).

The usage of a Volume Balance junction is illustrated with the Slurries With Variable Fluid Prop-
erties - SSL example (English, Metric).  Figure 1 below provides a summary of the four snap-
shots in time that occur in the Slurries with Variable Fluid Properties example. In reality, injecting 
slurry into a pipeline where there are two separate fluids with an interface between is a transient 
situation.

Figure 1: Four snapshots in time and when to use the volume balance junction is shown for slurries 
and variable fluid properties systems

Related Topics
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Junctions 251
General Junction Information 252
Junction Loss Models 264
Junction X has a density change across it 790

Weir

Note: The Weir junction must be used with great caution. A weir inherently is for open-chan-
nel flow. However, Fathom always assumes flow is in a pipe, and that the pipe is liquid 
full. The loss models for the Weir junction will give a good estimate of losses associated 
with a weir in a system, but does not truly model open-channel flow.

The Weir junction type requires one or two connecting pipes. The Weir Properties window fol-
lows the first of the two basic Properties window formats, displaying the connecting pipes in a 
fixed format. A flow direction through the junction is adopted from the defined directions of the 
connecting pipes. 

When using the Weir junction, keep in mind that AFT Fathom only models fluid flow in liquid-full 
pipes. Use of the Weir junction will not allow AFT Fathom to model open-channel flow.

Weir Types

There are three weir configurations available. The following input data is required for each.

 l Rectangular Sharp Crested - 
 l Surface Pressure
 l Notch Elevation (Zn)
 l Notch Width (L)
 l Channel Width (B)
 l Number of contractions
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Figure 1: Rectangular Sharp Crested Weir Model

 l V-Notch Sharp Crested - 
 l Surface Pressure
 l Notch Elevation (Zn)
 l Notch Angle (θ)
 l Channel Width (B)

Figure 2: V-Notch Sharp Crested Weir Model

 l Cipolletti, where the vertical angle is a 1:4 ratio - 
 l Surface Pressure
 l Notch Elevation (Zn)

- 357 -



Junctions

 l Notch Width (L)
 l Channel Width (B)

Figure 3: Cipolletti (1:4 ratio) Weir Model

Notch elevation (Zn)

The absolute elevation of the bottom of the notch using the same reference frame as the pipe 
elevation.

Elevation of the Upstream and Downstream Areas (Zu and Zd)

The absolute elevation of the bottom of the the upstream (Zu) tank area and downstream (Zd) 
tank area using the same reference frame as the pipe elevation.

Number of Contractions

For a Rectangular Sharp Crested weir the notch area can be contracted from the sides of the 
weir. This can be from one side (1 contraction) or both (2 contractions). If the weir notch extends 
the full length of the channel then there are no contractions.

Upstream and Downstream Area Geometry

If the Cross-Sectional Area is specified as Constant, the weir area is assumed to be a vertical 
tank with constant cross-sectional area. If the cross-sectional area changes with height, this can 
be entered by selecting the variable option and entering the cross-sectional variation in the table.
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The Tank Cross-Sectional Area is used for the purpose of determining the liquid volume. It will 
determine how high the liquid will rise or drop, since a given volume of liquid will flow into the weir 
during a time step.

Related Topics

Junctions 251
General Junction Information 252
Junction Loss Models 264
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Interface and User Options
This section focuses on the how the items within the various menus and tabs that comprise 
AFT Fathom can be used to customize the user's experience within the software. Topics dis-
cussed include the options present in each of the AFT Fathom drop-down menus, the tools avail-
able in the Primary Window tabs, and descriptions of the customizable parameters in the User 
Options menu. 

Contents

Menus and Toolbars 361

Printing 373

Primary Window Overview 374

Status Bar 376

Quick Access Panel 376

Model Status Light 387

Solution Progress Window 387

Workspace Window 388

Model Data Window 412

Output Window 417

Graph Results Window 430

User Options Overview 454

Menus and Toolbars
Many of the actions required to set up an AFT Fathom model can be completed from the various 
menus located at the top of the AFT Fathom window. Additionally, these menus can provide help-
ful features such as saving, importing and exporting files, and accessing various help documents 
such as the product help files and examples. These menus include the...

 l File menu
 l Edit menu
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 l View menu
 l Analysis menu
 l Tools menu
 l Library menu
 l Arrange menu
 l Window menu
 l Help menu

This topic also gives a high level overview of Toolbars, including the Main Toolbar as well as 
each Primary Windows toolbar.

File Menu
 l New - Opens new model.
 l Open - Calls Open file common dialog window so pre-existing model can be selected for 

opening.
 l Save - Saves input model using current model file name.
 l Save As - Opens Save As common dialog so you can specify a file name to save model.
 l Save Graph As - (Graph Results Only) - Opens Save Graph As common dialog so user 

can specify a file name to save graph as a graphics image file.
 l Save Graph Data As - (Graph Results Only) - Opens Save Graph Data As common dia-

log so user can specify a file name to save graph x-y data to text file.
 l Import Graph Data - (Graph Results Only) - Allows for data as .txt and .dat to be impor-

ted for creating graphs
 l Import Excel Change Data - (Workspace and Model Data Only) - Imports data from 

Excel file which modifies certain input data.
 l Excel Export Manager - Opens the Excel Export Manager.
 l Export Model Data - (Model Data Only) - Opens formatting window and Save As dialog 

where you can specify data from the Model Data window to be saved to a delimited file 
appropriate for spreadsheet use. Available in Model Data window.

 l Export Output - (Output Only) - Opens formatting window and Save As dialog where you 
can specify data from the Output window to be saved to a delimited file appropriate for 
spreadsheet use.

 l Merge - (Workspace Only) - Opens a Merge dialog where you can specify another model 
file to merge into the current model.

 l Print Preview - Opens Print Preview which allows you to specify special formatting for 
printed graphics and text, as well as preview printed content before sending it to the 
printer.

 l Start Batch Run - The Start Batch Run button on the File Menu opens a Batch Run dia-
log where you can select a different scenarios or models and initiates a process whereby 
Fathom runs the multiple scenarios/models automatically.

 l Load Background Picture - (Workspace Only) - Loads a background picture into the 
Workspace. Formats supported include bitmap, windows metafile, enhanced metafile, 
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JPEG, GIF and RLE. Available in Workspace window.
 l Import Piping Layout From

 l Piping Component File (.pcf) - Import a Piping Component File
 l CAESAR II Neutral File (.cii) - Import a CAESAR II Neutral File
 l GIS Shapefile (.shp) - Allows for Importing GIS Shapefile (geospatial maps) as 

.shp file.
 l EPANET File (.inp) - Import an EPANET File

 l Export Piping Layout To
 l EPANET File (.inp) - Export an EPANET File

 l Exit - Exits AFT Fathom.

Related Topics

Workspace Window 388
Model Data Window 412
Output Window 417
Graph Results Window 430
Menus and Toolbars 361

Edit Menu
 l Undo - (Workspace Only) - Undoes the previous workspace manipulation action. Fathom 

will keep track of a historical list of changes, and users can revert the workspace back to 
recent states.

 l Redo - (Workspace Only) - Reverts the workspace following Undo actions. Fathom will 
keep track of undo actions, and users can redo any recent changes that have been 
undone.

 l Cut - (Workspace Only) - Cuts the selected pipes and junctions on the Workspace and 
places them on the clipboard.

 l Copy - (Workspace, Model Data, and Graph Results Only) - Copies the selected contents 
to the clipboard.

 l Copy X-Y Data - (Graph Results Only) - Copies numerical data from graph to the Win-
dows clipboard. Available in the Graph Results window.

 l Copy Graphics - (Workspace Only) - Copies selected Workspace content to the Win-
dows clipboard. Formats supported include bitmap, windows metafile, and enhanced 
metafile.

 l Paste - (Workspace Only) - Pastes clipboard pipes and junction contents (from previous 
cut or copy operation) into the Workspace model. New paste preview mode allows the 
pasted pipes and junctions to be moved and specifically placed where desired and will 
indicate interference with other junction by changing color. A green box indicates that 
there is no interference and a red box indicates that the junctions will be overlapping and 
are not in a proper location. Available in the Workspace window.

 l Delete - (Workspace Only) - Deletes the selected pipes and junctions on the Workspace.
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 l Duplicate - (Workspace Only) - Duplicates the selected pipes and junctions on the Work-
space.

 l Duplicate Special - (Workspace Only) - Opens Duplicate Special dialog window where 
you can specify the increment by which all pipes and junction numbers will be increased 
when the model is duplicated, the creation of a new group from the duplicated objects, 
and whether to hide the duplicated objects in the output.

 l Select All - (Workspace Only) - Selects all pipes and junctions on the Workspace.
 l Select Last Selection - (Workspace Only) - The most recent pipes and/or junctions 

selected may be reselected.
 l Select Special - (Workspace Only) - Opens Select Special window where group of pipes 

and junctions can be built up.
 l Select Flow Path - (Workspace Only) - Selects the sequence of pipes and/or junctions in 

the flow path connected to the selected pipe(s) on the Workspace.
 l Select Shortest Path - (Workspace Only) - The shortest flow path between two junctions 

can be found and selected by Fathom. To enable this option, two junctions must be selec-
ted in the Workspace which Fathom will find a path between.

 l Customize Icon - (Workspace Only) - Allows user to change junction icon color, ori-
entation, and icon image.

 l Special Conditions - (Workspace Only) - Sets or clears Special Conditions for selected 
pipes and junctions on the Workspace.

 l Groups - (Workspace Only) - Allows you to create and manage groups of pipes and junc-
tions.

 l Renumber - (Workspace Only) - Allows renumbering pipes and junctions on the Work-
space using one of the Renumbering methods.

 l Join Selected Pipes/Jcts - (Workspace Only) - A continuous series of connected pipes 
and junctions can be combined into a single pipe object to simplify the Workspace. See 
Joining and Splitting Pipes.

 l Split Pipe at Intermediate Elevations - (Workspace Only) - A pipe with intermediate 
elevations can be split into separate pipes at the intermediate elevation points. See Join-
ing and Splitting Pipes.

 l Global Pipe Edit - (Workspace and Model Data Only) - Opens Global Pipe Edit window 
where editing of multiple pipes can be performed.

 l Global Junction Edit - (Workspace and Model Data Only) - Opens Global Junction Edit 
window where editing of multiple junctions can be performed.

 l Transfer Results to Initial Guesses - (Output Only) - Copies solution results into initial 
guesses for pipes and junctions.

 l Make Selection Same As Parent - (Workspace Only) - Replaces all input data for the 
selected pipes and/or unctions with data from those objects in the current scenario's par-
ent.

 l Clear Initial Guesses - Clears all initial guesses in pipes and junctions.

Related Topics
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Workspace Window 388
Model Data Window 412
Output Window 417
Graph Results Window 430
Menus and Toolbars 361

View Menu
 l Last View - (Workspace Only) - Switches to the most recent Workspace view. The view is 

changed by scrolling, zooming, or using the Workspace Find. The Last View in the View 
Menu will take you back to the previous view of the Workspace. You can toggle between 
two views by continuously clicking Last View.

 l Select Objects - (Workspace Only) - Changes cursor to selection tool to select junctions, 
pipes, etc.

 l Overview Map - (Workspace Only) - Opens overview map in the Quick Access Panel.
 l Workspace Pan - (Workspace Only) - Changes cursor to pan tool to move around work-

space.
 l Show Magnifier - (Workspace Only) - Turns on the Magnifier tool in the Workspace.
 l Show Object Status - (Workspace Only) - Toggles Show Object Status, which checks 

status of all pipes and junctions in model.
 l List Undefined Objects - (Workspace Only) - Opens Undefined Objects window which 

displays undefined pipes and junctions and their properties.
 l Extended Model Check - Performs and exhaustive check of model consistency and com-

pleteness.
 l Highlight in Pipe and Jct Windows - (Workspace Only) - Toggles Highlight feature for 

pipe and junction Properties Windows.
 l Color Common Size Groups - (Workspace with ANS Module Only) - Colors the pipes 

assigned to the selected Common Size Group(s) in the Workspace.
 l Color Design Requirements - (Workspace with ANS Module Only) - Colors the pipes 

assigned to the selected Design Requirement in the Workspace.
 l Bookmarks - (Workspace Only) - Allows creation and management of bookmarks.
 l Find - (Workspace Only) - Opens window whereby specific pipes and junctions can be 

found.

Related Topics

Workspace Window 388
Model Data Window 412
Output Window 417
Graph Results Window 430
Menus and Toolbars 361
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Analysis Menu
 l Analysis Setup - Opens the Analysis Setup window.
 l Time Simulation (XTS Module Only) - Allows selection of either steady-state run or 

transient run.
 l Goal Seek & Control (GSC Module Only) - Allows selection of whether to use the Goal 

Seek & Control parameters in the current run.
 l Slurry (SSL Module Only) - Allows selection of whether to use normal fluid calculation 

or settling slurry calculation in the current run.                    
 l NFPA Configuration - NFPA must first be enabled in the NFPA panel. Its use can then 

be toggled on and off here.
 l Automated Sizing (ANS Module Only) - Allows selection of whether to use Network 

Sizing calculations in the current run.                     
 l Fluid Properties... - Opens the Fluid panel in Analysis Setup.                     
 l Transient Control... (XTS Module Only) - Opens the Simulation Duration panel in Ana-

lysis Setup.
 l Run Model... - When the model is complete (as determined by the Analysis Setup win-

dow), the Run Model selection sends the model to the Solver for solution.                    

Related Topics

Workspace Window 388
Model Data Window 412
Output Window 417
Graph Results Window 430
Menus and Toolbars 361

Tools Menu
 l Scenario Manager - Opens the Scenario Manager window.
 l Last Scenario - Switches back to the previously loaded scenario.
 l Generate Disconnected Scenario - (Output Only) - Generates a scenario which is no 

longer connected into the Scenario Manager hierarchy and thus does not inherit changes 
from parents.

 l Compare Scenarios - Quickly sets up a comparison between the current scenario and a 
related scenario.

 l Scenario Comparison Tool - Opens the Scenario Comparison Tool window, allowing 
users to compare differences between any two or more scenarios in a model.

 l Output Control - Opens the Output Control window.
 l Output Print Content - (Output Only) - Configures what content can be printed from the 

Output window.
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 l Output Language - Selects the display language for certain phrases in the Output win-
dow, Graph Results window, and the labels in Workspace Layers.

 l Model Data Control - (Model Data Only) - Opens the Model Data Control window.
 l Model Data Print Content - (Model Data Only) - Configures what content can be printed 

from the Model Data window.
 l Select Graph Parameters - (Graph Results Only) - Opens window to allow user to select 

which parameters to graph.
 l Quick Graph Formatting - (Graph Results Only) - Opens window to allow user to 

change quick graph title and axis names, fonts, and scale values.
 l Design Alerts - Opens the Design Alerts window.
 l Cost Application Manager - Opens the Cost Application Manager window. Cost data 

can be applied to all pipes and junctions.
 l Cost Summary - Opens the Cost Summary window.
 l Fluid Property Viewers - Gives options to open either the SteamCalc Viewer or 

Chempak Viewer. These are separate executables bundled with the software. Chempak 
Viewer requires a license.

 l Activate Modules - Opens the Modules panel in Analysis Setup where optional add-on 
modules can be activated or deactivated.

 l eLicense Information - Visible if AFT Fathom was opened using an eLicense - shows 
general information about the eLicense.

 l Keep Network eLicense Checked Out - If a network eLicense is used, it can be kept 
Checked Out to this machine. This will prevent it from being lost when going offline, and 
prevent it from being accessible by other users. The license will be good for the Checkout 
Period - generally one week but depends on the specific company license.

 l Model Diagnostics - Opens the Model Diagnostics window which provides troubleshoot-
ing information.

 l Custom Units - Allows custom unit names to be enabled or disabled. Custom unit names 
can be defined in the User Options under the Unit System section.

 l User Options - Opens the User Options window.

Related Topics

Workspace Window 388
Model Data Window 412
Output Window 417
Graph Results Window 430
Menus and Toolbars 361

Library Menu
 l Add Junction to Library - (Workspace Only) - Prompts you to enter the name to be used 

in the Junction Library for the currently selected junction. After naming, adds junction to 
the library.
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 l Edit Junctions - Opens Edit Junctions window where you can delete or rename entries 
in the Junction Library.

 l Edit Fluids - Opens Edit Fluids window where you can add, delete, modify or review cus-
tom fluids.

 l Edit Pipe Materials - Opens Edit Pipe Materials window where you can add, delete, 
modify or review custom pipe materials.

 l Edit Insulations - Opens Edit Insulations window where you can add, delete, modify or 
review custom insulations.

 l Edit Fittings & Losses - Opens Edit Fittings & Losses window where you can add, 
delete, modify or review custom pipe fittings and losses.

 l Edit Solids  (SSL Module Only) - Opens the Edit Solids window where you can add, 
delete, modify or review solids properties for slurry modeling.

 l Cost Library - Opens the Edit Cost Library window where you can add, edit, or review 
cost libraries.

 l Energy Cost Library - Opens the Energy Cost Library window to input time varying 
energy costs.

 l Suggest Pump - Opens the Suggested Pumps window which allows the user to search 
libraries created in Fathom or the Intelliquip™ online database of pump manufacturers to 
find and select a pump (and the associated performance curve) based on the operating 
point. See the Pump Sizing topic for more information.

 l Library Manager - Opens the Library Manager window.

Related Topics

Workspace Window 388
Model Data Window 412
Output Window 417
Graph Results Window 430
Menus and Toolbars 361

Arrange Menu
 l Primary Windows - Allows you to configure the Primary windows in two panes in a hori-

zontal or vertical orientation. The primary windows can be further rearranged by dragging 
the tabs into the center of the screen and adjusted by moving the tab into the desired pos-
ition in the docking guide (see Figure 1).
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Figure 1: The Docking Guide can be used to view multiple primary window tabs at the same time

 l Sort Table By - (Output Only) - Allows user to order tables in order of any variable and in 
ascending or descending order.

 l Rotate Icon Right or Left - (Workspace Only) - Rotates icons for all selected junctions 
on the Workspace.

 l Auto-rotate Icon - (Workspace Only) - Rotates the selected icon(s) to align with the con-
nected pipes if possible.

 l Rotate Selection Right or Left - (Workspace Only) - Rotates selected pipes and junc-
tions as a group.

 l Align - (Workspace Only) - Aligns selected pipes and/or junctions on the Workspace. You 
can choose to align pipes and junctions, just pipes, or just junctions horizontally or ver-
tically on the workspace.

 l Pipe Drawing Mode - (Workspace Only) - Select the type of grid layout that the model 
will use.

 l 2D Freeform - Junctions can be placed anywhere on the Workspace.
 l 2D Orthogonal - Toggles orthogonal drawing capability on the Workspace. This 

toggle is a shortcut to enabling the feature in User Options window.
 l Isometric - Uses an isometric grid.

 l Snap to Grid - (Workspace Only) - Available for 2D grids (on by default for isometric 
grid). Toggles Snap to Grid feature on the Workspace. When ON, all Workspace pipes, 
junctions and annotations snap to a grid specified in User Options window.

 l Show Grid - (Workspace Only) - Toggles Show Grid feature on the Workspace. Shows or 
hides grid that is specified in User Options window.

 l Make Selected Pipes and Jcts Orthogonal - (Workspace Only) - Makes all selected 
pipes and pipes connected to selected junctions on the Workspace orthogonal.

 l Flip Vertex - (Workspace Only) - Available when orthogonal drawing is enabled. This will 
flip the vertex of all selected pipes on the Workspace.

 l Scale/Flip Workspace - (Workspace Only) - Scales (shrinks or expands) or flips either 
selected or all pipes and junctions on the Workspace.
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 l Set Pipe and Junction Locations to Parent - (Workspace Only) - Sets locations of pipe 
and junction labels to the same position as the parent scenario.

 l Reset Label Locations - (Workspace Only) - Sets locations of pipe and junction labels to 
their default locations.

 l Disable Pipes Snapping to Isometric Grid - (Workspace Only) - Toggles Snap to Grid 
feature on the Workspace for the selected pipe. When Snap to Grid is disabled for that 
pipe, the pipe end point no longer snaps to grid points and pipe segments do not follow 
the Isometric lines.

 l Add/Remove Segments - (Workspace Only) - Allows user to Add Segment (visual bend 
in pipe), Add Segment at Right Angle, Add Multiple Segments, Remove Segment, or 
Remove all Segments.

 l Lock Object - (Workspace Only) - Locks selected pipes and junctions on the Workspace 
so they cannot be moved. A lock symbol appears next to locked pipes or junctions when 
an attempt is made to move the pipe or junction.

 l Reverse Direction - (Workspace Only) - Reverses the reference positive flow direction of 
all selected pipes on the Workspace.

Related Topics

Workspace Window 388
Model Data Window 412
Output Window 417
Graph Results Window 430
Menus and Toolbars 361

Window Menu
 l Workspace - Makes the Workspace window active.
 l Sizing (ANS Module Only) - Makes the Sizing window active.
 l Model Data - Makes the Model Data window active.
 l Output - Makes the Output window active.
 l Graph Results - Makes the Graph Results window active.

Related Topics

Workspace Window 388
Model Data Window 412
Output Window 417
Graph Results Window 430
Menus and Toolbars 361
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Help Menu
 l Help File -  Opens help site home page
 l Use Offline Help - Indicates that the PDF help file will be used instead of the Online AFT 

Help File when the help buttons in topics are clicked. Note that the PDF help file must be 
downloaded from the PDF Downloads page on the online help site prior to using this 
option.

 l Quick Start Guide - Opens quick start guide pdf in English or metric units 
 l Quick Start Video - Opens quick start video series on aft.com
 l Optimization Assistant (ANS Module Only) - Opens the Optimization Assistant to help 

identify input that will potentially effect the sizing results. Also appears if problems are 
identified when the model is run.                     

 l Keyboard Shortcuts - Opens keyboard shortcut help page in help system
 l Show Examples - Opens help system with links to various example problems. Note that 

the Examples PDF  must be downloaded from the PDF Downloads page on the online 
help site if the Use Offline Help option is active.

 l Video Tutorials - Opens video tutorials on aft.com in English or metric units and English 
or Spanish language

 l Technical Seminars - Opens information on training courses on aft.com.
 l Flow Expert Package - Opens information on aft.com for individualized help from AFT 

engineers for training, modeling, consulting, and more
 l Online Learning Center - Opens learning center on AFT website with links to resources 

such as blogs, video tutorials, webinars, etc.
 l AFT Home Page - Opens home page on aft.com
 l AFT Blog - Opens blog home page on aft.com
 l Send Email to Support  - Links to AFT support in your default email program
 l Latest Release - Opens page on aft.com to download the newest AFT Fathom release
 l AFT Notifications - Opens page on aft.com where you can sign up for email notifications 

for new software updates and releases
 l About AFT Fathom - Opens window in AFT Fathom with information on current AFT 

Fathom version, license number, etc.

Related Topics

Workspace Window 388
Model Data Window 412
Output Window 417
Graph Results Window 430
Menus and Toolbars 361
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Toolbars
The Toolbars offer quick access to the features used most frequently in AFT Fathom. There are 
actually several Toolbars in all. One is the Common Toolbar, and it is always shown. Its features 
are common to all Primary Windows. In addition, there is one Toolbar for each Primary Window, 
offering features appropriate for work in that window. You only see two Toolbars at a time in AFT 
Fathom. The function of each icon in a given Toolbar appears when you pass the mouse over 
the icon button without clicking on the button.  Each of the functions on the Toolbar is also avail-
able through the menu system.

Figure 1: Common Toolbar

Figure 2: Workspace Toolbar

Figure 3: Model Data Toolbar

Figure 4: Output Toolbar

Figure 5: Graph Results Toolbar

Related Topics

Workspace Window 388
Model Data Window 412
Output Window 417
Graph Results Window 430
Menus and Toolbars 361
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Printing

Printer Page Layout

The Printer Page Layout tool enables users to control how a model on the Workspace will be 
split across pages in the Print Preview window. To access this tool click the printer icon in the bot-
tom-right of the Workspace. The Printer Page Layout options should appear.

Figure 1: The Printer Page Layout options control how the model is split between pages on the Print 
Preview

 l Show Page Boarders - When checked, a dotted yellow outline will appear around sec-
tions of the model. If the dotted yellow lines form a single box around the model, this 
means the entire model will fit on a single page. If the dotted yellow lines form multiple 
boxes, regardless of the size of the boxes, the model will be divided such that everything 
in a box will appear on its own page once the Print Preview is used.

 l User Defined Print Area - When checked, a purple box will be drawn around the entire 
model. Clicking on this box will cause sizing handles to appear. Using these sizing 
handles along with the "Show Page Boarders" enables users to customize more precisely 
what appears on each page. Additionally, a user can shift the model on the Workspace in 
order to place specific sections of the model on specific pages.

 l Paper Size - The paper size is a drop down with a selection of page dimensions based on 
the page sizes. The list of page sizes is determined by  whatever printer page sizes are 
supported by your printer. Selecting one of these sizes will affect the size of the paper the 
model will be printed on. As such, the size of the boxes formed by the dotted yellow lines 
from the "Show Page Boarders" will adjust in size.

 l Orientation - The portrait setting will flip the page such that the longest side from the 
paper size will align vertically on the page. The Landscape setting will flip the page such 
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that the longest side from the paper size will align horizontally. As such the boxes created 
from the "Show Page Borders" option will follow suit.

 l Contents Scaling - This feature determines how large the model will appear on each 
page. As the slider moves, it will appear as though the boxes from the "Show Page 
Borders" are shrinking or growing. This does not affect the dimensions of the pages. 
Instead, when the Print Preview is used the page size will remain the same, but the 
objects in each box will fit to the pages as displayed on the Workspace.

Print Preview

The Print Preview window allows you to access special print features such as Print Preview and 
Fit to One Page. It is accessed from the File menu or using the shortcut CTRL + P.

The Print Preview window also offers you a preview of the print content and format for all Primary 
Windows. By clicking the Print Preview button you can review your printed material at several 
zoom states. Individual pages can be printed.

The "Fit To Page(s)" feature causes the graphic image generated from the Workspace window 
to be compressed onto the specified number of pages. This is a convenient feature for creating 
reports of your model. The Print Preview supports whatever printer page sizes are supported by 
your printer, so the use of legal paper or larger may allow you to get more visible details. The 
graphics can also be centered vertically and/or horizontally. You also can fit your content onto 
multiple pages.

The Page Setup option in the Print Preview window allows you to set the page orientation, paper 
size/type, and margins.

Additional special printing features affect the Workspace. The "Selected on Workspace" option 
works with Workspace printing by selectively printing the pipes and junctions currently selected 
on the Workspace.

By default, the junction icons on the Workspace will be printed with the same colors as displayed 
on the screen. It also prints the background color as specified in the User Options > Workspace 
> Colors and Fonts. You can also specify that the junction icons be printed in black and white 
(still with the color background) or that the entire printout be black and white.

If you added a background picture from the File menu, this picture will be included in the printout.

Finally, if you have a grid displayed on the Workspace, the grid will be included in the printout.

Page options allow the use of a company logo, user comments, titles, and different options for 
borders.

Related Topics

Interface and User Options 361

Primary Window Overview
AFT Fathom has several Primary Windows that work in an integrated fashion. Each is located on 
a separate, moveable tab. You work exclusively from one of these windows at all times. For this 
reason, they are referred to as Primary Windows.
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You can change between the Primary Windows by selecting them from the Window menu or by 
clicking the appropriate tab within the AFT Fathom window.

 l Workspace
The Workspace Primary Window is where the user creates the graphical representation 
of the system. Engineering data is input on pipe and junction property windows which are 
opened by double-clicking the objects.
The Workspace Layers are also located on this Primary Window and allow the user to dis-
play both input and output data superimposed on the pipe system schematic.

 l Model Data
The Model Data Primary Window summarizes the engineering input data from the Work-
space into categorized tables. This allows for easy review of the system inputs, and 
double clicking cells will open the pipe or junction properties for quick editing.

 l Output
The Output Primary Window offers a powerful and diverse range of features for reviewing 
analysis results which are organized into categorized tables and lists. The Output allows 
the user to easily compare multiple design scenarios with color coded rows, details errors 
or design requirement violations, and prepare the results for documentation.

 l Graph Results
The Graph Results Primary Window allows the user to create a wide array of graphs with 
various parameters which are integral to gaining a deeper understanding of the pipe sys-
tem’s behavior. The user can adjust various formatting settings such as axis ranges, 
labels, colors, and create dual y-axis or stacked graphs. The settings can be saved into 
templates called Graph List Items so that the graphs can be easily reproduced.

If the ANS Module is activated, an additional Primary Window called the Sizing window will be 
available, which allows sizing information to be configured.

Primary Win-
dow

Can Dis-
play Input

Can Dis-
play Out-

put

Workspace ✓ ✓

Model Data ✓  

Output  ✓

Graph Res-
ults  ✓

Related Topics

Interface and User Options 361
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Status Bar
AFT Fathom's Status Bar displays contextual information about the current scenario or oper-
ation.

Figure 1: Current scenario displayed in the Status Bar

The Status Bar indicates the status of certain operations - for example, when opening a model 
the progress of loading the pipes, junctions, and scenarios is displayed.

Figure 2: Status Bar displaying progress when opening a model

Related Topics

Interface and User Options 361

Quick Access Panel
The Quick Access Panel, as shown in Figure 1, contains several useful features:

 l Scenario Manager - Configure the scenarios and variations of the model
 l Properties tab - Review pipe/junction inputs or output, and edit annotations
 l Workspace Layers - Superimpose input and output parameters on top of the Workspace 

model
 l Overview Map - Easily navigate large models
 l Activate Add-on Modules - Shortcut to the Add-on Modules group in the Analysis Setup
 l Model Status Light - Green/red light indicating if all required input is present and if the 

Solver is ready to run
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Figure 1: The Quick Access Panel

Scenario Manager

By clicking on the Scenario tab in Figure 2 below, you have the full scenario customization ability 
as you would with the Scenario Manager. You can create child scenarios, expand or collapse 
various families of scenarios, and use the many other Scenario Manager features here as well.
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Figure 2: The Scenario Manager

Properties Tab

As seen in Figure 1 or 2, there is a "Properties" tab in the Quick Access Panel.  When pipes and 
junctions are drawn on the Workspace, you can quickly view the Pipe or Junction Properties by 
first selecting a pipe or junction on the Workspace, then clicking on the "Properties" tab. The 
tab's name will dynamically update depending on which pipe/junction is selected. This will dis-
play the Object Property data as well as any Output data if the model has been run.  Figure 3 
below shows an example of what the Properties tab would look like when clicking on a pipe on 
the Workspace after it has been defined and output was created.

- 378 -



Interface and User Options

Figure 3: Viewing the Pipe/Junction Properties and Output Data from the Quick Access Panel

Annotations can be edited by selecting an annotation on the Workspace which will bring up their 
properties in this tab where they can then be edited.
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Figure 4: Annotation view for the Properties in the Quick Access Panel

Workspace Layers Tab

The Workspace Layers tab contains settings relating to object visibility, labels, superimposing 
input/output data, and color maps.

Figure 5: View of the Workspace Layers panel structure
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Overview Map

When a model is very large in size, it can be troublesome to have to constantly drag the model 
around on the Workspace to get to a specific area of the model you want to view.  By clicking on 
the Workspace Overview Map button in the red box in Figure 6, you will bring up a map that is a 
bird's eye view of the model.  Drag the small square in the Workspace Overview Map over vari-
ous parts of the model, then zoom in and out of the model.  You can also click the "Fit" button to 
see the full model zoomed out on the Workspace. You can also zoom in and out using the mouse 
wheel.
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Figure 6: Workspace Overview Map

Activate Add-on Modules

Clicking the Modules button in the bottom right of the Quick Access Panel in Figure 7 launches 
Analysis Setup to the Modules panel to activate or deactivate add-on modules.
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Figure 7: Activating the Modules from the Quick Access Panel

Model Status Light

The Model Status Light is located in the bottom-right of the Quick Access Panel (Figure 8). Click-
ing the Status Light will open Analysis Setup. When each item in Analysis Setup is fully defined, 
it will have a green check mark.  When all necessary items in Analysis Setup are completed, the 
Status Light will turn from red to green, indicating that the model can be run.
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Figure 8: The Model Status Light is located at the bottom-right of the Quick Access Panel

Minimizing the Quick Access Panel

By default, AFT Fathom opens with the Quick Access Panel automatically expanded.  The Quick 
Access Panel can be easily collapsed and pinned to the side of the Workspace to allow for a lar-
ger usage area of the Workspace.  Figure 9 shows the AFT Fathom window with the Quick 
Access Panel initially expanded.  By clicking on the thumbtack pin button (highlighted below with 
the red box), the Quick Access Panel will then become collapsed as shown in Figure 10.  After 
the Quick Access Panel is collapsed, it can be temporarily expanded again simply by hovering 
over the "Scenario" sidebar with the mouse.
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Figure 9: The Workspace with the Quick Access Panel expanded

Figure 10: The Workspace with the Quick Access Panel collapsed
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Related Topics

Interface and User Options 361

Model Status Light
The light at the right of the Status Bar located at the bottom of the AFT Fathom window, which 
indicates whether or not the model can be sent to the Solver (the part of AFT Fathom that applies 
the governing incompressible flow equations to obtain a solution to the pipe system).             

Clicking on the Model Status Light will show the Analysis Setup window, which indicates incom-

plete inputs  with a red exclamation mark:       

Related Topics

Interface and User Options 361
Solver
The part of AFT Fathom that 
applies the governing incom-
pressible flow equations to obtain a 
solution to the pipe system.

Solution Progress Window
Solution Progress indicates the current state of the solution iterations.

The most out of tolerance junction or pipe is listed for the appropriate tolerances, along with gen-
eral information about the solution method and related settings.

Note: Both absolute and relative criteria are always displayed. This can be helpful for select-
ing the appropriate tolerance criteria on difficult to converge models.             

The area in the bottom of the window will give important feedback on the model solution. It is 
important not to dismiss messages in this area, as they could have an impact on results.

When the model solution is converged, options to view Output, Graph Results, and Workspace 
become available.

Pausing the iterations allows the modification of certain Steady Solution Control parameters dur-
ing the run, as well as viewing the iteration history. These options are available under Other 
Actions.

Related Topics

Interface and User Options 361
Iterations Panel 163
Review the Iteration History 808
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Workspace Window
The Workspace window is the sole area where you specify the model layout and connectivity. 
The Workspace window has two separate functional areas: the Toolbox on the far left and the 
Workspace itself encompassing the rest of the screen (see Figure 1). 

Figure 1: The Workspace window

Printing

The Workspace image can be:

 l Copied to the clipboard (Note: cannot be done from print preview)
 l Saved to a picture file
 l Saved directly to an Adobe PDF file
 l Sent to the printer

The Print Preview window allows the above outputs to be applied to all or certain selected Work-
space objects.

Related Topics

Interface and User Options 361
Menus and Toolbars 361
Workspace Layers 389
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Annotations 399
Merging Models 404
Renumbering Workspace Objects 403
Scale/Flip Workspace 405
Magnifier Tool 405
Extended Model Check 410
Keyboard Shortcuts for Workspace 408
Undefined Objects Window 407
Raw Data Changes 411
Duplicate Special 406

Workspace Layers
Fundamentally, Workspace Layers are used to control the visibility of Workspace objects and 
labels.  Layers allow custom views to be created in which results can be displayed without need-
ing to leave the Workspace window.  A group of layers functions like a stack of transparencies, 
with each layer displaying specific, customizable information.  The view on the Workspace is a 
composite of the information presented by all visible layers, but all objects exist regardless of vis-
ibility for the purposes of calculations and object connections.

Figure 1: Information from all currently visible layers combines to form the view displayed on the 
Workspace

Layers can be shown or hidden to create different views of the Workspace.  The visibility of 
objects on the Workspace depends on the layers that are shown, as objects on hidden layers are 
not shown on the Workspace unless present on another layer. If an object exists on multiple lay-
ers, only the top-most representation is visible. The order of the layers is controlled by the order 
in which they are listed in the Workspace Layers panel.
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Workspace Layers Panel

The Workspace Layers panel is accessed via the Workspace Layers tab in the Quick Access 
Panel. There are two areas within the Workspace Layers panel to control Layer Presets and Lay-
ers.

In the Layers area, new layers can be created, and any selected layers can be renamed, duplic-
ated, and toggled in visibility. The Global Layers Settings menu is accessed here, and the 
column of visibility icons on the right shows the current visibility of each layer and can be clicked 
to toggle visibility. Hovering over a layer, a gear icon appears that links to the layer’s Layer Set-
tings options for customization.

Figure 2: View of the Workspace Layers panel structure

- 390 -



Interface and User Options

Standard layers control pipe and junction styles, labels, and visibility, along with the visibility of 
any annotations in the model. Among the standard layers is the All Objects Layer. The All 
Objects Layer exists in all models and contains all pipes, junctions, and annotations in the 
model. This serves as the primary layer, provides a central location for users to quickly see all 
objects in the model, and is always the bottommost layer.  When creating a view where some 
objects are hidden, the All Objects Layer can be toggled in visibility so that only objects visible in 
other layers are shown on the Workspace.

Other standard layers can be reordered up or down the layer stack using the areas at the top of 
the Layers area. For pipe and junction labels, the order of displayed text items is affected by the 
order of the layers containing label text.

Standard layers can be created from the New Layer drop-down as a Blank Layer or From Work-
space Selections. Layers created from Workspace selections have the selected objects and 
their labels visible in the new layer.

By default, new objects are visible only on the All Objects Layer.  However, if layers are set as Act-
ive Layers, then any new objects that are created and their labels will be visible within all Active 
Layers. Active Layers are set by hovering over a layer and clicking the pencil icon and any cur-
rently Active Layers are denoted by the pencil icon.

Layer Presets

Layer Presets allow customized Workspace views to be retained by saving the status (visibility) 
of each layer. There are four columns in the Layer Preset area. One shows the name of the pre-
set, the Load Preset option allows the previously saved layer states to be loaded onto the Work-
space, the Update Preset option saves the current layer states to that Layer Preset, and the Link 
Preset option links that preset to the currently active scenario.

By linking a preset to a scenario, it will automatically load whenever that scenario is loaded in the 
future. Individual layers, by contrast, are not tied to a specific scenario and are defined globally 
and immediately available in all scenarios. A layer can only show objects that exist in the active 
scenario, and changes to the style of an object in a layer will affect all scenarios.
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Global Layer Settings

Figure 3: Global Layer Settings window

The Global Layer Settings are accessed from the double gear icon on the Layers Toolbar in the 
Quick Access Panel. The properties that are controlled by Global Layer Settings are not defined 
for individual layers – changes to these settings affect all layers globally.

Text and Graphics Options allow the analysis title, input filename, scenario name, and units in 
the legend to be toggled.

Note: The analysis title is set in the general tab of Output Control.

(XTS Module Only) For using XTS in the Workspace, the Show Time for Displayed Results 
option shows the time associated with the current transient results on the Workspace. This is par-
ticularly useful for printing.

The Fonts setting controls the fonts for Data/Text (e.g. labels), the Title text (the analysis title, 
input filename, and scenario title if visible) and the text in the legend.

The Numerical Formats option determines the minimum number of digits shown for input and out-
put data displayed within label text.

Layer Settings - Pipes & Junctions

The Layer Settings window can be accessed by double-clicking the layer, from the single gear 
icon on the right of each layer, or by selecting the layer and clicking the single gear icon on the 
Layers Toolbar.

The layout of the Layer Settings window is similar to Analysis Setup, with a number of groups lis-
ted on the left side of the window. Each group contains items that when selected change the con-
tent of the main panel area on the right.
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Figure 4: The Show/Hide & Style panel allows the appearance and visibility of pipes and junctions to 
be managed

The Pipes & Junctions group of the Layer Settings window allows the pipe and junction color and 
size/thickness to be defined for a given layer, along with which pipes and junctions are visible. 
Note that changes to this panel are made live in real time, and no Apply button is needed to apply 
the changes that you make. Pipes and junctions are shown in two separate lists, which can be 
filtered.

Multiple pipes or junctions can be edited at a time using the Color, Size, and Thickness modifiers 
at the top of each table, or set to default options with the Defaults buttons towards the bottom. 
The usual tools for selecting pipes and junctions, including Workspace select and Select 
Special, are available here. Pipes and junctions may also be edited individually with the visibility, 
color, and size options in each row.

The appearance of new pipes and junctions is layer specific, and can be set to default options 
with the top Defaults button or modified with the New Pipe Color, New Pipe Thickness, and New 
Junction Size options. Note that color and icon style for new junctions are set via the Toolbox as 
they are specific to each type of junction.

List Pipes & Junctions from All Scenarios is toggled off by default to reduce unintended changes 
to items in other scenarios, but this can be toggled on to include objects from all scenarios in the 
lists.

Layer Settings - Label Control

A label is text that is associated with a pipe or junction on the Workspace. Labels include both 
input and output parameters along with object names, numbers, and workspace symbols. While 
there is no separate output mode, output parameters are only displayed when the current 
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scenario has output data available. If no output is present, the parameter in the list to the right will 
appear grayed out. Input parameters will always be shown when added to the list on the right. 
The label shown for an object on the Workspace is a combination of defined label items from 
each visible layer, and the order of the items is determined by both the layer order and the order 
that parameters are listed within each layer.

Figure 5: The Junction Parameters panel within the Label Control group of Layer Settings

Within the Label Control group, the Pipe Parameters and Junction Parameters items allow for 
the parameters associated with a layer to be customized. When there is no output available, out-
put parameters will be grayed out within the list, but their list position and units may still be 
edited.

Label locations are defined globally, so the Reset Label Locations option will apply to all labels in 
all layers and all scenarios.
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Figure 6: The Show/Hide Labels panel determines which objects will have visible labels for a given 
layer

The Show/Hide Labels panel can be used to toggle the visibility of labels for each pipe and junc-
tion within a layer. This allows a user to create a layer that shows only the relevant parameters 
for the relevant objects in the model. Visibility can be modified for one or several objects at a time 
via the same methods as pipe and junction visibility.

The Force Shown Labels to Match Shown Objects option forces the visibility of each label to 
match its object visibility as defined in the Pipes & Junctions group of the Layer Settings. The 
Defaults options at the bottom of the tables simply toggle this option on if it had been previously 
unselected.
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Layer Settings - Annotations

Figure 7: The Show/Hide Annotations panel shows all annotations that exist in the model file and 
allows their visibility to be controlled on a per-layer basis

The Show/Hide Annotations panel allows the visibility of annotations to be defined for the current 
layer and displays the visibility of each annotation in the current layer. While annotations exist 
globally, in concert with Layer Presets this menu allows annotations to be controlled so that they 
are only visible in the relevant scenarios. Annotations can be edited from this list view by double-
clicking them in the list to open the annotation in the Annotation Editor.

Color Maps

A Color Map layer allows you to visualize magnitudes of various parameters by coloring the 
pipes. Color Maps are a special layer type, and are shown in a separate group on the Layers 
panel. There can be only one special layer visible at a time, and they override the behavior of 
standard layers in the model - in this case superseding any colors assigned to pipes by other lay-
ers.

Example use cases for Color Maps includes visualizing hot/cold loops, locations of high velo-
city/reverse flows, or pipe diameters/lengths.

To create a Color Map layer, click the new layer icon on the Layers Toolbar, select a Color Map 
layer type, and name the new layer. To edit the layer, go to its Layer Settings menu, accessed in 
the same manner as a standard layer.
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Figure 8: Layer Settings window for a Color Map

In the Color Map Layer Settings window, choose a parameter and units for which all pipes will be 
categorized. Then choose the Number of Conditions (number of colors) and click Generate. The 
operators (i.e. >, >=, =, <=, <) and values can be modified. Values may be categorized on an 
absolute value basis by selecting the Use Absolute Value checkbox. The Show Value on Work-
space Label option shows the evaluated parameter next to each visible pipe in the model, and 
combines with any other label text items from other layers.

The order of entry is not important. Fathom will sort the entries first by value and then by the oper-
ator, with the greater than (>) operator being above the less than (<) operator. The pipes will be 
colored using the first match found in the map, starting from the top of the map. If no match is 
found, the pipe will be the Workspace pipe color. Be careful to avoid overlapping operators and 
values. If, for example, the map defined four colors using the following inequalities,

 l >=60
 l <60
 l >=20
 l <20

then there is no way colors 3 and 4 will be used because any pipe less than 20 is also less than 
60. Since <60 is before <20 in the map, the pipe will be colored using color 2. 

To avoid overlapping colors, only use less than (<) as the last entry. A better map would be the 
following:

 l >=60
 l >=20
 l <20

To delete a map value, select the row from the Color Map Grid and  click the Remove Row but-
ton. Instead of coloring the pipes, it is possible to color just the pipe numbers. This is done by 
choosing the Color Pipe Labels radio button in the Color Options area. Alternatively, the Color 
Pipes and Labels radio button allows both to be colored.
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Color choices from the Color Map Grid will appear in a legend without units shown by default. 
The legend may be repositioned by dragging it to any location on the Workspace. Units may be 
displayed in the legend using the Show Units in Legend setting within Global Layer Settings.

If there is no output for the current scenario, any Color Map layer that displays an output para-
meter will have a red exclamation mark next to it on the Layers panel to warn the user that there 
is no output. The model must run before such Color Map layers can be displayed.

Workspace Layers Import Assistant

The Workspace Layers Import Assistant can be used when importing a model from Fathom 12 or 
earlier. By default, when opening a model from these previous versions, layers are created as 
applicable for object numbers, workspace symbols, and object names. This is done regardless 
of whether or not the  Workspace Layers Import Assistant is run.

The purpose of the Workspace Layers Import Assistant is to import visual styles of pipes and 
junctions and to import labels from the deprecated Visual Report Window as Workspace Layers 
so that previous Visual Reports can be recreated. This is a step by step guided procedure that 
will attempt to bring these elements into Workspace Layers while creating as few new layers as 
possible. These layers are created on a per-scenario basis.

If a model has a high number of scenarios with similar Visual Reports, it may be preferable to 
recreate the Visual Report manually as a new layer that can be used with any scenario. If the 
chosen scenarios for the Import Assistant share many of the same visual settings, the Import 
Assistant will create all relevant layers for each, even if those layers are identical to each other.

The  Workspace Layers Import Assistant will allow you to select which scenarios to use to create 
the new layers. Once these are selected, the next page of the Import Assistant will allow you to 
see how many layers and Layer Presets will be generated. Once satisfied with the proposed 
Workspace Layers and Layer Presets, click Import Layers to complete the import process.

Related Topics

Workspace Window 388
Annotations 399
Merging Models 404
Renumbering Workspace Objects 403
Scale/Flip Workspace 405
Magnifier Tool 405
Extended Model Check 410
Keyboard Shortcuts for Workspace 408
Undefined Objects Window 407
Raw Data Changes 411
Duplicate Special 406

- 398 -



Interface and User Options

Annotations
Annotations are objects that can be placed on the Workspace to display customized text, 
express ideas via shapes or lines, or even to insert pictures into the Workspace. These are 
purely visual and do not affect results; their purpose is to communicate conceptual information 
about a system. They appear both in the Workspace and when printing from the Workspace.

New annotations are created using the Annotation Tool in the Toolbox. The Annotation Tool is 
located to the right of the Pipe Drawing Tool. With this tool, the user can draw a line or a shape 
on the Workspace. Shapes can display an image or text on the Workspace or can be used 
without text to display boundaries around various regions of the model.

Figure 1: After clicking the Annotation Tool, select the shape for the new annotation
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Properties
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Figure 2: Annotation view for the Properties in the Quick Access Panel

After an annotation is placed on the Workspace, the properties of the annotation will be dis-
played in the Properties tab of the Quick Access Panel where they can be edited. For existing 
annotations, it can be accessed quickly by double-clicking on the annotation in the Workspace. 
Annotation styles can be set as default or restored to default settings using the Defaults drop-
down menu in the upper right of the Annotation properties area.

 l Annotations - The name of the annotation, its text content, text style, and text visibility 
can be edited within the Annotations section. The name of the annotation is not displayed 
on the Workspace but is shown within the Layers Settings where it can be used to com-
municate the purpose of an annotation.

 l Behavior - The Behavior section allows the behavior of the annotation to be customized. 
Annotations can be attached to the Workspace, a pipe, or a junction. When attached to 
the Workspace, the annotation always remains in the same location until you move it. 
When attached to a pipe or junction, the annotation will move when the pipe or junction is 
moved.

Note: Whether an annotation appears behind or in front of another object is usually determ-
ined by the order of the Workspace Layers in which they are visible, but the toggle Work-
space Keep in Back forces the annotation to appear below pipes and junctions 
regardless of layer order.

 l Format - The Format section controls the shape as well as the shape's style and visibility.
 l Image - The Image section allows an image to be displayed within the annotation and con-

trols its appearance.
 l Line - The Line section controls the appearance of lines and only applies when the shape 

is set to be a line in the Format section. Similarly, the shape color and border properties 
from the Format section are not used for lines.

Interaction with Scenarios and Layers

Annotations are not scenario-specific and exist globally within a model. Their visibility is asso-
ciated with layers and can be controlled for each layer in the Layer Settings. While annotations 
exist globally, their visibility for a given scenario can be controlled using Layer Presets.

Related Topics

Workspace Window 388
Workspace Layers 389
Merging Models 404
Renumbering Workspace Objects 403
Scale/Flip Workspace 405
Magnifier Tool 405
Extended Model Check 410
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Keyboard Shortcuts for Workspace 408
Undefined Objects Window 407
Raw Data Changes 411
Duplicate Special 406

Renumbering Workspace Objects
Objects on the Workspace can be renumbered by choosing Renumber from the Edit menu. 
There are several ways that Renumbering can proceed.

Renumber Wizard

The Renumber Wizard allows you to renumber pipes and/or junctions by simply clicking on them 
on the Workspace. Normal Workspace functions are suspended when the Renumber Wizard is 
active. The Renumber Wizard is activated on the Edit menu.

When the Renumber Wizard is active the settings can be modified in the Quick Access Panel. 
Click Done Renumbering in the Quick Access Panel to finish renumbering and exit the wizard.

Renumber Automatic

Selected pipes and/or junctions can be renumbered starting at the lowest selected number or at 
a specified number. If a pipe or junction which is not selected to be renumbered already has the 
next number in sequence, it will only be changed if the Force Sequential checkbox is checked.

Fathom will start at the beginning of the flow path containing the lowest numbered selected pipe 
and will attempt to march down the pipes in the direction of flow. It is recommended that renum-
bering be performed after the model has been completed so that the junctions and pipes are 
completely connected.

Tip: If you want certain sections of the model to be numbered in sequence, then use the 
Renumber feature on the selected sections only. It is also preferable in the case of large 
or complicated models to renumber small sections at a time.             

Renumber Increment

Renumber Increment is on the Edit menu and allows you to increment or decrement all selected 
pipes and junctions by a specified value.

Related Topics

Workspace Window 388
Workspace Layers 389
Annotations 399
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Merging Models 404
Scale/Flip Workspace 405
Magnifier Tool 405
Extended Model Check 410
Keyboard Shortcuts for Workspace 408
Undefined Objects Window 407
Raw Data Changes 411
Duplicate Special 406

Merging Models
Two models can be merged together using the command on the File menu. Here's how:

 l Open the first model
 l Choose Merge on the File menu
 l From the file list, select the model to be merged

If there are duplicate numbers, the objects in the second model will be changed. The second 
model will be selected (highlighted) so that you can move it into position (be careful not to click 
off the selected portions or the second model may be deselected).

Note that annotations, layers, and layer presets are not imported from the second model.

Tip: To move a selected group of objects, use a junction icon, instead of a pipe, to drag the 
group. This will avoid missing the pipe and clicking on an empty area of the Workspace 
which will deselect your group.             

Merging Models with Multiple Scenarios

If the model you are merging from has multiple scenarios, only the base scenario can be 
merged. If you want to merge one of the children of that model, do the following:

 1. Open the model which you want to merge.
 2. Open the Scenario Manager.
 3. Select the child scenario you want to merge.
 4. On the Other Actions button, choose the Save Scenario to File Without Children.
 5. Enter a name and click OK. This process creates a new model with the desired scenario 

as the base scenario.
 6. Open the original model and merge in the new model file created in Step 5.

Related Topics

Workspace Window 388
Workspace Layers 389
Annotations 399
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Renumbering Workspace Objects 403
Scale/Flip Workspace 405
Magnifier Tool 405
Extended Model Check 410
Keyboard Shortcuts for Workspace 408
Undefined Objects Window 407
Raw Data Changes 411
Duplicate Special 406

Scale/Flip Workspace
The Workspace can be scaled horizontally and/or vertically by choosing Scale/Flip Workspace 
on the Arrange menu. Scaling will move the junctions and will stretch or shrink the pipes so that 
the area the model covers is changed by the percentage specified.

Flipping the Workspace horizontally and/or vertically will move the pipes and junctions to their 
mirror image locations. This is useful when you are building a system which has symmetrical or 
mirrored sections. For example, you could select the section, duplicate it, and then flip it hori-
zontally, vertically, or both with Scale/Flip Selected Objects Only checked.

Related Topics

Workspace Window 388
Workspace Layers 389
Annotations 399
Merging Models 404
Renumbering Workspace Objects 403
Magnifier Tool 405
Extended Model Check 410
Keyboard Shortcuts for Workspace 408
Undefined Objects Window 407
Raw Data Changes 411
Duplicate Special 406

Magnifier Tool
The Magnifier tool can be used to provide a magnified view of any area on the Workspace. This 
is useful for navigating and viewing details of a large model without needing to zoom in on that 
area. The Magnifier tool can be accessed from the Workspace Toolbar, as can be seen in Figure 
1 below. The magnifier tool can be enabled/disabled by clicking the button on the Toolbar.

There are several options available to adjust the Magnifier view:

 l Zoom Level - Adjusts the level of magnification used                     
 l Magnifier Size - Adjusts the size of the magnifier circle                     
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Figure 1: Magnifier tool on the Toolbar

Related Topics

Workspace Window 388
Workspace Layers 389
Annotations 399
Merging Models 404
Renumbering Workspace Objects 403
Scale/Flip Workspace 405
Extended Model Check 410
Keyboard Shortcuts for Workspace 408
Undefined Objects Window 407
Raw Data Changes 411
Duplicate Special 406

Related Blogs

AFT Fathom 11 New Features at a Glance

Duplicate Special
Duplicate Special allows the model to be copy & pasted, while simultaneously applying other 
helpful settings as explained below. Additional options will be available when the ANS module is 
activated.

 l Increment All Pipe and Junction Numbers By - Adds the specified number to all 
pipe/junction numbers for the created object duplicates. Useful for maintaining consistent 
numbering

 l Create Group - Adds the duplicates to a group.
 l Hide in Output - Automatically hides the pipe and junction duplicates in the Output win-

dow so only the original pipes and junctions will be seen.
 l Copy Layer Style Settings From Original Objects - Duplicates Workspace Layers 

style settings (visibility, thickness, color, label parameters, etc.) for selected objects.
 l Make Dependent Design Case - (ANS Only) - Sets the duplicate objects as a Depend-

ent Design Case of the duplicated model.
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 l Keep Common Size Groups - (ANS Only) - Only available if "Make Dependent Design 
Case" is checked. This adds the duplicate objects to the same Common Size Groups that 
the original objects were included in.

 l Clear Design Requirements - (ANS Only) - This clears all Design Requirements from 
the newly created objects.

 l Link GSC Variables in New Pipes/Jcts - (XTS Only) - Variables associated with duplic-
ated objects are duplicated and linked together within the Variables Panel.

 l Duplicate Goals - (XTS Only) - Goals associated with duplicated objects are duplicated.

Related Topics

Workspace Window 388
Workspace Layers 389
Annotations 399
Merging Models 404
Renumbering Workspace Objects 403
Scale/Flip Workspace 405
Magnifier Tool 405
Extended Model Check 410
Keyboard Shortcuts for Workspace 408
Undefined Objects Window 407
Raw Data Changes 411

Undefined Objects Window
This window is launched by clicking List Undefined Objects from the View menu.

This window displays all undefined pipes or junctions in the model. Clicking on the undefined 
object will display the undefined properties in the list below. All undefined data for all objects can 
be saved to the file or copied to the clipboard.

Any undefined object's Properties window can be launched by double-clicking the object's name 
in the list to finish defining the object.

Related Topics

Workspace Window 388
Workspace Layers 389
Annotations 399
Merging Models 404
Renumbering Workspace Objects 403
Scale/Flip Workspace 405
Magnifier Tool 405
Extended Model Check 410
Keyboard Shortcuts for Workspace 408
Raw Data Changes 411
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Duplicate Special 406

Keyboard Shortcuts for Workspace

Selection Box

 l Select all objects completely inside box by dragging cursor from left to right
 l Select all object completely or partially inside box by dragging cursor from right to left

Pipe Drawing Tool 

 l If you double-click the pipe drawing tool, it will allow you to draw multiple pipes at a time. 
Clicking Esc or clicking the pipe drawing tool again will deactivate the tool.

 l When orthogonal drawing is off and you hold down the SHIFT key while drawing pipes on 
the Workspace, you can draw pipes that are perfectly horizontal or vertical. When the 
orthogonal drawing is on and you hold down the SHIFT key down while drawing new 
pipes on the Workspace the pipe vertex will flip. If you move an existing pipe and hold the 
shift key while selecting a handle at one of the pipe endpoints a new vertex will be inser-
ted at that point endpoint.

 l If you hold down the CTRL key when completing the pipe drawing (just before releasing 
the mouse button), the Pipe Drawing Tool remains active, and you can draw a series of 
pipes without returning to the Toolbox each time.

 l To add pipe segments, use CTRL+SHIFT+Y 
 l To remove all pipe segments, use CTRL+SHIFT+N

Junctions

 l If you double-click any junction in the Toolbox, you will be able to place multiple of that 
junction on the Workspace by clicking the Workspace where you would like to place each 
junction. Clicking Esc or clicking the junction icon in the Toolbox again will deactivate the 
tool.

 l If you hold down CTRL key and select a junction from the Toolbox and drop it onto an 
existing Workspace junction, the old junction will "morph" into the new one. The junction 
type will change to the new junction type, and data that can be kept will be copied into the 
new junction.

 l If you hold down the CTRL key then drag a junction on the Workspace which has pipes 
connected to it, the junction will move but the pipes will not move with it

 l If you hold down the SHIFT key while selecting a junction from the Toolbox and then drop 
the junction onto an existing pipe, the pipe will split into two pipes. You will specify the 
length of the first pipe and the second pipe will be automatically set to the remaining 
length from the original pipe. Thus the sum of the two pipe lengths will equal the length of 
the original pipe. You can also choose which pipe contains any Fittings & Losses that 
were specified within the original pipe.
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Figure 1: Split pipe keyboard shortcut

Pipe and Junction Properties Window

 l When in a pipe or junction Properties Window you can toggle the highlight feature by 
pressing the F2 function key. You can also toggle this from the View menu.

 l When in a Pipe Properties window, if you press the F5 function key, you will jump to the 
next highest numbered pipe. If you press the CTRL key while pressing the F5 function 
key, you will jump to the next lowest numbered pipe. The F5 function key also behaves 
this way for junction Properties Windows.

Pan and Zoom

 l The Workspace position can be moved with CTRL + arrow keys.
 l The Zoom level can be adjusted with CTRL + (+/-)
 l The Zoom level can be reset to default with CTRL + 0
 l Mouses with scroll wheels can be used to zoom by scrolling, or to pan by clicking and hold-

ing the scroll wheel

Switching Primary Windows

 l Go to the Workspace window using CTRL + W
 l Go to the Model Data window using CTRL + M
 l Go to the Output window using CTRL + U
 l Go to the Graph Results window using CTRL + G
 l When ANS is active, go to the Sizing window using CTRL + N
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Other

 l Open the Keyboard Shortcuts Help Page (this page!): CTRL + Q
 l Run the model: CTRL + R
 l Save the model: CTRL + S
 l Open a file: CTRL + O
 l Undo the last action: CTRL + Z
 l Redo the last action: CTRL + Y
 l Cut: CTRL + X
 l Copy: CTRL + C
 l Paste: CTRL + V
 l Duplicate: CTRL + D
 l Delete selected pipes and junctions: DEL
 l Reverse pipe direction: F3
 l Lock Object: CTRL + L
 l Toggle special condition of pipes/junctions between open and closed: F4
 l Show object status: CTRL + H
 l Other available shortcuts can be seen listed by their command on the menus

Related Topics

Toolbox 193
Creating Pipes - the Pipe Drawing Tool 196
Creating Junctions 201
Workspace Window 388
Workspace Layers 389
Annotations 399
Merging Models 404
Renumbering Workspace Objects 403
Scale/Flip Workspace 405
Magnifier Tool 405
Extended Model Check 410
Undefined Objects Window 407
Raw Data Changes 411
Duplicate Special 406

Extended Model Check
The connections and settings of each pipe and junction are exhaustively checked using the 
Extended Model Check item on the View menu. This is also helpful if the model seems to not be 
connected correctly.
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Related Topics

Workspace Window 388
Workspace Layers 389
Annotations 399
Merging Models 404
Renumbering Workspace Objects 403
Scale/Flip Workspace 405
Magnifier Tool 405
Keyboard Shortcuts for Workspace 408
Undefined Objects Window 407
Raw Data Changes 411
Duplicate Special 406

Raw Data Changes
When other objects in the model use the same base raw data as the current object and the data 
is changed, you can decide whether to use the new data on the other model objects.

This frequently happens when you have multiple junctions based on the same x-y data for pump 
curves or junctions resistance curves, and later change that x-y data. The question is whether 
you want to have the current junction you are working on updated, or all junctions that use that 
same base data.

Figure 1: Raw Data Change Options             

Related Topics

Workspace Window 388
Workspace Layers 389
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Annotations 399
Merging Models 404
Renumbering Workspace Objects 403
Scale/Flip Workspace 405
Magnifier Tool 405
Extended Model Check 410
Keyboard Shortcuts for Workspace 408
Undefined Objects Window 407
Duplicate Special 406

Model Data Window
The Model Data window offers a text-based perspective on all engineering information in the 
pipe flow model. This window is immensely useful for obtaining a global view of the model and 
rapidly checking the input. 

The Model Data window does not offer any tools to build or add to a model; all model assembly 
must happen in the Workspace. 

The Model Data window allows you to manipulate existing elements from the Workspace. There-
fore, a complete model can be assembled in the Workspace window without ever opening the 
Model Data window. In fact, for small models this may be the preferred approach.

General, Pipe, and Junction section display sizes can be changed by the user by clicking and 
dragging the bars between each section to resize them. Each section can also be hidden by click-
ing the arrow in the upper left of each section.

You can use the zoom feature in the lower right hand corner of the Model Data window to resize 
the text displayed on screen.

Figure 1: The Model Data window displays input in text form
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Editing Features

The Pipe table allows display of all input data for all pipes in the model. Details of Fittings & 
Losses are displayed in the Pipe Loss Data table, accessed with an adjacent tab. The Pipe Loss 
Data table displays all fittings with K factors grouped into columns.

The other display tab in the pipe area is the Pipe Detail Summary, which assembles a list of 
details about each pipe in another format useful to some engineers.

The junction data area is below the pipe data area. Here the junction data is separated into 
tables for each junction type. Click the tabs to see the data for any type of junction.

To edit information in the Model Data window, you can open the Properties Window for the pipe 
or junction. This can be done by double-clicking anywhere in the row for the pipe or junction to be 
edited. Alternatively, you can use the Global Edit windows opened from the Edit menu. 

 l XTS Module tables - When using the XTS Module, a Transient Data table in the Junc-
tion area displays all transient data entered for junctions. If there is no transient data, the 
table will not be displayed.

 l GSC Module tables - When using the GSC Module, if GSC data has been entered in 
the Goal Seek and Control Group in Analysis Setup, the variable and goal data will be dis-
played in the General section in a "Goal Seek & Control" table.

Display and Printing Features

Model Data Control lets you specify the combination of pipe, junction, and general information 
you want to see in the Model Data Window.

The Model Data Print Content window lets you specify the content to include in the printed Model 
Data report and select the font to be used for printing. This window is opened from the Tools 
menu (or Toolbar).

The Model Data window contents can be:

 l Copied to the clipboard
 l Saved to a formatted text file
 l Exported to a delimited file suitable for direct importing into spreadsheet software
 l Saved directly to an Adobe PDF file
 l Sent to the printer

Related Topics

Interface and User Options 361
Menus and Toolbars 361
Model Data Control 414
Bill of Materials 416
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Related Blogs

Having model convergence problems? Start here!

Model Data Control
The Model Data Control allows you to customize what data to show for the pipes and for each 
junction type and also which pipes and junctions to show (see Figure 1). It can be opened from 
the Tools menu (or Toolbar).

Pipe Data Display

The data to be shown for the pipes is selected on the left side of the Model Data Control window. 
Only the items with check marks will be shown in the Model Data window. All pipes shown will 
report the selected items.

Junction Data Display

The data to be shown for the junctions is selected on the right side of the Model Data Control win-
dow. The data is grouped by junction type. However, some data is general and applied to each of 
the junction types. Select the junction type from the list and then select the data for that junction 
type. Each type also includes the general data which may be selected/deselected.  

You can select/deselect the general data for all junction types simultaneously by clicking Set 
Common.
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Figure 1: The Model Data Control window allows selection of the parameters to show in the Model 

Data window

Model Data Format

The Model Data Control format can be saved to a file so that the format can be quickly applied to 
other model files. There are multiple ways to do this. The Model Data Control format can be 
saved to the internal user library by clicking the Set As Default button, then choosing User 
Default in a new model file to apply the settings.

The Model Data format can also be saved to an external file, which can then be shared with dif-
ferent users. The external file can be generated by clicking the Save Control Format button at the 
bottom of the window. The format can then be applied to other model files by clicking the Load 
Control Format button.

Show Selected Pipes and Junctions

Specific pipes and junctions can be shown in Model Data. Click the Show Selected Pipes/Jct tab, 
then click the items in the lists to select the pipe(s) and junction(s) to be shown.
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Other Data

When pipes with intermediate elevations are specified, you can specify which pipe data is to be 
displayed in the Model Data window:

 l Show only pipes with intermediate elevations
 l Show only non-horizontal pipes
 l Show all pipes

In addition, you can specify whether to show Pipe Elevation Data, whether junction curve data is 
to be displayed with the Model Data, whether to display Design Alerts, and whether to include a 
Bill of Materials.

Scenario Format

A powerful Model Data feature when using scenarios is to show all direct ancestor data in the 
Model Data along with data from the current scenario. The Scenario Format features allow you 
to do this, and to highlight where data changes occur. Note that the scenario name is appended 
to the pipe and junction number in the left columns. This tab only appears when multiple scen-
arios exist.

Library Connections

In the lower left of the Model Data Control window there is a Library checkbox. If this box is 
checked, your Model Data Control parameters are setup as determined by the library to which 
you are connected. This is referred to as an active library. To make it inactive, uncheck the box 
or change one of the Model Data Control settings controlled by the library.

If the check box is unchecked, but enabled, you are connected to a library but the settings are 
not being passed to the Model Data Control window. The library is thus inactive. To make it act-
ive, check the box then click the OK button.

If the check box is disabled, there is no connected library.

Related Topics

Model Data Window 412
Bill of Materials 416

Bill of Materials
A bill of materials is a summary of all materials, components, and fittings that have been spe-
cified for a project.
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A bill of materials can be added to the Model Data Summary section by opening Model Data Con-
trol, and checking "Include Bill of Materials" on the Other tab.

Figure 1: Include Bill of Materials

Related Topics

Model Data Window 412
Model Data Control 414

Output Window
The Output window is the primary vehicle for communicating the results of an analysis in text 
form (see Figure 1). The Output window follows the same general window organization as the 
Model Data window.

When a model is submitted to the Solver (the part of AFT Fathom that applies the governing 
incompressible flow equations to obtain a solution to the pipe system), the Solution Progress win-
dow appears. After the solution is obtained, you can view the results in the Output window by 
clicking the View Output button.             

If the information in the Output window is not in the desired format, you can choose Output Con-
trol from the Tools menu (or Toolbar) to modify the format. Output Control lets you specify the 
parameters, their units, and the order of their display in the Output window.

The Output Print Content window available on the Tools menu (or Toolbar) lets you specify the 
content to include in the printed Output report and select the font to be used. 

- 417 -



Interface and User Options

The Sort window opened from the Arrange menu (or Toolbar) offers the ability to sort the Pipe 
Results or Junction Results tables according to the values in any of the columns. 

The Transfer Results to Initial Guesses feature on the Edit menu (and Toolbar) sets all pipe and 
junction initial flows and pressures equal to the converged results, which causes future runs to 
converge much faster.

You can view the input data for individual pipes or junctions directly from the Output window. To 
do this double-click the pipe or junction row, which will open the properties window in read-only 
form where you can review input in detail.

General, Pipe, and Junction section display sizes can be changed by the user by clicking and 
dragging the bars between each section to resize them. Each section can also be hidden by click-
ing the arrow in the upper left of each section.

You can use the zoom feature in the lower right hand corner of the Output window to resize the 
text displayed on screen.

Figure 1: The Output Window

Right-click Context Menu Actions

There are several options available when right-clicking on a cell, row header, column header, or 
entire table in the Output window:
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 l Column Header
 l Change Units -  Quickly redisplay the selected column in a different unit.
 l Sort - Sort the table in Ascending or Descending order on the selected column.
 l Add "Parameter" for all Table Objects to Excel Export Manager - Add this 

column to the Excel Export Manager.
 l Open Excel Export Manager - Directly open the Excel Export Manager.
 l Copy Selected Cell Data - Copies all of the values in the column to the clipboard.

 l Row Header
 l Add all Object Parameters to Excel Export Manager - Add this row to the Excel 

Export Manager.
 l Open Excel Export Manager - Directly open the Excel Export Manager.
 l Find on Workspace -Quickly locate an object on the Workspace.
 l Copy Selected Cell Data - Copies all of the values in the row to the clipboard.
 l Open Properties Window - Opens the properties window for the associated pipe 

or junction.
 l Table (upper left cell)

 l Add Object Table to Excel Export Manager - Add the entire table to the Excel 
Export Manager.

 l Open Excel Export Manager - Directly open the Excel Export Manager.
 l Copy Selected Cell Data - Copies all of the values in the table to the clipboard.

 l Cell
 l Add Object "Parameter" to Excel Export Manager - Add this cell to the Excel 

Export Manager.
 l Open Excel Export Manager - Directly open the Excel Export Manager.
 l Create Design Alert -Create a Design Alert related to the selected object and 

value.
 l Copy Selected Cell Data - Copies the value of the cell to the clipboard.

Output Window Updates

Whenever you change the input model, all output windows are erased. This prevents you from 
changing your input model, forgetting to rerun it, and mistaking the previous Output window for 
the current model's results.

Results Diagrams

Results diagrams are available for both pump results (see Figure 2) and pipe heat transfer res-
ults (see Figure 3). These diagrams allow you display the information in a more intuitive manner, 
copy the image of the diagram to your clipboard, or print the diagram. The option to show the res-
ults diagram can be found in the pump summary tab for pumps or the heat transfer tab for pipes 
with heat transfer.

- 419 -



Interface and User Options

Figure 2: Pump Results Diagrams
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Figure 3: Pipe Heat Transfer Results Diagram

Printing and Exporting

Data in the Output window can be:

 l Copied to the clipboard
 l Saved to a formatted text file
 l Exported to an Excel spreadsheet
 l Saved directly to an Adobe PDF file
 l Sent to the printer (see the Printing topic)

The printed and Adobe PDF output follows the same format as the Output window itself.

Related Topics

Interface and User Options 361
Menus and Toolbars 361
Output Control 422
Output Parameters 428
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Applied Standards 430
Use the Output Window Sort Feature 805
Exporting To Excel 481
XTS in Output 614
GSC in Output 552
Cost Report 544
SSL in Output 580
Output Messages & Warnings 779

Output Control
The Output Control window (see Figure 1) allows you to customize the parameters shown on the 
Output window. The control features are grouped on numerous tabs.

Figure 1: The Output Control window selects parameters for the Output window. Here the Pipe para-
meters are shown. The Junction and other parameters function the same.

Display Parameters

The Display Parameters tab controls the parameters to be shown for the pipes, junctions and 
summary reports. The output type is selected from the group of buttons at the top. For each out-
put type, the list on the left side shows all available parameters for the selected report. For the 
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pipe and junction output, this list can be viewed in alphabetized or categorized mode, which 
makes it easier to find a parameter.

Choose a parameter to be shown by selecting it on the left-hand list and clicking the Add button, 
or double-clicking the parameter name. The selected item will appear in the list on the right either 
at the bottom or at the previously selected location. The list on the right shows the order of the 
parameters to be displayed in the output and the units (if any) in which to display the results.

You can change the order of the output by selecting a parameter on the right-hand list, then click-
ing the Reorder scroll bar on the far right or by clicking and dragging the row using the handle on 
the left. The list will be reordered accordingly. The output is presented from left to right in the 
order defined in this list.

The units used for a parameter can be changed by selecting the parameter then choosing the 
desired units from the adjacent dropdown list. By selecting the units of interest, you can obtain 
your results in whatever units you find most convenient and meaningful. This means that you can 
enter all your input parameters in one set of units (or a variety of units, for that matter), and have 
all your output parameters in a completely different set of units. 

To set selected units for both pipes, junctions and summary reports to the preferred units (set in 
the User Options window), click the Use Preferred Units button. If you change the units of a para-
meter and you would like that unit to be used for all similar parameters in the list or entire output, 
select the Same Units button.

You will note that some output parameters do not offer the ability to specify output units. These 
parameters either do not have units associated with them (such as Reynolds Number or friction 
factor), or are input parameters from a library (such as Pipe Nominal Size). 

Several Special Summary Reports can be displayed in the Output window. These include the fol-
lowing:

 l Pump Summary
 l Valve Summary
 l Heat Exchanger Summary
 l Reservoir Summary
 l Pipe Heat Transfer Output
 l Cost Report

In addition, if you are using the XTS module there will be transient output reports available for 
pipes, junctions and many of the summary reports. If you are using the SSL module, there will 
be a slurry report available and transient slurry report if XTS is also active. If the ANS module is 
active the Pipe Sizing tab will be available, as well as Design Requirements and Library tabs for 
each pipe/junction which has design requirements or libraries assigned to them.

General

The General Section is the text area located at the top of the Output window. The project title, ref-
erence information and solution balance display are controlled here. 

You can enter a descriptive Analysis Title which will be used in the Model Data, Output and Work-
space windows. A title is required and can have up to 100 characters.
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You can keep a lengthy explanation or any other documentation about your model in the Refer-
ence Information section. Names of projects, individuals, and assumptions can all be kept with 
the model. This information can then be included in your reports to improve tracking.

There is an option "Show Solution Balance Summary" that is defaulted to off. This option toggles 
the display of a general output tab showing the total flow entering and exiting each junction, as 
well as the sum of those flows. This can be helpful in verifying the results as well as in some 
troubleshooting cases.

Format & Action

The results can be automatically sent to the printer or saved to a file when the model has 
reached convergence. Additionally, the results can be automatically saved as initial conditions 
when the model is run. By saving the results as initial guesses, the iteration time for AFT Fathom 
to arrive at a converged solution is reduced. The initial guess can also be transferred manually 
by selecting Transfer Results to Initial Guesses on the Edit menu or Toolbar. The model can also 
be automatically saved after the initial conditions are transferred. The valve state (open, closed 
or failed) can also be saved along with the initial conditions.

When enabled, the Wrap Table Column headers option makes the output tables wrap the 
column headers an extra line if the header is wider than usual.

There are four formatting methods for the pipe and junction output data:

 l Always Align Decimal Point on Output - allows magnitude of the data to be easily com-
pared as the data is read down the column. However, a number whose magnitude is 
small may force larger numbers to show many digits. For example, assume that the min-
imum number of digits is set to four, and there are two output values: 1234.5 and .09876. 
These two values will be displayed in the output as:

 l 1234.50000
 l      0.09876

 l Show Only Number of Digits (not aligned) - forces the data to use exactly the number 
of digits specified, which may result in the decimal point location changing from value to 
value. Using this method with the above example and four digits, the output will be dis-
played as:

 l         1235  
 l 9.876E-02

 l Align Only When Max/Min < Limit- aligns the data on the decimal point only if the max-
imum value in the column divided by the minimum value is less than a limiting order of 
magnitude that you set. If this ratio is greater than the limit, then each value in the column 
will be exactly the number of digits specified. Using the above example with a limit set to 4 
then 1234.5/.09876 = 12500 or an order of magnitude of 5. This is greater than the limit. 
The entire column will not be aligned and will be displayed as:

 l         1235
 l 9.876E-02

 l Use Exponential When Max/Min > Limit - similar to the above method except that if the 
ratio is greater than the limit then the entire column will be shown in exponential format. 
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Using the above example, the column would be shown as
 l 1.235E+03
 l 9.876E-02

These formatting options are for the entire Output window; however, the last two are calculated 
and applied on a column basis. In other words, if you choose the third option one column may be 
aligned but another may not be. 

The output can be forced to always display in exponential notation by choosing the checkbox.

Options to adjust the colors for the headers and design alert highlighting are also available.

Cost Report Formatting

The Cost Report monetary numerical format can be specified.

Time Simulation Formatting

(XTS Module only) XTS output can be displayed in different units of time. In addition, when run-
ning transients over hours or days there are formats which display time in formats such as dd:h-
h:mm:ss.

Show Pipes/Jcts

You can choose which pipes and junctions are to be displayed in the Output window. Clicking a 
selected item in the list on the Show Pipes/Jcts tab will deselect it. Clicking a deselected item will 
select it. This feature is especially useful when you are interested only in a certain area of the 
model.

You can quickly define the output you want by doing the following:

 1. Select the pipes and junctions on the Workspace
 2. Open the Output Control window and select the Show Pipes/Jcts tab
 3. Click the Workspace button for both the pipes and junctions
 4. Click the Show button

Junction Deltas

You can have AFT Fathom calculate the difference between two junctions for a particular para-
meter. These results are displayed in the General Section. A list of Junction Deltas is created by 
selecting the upstream and downstream junctions, the parameter and units of interest, then 
adding it to the list by clicking the Add >> button. Some parameters will require that either the 
inlet or outlet value for the junction be specified. The list will contain the parameter symbol and 
the two junction numbers with "in" or "out" in parentheses. Different parameters can be used for 
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each item in the list so you can, for example, choose pressure difference between junctions 2 
and 10 and also temperature difference between junctions 45 and 16.

Multi-Scenario

You can view output from multiple scenarios concurrently in the Output window. To do this, 
select the Multi-Scenario tab. This tab is only visible when at least one child scenario exists. 
From this tab, choose which scenarios you would like to view concurrently by clicking on the 
Select Scenarios button located at the top left of the Multi-Scenario tab. The color of each scen-
ario is automatically generated and can be regenerated by selecting "Reset All Colors". You can 
manually select the background color for the Output data of a given scenario by clicking on the ... 
button located in the row corresponding to the scenario. 

You can also order the scenarios to appear in the Output window according to your preferences. 
To do this, arrange the scenarios in the order you would like them to appear by using the tur-
quoise arrows at the bottom left corner of the Scenario Order and Colors box. Then, select how 
you would like the current scenario to be displayed by clicking the appropriate choice under the 
Display Current Scenario section. Figure 3 shows the Output window with multiple scenarios dis-
played.

Figure 2: Output Control window selections for multi-scenario output
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Figure 3: Output window with multiple scenarios displayed

Library Connections

In the lower left of the Output Control window there is a Library checkbox. If this box is checked, 
your Output Control parameters are setup as determined by the library to which you are con-
nected. This is referred to as an active library. To make it inactive, uncheck the box or change 
one of the Output Control settings controlled by the library.

If the check box is unchecked, but enabled, you are connected to a library but the settings are 
not being passed to the Output Control window. The library is thus inactive. To make it active, 
check the box then click the OK button.

If the check box is disabled, there is no connected library.

Command Buttons

There are eight buttons at the bottom of the Output Control window. Fathom has built-in default 
parameters, units and settings which you can choose by clicking the Fathom Default button. You 
can also develop your own settings, tailored to your project or industry, and have these used by 
default (instead of Fathom’s defaults). To make your own default, first select the output para-
meters, units and settings you would like to use then click the Set As Default button. Your set-
tings will be saved and will be used each time any new project is initiated. If you make changes to 
the settings, and want to get back to your defaults, click the User Default button. The saved set-
tings are updated only when you click Set As Default.

You can save the output settings (except for the selected pipes/junctions and junction deltas) to 
a file by pressing the Save Control Format button and entering a file name. These settings are 
loaded again by pressing the Load Control Format button and choosing the file name. For 
example, you may have a final report format that is always desired. You can load this format 
before generating final results. If you have another format you use for reviewing model accuracy, 
you may want a larger number of parameters in the output.
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The format files you create can be placed on a network for sharing among a group or company, 
or incorporated into a company-wide library, allowing standardized reporting.

If you have made changes you don’t want to keep, click the Cancel button. Click OK to use the 
setting you have specified.

Related Topics

Output Window 417
Output Parameters 428
Applied Standards 430
Use the Output Window Sort Feature 805
Note: No scenarios have been set in the Multi-Scenario Output display 792

Related Blogs

Quick Guide to Custom Output

Back to the Basics: Calculating and Defining Head

AFT Responds to 2020 Customer Survey Feedback

Learn About the Acceleration Head and How To Model It

Output Parameters
A variety of parameters are available to display in the Output window depending on the junctions 
and loss models used in the model.

A description of each parameter may be seen by double-clicking the header in the Output Win-
dow table, and is also displayed below the Output Parameters table when that parameter is 
selected in the Output Control window (Figure 1).

Additional information can be found below for some of the output parameters.

Figure 1: A description is provided at the bottom of Output Control for the selected parameter

Mass Flow Rate Net At Junction

Displays the total mass flow rate exiting the system through the junction, which is useful to dis-
play the flow exiting through junctions such as a spray discharge. In other words, the Mass Flow 
Rate Net At Junction is equal to the flow rate into the junction from the pipes minus the flow rate 
out of the junction into the pipes.
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Mass Flow Rate Through Junction

Displays the total mass flow rate through the junction for junctions connected to only two pipes. If 
the junction is connected to more than two pipes this parameter will be displayed as N/A. When 
more than two pipes are connected the user should refer to the output for the pipes connected to 
the junction in order to view the flow rate through the pipes. The user can add the "Mass Flow 
Rate Net At Junction" to view flow exiting the system rather than flowing out of the junction into a 
pipe.

Pressure Loss Static Friction Component

Static pressure drop due to the Fittings & Losses entered in the Pipe Properties window. 
Excludes pressure drop due to pipe wall friction.

Pressure Loss Static Friction Total

Static pressure drop due to friction from the wall and the Fittings & Losses entered in the pipe. 
This value will be equivalent to the stagnation pressure drop due to friction because the velocity 
along the pipe is constant.

Pressure Loss Static Friction Wall

Static pressure drop due to friction from the wall. Excludes static pressure drop due to friction 
from Fittings & Losses in the pipe. This value will be equivalent to the stagnation pressure drop 
due to wall friction because the velocity along the pipe is constant.

Volumetric Flow Rate Net At Junction

Displays the total volumetric flow rate exiting the system through the junction, which is useful to 
display the flow exiting through junctions such as a spray discharge. In other words, the Volu-
metric Flow Rate Net At Junction is equal to the flow rate into the junction from the pipes minus 
the flow rate out of the junction into the pipes.

Volumetric Flow Rate Through Junction

Displays the total volumetric flow rate through the junction for junctions connected to only two 
pipes. If the junction is connected to more than two pipes this parameter will be displayed as N/A. 
When more than two pipes are connected the user should refer to the output for the pipes con-
nected to the junction in order to view the flow rate through the pipes. The user can add the "Volu-
metric Flow Rate Net At Junction" to view flow exiting the system rather than flowing out of the 
junction into a pipe.
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Related Topics

Output Window 417
Output Control 422
Applied Standards 430
Use the Output Window Sort Feature 805

Applied Standards
When an applicable standard is used in a calculation, an additional tab appears in the general 
area of the Output Window. This tab indicates what standard(s) were used for what calculations 
in the model.

Figure 1: Applied Standards when Pump Viscosity Corrections are used in a model

Related Topics

Output Window 417
Output Control 422
Output Parameters 428
Use the Output Window Sort Feature 805

Graph Results Window
The Graph Results window, shown in Figure 1, allows you to generate high quality printed 
graphs.

The Graphing Panel offers several types of standard graphs for pump vs. system, profile, tran-
sient (XTS Module Only), and slurry system (SSL Module Only) information. Users can also con-
trol graph content, plotting information for multiple parameters, pipes, paths, or scenarios 
simultaneously.             

Results can be graphed as linear or log versus linear. 
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Figure 1: The Graph Results window offers full-featured plot generation

Graph List Manager

Allows the user to create, update, and even replace unique graphs that can be regenerated with 
new data. Multiple graphs can be displayed at the same time and organized into separate 
Folders. The default folder is named “My Graphs” and more folders can be created using the 
“New Folder…” icon on the Graph List Manager Toolbar or by right clicking on “My Graphs” and 
selecting “New Folder…”

Once a folder is created and selected, a Graph can be added to its list by selecting the “Add 
Graph to List” icon found on the Graph Results Toolbar. This can also be done by right-clicking 
anywhere on the graph. Once Graphs are in a Folder individual Graphs can be generated in 
unique tabs or each Graph in a Folder can be displayed in a single tab by right clicking on the 
Folder and selecting “Load Current Folder Graphs in New Tabs” or “Load Current Folder Graphs 
in Same Tabs”. These options are available in the Graph List Manager toolbar as well. Other 
options that can be found by right clicking on a Folder or Graph in the Graph List Manager or on 
the toolbar are:

 l Load Graph Item in Current Tab – Regenerates the graph in the currently active tab.
 l Load Graph Item in New Tab – Creates a new tab and regenerates the graph there.
 l Load Folder items - Regenerates all the Graphs in a Folder in separate tabs, in the 

same tab side by side, or in the same tab as stacked graphs, depending on the selection.
 l Keep Folder Display Layout - Saves the current layout when multiple graphs are 

loaded on the same tab.
 l Reset Folder Display Layout - Resets the Graph List Folder to the default layout when 

multiple graphs are loaded on the same tab.
 l Close Open Folder Items - Closes any graphs that were opened from the current folder.
 l Delete Folder Items - Deletes all graphs in the current folder.
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 l Print Preview All Graphs in Folder - Displays a print preview of all items in the current 
folder.

 l Move Graph Item Up – Moves the selected Item up one level. 
 l Move Graph Item Down - Moves the selected Item down one level. 
 l Rename Graph Item - Changes the name of the Item.
 l Duplicate Graph Item – Creates a copy of the selected Item with a new name.
 l New Folder – Creates a new Folder where more Graphs can be saved to.
 l Delete Graph Item – Removes Item from the Graph List Manager.
 l Move Graph Item To Folder – Moves the selected Item to a previously existing Folder or 

a new Folder.

Graph Results Toolbar

The Graph Results Toolbar also has many options that are available right clicking on the Graph 
Results space at any point. These options are:

 l Select Graph Parameters – Select the type of Graph to create and its parameters.
 l Add Graph To List – Saves the Graph to the currently active list allowing it to be regen-

erated in the future.
 l Update Current Graph In List – Saves any changes to the current graph that have been 

made. (e.g. Changing the Graph Title or Line Style). Note that it is preferred to use the 
Replace Graph in List option if changes to the parameters or objects/paths being shown 
have been made. 

 l Replace Graph In List – Replaces the graph highlighted in the Graph List with the cur-
rent graph that is shown. 

 l Copy Graph Image – Copies a .jpeg of the Graph to the clipboard
 l Copy X-Y Data – Copies the X-Y data used by the Graph to the clipboard
 l Show Data – Displays the X-Y data used to generate the graph in a column to the right of 

the graph
 l Right-clicking on the x-y data set provides further options to find the maximum or 

minimum in the data set, create an annotation on the graph for a data point, or to 
copy an individual data point

 l Create Annotation – Add an annotation to the graph that can be formatted and saved to 
be reloaded with the Graph in the future.

 l Show Legend – Toggles the legend off and on.
 l Show Check Boxes in Legend – Adds a check box in the legend that allows the user to 

selectively turn off and on certain curves in a Graph without having to recreate a new 
Graph.

 l Show Cross Hair – Displays and cross hair that shows the cursors X-Y values along the 
X and Y axis. This also displays the nearest data point X-Y values in a tooltip. If this fea-
ture is used at the same time as "Show Data" the Cross Hair will focus on that highlighted 
data point and display its values in a tooltip. The user can also change what data point is 
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highlighted with the arrow keys and the Cross Hair and tooltip will move to that datapoint.
 l Show Range Finder – Adds a toolbar at the bottom of the graph that displays the entire X 

axis, but allows the user to zoom in to a specific range by clicking and dragging the 
handles on either side of the range finder.

 l Show Junction Locations – Add a vertical line with the number of the junction labeled at 
the location of the junction along the flow length.

 l Manage Junction Locations - Allows the user to show/hide the labels for each junction 
on the profile graph when Show Junction Labels is enabled.

 l Zoom to 100% - Resets the focus of the graph to 100%
 l Format – Allows the user to change the Graph’s format. Including

 l Header, Axis, and Legend names and fonts.
 l X and Y scaling
 l Line color and thickness

Graph Outline Colors

The active graph will always have an outline which indicates what state it is in.

 l Orange – Graph not added to list
 l Dark Green – Graph added to list
 l Light Green – Graph added to list, but changes have occurred. These can be saved and 

make the graph dark green by selecting “Update Current Graph in List” on the toolbar. 

Graph Tab Icons

Each Graph Type has a specific color associated with it. This color will display in the box on the 
tab for the Graph. The colors are below:

 l Green – Pump vs. System                     
 l Profile – Purple                     
 l Transient – Light Blue                     
 l Slurry System Curve – Pink                     
 l Blank Graph – Gray                     

These tabs also display if the Graph in the tab is not saved or has been changed from the original 
Graph List item by showing a small yellow square over the tab's icon. If the current graph has 
been saved, there will be no yellow square.
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Graph Tab Actions

New Tab – Creates a blank tab in which a new type of Graph can be generate and added to the 
Graph List Manager

 l Tab Actions
 l Close Active Tab
 l Close All Tabs
 l Close All But The Active Tab
 l Two Vertical Tab Groups
 l Two Horizontal Tab Groups
 l Reset to Single Tab Group
 l Tabs on…. – Selects the location of tabs (defaults to the bottom of the Graph)

 l Graph Tab Selection – Selects which Graph tab will be active (shown) based on the 
Graph Name. The user can also switch tabs by clicking on the desired tab.

Profile Cross-Plotting Features

The graphical data can be exported to a file for later import as a cross plot against results for a dif-
ferent model. For example, let's say you would like to see the effect on the system pipe pressure 
drop when you change a valve loss factor. You could run the Solver for one value of K and export 
the results to a file. Then you could rerun the Solver for a new value of K and import the results 
from the previous case for cross plotting. These features are accessed using the Save Graph 
Data and Import Graph Data command buttons on the Graph Results File window.

The Graph Results window is always erased when you make changes to model input. Rerun the 
model to graph the new results.

Multiple paths in the same scenario can also be plotted against each other by adding each path 
to a group, then choosing the "Plot Multiple Paths Using Groups" option as shown in Figure 3.
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Figure 2: The Select Graph Parameters window controls the Graph Results window

 
Figure 3: Multiple paths can be cross-plotted using predefined groups
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Printing and Exporting

The Graph Results image can be:

 l Copied to the clipboard
 l Saved to a picture file
 l Saved directly to an Adobe PDF file
 l Sent to the printer

The x-y data in the Graph Results graph can be:

 l Copied to the clipboard
 l Exported directly to Excel using the Excel Export Manager
 l Exported to a delimited file suitable for direct importing into spreadsheet software

Related Topics

Interface and User Options 361
Menus and Toolbars 361
Quick Graph Formatting Window 436
Graph Types 437
Pump vs. System Curve Methods 440
Multi-Scenario Pump vs. System Curves Tutorial 448

Related Blogs

Quick Guide to Custom Output

Know Your Pump & System Curves - Part 1

Know Your Pump & System Curves - Part 2A

Know Your Pump & System Curves - Part 2B

Know Your Pump & System Curves - Part 3

Quick Graph Formatting Window
The Quick Graph Formatting window is accessed by clicking the Formatting button in the Quick 
Access Panel, or from the Tools menu.

The Quick Graph Formatting window allows you to customize the plot by giving you control over 
the many aspects including:

 l Axis titles and font sizes
 l Legend text and font size
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 l Line thicknesses and basic color sets
 l Axis min and max values

Changes can be undone by using the Reset button at the bottom of the window, or can be 
returned to the default formatting by using the Fathom Default or User Default buttons at the bot-
tom of the window.

Related Topics

Graph Results Window 430
Graph Types 437
Pump vs. System Curve Methods 440
Multi-Scenario Pump vs. System Curves Tutorial 448

Graph Types
AFT Fathom offers several types of graphs to help users better understand and interpret their 
data. Each type of graph is given a brief description below. 

Pump vs. System Curve

This graphing option allows you to plot a pump curve versus a system curve for a single pump or 
group of pumps.

Note: The Pump Curve vs. System Curve is only available if there is a pump in the model             

You can create pump vs. system curves for complex parallel flow networks. Composite pump 
curves for pumps in parallel or in series can also be also generated. If you create a composite 
pump curve, you can also show single pump curves on the same graph. If efficiency data exists 
you can cross-plot the efficiency curve.

If POR or AOR have been defined in Pump Configuration, these items can be displayed on the 
Pump vs. System graph.

If control valves are present in the model the control valves will be excluded from the Pump vs. 
System curve by default. Excluding the control valves will set them to be fully open for all flow 
rates. This option is useful to prevent convergence issues.

Pump vs. System curves can be displayed in two ways when parallel pumps are selected. One 
way is the “traditional” method which is how AFT Fathom displayed them in AFT Fathom 6.0 and 
before. The second method is called the “enhanced” method and it attempts to determine the 
flow split on the pumps and adjust the system curve accordingly. It also attempts to create a bet-
ter composite curve when parallel pumps are dissimilar. For more information see Pump vs. Sys-
tem Curve Methods.

Pump vs. System curves for different scenarios can be plotted together on one graph by adding 
individual pump vs. system curves to a Multi-Scenario Pump Vs. System Folder, then loading 
them together in a single Multi-Scenario graph. For detailed information on how to do this see 
Multi-Scenario Pump vs. System Curves Tutorial.
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Profile

This graph category will allow you to plot the selected parameter(s) along a flow path. In order to 
generate this graph, the specified pipes in the Select Graph Parameters window that comprise 
the path must form a single, continuous path. If they do not, an error message will appear and 
inform you which pipes are preventing the path from being continuous. The independent variable 
in these graphs is the length along the pipe(s).

A path of pipes can be specified in several ways. First, the user can select the pipes in the dis-
played list. Additionally, you can select the path on the workspace, and then use the Workspace 
button on the Select Graph Parameters window to automatically select all pipes currently selec-
ted on the Workspace. These methods permit that only a single path to be specified.

A profile graph can also be generated directly by selecting a single, continuous flow path in the 
Workspace, then right-clicking the Workspace and choosing the desired parameter under "Gen-
erate Profile Graph."

One or more flow paths can be specified using groups. To do this change the profile plot from 
"Plot Single Path" to "Plot Multiple Paths Using Groups" at the top of the parameter selection 
area. Only those groups that consist of a continuous pipe sequence will be displayed as an 
option in the Select Graph Parameters window. 

Multi-Scenario Graphing Features

Starting with Fathom 12, users can plot information from multiple scenarios in the same graph for 
profile plots (or Transient plots with the XTS Module). Note Multi-Scenario Pump vs System 
curves are generated using a different method. 

In the Select Graph Parameters window, the button for 'Multiple Scenarios' allows users to select 
the scenarios in the model they wish to plot for a particular graph. The same pipe layout must 
exist for all scenarios being plotted in a graph. Design alerts cannot be included in multi-scenario 
plots.

The active scenario must be included in a multi-scenario graph. When creating a new graph, 
users are not able to deselect the current scenario. When a user loads a saved Graph List Item 
that does not include the active scenario, Fathom will add the active scenario into the Graph List 
Item, but will not save the active scenario into it.

Scenarios can be selected using the Multi-scenario... button as shown in Figure 1 below. 
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Figure 1: Graph Parameters window showing Multi-scenario selection options

Transient

(XTS Module Only) The Transient allows you to create plots of pipe and junction output with time 
as the independent parameter. See Transient Graph Results.

The overall maximum and/or minimum values can be plotted. Both of these graph types support 
animation.

To graph the results at a particular point in time, select the animation option and use the tools 
provided to display the desired time. 

Slurry System Curve

(SSL Module Only) Special system curves can be generated for slurry modeling. See Graphing 
Slurry Results.

Related Topics

Graph Results Window 430
Quick Graph Formatting Window 436
Pump vs. System Curve Methods 440
Multi-Scenario Pump vs. System Curves Tutorial 448
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Related Blogs

Know Your Pump & System Curves - Part 1

Know Your Pump & System Curves - Part 2A

Know Your Pump & System Curves - Part 2B

Know Your Pump & System Curves - Part 3

Pump vs. System Curve Methods
When plotting pump and system curves with two or more parallel pumps, AFT Fathom offers two 
methods: Enhanced and Traditional.

It should be understood by the engineer that it is not possible to create an unambiguous com-
posite pump and system curve for parallel pump systems. The reasons why are discussed here.

First, let's discuss the head curve. A composite pump curve shows a single head curve with val-
ues at particular flow rates. However, when there are parallel pumps with unequal head curves 
or even equal head curves with unequal flow distribution, it is not clear what flow rate to use in 
the composite head curve. Further, with unequal flow distribution, different heads for each par-
allel pump can result. But the composite head curve shows only a single head for any given flow. 
What head is this? The maximum, minimum, arithmetic average, flow rate weighted average, or 
some other value? A composite curve has uncertainty over what is meant by the composite flow 
rate and composite head.

Composite system curves have similar issues to composite head curves. The entire system per-
formance is boiled down to a single head vs. flow rate curve. What flow rate is being referred to 
and what head is being referred to which goes with a given flow rate?

AFT Fathom attempts to create as meaningful and helpful composite pump and system curves 
as possible, but the fact remains that the curves AFT Fathom creates are ambiguous because of 
the nature of composite head vs.system curves.

Enhanced

The “enhanced” method was introduced in AFT Fathom 7. 

For composite head curves, it assumes that the parallel pump head curves are added to the right 
with respect to flow rate. No attempt is made to apportion flow splits among the pump curves. 
With the head curves added to the right, there is a unique head value for every flow rate. In real-
ity, the parallel pumps may not work this way, depending on the flow split among the pumps and 
whether or not the head curves are identical and whether there are check valves at each pump 
discharge. This is, however, a reasonable approximation and represents the historical way that 
parallel pump head curves are added together.

No matter what method is used for creating a composite system curve, composite system curves 
are created by fixing some flow rate to each pump and then determining the required head from 
the pump to deliver the assumed flow rate.
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The enhanced system curve takes the flow split at the operating point and assumes that the flow 
split remains the same at all flow rates. It collects the required head for each pump at each flow 
rate and then averages these heads together arithmetically. 

If the pump head curves are identical and the flow split among pumps is proportional, this 
method will give the same results as the Traditional method.

Traditional

The “traditional” method was used in AFT Fathom 5.0 and 6.0. The traditional method assumes 
that the flow splits equally among all pumps at all flow rates, regardless of whether pump curves 
are identical or not.

The composite head curve is created by taking the composite flow rate, splitting it equally among 
each pump, obtaining the head for each pump at the split flow rate, and then taking the arithmetic 
average of the pump heads.

The composite system curve is obtained by taking the composite flow rate, splitting it equally 
among each pump, running the system model with these flow rates, and then taking the arith-
metic average of the required heads for each pump.

Related Topics

Graph Results Window 430
Quick Graph Formatting Window 436
Graph Types 437
Multi-Scenario Pump vs. System Curves Tutorial 448

Related Blogs

Know Your Pump & System Curves - Part 1

Know Your Pump & System Curves - Part 2A

Know Your Pump & System Curves - Part 2B

Know Your Pump & System Curves - Part 3

Basic Graph Tutorial
Graphs are powerful analysis tools. AFT Fathom has special tools  to create and save Graphs 
and regenerate them later even if the output data has changed due to model changes. Follow the 
tutorial below  to make and manage graphs from one of the example models.

Create and run a fully defined model. This tutorial uses the Sizing a Pump example model, avail-
able in the standard installation of AFT Fathom.

To skip to different sections of this tutorial, use the links below:
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Pump vs. System Curves

Using a 
model with 
output, nav-
igate to the 
Graph Res-
ults window. 
On the right 
in the Quick 
Access 
Panel, select 
the Pump vs. 
System tab 
and select 
the desired 
parameters 
(for the 
example, the 
defaults 
have not 
been altered) 
in the Para-
meters area. 
After the 
parameters 
have been 
selected, 
click Gen-
erate, and 
the graph will 
appear on 
the left.                     
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Profile Graphs

Using a 
model with 
output, nav-
igate to the 
Graph Res-
ults window. 
On the right 
in the Quick 
Access 
Panel, click 
the Profile 
tab. This 
graph type 
displays the 
selected 
parameter 
along the 
length of the 
flow path. 
Select both 
pipes in the 
system and 
change the 
parameter to 
Pressure 
Stagnation. 
Using the 
default units 
of feet for 
length and  
psia for pres-
sure, click 
Generate 
and the 
graph will 
appear on 
the left.                     
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Saving Graphs

After gen-
erating a 
graph, save 
the graph by 
selecting the 
Add Graph 
To List short-
cut on the 
Graph Res-
ults Toolbar. 
Give the 
graph a 
name and it 
will appear 
under My 
Graphs in 
the Graph 
List Man-
ager on the 
right. Easily 
regenerate 
this graph 
with the 
same para-
meters and 
format if the 
output 
changes by 
double-click-
ing on the 
graph name. 
The border 
of the Graph 
has also 
changed to 
dark green 
along with 
borders of 
the para-
meters and 
the name of 
the Graph in 
the Graph 
List Man-
ager. This 

- 444 -



Interface and User Options

indicates 
that that 
Graph is cur-
rent, saved, 
and that the 
displayed 
parameters 
are the ones 
used to gen-
erate the 
Graph.                     

Creating Multiple Graphs

Create mul-
tiple graphs 
stored on their 
own tabs by 
first clicking 
on the green 
plus button on 
the bottom 
right of the 
graph window 
to create a 
new graph 
tab. This cre-
ates a new 
graph tab. 
Generate a 
graph and 
then toggle 
between the 
graphs by 
selecting the 
tabs on the 
bottom of the 
graph window. 
Add as many 
graphs as 
desired.
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Alternatively, 
double-click a 
saved graph 
in the Graph 
List Manager 
in the Quick 
Access Panel 
to auto-
matically gen-
erate that 
graph on a 
new tab. 

Displaying Multiple Graphs Simultaneously

To view multiple 
graphs in the 
same window, 
right click on a 
graph tab and 
select either 
Two Vertical 
Tab Groups or 
Two Horizontal 
Tab Groups. 
The graphs will 
then display 
next to each 
other such that 
both graphs can 
be viewed sim-
ultaneously.
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Alternatively, 
right-click on 
the My Graphs 
folder in the 
Graph List Man-
ager, choose 
Load Folder 
Items, then click 
Same Tab. This 
will generate all 
graphs in the 
My Graphs 
folder into the 
same tab (as 
opposed to dis-
playing multiple 
tabs sim-
ultaneously as 
described pre-
viously).

Creating Graphs from the Workspace

Some 
graphs can 
also be gen-
erated dir-
ectly from 
the Work-
space after 
running the 
model. Gen-
erate the 
Pressure 
Stagnation 
vs. Flow 
Length graph 
from the 
Workspace 
by selecting 
the flow path 
on the Work-
space (note 
that you can 
select mul-
tiple pipes by 
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holding the 
SHIFT but-
ton on the 
keyboard 
while select-
ing each 
pipe). Right 
click on the 
Workspace, 
choose the 
Generate 
Profile Graph 
for Pipes 
option, then 
click Pres-
sure Stag-
nation.  

Multi-Scenario Pump vs. System Curves Tutorial
When a model file has multiple scenarios that have pumps in them, a graph containing multiple 
pump curves and/or system curves can be generated for the purpose of comparison. To create a 
multi-scenario pump vs. system curve graph, two options are available:

 l Standard Method: Save pump vs system curve graphs for each individual scenario to be 
included in the graph. This allows the user to define settings such as the flow range for the 
pump vs system curve on an individual scenario basis, but is more time consuming.

 l Batch Run Method: Create a template pump vs system curve graph, then set up a batch 
run to automatically generate the pump vs system curves for all scenarios to be included 
in the graph. This allows for a faster process.

Standard Method

 1. In the Graph List Manager select "New Folder". Provide a name for the folder, and check 
the box to "Make Multi-Scenario Pump Vs. System Folder", as is shown in Figure 1. This 
folder will be used to save the curves from the individual scenarios that will be included in 
the multi-scenario graph.
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Figure 1: Creating a Multi-Scenario Pump Vs. System Folder

 2. Load the first scenario you want to add to the graph, and run the scenario so that Output is 
present. Generate a Pump vs. System Curve for the scenario.

 3. Add the Pump vs. System Curve to the Multi-Scenario Pump Vs. System Folder. This can 
be done by selecting the Multi-Scenario folder in the Graph List Manager, then clicking 
the Add Graph to List button, and naming the graph. The graph should now be shown sub-
ordinate to the folder, with the scenario name listed next to it in red, as is shown below.

Figure 2: The name of the scenario that each Pump vs. System Curve was created in is displayed in 
the Graph List Manager

 4. Repeat steps 2 and 3 for all scenarios that will be included in the graph. 
 5. When all of the individual Pump vs. System curves have been added to the folder, right-

click on the folder name and choose "Load Multi-Scenario Graph," as is shown in Figure 
3.
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Figure 3: A Multi-Scenario Graph can be loaded from a Multi-Scenario graph folder

 6. In the Multiple Scenario Graph Selection window select which curves you would like to 
include in the graph, then choose Generate Graph as is shown in Figure 4.

Figure 4: Multiple Scenario Graph Selection

 7. The selected curves will now be displayed on a single graph, as is shown in Figure 5.
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Figure 5: Multi-Scenario Pump vs. System curve

Batch Run Method

To speed up the process outlined above when making Multi-Scenario Pump vs. System curves 
for more than a handful of scenarios, the Batch Run tool can be used. Follow the steps below to 
create the curves. 

 1. In one of the scenarios being included in the Multi-Scenario Pump vs. System curve, gen-
erate a single scenario Pump vs. System curve and save it as a standard Graph List item. 
This curve will be used as a template for all the other scenarios, and should be for a pump 
common to all scenarios. 

 2. Launch the Batch Run window found in the File menu. Select the option to have the Batch 
Runs create Multi-Scenario Pump vs. System curves, and select the template Pump vs. 
System curve as shown in Figure 6. If you have multiple templates, all options will be 
shown for selection. 
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Figure 6: Multi-scenario batch run option enabled in the Batch Run window

 3. Add the desired scenarios to run to the list and start the run. 
 4. Once the run is complete, navigate to the Graph Results tab. In the Graph List Manager, 

there will be a Multi-Scenario Pump System Curve folder named with the date and time of 
the run. Right-click on the folder name and choose "Load Multi-Scenario Graph," as is 
shown in Figure 7.
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Figure 7: A Multi-Scenario Graph can be loaded from a Multi-Scenario graph folder

 5. In the Multiple Scenario Graph Selection window select which curves you would like to 
include in the graph, then choose Generate Graph as is shown in Figure 8.

Figure 8: Multiple Scenario Graph Selection

 6. The selected curves will now be displayed on a single graph, as is shown in Figure 9.

- 453 -



Interface and User Options

Figure 9: Multi-Scenario Pump vs. System curve

Related Topics

Graph Results Window 430
Quick Graph Formatting Window 436
Graph Types 437
Pump vs. System Curve Methods 440

Related Blogs

Know Your Pump & System Curves - Part 1

Know Your Pump & System Curves - Part 2A

Know Your Pump & System Curves - Part 2B

Know Your Pump & System Curves - Part 3

Getting there is graph the fun! - Multi-Scenario Pump vs. System Curves

AFT Fathom 11 New Features at a Glance

User Options Overview
An array of User Options are provided in a single window that can be found in the Tools menu.

The General section of the User Options window provides the following options:
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 l Choose to show the Startup Options window at startup
 l Choose to show the New Version Welcome window at startup
 l Enable orthogonal drawing tips
 l Enable Confirm Before Clearing Results
 l Enable highlighting for required fields in the Properties windows, and choose the highlight 

color
 l Options for opening models with scenarios
 l Set a visual theme for the interface
 l Select a location for the Scenario Manager
 l Choose the number of data points to show in input tables
 l Setting parameters for "button flashing" for curve fit buttons on junction Properties win-

dows

User Option Defaults

There are several buttons at the bottom of the User Options window. There are built-in AFT 
Default parameters, units, and settings which you can choose by clicking the Reset to Fathom 
Defaults button. You can also develop your own settings, tailored to your project or industry, and 
have these used by default. To make your own default, first select the parameters, units, and set-
tings you would like to use, then click the Save All As New User Defaults button. Your settings 
will be saved and will be used each time any new project is initiated. If you make changes to the 
settings, and want to get back to your defaults, click the Load All User Defaults button. The 
default settings are updated only when you click Set All As New User Defaults.

If you have made changes which you don’t want to keep, click the Cancel button. Click Save and 
Close to use the settings you have defined.

Related Topics

Interface and User Options 361
Unit System 455
Workspace 457
Parameters 461
Files 462
Sizing Preferences 464

Unit System
You can set the units you prefer to use in AFT Fathom in the Unit System section. Once selected 
as the preferred units, these units appear as the default units in all instances in which empty 
fields exist in the model input. Any model input existing prior to changing the Preferred Units will 
maintain the units used when the data was input, regardless of changes made to unit pref-
erences. After saving your preferred units, a window appears asking if you would like the output 
parameters to be displayed in your preferred units. Choose Yes if you do want the output para-
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meters to be displayed in the preferred units, or No if you want the output parameters to be dis-
played in the units used prior to making changes to the preferred units.

Preferred Units

To customize the units used by AFT Fathom, first select Preferred Units under the Unit System 
section in the User Options window under the Tools menu.

AFT Fathom allows you to specify certain units from a large selection to be displayed in the main 
interface.

The primary selection is the Unit System:

 l US - Only US units will be available
 l Metric - Only Metric units will be available
 l Both with US Defaults - All Units will be available, but US units will be chosen by default
 l Both with Metric Defaults - All Units will be available, but Metric units will be chosen by 

default

Additionally, a filter can be applied to limit the selection:

 l All Units - all units for the Unit System will be displayed
 l Common Only - only "common" units will be displayed
 l Common Plus Selected Industries - Units particular to certain industries can be 

included with the common units

If the selection has been limited to Common Only, there may units common for certain industries 
no longer present. The Additional Units for Industry section allows the user to append additional 
sets of units to the Common unit set. For example, barrels/day is a common unit in the petroleum 
industry but not many others. Checking the Petroleum box adds these units to the main inter-
face.

Preferred Units allows fine grain control over what unit in the above selection is displayed as the 
default when defining model input. For example, it may be desired to have a particular parameter 
such as pipe diameter default to inches, while keeping other parameters metric. This area allows 
the user to define such defaults.

Show/Hide Unit Items

For additional control of the available units, select Show/Hide Unit Items under the Unit System 
section. From here, you can select which units for each Unit Family Type you would like to be 
available for the model input and output by checking the box next to each unit you would like to 
be used. Removing units that you do not wish to use as input or view as output can simplify your 
modeling and reduce errors associated with incorrect units.
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Edit Custom Unit Names

A custom unit name can be assigned to display different names in the interface for units. For 
example "feet/min2" could be changed to display as "ft/min2".

To assign a custom unit name choose the appropriate Unit Type from the drop-down and enter 
the Custom Unit Name in the table.

To speed up the process of entering custom unit names, the units can be exported to *.csv and 
re-imported as follows:

 1. Click "Save Units to CSV" and save the file where it will be easy to locate
 2. Open the *.csv file in a spreadsheet editing software like Excel, and fill in the desired cus-

tom unit names in the Custom Name column
 3. Save the *.csv file
 4. In the User Options window click "Load Units from CSV" and select the edited *.csv file

Note: To use units with superscripts, make sure the *.csv file is saved with UTF-8 encoding. 
This can be done in Excel by choosing Save As and selecting "CSV UTF-8" as the file 
type.

Note: Regions outside the United States that use commas as the decimal separator may 
have *.csv files that are delimited with semicolons (this was a change made by 
Microsoft). AFT software requires true comma delimited files. A workaround for such 
regional users in Excel is listed below.

Workaround for regional users with alternate decimal separators (e.g. Europe):

 1. In Excel go to File > Options > Advanced
 2. Under the Editing Options heading, uncheck the box for "Use system separators"
 3. Change the "Decimal separator" to a period symbol (.)
 4. Change the "Thousands separator" to a comma (,)
 5. Save the *.csv file
 6. Re-check the "Use system separators" option to revert to the default Excel settings

Related Topics

User Options Overview 454
Workspace 457
Parameters 461
Files 462
Sizing Preferences 464

Workspace
In the Workspace group of the User Options window, you can change the symbols used, default 
text content, and location of the text on the Workspace. Note that all display changes are made 
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only for the user's convenience/preference and do not affect the model calculations. Additionally, 
many display options available in the User Options window are also available in individual pipes 
and junctions.

Grid

A traditional 2-D grid or an Isometric grid can be displayed on the workspace for modeling con-
venience based on the Pipe Drawing Mode that is selected. The number of lines in the grid can 
be adjusted to create a grid that is fine, medium, or coarse. The grid can be hidden or shown by 
checking or unchecking the Show Grid box accordingly. If the grid is shown, the grid line pattern 
can be solid or dashed. The pipes and junctions can also be snapped to the grid, which moves 
junctions and pipe end points to the closest intersection of grid lines.

The Pipe Drawing Mode and the toggle to Show Grid can also be found on the Arrange menu.

Pipes

The display of pipe lines, closed pipes, pipe endpoints, and pipe direction arrows can be adjus-
ted according to your preferences here.

The default pipe line thickness for new layers can be adjusted by selecting the desired pixel 
value in the box next to New Layer Default Pipe Line Thickness (pixels).

You can close a pipe using the Special Conditions feature which closes the pipe to flow at both 
ends. From the User Options window, you can select how you would like a closed pipe to be dis-
played on the Workspace. The options include a solid line, dashed line, a dotted line, and 
dashed-dotted combinations. The color of the line is still determined by the visible Workspace 
Layers.

When building a model, Fathom automatically adjusts pipe endpoints to the centers of junctions 
for user convenience. If you would like to disable this feature, uncheck the box next to Auto-
matically Adjust Pipe Endpoints to Junction Centers.

Under the Pipe Direction Arrows section you can select the size of arrow you would like to be dis-
played as a percentage of the pipe thickness. Additionally, you can opt to not show a pipe dir-
ection arrow by checking the option Do Not Show Arrow.

Note: The pipe direction arrow is used as a reference positive flow direction and does not 
change direction on the Workspace if the calculated flow is in the opposite direction 
indicated by the arrow. Instead, the flow is reported as a negative flow in the Output.

Junctions

The junction icon styles include classic icons and transparent icon. Classic icons are the icons 
used in earlier versions of Fathom ending at Version 7 in which each junction is surrounded by a 
box, and transparent icons are updated icons not surrounded by boxes.

You can also select the icon size and label location for junctions. To adjust the size, click on the 
box below Icon Size in the Junctions panel and choose the percentage of the default size that 
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you would like the junction icons to be sized. For the junction label location, you can select from 
any of the eight locations shown by clicking on the selection circle that corresponds to the 
desired location.

Using the default transparent icon style, the appearance and color of icons for new junctions can 
be set in the Toolbox, and icon size and color for existing junctions can be set in Layer Settings. 
Junction icon and rotation can be edited for existing junctions by right clicking the junction on the 
Workspace and selecting Customize Icon.

Note: Junction and pipe labels can be moved individually on the Workspace by using the 
mouse to drag and drop the label according to your preferences.

The final option  is to enable or disable a dotted outline around a closed junction. If this option is 
enabled, a dotted box will appear around the junction when it is closed with Special Conditions. If 
this option is disabled, no dotted box will appear.

Labels

When a pipe or junction is inserted onto the Workspace, the next whole number available at the 
increment specified in this panel is automatically assigned to the new pipe and/or junction. The 
default is to increment pipe and junction numbers by one. Therefore, the first pipe you place on 
the Workspace will automatically be labeled as Pipe 1 (P1 for brevity), the second will auto-
matically be labeled P2, etc. Junctions are labeled in a similar fashion with a "J" in front of the 
number to indicate it is a junction. However, if you choose a different increment in the User 
Options window for pipes and/or junctions, the automatic numbering will increment pipes and/or 
junctions according to the specified number. You can renumber any pipe or junction individually 
as long as the number is not already used in any scenario of the model. If a number at the incre-
ment is already in use, Fathom will skip to the next available whole number. Pipe and Junction 
label numbers are limited to integers between 0 and 99,999.

Note: A unique label must exist for each pipe and junction on the Workspace. Therefore, 
there cannot be more than one P1 in the model, but a P1 and J1 can exist sim-
ultaneously because the leading letter is different. Pipe and junction numbers are 
defined globally and not per layer or per scenario.

Whether pipe/junction names and/or numbers are displayed is controlled ultimately by Work-
space Layers, but the Pipe/Junction Default Display setting allows the user to set their preferred 
default behavior.

Users can also choose whether the pipe and junction labels should be moveable at all times, or if 
they should only be moveable when the user is holding down the shift key with the Allowable 
Workspace Label Movements setting. Restricting the movement of labels can be especially help-
ful to users with complicated or dense models, as it is possible to inadvertently grab a label when 
attempting to reposition or select an icon on the Workspace.
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Colors and Fonts

The Colors and Fonts item located within the Workspace group in the User Options window 
allows you to change the colors of the following parameters seen on the Workspace:

 l Pipe and Junction Symbols
 l Junction Labels
 l Pipe Labels
 l New Layer Default Pipe Color
 l Selected Items
 l Undefined Numbers
 l Workspace Background Base Scenario
 l Workspace Background Children
 l Workspace Background Grandchildren
 l Workspace Background 3rd Generation
 l Workspace Background 4th Generation +
 l Grid

The currently selected color for each parameter is shown to the right of the parameter. To 
change the color for any parameter, either select the box containing the parameter's color and 
then click on the Set Color box under the list, double click on the box containing the color you 
would like to change, or click the "..." button next to the color of the parameter you would like to 
change. A color window pops up that allows you to choose from 48 basic colors, or to create a 
custom color by clicking anywhere in the color box and adjusting the slider at the right of the box 
to create the color of your choice. If you would like to save the custom color for use in other areas 
of the model, click on any empty box underneath Custom colors: and then click on the Add to 
Custom Colors box below the color box. When finished with selecting a color, click OK on the bot-
tom left of the Color window.

To have the background color of the children and grandchildren scenarios maintain the same 
color as the base scenario, click on the Set All Background Colors to Base Color button under 
the Parameter/Color list.

Other

Workspace Symbols representing pipe or junction special conditions and inflow or outflow are lis-
ted in the Other item within the Workspace group in the User Options window. These symbols 
can be disabled by unchecking the box on the left of the list. Users can also change what symbol 
will be used by clicking in the Symbol box on the right and typing the new desired symbol.

If there is a background image in a model, the image size can be controlled from this panel. To 
scale a background picture, enter a Scale Multiplier in the box underneath Background Picture 
Scaling.
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Related Topics

User Options Overview 454
Unit System 455
Parameters 461
Files 462
Sizing Preferences 464

Parameters
The Parameters section of the User Options window allows you to specify some default para-
meters and model input when a new pipe or junction is added to the Workspace. Changing any 
of the parameters in this window adjusts the specified default pipe and/or junction input para-
meters and/or values to simplify the modeling process and to prevent the user from having to 
enter repetitive data.

Pipes and Junctions

Pipe and Junctions, located within the Parameters section of the User Options window, allows 
you to specify default pipe and junction input information.

Under the Default Pipe Data box in this window, you can enable or disable the option Use Most 
Recent Pipe Size Data. If you enable Use Most Recent Pipe Size Data, the pipe property win-
dows of new pipes added to the Workspace will automatically contain pipe diameter, material, 
and friction information from the most recently entered pipe. This prevents you from having to re-
enter the pipe diameter, material, and friction model information in the case that several pipes 
require this same input. Disabling this feature leaves the pipe diameter, material, and friction 
model for each new pipe added to the Workspace as the default specified in the User Options 
window.

The Default Junction Elevation box allows you to select the default junction elevation you would 
like for all new junctions added to the Workspace. If you select Unspecified in this box, the junc-
tion elevation field in the Junction Properties window remains empty until you specify each junc-
tion elevation individually. If you select Use Most Recent, the junction elevation of a new junction 
added to the Workspace is shown as the elevation of the most recently specified junction. If you 
select Specified, you are able to input an elevation of your choice that will automatically be input 
into each new junction that is added to the Workspace.

The Default Reservoir Pipe Specification box allows you to specify the default option selected for 
how the height at which a pipe connected to a reservoir is specified. Selecting Pipe Elevation 
requires you to input the pipe elevation with respect to the reference elevation. Therefore, if a 
pipe is located 100 feet (30.5 m) from the reference elevation, or elevation= 0 ft (0 m), then you 
would input 100 ft as the pipe elevation when Pipe Elevation is selected in the Reservoir Prop-
erties window. Selecting Pipe Depth requires you to input the pipe elevation with respect to the 
level of fluid in the tank. Here, if a pipe is located 10 feet from the top of the fluid level in the tank, 
you would input 10 ft. Note that the same results will be calculated regardless of whether you spe-
cify Pipe Elevation or Pipe Depth as long as the height of the pipe is defined at the same height 
with respect to the system in both cases.
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The Default Control Valve Failure option allows you to choose the default behavior if a control 
valve is calculated to have failed. This option can be changed on an individual basis in the Con-
trol Valve Properties window. See Control Valve Setpoint Not Achievable for more information.

The Default Design Factors box allows you to add a default Design Factor to each junction 
shown in the list on the Pipes and Junctions window. Setting a default design factor for junctions 
can be especially useful when applying safety factors on given equipment.

Graphs from Workspace

Various parameters can be graphed quickly by right-clicking on a continuous selection of pipes 
from the Workspace and choosing the Generate Profile Graph for Pipes option. The graph para-
meters that are available from the right-click menu can be customized.

Parameter Type

Parameter Types, located within the Parameters section of the User Options window, allows you 
to specify the flow rate type, head/pressure type and Efficiency/Power types you would like as 
the default option wherever one of those parameter types is defined in the model. The default 
flow rate type can be set to either mass flow or volumetric flow, the default head/pressure type 
can be set to either head or pressure, and either efficiency or power can be selected as the 
default for efficiency/power. For example, when defining a resistance curve to describe the 
hydraulic pressure loss behavior through a general component, you are required to enter data 
that describes pressure loss at given flow rates. When defining the pressure loss behavior here, 
you can either define the flow rate as a mass or volumetric flow rate, and you can define the 
head/pressure loss as either a head or pressure loss. Adjusting the default option of these para-
meter types to fit your available data not only helps to make data input more efficient by pre-
venting you from having to constantly change parameter type, but it also helps to minimize input 
errors by adjusting the required input to the form of your available data.

Related Topics

User Options Overview 454
Unit System 455
Workspace 457
Files 462
Sizing Preferences 464

Files
The Files section of the User Options window allows you to specify file locations for saving mod-
els, library folders, user settings, and model backup files. You can also customize the model 
backup file settings here.
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File Locations

Under File Locations in the Files section of the User Options window, you have the option to 
select the default folder in which to save your model. If a default model folder is specified, this loc-
ation will be the default location to save the model. To specify the default location, click Add 
below the Default Model Folder box and browse to the location you want to set as the default 
folder. Once you have selected the folder, click OK.  The location of the default model folder will 
then show in the Default Model Folder box. You can add more than one default folder, but only 
the folder selected in blue will be the active default folder.

To specify locations for Fathom to search for library files, click Add under the Library Search 
Locations box. Browse to the file location that contains the library, select the location, and click 
OK. You can add multiple folders to be searched. To add additional folders, repeat the process 
for each folder.

The User File consists of all saved settings and preferences. In order to backup these user set-
tings in a *.ini file, click Add under User Backup Locations. Browse to the file location in which 
you would like to save these settings. Once you have selected the desired file location, click OK. 
Note that the User File can be saved in multiple locations. To add additional locations, repeat the 
process for each folder that you would like to save the settings.

Backup Files & Auto Save

A Backup File is a copy of a previously saved version of your model file (*.fth) that can function 
as a complete, standalone model. These files are used as a safety measure to provide you with 
one or more previous versions of the model in the case that the current model is deleted or dam-
aged.

The Number of Backup Files (i.e. the number of previously saved versions of the model) and the 
frequency that the model is saved can be adjusted. You can opt to save no Backup Files by 
choosing "0" in the Number of Backup Files Created dropdown.

After the model has been saved initially, subsequent instances of saving the model will create a 
new Backup File until the specified maximum has been reached. The most recent Backup File 
will always contain the file extension *.bakF-001. Larger numbers appended to the file name 
indicate older backups:

 l Model File.fth - Current and most recent version of the model file
 l Model File.bakF-001 - Latest backup (the second most recent version of the model file)
 l Model File.bakF-002 - Older backup
 l Model File.bakF-003 - Oldest backup

If you need to revert to a Backup File and convert it back into a standalone model, add the exten-
sion .fth to the Backup File (the file name should now appear as Model File.bakF-001.fth), and 
open the file in Fathom. From there you can re-save the file or overwrite your existing model file.

The model file can be saved periodically by enabling the checkbox for Automatically Save Model 
and specifying a frequency in the dropdown box.
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Create Recovery File

A Recovery File (*.Recv-FTH) is similar to a Backup File but is saved periodically at the specified 
interval. It allows the user to recover unsaved changes in the model file prior to the application 
crashing or closing abnormally. The Recovery File is written to the same location as the model 
file, and each time the specified interval passes it will be overwritten to contain the most recent 
state of the model. If the application is closed normally the Recovery File will be deleted. A 
Recovery File can only be generated for existing model files that are opened.

If a Recovery File exists, the next time the model file is opened a prompt will be shown asking if 
you want to use the Recovery File:

"A recovery file for this model was found which may indicate that the application closed unex-
pectedly. Would you like to open this recovery file?"

 l Yes - This will copy the previously saved model file to a new file with "(Original)" appen-
ded to the front, and the Recovery File containing the latest unsaved changes will be 
opened.

 l No - The Recovery File will be deleted, and the previously saved model file will be 
opened. This will open the model file in its last saved state, which may not include the 
latest unsaved changes if any are stored in the Recovery File.

Encoding

The File Encoding option can be set to "Unicode" in order to use characters outside of the stand-
ard English keyboard such as diacritics, cyrillic, etc for text fields such as the pipe/junction name, 
notes, etc.

Related Topics

User Options Overview 454
Unit System 455
Workspace 457
Parameters 461
Sizing Preferences 464

Sizing Preferences
The Sizing Preferences section provides options to customize the colors used in the Sizing win-
dow, set the location of the Sizing Navigation Panel, and enable options for creating con-
tinuous/discrete candidate sets.

Note: This section of User Options will only be shown if the ANS module is activated in 
Fathom.             
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Color Options

The "Sizing Option" parameter colors affect the background colors used for the corresponding 
columns in the "Options to Minimize Monetary Cost" table on the Sizing Objective panel and the 
"Sizing and Cost Options" table on the Size/Cost Assignments panel.

The assigned background colors will also change the background of the Sizing Level status but-
ton in the Sizing Navigation Panel.

The "Common Size Group" parameter colors affect the background colors used in the "Pipe 
Grouping" table on the Size/Cost Assignments panel, as well as the headers used in the "Assign 
Candidate Sets to Pipes" section on the Candidate Sets panel and the "Assign Design Require-
ments to Pipes" section on the Design Requirements panel.

Sizing Navigation Panel Preferences

This section allows the user to set the default location for the Sizing Navigation Panel. By default 
the Sizing Navigation Panel will be located at the bottom of the Sizing window.

Sizing Panel Preferences

This section provides users with the option to show the discrete/continuous option on the Can-
didate Sets panel. By default this option will be hidden and all Candidate Sets will be defined as 
discrete.

In general the continuous candidate set option should only be used if the Sizing Type is set to 
Continuous, and discrete sizing does not need to be performed for the pipes.

Related Topics

User Options Overview 454
Unit System 455
Workspace 457
Parameters 461
Files 462
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File Import and Export
This section focuses on the various file types that can be imported and exported from 
AFT Fathom. Topics included discuss importing piping layouts from various sources, importing 
and exporting between AFT products, and importing and exporting data with excel.

Contents

Importing Piping Component Files 466

Importing GIS Shapefiles 471

Importing CAESAR II Neutral Files 473

Importing and Exporting EPANET Files 476

Importing and Exporting from Other AFT Products 480

Exporting To Excel 481

Importing From Excel 487

Related Blogs

Meet the Import Piping Layout Wizard

Now it's Super Easy! Changing Input Data in AFT Models using Excel Change Data

That was EASY! Quickly Change Pipe and Junction Input Data into AFT models using Excel 
Change Data

Importing Piping Component Files
AFT Fathom includes the ability to import Piping Component Files (.pcf), which can be generated 
by a wide range of software, and provide a quick way to get started with the hydraulic modeling 
portion of a project. Files can be imported into existing models.

Selecting File > Import Piping Layout From > Piping Component File (.pcf) brings up the Import 
Piping Layout Wizard in the Quick Access Panel, as shown below in Figure 1.

The Import Piping Layout Wizard is organized into sections that help guide the import process:

 l Folder Browser - After browsing to a folder, all .pcf files within the folder will be listed 
here. Simply clicking a file in the list will show a preview of the import in the Workspace. 
The location of the preview can be moved by dragging the icon in the upper-left of the 
selection area. 
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 l Object List - When a file is selected, the objects to be created will be listed here. Each 
individual object can be reassigned to a certain Junction, if the automatic assignment is 
not correct. For example, the originating software may have only had a "valve" while this 
could be a Relief Valve or a Control Valve. Changing the AFT Object type will change the 
preview in the Workspace. Right-clicking on an object shows a menu for converting object 
types.

 l Property Window - This button opens an additional panel that shows the raw prop-
erties for the currently selected object.

 l Link Materials - Opens the File Object Link window, where groups of pipes from 
the .pcf file can be associated with a pipe material, size, and type in the AFT Pipe 
Material library. Pipes can be grouped by file schedules (i.e. item codes) or dia-
meters, and are sorted by length within each group. The selection from the AFT 
Pipe Material library will overwrite any diameter information from the .pcf file. Selec-
tions made for a .pcf material will be applied to all pipes that reference that .pcf 
material. Pipes associated with each material can be seen by clicking the arrow on 
the left expand the group (Figure 2) and can be edited individually or as a group.

 l Show Ignored Objects - Certain types of objects are ignored on import - these 
can be objects such as flanges, or additional file components such as materials or 
bolt specifications.

 l Options
 l Min Pipe/Max Pipe - Information fields on the length of the shortest pipe and 

longest pipe in the list of pipes to be imported.
 l Ignore Pipes of Length Less Than - Do not import pipes shorter than this 

amount.
 l Ignore Pipes of Diameter Less Than - Do not import pipes smaller than this dia-

meter.
 l Ignored Pipes - How many pipes will be ignored based on the above settings. 

Ignoring pipes can be helpful in keeping a model clean and free of unnecessary 
components. For example, a pipe stress software may require many short pipe 
segments in between welds or flanges. However, these types of connections are 
almost always ignored for hydraulic analysis. By ignoring short pipes, the amount 
of "import clean up" required can be reduced.

 l Preferred Scale - The wizard will Auto Scale the import by default. If a different 
scale is desired, this option can be disabled and a custom scale entered.

 l Show Pipes in Preview - Display the pipes in the Workspace preview.
 l Show Junctions in Preview - Display the junctions in the Workspace preview.
 l Combine Pipes When Possible - It is required that all pipes in the Workspace be 

connected to other pipes by a junction. However, this is not a requirement in all soft-
ware. Therefore, some .pcf files may be generated with several pipes "end to end." 
If the pipes were imported this way, either junctions would need to be added, or the 
pipes would need to be combined before the model could be solved. This option 
attempts to automatically combine pipes in this situation.

 l Import Bends as Pipes - Pipe bends can be imported as junctions, or as a visual 
change in direction of the pipe. Importing bends as pipes is identical to using seg-
ments with assigned fittings and losses to show piping layout. To account for 
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losses, bends will be matched to smooth flanged bends in the AFT Internal Fittings 
& Losses Library if an exact match for angle and r/D ratio is available and assigned 
to the pipe automatically. Losses that are not assigned automatically can be set up 
manually using junctions or fittings & losses. This option is helpful to reduce unne-
cessary model clutter and input if bend losses are negligible.

Note: In most cases, it is recommended to import bends as bends rather than pipes. Bends 
imported as bends will always use smooth bends with r/D and/or angle imported from 
the .pcf file and basis area inherited from the upstream pipe.

 l Ignore Fitting Lengths - Neglects additional length added to pipes that accounts 
for the equivalent length of fittings and losses, and is not actually part of the phys-
ical pipe length.

 l Import Data to Pipe or Junction Notes Field - Add the raw data from the ori-
ginating file to the Notes tab of the corresponding object.
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Figure 1: Piping Component File Import
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Figure 2: File Object Link window for Piping Component File Import

General Recommendations

Importing piping layouts from external file types such as Piping Component Files is intended to 
save time by allowing a means to quickly achieve a foundational layout. A .pcf file does not 
provide all information needed to create a working hydraulic model of a system and the import 
process will not produce a completed model or a perfectly accurate representation of the .pcf 
model. There will be missing data that must be assigned prior to analysis, such as fluid prop-
erties and boundary conditions. However, there are import practices and preparations that can 
be made to the .pcf file that will make creating model from an imported piping layout go more 
smoothly.

 l Workspace - Piping Component Files are a three-dimensional file format, whereas model 
layouts in the AFT Workspace are a two-dimensional representation of a system. 
Because the Workspace is a purely visual tool  independent of actual system dimensions, 
the Scale/Flip Workspace feature can be useful for achieving a readable model when 
working with imported piping layouts.

 l Object Positioning - It is recommended to have some distance between most objects 
(this is not relevant to welds, branch/tap connections, gaskets, and supports). This aids in 
pipe connections, as objects that are very close together may have trouble connecting 
automatically. This is especially true of non-isometric models. Spacing between objects 
also streamlines the process of scaling objects on the Workspace after import.

 l Bends - By default, Import Bends as Pipes is unchecked, and importing bends as bends 
is recommended for the sake of model readability and a more flexible approach to incor-
porating bend losses. Bends that have common angles and r/D ratios present in the 
internal AFT library can be imported as Fittings & Losses automatically when importing 
bends as pipes, but other bends will need to be added manually as junctions, or have their 
losses specified using the Additional K Factor option in the Pipe Fittings & Losses window 
or as user-specified fittings & losses using the Fittings & Losses Library. When bends are 
imported as bends, they will be treated as smooth bends, the upstream pipe determines 
the cross-sectional flow area, and the r/D ratio and/or angle is imported from the Piping 
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Component File. If only the r/D ratio or angle is specified, the other parameter will be cal-
culated using the endpoint coordinates.

Note: Bends modeled explicitly can be joined with adjacent pipes as using Join Pipes/Junc-
tions later if desired. Modeling bends as explicit junctions is advised for models con-
taining bends that are not smooth flanged or have an uncommon angle or r/D ratio.

 l Pipes - While the AFT Pipe Material Library contains many piping materials specified by 
ASME and ANSI, the Piping Component File format does not always contain these mater-
ials and  material attributes can be defined within .pcf files in a number of drastically dif-
ferent ways. Because of this, materials, nominal sizes and schedules are not assigned 
automatically and can be assigned using Link Materials (shown above in Figure 2). Pipes 
can be grouped by file schedules (i.e. item codes) if they exist or by diameter so that pipe 
size and material can be applied to a group of pipes quickly. Pipe inner diameter is 
assigned from the nominal diameter defined in the pipe's coordinates within the .pcf file as 
a starting point, but any sizes assigned in Link Materials will override these inner dia-
meters within the AFT model. Alternatively, pipes can be defined after import using Global 
Pipe Edit.
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Meet the Import Piping Layout Wizard

Importing GIS Shapefiles

Import GIS Shapefile

GIS Shapefiles that adhere to the ESRI standard can be imported into AFT Fathom for ease of 
model creation. These files have the extension .shp, but there are two other supporting file types 
that need to be in the same folder as the .shp in order for the import to work correctly. These are 
.shx and .dbf file types. The option is located under File > Import Piping Layout From > GIS 
Shapefile (.shp). This opens the "Import Piping Layout Wizard" in the Quick Access Panel that 
allows the importing of one line .shp that is of pipes and multiple point .shp files for branches, 
valves, pumps, and reservoirs. Once the .shp files have been added to this window the object 
type, scaling, and mapping can be selected. 
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Object Type

Any .shp files that are of lines are automatically set to the object type of "Pipes". Only one .shp 
file containing lines can be imported at a time. Any .shp file that is of points can be set to 
Branches, Valves, Pumps, or Reservoirs.

Scaling

Scaling only applies when no length is mapped to the AFT "length" field or when no length data 
exists in the shapefile. Scaling does not alter the Workpace layout or visual length of the pipe. It 
only adjusts the pipe length property that is calculated by the coordinates being imported from 
the shapefile.

The default scaling is 1 grid point to 1 foot. This can be adjusted by selecting the "..." button in the 
Scaling column. This button opens a new window in which a new scale is applied to the auto-
matic calculation of the pipe length property. This window does not change the visual length of 
the pipe drawn on the workspace. This window also allows the viewing of the coordinates of spe-
cific points and parts of different shapes within the shapefile.

Mapping

The Data Mapping window allows the user to select what data fields have relevant data for AFT 
Fathom to import. 

 l Pipes can map:
 l Labels - Names
 l Length - Mapping this field will utilize included user shapefile data and override the 

automatic calculation of pipe length. The scaling window settings will have no 
effect when this field is mapped.

 l Friction - Absolute Roughness, Relative Roughness, Hazen-Willams Factor, Expli-
cit Friction Factor, Weymouth, and Panhandle friction models are available.

 l Inner Diameter
 l Branches can map:

 l Labels - Names
 l Elevation

 l Pumps can map:
 l Labels - Names
 l Elevation
 l Assigned Flow - Imports as a Fixed Flowrate pump

 l Reservoirs can map:
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 l Labels - Names
 l Elevation - To the base of the reservoir
 l Liquid Elevation - Height from base to liquid surface elevation. Liquid elevation 

and elevation are summed and input as liquid surface elevation in the generated 
reservoir junctions.

 l Valves can map:                     
 l Labels - Names
 l Elevation
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Importing CAESAR II Neutral Files
AFT Fathom includes the ability to import CAESAR II Neutral Files (.cii), providing a quick way to 
get started with the hydraulic modeling portion of a project. Files can be imported into existing 
models.

Selecting File > Import Piping Layout From > CAESAR II Neutral Files (.cii) brings up the Import 
Piping Layout Wizard in the Quick Access Panel, as shown below in Figure 1.

The Import Piping Layout Wizard is organized into sections that help guide the import process:

 l Folder Browser - After browsing to a folder, all .cii files within the folder will be listed 
here. Simply clicking a file in the list will show a preview of the import in the Workspace. 
The location of the preview can be moved by dragging the icon in the upper-left of the 
selection area. 

 l Object List - When a file is selected, the objects to be created will be listed here. Each 
individual object can be reassigned to a certain Junction, if the automatic assignment is 
not correct. For example, the originating software may have only had a "valve" while this 
could be a Relief Valve or a Control Valve. Changing the AFT Object type will change the 
preview in the Workspace. Right-clicking on an object shows a menu for converting object 
types.
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 l Property Window - This button opens an additional panel that shows the raw prop-
erties for the currently selected object.

 l Link Materials - Opens the File Object Link window, where the pipes can be asso-
ciated with a pipe material, size, and type in the AFT Pipe Material library. The 
selection from the AFT Pipe Material library will overwrite any diameter information 
from the CII file, and will be applied to all of the pipes. Pipes are grouped by dia-
meter by default and can also be grouped by schedule.

 l CAESAR II Info - Detailed information from the neutral file can be viewed for 
objects in the neutral file, including information on physical properties, allowable 
stresses, 3-dimensional orientation, etc. for the imported objects.

 l Options
 l Min Pipe/Max Pipe - Information fields on the length of the shortest pipe and 

longest pipe in the list of pipes to be imported.
 l Ignore Pipes of Length Less Than - Do not import pipes shorter than this 

amount.
 l Ignore Pipes of Diameter Less Than - Do not import pipes smaller than this dia-

meter.
 l Ignored Pipes - How many pipes will be ignored based on the above settings. 

Ignoring pipes can be helpful in keeping a model clean and free of unnecessary 
components. For example, a pipe stress software may require many short pipe 
segments in between welds or flanges. However, these types of connections are 
almost always ignored for hydraulic analysis. By ignoring short pipes, the amount 
of "import clean up" required can be reduced.

 l Preferred Scale - The wizard will Auto Scale the import by default. If a different 
scale is desired, this option can be disabled and a custom scale entered.

 l Show Pipes in Preview - Display the pipes in the Workspace preview.
 l Show Junctions in Preview - Display the junctions in the Workspace preview.
 l Show Labels In Preview - Show the corresponding label from the .cii file in the 

Workspace preview. This is only shown in the preview and will not be imported into 
the model itself.

 l Combine Pipes When Possible - It is required that all pipes in the Workspace be 
connected to other pipes by a junction. However, this is not a requirement in all soft-
ware. Therefore, some .pcf files may be generated with several pipes "end to end." 
If the pipes were imported this way, either junctions would need to be added, or the 
pipes would need to be combined before the model could be solved. This option 
attempts to automatically combine pipes in this situation.

 l Import Bends as Pipes - Pipe bends can be imported as junctions, or simply as a 
visual change in direction of the pipe. Importing bends as pipes is identical to using 
segments to show piping layout - no additional losses due to direction change are 
accounted for with this option. To account for losses, additional information will 
need to be entered using either junctions or fittings & losses. This option is helpful 
to reduce unnecessary model clutter and input if bend losses are negligible.

 l Ignore Fitting Lengths - Neglects additional length added to pipes that accounts 
for the equivalent length of fittings and losses, and is not actually part of the 
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physical pipe length.
 l Import Data to Pipe or Junction Notes Field - Add the raw data from the ori-

ginating file to the Notes tab of the corresponding object.

Figure 1: CAESAR II Neutral File Import

Related Topics

File Import and Export 466
Importing Piping Component Files 466
Importing GIS Shapefiles 471

- 475 -



Interface and User Options

Importing and Exporting EPANET Files 476
Importing and Exporting from Other AFT Products 480
Exporting To Excel 481
Importing From Excel 487

Related Blogs

Meet the Import Piping Layout Wizard

Importing and Exporting EPANET Files
AFT Fathom includes the ability to import and export EPANET Files (*.INP). EPANET is public 
domain modeling software developed by the US Environmental Protection Agency. Many dif-
ferent applications support the file format, so it can therefore provide a quick way to get started 
with the hydraulic modeling portion of a project.

Import Piping Layout Wizard

Selecting File > Import Piping Layout From > EPANET File (.inp) brings up the Import Piping Lay-
out Wizard in the Quick Access panel, as shown below in Figure 1. Note that importing from 
EPANET requires that the Workspace be empty.

The Import Piping Layout Wizard is organized into sections that help guide the import process:

 l Folder Browser - After browsing to a folder, all .inp files within the folder will be listed 
here. Simply clicking a file in the list will show a preview of the import in the Workspace. 
The location of the preview can be moved by dragging the icon in the upper-left of the 
selection area. 

 l Object List - When a file is selected, the objects to be created will be listed here. Each 
individual object can be reassigned to a certain Junction, if the automatic assignment is 
not correct. For example, the originating software may have only had a "valve" while this 
could be a Relief Valve or a Control Valve. Changing the AFT Object type will change the 
preview in the Workspace. Clicking on an object in the workspace highlights it in the wiz-
ard.

 l Property Window - This button opens an additional panel that shows the raw prop-
erties for the currently selected object.

 l Link Materials - Opens the File Object Link window, where the pipes can be asso-
ciated with a pipe material, size, and type in the AFT Pipe Material library. The 
selection from the AFT Pipe Material library will overwrite any diameter information 
from the EPANET file, and will be applied to all of the pipes.

 l Options
 l Min Pipe/Max Pipe - Information fields on the length of the shortest pipe and 

longest pipe in the list of pipes to be imported.
 l Ignore Pipes of Length Less Than - Do not import pipes shorter than this 

amount.
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 l Ignore Pipes of Diameter Less Than - Do not import pipes smaller than this dia-
meter.

 l Ignored Pipes - How many pipes will be ignored based on the above settings. 
Ignoring pipes can be helpful in keeping a model clean and free of unnecessary 
components. For example, a pipe stress software may require many short pipe 
segments in between welds or flanges. However, these types of connections are 
almost always ignored for hydraulic analysis. By ignoring short pipes, the amount 
of "import clean up" required can be reduced.

 l Preferred Scale - The wizard will Auto Scale the import by default. If a different 
scale is desired, this option can be disabled and a custom scale entered.

 l Show Pipes in Preview - Display the pipes in the Workspace preview.
 l Show Junctions in Preview - Display the junctions in the Workspace preview.
 l Import Data to Notes Field - Add the raw data from the originating file to the 

Notes tab of the corresponding object.
 l Auto-Zoom Preview - This option can be enabled to automatically zoom out so 

that the whole model can be seen in the workspace, which can be convenient for 
large systems.
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Figure 1: EPANET Import/Export Dialogs

Pipes and Junctions

All pipes and junctions get imported with user-specified names from EPANET. All junctions 
below that have flow, elevation, length or other parameters will be imported with the same units if 
possible.

 l Pumps - The available points on the pump curve are imported into the pump data and 
used with the curve fit type set to interpolated X-Y data. If desired, polynomial curve fits 
can be set up within pump configuration using this data after the import process is com-
plete.
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Note: If only one or two data points exist for the pump curve, the curve will still need to be 
user-specified.

 l Tanks - If XTS is on, finite-volume tanks will imported as finite open tanks. Otherwise, 
they will be imported as normal reservoirs.

 l Reservoirs - EPANET reservoirs are imported as a reservoir with a surface pressure of 1 
atm with liquid elevation imported from EPANET.

 l Pipes - These will use roughness, length, and inner diameter from EPANET model.
 l Junctions - (Just called Junctions in EPANET) 

 l If one connecting pipe - If it has a demand, it becomes an Assigned Flow with rel-
evant inflow/outflow. Otherwise, it becomes a dead end.

 l If multiple connecting pipes - If it has a demand, it becomes a branch using the 
Flow Source or Sink optional property with the relevant inflow/outflow imported 
from the EPANET junction demand. Otherwise, it is imported as a normal branch.

 l Valves - The K factor of a valve is assigned with the value specified in the EPANET 
model. Valves can be imported as normal valves, control valves, relief valves, or check 
valves depending on how they are defined within EPANET:

 l Normal valves come from GPV and TCV in EPANET.
 l Control valves come from FCV, PBV, and PSV in EPANET.
 l Relief valves come from PRV in EPANET.
 l Check valves come from CV in EPANET.

 l Heat Exchangers - While Heat Exchangers are not an explicitly defined object type in 
EPANET, EPANET junctions with "Heat Exchanger" in their user-defined name are impor-
ted as Heat Exchangers in AFT software.

 l Emitters - Emitters in EPANET are defined as a junction with a base demand and an emit-
ter coefficient. These are imported as Spray Discharge junctions with the emitter coef-
ficient imported as a K Fire Sprinkler value with the flow units defined by the base demand 
units and the pressure component defined by the emitter coefficient units (e.g. flow unit 
per square root of psi in EPANET). The number of sprinklers per emitter are set to 1 and 
the exit pressure is set to the atmospheric pressure (zero gauge pressure). The correct 
atmospheric pressure for the imported system should be set in Environmental Settings in 
Analysis Setup.

Exporting EPANET Files

AFT models can be exported to an EPANET file by using the File -> Export Piping Layout To -> 
EPANET File (.inp)... option from the Workspace window. The EPANET Export window shown in 
Figure 2 below allows the user to specify the desired destination to export the file to.
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Figure 2: EPANET Import/Export Dialogs
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Related Blogs

Meet the Import Piping Layout Wizard

Importing and Exporting from Other AFT Products
Models made in other AFT products such as AFT Impulse can be opened directly in AFT Fathom  
and vice versa. This can be a useful starting point when it is desired to perform additional ana-
lysis on a model that has already been built in another AFT product, such as if it is desired to plot 
pump vs system curves for a model built in Impulse.

To convert a model from one AFT product to another just browse to the model you would like to 
convert and open it in the software you are converting the model to. This can be done by chan-
ging the file extension selected, as is shown below in Figure 1. Note that though AFT Arrow and 
AFT xStream are not explicitly listed, models from Arrow and xStream can also be converted by 
selecting "All" and browsing to the model file.

When the model is opened in AFT Fathom a backup copy of the original model will be created 
from which the original model can be restored if needed. See the Backup Settings explanation 
for more information on backup files.

The conversion process will automatically change junction types not included in AFT Fathom to 
either a General Component or Branch junction. Be aware that some features available for use 
in other AFT products are not available for use in AFT Fathom. If a junction is defined using a fea-
ture not available in AFT Fathom, the non-applicable information will be removed, and the user 
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may be required to input additional information to fully define the model. It is advised to fully 
review the model after import.

Figure 1: File extensions options for Open File window

Related Topics
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Importing GIS Shapefiles 471
Importing CAESAR II Neutral Files 473
Importing and Exporting EPANET Files 476
Exporting To Excel 481
Importing From Excel 487

Exporting To Excel
AFT Fathom includes a powerful ability to export any Output data to any specific cell(s) in an 
Excel spreadsheet. Specific values from the model can be exported, as well as columns, rows, 
or entire output tables as defined in Output Control. These items are controlled with the Excel 
Export Manager, available from the File menu.
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Figure 1: The Excel Export Manager

Adding Items to the Excel Export Manager

Data from the Output can be added to the Excel Export by clicking New, or by selecting an exist-
ing item and clicking Duplicate. Items can also be created directly from the Output Window by 
right-clicking on a cell or header.

Figure 2: Adding items directly from the Output

Each row in the Excel Export Manager corresponds to a cell, column, row, or table of data to be 
added to the spreadsheet. Each column helps define what data will be transferred where. The 
grid below the entries shows a preview of where the data will be added to help prevent inter-
secting data by showing where there are overlapping regions. Note that graph items can vary in 
size and do not show a complete region here.

 l Apply to Export - Items can be optionally included or excluded from the export.
 l Export Type - What type of data is being exported. This affects other settings, and will 

affect how much room is required on the target Excel sheet.
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 l Single Value - The value of a single parameter for a single pipe or junction object.
 l Column - Values of a single parameter for all of the displayed objects.
 l Row - Values of all displayed parameters for a single object.
 l Table - Values of all displayed parameters for all displayed objects.
 l Graph - The graph points from a specified Graph List Item.
 l Other - Additional information not available in a standard Output table, such as 

Fluid definition, Model Title, or Scenario Names.
 l Source - Where the data is coming from.

 l Pipe - From the Pipe section of the output.
 l Junction - From the Junction section of the output.
 l General Output Summary - From one of the available output Summary sections. 

For example, if there is a pump junction in the model, Pump Summary is available.
 l Graph - From a specified Graph List Item.

 l Object - The object in particular that is desired. If Column or Table are selected for Export 
Type, this selection will be fixed to ALL.

 l Parameter - The parameter in particular that is desired. If Row, Table or Graph are selec-
ted for Export Type, this selection will be fixed to ALL.

 l Units - The units of the exported value. This is available only for Single Value and Column 
Export Types. Some parameters do not have units and this will display N/A.

 l Excel Sheet - Which Excel Sheet to export to. This value can be edited by the user - if it is 
desired to export to a named sheet this can be entered here.

 l Excel Starting Cell - The upper-left cell to export the data to.
 l Excel Ending Cell - The automatically calculated lower-right cell of the data, which 

depends on the Export Type, export options, and the number of parameters or objects in 
the model. It is important to recognize that the Excel Starting Cells can be defined in a 
way that data gets overwritten. The Ending Cell column is a handy reference to help 
avoid this.

 l Header - Optionally export the name of the Parameter(s) related to the item.
 l Units - Optionally export the name of the Unit(s) related to the item.
 l Add Excel Comments - Optionally adds an Excel comment to the value cell that con-

tains the Parameter name and unit.
 l Show Example - Displays an example of how the exported cells will appear.

Figure 3: Example Export
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Figure 4: Result of the above example, color added for emphasis

Excel Export Location

After all of the desired data has been added to the Excel Export Manager, the next step is to actu-
ally export the data. There are three options available for the export:

 l Create New Workbook - A new Excel Workbook will be opened with the exported data.
 l Previously Saved Workbook - Browse to a Workbook saved to file. The Workbook will 

be opened and the modifications made to the sheets as specified.
 l Currently Opened Workbook - Select a Workbook that is currently open in Excel. The 

already open Workbook will be modified.

Note: The Excel Export Manager does not save Excel files for non-batch run exports. Any 
changes made need to be manually saved by the user in Excel.             

There are two options available for exporting:

 l Clear Sheet Data - All of the existing data on the sheets specified in the Excel Sheet 
column will be cleared. This is especially useful for setting up a new export when many 
changes are being made.

 l Automatically Export After Running Model - After the model is run, the Export will be 
carried out automatically, per the settings defined by the user in the Excel Export Man-
ager.

Advanced Options

Items can be added directly from the Output instead of adding custom items with the New button. 
There are two behavioral options that can be modified for this action:

 l Open Excel Export Manager - If enabled, the Excel Export Manager will be opened 
every time an item is added from the Output. This is useful for double checking the export 
process completed as expected. 

 l For Existing Items -
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 l Add New Item - The item selected will be added to the Excel Export Manager 
even if it already exists.

 l Select Existing - If the item already exists, do not add a duplicate item and 
instead select the existing item.

 l Ask - If the item already exists, prompt the user on the action to take.
 l Create an Export Guide - When exporting, an Export Guide can optionally be included 

in the export. The Export Guide contains information about the model and the generation 
of the export, to help keep the connection between the data and the model clear for future 
reference.

Exporting Data From Multiple Scenarios

The Excel Export Manager can be employed with Batch Runs with a couple of important dis-
tinctions.

First, if multiple sheets are specified in the Excel Export Manager, the only way to export multiple 
scenarios is to export every scenario to its own Workbook. To keep data from multiple scen-
arios in one Workbook, there can only be one sheet specified in the Excel Export Manager.

Second, the Excel File will be saved after each scenario. In normal single-scenario exports 
the file is never saved, but in batch mode it is required. 

In the Batch Run tool, users are also able to use Excel Export without having to run the scenarios 
again by using the Export Only (Do Not Run) option. Note that if any of the scenarios in the Batch 
Run do not have output, the batch Export Only will not export any data for that scenario, as it will 
not run those scenarios to get output.
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Figure 5: Saving Results From Multiple Scenarios
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Importing From Excel
A Microsoft Excel spreadsheet can be used to make changes to objects in an AFT Fathom 
model. The values in the Excel file are located in specific locations as described in the Setting Up 
Excel section.

Setting Up Excel

When reading an Excel file, AFT Fathom will search for a worksheet named AFT Transfer. 
There can be other worksheets in the workbook but Fathom will only look for a sheet with this 
name. The file structure looks like the following:

Figure 1: Sample AFT Transfer Excel Sheet

Row 1 and column A are not read by AFT Fathom - these cells can have any value in them, 
though it is recommended to enter the values above for the header row.

Each column has certain accepted values, which can depend on the values in neighboring 
columns.

Note: A template spreadsheet containing validation rules for the required layout is included in 
the AFT Fathom installation, or can be downloaded here. By default the file path is: 
C:\AFT Products\AFT Fathom\AFT Fathom Excel Import Workbook.xlsx

Apply Column

This column accepts Yes or No. Only changes marked as Yes will be imported into the model.

Object Type

This column must be a junction name or Pipe. Valid choices can be seen below in Table 1.

Object Number

This corresponds to the junction or pipe number.
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Parameter

The specific parameter to be changed. These parameters vary based on the Object Name selec-
ted. Each parameter has a type (C/S/I) associated with it, as is explained in the next section.

- 488 -



File Import and Export

Table 1: Object Types, Associated Parameters, and Change Codes

   Pipe

S  Additional K 
Factor

S  Ambient 
Fluid Velocity

S  Ambient 
Temperature

S  Buried Pipe 
Depth

S  Design 
Factor - Pipe 
Fittings & 
Losses

S  Design 
Factor - Pipe 
Friction

S  Design 
Factor - Pipe 
Heat Transfer

S  External 
Heat Flux/Tra-
cing Flux

S  External 
Heat Rate

S  ID Reduction 
(Scaling)

S  Initial Guess 
Flowrate

S  Inner Dia-
meter (for 
unspecified, 
cylindrical 
pipes)

S  Length

I  Nominal Size 
Increment

   Area 
Change

S  Design 
Factor

S  Initial 
Guess Pres-
sure

S  Initial 
Guess Tem-
perature

S  Inlet Elev-
ation

C  Junction 
Name

S  Outlet Elev-
ation

I  Sizing/Cost 
Setting

I  Special 
Condition

S  User Spe-
cified K

   Assigned 
Flow

S  Design 
Factor

S  Elevation

S  Flow Rate

S  Initial Guess 
Pressure

C  Junction 
Name

I  Sizing/Cost 
Setting

I  Special 
Condition

S  Tem-
perature

   Assigned 
Pressure

S  Design 
Factor

S  Elevation

C  Junction 
Name

S  Pressure

I  Sizing/Cost 
Setting

S  Tem-
perature

   Bend

S  Design 
Factor

S  Initial Guess 
Pressure

S  Initial Guess 
Temperature

S  Inlet Elev-
ation

C  Junction 
Name

S  Outlet Elev-
ation

I  Sizing/Cost 
Setting

I  Special Condi-
tion

S  User Spe-
cified K
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C  Nominal 
Size Set (must 
match text in 
Pipe Property 
Window)

C  Nominal 
Type Set 
(must match 
text in Pipe 
Property Win-
dow)

S  Non-
cylindrical Pipe 
Flow Area

S  Non-
cylindrical Pipe 
Wetted Peri-
meter

C  Pipe Name

S  Rectangular 
Duct Height

S  Rectangular 
Duct Width

S  Roughness 
Value (for 
unspecified 
friction mod-
els)

I  Sizing/Cost 
Setting

S  Soil Surface 
Temperature

I  Special 
Condition

   Branch

S  Design 
Factor

S  Initial Guess 
Pressure

S  Initial Guess 

   Check 
Valve

S  Design 
Factor

S Forward 
Velocity to 
Close Valve

   Control 
Valve

S  Design 
Factor

S  Initial Guess 
Pressure

   Dead End

S  Initial Guess 
Pressure

S  Initial Guess 
Temperature

S  Elevation

   General 
Component

S  Design 
Factor

S  Initial Guess 
Pressure
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Temperature

S  Inlet Elev-
ation

C  Junction 
Name

S  Outlet Elev-
ation

I  Sizing/Cost 
Setting

S Source/Sink 
Flow Rate

S  Source/Sink 
Temperature

S  Initial 
Guess Pres-
sure

S  Initial 
Guess Tem-
perature

S  Inlet Elev-
ation

C  Junction 
Name

S  Loss Value

S  Outlet Elev-
ation

I  Sizing/Cost 
Setting

I  Special 
Condition

S  Initial Guess 
Temperature

S  Inlet Elev-
ation

C  Junction 
Name

S  Loss When 
Fully Open

S  Outlet Elev-
ation

S  Setpoint

I  Sizing/Cost 
Setting

I  Special 
Condition

C  Junction 
Name

I  Sizing/Cost 
Setting

S  Initial Guess 
Temperature

S  Inlet Elev-
ation

C  Junction 
Name

S  K Factor

S  Outlet Elev-
ation

I  Sizing/Cost 
Setting

I  Special Condi-
tion

   Heat 
Exchanger

S  Controlled 
Outlet Tem-
perature

S  Design 
Factor - Fric-
tion Loss

S  Design 
Factor - Heat 
Transfer

S  Heat Flow 
Into System

S  Heat Trans-
fer Area

S  Initial Guess 
Pressure

S  Initial Guess 
Temperature

S  Inlet Elev-
ation

   Jet Pump

S  Design 
Factor

S  Initial 
Guess Pres-
sure

S  Initial 
Guess Tem-
perature

S  Inlet Elev-
ation

C  Junction 
Name

S  Outlet Elev-
ation

I  Sizing /Cost 
Setting

I  Special 
Condition

   Orifice

S  Area/Dia-
meter

S  Design 
Factor 

S  Exit Pres-
sure

S  Exit Tem-
perature

S  Initial Guess 
Pressure

S  Initial Guess 
Temperature

S  Inlet Elev-
ation

C  Junction 
Name

S  Loss Value

S  Outlet Elev-
ation

   Pump

S  Control Set-
point

S Delta Pres-
sure to Re-
Open Com-
bined Check 
Valve

S  Design 
Factor 

S  Fixed Flow 
Rate

S  Fixed 
Speed (%)

S Forward 
Velocity to 
Close Com-
bined Check 
Valve

S  Initial Guess 
Pressure

S  Initial Guess 

   Relief Valve

S  Blowdown 
Pressure

S  Design 
Factor

S Exit 
Head/Pressure

S Exit Tem-
perature

S  Initial Guess 
Pressure

S  Initial Guess 
Temperature

S  Inlet Elev-
ation

C  Junction 
Name

S  Loss Value

S  Outlet Elev-
ation
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C  Junction 
Name

S  K Factor

S  Outlet Elev-
ation

S  Overall Heat 
Transfer Coef-
ficient

S  Secondary 
Fluid Flow 
Rate

S  Secondary 
Fluid Inlet Tem-
perature

S  Secondary 
Fluid Specific 
Heat

I  Sizing/Cost 
Setting

I  Special 
Condition

I  Sizing/Cost 
Setting

Temperature

S  Inlet Elev-
ation

C  Junction 
Name

S Liquid 
Depth

S Liquid Sur-
face Pres-
sure/HGL

S  Outlet Elev-
ation

I  Sizing/Cost 
Setting

I  Special 
Condition

S Submerged 
Suction Pres-
sure

S Submerged 
Suction Tem-
perature

S Trimmed 
Impeller Ratio 
as Percent

S  Over-
pressure

S  Remote 
Pressure

S  Set Pressure

I  Sizing/Cost 
Setting

I  Special Condi-
tion

   Reservoir

S  Cross-Sec-
tional Area

S  Design 
Factor

C  Junction 
Name

S  Liquid Sur-
face Elevation

S  Liquid Sur-
face Pressure

S  Liquid Tem-
perature

   Screen

S  Design 
Factor

S  Initial 
Guess Pres-
sure

S  Initial 
Guess Tem-
perature

S  Inlet Elev-
ation

C  Junction 
Name

   Spray Dis-
charge

S Cd (Dis-
charge Coef-
ficient)

S  Design 
Factor

S  Discharge 
Flow Area

S  Elevation

S  Exit Pres-
sure

S  Exit Tem-

   Three Way 
Valve

S  Actual Per-
cent Open

S  Design 
Factor

S  Elevation

S  Initial Guess 
Pressure

S  Initial Guess 
Temperature

C  Junction 
Name

   Tee or Wye

S  Design 
Factor

S  Initial Guess 
Pressure

S  Initial Guess 
Temperature

S  Elevation

C  Junction 
Name

I  Sizing/Cost 
Setting
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I  Sizing/Cost 
Setting

I  Surface Elev-
ation Type

S  Tank Bottom 
Elevation

 

S  K Factor

S  Outlet Elev-
ation

I  Sizing/Cost 
Setting

perature

S  Initial Guess 
Pressure

S  Initial Guess 
Temperature

C  Junction 
Name

I  Number of 
Holes

I  Sizing/Cost 
Setting

I  Special 
Condition

I  Sizing/Cost 
Setting

   Valve

S  Design 
Factor 

S  Exit Pres-
sure

S  Exit Tem-
perature

S  Initial Guess 
Pressure

S  Initial Guess 
Temperature

S  Inlet Elev-
ation

C  
Junction Name

S  Loss Value

S  Open Per-
centage

S  Outlet Elev-
ation

S  Restricted 
Flow Area

I  Sizing/Cost 
Setting

   Venturi

S  Design 
Factor

S  Initial 
Guess Pres-
sure

S  Initial 
Guess Tem-
perature

S  Inlet Elev-
ation

C  Junction 
Name

S  Loss Value

S  Outlet Elev-
ation

I  Sizing/Cost 
Setting

   Volume Bal-
ance

S  Initial Guess 
Pressure

S  Initial Guess 
Temperature

S  Elevation

C  Junction 
Name

I  Sizing/Cost 
Setting

   Weir

S  Channel 
Width

S  Down-
stream Bot-
tom Elevation

S  Down-
stream Cross-
Sectional 
Area

S  Initial Guess 
Pressure

S  Initial Guess 
Temperature

S  Inlet Elev-
ation

C  Junction 
Name

S  Notch 
Width/Angle 

S  Outlet Elev-
ation

I  Sizing/Cost 
Setting

I  Special 

 

- 493 -



Interface and User Options

I  Special 
Condition

Condition

S  Surface 
Pressure

S  Upstream 
Bottom Elev-
ation

S  Upstream 
Cross-Sec-
tional Area

S  Height of 
Weir

I  Weir Type

Change Code

Each Parameter has restrictions on how it can be changed. All of the Parameters are decimal 
numbers, integers, or strings. 

Table 2: Valid Change Codes for each type of Parameter

Decimal 
Number 
(S)

Integer 
Number (I)

String 
(C)

Set equal 
to value

Set equal 
to value

Set equal 
to value

Change by 
value (+/-)

Change by 
value (+/-)

Add 
string to 
list

Change by 
percent 
(+/-)

Delete 
string 
from list

Value

The actual value to change the Parameter to or by.

For special conditions there are specific values assigned to each special condition option, as are 
listed in the table below.
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Table 3: Values used to import special conditions

Junc-
tion

Special 
Condi-
tion

Valu-
e

Assigne-
d Flow

None

Closed

0

1

Check 
Valve

None

Closed

Open

0

1

2

Control 
Valve

None

Closed

Fully 
Open - 
No Con-
trol

0

1

2

General 
Com-
ponent

None

Closed

0

1

Heat 
Exchang-
er

None

Ignore 
Heat 
Trans-
fer

0

2

Jet 
Pump

None

Closed

0

1

Pump None

Pump 
Off No 
Flow

Pump 
Off With 
Flow 
Throug-
h

0

1

2

Relief None 0
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Junc-
tion

Special 
Condi-
tion

Valu-
e

Valve Failed 
Open

Ignore 
Relief 
Valve

2

5

Spray 
Dis-
charge

None

Closed

0

1

Valve None

Closed

0

1

Weir None

Ignore 
Weir

0

5

Scenario Path Name

The Scenario that the changes are intended to apply to. If no scenario is present, the changes 
will be applied to the current scenario.

It is important that the Scenario name is uniquely qualified - if there are multiple scenarios with 
the same name, the full Scenario Path Name can be used. Scenario Path Names can easily be 
copied from AFT Fathom by right-clicking the scenario name and selecting "Copy Scenario Path 
Name."

Importing the File

When the sheet has been completely filled out, it can be imported from File -> Import Excel 
Change Data. When importing the data, the Object Change Log will appear, listing the changes 
that were made and any errors that occurred during the import. 
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Table 4: Excel Importing Error Messages

Error Description

Scenario name 
is not unique in 
the model (use 
full scenario path 
name)

There are mul-
tiple scenarios 
with this name. 
Use the fully qual-
ified path name 
(e.g. Base Scen-
ario\US Unit-
s\Pump A).

Invalid change 
type

The Change 
Code is not valid 
for the Para-
meter. For 
example, trying to 
change a string 
type with Change 
by Value (+/-).

Invalid para-
meter ID

The parameter 
given does not 
match the object 
type (e.g. Length 
for a junction).

Invalid para-
meter value

The value cannot 
be changed 
because the 
value is not valie. 
For example, a 
pump speed can-
not be negative.

Object not found A pipe or junction 
with the given ID 
was not found.

Parameter con-
flict

The value cannot 
be changed 
because it con-
flicts with another 
setting. For 
example, the loss 
value cannot be 
set when the junc-
tion is using a res-
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istance curve.

Scenario not 
found in the 
model

No scenario by 
the given name 
was found in the 
model.

Note: In order for the junction to accept the changes, some fields must already contain data. 
For example, if the control setpoint for a control valve is being changed, there must 
already be a setpoint and units entered into the control valve junction object. This is to 
ensure that the correct set of units are being used. These values can be set using 
Global Edit to an arbitrary value before the changes are made from Excel.

Related Topics

File Import and Export 466
Importing Piping Component Files 466
Importing GIS Shapefiles 471
Importing CAESAR II Neutral Files 473
Importing and Exporting EPANET Files 476
Importing and Exporting from Other AFT Products 480
Exporting To Excel 481
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This section is dedicated to unique standard based outputs as well as the designation of design 
alerts. Topics include discussions on using the submergence parameter to prevent vortexing, 
and utilizing the design alerts feature in the Workspace.

Contents

Submergence 499

Design Alerts 500

Design Alerts From Output 503

Design Alerts Importing & Exporting 505

Submergence
Submergence is a parameter used to determine the amount of liquid needed above a pipe sup-
ply from a tank or reservoir to ensure smooth flow and avoid vortexing. AFT Fathom offers a pipe 
output parameter for submergence and also submergence margin, which is the difference 
between the submergence and the actual pipe depth. 

Note: Pipe output parameters for submergence include options for Submergence Inlet and 
Submergence Outlet. Like all pipe output parameters, the Inlet and Outlet reference the 
inlet and outlet of the pipe. They do not describe if flow is entering or exiting the tank.

The equation used in AFT Fathom for submergence is given by ANSI/HI Standard 9.8.7 1998, p. 
32:

Where S is the submergence and Fr is the Froude number. Note that the required submergence 
can be modified by using devices such as baffles in which case the above equation would not 
apply.             

Related Topics

Design Alerts 500
Design Alerts From Output 503
Design Alerts Importing & Exporting 505
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Design Alerts
Design Alerts are a powerful feature that can help speed up the modeling process and help verify 
that the model is behaving as expected. The creation of a Design Alert does not constrain or 
affect the operation of the model in any way. However, it automatically creates an output alert 
any time the design limit is violated. One common use case might be defining a maximum allow-
able pressure for the pipes in the model. While the output can be reviewed manually for these 
violations, this quickly becomes tedious as the model grows in size. Creating a Design Alert 
instead allows the engineer to spend less time reviewing output tables as any violation will be 
immediately identified. 

The Design Alert Manager allows the user to create or modify Design Alerts. It can be accessed 
from the Tools Menu or in the Design Alerts tab in pipe and junction properties windows.

Design Alerts can also be created directly from the output, or can be imported/exported for use in 
other models. 

Figure 1: Design Alert Manager

Creating and Applying Design Alerts

Click the green plus sign (New Design Alert) to add a new Design Alert to the model.

A Name, Object Type, and Parameter Type and Value can be specified. Depending on the 
Object Type, a different selection of Parameters are available, as shown below. To add a Para-
meter:
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 1. Give the Design Alert a distinct and descriptive name.
 2. Select the Object Type the alert will be applied to.
 3. Select the Parameter Type the alter will monitor.
 4. Specify a value, unit if applicable, and companion.

 1. Use >= when the value shouldn't rise above the specified value (i.e. temperature 
shouldn't exceed a maximum value)

 2. Use <= when the value shouldn't fall below the specified value (i.e. pressure 
shouldn't drop below a minimum value)

 5. Select which Objects from the Workspace the Design Alert will be applied to.
 6. Click "OK" to save changes.

Several Parameter limits can be added to one Design Alert. For example, an alert can be created 
that requires a pressure within a range by adding both the maximum and minimum pressure lim-
its.

To update a Parameter, simply create it again and click Add to List - the old value will be 
replaced with the new one.

Figure 2: Creating a Design Alert
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Table 1: Available Design Alerts

Pipes General 
Junctions

Pump Valves Heat 
Exchangers

Reservoirs

Mass Flow Rate

Pressure Gradi-
ent Stag. Total

Pressure Stag-
nation

Pressure Static

Submergence 
Inlet Margin

Submergence 
Outlet Margin

Temperature 
Stagnation

Vapor Pressure 
Margin

Velocity

Volumetric Flow 
Rate

Gradeline 
Energy Inlet 
(EGL)

Gradeline 
Energy Out-
let (EGL)

Gradeline 
Hydraulic 
Inlet (HGL)

Gradeline 
Hydraulic 
Outlet (HGL)

Pressure 
loss Stag-
nation Total

Pressure 
Loss Static 
Total

Pressure 
Stagnation 
Inlet

Pressure 
Stagnation 
Outlet

Pressure 
Static Inlet

Pressure 
Static Outlet

Head Rise

Mass Flow 
Rate

NPSH Mar-
gin Absolute

NPSHA

Percent of 
BEP

Power Over-
all

Pressure Dis-
charge Stag-
nation

Pressure Dis-
charge 
Static

Pressure 
Rise Stag-
nation

Pressure 
Suction Stag-
nation

Pressure 
Suction 
Static

Speed

Volumetric 
Flow Rate

Cv

Flow Area

Head Loss

K

Kv

Mass Flow 
Rate

Open Per-
centage

Pressure 
Drop Stag-
nation

Pressure 
Static Inlet

Pressure 
Static Outlet

Volumetric 
Flow Rate

Head Loss

Heat Rate

Log Mean Tem-
perature Dif-
ference

Mass Flow 
Rate

Pressure Drop 
Stagnation

Temperature 
Inlet

Temperature 
Outlet

Volumetric 
Flow Rate

Liquid Height

Liquid Sur-
face Elev-
ation

Mass of 
Liquid in 
Reservoir

Volume of 
Liquid in 
Reservoir

When running the model, the selected object's output values will be checked against the con-
ditions that have been defined. If any of the Design Alert conditions are met, the user will receive 
a Design Alert warning and the violating parameters will be highlighted in the output tables. 
Design Alert warnings can be double-clicked to take you to that object in the Workspace.
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Figure 3: Design Alert Violations in Output

Design Alerts can be cross-plotted in the Graph Results window vs. the actual results. One good 
example where this is useful is for cross-plots of maximum and minimum allowed operating pres-
sures.

Design alerts are visible in every scenario in a model, but can be turned off or on for specific 
scenarios. When creating a design alert for the first time it will be active in that scenario and all 
descendent scenarios. For more information about scenarios, please read the Scenario Man-
ager help topic.

Related Topics

Submergence 499
Design Alerts From Output 503
Design Alerts Importing & Exporting 505

Design Alerts From Output
Right-clicking on a cell in the Output Window brings up a context menu. One of these options is 
Create Design Alert...

- 503 -



Special Modeling Features

Figure 1: Output Context Menu

Create Design Alert automatically defines a Design Alert based on the selected value and quant-
ity:

Figure 2: Automatically defined Design Alert

The Design Alert needs to have a name defined to be added. The specific value of the alert can 
be modified, and whether it is a maximum or minimum can be selected. The associated object is 
automatically selected as part of the Design Alert, but this is not required and additional objects 
can be selected now.

After the Design Alert has been created it can be further modified in the Design Alert Manager.

Related Topics

Submergence 499
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Design Alerts 500
Design Alerts Importing & Exporting 505

Design Alerts Importing & Exporting 
Design Alerts can be saved to a text file to be imported into other model files. This allows the 
user to quickly load commonly used design alerts into multiple model files.

Export a Design Alert

To export a Design Alert:

 1. Fully define a Design Alert for any parameter in the Design Alert Manager. For this 
example, we are using a velocity design alert.

Figure 1: A design alert for velocity to be exported

 2. Select "Save All Alerts To File..." and give the file a descriptive name.

Import a Design Alert

 1. Open the Design Alert Manager from the Tools menu.
 2. Select "Load Alerts From File...", then browse to and select the saved design alert file.

- 505 -



Special Modeling Features

 3. The Design Alert should now be added to the Existing Design Alerts list, and can be 
applied to objects in the model.

Related Topics

Submergence 499
Design Alerts 500
Design Alerts From Output 503
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Scenario Manager (in the Quick Access Panel) is a powerful tool for managing variations of a 
model, referred to as scenarios. It allows you to quickly test the same model with selected dif-
ferences (such as pump size, pipe diameter, system location, units, etc.) to find the system 
which works best. The Scenario Manager allows you to:

 l Create, name and organize scenarios
 l Select the scenario to appear on the Workspace (the "current" scenario)
 l Delete, copy, and rename scenarios
 l Duplicate scenarios and save them as separate models
 l Review the source of a scenario’s specifications
 l Pass changes from a scenario to its variants
 l See what scenarios have output by automatically changing the text color to blue if they 

have output

All scenarios are saved within the model file.

Scenario

A variant case of a model that is created in the Scenario Manager.

Base Scenario

The Base Scenario is the root scenario at the top of the scenario tree. As the highest level 
ancestor, It does not inherit from any other scenario. A new scenario can be inserted above the 
base scenario, at which point the new scenario would behave as the base scenario, and the ori-
ginal base scenario would behave as a child scenario. "Base Scenario" is the default name given 
in a new, single scenario model.

The Scenario Manager

Illustrated in Figure 1, the top of the Scenario Manager displays the scenario tree, showing the 
names of the currently defined scenarios, their relationship to other scenarios, and which is the 
current Workspace scenario (the current scenario is identified both as the scenario with a green 
check mark next to it and in AFT Fathom’s Status Bar). At the bottom, there is a place where you 
can record notes related to that scenario (propagates to children).

Those attributes whose value comes from a different scenario are linked, while those values 
coming from the selected scenario are not linked. Linked attributes will inherit changes made in 
the same object and attribute of the linked ancestor. This inheritance will occur over as many 
generations as the link exists.
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Figure 1: Scenario Manager on Quick Access Panel

Related Topics

Note: No scenarios have been set in the Multi-Scenario Output display 792
Creating, Organizing, and Editing Scenarios 509
Modifying Individual Scenarios 512
Scenario Inheritance 512
Running Models in Batch Mode 516
Open Model Using Last Scenario 517
Disconnected Scenario 517
Scenario Comparison Tool Overview 518
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Creating, Organizing, and Editing Scenarios
Scenarios are referred to as either a parent or child, plus the Base Scenario, which may be 
thought of as the root scenario. Upon opening a new model file, only a Base Scenario will be 
present.  To create a new scenario below the Base Scenario, right-click the Base Scenario and 
select Create Child.

Any scenario can be made current by double-clicking on it.

Figure 1 illustrates a model with a Base Scenario with two children, "English Units" and "Metric 
Units". These have three children, ‘3 inch Pipe’, ‘3.5 inch Pipe’ and ‘4 inch Pipe’, representing 
three different sized pipe runs. Each of these has one child scenario "Fire Flow"  and each of 
these, in turn, has two children, ‘North Hydrant Fire’ and ‘South Hydrant Fire’, for the two oper-
ating cases.

 
Figure 1: Scenario Manager Window
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‘English Units’ and ‘Metric Units’ were created by first selecting the Base Scenario and Creating 
a Child.‘3 inch Pipe’, ‘3.5 inch Pipe’ and ‘4 inch Pipe’ were created by first selecting the 'English 
Units' Scenario then Creating Children. 'Fire Flow' was created by  clicking on '3 inch Pipe' and 
creating the child. ‘North hydrant open’ and ‘South hydrant open’ were, in turn, created by select-
ing each of the above children scenarios for the three different pipe run sizes, then Creating Chil-
dren.

Note: Alternatively, one could have made the 'English Units' scenario current, created the ‘3 
inch Pipe’ child, then selected it and created the 'North Hydrant Fire' and 'South Hydrant 
Fire' scenarios below it, then, with '3 inch Pipe' still selected, selected Clone With Chil-
dren twice, then rename the new clones '3.5 inch Pipe' and '4 inch Pipe'.

The ‘North Hydrant Fire’ and ‘South Hydrant’ scenarios may be thought of as great great grand 
children of the Base Scenario. This concept of scenario ancestry is helpful in keeping track of the 
differences and similarities between scenarios discussed later.

A box with a plus sign next to a scenario indicates it may be expanded to reveal children scen-
arios while a box with a minus sign indicates the level is fully expanded with all children scen-
arios shown, if any.  No box indicates there are no children. Levels may be expanded by clicking 
on the plus sign and condensed by clicking on the minus sign.

Right-clicking a scenario provides the following choices:

 l Create Child with No Output - create child scenarios without results saving duplication 
and load time

 l Rename - renames the selected scenario
 l Delete Scenario - deletes the selected scenario
 l Delete All Children - deletes all children of the selected scenario
 l Clone Without Children - creates a copy of the selected scenario at the same level (a 

sibling). Cloning a scenario prompts the user for a name for the new scenario
 l Clone With Children - creates a copy of the selected along with its children. Cloning a 

scenario prompts the user for a name for the new scenario.
 l Insert Scenario Above Selected... - creates a new scenario where the selected scen-

ario is and shifts the selected scenario and its children down a level. This can be used to 
create a new base scenario. If this is done the user will be prompted to rename the pre-
vious base scenario.

 l Promote - raises a scenario one level, i.e. from a child to a sibling, active only for scen-
arios more than one level below the base scenario

 l Copy/Save Scenario Names
 l Copy Scenario Path Name - copy the fully-qualified name of the scenario to the 

Windows clipboard ("Base Scenario/Case 1/Child 3")
 l Copy Scenario Path Name With File Name - copy the fully-qualified scenario 

name along with the model name ("Model.fth :: Base Scenario/Case 1/Child 3")
 l Save Scenario Names Only to File... - copy all scenario names on separate 

lines, with indents to show child/parent relations
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 l Save Full Scenario Paths to File... - copy all scenario names on separate lines, 
with the full path name used for each scenario

 l Save Scenario to File Without Children - saves the selected scenario to a separate file 
without its children

 l Save Scenario to File With Children - saves the selected scenario and its children to a 
separate file

 l Compare to Active Scenario - compares all parameters for all objects between the 
selected scenario and active scenario and displays the Comparison Grid showing the res-
ults

 l Scenario Comparison Tool - opens the Scenario Comparison tool to create a custom 
scenario comparison

Note: It is important to remember that AFT Fathom’s Edit menu Undo does not apply to Scen-
ario Manager operations. To undo a Rename scenario operation, you can rename the 
scenario again to the old name. To undo a Clone or Save Scenario operation, you can 
delete the clone or file created. Once a scenario is deleted or promoted, there is no way 
to un-delete or un-promote the scenario.

Viewing Scenario Differences

Differences between scenarios can be viewed in two different ways. All data associated with any 
selection of scenarios can be viewed using the Scenario Comparison tool. Alternatively, a scen-
ario’s data compared to all of its direct ancestors can be viewed in the Model Data window. This 
functionality can be enabled in the Model Data Control window.

Output from different scenarios can also be displayed in the Output window using Output Control 
features.

Fast Scenario Changes

AFT Fathom remembers the most recent scenario you had open, and allows you to quickly 
change back to that scenario by using the Last Scenario feature. The Last Scenario feature is 
found on the Tools menu and the Common Toolbar.

Related Topics

Scenario Manager 507
Modifying Individual Scenarios 512
Scenario Inheritance 512
Running Models in Batch Mode 516
Open Model Using Last Scenario 517
Disconnected Scenario 517
Scenario Comparison Tool Overview 518
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Modifying Individual Scenarios
When first created, a scenario is identical to its parent. To modify or run a scenario, it must first 
be made in the current Workspace scenario by selecting it within the Scenario Manager window, 
then clicking on the Load As Current Scenario button.  (The name of the current scenario is dis-
played in both the Scenario Manager window and in AFT Fathom’s Status Bar.) Once a scenario 
is the current scenario, changes may be made to differentiate it from its parent using any of AFT 
Fathom’s editing tools and functions. When an attribute is changed within a scenario, it breaks 
the link for this attribute. Subsequent changes in the scenario’s ancestors will no longer affect 
this attribute.

Properties of a scenario that may differ from its ancestors include:

 l Presence and location of objects -- one may add or delete pipes and junctions within a 
scenario and the workspace locations may vary from scenario to scenario

 l Pipe and junction Properties - All values set in the Properties windows
 l Fluid Properties - Fluid, viscosity model, heat transfer, and laminar and non-Newtonian 

corrections
 l Steady Solution Control - Solution method, tolerances, relaxation
 l Output Control - Output window content and formatting
 l Cost Settings - Application of cost data
 l Transient Control (XTS Module Only) - Start and stop times for transient simulation                     
 l Goal Seek & Control (GSC Module Only) - Application of variables and goals can change 

between scenarios. The actual variables and goals are the same in all scenarios.                     
 l Library Manager - The connected library content can be varied between scenarios

Model Data Control and User Options apply to all scenarios.

Related Topics

Scenario Manager 507
Creating, Organizing, and Editing Scenarios 509
Scenario Inheritance 512
Running Models in Batch Mode 516
Open Model Using Last Scenario 517
Disconnected Scenario 517
Scenario Comparison Tool Overview 518

Scenario Inheritance
Scenario Manager will pass changes made in a scenario to linked attributes of its descendants, 
allowing multiple scenarios to be modified in one operation and maintain similarity between scen-
arios where desired.

Any attribute whose value is the same as that of the scenario’s parent is linked to the parent. In 
turn, if the parent’s attribute value is the same as that of its parent, then the child’s attribute is 
linked to its grandparent. This ancestral linking of attributes can exist across any number of 
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generations. A change made to a scenario will be passed downward to its children, grand-
children, etc., as far as the link exists. Changes are NOT passed upward from child to parent.

Once an attribute is changed within a scenario, the link is broken to that individual attribute. Sub-
sequent changes in the scenario’s ancestors, parent, grandparent, etc., will no longer affect that 
attribute, but all other attributes within the scenario will remain linked. The Model Data window 
with Scenarios enabled shows how the data changes between scenarios.

Scenario Logic Examples

For many users, it is easiest to grasp Scenario Manager when it is explained how the coding 
logic is actually implemented. Blank fields for children, grandchildren, etc., mean to look to 
the parent for the data. The Base Scenario never has blank fields (Table 1). Data only passes 
downwards, never upwards.             

Table 1: Blank fields for Child #1 and Grandchild #1 mean that the data is to come from the parent. If 
the Base scenario data is changed, all descendants are changed.

If a child scenario does not have a blank field, then data for that property is initiated at that scen-
ario level (see Table 2).

Table 2: Child #1 does not have a blank field, so it’s Diameter would be 2, not 3, as would Grandchild 
#1

If a scenario is changed, and its child has different data, then the change will not pass down-
wards (see Table 3). 
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Table 3: Changing the Base Scenario Diameter from 3 to 6 would not impact Child #1 or any des-
cendants in that line. Changing the Length from 25 to 40 would also change the length in Child #1, 

Grandchild #1, and any descendants of Grandchild #1.

If a child scenario has data that is different than the parent, its children cannot relink to the parent 
(see Table 4).

Table 4: Even if the Grandchild #1 has the same Diameter as the Base, it is not linked to the Base 
because it and its parent are not blank

If a child scenario’s data, which was previously changed and is thus different from the parent, is 
changed back to the same vale as the parent, the inheritance link is re-established (see Table 5). 
Its descendant’s link is also re-established.

Table 5: If the Diameter in Child #1 is changed to be the same as the Base, it will be "blanked out" 
the next time the scenario is loaded and the link re-established. And so will Grandchild #1, if its Dia-

meter is also the same
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Table 6 shows data for two pipe properties across three scenarios. The data that would be used 
when each scenario is loaded is as follows:

 l Base scenario
 l Diameter = 3
 l Length = 25
 l Changes to Diameter will not pass downwards
 l Changes to Length will affect only Child #1.

 l Child #1 scenario
 l Diameter = 2
 l Length = 25
 l Changes to Base Diameter will not affect Diameter
 l Changes to Base Length will affect Length

 l Grandchild #1 scenario
 l Diameter = 2
 l Length = 15
 l Changes to Base Diameter will not affect Diameter
 l Changes to Child #1 Diameter will affect Diameter
 l Changes to Base Length or Child #1 Length will not affect Length

Table 6: Input data for these properties explained in the text

Re-Establishing Broken Scenario Links

A link may be re-established by returning the attribute to the same value as that of its parent. 
This can be done manually by entering the value or selecting the Copy Data From Pipe list and 
selecting the Parent Pipe Data option. Within other data windows, it is done by selecting the 
Same As Parent option in  Output Control, Analysis Setup, or Library Manager

Since links are identified by comparing attribute values of pipes or junctions with the same Work-
space ID number, renumbering a scenario will break the links of all pipes and junctions 
renumbered. Since numbers must be unique, once a link has been broken by renumbering, it 
may not be re-established.

Related Topics

Scenario Manager 507
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Creating, Organizing, and Editing Scenarios 509
Modifying Individual Scenarios 512
Running Models in Batch Mode 516
Open Model Using Last Scenario 517
Disconnected Scenario 517
Scenario Comparison Tool Overview 518

Running Models in Batch Mode
AFT Fathom scenarios or models can be run in batch mode, a feature that is especially useful for 
running a group of scenarios or models during lunch or overnight.

To run models in batch mode, follow these steps:

 1. From the File menu, click Start Batch Run.
 2. Select the Batch Run Type. This is where you select if you want to run scenarios from the 

current model or different model files. If the current model does not have any scenarios, 
then only the second option will be available.

 3. If the Batch Run Type is Scenarios in Current Model, then click the Add Scenarios button 
and select the scenarios you wish to run.

 4. If the Batch Run Type is Models from Different Files, then the models can be selected indi-
vidually using the Add Model Files button, or loaded from a Batch File (by Choosing the 
Load Existing Batch File button). A Batch File is a text file listing all models you would like 
to run. At any time, a selected model file can be removed by clicking the Remove Selec-
tions button. The current list of models can be saved to a Batch File for use in the future by 
clicking the Save List to File button.

 5. The option can be chosen to Save Using Excel Export Manager by either saving to sep-
arate sheets, or saving the scenarios to separate workbooks. The Excel Export option can 
only be chosen if the batch run type is for Scenarios in Current Model. Additionally, the 
desired output must first be configured in the Excel Export Manager under the File menu 
for any data to be exported.

 6. Use the Output Options in the lower left to save the output data to a file and/or send it to a 
printer or Adobe PDF file. All reports will use the specified font.

 7. Check the box to Run Batch in Background if you wish for all selected scenarios to run 
without showing the Solution Progress window. AFT Fathom will run the simulations in the 
background and will not interrupt any work being done in other programs.

 8. Click the Start Run button to begin the batch run.

AFT Fathom then opens each scenario or model file in sequence, automatically runs each scen-
ario/model that has Analysis Setup fully defined, and sends results to the specified destination. 
All pertinent information that is generated during the batch run (such as error messages) are 
automatically displayed when the final scenario/model is finished. Output files generated from 
each scenario or model run is automatically saved before moving to the next run. 

The entire batch run can be canceled at any time by clicking the Cancel button in the Solution 
Progress window. Output from scenarios that have already been run is still retained when the 
Batch Run is canceled.

Note: You can view output from multiple scenarios concurrently in the Output window.
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Related Topics

Scenario Manager 507
Creating, Organizing, and Editing Scenarios 509
Modifying Individual Scenarios 512
Scenario Inheritance 512
Open Model Using Last Scenario 517
Disconnected Scenario 517
Scenario Comparison Tool Overview 518

Open Model Using Last Scenario
When the model is saved, the current scenario is remembered, and by default, reloaded when 
the model is opened again. Your preference of whether to always open the model to the most 
recent scenario or to the base scenario can be specified in the User Options window.

Related Topics

Scenario Manager 507
Creating, Organizing, and Editing Scenarios 509
Modifying Individual Scenarios 512
Scenario Inheritance 512
Running Models in Batch Mode 516
Disconnected Scenario 517
Scenario Comparison Tool Overview 518

Disconnected Scenario
A special type of scenario that is no longer connected to the Scenario Manager, created from the 
Tools Menu or from the Toolbar in the Output window. A disconnected scenario itself breaks the 
inheritance of normal child scenarios so that it is truly standalone scenario. No changes made to 
any parent scenario will propagate to this scenario. This is useful to preserve certain settings 
from a different scenario.

Disconnected Scenarios are denoted with (*). 

Related Topics

Scenario Manager 507
Creating, Organizing, and Editing Scenarios 509
Modifying Individual Scenarios 512
Scenario Inheritance 512
Running Models in Batch Mode 516
Open Model Using Last Scenario 517
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Scenario Comparison Tool Overview 518

Scenario Comparison Tool OverviewScenario Manager
Scenario Comparison Tool (accessed via the Tools menu) is a powerful tool that allows users to 
compare model parameters between scenarios in a given model. It lets users quickly identify dif-
ferences between two or more scenarios without needing to search through the model data for 
each scenario or inspect each element of the model. This tool can be especially powerful for 
users reviewing others' models, or for users returning to models after a period of time. It can also 
be powerful for troubleshooting purposes. The Scenario Comparison Tool lets you: 

 l Compare any two or more scenarios
 l Compare selected Pipes and Junctions between selected scenarios
 l Compare selected Pipe and Junction parameters between selected scenarios
 l Compare selected General Properties between selected scenarios

Related Topics

Accessing Scenario Comparison Tool 518
Modify Comparison 520
Scenario Comparison Grid 521
Scenario Manager 507
Creating, Organizing, and Editing Scenarios 509
Modifying Individual Scenarios 512
Scenario Inheritance 512
Running Models in Batch Mode 516
Open Model Using Last Scenario 517
Disconnected Scenario 517

Related Blogs

New Feature Highlight - Scenario Comparison Tool

AFT Fathom 11 New Features at a Glance

Accessing Scenario Comparison Tool
The Scenario Comparison tool can be accessed from the Scenario Manager, the Workspace, 
and the Tools menu. 

From the Scenario Manager

To set up a comparison from the Scenario Manager, first select the pipes and junctions to com-
pare in the workspace. Then, select the desired scenario to compare the current scenario to in 
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Scenario Manager

the Scenario Manager. Note the current scenario is indicated  by the green check-mark symbol. 
Right-click the desired scenario, and select Compare Selected Scenarios.... This will bring users 
to the Scenario Comparison window and display a grid with the differences between the selected 
objects in the two scenarios.

To modify the comparison use the Modify Comparison button at the bottom of the window.

From the Workspace

From the workspace, users can quickly select desired pipes and junctions in the scenario and 
compare them to those found in any other scenario. 

First, select the desired pipe(s) and/or junction(s) in the workspace. Then, right-click the Work-
space, choose Compare Scenarios, and select the desired comparison. This will bring users to 
the Scenario Comparison window and display a grid with the differences between the selected 
objects in the two scenarios.

To modify the comparison use the Modify Comparison button at the bottom of the window.

From the Tools Menu

From the Tools Menu, there are multiple options to generate the Scenario Comparison Grid.

A comparison grid can be directly generated by selecting the desired objects to compare in the 
Workspace, then selecting the scenarios to be compared from the Compare Scenarios menu 
option.

Alternatively, the Scenario Comparison Tool menu option can be selected to build a custom 
scenario comparison by directly selecting the scenarios, objects, and parameters to be included 
in the comparison. See Modify Comparison for more information on the available options.

Click the Show Comparison button at the bottom of the window to view the comparison. To make 
additional changes, use the Modify Comparison button at the bottom of the window.

Related Topics

Scenario Comparison Tool Overview 518
Modify Comparison 520
Scenario Comparison Grid 521

Related Blogs

New Feature Highlight - Scenario Comparison Tool
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Modify Comparison
Several Options are available to customize the Scenario Comparison Grid. These options are 
available from the Modify Comparison button at the bottom of the scenario comparison report, or 
by selecting Scenario Comparison Tool from the Tools menu. The Modify Comparison window is 
shown in Figure 1 below.

Figure 1: Scenario Comparison window options to Modify Comparison

Select Scenarios to Compare

The Scenario Comparison Tool has four pre-set templates for comparing scenarios, plus the abil-
ity to set up a custom comparison. These are:

 l Parent: This template compares the current scenario with that scenario's parent.
 l Ancestors: This template compares the current scenario with all of that scenario's direct 

ancestors. This setting would be similar to the comparison available in the Model Data 
window, though it does provide a more comprehensive comparison. 

 l Siblings: This template compares the current scenario with all of that scenario's siblings. 
 l Exhaustive: This template compares all of the scenarios in the model with each other. 
 l Custom: This option allows users to compare any two or more scenarios throughout the 

model. 

Select Pipe and Junction Properties

This section sets what parameters will be compared such as length, diameter, roughness, etc.
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Users can choose to compare a set of specified properties, or all pipe and junction properties by 
selecting the desired properties under Select Pipe and Junction Properties. Only properties 
selected in this section will be considered when the comparison is run.

A helpful option to filter the parameters to be displayed in the comparison is to display the para-
meters shown in the Model Data window. This can simplify the comparison, but might hide some 
differences between scenarios. Use the Model Data Control window to further define what para-
meters are shown with this option.

Select General Properties

This section sets what General Properties will be compared such as fluid properties, tolerances, 
etc.

Users can choose to compare all or a select set of general properties from the Analysis Setup 
window.

Select Pipes and Junctions

This section sets which pipes and junctions will be compared for the model.

Users can choose to compare all objects in the model, or a selected set of pipes and junctions. 
Users can manually select the desired objects, select those highlighted in the workspace, or use 
the Select Special tool to select desired groups or other sets of objects. 

Related Topics

Scenario Comparison Tool Overview 518
Accessing Scenario Comparison Tool 518
Scenario Comparison Grid 521

Related Blogs

New Feature Highlight - Scenario Comparison Tool

Scenario Comparison Grid
Choosing the Compare Selected Scenarios menu item from the right-click or Tools menu will 
bring the user directly to the Scenario Comparison Grid based on any selected Workspace 
objects and scenarios. The settings for the scenario comparison can be seen/modified by click-
ing Modify Comparison at the bottom of the window.

The tabular data from the report can be copied from and pasted to a separate file or worksheet 
using the Copy button at the bottom of the window.
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Figure 1: Default Scenario Comparison Report view

Filtering Options

When a large comparison is run, typically many of the objects/parameters in the model will be 
unchanged across scenarios, which may result in a large number of items with no differences. 
To help condense the Scenario Comparison Grid, several toggles are available at the top of the 
Item and Parameter columns which allow the user to show/hide rows in the grid. Switching the 
toggle to All will show all items or parameters being compared. If the toggle is set to differences, 
then only Items/Parameters that have a different value in at least one scenario will be shown. 
Thus, if both toggles are set to All, then all parameters will be displayed for all items. If both 
toggles are set to Differences, then only items that have parameters with different values will be 
shown, and only the parameters that differ will be displayed.

Color Coding

The cells in the Item and Parameter columns will be colored either yellow or green to indicate 
whether that item/parameter has differences between the scenarios being compared. Yellow 
indicates differences, while green indicates that no differences exist. Parameters will be colored 
yellow if the value of that parameter is different in at least one scenario that is being compared. 
Items will be colored yellow if at least one parameter that is being compared for that item has a 
different value in one or more scenarios.

The Highlight Unique Values toggle is used to color the values to visually link identical values. All 
values under the currently active scenario will remain grey, while values that have differences 
will be colored This is powerful to quickly see differences when more than two scenarios are 
being compared. If two scenarios have the same value for a parameter, the values will have the 
same shading. See Figure 2 below for an example.
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Figure 2: Scenario comparison showing differences only. Each unique value is highlighted with a dif-
ferent color to indicate which scenarios have differences from the currently active scenario, which is 

the North Hydrant scenario for this example.

Related Topics

Scenario Comparison Tool Overview 518
Accessing Scenario Comparison Tool 518
Modify Comparison 520

Related Blogs

New Feature Highlight - Scenario Comparison Tool
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Cost Calculation
AFT Fathom has the powerful ability to account for both recurring and non-recurring costs in your 
model.

The most common and easiest to account for recurring cost is Energy Cost. It is often desirable 
to reduce the electricity usage of pumps in a system, and AFT Fathom makes measuring this 
value easy.

In addition to energy usage, AFT Fathom can track other user-defined costs such as main-
tenance, installation, and material cost with a Cost Library.

Cost Calculation Procedure

Depending on what types of costs or what components of a model you wish to include this pro-
cess may change.

Note: This process only applies if the ANS Module is not enabled. To set up cost calculations 
with ANS, see the Assign Cost Libraries topic.

 1. Enable Cost Calculation from the Cost Settings panel in Analysis Setup.
 2. Specify the system life and energy cost in the Cost Settings panel.
 3. Junctions or pipes you wish to include in the cost calculation must be added to the Cost 

Report with the Cost tab in the object's Properties window.
 4. If you are calculating all costs (not just Energy), you will need to create Cost Libraries. To 

represent more complex Energy Cost, such as varying cost over time, you will need to cre-
ate an Energy Cost Library.

 5. Within the Cost Libraries, specific recurring or non-recurring costs will need be defined.
 6. These costs can be further refined to adjust automatically based on diameter, time, 

power, or Cv with Scale Tables.
 7. Review the application of costs with the Cost Application Manager and the Cost Summary 

window. It is important that the costs are being applied correctly.
 8. Run the model and view the cost totals with the Cost Report.

Related Topics

Cost Settings Group 168
Cost Settings Panel 168
Cost Application Manager 530
Scale Tables 532
Select Size From 534
Cost Definitions 535
Cost Libraries 538
Cost Summary Window 542
Custom Monetary Units 543
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Cost Report 544

Enabling Cost Calculation

Note: This topic does not apply for the ANS module. To set up cost calculations with ANS, 
see the Assign Cost Libraries topic.             

The first step in any cost calculation is to enable it in the Cost Settings panel. The following 
options are available:

 l Do not calculate - Selected by default.
 l Pump Energy Only - Only calculate the costs associated with the power consumption of 

pumps. The energy cost and system life must be entered in Cost Settings.
 l Calculate - Enable full calculation of costs. In addition to defining Cost Settings, Cost 

Libraries must be defined to use this feature.

Including Objects in Cost Report

Workspace objects must be included in the Cost Report to have their costs calculated. This 
allows only analyzing the cost of certain parts of the model - useful if only one pump is being 
replaced, or if an expansion to an existing system is being considered. To include the objects in 
the Cost Report simply select "Include Cost in Report" on the object's Cost tab, as shown below. 
Finer detail in how the Cost is included can be set by clicking the Cost Application button.

Figure 1: Include Cost in Report
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Energy Cost Library
Energy Cost Libraries allow users to input time varying energy costs. These energy costs can 
then be assigned to pumps, so that pump operation/energy costs can be calculated.

Creating an Energy Cost Library

When opening the Energy Cost Library window from the Library menu, you will be greeted with 
Figure 1. An Energy Cost Library either needs to be created or opened.

Figure 1: Energy Cost Library window

To create a new Energy Cost Library, click the New button. The Description field is mandatory, 
and the notes are optional. Select an alternate Monetary Unit if desired. Finally, save the library 
by clicking Save As and enter name for the *.ecd file. AFT Fathom will also prompt if the library 
should be connected and available - typically this is desired so the library can be used in the cur-
rently open model.
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Figure 2: New Energy Cost Library

Defining Energy Costs

Once an Energy Cost Library is opened, the Energy Costs tab allows costs to be added. Select 
New Cost to add costs to the library. In Figure 3, costs have been added to represent a varying 
electricity cost over night and day. If the Cost Time Period exceeds the time defined in the 
Energy Cost Library, the pattern will start over at zero. That is, for the above example if the Cost 
Time Period was one year the defined 24 hour cost cycle would repeat 365 times.

The Cost Scaling column allows a Scale Table to be applied to a cost, as discussed below.
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Figure 3: Energy Costs

Scale Tables

You can add a time-based multiplier to an Energy Cost Library on top of the normal Energy 
Costs if desired. The Scale Table can be used, for example, to represent the increasing cost of 
electricity year by year. See the Scale Tables topic for more information.

For energy cost libraries, the Scale Tables are limited to entering a multiplier over time.

Applying Energy Costs in the Model

The following must be completed to view the Operation/Energy column in the Cost Report:

 l The Cost Settings panel in Analysis Setup must have the following definitions:
 l Cost Calculation set to either Pump Energy Only or Calculate
 l Cost Definition checkbox enabled for Operation/Energy
 l Energy Cost set to Use Energy Cost Libraries
 l Cost Time Period must have a non-zero System Life

 l Pump junctions must have the appropriate selection from the Library Jct dropdown
 l Cost tab of each Pump Properties window must be set to Include Cost in Report
 l Output Control must have the Operation Costs parameter added under the Cost Report
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Library Connection

Creating a new Energy Cost Library will prompt connecting it automatically. If for whatever 
reason an existing Library is not connected in can be manually connected with the Library Man-
ager.

Cost Application Manager

Note:: This topic does not apply for the ANS module. To set up cost calculations with ANS, 
see the Assign Cost Libraries topic.             

The Cost Application Manager, accessed from an object's Cost tab, allows the user to do the fol-
lowing:

 l Choose which cost libraries will be applied to each pipe and junction
 l Note that if multiple libraries are applied, costs from ALL of the selected libraries 

will be included.
 l Choose when each pipe’s or junction’s life will start and/or end
 l Specify fractional cost multipliers to be applied (for cases such as pump energy when the 

pump operates only part of the time)

The Cost Application Manager can also be accessed from the Tools menu - in which case it will 
show data for all Workspace objects.
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Figure 1: Cost Application Manager

How Duplicate Costs are Handled

To maximize flexibility for the user, multiple cost libraries can be connected to the same engin-
eering library. What happens if there is cost data for the same engineering item in each library? 
For example, assume an engineering library, pump.dat, exists with a specific pump "PumpCo 
Model 100A". 

Two cost libraries exist based on pump.dat: 

 l maxcost.cst ("PumpCo Model 100A" installation cost = $1000)
 l bestcost.cst ("PumpCo Model 100A" installation cost = $750)

If both of these libraries are connected, and All Connected Libraries are applied to the pump, 
AFT Fathom will interpret the cost for "PumpCo Model 100A" as the sum of the two: $1750.

There will be occasions you want cost items to be summed, and other cases where you do not. 
Obviously, if you have two libraries, one that tracks the maximum cost and the other that tracks 
the "best" cost of an item, you want to use only one cost at a time and not have the costs 
summed. This can be accomplished with the Cost Application Manager, by selecting only the 
desired library to apply.

However, perhaps the two acquisition costs do not represent the same item, but rather represent 
partial costs of that item that you want to maintain separately. For example, one library may con-
tain costs of the pump and its casing, while another may contain cost for the motor. A third might 
contain cost for a variable speed drive. When managed in this way, you want the costs to be 
summed.
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Related Topics

Cost Calculation 525
Scale Tables 532
Select Size From 534
Cost Definitions 535
Cost Libraries 538
Cost Summary Window 542
Custom Monetary Units 543
Cost Report 544

Scale Tables
 l Scale tables have a type (time or size) and a format (multiplier or cost). "Size" can refer to 

diameter, power, or Cv.
 l Diameters can be quickly found and entered using the Select Size From button.
 l The type of scale table defines the parameter that controls the variation in cost. For 

example, increasing diameter would generally cause an increase in cost, or energy prices 
may be projected to increase or decrease with time.

 l Time type tables only accept the multiplier format.
 l All scale tables require both a cost and a multiplier to determine the final cost value. Mul-

tiplier format tables require a base cost in the cost definition, cost format tables require a 
base multiplier.

 l One scale table can be applied to multiple cost items - pipe materials, junctions, or fittings 
& losses.
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Figure 1: Scale table example of a table of costs (Diameter inches vs U.S. Dollars)

Energy Cost Libraries

Changes in Energy Cost over time can be captured with a scale table. Only time type scale 
tables can be applied to an Energy Cost Library.

Cost Libraries

Scale tables are applied in the cost definition area of the Cost Library window. Pipe Materials 
only accept time scaling tables for recurring cost (shown in Figure 2)

Figure 2: Time Scaling table applied to recurring cost

Fittings & losses and junction non-recurring costs can accept size scaling tables. Only one table 
can be applied to a cost item. The selection of a table of multipliers will require a base cost, and 
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the selection of a table of costs requires a base multiplier (default of 1). This is demonstrated 
below.

Figure 3: Applying size tables to fittings & losses

Recurring costs can include both a size scaling table and a time scaling table, like in Figure 3. 
This would allow you to specify one base cost and use scale tables to represent both a range of 
sizes and an increasing cost over time, for example. Specifying both types of tables would be 
useful for a sizing calculation with the ANS module, where cost is being minimized by varying 
the size.

Related Topics

Cost Calculation 525
Cost Application Manager 530
Select Size From 534
Cost Definitions 535
Cost Libraries 538
Cost Summary Window 542
Custom Monetary Units 543
Cost Report 544

Select Size From
The Select Size From button opens the Nominal Diameter window, which allows you to quickly 
obtain the inner diameter for a nominal size and schedule. The Diameter window is called from 
the Scale Tables window.
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Figure 1: Nominal Diameter selection

Selecting a size and clicking OK enters the Inner Diameter into the currently selected Scale 
Table row.

Related Topics

Cost Calculation 525
Cost Application Manager 530
Scale Tables 532
Cost Definitions 535
Cost Libraries 538
Cost Summary Window 542
Custom Monetary Units 543
Cost Report 544

Cost Definitions
Depending on the contents of the associated Engineering Library there are tabs for Pipe Mater-
ials, Junctions, and Pipe Fittings & Losses. Each of these tabs serves the same purpose in 
slightly different ways - allowing the definition of costs for a certain component.

First, select a component of a certain type or size in the upper-left of the window. Then, click on 
the New Cost button. A new cost item is created in the table below as a new column. Some cells 
are displayed in black, which means that are not relevant to the type of entry selected.

Costs can be:

 l Material (NR)
 l Installation (NR)
 l Maintenance (R)
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where the (NR) and (R) indicate Non-Recurring and Recurring. Non-Recurring Costs are cal-
culated as a sum total for the model, whereas Recurring costs require a time period and a total 
system life, as defined in the Cost Settings panel of Analysis Setup.

These costs are on either a per-item, per-length, or time basis. The costs can further be adjusted 
with Scale Tables.

Pipe Materials Costs

Figure 1: Cost Definitions for a Pipe Material

The Pipe Materials tab shows all the pipes in the engineering cost library. Costs can be entered 
at several levels. You can enter costs at the material level, the nominal size level, and finally at 
the type (e.g. schedule) level. Costs entered at the material apply to all pipes nominal sizes and 
types in that material type. Costs entered at the nominal size level apply to all schedules within 
that nominal size. Costs entered at the type level apply only to that type.

To make this process easier, values can be imported or exported to excel. The easiest way to 
import cost data from Excel is to first export the desired pipe Sizes and Types. Only the currently 
selected Sizes and Types will be exported (if the Pipe Material is selected, all will be exported) 
with any currently defined cost information included.
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Figure 2: Excel Sheet for Importing Cost Definitions

The empty columns for cost per unit length can be filled in where cost data is required - it is not 
necessary to supply data for every cost, or for every Size/Type. After saving this sheet, the data 
can be imported directly with "Import from Excel."

Recurring costs for Pipe Materials can be modified with a Time Scaling Table.

Junctions Costs

Costs can be entered for all junction types except the volume balance.

Figure 3: Cost Definitions for a Bend

Above is an example of entering cost data for a bend junction. Junction costs can also be 
entered at a higher level. For example, you can apply a cost to all Smooth Flanged Elbows.
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Junction costs can be scaled with a Table of Multipliers, Table of Costs, or a Time Scaling Table.

The behavior of certain junctions varies slightly:

 l Pumps - Cost can be entered per item (pump) or per Power. This will allow an approx-
imate scaling for the size of the pump on a more reasonable basis than diameter.

 l Control Valves - Costs can be entered per item or diameter. With a Scale Table, costs 
can be scaled based on Cv.                     

 l Other Junctions - Costs can be entered per item or diameter. Scaling tables can also be 
used on a diameter basis.

Pipe Fittings & Losses Costs

Cost specification functions the same as non-pump junctions, with the exception that fitting & 
loss costs can be associated with a particular pipe material and size. Since the pipe fitting & loss 
engineering library is included only in the AFT Fathom internal library, cost data for pipe fittings & 
losses can only be entered when the cost library is associated with the internal engineering lib-
rary – unless you add your own custom fittings & losses to an engineering library. Then cost lib-
raries can be associated with that library as well.

Related Topics

Cost Calculation 525
Cost Application Manager 530
Scale Tables 532
Select Size From 534
Cost Libraries 538
Cost Summary Window 542
Custom Monetary Units 543
Cost Report 544

Cost Libraries
AFT Fathom can track user-defined costs such as maintenance, installation and material cost 
with a Cost Library.

Note that AFT Fathom is not designed as a cost estimator. Instead, user-defined cost data can 
be used to compare different designs to determine which one has a lower cost. Like all parts of 
the model, the results of a cost calculation depend on how the costs have been defined by the 
user.

Relationship to Engineering Libraries

AFT Fathom uses Engineering Libraries to create collections of standardized components.
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Cost Libraries must be created based on an engineering library to provide user-defined cost val-
ues for components in the engineering library. There can be multiple cost libraries for each engin-
eering library. This allows cost data sets to be maintained separately from the engineering data. 
This can be useful for maintaining costs in different currencies or differences based on geo-
graphical location or times of the year.

Figure 1: Relationship between Cost and Engineering Libraries

Like Engineering Libraries, Cost Libraries must be connected to be used. See Library Manager 
for information on how to connect libraries. Newly created cost libraries are connected auto-
matically.

Edit Cost Library Window

The Edit Cost Library window is opened from the Library menu. This window allows you to create 
a cost library for items that are in a specific engineering library. Costs can be entered for pipes, 
junctions, and pipe fittings & losses. 

On the General tab, a cost library can be created with the New button, or an existing library can 
be accessed with one of the Open buttons.
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Figure 2: General tab of Edit Cost Library Window

Clicking New brings up the following window:

Figure 3: Select Library Window
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All Cost Libraries need to be associated with an Engineering Library. After selecting a library, the 
Edit Cost Library Window will change to allow you to enter information into the newly created 
Cost Library.

Figure 4: Edit Cost Library Window - New Library

A Description is required for all Cost Libraries, which is displayed as the library's name in the 
Library Manager. Multipliers can be set for all items in the cost library using the Multipliers on 
Cost Items table. Notes are optional.

Cost Definitions

Depending on the contents of the associated Engineering Library there are tabs for Pipe Mater-
ials, Junctions, and Pipe Fittings & Losses. Each of these tabs serves the same purpose in 
slightly different ways - allowing the definition of costs for a certain component. See Cost Defin-
itions for a detailed explanation.

Summary

The summary tab allows for an easy way to quickly review what has been defined in a cost lib-
rary. This is different than the Cost Summary Window, as this summary is a listing of all items 
defined as costs, whereas the Cost Summary Window lists objects in the model with costs 
applied to them.

The costs are grouped by type, and only defined costs are shown. An example of defined costs 
on a Pipe Materials library is shown below.
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Figure 5: Cost Summary

Related Topics

Cost Calculation 525
Cost Application Manager 530
Scale Tables 532
Select Size From 534
Cost Definitions 535
Cost Summary Window 542
Custom Monetary Units 543
Cost Report 544

Cost Summary Window

Note:  This topic does not apply for the ANS module. To set up cost calculations with ANS, 
see the Assign Cost Libraries topic.

The Cost Summary window, opened from the Tools menu shows all connected cost libraries and 
energy cost libraries, and which pipes and/or junctions are obtaining costs from each library.
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Figure 1: Cost Summary Window

Related Topics

Cost Calculation 525
Cost Application Manager 530
Scale Tables 532
Select Size From 534
Cost Definitions 535
Cost Libraries 538
Custom Monetary Units 543
Cost Report 544

Custom Monetary Units
New Monetary Units can be added with the following steps:

 1. Open User Options from the Tools menu
 2. Under Unit Systems, select Show/Hide Unit Items
 3. In the Unit Family Type list box, select Monetary Units
 4. The Custom Units button will appear on the right, select New
 5. Enter the name, description and conversion to U.S. Dollar in the appropriate fields.
 6. Click OK
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The new Monetary units can be specified as your default units and used in Cost Libraries. If you 
do have a mixture of cost libraries with different Monetary Units, the conversion factors to U.S. 
Dollars will need to be updated before the cost is calculated.

Figure 1: Custom Unit Edit Window

Related Topics

Cost Calculation 525
Cost Application Manager 530
Scale Tables 532
Select Size From 534
Cost Definitions 535
Cost Libraries 538
Cost Summary Window 542
Cost Report 544

Cost Report
The Cost Report is a detailed list of all costs for the system displayed on the Cost Report tab in 
the General section of the Output window. The content of the Cost Report can be customized in 
the Output Control window on the Display Parameters tab and the Format & Actions tab.

The grand total cost is shown on the top line, with subtotals for each category on the second line. 
In the main table area costs for each pipe, junction, and pipe fitting & loss included in the cost cal-
culation are shown.

Output Control Format & Action allows you to hide items that have zero cost, group costs by 
pipe, or show only the subtotals for each category. You can also edit the number of decimal 
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places shown, or adjust the costs to be truncated to be shown in terms of hundreds, thousands, 
etc. instead of showing the full number. 

Figure 1: The Cost Report is displayed in the General section of the Output window

Using the Library Sources Tables

AFT Fathom displays the source of all cost data in a run, and you are strongly encouraged to 
review this data to verify that the solution was based on the appropriate cost data.

In the Output window, the sources of all cost data are displayed for each pipe and junction in the 
Library Sources table. Figure 2 shows the Library Sources for an example case.

Figure 2: Library Sources table for pipes

Related Topics

Cost Calculation 525
Cost Application Manager 530
Scale Tables 532
Select Size From 534
Cost Definitions 535
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Cost Libraries 538
Cost Summary Window 542
Custom Monetary Units 543
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Add-on Modules
AFT Fathom has four optional add-on modules which extend its modeling capabilities into other 
areas. The modules allow multivariable goal seeking and control simulation, settling slurry mod-
eling, time varying simulation, and full system sizing. The Modules panel within the Modules 
group in Analysis Setup allows you to activate and enable any of the four AFT Fathom add-on 
modules. An additional license to the base AFT Fathom license is required to use a module. 
These modules include:

 l GSC (Goal Seek & Control) - Identifies input parameters that yield desired output values 
and simulates control functions.

 l SSL (Settling Slurry) - Models the effects of pumping fluids containing settling solids using 
the Wilson/GIW method.

 l XTS (Extended Time Simulation) - Models dynamic system behavior and how critical sys-
tem parameters vary over time.

 l ANS (Automated Network Sizing) - Evaluates the complex interaction of system variables 
to reveal combinations of cost savings.

Related Topics

Modules Group 79
Modules Panel 80

GSC - Goal Seek & Control

What is the GSC Module?

An optional add-on module to AFT Fathom which allows users to perform multi-variable goal 
seeking and simulate system control functions.

Many engineering modeling tasks involve more than just directly solving a system. In some 
cases a manual, “cut and try” method of changing input variables to achieve desired operating 
results is required. When a single parameter is being changed, the manual process (while tedi-
ous and time consuming) can be used successfully. However, varying two or more parameters 
at the same time quickly becomes impractical.

The GSC module automates the process of changing input variables to achieve desired design 
goals. For single variable situations, the GSC module offers the advantage of being much faster 
than manual methods. Further, it provides a practical tool for solving cases when there are two or 
more variables.

How Does the GSC Module Work?

The GSC module employs numerical optimization technology like that used in the AFT Fathom 
ANS Module. The optimization engine employed by the AFT Fathom GSC module uses state-
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of-the-art optimization technology licensed from Vanderplaats Research and Development, the 
leading company in optimization technology. However, rather than minimizing some function 
value such as system cost or weight, the GSC module satisfies equality criteria using “goal pro-
gramming” methods.

The core hydraulic solution in AFT Fathom is performed by the Hydraulic Solver. In standard 
AFT Fathom usage, the Hydraulic Solver is called once to solve a system. The GSC module’s 
Numerical Optimizer is used to call the Hydraulic Solver repeatedly, thus solving a series of mod-
els with different inputs. The Numerical Optimizer adjusts the user specified Variables in order 
force the Hydraulic Solver output values to agree with the user specified Goals. Figure 1 depicts 
the relationship between the different components.

Figure 1: The GSC module flowchart shows how the Hydraulic Solver is called repeatedly in an iter-
ative loop

Using the GSC Module

The user has the option of activating or not activating the GSC module when AFT Fathom first 
loads. After AFT Fathom is loaded, the GSC module can be activated or deactivated for use 
from the Modules panel in the Analysis Setup window or the Tools menu. Whether or not GSC is 
activated impacts the View menu, Analysis menu, Model Data window, Solution Progress win-
dow, and Output window as is discussed in the Modules panel topic. 

If the GSC module is active, the user can still run models without goal seeking. This is selected 
under Goal Seek & Control on the Analysis menu. Hence there are three possibilities for GSC. 

 l GSC is not active
 l GSC is active and goal seeking is ignored
 l GSC is active and goal seeking is performed

Related Topics
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Modules Panel 80
Add-on Modules 547
Goal Seek and Control Group 146
Variables Panel 146
Goals Panel 152
Numerical Controls Panel 158
GSC in Model Data 549
GSC in Solution Progress 551
GSC in Output 552
GSC in Scenarios 553
Changing Input Values to GSC Results 553
GSC Troubleshooting 554

GSC Module
Goal Seek and Control Module
An optional add-on module to AFT 
Fathom which allows users to per-
form multi-variable goal seeking 
and simulate system control func-
tions.
Solver
The part of AFT Fathom that 
applies the governing incom-
pressible flow equations to obtain a 
solution to the pipe system.

GSC in Model Data
(GSC Module Only) When the GSC module is active, the Model Data window displays a list of 
all variables and goals in the General section. This is useful for documentation purposes. See 
Figure 1.             
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Figure 1: Model Data window shows the variable and goal input data

Related Topics

GSC - Goal Seek & Control 547
GSC in Solution Progress 551
GSC in Output 552
GSC in Scenarios 553
Changing Input Values to GSC Results 553
GSC Troubleshooting 554
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GSC in Solution Progress
(GSC Module Only) When a model is run with GSC active, an additional line will be shown in the 
Solution Progress window to indicate the progress that the GSC module has made towards 
reaching the specified goal. There are three fields displayed, as can be seen in Figure 1 below.             

The "Best (Lowest)" and "Current" fields indicate the relative difference between the GSC iter-
ations and the goal. The "Current" field shows the difference for the current iteration, and the 
"Best" field tracks the difference for the iteration that had the smallest difference from the goal. 
Both fields start at 100, as the initial iteration is the farthest from the goal. Both fields will 
decrease in magnitude as GSC proceeds closer to reaching the goal value. If these numbers 
are not significantly changing when the model is run, this is an indication that GSC may not be 
able to reach the goal with the current model settings. See the Goal Seek and Control 
Troubleshooting topic for more information on resolving this.

The field on the far right of the GSC Calls to Solver line tracks the total iterations performed by 
GSC. For every GSC iteration, GSC makes a call to the hydraulic solver in Fathom to determ-
ine the hydraulic solution with the adjusted value of the GSC variable. Thus, this value will 
always be smaller than the flow and head iterations.

Figure 1: The Solution Progress window has an additional line to show information on the GSC Calls 
to Solver when the Fathom model is run with GSC enabled

Related Topics
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GSC - Goal Seek & Control 547
GSC in Model Data 549
GSC in Output 552
GSC in Scenarios 553
Changing Input Values to GSC Results 553
GSC Troubleshooting 554

GSC in Output
(GSC Module Only) The results for a Goal Seek & Control run are displayed in the Output win-
dow in the general section in two tables called GSC Variables and GSC Goals (see Figure 1).             

Figure 1: Calculated GSC Variables table (top) shows values required to achieve goals. GSC Goals 
table (bottom) shows user’s goals and actual values achieved (these should match).

Related Topics

GSC - Goal Seek & Control 547
GSC in Model Data 549
GSC in Solution Progress 551
GSC in Scenarios 553
Changing Input Values to GSC Results 553
GSC Troubleshooting 554
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GSC in Scenarios
GSC variables and goals will appear in all scenarios. In other words, you cannot create a vari-
able or goal that will appear in some scenarios and not others. Deleting a variable or goal in one 
scenario will delete it in all scenarios. However, the application of variables and goals can differ 
from scenario to scenario. This allows you to perform goal seeking with different variables and 
goals being used in different scenarios.

Related Topics

GSC - Goal Seek & Control 547
GSC in Model Data 549
GSC in Solution Progress 551
GSC in Output 552
Changing Input Values to GSC Results 553
GSC Troubleshooting 554

Changing Input Values to GSC Results
(GSC Module Only) As discussed previously, the Output window GSC Variables tab indicates 
how the input parameters must be varied to satisfy the goals. Once you have these results, you 
may want to keep and use them in the model. There are two ways to do this: Transferring Res-
ults to Initial Guesses and generating a Disconnected Scenario.             

Transferring Results to Initial Guesses

In general, the Output window supports a feature called Transfer Results to Initial Guesses. This 
is available on the Edit Menu. When used without the GSC module, it transfers calculated res-
ults for flow, pressure and temperature to the initial guess values of the pipes and junctions. 
When used after a GSC run it gives you three options: to transfer the GSC Variable Data, the 
calculated results, or both.

If you choose either of the first two options that transfer GSC Variable Data, the junction data on 
the Properties Window will be changed to the GSC Variable results. This means that one could 
then choose to Ignore goal seeking, rerun the model, and obtain the same results as before. The 
options to transfer the calculated results will transfer the pipe and junction results to the initial 
guesses field, similar to what would be done if the GSC module were not enabled.

Generating a Disconnected Scenario

Generating a disconnected scenario is ideal for GSC results in that it may not make sense to 
save the GSC results for future use if the model can otherwise be changed in arbitrary ways - if 
the model were changed the GSC results would be invalidated, meaning the user would need to 
rerun GSC.
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For example, assume a GSC run is made to find the valve open position required to achieve a 
certain flow. If this result is saved, and then the pipe size is later changed, the valve open pos-
ition would no longer supply the desired flow.

Creating a disconnected scenario helps prevent changes to the scenario since disconnected 
scenarios cannot be changed by propagated changes from other scenarios.

Related Topics

GSC - Goal Seek & Control 547
GSC in Model Data 549
GSC in Solution Progress 551
GSC in Output 552
GSC in Scenarios 553
GSC Troubleshooting 554

GSC Troubleshooting
(GSC Module Only) See the below topics for more information on troubleshooting issues with 
the GSC module:

 l When Goals Cannot Be Achieved
 l Goal Seek and Control Adjustments
 l What To Do if the Solver Gets Stuck in GSC
 l Goal Seek and Control Inconsistencies

Related Topics

GSC - Goal Seek & Control 547
GSC in Model Data 549
GSC in Solution Progress 551
GSC in Output 552
GSC in Scenarios 553
Changing Input Values to GSC Results 553

When Goals Cannot Be Achieved
(GSC Module Only) In some cases the GSC module may not be able to achieve a goal. This 
can happen for the following reasons:             

 l A goal is not physically realistic
 l A better starting point is needed for the input values assigned as GSC Variables
 l Hydraulic solution tolerances or optimizer numerical parameters require adjustment

In such cases, the goal will not be satisfied in the results. In other words, the Actual Goal Value 
and User Goal Value will differ (Figure 1). 
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In all cases the user will be warned when goals were not met. Figure 1 shows the Output window 
with such a warning.

Figure 1: Warning display in Output window when a goal cannot be met

Physically Unrealistic Goals

It may be possible that a goal is not achievable because it is not physically possible. For 
example, a pump may be too small to satisfy a flow rate goal at some pipe. 

To determine whether a goal is unrealistic, try changing the goal and rerunning the model. If the 
goal can be met in some cases and not others, this is an indicator that the original goal was 
unrealistic.

Better Starting Point Needed

In some cases the goal may be so far away from the original model that the GSC module has dif-
ficulty finding a solution. This is not common, but it is worth trying to adjust the starting point of 
parameters which are being varied.

Changing Control Parameters

The Numerical Optimizer determines goal search directions by approximating a gradient based 
on perturbed variable values. By default it uses a central difference approximation, but forward 
difference can also be used. If the hydraulic solution is not converged to a sufficiently small tol-
erance, the gradient approximation will not be sufficiently accurate and hence a good search dir-
ection cannot be obtained. The end result is that the goal seeking fails.
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There are two general area that can be changed in such cases: the hydraulic solution tolerances 
in the Steady Solution Control group and Numerical Controls panel in Analysis Setup.

In the next few sections recommendations on how to manually change these parameters will be 
given. However, before making a manual change it is worthwhile to try the automated parameter 
adjustment feature.

Figure 1, bottom picture, shows the warning when a goal is not met, and also shows a recom-
mendation and suggest pressing the F2 key. When doing so, a window appears as shown in Fig-
ure 2. This window will offer up to three options for automatic parameter adjustment. Accepting 
the default values is typically a good starting point. Click OK, and rerun the model.

The purpose of the window shown in Figure 2 is to simplify making common changes to resolve 
goal seeking problems.

 
Figure 2: When goal seeking fails, pressing the F2 key will show this window which allows the user 

to automatically implement recommend numerical parameter adjustments

Caution: The user should be very cautious in manually changing parameters in the Steady 
Solution Control Group and Numerical Controls panel. Making changes without a good 
understanding of the parameters involved can lead to incorrect results.

 l Changing Tolerance on Tolerance panel - By default AFT Fathom uses Relative Tol-
erance criteria set to 0.0001 (see Figure 3). Goal seeking convergence can sometimes be 
improved by reducing these values to 0.00001 or 0.000001.

 l See Iterations panel for a more in-depth discussion.
 l Changing Goal Seeking Numerical Controls - Figure 4 shows the Numerical Controls 

panel in Analysis Setup. The most useful parameter one can adjust is the Relative Finite 
Difference Step Size. Using values between 0.01 and 0.001 are recommended. In some 
cases using a value as high as 0.1 may be tried.
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Figure 3: Reducing  tolerance may resolve goal seeking difficulties

Figure 4: Changing certain numerical control parameters in the Numerical Controls panel in the Goal 
Seek and Control group may resolve goal seeking difficulties

Related Topics

What To Do if the Solver Gets Stuck in GSC 558
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GSC Adjustments 559
GSC Inconsistencies 559
GSC Troubleshooting 554
Goals Panel 152
GSC Goal may not be valid. User goal = X. Final goal result = Y. 784

What To Do if the Solver Gets Stuck in GSC
(GSC Module Only) Occasionally the user may have specified a goal which is in fact physically 
realistic, but in the process of going from a physically realistic starting point to a similarly phys-
ically realistic goal, a physically unrealistic system may be proposed by the Numerical Optimizer. 
What happens in such cases?             

When performing goal seeking with the GSC module, AFT Fathom has been designed to grace-
fully handle such cases. One of two things will typically happen:

 l The Hydraulic Solver will experience a computational error
 l The Hydraulic Solver will not be able to converge 

In the first case, AFT Fathom does not stop and tell the user of the error, but instead sets an 
internal flag that the system used for the particular iteration that caused the error was a poor sys-
tem and should not be considered further by the Numerical Optimizer. In other words, it skips the 
system that caused the error. This will happen in a way which is transparent to the user and 
requires no intervention.

The second case is of more interest here. In this case the Hydraulic Solver gets stuck on one of 
the systems proposed by the Numerical Optimizer and cannot progress. The Hydraulic Solver 
will continue trying to converge until it reaches the iteration limit. Once it reaches that limit, it will 
react in a similar way to the first case above – it will set a flag and skip that system.

However, the default maximum number of iterations is 50,000 (specified on the Iterations panel 
in Analysis Setup). It is perfectly fine for one to wait until this limit is reached and allow the AFT 
Fathom to handle the situation automatically, but depending on the size of the model it may take 
awhile to get to 50,000 iterations. In such cases it may be desirable to allow AFT Fathom to more 
quickly conclude the model that will not converge by reducing the maximum iterations to some-
thing like 5,000.

Tip: If the Hydraulic Solver appears to get stuck while performing a GSC run, you can pause 
the Solver, open the Iterations panel, and reduce the Maximum Iterations. The default 
value is 50,000. Depending on the model size, a reduced value of 5,000 may be appro-
priate.             

Related Topics

When Goals Cannot Be Achieved 554
GSC Adjustments 559
GSC Inconsistencies 559
GSC Troubleshooting 554

GSC Module
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Goal Seek and Control Module
An optional add-on module to AFT 
Fathom which allows users to per-
form multi-variable goal seeking 
and simulate system control func-
tions.
Solver
The part of AFT Fathom that 
applies the governing incom-
pressible flow equations to obtain a 
solution to the pipe system.

GSC Adjustments
(GSC Module Only) When a GSC run results in the goals not being met, the user may want to 
adjust GSC Numerical Controls or Solution Control parameters. These can be automatically 
adjusted after a run if a warning has been displayed and the user is prompted to press the F2 
function key. When the user does this, recommended changes are offered which the user can 
choose to have automatically applied.             

The changes will affect either the Numerical Controls panel, Tolerance panel, and/or Iterations 
panel.

Related Topics

When Goals Cannot Be Achieved 554
What To Do if the Solver Gets Stuck in GSC 558
GSC Inconsistencies 559
GSC Troubleshooting 554

GSC Inconsistencies
If an object in the Variables panel in Analysis Setup is defined with a parameter that has not been 
defined in that object's property window, an error will appear stating "Junction XX does not have 
XX parameter modeled. Cannot use as a GSC variable."

In this case, the user may resolve this inconsistency by either selecting a different parameter for 
the variable in the Variables panel, or by changing the specified junction to be defined using the 
specified variable. Note the properties window for the junction can be opened directly by double-
clicking the far left column of the row on the Variables table.

Related Topics

When Goals Cannot Be Achieved 554
What To Do if the Solver Gets Stuck in GSC 558
GSC Adjustments 559
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GSC Troubleshooting 554

SSL - Settling Slurry

What is the SSL Module?

An optional add-on module to AFT Fathom which allows users to simulate settling slurries.

Settling slurries are fluids which carry solids of relatively large size which cannot be suspended 
in the liquid under all conditions. At sufficiently low velocities the solid particles will settle to the 
bottom of the pipe and may ultimately plug the pipe completely. It is important to predict the beha-
vior of such flows to avoid settling conditions and economically move the fluid and solids through 
the pipe.

The SSL module allows users to predict the behavior of settling slurries within the framework of 
the powerful AFT Fathom software. The SSL module allows users to specify solid particle prop-
erties, distribution and concentration. State-of-the-art correlations are then used to predict the 
flow, pressure drop and reduced pump performance when pumping solids.

Special output reports and system curve generation are available to assist the user with under-
standing the hydraulic behavior of the slurry.

The SSL module can work in conjunction with the other AFT Fathom modules. The XTS module 
allows users to model slurry flows of constant concentration which vary over time. The GSC 
module allows users to vary input parameters automatically to achieve desired output para-
meters.

How Does the SSL Module Work?

The SSL module offers additional input windows where users can enter the properties of the 
solid particles. The SSL module takes the properties of the solid particles and carrier fluid (which 
is often water but can be another fluid) and calculates the hydraulics of the piping and pumps 
using widely accepted correlations.

Predicting the flow of settling slurries depends heavily on correlations based on experiment. 
Such predictions are inherently less accurate than standard clear fluid pipe flow.

Using the SSL Module

The user has the option of activating or not activating the SSL module when AFT Fathom first 
loads. After AFT Fathom is loaded, the SSL module can be activated or deactivated for use  from 
the Modules panel in the Analysis Setup window or the Tools menu. Whether or not SSL is activ-
ated impacts the Analysis menu, Library menu and Output window as is discussed in the Mod-
ules panel topic.

If the SSL module is active, the user can still run models without slurries. This is selected under 
Slurry Modeling on the Analysis menu. Hence there are three possibilities for the SSL module. 
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 l SSL is not active
 l SSL is active and slurry calculation is disabled
 l SSL is active and settling slurry calculation is performed

Related Topics

Modules Panel 80
Add-on Modules 547
SSL Module Fluid Properties Group 130
Carrier Fluid Panel 131
Solids Definition Panel 132
Slurry Definition Panel 135
SSL Nomenclature 571
SSL Engineering Assumptions 572

Slurry Calculation Method Overview
(SSL Module Only) The methodology for slurry pipe calculations is taken from Wilson, et al, 
2006. There are three Slurry Calculation Methods – Minimal, Simplified and Detailed. These 
require an increasing level of knowledge and data about the slurry being modeled. Each of the 
methods are described with repeated information as there are many calculations that are com-
mon among the three.

 l Minimal Slurry Calculation Method
 l Simplified Slurry Calculation Method
 l Detailed Slurry Calculation Method

Related Topics

Sloped Pipe Theory For Slurries 568
Vertical Pipe Theory For Slurries 567
SSL Engineering Assumptions 572
SSL Nomenclature 571

SSL Module 
Settling Slurry Module
An optional add-on module to AFT 
Fathom which allows users to sim-
ulate settling slurries.

Minimal Slurry Calculation Method
(SSL Module Only) The Minimal Slurry Calculation method was developed for fully-stratified 
flow, but can be used as a conservative method for two-layer heterogeneous flow. The following 
data are required for the Minimal Calculation Method             
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 l Temperature
 l Solids concentration
 l Density
 l Sliding friction coefficient, μs

Horizontal pipes

The pressure drop in a given by the relationship given by Wilson, et al, 2006, on page 116. As 
described in the discussion in the book, the coefficient 0.55 is based on sand or gravel sliding in 
steel pipe which has a coefficient of sliding friction, μs of 0.40. The equation then is modified with 
the ratio of the value entered on the Slurry Definition panel of Analysis Setup and becomes the 
following:

(1)

Where im is the dimensionless head gradient and Vm is the mean velocity based on the full dia-
meter regardless of whether any solids collection in the bottom of the pipe has reduced the effect-
ive diameter. Note that when the Minimal Input option is selected in Analysis Setup on the Solids 
Definition panel there is no value entered for the d50 or d85 particle sizes in the Solids Definition 
panel and therefore the exponent M, V50 and other parameters cannot be determined.             

Related Topics

Sloped Pipe Theory For Slurries 568
Slurry Calculation Method Overview 561
Vertical Pipe Theory For Slurries 567
SSL Engineering Assumptions 572
SSL Nomenclature 571

Simplified Slurry Calculation Method
(SSL Module Only ) The Simplified Slurry Calculation Method was developed for two-layer het-
erogeneous slurry flow with a newtonian carrier fluid. This method is similar to the Detailed Slurry 
Calculation Method, but uses a simpler method to estimate V50. The following data is required 
for the Simplified Calculation Method:

 l Temperature
 l Solids concentration
 l Density

- 562 -



Add-on Modules

 l d50 particle size                     
 l M exponent value                     

Horizontal Pipes

The correlation for additional pressure loss in horizontal pipes due to the slurry is given by 
Wilson, et al. 2006, on page 130

       (1)

 
Where im is the dimensionless head gradient and Vm is the mean velocity based on the full dia-
meter regardless of whether any solids collection in the bottom of the pipe has reduced the effect-
ive diameter. By adding in the base fluid pressure loss, the full head gradient is given by Wilson, 
et al. 2006, on page 134 (note that Wilson, et al, assume the fluid is water where here the fluid is 
generalized)             

(2)

Noting that:

we get the following solution for the total head gradient:

(3)

Calculating the V50 Value             

Equation 3 above needs the velocity at which 50% of the solids are suspended by the fluid, V50. 
An estimation shown in Wilson, et al, 2006, on page 141, is used.
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(4)

The relative viscosity vr is the ratio of the actual fluid viscosity to that of water at 20 degrees C 
(i.e. 1.0016 centipoise).

Related Topics

Sloped Pipe Theory For Slurries 568
Slurry Calculation Method Overview 561
Vertical Pipe Theory For Slurries 567
SSL Engineering Assumptions 572
SSL Nomenclature 571

Detailed Slurry Calculation Method
(SSL Module Only) The Detailed Slurry Calculation Method was developed for two-layer het-
erogeneous slurry flow with a newtonian carrier fluid. This method is similar to the Simplified 
Slurry Calculation Method, but includes more sophisticated methods to calculate M and V50, as 
is discussed below. The following data is required for the Detailed Calculation Method:

 l Temperature
 l Solids concentration
 l Density
 l d50 particle size                     
 l d85 particle size if the M exponent it so be calculated                     
 l M exponent value if no d85 particle size is available                     
 l Terminal velocity parameter, using either the Shape Factor (K) or Vt / Vts

Horizontal Pipes

The correlation for additional pressure loss in horizontal pipes due to the slurry is given by 
Wilson, et al, 2006, on page 130             

(1)
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Where im is the dimensionless head gradient and Vm is the mean velocity based on the full dia-
meter regardless of whether any solids collection in the bottom of the pipe has reduced the effect-
ive diameter. By adding in the base fluid pressure loss the full head gradient is given by Wilson, 
et al, 2006, on page 134 (note that Wilson, et al, assume the fluid is water where here the fluid is 
generalized)             

(2)

Noting that:

We get the following solution for the total head gradient:

(3)

Calculating the V50 Value             

Equations 2 and 3 above need the velocity at which 50% of the solids are suspended by the fluid, 
V50. This is discussed by Wilson, et al, 2006, with a functional relationship given on page 130.             

(4)

Where:

 l w50 is the particle associated velocity
 l d50 is the particle diameter
 l D is the pipe inner diameter

W50 used in Equation 4 above, is the particle associated velocity for the median particle size, 
and is defined in equation 5 below. The 3rd edition of Wilson (Wilson, et al, 2006, from which the 
equations for the rest of this discussion are taken) defines w using Figure 6.5 on page 136 of the 
text. The plot of w vs. particle size is based on an empirically-derived equation in the 2nd edition 
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of the text (Wilson, et al, 1996), equation 6.12 found on page 134. The AFT Fathom SSL module 
uses that equation (Equation 5 below) in its solution methodology.

(5)

Where:

 l vt is the particle settling velocity for the particle size in question                     
 l ρs is the slurry density                     
 l ρf is the fluid density                     

Calculating the M Exponent Value

If both the d50 and d85 values are entered, the M exponent value can be calculated using the 
method shown in Wilson, et al, 2006, on page 140.             

(6)

Where:

(7)

When using these calculations M is limited to between 0.25 and 1.7.

Related Topics

Sloped Pipe Theory For Slurries 568
Slurry Calculation Method Overview 561
Vertical Pipe Theory For Slurries 567
SSL Engineering Assumptions 572
SSL Nomenclature 571
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Vertical Pipe Theory For Slurries
(SSL Module Only) Flow in vertical pipes offer a special-case flow regime. The basic equation 
for flow rising in a vertical pipe is given in Wilson, et al, 2006, on page 178.

(1)

It is important to note that this is the total pressure drop per unit length whereas the horizontal 
pipe equations have components for the pure fluid and the solids separately.

Noting that for water, for which Equation 1 is based, we can substitute:

and obtain the following basic relationship:

(2)

Wilson, et al, states that for particles smaller than 150 microns, the density in the final term 
should be the mixture density:

Substituting this in to Equation 2 we obtain:

(3)

The friction factor f could be found with homogenous methods, but it is often reasonable to use 
the friction factor for a water flow fw with the same mean velocity. For larger particles Wilson, et 
al, suggests that the density term should be that of water which, when substituted in to Equation 
2 yields:
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(4)

Related Topics

Sloped Pipe Theory For Slurries 568
Slurry Calculation Method Overview 561
SSL Engineering Assumptions 572
SSL Nomenclature 571

Sloped Pipe Theory For Slurries
(SSL Module Only) Sloped pipe calculations are a combination of horizontal head loss and a ver-
tical component. A widely used formula is given in Wilson, et al, 2006, on page 183.

(1)

Where Δi(θ) is simply the excess pressure gradient (im – iw) for a pipe at an angle θ.

The term Δi(θ) is the solids effect for a horizontal pipe and is calculated using the equations 
described in that section above. It is modified by cos(θ) to reflect the pipe inclination from hori-
zontal.

The Deposition Velocity, Vsm, is also modified based on pipe angle. The following is added to the 
value calculated for horizontal pipes.

(2)

Where ΔD is determined from the graph in Wilson, et al, 2006, on page 181.

Related Topics

Slurry Calculation Method Overview 561
Vertical Pipe Theory For Slurries 567
SSL Engineering Assumptions 572
SSL Nomenclature 571
Pipe Slope 587

SSL Module 
Settling Slurry Module
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An optional add-on module to AFT 
Fathom which allows users to sim-
ulate settling slurries.

4-Component Slurry Model
The 4-Component Slurry Model is a holistic approach to characterizing how slurry flows function 
by considering the combined effects of four slurry flow regimes. The model strongly references 
and utilizes the method of the same name outlined by GIW Industries Inc.

The 4-Component Model can be selected on the Slurry Model dropdown in the Slurry Definition 
panel of Analysis Setup. Optionally, a Solids Library can be created to define the slurry prop-
erties.

The Four Slurry Regimes

The four slurry flow regimes are:

 l Carrier Fluid
 l Pseudo-homogeneous
 l Heterogeneous
 l Fully Stratified

The Carrier Fluid regime considers particles smaller than 40 μm. These solid particles mix with 
liquid in such a way that mixture viscosity is affected.

The Pseudo-homogeneous regime considers particles larger than 40 μm and smaller than 200 
μm. Due to the turbulence, the solid particles are supported within the fluid. The mixture's vis-
cosity is not affected by this regime.

The Heterogeneous regime considers particles larger than 200 μm and smaller than 1.5% of the 
pipe's diameter (μm). Particles of this size begin to settle creating a heterogeneous mixture 
where the solids are found in greater concentration at the bottom of the pipe. Turbulence in the 
fluid and contact with the pipe wall support these solids from settling out of the fluid.

The Fully Stratified regime considers particles larger than 1.5% of the pipe's diameter (μm). 
Solids are primarily supported by the pipe wall and will slide along the bottom of the pipe. A slid-
ing bed friction model is used for this flow regime.
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Figure 1: The 4-Component Slurry Model considers combined effects from four slurry regimes

The water pressure gradient im (in meters of water head per meter of pipe) from frictional losses 
is the sum of if, the pressure gradient of the carrier fluid component, with the excess pressure 
gradients of the pseudo-homogeneous component Δip, the heterogeneous component Δih, and 
the fully stratified component Δis. The slurry pressure gradient jm is related to im by the specific 
gravity of the total slurry mixture Sm.

Defining and Using a 4-Component Slurry Model

To begin defining and using the 4-Component Slurry Model, enable the Settling Slurry Module 
with the radio button set to Settling. Define the Carrier Fluid on the Carrier Fluid panel. On the 
Slurry Definition panel, set the Slurry Model dropdown to Settling Slurry - 4-Component Model. 
Navigate to Solids Definition panel and select one of the Solids Specifications options. If a Solids 
library is attached, it can likewise be selected from the dropdown. Density, d100 (the Maximum 
Solid Diameter), and a Particle Size Distribution are required to be filled out. Once the Solids 
Definition panel is completely defined, navigate to the Slurry Definition panel. Enter an Amount 
Solids Added and Sliding Friction Coefficient in the required fields. With all of the required inform-
ation entered, the 4-Component Slurry Model can now be used.

4-Component SSL Pump De-Rating is available for use with 4-Component slurries.
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Related Topics

Sloped Pipe Theory For Slurries 568
Slurry Calculation Method Overview 561
Vertical Pipe Theory For Slurries 567
SSL Engineering Assumptions 572
SSL Nomenclature 571

SSL Nomenclature
(SSL Module Only)

CE derated pump multiplier on efficiency

CH derated pump multiplier on head

Cm mass concentration of solids

Cvd volume concentration of solids, delivered

Cvi volume concentration of solids, in situ

Cvb volume concentration of solids in sliding bed (bed concentration)

d50 mass-median particle diameter

d85 diameter for which 85% by mass of the particles are finer

D inner diameter of pipe

f friction factor

ff friction factor when calculating ifg

fturb turbulent friction factor

fw friction factor of water

g acceleration due to gravity

i head gradient

if head gradient contribution from fluid

im value of i for flow in terms of water density

is head gradient contribution from solids

iw head gradient contribution from fluid when fluid is water

jm head gradient in terms of slurry density

K loss factor

K Power Law constant
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L pipe length

Leq equivalent pipe length of fittings

M an exponent in the stratification ratio equation

ρw density of water

Ss relative density of solids in slurry

Sf relative density of fluids in slurry

Sm relative density of slurry

V50 value of Vm at which 50% of the solids are suspended in the fluid

Vm mean velocity of mixture

Vsm deposition velocity, velocity at which particles have all settled out

Vt terminal velocity of a solid particle in the slurry carrier fluid

Vts terminal velocity of a perfectly spherical solid particle in the slurry carrier fluid

SSL Engineering Assumptions
(SSL Module Only)             

Calculations done with the SSL module are based on the following assumptions:

 l Solid particles are moving with the fluid. Stationary beds cannot be modeled. Sliding beds 
can be modeled with caution.

 l Base liquid behaves in a Newtonian viscosity manner
 l Slurry viscosity is equivalent to the viscosity of the carrier fluid

SSL Flow Rates
(SSL Module Only) When specifying or referring to slurry flow rate, three different meanings of 
flow rate are possible and two are commonly used. The definitions for flow rate are as follows:

 l Slurry - Combined flow rate of the fluid and solids. This is the most common flow rate 
definition.

 l Solids - Flow rate of just the solids in the slurry. This is often used because the purpose of 
the slurry is frequently to convey solids and this flowrate is of the greatest importance to 
the engineer.

 l Clear Liquid - Flow rate of the carrier fluid. This is not commonly used.

The three flow rate definitions are of course interrelated. The slurry flow rate is the sum of the 
other two. As shown in the slurry output section, all three flow rates can be displayed in the Out-
put window.

The three flow rate definitions can be specified in three places in AFT Fathom. Two are on the 
Pump Properties Window and one is on the Assigned Flow Properties window.
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An example of one of the three locations is shown in Figure 1 in the Pump Properties Window. 
When the SSL module is in use there is a dropdown list adjacent to the flowrate specification 
fields (as shown in Figure 1) that allows one to choose one of the three. The default selection is 
the flow rate of slurry.

Note that anywhere in AFT Fathom that specifies or displays flow rate information and does not 
offer the qualifier of slurry/solids/clear liquid, the flow rate of slurry is assumed.

Figure 1: Pump Properties Window with fixed mass flow rate of slurry specified                 

Related Topics

SSL Engineering Assumptions 572
SSL Nomenclature 571

Estimating M From Recorded Data
(SSL Module Only) There is an option on the Solids Definition panel of the Analysis Setup win-
dow and Solids Library to estimate M from recorded data. Choose the button for M Curve Fit. 
This is based on discussion in Wilson, et al, 2006, on pages 128-136.

Figure 1 shows the M Parameter Curve Fit window. Data for velocity and relative excess pres-
sure gradient are entered and a linear curve fit is generated on a log-log plot. The M factor is dis-
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played at the top. Data that does not fit the curve can be disregarded by the user by deselecting 
the checkbox in the table.

M values are not allowed to be greater than 1.7 or less than 0.25 based on recommendations in 
Wilson, et al.             

Figure 1: M curve fit window based on recorded data

Related Topics

SSL Engineering Assumptions 572
SSL Nomenclature 571

SSL Module 
Settling Slurry Module
An optional add-on module to AFT 
Fathom which allows users to sim-
ulate settling slurries.

Solids Library
(SSL Module Only) Users can create Solids Library entries which retain data for specific solids 
profiles. The Solids Library window (Figure 1) can be accessed from the Library menu or from 
Analysis Setup on the Solids Definition panel.

This allows you to view, add, edit and delete solids in the library. The physical properties are 
entered in the Change Solids Physical Properties window. Enter the name of the solids data and 
the temperature units.
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Often the physical properties of the solids do not vary appreciably with temperature or the vari-
ation is unknown. In this case select Use Constant Properties (Figure 2). The temperature units 
are ignored but one must still be selected. The density is always required. The specific heat and 
thermal conductivity are optional and are only used when heat transfer is modeled.

If one or more properties vary with temperature, uncheck the Use Constant Properties box. The 
property values as a function of temperature can then be entered in the table on the Solids Prop-
erty Data tab (Figure 2). If a property does not vary with temperature, simply enter the same 
value for each temperature listed in the table.

Figure 1: Solids Library showing example of user-entered solids data
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Figure 2: Change Solids Physical Properties window showing tab to specify thermophysical prop-
erties of solids (available when “Use Constant Properties” is unchecked)

Other Solids Parameters

The Terminal Velocity Parameter and the M exponent are entered on the Other Solids Para-
meters tab (Figure 3). The particle size distribution is also entered on this tab.

Similar to direct entry on the Solids Definition panel, the user can allow AFT Fathom to estimate 
the M factor from recorded data or can input an M value directly. If M is calculated, values for 
both d50 and d85 must be entered.

The Terminal Velocity Parameter can be entered as either a Shape Factor (K) or the ratio of the 
particle's terminal velocity (Vt) to that of a sphere (Vts). This ratio is designated by z or Xi

Typical shape factors are given in Wilson, et al, 2006, on page 46 where K = 0.26 for sand. To 
ignore this effect select Vt / Vts = 1.

Particle Size Distribution

The particle size parameters d50 and d85 can be entered directly or statistically calculated based 
on particle size distribution data. 
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With the Use Particle Size Distribution option checked, you can enter the percent of the solids 
that remained on the mesh as observed from test data for each Tyler Mesh Size. The d50 and 
d85 parameters will automatically be calculated (Figure 3).

Figure 3: Solids Library showing the definition of particle size distribution

Related Topics

SSL Engineering Assumptions 572
SSL Nomenclature 571

SSL Pump De-Rating
(SSL Module Only) When centrifugal pumps are pumping slurries the solids in the slurry can 
cause decreased pump performance. This is known as de-rating, as the process involves redu-
cing the pump head curves provided by manufacturers which are based on clear water.             

The SSL module offers three methods to estimate pump de-rating. The first is based on a stand-
ard published by the Hydraulic Institute in 2016. In AFT Fathom it is called the “ANSI/HI Standard 
12.1-12.6-2016” method. The second is based on the Warman method.  The third allows the 
user to define a CH, CQ and CE rather than having them calculated.

When the SSL module is used, a new tab appears on the Pump Properties Window called Slurry 
De-Rating (Figure 1). Here the user can choose the de-rating method. The de-rating factors are 
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shown in the Output window Pump Summary as CH (for head correction) and CE (for efficiency 
correction). Figure 2 shows the Pump Summary with correction factors displayed. If you do not 
see them in your Output you can add them to the Pump Summary in the Output Control window 
opened from the Tools menu.

Figure 1: Slurry De-Rating tab on Pump Properties Window lets user estimate reduced pump per-
formance due to solids

Figure 2: Pump de-rating factors CH and CE are shown in Output window Pump Summary

Theory of Pump De-Rating

The head reduction for slurry pumps is based on ANSI/HI Standard 12.1-12.6-2016, page 52, 
Figure 12.3.2.7 (not shown here). Correction factors for solids density, solids concentration and 
percent of fine particles are applied per the standard. This figure and methodology is the same 
as found in Wilson, et al. 2006 on page 243.

The Warman Method is in use in industry but is not widely available. The method used in AFT 
Fathom is based on a white paper by Walker, C. I., Undated, page 2, and uses a correction factor 
for impeller size. Cm is the solids mass concentration of the slurry in terms of percent mass.
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The 4-Component Model option is a modified form of ANSI/HI Standard 12.1-12.6-2016 by GIW 
Industries Inc. intended for use with the 4-Component Slurry Model. The head reduction is given 
by the following equation.

Where rh is the total percent head reduction factor (i.e. 1 percent de-rate is 1.0) and rh,f, rh,p, rh,h, 
and rh,s are the contributions of the carrier fluid viscosity, pseudo-homogeneous fraction, het-
erogeneous fraction, and fully stratified fraction, respectively.

For viscosity below 20 centipoise, GIW guidelines state that rh,f can be assumed to be zero. 
Above 20 centipoise, ANSI/HI 9.6.7-2021 should be used to calculate this term.

Note: The Viscosity Correction term rh,f is not automatically applied when pump slurry de-rat-
ing is in use. To incorporate this term, Use Viscosity Correction must be enabled in the 
Optional tab. That option alone determines whether rh,f is calculated and the recom-
mended 20 centipoise threshold is not used.

The equations for the other components take the following general form where D2 is pump dia-
meter in meters, DREF is 1.0 m, SS is the solid specific gravity, Sx is the mixture specific gravity 
for each component, Cv is the volumetric concentration of solids, and Xx is the fraction of solids 
associated with each component. S1 is equal to 0.5 times D2/DREF and S2 is 0.4.

This results in the following three equations:
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Where A”, B”, and C” are empirical parameters and d50p, d50h, and d50s are the average particle 
sizes in mm of the pseudo-homogenous, heterogeneous, and fully stratified fractions, respect-
ively. CH is determined from rh with the following expression.

Related Topics

SSL Engineering Assumptions 572
SSL Nomenclature 571

SSL in Output
(SSL Module Only)

Selecting Slurry Output Data

The specific slurry data to be shown in the Output window is specified in the Output Control win-
dow. Select the Slurry button on the Display Parameters tab to see the available parameters (Fig-
ure 1).
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Figure 1: The Output Control window has a slurry button to allow choice of Output table parameters

Viewing Slurry Output

When an AFT Fathom model is run there is a special output table for the SSL module labeled 
Slurry that shows the results in the Pipes section (Figure 2).

Figure 2: Output window showing Slurry table in Pipes section

Related Topics

SSL Engineering Assumptions 572
SSL Nomenclature 571
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SSL in Graph Results
(SSL Module Only) Slurry system curves are common way of interpreting slurry behavior. Such 
system curves can be specified in the Graph Control tab of the Quick Access Panel.

When the SSL module is in use a new tab appears on the right called Slurry System Curve (Fig-
ure 1). Here, one can select the type of curve to generate.

Note: All pipes must be of the same diameter to use the Slurry System Curve.             

Options to include pump curves (if a pump curve is used) and water curve cross plots are avail-
able.

The system curve is displayed in the Graph Results window (Figure 2).

Equations for Slurry System Curve

Fathom uses the equations below as are given in Wilson et. al (2006) on page 320 to calculate 
the velocity (V) and head gradient (j) for the slurry system curve.

where V50 is the value of Vm at which 50% of solid are suspended in fluid, Vm is the mean velo-
city of the mixture, and fw is the friction factor of water.

Since the head gradient depends on the velocity, all pipes must be the same diameter to pro-
duce a meaningful curve.
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Figure 1: Slurry System Curve tab in the Quick Access Panel allows system curves to be created
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Figure 2: Graph Results window shows slurry system curve when using the SSL module

Related Topics

SSL Engineering Assumptions 572
SSL Nomenclature 571
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SSL Initial Guesses for Pipe Velocity
(SSL Module Only) AFT Fathom uses iterative methods to solve for the equations of pipe flow. 
This requires initial guesses for pipe flowrate. Such guesses are optional for the user and can be 
entered on the Pipe Properties Window Optional tab. If the user does not provide an initial guess 
then AFT Fathom makes an initial guess itself.

Typical settling slurry applications operate at a higher velocity than non-slurry flows and AFT 
Fathom will converge more reliably on a result if the initial guess at velocity reflects this higher 
velocity. 

By default the initial guess flowrate for all pipes is based on a velocity of two times VSM. This can 
be modified by the user in the Advanced Parameters panel or overridden directly by entering an 
initial guess for the pipes manually.

Related Topics

SSL Engineering Assumptions 572
SSL Nomenclature 571

SSL Troubleshooting
(SSL Module Only) Figure 1 shows a system curve for a settling slurry. One of the distinct 
aspects of settling slurry behavior is the minimum point of the system curve. This means that for 
a given jm (or, in general, head difference) there are two potential flowrates. This has the poten-
tial for unstable numerical results. 

For more reliable modeling results it is recommend the engineer use fixed flow type models. 
When the flow is fixed it determines an operating point on Figure 1 and a unique solution for 
head loss can be obtained.

A fixed flow type model would be a model where the user specifies the flow rate in some way. 
Here are the most common ways the flow rate can be fixed:

 l Use an Assigned Flow junction at all model inlet or outlets
 l Use a pump with a fixed flow rate
 l Use a pump with variable speed control which controls a fixed flow rate

In contrast, it is recommended the engineer avoid pressure difference type models where the 
flow solution has to be iterated. A common way to have a pressure difference is to use Reservoir 
or Assigned Pressure junctions at all inlets and outlets and to have no flow constraining junctions 
in the system like a controlled flow pump. In such cases AFT Fathom has to solve for the flow 
rate. This can cause difficulty in obtaining any solution at all.
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Figure 1: Graph Results window shows slurry system curve when using the SSL module

Related Topics

SSL Engineering Assumptions 572
SSL Nomenclature 571

Tips When Using GSC with SSL Module
The GSC module in AFT Fathom can be used in conjunction with the SSL Module. Similar con-
siderations apply as are discussed in SSL troubleshooting. If one is looking for a goals but the 
system is not a fixed flow type system then the goal seeker can become unstable. 

The following tips are the same as given for general GSC troubleshooting but can be even more 
important when modeling slurries:

 l Use bounds on design variables to keep the search within certain limits
 l Vary the design variable starting point. If the simulation is started far away from the actual 

value then GSC may not be able to find the solution
 l Manually modify some of the Numerical Control parameters in the Goal Seek & Control 

Group. Specifically, increasing the Relative Finite Difference Step Size can help the goal 
seeker obtain better gradients and provide more reliability
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Related Topics

SSL Engineering Assumptions 572
SSL Nomenclature 571

Pipe Slope
SSL Module Only Pipes with different slopes will have different pressure drops for slurry flow 
because of the way solids are carried horizontally, vertically or in between. AFT Fathom determ-
ines the pipe slope based on the pipe length and connected junction elevations.

The pipe angle can be added to the Slurry output in the Output Control table.

Related Topics

Sloped Pipe Theory For Slurries 568

XTS - Extended Time Simulation

What is the XTS module?

An optional add-on module to AFT Fathom which allows users to simulate system transient beha-
vior.

While steady-state modeling answers many design questions, some questions cannot be 
adequately answered without considering how systems behave over time. Questions such as 
how long it will take to fill a tank require a dynamic system model. The AFT Fathom XTS module 
answers such questions.

The XTS module allows you to model transient system behavior. Users can specify the time dur-
ation of the simulation, time step size, control system parameters, and how components such as 
pumps and valves operate over time. Operations such as valve position changes can occur dur-
ing a specified time schedule, or can occur in response to events in the system thereby sim-
ulating control system actions.

Users can also specify tank volume on “finite” tanks, so that tank draining and filling can be sim-
ulated. Tanks can be open or pressurized, with the gas pressure automatically calculated as the 
liquid level changes.

The XTS module is a powerful tool which extends AFT Fathom’s powerful modeling capabilities 
into the dimension of time.

Note: Transient modeling with XTS does not support heat transfer.
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How Does the XTS Module Work?

The XTS module can be described as using a lumped or quasi-steady approximation to time sim-
ulation. This means it represents the transient system behavior as a sequence of pseudo-
steady-state solutions. In between each pseudo-steady-state solution it adjusts transient para-
meters, performs mass balances on tanks, and changes component operations as specified by 
the user.

As a thought experiment, consider a system which you want to simulate for ten minutes in one 
minute increments. This would require eleven time step solutions (time zero and each minute up 
to ten). You could manually do this with standard AFT Fathom by running a steady-state model 
eleven times, and in between each run adjusting the input parameters for the next run based on 
the results of the previous run. The XTS module automates this manual process.

Besides the automation benefits, the XTS module offers additional benefits such as transient 
output data management, consolidation and display, and graphing tools to review the transient 
results.

Using the XTS Module

The user has the option of activating or not activating the XTS module when AFT Fathom first 
loads. After AFT Fathom is loaded, the XTS module can be activated or deactivated for use  from 
the Modules panel in the Analysis Setup window or the Tools menu. Whether or not XTS is activ-
ated impacts the Analysis menu, Analysis Setup window, Status Bar and multiple other AFT 
Fathom functions as is discussed in the Modules panel topic. 

If the XTS module is active, the user can still run models in Steady Only mode by selecting this 
under Time Simulation on the Analysis menu. Hence there are three possibilities for XTS: 

 l XTS is not active
 l XTS is active and operated in Steady Only mode
 l XTS is active and operated in Transient mode

Types of Transients Modeled 

 l Reservoirs - 
 l Reservoirs can be modeled as finite tanks with user specified tank geometry. 
 l Finite reservoirs with known geometry allows AFT Fathom to model liquid level 

changes over time to simulate tank filling and draining and its impact on the flow in 
the system. 

 l Finite reservoirs can be open or enclosed. If enclosed, then surface gas pressure 
changes are automatically updated.

 l Pump transients - 
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 l Pumps can be started or stopped based on time or event transients
 l Pump and Pump as Turbine speed can be changed with time
 l Pump flow or head can be changes with time
 l Controlled pump setpoint can be changed with time
 l Pump as Turbine Load Rejection

 l Valve transients - 
 l Valves can be closed or opened based on time or event transients

 l Control Valve transients - 
 l Control valve setpoints can be varied based on time or event transients

 l Other junction transients - 
 l Spray Discharge junctions can be closed or opened based on time or event tran-

sients
 l Assigned Flow junctions can have flow varied based on time or event transients
 l Assigned Pressure junctions can have pressure varied based on time or event tran-

sients
 l Reservoir junctions can have liquid level or surface pressure varied based on time 

or event transients
 l Three-way valve junctions can have valve position varied based on time or event 

transients

Related Topics

Modules Panel 80
Add-on Modules 547
Transient Control Group 140
Simulation Duration Panel 140
Choosing Time Simulation 590
Junction Transient Data 590
Finite and Infinite Reservoirs 603
XTS in Model Data 613
XTS in Output 614
XTS in Graph Results 616
XTS in Workspace 612

Related Blogs

What Is Transient Analysis?

And, Not, Or - Starting Transient Events with Complex Logic
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Choosing Time Simulation
(XTS Module Only) When using XTS, the option Time Simulation appears in the Analysis Menu. 
This drops down to two menu choices: Steady Only and Transient (Figure 1). Users can thus 
build steady models with XTS or transient models.

The Transient option requires the Transient Control Group to be defined in addition to the other 
typical settings. The Steady Only option makes the Transient Control Group settings optional.

Figure 1: Time Simulation option in the Analysis menu

Related Topics

Junction Transient Data 590
Finite and Infinite Reservoirs 603
XTS in Model Data 613
XTS in Output 614
XTS in Graph Results 616
XTS in Workspace 612

Junction Transient Data
(XTS Module Only) Many junction types can have active transient data specified. The junction 
types are listed in Table 1:

Table 1: Junctions that support transient data

Junction 
Type

Type of 
Transient

Assigned 
Flow

Flow rate

Assigned 
Pressure

Pressure
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Junction 
Type

Type of 
Transient

Branch Flowrate 
source or 

sink

Control 
Valve

Setpoint

Pump Speed, 
flowrate, 
head rise, 

control set-
point

Reservoir Liquid level, 
surface pres-

sure

Spray Dis-
charge

Flow area

Three-Way 
Valve

Position

Valve K, Cv, or 
open per-
centage

The active transient data is entered on the Transient tab (Figure 1). The type of data that can be 
entered for each junction type is listed in Table 1. If a junction does not have any active transient 
behavior, there is no need to enter any data on the Transient tab.

In most cases, transient data can be entered as absolute values or as a percentage of steady-
state. The distinction is made when choosing between Absolute Values and Relative to Steady-
State Value. Some junctions may have additional options, such as the Valve junction (Figure 1).

The first data point always needs to match the steady-state value which is usually entered on the 
tab at the far left. If, for example in Figure 1, the steady-state data for Cv of 260 is changed to 
200, the transient data will also need to be changed. However, if in Figure 1 the Relative option is 
specified, the first data point would be 100%, and when the Cv is steady-state is changed from 
260 to 200 there is no need to change the transient data since the first data point is still 100%. 
But it is now relative to a different steady-state value.
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Figure 1: Example of junction transient data

Repeat Transient

If the transient data is periodic, you can enter the data for one cycle of the period and then tick 
the check box for Repeat Transient. This will cause the one cycle of transient data to be repeated 
once it has reached the end. The repetition will continue until the end of the simulation.

Transient Special Conditions

There may be occasions where, once having entered the transient data, you do not wish the tran-
sient to activate for a particular case. One option is to just delete the transient data. A second 
option is to specify the Transient Special Condition as Ignore Transient Data. In such a case, the 
data can be left in the window for future use, but will not activate during the run.

In Figure 1, there is an area called Initiation of Transient, and the selection is Time. This means 
that the specified transient is linked to the time of the simulation. Specifically, the valve transient 
data is activated as soon as the simulation is started. Because the transient data is constant for 
one second, the valve does not start to close until the simulation time reaches one second. 
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Transients can also be initiated based on events. For instance, we can change the valve in Fig-
ure 1 to start closing when the pressure at some other system location reaches a certain level. 
Or maybe when a tank has filled up and thus reached a certain level. In such a case, the time 
zero data in Figure 1 does not refer to the start of the simulation, but is relative to when the event 
occurs. If, for instance, the pressure never reaches the specified level, the valve never closes. 

Related Topics

Initiation of Transients 593
Multi-Condition Events 597
XTS Special Conditions 601
Choosing Time Simulation 590
Finite and Infinite Reservoirs 603
XTS in Model Data 613
XTS in Output 614
XTS in Graph Results 616
XTS in Workspace 612

Initiation of Transients
(XTS Module Only) In general, transients can be initiated according to a certain time or accord-
ing to certain events that happen in the system. These two categories are referred to as time 
based and event based transients. This is defined in the Initiation of Transient area of a junc-
tion's transient tab.

Figure 1: Type of transient initiation

It is helpful to consider the different time scales that are used when referring to the initiation of a 
transient, as shown in Figure 2.

Absolute and Simulation Time are often identical. The simulation Start Time is set in Simulation 
Duration panel to an Absolute Time of zero seconds by default, but it could be non-zero. In Fig-
ure 2, the Simulation Start Time is set to a value of 2 seconds – the entire Simulation Time 
timeline is shifted forward 2 seconds.

Event Time refers to the time data defined in Transient Data. This could be equal to Simulation 
Time (and Absolute Time) depending on how the event is defined. For example, all three time 
bases will match for a pump trip event starting at the beginning of a simulation with Start Time 
equal to zero. However, the event may not start until a certain system condition is met and zero 
Event Time could be well into the simulation.
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Figure 2: Time basis

Time

Time based transients modify a parameter directly according to Simulation Time.

For example, consider a valve closure transient. The valve starts to close at two seconds into the 
simulation, and the time it takes for the valve to close is one second. After that, the valve stays 
closed. To define this event with the Time option, the Start Time must be set to zero, and the 
Transient Data must look something like the data shown in Figure 3.

Figure 3: Defining a valve closure at a specific time

Single Event

Single Event initiated transients do not begin until a certain condition is met.

To completely define an Event, four parameters are required:

 l Event Type - What parameter is being considered to initiate the transient. See Table 1 
below for a list of the possible Event Types.

 l Condition - The logical relationship between Event Type and Value (e.g. greater than, 
less than, etc)

 l Value - The specific magnitude of the Event Type parameter at Location
 l Location - Where in the model the Value should be observed
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Given the same valve closure profile described in Figure 3, we can set the valve to remain open 
until (and if) the pressure at the inlet of P101 exceeds 100 psia. Note that the Transient Data is 
identical - but the initiation of the event may happen at a very different time.

Figure 4: Event definition

Table 1: Event types

** Multi-Condition 
** Kv Reservoir Liquid Height

Check Valve State Mass Flow Rate in Pipe Reservoir Liquid Volume  

Control Valve 
State Pressure Stag. Diff. at Junction Reservoir Surface Elevation 

Cv Pressure Stag. Diff. Between Pipes Reservoir Surface Pressure

EGL at Pipe Pressure Stagnation at Pipe Spray Discharge Outflow

EGL Diff. at Junc-
tion Pressure Static at Pipe Time Absolute

EGL Diff, Between 
Pipes Pressure Static Diff. at Junction Time Difference

HGL at Pipe Pressure Static Diff. Between Pipes Valve Open Percent

HGL Diff. at Junc-
tion Pump Speed Velocity in Pipe

HGL Diff. 
Between Pipes Relief Valve State Volumetric Flow Rate in Pipe

Dual Event Cyclic

The Dual Event options, as the names imply, require the definition of two events. The definition 
for each event follows the same structure as a Single Event.
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Dual Event Cyclic will continue monitoring both triggering events throughout the simulation and 
will apply the corresponding transient data when the conditions are met.

To continue with the valve example, we can define our valve not only to open when a pressure is 
exceeded, we can tell it to close when the pressure drops below a certain setting.

Figure 5: Dual Event set up. Note that a Second Event requires additional data for the Second Tran-
sient

Dual Event Sequential

Dual Event Sequential is nearly identical to Dual Event Cyclic. In fact, all of the required user 
input is the same.

The difference is that the two defined events are only applied once. That is – after the second 
event is complete, no more transients will be applied even if the conditions are met.

Junctions With Inherent Event Logic

There are two junction types in AFT Fathom which have built-in, or inherent, event logic. These 
are the check valve and relief valve. The user does not need to specify the nature of the events, 
and in fact is not allowed to. 

The inherent event logic is very similar to the Dual Event Cyclic logic described previously.

 l Check valve - The check valve has two built-in events. The first is that it closes when 
backflow starts to occur. The second is that it reopens when sufficient pressure dif-
ferential occurs. These transients are assumed to be instantaneous.
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 l Relief valve - The relief valve has two built-in events. The first is that it opens when the 
set pressure is reached. The second is that it closes again when the pressure falls back 
below the set pressure. These transients are assumed to be instantaneous unless the 
Pressure/Pressure Opening/Closing profile is used.

Related Topics

Junction Transient Data 590
Multi-Condition Events 597
XTS Special Conditions 601

Related Blogs

And, Not, Or - Starting Transient Events with Complex Logic

Multi-Condition Events
One of the Event Types available in XTS is Multi-Condition. This feature allows starting a tran-
sient based on more than one parameter in the model.

For example, it may be desirable to open a valve when either of two pressures is exceeded.

To define a Multi-Condition Event, first select Multi-Condition as the Event Type from the junc-
tion's Transient tab.
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Figure 1: Selecting Multi-Condition Event Type

Event Manager

Clicking Multi-Condition Event opens the Event Manager, where Simple Events and Multi-Condi-
tion Events can be defined.

The Event Manager defines events model-wide. That is, if the active scenario is changed, the 
same events will be accessible.
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Figure 2: The Event Manager

Simple Events

The Event Manager allows for the definition of Simple Events and Multi-Condition Events.

Simple Events are nearly identical to normal (non Multi-Condition) events defined in a Transient 
tab. They require a Parameter, Condition, Value, and Object as well as a unique Name.

Clicking "Create Simple Event..." adds a new Simple Event to the list with default values. These 
values should be updated with the desired values and applied with the Update button. Simple 
Events can be duplicated to help reduce repeated data entry.

Multi-Condition Events

Multi-Condition Events are a collection of other Events with a logical condition applied to them. 
When creating a new Multi-Condition Event, a prompt for a Name appears. After entering a 
name, an empty Multi-Condition is created with a default logical condition of AND. This logical 
condition can be:

 l AND - All of the Simple Event conditions must be met for the Multi-Condition Event to trig-
ger.
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 l NOT - The Multi-Condition Event triggers when none of the conditions evaluate to true.
 l OR - One or more of the Simple Event conditions must be met for the Multi-Condition 

Event to trigger.

Figure 3: Conditional logic for Multi-Condition Events

Any number of Simple Events can be added to a Multi-Condition Event as Sub-Events:

Figure 4: Multiple Events

Complex Multi-Condition Events

More complex events can be defined by adding one or several Multi-Condition Events as Sub-
Events to another Multi-Condition Event.

Figure 5: A Multi-Condition Event containing another Multi-Condition Event (trigger if Limit 3 AND 
(Limit 1 OR Limit 2))
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Using Multi-Condition Events

All Multi-Condition Events are listed in the junction's Initiation of Transient section. Only one 
Multi-Condition Event can be selected as the Initiating Event for any particular Transient Data.

Figure 6: The selected Multi-Condition Event controls the trigger of the Transient Data. Hovering 
over the Multi-Condition events here shows an expanded definition of the event.

Related Topics

Junction Transient Data 590
Initiation of Transients 593
XTS Special Conditions 601

Related Blogs

And, Not, Or - Starting Transient Events with Complex Logic

XTS Special Conditions
(XTS Module Only) Some junctions have Special Conditions that alter the normal state of the 
junction. 

The junctions that have special conditions set are shown using a special symbol before the ID 
number (an “X” by default). This symbol can be customized in the User Options window.
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Special Conditions with No Transient Data

If a Special Condition is applied to a junction without any transient data, then the transient solu-
tion will retain the Special Condition. For instance, if a Special Condition is set for a valve junc-
tion, the steady- state solution will solve with the valve closed. In addition, the transient solution 
will run the entire simulation with the valve closed as well because there is no transient data 
entered which implies the valve state is not intended to change.

Special Conditions with Transient Data

If a Special Condition is applied to a junction that has transient data, then the transient solution 
will ignore the Special Condition. It is then incumbent upon the engineer to relate the Special 
Condition to the initial transient data.

For instance, assume the user wants to simulate the transient that occurs during a valve open-
ing. The steady-state solution will have the valve closed, and this is modeled by using a Special 
Condition for the valve junction. In such a case, the Cv data entered on the valve junction's Loss 
Model tab will be ignored.

On the Transient tab, a transient can be entered. The first data in the table should then be Cv = 0, 
which corresponds to a closed valve. From there the Cv can be increased above zero as desired 
to open the valve.

If the user were to keep the Cv equal to zero, then that would be equivalent to the previous case 
where the user set the Special Condition but did not enter any transient data.

Pump Special Conditions

Pump Special Conditions are slightly more complicated than for valves. In fact, pump junctions 
have two types of Special Conditions. The first is to turn the pump off and have no flow through it. 
This is called “Pump Off No Flow”. The second type of Special Condition turns the pump off but 
allows flow to go through the pump. This is called “Pump Off With Flow Through”.

Why would one want to use one Special Condition rather than the other? The simple answer is 
that the first Special Condition is more appropriate for positive displacement type pumps and the 
second for centrifugal pumps. 

Here's why. When a positive displacement pump is turned off and has a pressure difference 
across it, it will usually act like a closed valve and not allow flow to go through it. Thus the first 
Special Condition would be most appropriate. For instance, assume one wants to model the tran-
sient that occurs during the startup of a positive displacement pump. The best way to do this 
would be to use the first Special Condition with no flow, and then input a flowrate transient in 
which the first data point is zero flow.

On the other hand, when a centrifugal pump is turned off and has a pressure difference across it, 
in the absence of other valving which prevents flow the pump will usually allow flow to go through 
it. Thus the Special Condition that allows through flow would be most appropriate. For example, 
assume one wants to model the transient during the startup of a centrifugal pump. One would 
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use the second Special Condition, and, in conjunction with a pump curve entered at 100% 
speed, input a speed transient with the initial speed as zero.

Transient Special Conditions

Junctions which accept transient data also support Transient Special Conditions. The default for 
all junctions is None. The other choice is Ignore Transient Data. This allows one to have no tran-
sient initiation at that junction without having to delete the transient data.

When a Transient Special Condition is set to Ignore, a # symbol is displayed adjacent to the junc-
tion number on the Workspace. This symbol can be customized in the User Options window.

Related Topics

Junction Transient Data 590
Initiation of Transients 593
Multi-Condition Events 597

Finite and Infinite Reservoirs
Without the XTS Module, reservoirs are infinite. With the XTS module, reservoirs can be infinite 
or finite. 

 l Infinite reservoirs - infinite reservoirs refer to a massive body of fluid whose surface 
level does not change appreciably as a result of liquid inflow or outflow during the time 
frame of the simulation. An example is a large lake or the ocean. 

 l Finite reservoirs - (XTS Module Only) finite reservoirs (also called finite tanks) refer to a 
body of fluid which is small enough that its surface level changes significantly during the 
time frame of the simulation as a result of liquid inflow or outflow. An example is a tank 
which drains as the simulation progresses. 

 l Finite reservoirs can be open or closed. Finite open reservoirs are open to the 
atmosphere or some other fixed surface pressure. Typically open reservoirs have 
a constant surface pressure with time, although users have the latitude to pre-spe-
cify time varying surface pressure.

 l Finite closed reservoirs are closed tanks in which, as the liquid level changes, the 
gas above the liquid expands or contracts and hence its pressure changes accord-
ing to the gas thermodynamic laws. For closed reservoirs the user specifies the ini-
tial liquid level and gas pressure, but during the simulation all gas pressure and 
liquid levels are calculated by AFT Fathom.

Related Topics

Reservoir 338
Pipe X elevation of Y is below Reservoir Z tank bottom elevation... 792
Tank Junction X began overflowing at Y seconds 786
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Tank Junction X completely drained at Y seconds 786
Choosing Time Simulation 590
Junction Transient Data 590
XTS in Model Data 613
XTS in Output 614
XTS in Graph Results 616
XTS in Workspace 612

Entering Reservoir Volume Data
(XTS Module Only) When running AFT Fathom in Steady Only mode (or without the XTS mod-
ule), each reservoir junction is considered an infinite reservoir. This means that the liquid heights 
and surface pressures entered are constant. When running transients, reservoirs can be either 
infinite or finite. Similar to Steady Only mode, an infinite reservoir maintains its level during the 
transient. The differences are discussed below and summarized in Table 1.

Table 1: Various possible inputs with infinite and finite Reservoir junctions

 

Infinite Reservoirs 

Infinite reservoirs refer to a massive body of fluid whose surface level does not change appre-
ciably as a result of liquid inflow or outflow during the time frame of the simulation. An example is 
a large lake or the ocean. Figure 1 shows a Reservoir junction modeled as infinite.

Finite Reservoirs

Finite reservoirs (also called finite tanks) refer to a body of fluid which is small enough that its sur-
face level changes significantly during the time frame of the simulation as a result of liquid inflow 
or outflow. An example is a tank which drains as the simulation progresses. Tanks can have con-
stant cross-section (e.g., a pure vertical cylinder) or tank cross-section can change with height. 
When the cross-section changes, the tank volume at each height data point must be specified.

Finite tanks can further be broken down into open or closed tanks.

 l Finite open tanks - Finite open tanks are open to the atmosphere or some other fixed 
surface pressure. Typically open tanks have a constant surface pressure with time, 
although users have the latitude to pre-specify time varying surface pressure. Figure 2 
shows a Reservoir junction modeled as a finite open tank.
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 l Finite closed tanks - Finite closed tanks are tanks in which, as the liquid level changes, 
the gas above the liquid expands or contracts and hence its pressure changes according 
to the gas thermodynamic laws. For closed tanks the user specifies the initial liquid level 
and gas pressure, but during the simulation all gas pressure and liquid levels are cal-
culated by AFT Fathom. Figure 3 shows a Reservoir junction modeled as a finite closed 
tank.

Known Parameters Initially

In some cases the liquid level may not be known initially when modeling finite tanks. An example 
would be a vertical standpipe. At time zero the net flow at the standpipe would be balanced, and 
the liquid surface would find its own level (this would equal the local hydraulic gradeline). Hence 
the initial liquid level would be calculated based on equilibrium.

However, under transient conditions the liquid level will change, and the liquid volume in the 
standpipe can significantly affect pipeline behavior.

This is the purpose of the features in the Known Parameters Initially area (see Figure 2). By 
default, both the initial liquid level and initial surface pressure are assumed known. If you want to 
model one of them as unknown initially, select the desired parameter from the drop-down. If the 
surface pressure is selected as unknown initially, it functions similarly to the unknown liquid level 
except initial equilibrium surface pressure would be calculated.

This feature only affects the calculation at the initial “zero” time step. For all other time steps, the 
junction behaves the same as a junction in which the liquid level and surface pressure are known 
initially.
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Figure 1: Reservoir junction modeled as infinite 
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Figure 2: Reservoir junction modeled as finite open 
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Figure 3: Reservoir junction modeled as finite closed

Related Topics

Entering Reservoir Transient Data 608
Finite Reservoir Maximum and Minimum Pressures 611
Finite Tank Overflow & Draining 610

Entering Reservoir Transient Data
(XTS Module Only)

Infinite Reservoirs

For an infinite reservoir, the liquid level or surface pressure can be varied over time according to 
a user specified transient profile (see Table 1 in the Entering Reservoir Volume Data topic). This 
is input on the Transient tab (see Figure 1).
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Figure 1: Infinite reservoirs can have user specified time varying liquid level or surface pressure

Finite Open Tanks

For a finite open tank, the surface pressure can be varied over time according to a user specified 
transient profile. This is input on the Transient tab (Figure 2).

Finite Closed Tanks

For a finite closed tank with a maximum allowable pressure (this is a relief pressure), the relief 
pressure can be varied over time according to a user specified transient profile. This is input on 
the Transient tab.
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Figure 2: Finite tanks can have user specified time varying surface pressure

Related Topics

Entering Reservoir Volume Data 604
Finite Reservoir Maximum and Minimum Pressures 611
Finite Tank Overflow & Draining 610

Finite Tank Overflow & Draining
(XTS Module Only) 

Finite Tank Overflow

As the transient progresses finite tanks can fill up. If the tank is open, then it is possible for the 
liquid to reach the top. How does AFT Fathom handle this?

When a finite tank liquid level reaches the top, it is assumed that the liquid spills over the top. 
Hence the liquid height is maintained at the top of the tank. Note that this causes a loss of mass 
from the system model.

If the tank is closed, the gas pressure will increase as the tank fills. Thus the tank cannot over-
flow. If the tank has a maximum pressure (which represents a relief line) then it is possible for the 
liquid mass to be lost as it would ostensibly flow out the relief line. The liquid level in the tank 
would then be maintained at the top of the tank.
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Finite Tank Drained

When a tank drains to the bottom, it cannot supply any more liquid to the connected pipes. The 
system behavior after a tank has drained cannot be accurately modeled by AFT Fathom. In a 
real system, and in the absence of a valve to stop the flow, a drained tank which continues to 
flow would result in the connected pipes themselves draining and a gas/liquid interface moving 
down the pipes. AFT Fathom assumes all pipes are liquid full, and cannot model draining pipes.

Since it is not desirable in most applications to have the pipes drain, this limitation is not a sig-
nificant issue. The user can, for example, use a valve in the pipe which closes when the tank 
drains. This would use an event transient.

Since AFT Fathom cannot model a tank after it has drained, what does it do? Rather than halt 
the transient run, which would not be very helpful to the user, AFT Fathom assumes the con-
necting pipe “turns off” when it no longer has liquid to supply it. To implement this, AFT Fathom 
sets the pipe’s Special Condition so that it turns the pipe off.

Finite Tank Pipes Uncovered

AFT Fathom allows multiple pipes to connect to a reservoir, all at different elevations. As a tank 
drains, pipes may be uncovered. AFT Fathom handles this in the same manner as described 
above for completely drained tank. 

If a pipe is uncovered, then there are two possibilities:

 l Liquid flows from the pipe and into the tank – AFT Fathom can model this case. The 
liquid free falls to the liquid surface, and appropriate boundary conditions are used to 
solve the system.

 l Liquid tries to flow from the tank and into the pipe – AFT Fathom cannot model this 
case. Since the pipe is not covered by liquid, then the tank cannot supply liquid to the pipe 
and in reality the pipe itself would drain. AFT Fathom does the same thing as described 
above for a completely drained tank – it sets the pipe flow to zero.

Important: When a tank drains completely or sufficiently to uncover a pipe, AFT Fathom can-
not adequately model the system behavior after this point unless a valve is used to stop 
the flow into the pipe. AFT Fathom will warn the user when this happens.

Related Topics

Entering Reservoir Volume Data 604
Entering Reservoir Transient Data 608
Finite Reservoir Maximum and Minimum Pressures 611

Finite Reservoir Maximum and Minimum Pressures
(XTS Module Only) A finite closed tank allows the user to specify maximum and minimum pres-
sure. This is the pressure of the gas in the tank. The purpose of maximum and minimum 
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pressure is to simulate relief and vent systems in the tank which represent over and under-
pressurization.

Related Topics

Entering Reservoir Volume Data 604
Entering Reservoir Transient Data 608
Finite Tank Overflow & Draining 610

XTS Module 
Extended Time Simulation Mod-
ule
An optional add-on module to AFT 
Fathom which allows users to sim-
ulate system transient behavior.

XTS in Workspace
(XTS Module Only) The transient parameter labels on the Workspace Layers will change dynam-
ically to be displayed at a selected time. The slider bar and buttons at the bottom of the Work-
space function the same as the Output window time selection controls. When the user changes 
the current time, displayed transient parameters are changed as well. In addition, color maps are 
updated when in use.

As shown in Figure 1, the current time is displayed in the bottom-left by the time adjustment but-
tons. The time can also be optionally displayed next to the model as well. The time display on the 
Workspace can be turned on and off within the Global Layer Settings window. It is helpful to have 
the time on the Workspace when it is printed.
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Figure 1: The Workspace has additional time adjustment controls when the XTS Module is in Tran-
sient mode

Related Topics

Choosing Time Simulation 590
Junction Transient Data 590
Finite and Infinite Reservoirs 603
XTS in Model Data 613
XTS in Output 614
XTS in Graph Results 616

XTS in Model Data
(XTS Module Only) Junction transient data is displayed on the Transient tab in the Junction sec-
tion of the Model Data window (Figure 1). This tab is only visible if transient input data exists.
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Figure 1: Transient input data is displayed in the Junction section of the Model Data window

Related Topics

Choosing Time Simulation 590
Junction Transient Data 590
Finite and Infinite Reservoirs 603
XTS in Output 614
XTS in Graph Results 616
XTS in Workspace 612

XTS in Output
(XTS Module Only) Transient simulations create more output data than steady-state runs. This 
data is displayed in the Output window in two general ways.

First, the pipe and junction output tables now reflect output at a specific point in time. In Figure 1 
below the displayed results are 10 minutes into the simulation. This can be seen at the bottom 
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left of Figure 1. The forward/reverse buttons and the slider at the bottom allow changing the cur-
rently displayed time.

Second, the results for all time steps are displayed together in the tables labeled "Transient". Fig-
ure 2 shows the same output as Figure 1, except the transient reservoir, pipe and pipetabs have 
been selected for display. Here one sees multiple results for each pipe or junction. For example, 
look at the transient pipe data in the middle tables. While the table holds data for all pipes, one 
can see here only part of the data (up to 3 minutes) for the first pipe, pipe 1. In the far left column, 
the first data is the pipe number (#1) and the adjacent number in parentheses is the time for that 
row (in the units defined for the time step interval, - minutes in this case). The time unit of 
seconds is displayed in the bottom left, and can be changed in the Output Control time format-
ting. The data in Figure 2 shows these changes over each time step. The transient tables are 
organized with a collapsing/expanding capability for each pipe or junction to facilitate data view-
ing.        

Notice that each of the junction Summary reports at the top of Figure 1 (in the General Section, 
see Pump, Valve and Reservoir Summary) have a parallel Transient table that goes with it.

Figure 1: Output window displaying data at 10 minutes

Figure 2: Output window displaying transient data for entire simulation
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Related Topics

Choosing Time Simulation 590
Junction Transient Data 590
Finite and Infinite Reservoirs 603
XTS in Model Data 613
XTS in Graph Results 616
XTS in Workspace 612

XTS in Graph Results
(XTS Module Only) Transient data can graphed in the Graph Results window in two general 
ways: Profile graphs and transient graphs.

Pump vs. System curves can still be generated, but only when the Time Simulation is set to 
Steady Only. See the bottom of this topic.

Profile Graphs

Profile graphs show results where the distance along the pipe is the independent, x parameter 
(Figure 1). If the pipes are connected, a sequence of pipes can be graphed in the profile. Profile 
graphs can only show data at a particular time or show overall maximum and minimum values for 
all times (Figure 2).

Profile graphs can be created for one or more pipe sequences. Note that the x-axis on profile 
plots is cumulative distance along the pipe sequence. 

Multiple profiles can be plotted simultaneously using the Groups on the Edit menu.
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Figure 1: The Graphing panel showing a profile plot for a pipe sequence for maximum and minimum 
static pressure is to be generated
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Figure 2: Transient max/min profile plot for pressure as specified in Figure 1

Animation of Output

Another useful feature of profile graphs is that they allow animation of the output results. Anim-
ation is selected in the Quick Access Panel (Figure 1) and, when selected, reveals additional con-
trol features on the Graph Results window. See Animating Transient Results for more 
information.

Transient Graphs

Transient graphs show how parameters vary with time (see Figures 3 and 4). Here the x-axis is 
time (rather than distance as in profile graphs) as shown in Figure 2.
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Figure 3: Setting up a Transient graph
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Figure 4: Transient graphs show how parameters vary with time

Pump vs. System Curves

Pump vs. System Curve plots can only be created for a steady analysis. To perform a steady 
analysis change the Time Simulation to "Steady Only" from the Analysis menu.

To create a pump vs. system curve for a time step other than the initial time step, create a child 
scenario, change the Time Simulation to "Steady Only," and adjust the model file inputs to reflect 
the time step you want to create a pump vs. system curve for.

Related Topics

XTS Animating Results 621
XTS Quick Graph 622
Choosing Time Simulation 590
Junction Transient Data 590
Finite and Infinite Reservoirs 603
XTS in Model Data 613
XTS in Output 614
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XTS in Workspace 612

XTS Animating Results
Figure 1 shows the Graph Results window when using animation. As shown, additional controls 
become visible to allow the user to adjust animation. At the left is the Play button, which starts 
the animation. Next to it are the Pause and Stop buttons. If the Pause button is pushed, the anim-
ation stops at that time step. One can print the graph or copy the data if desired or use the time 
slider controls (to the right of the Stop button) to set the time forward or backwards. The Stop but-
ton stops the transient and resets the time to zero.

The current time (in seconds) and time step are shown to the right of the time controls. At the far 
right are the speed controls. Slowing the animation involves adding time delays to the data dis-
play. Increasing the speed involves skipping time steps. The default speed, right in the middle, 
has no delays or skips.

If plotting a single path using the list of pipes in Graph Control (Figure 2), one can cross-plot on 
the animation design alerts (in Profile Along a Flow Path) or steady-state results (in EGL, HGL 
and Elevation Profile).

Figure 1: The animation options display additional controls
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Figure 2: Enabling Animation in Graph Control

Related Topics

XTS in Graph Results 616
XTS Quick Graph 622

XTS Quick Graph
(XTS Module Only) Transient output data displayed in the Output window can be graphed by 
right-clicking on the data in the table and selecting Quick Graph (see Figures 1 and 2).

Figure 1: Quick Graph on the Output window is selected by clicking the with the right mouse button 
in a column of transient data

- 622 -



Add-on Modules

Figure 2: Quick Graph window is opened from Output window as shown in Figure 1

Related Topics

XTS in Graph Results 616
XTS Animating Results 621

ANS - Automated Network Sizing

What is the Automated Network Sizing (ANS) module?             

Sizing a single pipe or a single pump for minimum cost is relatively straightforward with manual 
iteration. When considering a network of pipes, the manual approach of selecting cheaper com-
ponents one at a time quickly becomes not only impractical, but ineffective. While manual com-
ponent selection can certainly reduce cost, it often does not result in a minimized cost.          

The path to minimizing cost is often unintuitive. Replacing certain components with more expens-
ive ones often results in a lower total system cost. Solving such a problem - with dozens or per-
haps hundreds of variables - cannot reasonably be completed by hand. A computational 
approach quickly finds ways to reduce cost that may never be found by other means.             
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In addition, components cannot be arbitrarily changed without impacting overall operation. Any 
given system has certain requirements that must be met. Reducing pipe sizes too much, for 
example, may result in flow rates that are unacceptably low. There is a balance between redu-
cing cost and providing the desired operation. The ANS module automates this process, min-
imizing the cost of complex systems while still meeting requirements with ease.             

Note: ANS is not designed to be a cost estimator. It instead offers an approach for com-
paring potential designs using cost as a common denominator. The value of ANS is in 
the minimization of cost, not the precise estimation of total cost.             

Using the ANS Module             

The ANS module can be enabled  from the Modules panel in Analysis Setup. Activating ANS 
adds the Automated Sizing item to the Analysis menu, and enabling ANS affects many areas of 
the AFT Fathom interface.             

If the ANS module is active, models can still be run without ANS by selecting Analysis -> Auto-
mated Sizing -> Not Used. It is also possible to run models without sizing by selecting Do Not 
Size in the Sizing Method panel. These options create three distinct possibilities:             

 l ANS is not active - this is standard AFT Fathom mode.
 l ANS is active, but not sizing - the Sizing Window and Sizing panels are visible but will 

not be used in simulation.
 l ANS is active and sizing - the Sizing Window and Sizing panels are visible and the set-

tings are applied during simulation.

Examples

ANS is best understood by sizing a model yourself. We have created several examples to help 
walk you through what is required with ANS: ANS Examples.

Related Topics

Modules Panel 80
Add-on Modules 547
Automatic Sizing Group 171
Sizing Summary Panel 171
Sizing Fundamentals 625
Sizing Window 639
Solution Progress with ANS 661
Sizing Results 663
Workspace Integration 665
Junction Loss Factors 667
Improving and Troubleshooting the Sizing Process 668
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Related Blogs

What is the ANS Module Asking For? Introduction to the Sizing window in the ANS Add-on Mod-
ule

Sizing Fundamentals

How Does the ANS Module Work?

ANS is built to allow you to approach the automated sizing process in a way appropriate to your 
system.

You must specify an Objective - minimizing or maximizing a specific system variable. Most 
commonly, the ultimate Objective is to minimize monetary cost.

The pipes to be sized must be defined - any given pipe may be included or excluded from the 
automated sizing process. It may not be desired to automatically size every pipe in the entire sys-
tem independently. It is common that groups of pipes - such as those in a header - must be of 
equal size. This is accomplished by placing them into Common Size Groups - sets of pipes 
that are automatically sized but must all be the same size.

The selection of piping is generally restricted to certain materials, sizes, and types independent 
of fluid flow concerns. Perhaps certain system piping must be Stainless Steel of any common 
size, whereas other piping in the system can be regular Steel, but is limited to three on-hand dia-
meters. These are represented with Candidate Sets - selections of pipe sizes and types 
that are allowed.

If the only goal is to minimize cost, the answer is trivial - select the smallest pipe sizes available. 
Clearly, this is not practical as systems are not built for the sake of being inexpensive, but are 
meant to accomplish some goal. These goals, such as minimum flows or pressures, are 
Design Requirements. Any number of Design Requirements can be specified in a system, con-
trolling the allowed fluid behavior.

There are several different Sizing Methods available. These methods approach the same 
Objective in different ways, with certain methods being more appropriate for certain systems. 
Agreement between methods is a strong indication that the ideal sizes have been selected.

Analysis vs. Design

Sizing a system to minimize or maximize a system-wide quantity like monetary cost or pipe 
weight is a complex process with many considerations. AFT Fathom is foremost an analysis tool, 
but the ANS module is a design tool. While closely related, analysis and design are different in 
many ways.

Engineering analysis is the process of using accepted calculation methods to predict the beha-
vior of a given system. Analysis requires the full specification of the system before calculations 
are made. For example, fundamental fluid equations can be used to determine the flow in a pipe 
of a known size.

- 625 -

https://www.aft.com/support/product-tips/what-is-the-ans-module-asking-for-introduction-to-the-sizing-window-in-the-ans-add-on-module
https://www.aft.com/support/product-tips/what-is-the-ans-module-asking-for-introduction-to-the-sizing-window-in-the-ans-add-on-module


Cost Calculation

When a new system is being designed, the pipe size is not known. Instead, it might be desired to 
find the size necessary to meet a minimum flow. The engineer can make an educated guess, per-
form the analysis, modify the size, and repeat the process. The analytical methods are used iter-
atively to arrive at a final design.

Even for a simple problem, the iterative Specify Model -> Analyze -> Investigate Results -> 
Adjust Model method can be very inefficient. For simple systems, it is often possible to solve for 
a design variable by manipulating the fundamental equations. This would allow the process to be 
completed in one design iteration.

For complex problems direct solutions are impractical or impossible. Instead, the iterative 
method can be applied with numerical methods. AFT Fathom already automates the "Specify 
Model -> Analyze" portion of the process. AFT Fathom ANS further simplifies the process by 
using intelligent searching algorithms to automate the "Investigate Results -> Adjust Model" 
steps.

By providing ANS with information on the requirements of a system, it offers a true design-ori-
ented approach, automating a complex iterative process.

Related Topics

Objective 626
Design Requirement 628
Feasible and Infeasible Designs 630
Active, Inactive, and Violated Design Requirements 632
Discrete and Continuous Sizing 634
Multiple Operating Cases 635
Common Size Group 636
Initial Costs and Recurring Costs 637
Candidate Set 639

Objective
The Objective is the goal of the sizing process - the variable of concern and whether it should 
be minimized or maximized.

A valid Objective variable must be calculable as a total for any potential system configuration. 
For example, a system can be sized to minimize or maximize weight because any pipe has a 
weight measured in a common unit. However, different pipes may have different pressure rat-
ings - it does not make sense to maximize or minimize pressure rating as they cannot be added 
together and retain the same meaning. Further, the value must be available for all possible con-
figurations - if some pipe sizes are of unknown weight, the sizing cannot proceed effectively 
because it is unknown whether choosing that size is an improvement or not.

The Objective is defined on the Sizing Objective panel.
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Conceptual Example

Consider a simple problem - moving fluid from one large tank to another. The pressures and fluid 
levels in the tanks are fixed. The fluid must be transferred in a pipe of specialized material, and it 
is difficult to manufacture this material in small diameters, making them more expensive. The 
Objective is to select the cheapest pipe possible for the task.

Figure 1: Cost for different diameters of specialized piping

Clearly, there is a minimum cost between diameters "4" and "5."
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Figure 2: Locating the Diameter with minimum cost

However, what if we are limited by other requirements? For example, we may have a minimum 
flow rate. This is a Design Requirement, and makes the problem more complex.

Related Topics

Sizing Fundamentals 625
Design Requirement 628
Feasible and Infeasible Designs 630
Active, Inactive, and Violated Design Requirements 632
Discrete and Continuous Sizing 634
Multiple Operating Cases 635
Common Size Group 636
Initial Costs and Recurring Costs 637
Candidate Set 639

Design Requirement
A real system has Design Requirements - specific parameters that must be met, regard-
less of the Objective value. Targeting an Objective without any other associated requirements 
is not meaningful. If a system is not attempting to achieve some goal, then the minimum cost is 
zero as no system is required.

The Objective alone may be "How can I drive my cost to a minimum?" but the question really on 
the designer's mind is "How can I drive my cost to a minimum while maintaining desired oper-
ation?"

Design Requirements are defined on the Design Requirement panel.
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Note: There is a distinction between a boundary and a Design Requirement. Boundaries rep-
resent a physically forced flow or pressure while Design Requirements represent 
desired behavior. See Boundaries vs. Design Requirements for further discussion.

Conceptual Example

Continuing with our example from the Objective topic, we want to minimize the cost of some 
pipe. However, there is a minimum flow rate. This is a Design Requirement and limits the pos-
sible solutions. In our example, flow rate follows a predictable relationship with diameter (Figure 
1).

Figure 1: Flow Rates for different diameters, showing the minimum required for our pipe

Our pipe has a Design Requirement that flow rate is at least "150", which indicates a minimum 
diameter between "6" and "7" (Figure 2).
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Figure 2: Minimum diameter indirectly imposed by flow rate requirement

Adding Design Requirements may influence the sizing results as this requirement makes certain 
solutions Infeasible.

Related Topics

Sizing Fundamentals 625
Objective 626
Feasible and Infeasible Designs 630
Active, Inactive, and Violated Design Requirements 632
Discrete and Continuous Sizing 634
Multiple Operating Cases 635
Common Size Group 636
Initial Costs and Recurring Costs 637
Candidate Set 639

Feasible and Infeasible Designs
If a system has Design Requirements, there will be designs unable to meet the requirements. 
These designs are termed Infeasible - configurations that violate Design Requirements. 
Likewise, configurations that meet all Design Requirements are Feasible.

Feasibility can be determined without any knowledge of the Objective. While it is not directly 
related to the Objective, feasibility can heavily influence the sizing process. It is typical that the 
ideal solutions are infeasible because they do not meet the Design Requirements. Instead, the 
best solution is where the Objective is met in the feasible space. Not all Design Requirements 
will impact the sizing in the same way.
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It is important not to confuse infeasible design with impossible design. A potential design being 
infeasible does not mean that the system could not be built as specified. In fact, it is possible that 
the system could run quite well. It only means that a specified Design Requirement has been 
violated.

Conceptual Example

We previously added a Design Requirement to our pipe, which makes certain designs Infeasible 
(Figure 1). The minimum flow rate Design Requirement requires a minimum diameter.

Figure 1: Certain diameters are infeasible when a Design Requirement is added

Clearly, our best case minimum cost is now in the Infeasible region. This would still be the 
cheapest pipe to select, but would limit flow too much. Instead, we need to find the minimum cost 
within the feasible region (Figure 2).
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Figure 2: Minimum Feasible Cost

Because our cost only increases with diameters larger than our minimum, the best case cost is 
now the minimum diameter possible due to the flow requirement. This means that the Design 
Requirement is Active.

Related Topics

Sizing Fundamentals 625
Objective 626
Design Requirement 628
Active, Inactive, and Violated Design Requirements 632
Discrete and Continuous Sizing 634
Multiple Operating Cases 635
Common Size Group 636
Initial Costs and Recurring Costs 637
Candidate Set 639

Active, Inactive, and Violated Design Requirements
Design Requirements may or may not drive the sizing solution. Design Requirements are Active 
if they drive the sizing solution. Design Requirements that have no impact on the sizing solution 
are Inactive.

There can easily be Design Requirements that, while important for normal operation, do not 
drive the sizing solution because violating them would not improve the Objective. These Inactive 
Design Requirements could be removed entirely without changing the sizing solution.
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It is not always easy to tell what Design Requirements will be Active or Inactive. A better overall 
solution can easily often obtained by making a local selection more expensive. This means that 
Design Requirements that would appear to only affect high-cost options may in fact be Active.

Knowing which Design Requirements are Active or Inactive in a sizing analysis can provide valu-
able insight into a design. Perhaps one Design Requirement is significantly increasing the cost of 
the system, but is not critical to the operation. In such cases it may be worthwhile to relax the 
restriction and modify the Design Requirement for a cheaper solution.

A Design Requirement is Violated if it is not met. During the sizing process it is common that 
Design Requirements will be Violated. However, if a solution exists, they should only be Active or 
Inactive in the final result.

Conceptual Example

Adding a specific Design Requirement to our pipe changed the sizing solution. What if we had 
also added a maximum flow rate, effectively imposing a maximum diameter? It will not impact 
the sizing solution, despite it being an important consideration for our system. Our original 
Design Requirement is considered Active, because it is driving the sizing solution, while the 
second Design Requirement is considered Inactive. As before, the absolute minimum cost dia-
meter would Violate our minimum flow requirement, making it infeasible (Figure 1).

Figure 1: Multiple Design Requirements

Piping is generally not available in any requested size, but instead only in selected, Discrete dia-
meters, which will also affect the sizing solution.

Related Topics

Sizing Fundamentals 625

- 633 -



Cost Calculation

Objective 626
Design Requirement 628
Feasible and Infeasible Designs 630
Discrete and Continuous Sizing 634
Multiple Operating Cases 635
Common Size Group 636
Initial Costs and Recurring Costs 637
Candidate Set 639

Discrete and Continuous Sizing
Continuous sizing considers any physical diameter in a given range. The ideal solution of 
a Continuous sizing will contain fractional sizes. However, piping is generally only available in 
Discrete sizes - a selection of individual, unique diameters.

It is assumed during a Continuous sizing that the Objective value varies linearly between inter-
mediate sizes. For monetary cost, this is highly unlikely to be the case - custom pipe of unusual 
diameter would be very expensive. Continuous sizing is useful because it is generally a far 
easier problem to mathematically solve. On its own, it will give the engineer a good idea of what 
the ideal system and best-case Objective value looks like. Coupled with a Discrete sizing 
method, the Continuous sizing result provides an excellent starting point, making the math-
ematical solution easier.

Continuous sizing methods also generally require less input as they are less restrictive. Starting 
the sizing process on a Continuous basis is often a good idea at it can reveal potential problems 
or areas of improvement earlier in the design process.

The selection between Continuous or Discrete is defined on the Sizing Method panel.

Conceptual Example

Our example has so far been a Continuous sizing problem - we are able to select any size of pipe 
to drive the cost to an absolute minimum. However, the piping is only available in Discrete sizes. 
This fact will impact the sizing solution and the resulting cost (Figure 1).
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Figure 1: Minimum Feasible Discrete Size

The minimum flow Design Requirement is still be considered Active in this case, as it is still driv-
ing the sizing solution.

Note: In our example, the cost of diameter "7" is almost double the cost of diameter "6." In 
such a case, it may warrant further investigation into why the minimum flow rate is 
required. If the minimum flow was imposed as a rule of thumb or for a non-critical 
reason, it is well worth considering violating this Design Requirement and selecting size 
"6" for the cost savings.

Related Topics

Sizing Fundamentals 625
Objective 626
Design Requirement 628
Feasible and Infeasible Designs 630
Active, Inactive, and Violated Design Requirements 632
Multiple Operating Cases 635
Common Size Group 636
Initial Costs and Recurring Costs 637
Candidate Set 639

Multiple Operating Cases
Sizing a system has many affects in addition to saving on quantities like weight or monetary cost. 
The operating capabilities of the system are impacted by any sizing decision. What may work 
well for one situation may not work well for another situation. Furthermore, the ideal design for a 
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system that must operate in more than one way may not simply be the ideal design of one of the 
cases.

In other words, repeatedly sizing the same system for individual multiple operating cases may 
not result in the ideal design.

By sizing multiple operating cases in parallel, it is possible to account for these vari-
ations and still obtain an ideal design in just one sizing simulation. We call these oper-
ating cases Dependent Design Cases.

This can be enabled on the Sizing Objective panel, with the Dependent Design Cases panel 
showing details on the process and model configuration.

Conceptual Example

Minimizing the size of a pipe with a Design Requirement of a minimum flow is relatively straight-
forward when only one situation must be considered.

However, consider if our example had multiple operating, or Dependent Design Cases. For 
example, the pressures in the tanks may vary depending on the time of day, the required flow 
rate may vary with demand, and the environment may vary which could affect the system 
through thermal affects.

The minimum pipe size found without considering these situations may violate a Design 
Requirement in other cases. Clearly, this cannot be allowed. While some attempt could be 
made by the engineer to determine the "most severe" case and size for that case, this is often 
very difficult and can easily neglect potential savings. Instead, by leveraging Dependent 
Designs, we can account for these variations directly in the model.

Related Topics

Sizing Fundamentals 625
Objective 626
Design Requirement 628
Feasible and Infeasible Designs 630
Active, Inactive, and Violated Design Requirements 632
Discrete and Continuous Sizing 634
Common Size Group 636
Initial Costs and Recurring Costs 637
Candidate Set 639

Common Size Group
A Common Size Group is a group of pipes that must be of uniform size.

There are two reasons to create Common Size Groups:

 l Physical Requirements - All of the pipes in the group must be the same size in the field. 
For example, a long header may be drawn on the Workspace as a series of individual 
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pipe objects. Adding these individual pipes to a Common Size Group forces the entire 
header to be a common size. If the pipes were not placed in a Common Size Group, it is 
likely that different sizes would be selected for different sections of the header. Require-
ments based on pipe connections are also common - it would not be unusual to require 
equal diameter piping upstream and downstream of a valve or other junction.

 l Reduction in Complexity - Every additional independently sized pipe increases the dif-
ficulty of the sizing problem. Sizing problems with large numbers of independently sized 
pipes can take extremely long to solve, often for relatively little benefit. This is especially 
true when the resulting pipe sizes are similar, or when the cost of a particular pipe has min-
imal impact on the overall cost. For example, parallel pipes would often be expected to 
have the same size, and short connector pipes will likely have no significant bearing on 
overall cost if there are much longer pipes being sized. By adding these types of pipes to 
a Common Size Group, the solution time can be dramatically reduced.

Common Size Groups are defined in the Size/Cost Assignments panel.

Related Topics

Sizing Fundamentals 625
Objective 626
Design Requirement 628
Feasible and Infeasible Designs 630
Active, Inactive, and Violated Design Requirements 632
Discrete and Continuous Sizing 634
Multiple Operating Cases 635
Initial Costs and Recurring Costs 637
Candidate Set 639

Initial Costs and Recurring Costs
Systems can be sized for a variety of costs. Most notably, there are Initial Costs and Recurring 
Costs. The sum of the Initial Costs and Recurring Costs over the expected system lifetime is 
known as Life Cycle Cost.

Initial Costs include any one-time cost that is required to get the system in question operational. 
Most often, this is a combination of Material and Installation costs.

Recurring Costs include any cost that accrues over time (Figure 1). This could be fixed costs at 
regular intervals, such as the cost of routine Maintenance. It can also be the potentially variable 
cost of energy to run pumps.

Note: Costs must be defined in Cost Libraries, which are available as part of the base Applic-
ation.
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Figure 1: Components of Life Cycle Cost

Keep in mind when considering what costs to include what your most significant cost is likely to 
be. Systems are often designed to run for many years. This generally means that the total cost of 
running the system ends up as much more than the cost of building it. Fully defining the sizing 
input for minimizing Life Cycle Cost is more difficult, but often worthwhile. The inclusion of cost 
components is defined in the Sizing Objective panel.

Figure 2: Potential distribution of costs for a long System Life

Related Topics

Sizing Fundamentals 625
Objective 626
Design Requirement 628
Feasible and Infeasible Designs 630
Active, Inactive, and Violated Design Requirements 632
Discrete and Continuous Sizing 634
Multiple Operating Cases 635
Common Size Group 636
Candidate Set 639
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Candidate Set
A Candidate Set is a set of allowed pipe sizes. All pipes that are being sized must be associated 
with a Candidate Set.

The Candidate Set is required for both Discrete and Continuous Sizing. In continuous sizing it is 
used to determine a minimum and maximum pipe size. The intermediate sizes are only used if 
sizing is done on a discrete basis.

Multiple Candidate Sets can exist, but only one can be applied to any given pipe or Common 
Size group.

Candidate Sets, and their assignment to pipes, are defined on the Candidate Sets panel.

Related Topics

Sizing Fundamentals 625
Objective 626
Design Requirement 628
Feasible and Infeasible Designs 630
Active, Inactive, and Violated Design Requirements 632
Discrete and Continuous Sizing 634
Multiple Operating Cases 635
Common Size Group 636
Initial Costs and Recurring Costs 637

Sizing Window
The Sizing Window is a sixth Primary Window that appears when the ANS module is activated 
and enabled (Figure 1).

Figure 1: The Sizing Window

The Sizing window contains all of the information required to define a sizing analysis. Other 
areas of AFT Fathom interact with the definition of sizing parameters, but ultimately all changes 
are reflected here. The Sizing window is further divided into Sizing panels (Figure 2).
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Figure 2: Sizing Navigation

Each Sizing panel serves a certain purpose in the sizing process.

 l Sizing Objective panel - What parameter should be minimized or maximized?
 l Size/Cost Assignments panel - What pipes or junctions should be sized, which should 

be counted in the cost total, and how should they be grouped together?
 l Candidate Sets panel - What materials, sizes, and types of pipes can be considered in 

the sizing process?
 l Design Requirements panel - What requirements does the system have?
 l Assign Cost Libraries panel - If optimizing on cost, what is the source of the cost data?
 l Sizing Method panel - What type of sizing and what method should be used?
 l Dependent Design Cases panel - What operational variations must the sizing analysis 

account for?
 l Sizing Summary panel - How are the sizing settings currently applied to the system?

Panel Locks

Every Sizing panel can be individually locked to prevent accidental changes (Figure 3).

Figure 3: Locking panels

Related Topics

Sizing Objective Panel 641
Size/Cost Assignments Panel 645
Candidate Sets Panel 649
Design Requirement Panel 652
Assign Cost Libraries Panel 653
Sizing Method Panel 655
Dependent Design Cases Panel 657
Sizing Summary Panel 659
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Related Blogs

What is the ANS Module Asking For? Introduction to the Sizing window in the ANS Add-on Mod-
ule

Sizing Objective Panel

Sizing Options

Figure 1: The three sizing ANS sizing methodologies are shown 

 l Perform Sizing - The best case selection of pipe sizes will be determined based on the 
various Sizing Window settings.

 l Calculate Cost, Do Not Size - Pipe sizes will not change from their initial, user-defined 
size. The costs of the system as-defined will be calculated.

 l Do Not Size - No sizing or cost calculations will be carried out. This is equivalent to tem-
porarily disabling ANS.

Objective

The Objective is the goal of the automated sizing process. Any of the listed parameters can be 
minimized or maximized.

 l Pipe Weight - Calculated using the pipe material density and dimensions from the 
internal pipe material library for the pipes being sized.

 l Pipe and Fluid Weight - Calculated using the pipe material density and dimensions from 
the internal pipe material library, as well as the fluid density defined on the Fluid panel of 
Analysis Setup.

 l Flow Volume - The total volume of fluid in the pipes calculated from the inner diameter 
and geometry defined in the Pipe Properties window.

 l Pipe Inner Surface Area - The internal surface area of the pipes calculated using the 
inner diameter and geometry defined in the Pipe Properties window.
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 l Monetary Cost - The monetary value of the pipes/junctions calculated from the user 
provided cost libraries

Minimizing a physical parameter such as weight, volume, or surface area is often a good approx-
imation of minimizing Initial Cost. These options are also useful in specific cases were monetary 
cost of the fluid system is not the primary concern.

Other Options

Figure 2: The additional options in the Sizing window are shown

By default, all sizing panels are locked after a simulation is run. Modifying sizing input will require 
unlocking the panel.

It is possible to model multiple operating cases simultaneously by enabling Dependent Design 
Cases (Figure 2). The Dependent Design Cases panel is hidden unless it is enabled here.

Monetary Cost Options

There are several considerations to be made when considering the total Monetary Cost of a pip-
ing network. Is the Initial Cost of the Materials required the only concern? Do Installation Costs 
have to be accounted for? The true cost of a system could be considered its Life Cycle Cost - 
how much does it cost not only to build the system, but to run and maintain it? These are all valid 
approaches to the challenge of minimizing cost, and each requires different input.
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Figure 3: The various life cycle costs that can be considered are shown

 l Size for Initial Cost - Material and Installation Costs will be used to size the system.
 l Size for Initial Cost, Show Energy Costs - Material and Installation Costs will be used 

to size the system. Energy cost does not impact the sizing, but will be displayed. This may 
be helpful to determine if it is worthwhile to resize the system considering Recurring 
Costs.

 l Size for Initial and Recurring Costs - Energy Cost is considered in the sizing, along 
with Material and Installation Cost.

 l User Specified - Custom sizings are possible by selecting the appropriate radio buttons. 
For example, if Installation Costs are not readily available, these can be ignored by chan-
ging that row to Ignore Cost.

Note: The Sizing Level affects the available options. If the overall Sizing Level is "Do Not 
Size" then no sizing can take place and this will be reflected by forcing all cost rows to 
Ignore Cost.

 l Warn When Fittings & Losses Costs are Missing - By default, ANS will warn the user 
whenever costs are missing for any Fitting & Loss defined within a sized pipe. For the 
most accurate solution, these costs should be included, however, they are often small 
compared to other costs and this option allows ignoring those warnings.

Recurring Cost Options

If any Recurring Costs is specified to be included in the Cost Report or Sizing, additional input is 
required (Figure 4).
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Figure 4: Additional required information when recurring costs are included

 l System Life (For Recurring Costs) - The period for which the Recurring Costs are coun-
ted. Interest and Inflation Rates can optionally be specified.

 l Energy Cost - Only enabled if Energy is included in the Cost Report or Sizing.
 l Use Energy Cost Libraries - Use Cost Libraries for energy cost.
 l Use This Energy Cost Information - Specify a monetary cost for energy directly. 

If this is specified, Energy Cost Libraries will not be utilized.
 l Initial Cost Limit - Limits the total amount allowed for Initial Cost. A higher initial cost 

may result in a lower Life Cycle cost, but it is sometimes the case that there is an absolute 
limit on initial spending.

Related Topics

Sizing Window 639
Size/Cost Assignments Panel 645
Candidate Sets Panel 649
Design Requirement Panel 652
Assign Cost Libraries Panel 653
Sizing Method Panel 655
Dependent Design Cases Panel 657
Sizing Summary Panel 659

Related Blogs

What is the ANS Module Asking For? Introduction to the Sizing window in the ANS Add-on Mod-
ule
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Size/Cost Assignments Panel
The Size/Cost Assignments panel defines which components are to be included or excluded 
from sizing and cost reporting. Buttons across the top of the panel display selections for a spe-
cific component type.

Pipes

The options for pipes include including or excluding them from sizing, including or excluding from 
cost, including in cost only if size changes, and collecting the pipes into Common Size Groups 
(Figure 1).

 l Sizing and Cost Options - This section of the table controls sizing and cost calculation.
 l Automatically Size - If either of these columns are selected, this pipe will be 

included in the sizing analysis.
 l Always Include in Cost - The cost of this pipe will always be considered 

and reported.
 l Include in Cost if Size Changes - The cost of this pipe will effectively be 

considered zero for the initial size. This is useful for representing existing 
pipes, while considering the cost savings that could result from replacing 
the existing pipe with one of a more appropriate size.

 l Do Not Size - If either of these columns are selected, this pipe will not be included 
in the sizing analysis.

 l Include in Cost - The pipe will not be considered for sizing, but the cost of 
the pipe for the user specified size will be included. This is useful for having 
a complete picture of the system cost, even if certain pipes must be a given 
size.

 l Do Not Include in Cost - The pipe will not be sized or included in costs.
 l Pipe Grouping - Pipes can be placed into Common Size Groups here. You can sort this 

table by clicking on the column headers, or by right-clicking on the headers and choosing 
Organize Grid by Common Size Group. 

 l Not in Group - the pipe is not in a group, and is either not sized, or sized inde-
pendently from any other pipe.

 l Common Size Groups - This section is only visible after a Common Size Group is 
created with the New button. When a Common Size Group is created, it will create 
a corresponding column underneath the Common Size Groups header. Pipes can 
then be placed into the Common Size Group by selecting the radio button for the 
given pipe under the given Common Size Group. Groups can be collected to the 
top of the table by clicking on their column headers.
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Figure 1: The options for including pipes in both sizing and cost calculation. Additionally, the 
options to create custom size groups is shown.

Note: You can also add Pipes to Common Size Groups directly from the Workspace, and 
optionally color the Workspace pipes to indicate which pipes are in what groups.

Pipes can be selected by clicking on the row header, and multiple pipes can be selected by hold-
ing control or shift. With multiple pipes selected, their sizing or cost options can be reassigned 
with the buttons near the top of the table. All of the tables displayed in this panel include the 
selection features(Figure 2) available elsewhere in AFT Fathom.

Figure 2: Selection options available for the Size/Cost Assignments panel

Selected rows can have their settings changed all at once with the buttons just above the table 
(Figure 3).

Figure 3: The buttons above the table can be used to change selected rows all at once

Note the indication of the total number of Independent Pipe Sizes in the lower right (Figure 4). 
This quantity has important implications on run time and what Search Method will be appropriate 
for the model.
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Figure 4: The Number of Independent Pipe Sizes in the model are shown which has implications on 
runtime

Pumps, Control Valves, and Junctions

 l Cost Options - This section of the table controls sizing and cost calculation (Figure 5).
 l Include in Cost Report and Sizing - If a junction is included in the sizing cal-

culation, this does not mean that the junction itself is modified as pipes are. 
Instead, this means that the cost associated with the junction is included in the 
Objective. This can indirectly affect the size of the junction as the pipes are sized 
accordingly around it.

 l Include in Cost Report Only - The junction cost will not be included in the Object-
ive. However, the cost of the junction will be included in the Cost Report. The sizing 
of the junction may change as a result of pipe size changes, but the cost impact of 
this change will not drive the solution.

 l Do Not Include Cost - Not included in sizing or costs.

Figure 5: Cost options available for Pumps, Control Valves, and Junctions

Maximum Cost Groups

Pumps and Control valves can optionally be grouped together in maximum cost groups (Figure 
6). This is useful to account for situations where the cost of multiple components is the same, 
regardless of how the system operates around them.

For example, it is common to have two identical pumps installed in parallel, with only one oper-
ating and the other functioning as a spare. Clearly, the cost of purchasing and installing two 
identical pumps will be identical regardless of how they end up being operated. The automated 
sizing calculation will base the cost of the pump off its required size to maintain the desired flow. 
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However, in the case of a spare there is no flow requested, meaning that the ideal size of pump 
is "zero" - no pump at all! ANS must be told that the spare pump is the same size as the running 
pump. This will force the costs to be the same, accounting for both in the sizing.

In any Maximum Cost Group, the largest cost found during sizing will be applied to all of the 
junctions in the group for the given category. There are three categories:

 l Material - The most common grouping - A set of identical junctions will likely cost the 
same to procure, and therefore should be placed into a Material Maximum Cost Group.

 l Installation - Commonly tied to Material - the junctions are likely to cost the same to 
install.

 l Maintenance - May or may not be grouped - if all junctions have routine maintenance 
whether or not they are used, they should be grouped. If maintenance occurs only when 
the junction is operating for some amount of time, then a spare will have different main-
tenance costs and they should not be grouped.

Figure 6: The Maximum Cost Groups feature is shown allowing for items with identical costs to be 
grouped together
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Candidate Sets Panel
Candidate Sets are selections of pipe Material, Types, and Sizes that can be considered in the 
automated sizing process.

Define Candidate Sets

Before it can be applied to any pipes in the model, a Candidate Set must be defined.

Figure 1: The new button allows for the creation of new Candidate Sets

Clicking New will request a name for the new Candidate Set (Figure 1). After entering a name, 
the Select Pipe Sizes window will appear. In this window, a Material must be selected, and any 
number of specific Types and Sizes can be added for consideration (Figure 2). It would be com-
mon to select commercially available Sizes of a certain Type, but any selection can be made.
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Figure 2: The Select Pipe Sizes window allows for the sizes to be considered for sizing to be spe-
cified

Figure 3: A fully defined candidate set
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Candidate Sets can be saved to and loaded from a file for distribution or use in other models.

Note: The Candidate Sets defined here are common to all scenarios. They can be applied or 
not applied in certain scenarios as needed.

Assign Candidate Sets to Pipes

Every pipe that is being sized must have an associated Candidate Set (Figure 4). As Common 
Size Groups already define every pipe within them as the same Size, Candidate Sets are 
assigned to the entire Common Size Group. Multiple Common Size Groups or Not in Group 
pipes can be assigned at once by selecting the rows and using the Assign To button.

Figure 4: Size Groups can be assigned Candidate Sets to limit the sizing options
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Design Requirement Panel
Design Requirements are of critical importance in a sizing process. Without any Design Require-
ments, the system will be sized based on cost alone. This will tend to reduce pipe diameters to 
the minimum size allowed by the Candidate Set. In turn, the fluid behavior of the system may 
become physically untenable - for example, with extremely high fluid velocities.

Additionally, the very requirements of the system may not be met - certain outflows may require 
a given pressure and flow and lowering the pipe size too much may mean these needs cannot be 
met.

Design Requirements ensure that the selected pipe sizes are the minimum cost considering 
these limitations - the minimum Feasible cost.

Define Design Requirements

Pipes and Junctions can both have Design Requirements applied to them (Figure 1). In both 
cases, individual Design Requirements are defined with a Name, Parameter, Location, and lim-
iting Value.

Figure 1: Defined Design Requirements in the Define Pipe Design Requirements

Note: The Design Requirements defined here are common to all scenarios. They can be 
applied or not applied in certain scenarios as needed.

Assign Design Requirements

Created Design Requirements can be applied to any number of applicable objects, and a single 
object can have any number of Design Requirements applied to it. Common Size Groups are 
indicated here, and a Design Requirement can be applied to an entire group with ease (Figure 
2). If this is not desired, the group can be expanded and individual selections can be made.
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Figure 2: Created Design Requirements can be assigned to multiple objects
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Assign Cost Libraries Panel
If Monetary Cost is selected as the Objective, the costs of any components considered in the 
Objective must be available.

Note: For an accurate analysis, costs are required for any component that may be con-
sidered in sizing. This means that it is not sufficient to have cost data only for some 
pipe sizes, or only for certain sized junctions. Every pipe Size and Type considered in a 
given Candidate Set needs to have cost information for every parameter considered in 
the Objective.
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Cost and Energy Libraries

Libraries are not discussed in detail here. Both Cost and Energy Libraries are available as a part 
of the base application. For a thorough explanation see Cost Overview and the associated top-
ics. The Cooling System - Creating Libraries - ANS is an excellent place to start if you are unfa-
miliar with Cost Libraries.

Assigning Cost Libraries

Candidate Sets can have any number of Cost Libraries assigned to them (Figure 1). This can be 
useful as different sources of costs can be distributed among several libraries. For example, dif-
ferent Sizes of pipes may be available only from certain manufacturers, and splitting libraries by 
material source can provide clarity.

Likewise, Installation cost mat have several sub-component costs such as Shipment and Labor. 
In these cases, There would be an Installation cost for the same Material, Size and Type in two 
different libraries. Including both of these libraries will use the sum of the two costs in the Object-
ive.

Figure 1: Candidate sets can have multiple Cost Libraries assigned to them

Note: Keep in mind when assigning cost libraries that the automated sizing will consider 
the sum of costs from all selected cost libraries. Be careful to include multiple lib-
raries only if every cost would be incurred. Do not include, for example, two cost lib-
raries comparing costs from two different suppliers.

Modifying Cost Calculations

Multipliers on a given cost category for a given component can be applied here. These are useful 
in a variety of situations. A pump may be in a difficult to access location, driving up its main-
tenance cost by some factor. Or, a control valve may only operate a percentage of the time, 
meaning that less cost is required for maintenance. A pipe that must be buried would have a 
higher installation cost. There are many such examples where a specific pipe or junction in the 
system has a higher or lower cost than the value defined in the library.
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Note: Multipliers can also be applied within cost libraries. The multipliers are independent of 
each other and stack multiplicatively.

If recurring costs are considered, there will be an additional column in this table titled Service Dur-
ation. By default, recurring costs are considered for the entire System Life. If certain components 
should only be considered as incurring cost for part of the System Life, this can be defined here.

Figure 2: The Multipliers and Service Duration fields allow for modification of the library cost
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Sizing Method Panel
The Sizing Method panel controls how the automatic sizing will determine the ideal sizes.

Sizing Level

 l Continuous - Allow the sized pipes to be any diameter
 l Discrete - Restrict the sized pipes to diameters directly specified in their Candidate Set

Discrete and Continuous Sizing each have their own advantages. Discrete Sizing will present a 
set of pipes that are commercially available, as defined by the associated Candidate Sets. 
Continuous Sizing is generally much easier computationally, and hence faster.
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It is good practice to begin with Continuous Sizing and only proceed to Discrete Sizing when the 
general design of the system has been determined.

Search Method

There are many ways to approach the search for a minimum or maximum.

A foolproof way to determine if a system is really the "best" is to compare every single possible 
combination allowed. Then, it will be guaranteed that the lowest cost option has been found. 
Unfortunately, attempting to brute force the problem is only viable with a very small number of 
variables. Instead, the solution must be searched for in an intelligent manner, without explicitly 
checking every possible option.

There are several such methods available in ANS:

 l Continuous Methods - These methods use gradients - rates of change of the Objective 
(total system cost) with respect to one design variable (a pipe diameter). For the most 
basic system, the gradient will show an increasing cost with increasing pipe size. 
However, this quickly becomes less rigid when considering Design Requirements and the 
impacts a certain pipe size has on the system. A smaller pipe size may make the pipe 
itself cost less, but it may require a larger pump which costs more, effectively making the 
gradient show a decreasing cost with increasing size. Regardless, if the direction of 
decreasing cost is known, an intelligent choice to search in that direction can be made. By 
intelligently running sizing sub-problems, it is possible to find a discrete solution 
with continuous methods. The Branch and Bound method searches for a discrete min-
imum by placing additional requirements on certain variables (branching) and analyzing 
the results of the continuous solution to determine if this section of the design space is 
worth further investigation (bounding).

 l Modified Method of Feasible Directions - Reliable and applicable to most prob-
lems.

 l Sequential Quadratic Programming - Frequently the most efficient, but more sens-
itive to system definition.

 l Sequential Unconstrained - Sensitive to initial sizes and control parameters, but 
more capable of handling large numbers of uniquely sized pipes.

 l Discrete Methods - Some methods are inherently discrete, and can only consider discrete 
possibilities during the sizing process. These methods are sometimes more adept at finding 
global minimums, but are also generally much slower than gradient based methods.

 l Genetic Algorithm - Cross-breeds a random "population" of designs, mimicking bio-
logical evolution. Less likely to become trapped in a local minimum, but very slow 
compared to other methods.

Note: Full understanding of the Search Methods is not required for effective use of ANS. 
However, it is important to realize that different methods are better suited to different 
systems. It is recommended to use multiple Search Methods on any system to ensure 
the best case sizes are located, and to determine if one method is more efficient than 
the others.
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Dependent Design Cases Panel
Dependent Designs are a powerful way of accounting for different operating cases during the siz-
ing process. This panel displays information on how to create a Dependent Design Case, or if 
one exists, how the objects are related to their base objects.

Enabling Dependent Design Cases

Dependent Design Cases are enabled by checking the box on the Sizing Objective panel.

Figure 1: The Enable Dependent Design Cases option selected

Note: Once a Dependent Design Case exists, this option cannot be turned off unless the 
Dependent Design Case is completely removed.

Creating a Dependent Design Case

Once the option above has been enabled, it is possible to create Dependent Design Cases on 
the Workspace.
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This is done simply with Duplicate Special. Select all of the objects to be included in the Depend-
ent Design and select Duplicate Special from the Edit menu, and selecting the special Make 
Dependent Design Case option.

Figure 2: The Duplicate Special window can be used to create Dependent Design Cases

Selecting OK will duplicate all of the objects selected and increment their numbers by the indic-
ated value. In addition, the new objects will be related to their base objects.

Modifying the Dependent Design

Dependent Design objects represent the same object that they were created from. Logically, the 
end result must be that the objects are the same in all dependent designs. It does not make 
logical sense for pipes to be different lengths, for example. ANS will force a single pipe dia-
meters across all dependent designs.

However, there are many modifications that are reasonable, and they fall into two categories:

 l Modifying the physical configuration of the model - Environmental changes can 
affect temperature, changing processes can change the fluid, tank liquid levels can 
change, pumps may be brought online, valves may change position, and even new pipes 
may be added to represent a planned expansion. These are just a few examples of a dif-
ferent operating case being the result of a physically changed model.

 l Modifying the Design Requirements - The exact same physical system may still have dif-
ferent requirements under different conditions. A plant may have different demands dur-
ing day or night, or it may be desired to account for future production without modifying 
the piping layout. These are a couple of examples of changing Design Requirements to 
create different operating cases.
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Note: The only sizing input that can be changed for a Dependent Design are the Design 
Requirements. Remember that both the base object and Dependent Design object 
really represent just one physical object - it cannot have different cost or be of a different 
pipe material in different cases.

Reviewing Dependent Designs

As the model becomes larger and more complex, it may be difficult to tell what objects cor-
respond to others across operating cases. The Dependent Design Cases panel (Figure 2) shows 
a review of how the objects are connected:

Figure 3: The Dependent Design Cases panel

Related Topics

Sizing Window 639
Sizing Objective Panel 641
Size/Cost Assignments Panel 645
Candidate Sets Panel 649
Design Requirement Panel 652
Assign Cost Libraries Panel 653
Sizing Method Panel 655
Sizing Summary Panel 659

Sizing Summary Panel
The Sizing Summary panel gives an at-a-glance, but comprehensive, view of how the model has 
been configured for sizing.

All of the sizing input can be grouped into a few relatively simple categories. However, as the 
model becomes more complex, the relationships between these inputs can be difficult to visu-
alize. For this reason, the Sizing Summary is a relational diagram with a handful of parent nodes. 
Nodes can be turned on or off with the checkboxes above the diagram.
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Figure 1: The Sizing Summary panel on launch

Each node can be expanded to see the related entries.

Note: The Summary can be manipulated much like the Workspace - use the scrollwheel to 
zoom in and out, and pan the view with the scrollbars or by clicking the middle mouse 
button.

Figure 2: The Sizing Summary panel with options expanded

Individual objects can be expanded, showing detailed related information about them.

Figure 3: The Sizing Summary panel can show detailed related information

Clicking on a related category for a specific object will indicate the associated node(s).
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Figure 4: Associated nodes can be determined by clicking on a related category

 

Related Topics

Sizing Window 639
Sizing Objective Panel 641
Size/Cost Assignments Panel 645
Candidate Sets Panel 649
Design Requirement Panel 652
Assign Cost Libraries Panel 653
Sizing Method Panel 655
Dependent Design Cases Panel 657

Solution Progress with ANS
When a model is run with the ANS module enabled, an additional line will be shown in the Solu-
tion Progress window to indicate the progress that the ANS module has made towards reaching 
the specified goal. There are three fields displayed, as can be seen in Figure 1 below.

The "Best Feasible Cost" and "Current Cost" fields indicate the total cost for the model in the 
default units, as indicated in the Solution Progress window. The Current Cost field shows the 
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cost calculated for the last design iteration, while the Best Feasible Cost field tracks the cost of 
the best solution so far that meets all design requirements.

The field on the far right of the Sizing Calls to Solver line tracks the total iterations performed by 
ANS. For every ANS iteration, ANS makes a call to the hydraulic solver in Fathom to determine 
the hydraulic solution for the current sizing solution. Thus, this value will always be smaller than 
the flow and head iterations.

Other Actions

If the solution is paused by clicking the Pause button in the Solution Progress window, there are 
several options that can be selected form the Other Actions window to assist with convergence.

Selecting Solution Control allows the Solution Control options to be adjusted before calculations 
are resumed. This is not recommended unless you have a good understanding of the para-
meters in theSteady Solution Control Group, or this has been suggested by AFT Technical Sup-
port.

The Sizing Control option provides a file with detailed information on the sizing parameters being 
used by the Sizing Engine. This can provide insight for cases where ANS is not converging, or is 
taking a long time to converge.

The Accept Sizing option will be available from the Other Actions window if the Genetic 
Algorithm is selected on the Sizing Method panel. This option allows the user to stop the iter-
ations and accept the design with the Best Feasible Cost as the solution for the model. Accepting 
the sizing solution early is helpful for models which have been running for a long time, without 
seeing any significant improvement on the Best Feasible Cost for the model. Rather than spend-
ing additional time on find the absolute best design, it may be desired to accept the design that 
gives the current Best Feasible Cost instead to save time.
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Figure 1: The Solution Progress window has an additional line to show information on the ANS Calls 
to Solver when the Fathom model is run with ANS enabled

Sizing Results

Automatically Selected Pipe Sizes

The pipe sizes corresponding to the best case Objective value are reported in the Output Win-
dow.

Figure 1: The sizing tab of the output window shows the pipe sizes indicated by the ANS module
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Cost Report

The Cost Report is displayed in the top section of the Output Window. It will display the appro-
priate variable for the Objective (e.g. kilograms for a Weight sizing). All Cost Libraries that were 
used in the generation of the report are listed in Library Sources. It is described in detail in Cost 
Report. 

Design Requirement Status

Whether or not a Design Requirement is Active can have important bearing on system design 
decisions.

Values in yellow are active. Values highlighted in blue are Design Requirements that were active 
during Continuous sizing, and may appear inactive after Discrete sizing. Un-highlighted values 
are inactive.

Figure 2: Active Design Requirements in the Output window are indicated by blue highlighting

Changing Input Sizes to Resulting Pipe Sizes

 l Set Pipes to Resulting Pipe Sizes - The Transfer Results to Initial Guesses takes on 
additional functionality when ANS is enabled. After a sizing run, you can use this feature 
to transfer the resulting pipe sizes to the pipes. For certain Search Methods, this can 
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greatly speed up the solution process for future sizing runs.
 l Generating a Disconnected Scenario - Generating a disconnected scenario allows the 

sizing results to be saved as input in a new scenario. This can be useful to keep track of 
results from different methods, or to tweak the sized solution if required.

Output Control

Items included in the Cost Report can be changed by adding/removing items from the Cost 
Report tab on the Display Parameters tab of Output Control. Similarly, the items shown in the Siz-
ing tab can be controlled from the Pipe Sizing tab.

Workspace Integration

Modifying Sizing from the Workspace

Right-clicking anywhere on the Workspace allows the selection of existing Common Size 
Groups:

Figure 1: Objects can be added to Common Size Groups from the right-click menu

Selected pipes can be moved to a new or existing Common Size Group:
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Figure 2: Pipes can be added to a previously created Common Size Group

Changes will be previewed before they are applied:

Figure 3: Preview of changes to Common Size Groups

Sizing Level Assignments and Design Requirements can also be applied in this manner.

Viewing Assigned Common Size Groups and Design Requirements

Additionally, each Common Size Group or Design Requirement can have a unique color applied 
to it by selecting the appropriate option under the View menu.
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Figure 4: Common Size Groups organized by color

Junction Loss Factors
During the sizing process, the size of junctions will implicitly change along with the size of the 
neighboring pipes.

Junctions which use handbook loss factors will automatically adjust their loss value when the 
pipe size changes. For example, a Bend junction defined as a Smooth Bend uses built-in rela-
tionships to determine a loss based on pipe area and r/D. As the pipe size changes, this loss 
value will change automatically.

However, a built-in loss model that updates for different pipe sizes is not always available. Many 
junctions allow the specification of a Loss Multiplier Table as seen below.
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Figure 1: Loss Multiplier Table

With a base loss factor (K-Factor, in Figure 1), ANS can use this table to determine how much to 
adjust the loss by when changing the associated pipe diameters. This can be done by inputting 
the Diameter and K-factor columns, specifying one of the rows as a multiplier of one, then using 
the Calculate Multipliers button below the table.

Improving and Troubleshooting the Sizing Process

Check the Continuous Solution First

For small problems with less than ten independently sized pipes, it should be possible to obtain a 
Discrete solution in a few minutes or less. Larger problems can take a long time to solve, so it is 
important to point the sizing process in a good starting direction.

The Discrete problem is generally much more difficult to solve than the Continuous, and most of 
the Discrete methods depend on an initial Continuous solution. Therefore, it is important to 
ensure the Continuous solution is good. There are a few guidelines to consider:

 l Check the quality of the Continuous Solution before proceeding to the Discrete 
Solution - If the Continuous solution is not ideal, then the methods which use the Continu-
ous solution for a starting point will have a poor Discrete solution as well.

 l Ensure the Discrete Solution is worse than the Continuous Solution - A Discrete 
solution always places further limits on the solution, and should therefore have a negative 
impact on the Objective. If the Discrete solution is better than the Continuous, this means 
that either the Continuous solution is poor, or that there are numerical issues affecting the 
solution by some small amount. If the difference is significant, this likely indicates an issue 
with the sizing process, the solver, or user input.

 l Check for Consistent Continuous Solutions - Using any of the Continuous methods 
should give comparable results. If this is not the case, it may indicate that ANS is finding 
Local Minimums with one or more of the methods.
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 l Use the best Continuous Solution to Proceed - If one of the methods is finding a bet-
ter Continuous Solution than the others, and the results are reasonable, this result should 
be used as the basis for the Discrete Solution.

Determine if the solution is a Local Minimum

It is possible for ANS to get stuck in a local minimum and not find the global minimum. If this is 
happening, there are a few things to try:

 l Change the initial pipe sizes
 l Use a different Sizing Method - Pure Discrete Methods are inherently better suited to 

finding global minimums.
 l Temporarily remove some of the Design Requirements - This can help identify 

Design Requirements that are actually driving the sizing process. Having too many 
Design Requirements can make the system much more difficult to solve with minimal 
gain.

Use a Different Search Method

The different search methods have different strengths and weaknesses. It is possible that one 
method will struggle with a problem that others can easily find a solution for.

It is also a good indicator that the best solution has been found if different methods agree.

Use Logical Design Requirements

 l Design Requirements in Closed Areas of a Model - ANS will attempt to identify 
Design Requirements that are irrelevant and ignore them during the sizing process. 
However, depending on ANS to do this is not advised. Design Requirements on closed 
areas should be removed. For example, it is not meaningful to apply a minimum flow rate 
requirement on a closed pipe - it is possible that ANS will not find a Feasible solution if 
such a Design Requirement is left in place.

 l Conflicting Design Requirements - It is easy to apply requirements that are impossible 
to meet. For example, a minimum flow rate greater than an in-line Flow Control Valve set-
point, a maximum pressure lower than the connected Assigned Pressure, or a maximum 
speed on a pump that has been manually set to a higher speed. With these types of 
Design Requirements, ANS will (correctly) conclude that no feasible design exists, and 
the results may not be meaningful.

Change the Initial Pipe Sizes

The sizing process uses the initial pipe sizes defined by the user as a starting point. It is possible 
to start the sizing process in an area that poses difficultly. Increasing or decreasing the initial 
pipe sizes can help.
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Simplify the Problem

It is good practice to solve a simpler problem first, before proceeding to a more complex prob-
lem.

 l Be sure the model solves as expected before using ANS - Any issues that are 
present in the base hydraulic model will also be present in the sizing process.

 l Find a Continuous Solution before searching for a Discrete solution.
 l Use a small number of Design Requirements, and add them as necessary. For 

troubleshooting purposes, it can be useful to remove Design Requirements that are 
necessary in the final design.

 l Decrease the number of variables - Adding more pipes to Common Size Groups, and 
limiting the number of Common Size Groups, can make the problem much easier to 
solve.

Sizing Components Other Than Pipes

Sizing Pumps

While pumps are not directly sized by ANS, they are able to be indirectly sized by including an 
estimation of their cost. Their actual behavior is a result of the system. The appropriate sizing of 
a pump requires a Cost Library and understanding of standard Pump Sizing.

At the most basic, pump sizing is simply selecting a pump that is capable of meeting pressure 
and flow requirements. Too often this involves selecting a pumps that is larger than required, 
under the assumption that a bigger pump will provide for operational margin. Unfortunately, 
over-sizing a pump has negative impacts on reliability and efficiency, both of which incur higher 
cost. Over-sizing could also require the installation of ultimately unnecessary valves or restric-
tions to bring the flow back down to where it should be.

The ability to appropriately size pumps is built into AFT Fathom. By using the Pump Sizing 
option, AFT Fathom will indicate the amount of head required to deliver the specified flow. It is up 
to the user to find a pump that operates at its BEP at the calculated flow and head.

The best size of pump to use when the pipe sizes are allowed to change as well is harder to 
handle, and requires iteration. See Sizing Pipes and Pumps Concurrently.

Note: Certain pump configurations require special attention in ANS. See Special Concerns 
For Sizing Pumps.

Sizing Control Valves

Control Valve sizing is similar - AFT Fathom already has all of the tools needed to size a Control 
Valve for a specific set of pipes. AFT Fathom will report the Cv or K Factor necessary for a Con-
trol Valve to attain a given setpoint. From this value, an appropriate valve could be selected for 

- 670 -



Add-on Modules

minimizing cost. It would be typical to select the smallest Control Valve possible while still remain-
ing in a good control range - typically 20-80% open.

Like pumps, selecting the best Control Valve while pipe sizes are changing is more complex. 
See Sizing Pipes and Control Valves Concurrently.

Sizing Other Junctions

Any other junction can be included in the sizing process as long as cost data exists.

For example, a Bend can have costs associated with it via a Table of Costs. From this table, 
ANS can determine the cost for a given diameter. ANS will assume that the Bend is of a dia-
meter equal to the upstream pipe inside diameter, and include the corresponding cost in the 
Objective. If certain components are very expensive compared to piping, this could affect the 
selection of pipe sizes.

Sizing Ducts

Duct sizing has special considerations discussed in Sizing Duct Systems.

Related Topics

Special Concerns For Sizing Pumps 671
Sizing Pipes and Pumps Concurrently 673
Sizing Pipes and Control Valves Concurrently 677
Sizing Pipes, Pumps, and Control Valves Concurrently 680
Sizing Duct Systems 681

Special Concerns For Sizing Pumps
There are several special concerns with sizing pumps. For a general overview of the process of 
sizing pumps see: Sizing Pipes and Pumps Concurrently.

End of Curve Flow Rate

Centrifugal pumps typically have an end of curve, or runout, flow rate. They cannot operate reli-
ably past this point. This can be entered in Pump Configuration, but this will not actually prevent 
the model from running the pump with higher flows. Instead, the curve will be extrapolated past 
this point and a warning will be generated.

If it is important to prevent the sizing results from considering flows in this region as valid, a 
Design Requirement for maximum flow rate equal to the end of curve value should be placed on 
the pump.
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Partial Service Duration

Without other input, ANS will assume that any pump included in the sizing operates constantly.

If this is not the case, then either an appropriate Service Duration or Multiplier should be defined 
in Assign Cost Libraries.

Variable Speed Pumps with Partial Control Applicability

ANS can size pumps with a user defined fixed speed other than 100%, or a controlled pump that 
modifies speed to meet a flow or pressure setpoint. However, pressure-type variable speed con-
trolled pumps allow the user to optionally enforce Control only when the actual pressure is 
above/below a setpoint. This causes an issue with sizing.

If ANS allowed the pump to change from a fixed 100% speed pump (non-controlling pressure) to 
a variable speed pump (when the setpoint is violated), it would be changing the characteristics of 
the system. This has a direct impact on the sizing process, so it cannot be allowed - ANS will 
always model this type of pump as fixed 100% speed.

Either an Always Controlling pump must be specified, or Design Requirements on pressure must 
be added to the appropriate pipes.

Unrealistic Sizing Results From Dependent Design Cases

If there are two design cases that have different pump flow rate requirements, the ideal pump 
curve may be unrealistic.

For example, one operating case may require 500 gal/min, and another may require 750 gal/min. 
It is desired to select the ideal pump. After running ANS, it is determined that the pump should 
generate 50 feet of head in the 500 gal/min case and 70 feet in the 750 gal/min case. To meet 
this requirement, we need a pump curve that increases from 50 feet of head to 70 feet with a 
large increase in flow. This is an unrealistic demand.

To prevent this, a head rise Design Requirement can be added to maintain the high flow head at 
70-90% of the low flow head. This will effectively force the sizing to consider only realistically 
shaped pump curves.

Related Topics

Sizing Components Other Than Pipes 670
Sizing Pipes and Pumps Concurrently 673
Sizing Pipes and Control Valves Concurrently 677
Sizing Pipes, Pumps, and Control Valves Concurrently 680
Sizing Duct Systems 681
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Sizing Pipes and Pumps Concurrently
The cost of a pumped piping system clearly depends on both the cost of the pipes, and the 
pump. It is tempting to select pumps and pipes in stages, but this is unlikely to produce the low-
est cost solution. Selecting a smaller pump may not appear to be viable, but changing the pipe 
sizes may make it viable. Like sizing pipes alone, overall costs can often be decreased by 
increasing the cost of one or a few components. Attempting to find the lowest cost option manu-
ally quickly becomes impractical even with a small number of variables.

Optimal Pumping System Operating Point (OPSOP)

A pump's BEP is considered the ideal place to run a pump as the efficiency is highest, and thus 
cost is lowest. Similarly, any piping system will have a lowest cost design.

Whether a pump is running at BEP, however, depends on the piping system, and the lowest cost 
piping system depends on the pumps it contains. What may be the lowest cost piping system for 
a given pump, may not me the lowest possible cost option. It is possible that a cheaper pump 
could be selected with the correct piping adjustments while still maintaining all Design Require-
ments.

The point at which no adjustments to pump or system will result in lower cost is known as the 
Optimal Pumping System Operating Point (OPSOP). One way to determine this point is to 
exhaustively size the system for different potential sizes of pumps. This is inefficient, but can be 
used to construct a visual representation of the OPSOP as shown below.

Figure 1: The OPSOP of a given system. Note that every point is an ideal sizing solution for the given 
pump size

If the sizing process is approached in stages, rather than concurrently, it is easy to get a result 
that says, for example, a 60 foot head rise pump is required. The best case system for the 60 
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foot head rise pump has a minimum cost of about $36,500. However, allowing the pump to 
change as well can result in a system more than 7% cheaper.

Process Outline

Find the Approximate Pump Size

 1. Model the pump with the Pump Sizing option, fixing the flow to the desired amount. AFT 
Fathom will determine the required head rise.                     

 l Include an estimate of Nominal Efficiency.                         
 l Optionally, include Nominal NPSHR.                         

 2. Add the pump to an Engineering Library.                     
 l Attach a Cost Library to the Engineering Library if one does not already exist.                         
 l Create a Power vs. Cost Scale Table for the pump with estimated cost values.                         

 3. Select the appropriate options in the Sizing Window.                     
 l The cost for the pump will only be included in the Objective if it is specified to be 

included in Size/Cost Assignments.                         
 l If there are several pumps that will ultimately be of the same type, they should be 

placed into a Maximum Cost Group.                         
 4. Run ANS.                     

 l Investigate the resulting pump size.                         
 l Update the Nominal Efficiency and NPSHR based on the result. Also update the 

cost information if necessary. If the pump accounts for a large portion of the overall 
cost, accurate values here are more important.                         

 l Repeat the process as necessary, until reasonable estimates for cost at the res-
ulting operating point are obtained.                         

Compare Candidate Pumps             

 1. Locate accurate cost information and pump curves for the candidates.
 l Incorporate these values into Engineering and Cost Libraries.                         

 2. Compare the sizing results for each candidate pump.                     

Estimating Pump Costs

Without knowing specifically what type or size of pump is going to be included in the system, the 
pump behavior must be approximated. The behavior is approximated with the Pump Sizing 
option, indicating a design flow. We also need to approximate cost. Because energy cost is often 
the largest component of a pump's overall cost, and this cost is directly related to the pump's 
power, it makes sense to correlate other pump costs to power as well.
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Figure 2 - Total Initial Costs for a series of pumps

Keep in mind that such a comparison is only valid for the selected range of pumps. Different 
designs of pumps, or pumps from different manufacturers may follow different relationships. One 
manufacturer may offer cheaper low-power pumps, while their competitor offers cheaper high-
power pumps. This cost information is represented in ANS as a Power vs Cost Scale Table. This 
requires the creation of a Cost Library including the pump as a Custom Component.

Because we do not know what specific pump is going to be used, we also do not know exactly 
how much it will cost to run or maintain it.

As part of our sizing process, we must assume that the pump runs at some Nominal Efficiency. 
AFT Fathom will calculate the fluid power required at any given flow and head rise. However, a 
pump or motor is not perfectly efficient and will therefore require more power than the fluid 
power. This affects the pump selection, and therefore cost, so it is important to include an estim-
ate on efficiency. 

Note: It may seem that including a nominal efficiency is not important, as selecting a certain 
pump size will minimize the initial pump cost regardless of this value. However, this 
does not consider the cost of power over a long period, which is often a driving factor in 
sizing. Also, it is important to get the relative cost of the pump correct as this can affect 
the best sizing. The nominal efficiency will require more power and hence a more 
expensive pump - as this is included in the Objective, it is important to account for.

If maintenance costs are expected to be significant, it is important to include an estimate of these 
costs. Again, this could be accounted for with a Power vs Cost Scale Table.
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The Approximate Sizing Solution

When the initial model is defined, the sizing configuration complete, and the pumps appropriately 
defined with approximate cost information, the automated sizing can take place.

ANS will size the pipes of the system to minimize cost while obeying Design Requirements. It 
will now include a power-based cost for the pump. Without cost information on the pump, ANS 
would tend to select small pipe sizes to reduce cost without any negative consequence. 
However, smaller pipe sizes have higher frictional loss, which requires greater head rise at the 
pump, and hence higher cost. By including pump cost information, the balance between pump 
costs and piping costs can be found.

However, this is still an estimate because we are not modeling a real pump. Fixing the flow and 
nominal efficiency are good design tools but it is important to represent a real pump curve not 
only to account for real effects, but also to ensure that the desired pump can actually be 
acquired.

If the pump costs are a significant portion of the overall cost, the estimates made for 
cost and nominal efficiency should be refined and the system re-sized before pro-
ceeding.

Sizing with a Real Pump

Now that there is a good idea of the size and cost of pump we are looking for, we can select a 
real pump we may want to use.

It will rarely be clear which pump is the best choice. First, the exact operating point determined 
from the approximate solution is likely unavailable in a commercially available pump. Second, dif-
ferent pumps have different costs - even if a pump with the exactly correct specifications is avail-
able, it may be much more expensive than a pump that is slightly mismatched. This cost 
difference could mean the cheaper pump is better overall, despite not appearing to be the ideal 
choice.

The best course is to select several candidate pumps, and size the system independently with 
each candidate pump. It is important that accurate pump curves and cost information be 
included for each candidate, as this no longer meant to be an estimation. After testing each can-
didate pump, the system with the lowest overall cost can be selected.

If the sizing results differ significantly in this stage this could indicate that the pump is poorly 
matched, that there was an error in the process, or that the system is dominated by pump costs 
and therefore very sensitive to the estimations.

Related Topics

Sizing Components Other Than Pipes 670
Special Concerns For Sizing Pumps 671
Sizing Pipes and Control Valves Concurrently 677
Sizing Pipes, Pumps, and Control Valves Concurrently 680
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Sizing Duct Systems 681

Sizing Pipes and Control Valves Concurrently

Process Outline

Find the Approximate Control Valve Size

 1. Model the Control Valve with the appropriate settings. AFT Fathom will determine the 
required loss.

 2. Add the Control Valve to an Engineering Library.
 l Attach a Cost Library to the Engineering Library if one does not already exist.
 l Create a Cv vs. Cost Scale Table for the control valve with estimated cost values.

 3. Select the appropriate options in the Sizing Window.
 l The cost for the control valve will only be included in the Objective if it is specified 

to be included in Size/Cost Assignments.
 l If there are several control valves that will ultimately be of the same type, they 

should be placed into a Maximum Cost Group.
 4. Run ANS.

 l Investigate the resulting control valve size.
 l Update the cost information if necessary. If the control valve accounts for a large 

portion of the overall cost, accurate values here are more important.
 l Repeat the process as necessary, until reasonable estimates for cost at the res-

ulting operating point are obtained.

Compare Candidate Control Valves

 1. Locate accurate loss and cost information for the candidates.
 l Incorporate these values into Engineering and Cost Libraries.

 2. Compare the sizing results for each candidate control valve.

Reference Pressure Concerns

It is impossible to generate a unique solution from a system (or part of a system) entirely 
bounded by fixed flows. For an in-depth discussion of this issue and common areas where it may 
occur see Role of Pressure Junctions - Detailed Discussion.

Particularly common when sizing a system is the tendency to place a Flow Control Valve imme-
diately downstream of a Pump modeled as a fixed flow. This situation has no unique solution, as 
discussed in the Sizing Pumps with Flow Control Valves section of the previous topic.

The typical solution to this issue is to temporarily change the Flow Control Valves to Pressure 
Drop Control Valves where necessary, until a pump curve is selected and specified. Effectively, 
this is the equivalent of specifying that our Flow Control Valve has a pressure drop requirement 
equal to the Pressure Drop Control Valve setpoint.
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Control Valves and Design Requirements

ANS will always attempt to minimize or maximize the value of the Objective. ANS does not 
know if the resulting design is realistic and this has no impact on the sizing. It can 
present results that would be physically impossible to attain in the field.

AFT Fathom is no different in this regard - it is possible to specify a system that would require 
physically unrealistic behavior. For example, the liquid pressures are allowed to drop below 
vapor pressure. When possible, there will be Warnings if this type of behavior is detected, but the 
solver does not make any attempt to prevent this situation. To avoid these unrealistic con-
figurations, the user must inspect the output and determine the changes required on the system 
to avoid the situation. In other words, the user must adjust the design of the system to meet 
desired or realistic behavior - a Design Requirement.

As an analysis tool, AFT Fathom does not allow the user to directly impose these requirements. 
ANS, on the other hand, is a design tool and actively selects inputs to meet certain spe-
cifications. It would not be unusual to specify a minimum pressure Design Requirement to pre-
vent the vapor pressure issue.

How does this relate to Control Valves? Control Valves in AFT Fathom will, by default, force con-
trol. This means that the system will be able to behave unrealistically in order to meet the set-
point specified, which can be useful in a design stage. As it would not be useful for a Control 
Valve to be unable to achieve its setpoint during the sizing process, Always Control 
(Never Fail) is automatically enabled for sizing.

Consider a simple case of a Flow Control Valve regulating flow between two reservoirs. It is 
desired to size this system for lowest pipe weight.

Because of Always Control (Never Fail), the Flow Control Valve is essentially able to act like a 
pump - providing "free" pressure to the system in order to meet the setpoint. As the cost of this 
"pump" is not considered, the sizing process is trivial - we can simply select the smallest pipe 
size available, as our "pump" will simply make up for the increase in pressure loss.

Clearly, it is not realistic for a Control Valve to add pressure to a system. So why don't we allow 
our Flow Control Valve to not meet its setpoint, as it would in reality? If the Control Valve is 
allowed to do so, we are essentially stating that the flow it is attempting to maintain is not actually 
a requirement. If this is the case, then again we will find that the "ideal" sizing solution is to select 
the smallest pipe size available. The Flow Control Valve will fully open in an attempt to allow 
more flow, but in the end the flow will be below the setpoint. However, our pipe weight will cer-
tainly be minimized.

What is the solution? We need to add a Design Requirement. It may seem intuitive to add a 
minimum flow requirement to our system as we are attempting to control flow. However, this will 
not solve the problem because the Control Valve will still simply add pressure to meet the set-
point. Furthermore, adding Design Requirements that conflict with the model itself can cause 
problems.

Instead, a Design Requirement should be added related to the position of the Control 
Valve. The position can be represented either directly as an Open Percentage if that data is avail-
able, or as a form of loss. It is typical that a Control Valve is designed to operated within a certain 
range of positions - often 20-80% open. It would not be useful to have a Control Valve designed 
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to operate at 100% open, as a slight variation in flow could cause it to not meet its setpoint and 
open fully.

By adding a Design Requirement on minimum dP/dH or maximum Cv/Open Percentage we pre-
vent unrealistic behavior and return a meaningful sizing result.

Note: It is always required to add this Design Requirement for Control Valves in the sizing 
model - even if the junction is not marked to be Sized in Size/Cost Assignments. Includ-
ing a Control Valve in Sizing adds its cost to the Objective which can influence the res-
ult, which is not always a concern. However, the behavior described above is always 
true and hence always needs a Design Requirement.

Optimal Control System Operating Point

Just like sizing pipes and pumps concurrently, there is an optimal size of a control valve that min-
imizes total system cost. Approaching the problem in "stages" rather than concurrently can eas-
ily miss the lowest overall cost solution.

Like the pump process, we do not know specifically what Control Valve is going to be used in the 
early stages of the process so we need to estimate the cost.

For Control Valves, the logical choice is to estimate with a Cost vs Cv relationship. This inform-
ation will be represented for the particular component in a Scale Table.

Note: When defining a Cost vs Cv Scale Table, keep in mind that this table is relating the cur-
rent Cv to the cost of the device. For example, if the Control Valve has a Design 
Requirement to be 80% open, and ANS calculates a corresponding Cv of 120, the cost 
used from the Scale Table will be that for a Cv of 120, not the full-open value of the con-
trol valve. This is important to keep in mind when creating the scale table, as man-
ufacturer cost information will often be in the form of full-open Cv vs cost.

The Approximate Sizing Solution

When the initial model is defined, the sizing configuration complete, and the control valves appro-
priately defined with approximate cost information, the automated sizing can take place.

ANS will size the pipes of the system to minimize cost while obeying Design Requirements - 
including the Design Requirement on position discussed above. However, this is still an estim-
ate because we are not modeling a real control valve.

If the control valve costs are a significant portion of the overall cost, the estimates made 
for cost should be refined and the system re-sized before proceeding.

Sizing with a Real Control Valve

Now that there is a good idea of the size and cost of control valve we are looking for, we can 
select a real control valve we may want to use.
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It will rarely be clear which control valve is the best choice. First, the exact operating point 
determined from the approximate solution is likely unavailable commercially. Second, different 
valves have different costs - even if a valve with the exactly correct specifications is available, it 
may be much more expensive than one that is slightly mismatched. This cost difference could 
mean the cheaper valve is better overall, despite not appearing to be the ideal choice.

The best course is to select several candidate valves, and size the system independently with 
each candidate. It is important that accurate loss and cost information be included for each can-
didate, as this no longer meant to be an estimation. After testing each candidate, the system with 
the lowest overall cost can be selected.

If the sizing results differ significantly in this stage this could indicate that the control valve is 
poorly matched, that there was an error in the process, or that the system is dominated by con-
trol valve costs and therefore very sensitive to the estimations.

Related Topics

Sizing Components Other Than Pipes 670
Special Concerns For Sizing Pumps 671
Sizing Pipes and Pumps Concurrently 673
Sizing Pipes, Pumps, and Control Valves Concurrently 680
Sizing Duct Systems 681

Sizing Pipes, Pumps, and Control Valves Concurrently
Many systems contain both pumps and control valves, which makes the sizing process some-
what more complex.

Like sizing pipes and pumps or pipes and control valves concurrently, there are adjustments and 
estimations that must be made when sizing all three in parallel. The overall goal and con-
siderations that must be taken into account are described in detail in those topics and will not be 
repeated here. Only the outline of steps will be presented for brevity.

Process Outline

Find the Approximate Pump and Control Valve sizes

 1. Model the pump(s) with the Pump Sizing option, fixing the flow to the desired amount.
 2. Model the Control Valve(s) with the appropriate settings.

 l If the control valve(s) are Flow Controls downstream of the pump(s) to be sized, 
temporarily set them to be Pressure Drop Control Valve with a setpoint equal to the 
minimum required pressure drop.

 l Any non-Pressure Drop control valves will require a Design Requirement of min-
imum dP/dH or maximum Cv/Open Percentage.

 3. Add the pump(s) and control valve(s) to one or several Engineering Libraries.
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 l Attach a Cost Library to the Engineering Library if one does not already exist.
 l Create a Power vs. Cost Scale Table for the pump with estimated cost values.
 l Create a Cv vs. Cost Scale Table for the control valve with estimated cost values.

 4. Select the appropriate options in the Sizing Window.
 l The cost for the pump(s) and control valve(s) will only be included in the Objective 

if it is specified to be included in Size/Cost Assignments.
 l If there are several pumps or control valves that will ultimately be of the same type, 

they should be placed into Maximum Cost Groups.
 5. Run ANS.

 l Investigate the resulting pump size.
 l Update the Nominal Efficiency and NPSHR based on the result. Also update the 

cost information if necessary. If the pump accounts for a large portion of the overall 
cost, accurate values here are more important.

 l Repeat the process as necessary, until reasonable estimates for cost at the res-
ulting operating point are obtained.

Compare Candidate Pumps

 1. Locate accurate cost information and pump curves for the candidates.
 l Incorporate these values into Engineering and Cost Libraries.

 2. Compare the sizing results for each candidate pump.

Select the two or three best candidate pumps and compare candidate Control Valves.

 1. If necessary, change Pressure Drop Control Valves back to Flow Control Valves.
 l This will require a Design Requirement of minimum dP/dH or maximum Cv/Open 

Percentage.
 2. Locate accurate loss and cost information for the candidate control valves.

 l Incorporate these values into Engineering and Cost Libraries.
 3. Compare the sizing results for each candidate control valve, under each candidate pump.

Related Topics

Sizing Components Other Than Pipes 670
Special Concerns For Sizing Pumps 671
Sizing Pipes and Pumps Concurrently 673
Sizing Pipes and Control Valves Concurrently 677
Sizing Duct Systems 681

Sizing Duct Systems
A Pipe Material Library of all possible rectangular duct sizes is needed, as is the case with 
Cylindrical pipe.
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If there are no geometric restrictions, the Candidate Set should use all of the duct sizes. Certain 
areas of the system may have maximum width or height restrictions. In these areas, a different 
Candidate Set should be created from the same Pipe Material Library.

There are two variables for a rectangular duct - height and width, whereas a normal pipe only 
has one - diameter. ANS treats these variables as independent when solving for the ideal size. 
This means that duct Candidate Sets must have corresponding widths and heights for every duct 
dimension.

For example, consider 3 duct sizes in a Candidate Set: 8x8, 10x10, and 12x12. Because width 
and height are considered independent by ANS, it is possible that 8 would be selected for width 
and 10 for height. However, 8x10 is not in the Candidate Set. ANS will warn that the Candidate 
Set is incomplete when this is detected.

Related Topics

Sizing Components Other Than Pipes 670
Special Concerns For Sizing Pumps 671
Sizing Pipes and Pumps Concurrently 673
Sizing Pipes and Control Valves Concurrently 677
Sizing Pipes, Pumps, and Control Valves Concurrently 680

Search Methods
ANS includes several different Search Methods for finding the best sizing solution. Some meth-
ods are very similar, while others are entirely unique, and each is particularly suited to certain 
kinds of mathematical problems.

It is impossible to state that one method is always better or worse than another. The quality and 
speed of each method depends on the specific system being solved and the sizing input. A 
method that excels for one model may not be the best choice for another model.

Note: All of the methods share a common goal of minimizing (or maximizing) an Objective. 
The analytical approach driving the sizing (the hydraulic solver) does not vary with the 
selected method. This means that the best sizing solution across all of the methods is 
the best overall solution. It is good practice to test several of these methods for 
any model.

 l Modified Method of Feasible Directions - Reliable and applicable to most problems.
 l Sequential Quadratic Programming - Frequently the most efficient, but more sensitive to 

system definition.
 l Sequential Unconstrained - Sensitive to initial sizes and control parameters, but more cap-

able of handling large numbers of uniquely sized pipes.
 l Genetic Algorithm - Cross-breeds a random "population" of designs, mimicking biological 

evolution. Less likely to become trapped in a local minimum, but very slow compared to 
other methods.
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Modified Method of Feasible Directions
A Continuous Search Method available in the Sizing Method panel.

The Modified Method of Feasible Directions (MMFD) finds the best case design by determining a 
search direction based on the Objective function and the active Design Requirements. When 
there are no active Design Requirements, the search direction will simply be in a direction influ-
enced by the current gradient and previous search directions.

When there is an active Design Requirement, following the direction of greatest change may 
make the design Infeasible. Instead, the search direction is modified to keep the solution in the 
feasible region. If a Design Requirement is Violated, the search direction will attempt to return 
the solution to the feasible region as quickly as possible.

This is the most robust method and can handle a wide variety of problems.

Note: Branch and Bound rapidly becomes inefficient with an increase in independent vari-
ables. For discrete optimization with more than 10 independently sized pipes, the 
Sequential Unconstrained or Genetic Algorithm methods should be considered.

Sizing Control Parameters

 l Finite Difference Gradient Calculation - The most likely parameters to be changed, 
gradient calculation directly influences the search direction. See a detailed discussion in 
Estimating the Gradient.

 l Method - Forward or Central, directly affects the quality of the gradient at the cost 
of runtime. Central gradients are more accurate but require about twice as many 
hydraulic solutions.

 l Step Size - How much to perturb the pipe sizes to determine the gradient. If the 
Objective was known exactly, it would make sense to make these values very 
small. However, as Fathom itself is an iterative solver, the Objective is only known 
to within a certain tolerance. Making the Finite Difference Step Size too small actu-
ally introduces uncertainty into the gradient and can therefore generate poor 
search directions making the process take longer, if a solution can be found at all. 
A Step Size that is too large has a similar effect, so it is important to select an 
appropriate value between the two extremes. The best value to use depends on 
the system in question - when in doubt, use the default.

 l Print Text Debug File - Generate a tab-separated file reporting on each call to the 
hydraulic solver. Actual pipe sizes are presented along with current Objective value and 
Design Requirement status.

Caution: The Advanced Control Parameters below should not be changed under normal cir-
cumstances without the direction of AFT Support.

 l Sizing Level Convergence
 l Maximum Iterations - This value is the number of sizing iterations, not the num-

ber of hydraulic solutions allowed. Generally, the hydraulic solution is by far the 
slowest part of the process, and as the number of uniquely sized pipes increases, 
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so does the number of required hydraulic solutions. A problem with 100 inde-
pendently sized pipes would require, at minimum, 100 hydraulic solutions just for 1 
sizing iteration. That said, it is important to have an adequate number of sizing iter-
ations regardless of the number of variables - if the process is stopped pre-
maturely, the ideal sizes have not been found.

 l Consecutive Iterations for Convergence - The sizing process will be repeated 
at least this number of times while satisfying the convergence criteria. It is helpful 
to allow additional iterations because the sizing process can occasionally make 
little change in one iteration and then significant change in the next.

 l Relative Tolerance - Changes smaller than this relative amount (default of 0.1%) 
are considered small enough to be converged. Note that the number of iterations 
requiring a change in the value of the Objective smaller than this amount can be 
modified.

 l Absolute Tolerance - The value entered here is multiplied by the initial Objective 
value. The resulting value is considered as an absolute tolerance. By default, the 
Objective is scaled to 1,000 meaning that the default value of 0.0001 results in an 
absolute tolerance of 1,000*0.0001 = 0.1. Objective values smaller than 0.1 will 
use the absolute criterion instead of the relative.

 l Sequential Unconstrained Parameters
 l Sequential Unconstrained Parameters - See Sequential Unconstrained.

 l Design Requirement Tolerances
 l Violated - A very small positive value, which allows Design Requirements to be 

violated. It is important to allow this small violation for numerical reasons, as 
attempting to force values to zero is often difficult computationally.

 l Active - This small negative number determines how close to the Design Require-
ment the Objective can be before the Design Requirement influences the search 
direction. This value is updated automatically during the sizing process.

 l Scaling Parameters
 l Desired Objective Scaled Value - In some cases it is helpful to scale the value of 

the Objective. Very large or very small unscaled Objective values can present 
numerical issues, and scaling can help with this.

 l Scale Factor for Design Requirements
 l Common - Design Requirements are always scaled (dividing by the user 

defined quantity) for numerical reasons. This factor allows additional scal-
ing.

 l Violated Tolerance - This can be used to reduce the value of Violated 
Design Requirement Tolerance. This can be useful if the small violation is 
unacceptable for a feasible design.

 l Print Optimizer Debug File - Generate a debug file detailing the normalized and gen-
eralized optimization process.

Related Topics

Search Methods 682
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Sequential Quadratic Programming 685
Sequential Unconstrained 687
Genetic Algorithm 690

Sequential Quadratic Programming
A Continuous Search Method available in the Sizing Method panel.

Sequential Quadratic Programming (SQP) finds the best case design by solving a series of quad-
ratic approximations to the Objective Function. Each of these "Sub-Problems" is solved with the 
Modified Method of Feasible Directions. This method is often the best and most efficient if the 
problem is numerically well defined. Sizing with this method is always worth checking.

Note: Branch and Bound rapidly becomes inefficient with an increase in independent vari-
ables. For discrete optimization with more than 10 independently sized pipes, the 
Sequential Unconstrained or Genetic Algorithm methods should be considered.

Sizing Control Parameters

 l Finite Difference Gradient Calculation - The most likely parameters to be changed, 
gradient calculation directly influences the search direction. See a detailed discussion in 
Estimating the Gradient.

 l Method - Forward or Central, directly affects the quality of the gradient at the cost 
of runtime. Central gradients are more accurate but require about twice as many 
hydraulic solutions.

 l Step Size - How much to perturb the pipe sizes to determine the gradient. If the 
Objective was known exactly, it would make sense to make these values very 
small. However, as Fathom itself is an iterative solver, the Objective is only known 
to within a certain tolerance. Making the Finite Difference Step Size too small actu-
ally introduces uncertainty into the gradient and can therefore generate poor 
search directions making the process take longer, if a solution can be found at all. 
A Step Size that is too large has a similar effect, so it is important to select an 
appropriate value between the two extremes. The best value to use depends on 
the system in question - when in doubt, use the default.

 l Print Text Debug File - Generate a tab-separated file reporting on each call to the 
hydraulic solver. Actual pipe sizes are presented along with current Objective value and 
Design Requirement status.

Caution: The Advanced Control Parameters below should not be changed under normal cir-
cumstances without the direction of AFT Support.

 l Sizing Level Convergence
 l Maximum Iterations - This value is the number of sizing iterations, not the num-

ber of hydraulic solutions allowed. Generally, the hydraulic solution is by far the 
slowest part of the process, and as the number of uniquely sized pipes increases, 
so does the number of required hydraulic solutions. A problem with 100 inde-
pendently sized pipes would require, at minimum, 100 hydraulic solutions just for 1 

- 685 -



Cost Calculation

sizing iteration. That said, it is important to have an adequate number of sizing iter-
ations regardless of the number of variables - if the process is stopped pre-
maturely, the ideal sizes have not been found.

 l Consecutive Iterations for Convergence - The sizing process will be repeated 
at least this number of times while satisfying the convergence criteria. It is helpful 
to allow additional iterations because the sizing process can occasionally make 
little change in one iteration and then significant change in the next.

 l Relative Tolerance - Changes smaller than this relative amount (default of 0.1%) 
are considered small enough to be converged. Note that the number of iterations 
requiring a change in the value of the Objective smaller than this amount can be 
modified.

 l Absolute Tolerance - The value entered here is multiplied by the initial Objective 
value. The resulting value is considered as an absolute tolerance. By default, the 
Objective is scaled to 1,000 meaning that the default value of 0.0001 results in an 
absolute tolerance of 1,000*0.0001 = 0.1. Objective values smaller than 0.1 will 
use the absolute criterion instead of the relative.

 l Sub-Problem Iterations
 l Maximum - This is the maximum number of approximate problem cycles.
 l Consecutive for Convergence - The approximations will be repeated at least this 

number of times while satisfying the Sizing Level Convergence tolerance criteria.
 l Sequential Unconstrained Parameters

 l Maximum Number of Independent Pipe Sizes for Branch and Bound - Dis-
crete solutions with this method require the use of Branch and Bound. If the system 
has more independently sized pipes than this value, the Sequential  Unconstrained 
will automatically be used.

 l Sequential Unconstrained Parameters - See Sequential Unconstrained.
 l Design Requirement Tolerances

 l Violated - A very small positive value, which allows Design Requirements to be 
violated. It is important to allow this small violation for numerical reasons, as 
attempting to force values to zero is often difficult computationally.

 l Active - This small negative number determines how close to the Design Require-
ment the Objective can be before the Design Requirement influences the search 
direction. This value is updated automatically during the sizing process.

 l Scaling Parameters
 l Desired Objective Scaled Value - In some cases it is helpful to scale the value of 

the Objective. Very large or very small unscaled Objective values can present 
numerical issues, and scaling can help with this.

 l Scale Factor for Design Requirements
 l Common - Design Requirements are always scaled (dividing by the user 

defined quantity) for numerical reasons. This factor allows additional scal-
ing.

 l Violated Tolerance - This can be used to reduce the value of Violated 
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Design Requirement Tolerance. This can be useful if the small violation is 
unacceptable for a feasible design.

 l Print Optimizer Debug File - Generate a debug file detailing the normalized and gen-
eralized optimization process.

Related Topics

Search Methods 682
Modified Method of Feasible Directions 683
Sequential Unconstrained 687
Genetic Algorithm 690

Sequential Unconstrained
A Continuous Search Method  available in the Sizing Method panel. This method is unique in 
that it has an internal method to generate Discrete solutions as well.

Sequential Unconstrained (SU) finds the best case design by solving a series of unconstrained 
problems. This simplification is appealing because it is almost always easier to solve an uncon-
strained problem, making it possible to efficiently solve very large and complex problems. In 
order to account for the Design Requirements, the Objective function is artificially increased in 
Infeasible regions. This has the effect of driving the unconstrained solution into the feasible 
region.

Artificially increasing the Objective a large amount on the first cycle creates a numerically ill-con-
ditioned problem which is difficult to solve. Instead, only a small penalty is added initially. This 
means it is likely the solution on the first cycle will be infeasible. The next cycle increases the pen-
alty factor and uses the results of the previous cycle as a starting point. In this way, the optimum 
point is moved toward the feasible region in small, numerically stable, steps. Once the result of 
an unconstrained cycle ends in the feasible region, the process is stopped.

A Hybrid Method

The Modern Penalty Method does not use Branch and Bound for the determination of Discrete 
sizes. Instead, it can force the continuous solution into discrete "slots" by creating an artificial set 
of constraints after the continuous solution is complete. This prevents the need for searching an 
exceptionally large "tree" that would result with Branch and Bound. However, the method is gen-
erally only effective at finding discrete sizes +-1 size away from the continuous solution.

Sizing Control Parameters

 l Finite Difference Gradient Calculation - The most likely parameters to be changed, 
gradient calculation directly influences the search direction. See a detailed discussion in 
Estimating the Gradient.
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 l Method - Forward or Central, directly affects the quality of the gradient at the cost 
of runtime. Central gradients are more accurate but require about twice as many 
hydraulic solutions.

 l Step Size - How much to perturb the pipe sizes to determine the gradient. If the 
Objective was known exactly, it would make sense to make these values very 
small. However, as Fathom itself is an iterative solver, the Objective is only known 
to within a certain tolerance. Making the Finite Difference Step Size too small actu-
ally introduces uncertainty into the gradient and can therefore generate poor 
search directions making the process take longer, if a solution can be found at all. 
A Step Size that is too large has a similar effect, so it is important to select an 
appropriate value between the two extremes. The best value to use depends on 
the system in question - when in doubt, use the default.

 l Print Text Debug File - Generate a tab-separated file reporting on each call to the 
hydraulic solver. Actual pipe sizes are presented along with current Objective value and 
Design Requirement status.

Caution: The Advanced Control Parameters below should not be changed under normal cir-
cumstances without the direction of AFT Support.

 l Sizing Level Convergence
 l Maximum Iterations - This value is the number of sizing iterations, not the num-

ber of hydraulic solutions allowed. Generally, the hydraulic solution is by far the 
slowest part of the process, and as the number of uniquely sized pipes increases, 
so does the number of required hydraulic solutions. A problem with 100 inde-
pendently sized pipes would require, at minimum, 100 hydraulic solutions just for 1 
sizing iteration. That said, it is important to have an adequate number of sizing iter-
ations regardless of the number of variables - if the process is stopped pre-
maturely, the ideal sizes have not been found.

 l Consecutive Iterations for Convergence - The sizing process will be repeated 
at least this number of times while satisfying the convergence criteria. It is helpful 
to allow additional iterations because the sizing process can occasionally make 
little change in one iteration and then significant change in the next.

 l Relative Tolerance - Changes smaller than this relative amount (default of 0.1%) 
are considered small enough to be converged. Note that the number of iterations 
requiring a change in the value of the Objective smaller than this amount can be 
modified.

 l Absolute Tolerance - The value entered here is multiplied by the initial Objective 
value. The resulting value is considered as an absolute tolerance. By default, the 
Objective is scaled to 1,000 meaning that the default value of 0.0001 results in an 
absolute tolerance of 1,000*0.0001 = 0.1. Objective values smaller than 0.1 will 
use the absolute criterion instead of the relative.

 l Sub-Problem Iterations
 l Maximum - This is the maximum number of approximate problem cycles.
 l Consecutive for Convergence - The approximations will be repeated at least this 

number of times while satisfying the Sizing Level Convergence tolerance criteria.
 l Sequential Unconstrained Parameters
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 l Maximum Number of Independent Pipe Sizes for Branch and Bound - Not 
used when Sequential Unconstrained is directly selected.

 l Number of Discrete Iterations - This number of cycles with the artificial discrete 
constraints in place will be run. If this value is greater than 1, it is possible that dis-
crete sizes more than one size away from the continuous solution can be found. 
However, this does not force an exhaustive search of all potential discrete sizes in 
this range.

 l Continuous Penalties
 l Initial Multiplier - This is the penalty applied to the Objective in the first con-

tinuous unconstrained cycle.
 l Multiplier on Additional Iterations - The penalty is increased by this 

amount each continuous cycle.
 l Discrete Penalties

 l Initial Multiplier - This is the penalty applied to the Objective in the first dis-
crete unconstrained cycle.

 l Multiplier on Additional Iterations - The penalty is increased by this 
amount each discrete cycle.

 l Design Requirement Tolerances
 l Violated - A very small positive value, which allows Design Requirements to be 

violated. It is important to allow this small violation for numerical reasons, as 
attempting to force values to zero is often difficult computationally.

 l Active - This small negative number determines how close to the Design Require-
ment the Objective can be before the Design Requirement influences the search 
direction. This value is updated automatically during the sizing process.

 l Scaling Parameters
 l Desired Objective Scaled Value - In some cases it is helpful to scale the value of 

the Objective. Very large or very small unscaled Objective values can present 
numerical issues, and scaling can help with this.

 l Scale Factor for Design Requirements
 l Common - Design Requirements are always scaled (dividing by the user 

defined quantity) for numerical reasons. This factor allows additional scal-
ing.

 l Violated Tolerance - This can be used to reduce the value of Violated 
Design Requirement Tolerance. This can be useful if the small violation is 
unacceptable for a feasible design.

 l Print Optimizer Debug File - Generate a debug file detailing the normalized and gen-
eralized optimization process.

Related Topics

Search Methods 682
Modified Method of Feasible Directions 683
Sequential Quadratic Programming 685
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Genetic Algorithm 690

Genetic Algorithm
A Discrete Search Method available in the Sizing Method panel. This method is fundamentally 
discrete and does not use gradients in its search.

The Genetic Algorithm is a type of Evolutionary Algorithm - as the name implies, it selects advant-
ageous traits by emulating biological evolution. An initial "population" of potential solutions is gen-
erated and gradually improved.

The starting population is an effectively random selection of "individuals". In the context of ANS, 
an individual is a proposed selection of pipe sizes for the system in question. At the start of the 
sizing process, these individuals may have an assortment of good and bad traits. A "bad" trait 
might be one that violates a Design Constraint or increases the cost of the system. 

To improve the Fitness of the population there are three major operations: Selection, Crossover, 
and Mutation.

Selection occurs by determining the "Fitness" of all individuals in the population. Objective value 
is not the only concern when determining how acceptable any given individual is, so we need a 
different function to represent this. This function is a Fitness Function. The Fitness of any given 
individual is measured based on its Objective value and proximity to, or violation of, Design 
Requirements. Like Darwin's theory of Survival of the Fittest the goal in this process is to max-
imize the Fitness of the population as a whole. With the Fitness known for all individuals, a par-
ent population with high Fitness can be selected.

Crossover occurs by "breeding" the parent solutions to generate new solutions. Some of these 
solutions will, randomly, have inherited good traits from their parents. Others will have inherited 
bad traits.

Mutation occurs after crossover, introducing a further element of randomness into the system by 
changing traits with no regard to the parent traits. This allows the algorithm to consider new solu-
tions that were not previously part of the "gene pool." If no new traits can be introduced, the flex-
ibility of the method is limited. If the mutation rate is too high, however, the good traits will not be 
carried through to new generations as effectively.

The new population is then combined with the parent population, and the process is repeated.

Note: When sizing with a Discrete method, it is possible to start the search with a Continuous 
Method. This limits the search space which should reduce the run time. When this 
option is enabled, the user has control over both the Continuous and Discrete methods.

Sizing Control Parameters

 l Genetic Algorithm Population Size
 l Number of Discrete Sizes Around Continuous Solution - If Start with Continu-

ous Method is selected, this option limits the search space of the genetic algorithm 
by only considering discrete sizes close to the continuous solution. For example, a 
Candidate Set may contain 20 unique sizes. Including all of these sizes makes the 
problem extremely complex, as indicated in Brute Force Method. It is likely that the 
best discrete solution is near the best continuous solution, so only searching 4 
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unique sizes (+/- 2) around the continuous solution can dramatically reduce 
runtime.

 l Automatic - Set the User Specified Multiplier to 2 to determine the size of the 
population to use.

 l User Specified Multiplier - Every independently sized pipe in the model has a cer-
tain number of possible sizes that it may be, as determined by its particular Can-
didate Set. Because every independently sized pipe in the model can have a 
unique Candidate Set, it can also have a unique count of possible sizes. This mul-
tiplier is based on the sum of all of these counts across the model. For example, if 
there are 2 independently sized pipes with Candidate Sets P1: (4", 6") and P2 (3", 
4", 6", 8"), the total count will be 6, and a multiplier of 3 would give a population size 
of 18.

 l User Specified Population - The size of the population can also be directly spe-
cified. It is important the population size is not too small as this will artificially limit 
the capability of finding a good solution. However, population sizes too large will 
not solve in a reasonable time frame. 

Caution: The Advanced Control Parameters below should not be changed under normal cir-
cumstances without the direction of AFT Support.

 l Genetic Algorithm Seed - This number is used to generate a "random" population. The 
same number will always generate the same initial population.

 l Genetic Algorithm Parameters
 l Crossover Probability - The average fraction of the population obtained from 

crossover. As a probability this does not mean exactly this fraction will be obtained. 
This value is typically close to 1, meaning that the majority of the population each 
generation is obtained as children of the parent generation. It is generally less than 
1 to avoid losing very good solutions from the parent generation due to poor cros-
sover.

 l Crossover Distribution Index - This value is inversely proportional to allowed 
perturbations caused by crossover. That is, a large value will limit the amount of 
perturbation generated from crossover, whereas a small value will allow significant 
perturbation.

 l Mutation Probability - The average fraction of the population subjected to muta-
tion. As a probability this does not mean exactly this fraction will be obtained. This 
value is typically the inverse of the number of independently sized pipes. As the 
system (and usually, population) gets very large, the need for "additional" ran-
domness decreases. However, for small systems this randomness is important to 
introduce to prevent a premature solution.

 l Mutation Distribution Index - This value is inversely proportional to allowed per-
turbations caused by mutation. That is, a large value will limit the amount of per-
turbation generated from mutation, whereas a small value will allow significant 
perturbation.

 l Genetic Algorithm Convergence
 l Consecutive Unimproved Generations - When no improvements in the Object-

ive occur over this number of generations, the sizing process will be stopped and 
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the results are presented. It is assumed from the lack of progress that the ideal 
solution has been found. It is impossible to tell in advance how many total iter-
ations this condition may require.

 l Fixed Number of Generations - To limit the runtime to a length that can be estim-
ated, the algorithm can be set to a specific count of generations. This should be 
used with caution as it is possible to end before the best solution has been found, 
or to continue long after the best solution has been found.

Related Topics

Search Methods 682
Modified Method of Feasible Directions 683
Sequential Quadratic Programming 685
Sequential Unconstrained 687

Sizing Theory
Automated Pipe Sizing is a small subset of the mathematical field of Optimization. This is a com-
plex subject that has evolved over many years - the topics here are not attempting to replicate 
this complexity but instead provide simplified understanding of the methods so that users of 
ANS can appropriately size systems and adjust models and parameters as needed.

 l Sizing and Optimization - ANS is designed to simplify the optimization problem as 
much as possible. Those familiar with optimization may find this topic useful to connect 
common optimization terms to those used in ANS.

 l Boundaries vs. Design Requirements - "Requirements" can be defined in many ways. 
Boundaries force a certain flow or pressure, whereas Design Requirements place limits 
on allowable values. While similar, the distinction is important in a sizing context.

 l Physical Parameters vs. Monetary Cost - Monetary Cost sizing is often difficult to the 
amount of data required. For this reason, minimum cost is often estimated with a physical 
parameter, such as pipe weight.

 l Brute Force Method - The most basic way to conclusively find a minimum is to exhaust-
ively test all possibilities. This is impossible on a realistic time scale for most systems.

 l Gradient Based Methods - The fastest methods for solving a continuous Objective are 
based on gradients. Understanding the core of these methods can help in finding better 
solutions more quickly.

 l Estimating the Gradient - The gradient is only estimated - not analytically determined. 
This fact means the associated parameters may require adjustment in some cases. 
Understanding the affect of these adjustments is important.

 l Branch and Bound - Only some methods are inherently suited to discrete sizing. Gradi-
ent based methods usually rely on narrowing the solution space and solving a number of 
easier problems.
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Sizing and Optimization
Techniques for minimizing or maximizing certain parameters - optimization - have been used 
throughout a variety of industries for many decades. As computers become more prevalent and 
more powerful, they are able to handle larger problems with more variables and greater com-
plexity. Optimization problems can be enormously complex, and techniques for solving them are 
almost always iterative. Such problems are generally impractical to solve without a computer.

The selection of pipe sizes to minimize some parameter - often monetary cost - is one specific 
example of optimization. For the sake of clarity, the mathematical terminology used when dis-
cussing optimization problems is compared to the terminology used in the ANS module here.

 l Optimization - Modifying a system to minimize or maximize some parameter. 
 l In ANS - This is represented by the name of the module - Automated Network Siz-

ing. The sizes of the various network pipes are modified automatically by the 
application, to achieve some goal.

 l Objective - The goal of optimization is referred to as the Objective. Minimizing monetary 
cost is a very common Objective. Others may be minimizing the time to complete an 
action, or maximizing the amount of material a machine can process.

 l In ANS - The term Objective is retained.
 l Objective Function - It is required that the Objective can be calculated for any con-

figuration of the system. This calculation is represented by the Objective Function, much 
like any other mathematical function. The Objective is to find the global maximum or min-
imum of this Objective Function.

 l In ANS - Is not a user input, and is not visible.
 l Constraint - Anything that is required by the system regardless of the Objective value. 

For example, an Objective might be to minimize the amount of cloth needed to make a 
blanket. The smaller the blanket, the less material it needs, but a tiny blanket is not very 
useful. Instead, the Optimization might be Constrained such that the blanket must be 
some minimum area.

 l In ANS - These are called Design Requirements.
 l Design Variable - Anything that is allowed to change in order to modify the Objective 

value. In the blanket example, this might be the width, length, and thread count of the 
blanket. As with any mathematical problem, the more variables there are, the harder the 
problem is to solve.

 l In ANS - The variables that are allowed to change are the pipe sizes. There are 
countless ways a fluid system could be Optimized, but pipe sizing is one of the 
most significant that will impact cost. The total number of design variables in the 
current analysis is displayed near the bottom of the Size/Cost Assignments panel 
as Independently Sized Pipes.

Related Topics

Sizing Theory 692
Boundaries vs. Design Requirements 694
Physical Parameters vs. Monetary Cost 695
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Brute Force Method 697
Gradient Based Methods 697
Estimating the Gradient 701
Branch and Bound 706

Boundaries vs. Design Requirements

Boundaries

Points in a model that physically force a given parameter.

A piping network can be considered to have three variables - flow, pressure, and the system. For 
analysis, it is required that the user fully define the system. The system is a collection of com-
ponents that affect the flows and pressures - pipes, pumps, valves, etc. Because there are still 
two variables - flow and pressure - the user must specify at least one of them as a boundary 
somewhere in the system.

Note: Due to the nature of fluid analysis, if there is only one boundary it must be a pressure 
type boundary. See Role of Pressure Junctions.

For a model to be accurate, its entire definition must reflect the system it is representing. This 
includes both the system and the boundaries. It is obvious that a 120 foot, 12" diameter pipe 
should be represented in the model with the same length and diameter. However, ensuring the 
correct selection of boundaries is often less intuitive.

Specifying any given boundary as a fixed pressure will result in some calculated flow at that 
boundary. Changing this pressure boundary to a flow boundary with the calculated value will not 
change any of the pressure or flow results in the model. However, this has important physical 
implications.

For example, consider a pipe bounded by two pressures. Doubling the pipe size will significantly 
increase flow. However, if a boundary was instead a fixed flow, doubling the pipe size will not 
change the resulting flow but instead change the pressures at the flow boundary. If the boundary 
in the real system is a large fixed pressure tank, it should not be represented as a fixed flow, 
because changes to the system will effectively change the pressure required in the tank. In other 
words, changing the system changes the physical meaning of the boundary. If the tank is 
represented as a fixed pressure, as it behaves in the field, this is not an issue.

This is important in ANS because ANS is changing the system as part of the sizing process. 
Using the incorrect type of boundary can present sizing solutions that would not work in the real 
system.

Note: It is not uncommon or incorrect to use boundaries to represent a requirement in an ana-
lysis. This is a common design tool to determine what is required of a boundary. In the 
above example, it may be desired to know the required tank pressure to drive the 
required flow. What is important is to recognize whether a junction is representing a 
requirement or a physical boundary that cannot be changed.
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Design Requirements

Design Requirements are limits on allowable behavior.

The distinction is important because Design Requirements are limits rather than imposed val-
ues. For example, a Design Requirement may state that a flow must be at least 100 gal/min. 
The design is considered acceptable if the flow ends up as 120 gal/min. On the other hand, using 
a boundary of 100 gal/min forces the model always to maintain 100 gal/min.

In this manner, Design Requirements are less restrictive than boundary conditions. Generally, 
the less restrictive the problem is, the more flexibility is available to obtain a better sizing result.

Even if it is known that there must be some fixed flow into a tank, using an Assigned Flow bound-
ary at this location may not be the best choice. If the pressure in the tank cannot be changed to 
the value calculated based on the sizing result, the use of an Assigned Flow here would be incor-
rect. Instead, it would be appropriate to use an Assigned Pressure and two Design Require-
ments on flow - a minimum and a maximum, to limit the solution to an acceptable range.

Related Topics

Sizing Theory 692
Sizing and Optimization 693
Physical Parameters vs. Monetary Cost 695
Brute Force Method 697
Gradient Based Methods 697
Estimating the Gradient 701
Branch and Bound 706

Physical Parameters vs. Monetary Cost
There are four physical parameters that can be maximized or minimized in addition to monetary 
cost:

 l Pipe Weight
 l Pipe and Fluid Weight
 l Flow Volume
 l Pipe Inner Surface Area

Actual Objective is to Limit the Physical Parameter

Occasionally, the goal of the sizing is to limit the physical parameter. For example, a system to 
be placed on an aircraft likely has greater emphasis on weight than monetary cost. It is important 
to keep in mind in such cases that only the pipes are included in the total Objective value. 
Pumps, valves, or other junctions that contribute to weight are not accounted for. This may affect 
the ideal sizing.

- 695 -



Cost Calculation

Using a Physical Parameter to Estimate Cost

There are advantages and disadvantages of estimating cost with a physical parameter.

It is generally far easier to use a physical parameter as cost libraries are not required. Cost lib-
raries are difficult to locate information for, and can be time consuming to create and manage. 
Avoiding this greatly simplifies the process.  

The main disadvantage is that only initial pipe costs can be accounted for. If junctions 
account for a significant portion of the initial cost, or if the recurring costs from operating them 
would affect sizing, then this may not result in the best sizing solution.

In general, if the goal is to minimize monetary cost of a system, then monetary information 
should be supplied. If recurring costs must be included, this is the only reasonable option. 
However, physical parameters often provide a good estimate of the ideal size for initial cost. It 
makes sense to start the sizing process with a physical parameter, and proceed to monetary 
cost as the Objective after larger design issues have been resolved. This is especially true if the 
potential savings are large.

Figure 1: Comparison of Dimensionless Costs for Schedule 40 ANSI Steel water pipe. RS Means mon-
etary cost closely follows pipe weight in this example.

Related Topics

Sizing Theory 692
Sizing and Optimization 693
Boundaries vs. Design Requirements 694
Brute Force Method 697
Gradient Based Methods 697
Estimating the Gradient 701
Branch and Bound 706
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Brute Force Method
The "easiest" way to find the cheapest set of pipe sizes is to test all of the possible combinations 
exhaustively, and report back the lowest cost option found.

This has the advantage that it is clearly conclusive - there can be no argument that a cheaper 
alternative exists if every possible alternative was shown to have higher cost. Unfortunately, this 
method is extremely impractical for any reasonable sized problem. The number of required ana-
lyses to find the current value of the Objective is related to the number of design variables and 
how many unique discrete sizes each variable can have.

In the context of ANS, this is the number of Independently Sized Pipes, and the number of selec-
tions in the Candidate Set, assuming there is one set for the model.

If we have only 3 independently sized pipes, and can only choose from 3 different pipe sizes, 
then we would need to solve 27 unique hydraulic models, which could be manageable by hand.

However, if we have 12 independently sized pipes, and can choose from 6 different pipe sizes, 
we suddenly have over 2 billion unique models to solve. If we could test 50 models every 
second, this would take over a year to complete - and it is still a relatively small system!

Due to the clear impracticality of this method, it is not used in ANS.

Related Topics

Sizing Theory 692
Sizing and Optimization 693
Boundaries vs. Design Requirements 694
Physical Parameters vs. Monetary Cost 695
Gradient Based Methods 697
Estimating the Gradient 701
Branch and Bound 706

Gradient Based Methods
Gradient based methods search for the ideal solution using the gradient of the Objective Func-
tion. A gradient is a vector function composed of partial derivatives measuring the change of 
some function with respect to each component. Effectively, a gradient is a derivative of a multi-
variable function - it indicates the magnitude and direction of greatest change in a multi-
variable function.

A gradient of a single variable function is simply the derivative of that function. While most prob-
lems requiring complex optimization techniques have many variables, it is easiest to think about 
a single-variable function, such as elevation related only to distance along some horizontal line:
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Figure 1: One of many possible elevation profiles of a mountain peak. The slope can be calculated at 
any point.

The gradient of a mountain's elevation will indicate the magnitude and direction of the elevation 
change at any given latitude and longitude. In other words, given a specific point, the gradient 
will tell you how steep the slope is at that point, and which direction it is steepest in. This is very 
useful for finding the top of the mountain - without being able to see anything but the local value 
of the gradient, you can make an estimate that the peak is probably in the direction of the slope, 
and that if the slope is very steep you likely have a long ways to go.

If the entire elevation profile was known ahead of time, finding the peak is trivial. Unfortunately, 
we do not normally know the entire profile, but instead can only determine its value where we 
explicitly test it. Stated generally, the shape and behavior of an Objective Function is not 
known ahead of time.

Rather than testing every single horizontal point to find the highest elevation by brute force, we 
can an employ an intelligent gradient based search method. Starting at a horizontal distance of 
zero, we can measure an elevation and slope:

Figure 2: Starting a gradient based search
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With the positive slope from our initial condition, we can make an educated guess that the peak 
is somewhere in the positive direction. We determine where we want to guess and measure our 
system again at that point:

Figure 3: Iteration number 2

Because our slope is higher, we assume that the peak is farther away and adjust our change in 
distance accordingly. Our new guess has a negative slope, so we will reverse our search dir-
ection.

Figure 4: Iteration number 3

We changed sign on slope again, so we reverse direction again. We can use information from 
previous guesses to narrow down the search range and make a more intelligent guess.
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Figure 5: Iteration number 4

As we continue, the adjustments to our guess get smaller and smaller. Once they are small 
enough, we can consider the search converged, and the peak found.

Figure 6: Iteration number 5

In only a few iterations, we have found an excellent approximation of the highest point, without 
knowing anything about the elevation or slope outside of our selected guess points.

The search algorithms included in ANS are much more sophisticated than the simple example 
presented here, but the idea remains the same. Furthermore, the allowable selections are restric-
ted by Design Requirements, which impacts the ideal search direction.

Related Topics

Sizing Theory 692
Sizing and Optimization 693
Boundaries vs. Design Requirements 694
Physical Parameters vs. Monetary Cost 695
Brute Force Method 697
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Estimating the Gradient 701
Branch and Bound 706

Estimating the Gradient
Analytically determining the gradient becomes extremely difficult if not impossible for problems 
with many variables such as sizing a piping network. Instead, the gradient is estimated with a 
finite difference. This is a method for numerically estimating the gradient at a given point.

The test points created with a finite difference method each represent a hydraulic model that 
must be solved independently. If the model is complex, adding additional variables (unique pipe 
sizes) or required runs (from a central difference) can make the process take a significant 
amount of time.

Forward Difference

The Forward Difference estimates the gradient by finding the change in the function value by 
making a small change in the independent variable.

First, an initial result is found. We want to know the gradient at this point.

Figure 1: An initial test. It is desired to know the gradient at this point.

The independent variable is perturbed some small amount and a new result found. A line can be 
drawn through these two points - an estimate of the gradient at the initial point.
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Figure 2: A perturbation. This allows the calculation of an average gradient as an approximation of 
the gradient at the initial point.

There are two important things to keep in mind:

 l This is an average gradient between the two points, but it is used as an estimate of the 
gradient at the initial point. It is not used to represent the behavior between the two 
points.

 l It is only an estimate. The result depends on the behavior of the Objective Function, 
and the selection of the test point.
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Figure 3: The actual gradient depends on the function. Many possible functions pass through two 
test points.

Central Difference

The central difference is a very similar process, with generally increased accuracy. We still want 
to know the gradient at our initial point (Figure 1), but instead of creating one test point, we create 
two, equidistant from the initial position. This effectively doubles the number of calculations 
required.

Figure 4: Central Difference estimate of gradient at the initial point
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Relationship to Iterative Tolerance

It may seem that simply making the perturbation in the Inner Diameter smaller will increase the 
accuracy of the gradient and help reduce the issue indicated by Figure 3. If the Objective func-
tion was known explicitly, this would be a good assumption. However, in ANS, the results are 
not known explicitly. Instead, the solution is found via iteration. Iterative methods require some 
determination of convergence - namely, a tolerance on the solution. This means, by definition, 
that the results found are not the exact, analytical solution. Further, it is impossible to tell how the 
results may be biased away from the true solution.

When making test points, as before, there is some band of uncertainty in the Objective Value for 
the point related (but not necessarily equivalent) to the iterative tolerance.

Figure 5: Uncertainty in the Objective Value due to iterative tolerance

We do not know where the "true" Objective Value lands on either of these bands, and we cannot 
state that the error is in the same direction or is of the same magnitude for both test points. This 
means that the gradient estimations have some variability as well.
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Figure 6: Uncertainty in the estimated gradient

In addition to the uncertainty indicated by Figure 3, there is also added uncertainty from the iter-
ative tolerance.

It can be tempting to reduce the step size to increase gradient accuracy, but the iterative error 
will not be reduced. This can have dramatic results on the gradient.

Figure 7: Substantially increased uncertainty in the estimated gradient from decreasing the step size

Now, due to the iterative tolerance, it is possible that the gradient is dramatically affected to the 
point where even the sign is uncertain.
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Note: Making the step sizes too large impacts the gradient negatively in other ways. The crit-
ical thing to remember is that the step size should be small enough to capture the chan-
ging Objective, but not so small the iterative tolerance impacts the gradient quality.

Related Topics

Sizing Theory 692
Sizing and Optimization 693
Boundaries vs. Design Requirements 694
Physical Parameters vs. Monetary Cost 695
Brute Force Method 697
Gradient Based Methods 697
Branch and Bound 706

Branch and Bound
Piping is almost always only available in Discrete sizes. Determining the best case selection of 
Discrete sizes requires a different approach than finding the best case Continuous sizes. One 
such method is Branch and Bound which is used for Discrete sizing on the basis of one of the 
Gradient Based Methods.

Branch and Bound divides the sizing problem into a collection of smaller sizing problems 
(branches). Solving these "sub-problems" gives information (bounds) about whether or not a 
given sub-problem is worth further investigation.

This method is well suited to problems with a relatively small number of variables (unique pipe 
sizes). For more than 10 variables, the Sequential Unconstrained method is advised. It is difficult 
to tell in advance how well any search method will work, and Branch and Bound is no different. It 
is possible, though unlikely, that the method can effectively reduce to a Brute Force Search. This 
makes it effective, but potentially very slow.

Example

There is a 50 foot pipe followed by a 100 foot pipe, and a 5 psi differential across the pipes. The 
piping is available in integer inside diameters between 3 and 17 inches, and the pipe walls thick-
ness is always 10% of the inside diameter. Our goal is to minimize the weight of this system, 
while maintaining a flow of at least 2500 gal/min.

Even though there are only two independent pipe sizes to consider, with 15 possible pipe sizes, 
there are 225 possible permutations, more than we would like to test by brute force.

We start the process by finding the Continuous Optimum. For this example, this best case 
is (P1 = 8.75 in, P2 = 8.77 in, Weight = 2772 lbm). It is reasonable to assume that the Discrete 
Optimum will be near these sizes. 
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Figure 1: The first node showing the Continuous Optimum

From this first node, we want to divide the solution space on our first variable - the diameter of 
pipe 1. The pipe size cannot be 8.75 inches, it can only be a discrete size, in our case an integer 
value. Therefore, we branch the into two sub-problems with pipe 1 restricted to less than 8 or 
more than 9 inches (Figure 2). We have also established a bound on the problem - the solution 
will never have a feasible weight lower than 2772 lbm.

Figure 2: Two Sub problems are created from the Continuous Optimum in Node 1

It is important to note that these additional nodes represent continuous sub-problems. The 
pipe size is not forced to be discrete, it only has an additional requirement on it. The resulting 
pipe size will often be discrete because that continuous diameter is closest to the overall lowest 
feasible weight.

We can solve each of these independent problems with the same methods we used to solve the 
first node.
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Figure 3: The conditions of Nodes 2 and 3 are shown, as well as the sizing arrived at in the two 
nodes

Due to the nature of this particular problem, the ideal pipe sizes for pipe 1 in both nodes 2 and 3 
ended up as discrete sizes. This is not required or enforced by the method. Each of our nodes 
also has its own bound. This fact is used to determine the location of the next branch. Because 
node 3 has a better possible solution (2782 lbm) than node 2 (2903 lbm), we branch from node 3 
(Figure 4). This time, however, we place a restriction on our second pipe's diameter.
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Figure 4: Node 4 produces an infeasible solution while Node 5 produces a feasible solution based on 
the branching criteria set from Node 3

Both of our branches from node 3 resulted in discrete size selections. However, node 4 was not 
able to result in a feasible solution. Infeasible nodes are valuable as there is no need to 
branch from them - placing further restrictions on a problem will never make it feasible. 
Node 5 on the other hand is both fully discrete and feasible. This is our first potential discrete 
solution. It is only a potential solution because node 2 has a lower bound - without branching 
from node 2, we do not know if a better discrete solution may exist under it, so branching from 
node 2 is exactly how we proceed (Figure 5).
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Figure 5: Branching occurs from Node 2 which produces one feasible (Node 7) and one infeasible 
(Node 6) solution

One of our nodes is infeasible, and despite the lower weight cannot be considered. Node 7, how-
ever, is feasible but not discrete, despite the requirements on diameter on both pipes. We could 
branch again from node 7, but there is no need - we have already found our ideal solution at 
node 5. We know this is the best possible discrete solution because the node 7 continuous solu-
tion has a higher minimum weight than node 5. No matter how we branch from node 7, we will 
never get a better solution than node 5.
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Figure 6: Results of the Branch and Bound method

Again, note that the results on node 5 are a continuous solution. It is only because of the 
requirements we have placed on the problem that the sizes have resulted in discrete sizes.

We have managed to find the best possible discrete solution by running 7 independent con-
tinuous sub-problems, instead of hydraulically solving hundreds of possible configurations. With 
more independent pipe sizes, the elimination of certain branches often becomes more common, 
further reducing the cases we need to check.

Related Topics

Sizing Theory 692
Sizing and Optimization 693
Boundaries vs. Design Requirements 694
Physical Parameters vs. Monetary Cost 695
Brute Force Method 697
Gradient Based Methods 697
Estimating the Gradient 701
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Powerful customization capabilities are provided through the ability to create libraries which can 
store custom fluid properties, pipe materials, and all junction types except the Volume Balance. 
There are several categories of libraries which are discussed below.

AFT Internal Library

 l Purpose - Stores AFT-provided library data that is always available with the default install-
ation.

 l Filename - Fathom#.dat (where # is the corresponding version number).
 l Location - Fathom installation folder, default is C:\AFT Products\AFT Fathom #.
 l Limitations - Cannot be transferred to other users, local use only.

Local User Library

 l Purpose - Stores user-specified data for most component types.
 l Filename - Fth_User#.DAT (where # is the corresponding version number).
 l Location - C:\Users\username\AppData\Roaming\Applied Flow Technology\AFT 

Fathom\#.
 l Limitations - Cannot be transferred to other users, local use only.

External Library

 l Purpose - Stores user-specified data of any type: fluids, pipe materials, junctions, and fit-
tings & losses. Multiple network or local custom libraries can be created via the Library 
Manager on the Library menu. External libraries can be shared to multiple users from a 
network location as is discussed in Creating an Enterprise-wide Network Library System.

 l Filename - User-specified filename.
 l Location - User-specified location.
 l Limitations - Must be connected via the Library Manager prior to use, and consideration 

should be given to version control or user permissions to edit.

Related Topics

Library Manager 714
Library Browser 714
Network Library Overview 729
Library Verification 733
Library Locations in General Preferences 735
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Fluid Library 719
Pipe Material Library 720
Pipe Material Library References 772
Junction Library 718
Insulation Library 723
Fittings & Losses Library 723

Library Manager
Accessed from the Library Menu, the Library Manager allows you to:

 l Connect to and disconnect from libraries
 l Create and delete libraries
 l Add content to libraries
 l Review the content of libraries
 l Move contents between libraries

Related Topics

Library Browser 714
Fluid Library 719
Pipe Material Library 720
Junction Library 718
Insulation Library 723
Fittings & Losses Library 723
Libraries 713
Network Library Overview 729
Library Verification 733
Library Locations in General Preferences 735
Pipe Material Library References 772

Library Browser
The first panel of the Library Manager is the Library Browser. Use the Library Browser to create a 
new library, add an existing library, view contents of an added library, and connect or disconnect 
libraries to the model.

Types of Libraries

There are three types of external libraries in AFT Fathom: 
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 l Engineering Libraries - Contain all component types except cost information
 l Energy Cost Libraries - Contains energy cost data associated with components in existing 

engineering libraries
 l Cost Libraries - Contains material, installation, and/or maintenance cost data associated 

with components in existing engineering libraries

All library types can be reviewed, added to the model, and connected to the model from the 
Library Browser. For engineering-type libraries additional actions are available to edit libraries.

Adding and Removing Existing Libraries

To work with a library you must first make it available to AFT Fathom. Referring to Figure 1, click-
ing on the Add Existing Library or Add Existing Cost Library button will open a standard file dialog 
box with which you may browse to and select a library. A library may be removed from the list of 
available libraries by right-clicking on the library and selecting Remove Library from List.  A sum-
mary of the library contents can be seen in the section on the right when a library, library section, 
or component is selected in the list of available libraries.

The AFT DEFAULT INTERNAL LIBRARY and the AFT FATHOM LOCAL USER LIBRARY may 
not be removed and will always appear in the list of available libraries. External shared libraries 
will also always appear in the available library list.

Figure 1: Library Browser in the Library Manager

Connecting and Disconnecting Libraries

In order to use the components from a library in the model the library must be connected. A lib-
rary is connected to the model when it is shown with a check mark in the Library Browser. All lib-
raries are automatically connected when they are first added to the Library Manager.

Sections or components in a library can also be connected/disconnected on an individual basis if 
the library as a whole is connected.
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It may be desired to disconnect a library if you do not want the components from that library to be 
available for use in the current model, but you do want the library to be available for use in other 
models.

Clicking on Set As Default will establish the list of connected libraries as the default list, while 
clicking on User Default will set the connections to the default list.

AFT Internal Pipe Material libraries can be connected or disconnected as a group from the Other 
Actions button under the available libraries list.

Editing Library Contents

Existing content can be moved to/from, copied to/from, or deleted from available libraries in the 
Library Browser.

To edit an item right-click on the item in the Library Browser, then click the desired action from 
the right-click menu. Note that moving, copying, and deleting can be done to a library as a whole, 
or can be done for just a section or single component in a library. Individuals components can 
also be edited by choosing Edit Component, which will take you directly to the Edit section for the 
component type.

Note: Editing Cost libraries must be done separately in the Cost Library or Energy Cost 
Library windows, accessed from the Library Menu.
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Figure 2: Library contents can be transferred or deleted from the right-click menu

Creating External Libraries

By default library items are stored in the AFT Default Internal Library or Local User Library, both 
of which cannot be shared with other users. Library items can be moved or copied to an external 
library which can be shared with multiple users.

To create an external library click the Create New Library button underneath the available lib-
raries list. You will be prompted to provide a name for the file, and a library description (Figure 3). 
The provided description will be displayed as the library's name in the Library Manager.

To add content to an external library copy or move content from an existing library as described 
in the Editing Library Contents section. Junction components can also be directly added to 
external libraries as is described in the Junction Libraries topic.

For more details on creating and sharing external libraries see Creating an Enterprise-wide Net-
work Library.

Figure 3: After specifying a library file name, you will be prompted for a description which will then 
appear in the Library Manager when this library is selected

Related Topics
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Library Manager 714
Fluid Library 719
Pipe Material Library 720
Junction Library 718
Insulation Library 723
Fittings & Losses Library 723
Libraries 713
Network Library Overview 729
Library Verification 733
Library Locations in General Preferences 735
Pipe Material Library References 772

Junction Library

Adding Custom Junction Data to the Component Library

To simplify modeling and eliminate repetitive data entry, AFT Fathom allows you to save fre-
quently-used junction data to a custom library. Once saved, the custom equipment data can be 
selected from the Library Jct dropdown in the Properties window at any later time for immediate 
recall of the data. Using this tool, you can easily build your own library of pumps, valves, or other 
components supplied by specific manufacturers.

To save a custom junction to the library - open the junction Properties window and enter all 
required data. Close the window and choose Add Component to Library from the Library menu. 
You will be prompted to enter a name for the custom junction. Enter a descriptive name then 
click OK. If you open the junction again, the custom name will be selected in the Library Jct drop-
down.

AFT Fathom accepts custom data for all junction types except the Volume Balance.

Editing the Component Library

You can delete or rename any existing library component in the Edit Junctions panel of the 
Library Manager, accessed from the Library menu. To edit an existing library entry, select the 
item in the list and click the Edit Data button. This opens the data into a Properties Window 
where the data can be modified.

Related Topics

Library Manager 714
Library Browser 714
Fluid Library 719
Pipe Material Library 720
Insulation Library 723
Fittings & Losses Library 723
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Libraries 713
Network Library Overview 729
Library Verification 733
Library Locations in General Preferences 735
Pipe Material Library References 772

Fluid Library
AFT Fathom provides an AFT Standard fluid library for numerous common fluids. If the working 
fluid you wish to model is not in this library, you may elect to enter the fluid properties in a custom 
library for later reuse using the Edit Fluids panel in the Library Manager.

You can open the Edit Fluids panel from the Library menu or from the Edit Fluid list button in the 
Fluid panel in Analysis Setup. The Edit Fluids panel allows you to review currently defined AFT 
Standard and custom fluids, to change the data for custom fluids, and to enter new fluids. All 
AFT Standard fluid properties are assumed to be a function of temperature. Custom fluids can 
be a function of temperature or solids concentration.

Once you have entered a custom fluid, it will appear in the Fluids Available in Library list of the 
Fluid panel when User Library Fluid is selected.

Adding a Custom Fluid

You can add new fluids by clicking the Add New Fluid button on the Edit Fluids panel of the 
Library Manager. Raw data can be provided for the variation of density, dynamic viscosity, spe-
cific heat, thermal conductivity, and vapor pressure as they depend on temperature or solids con-
centration. This window provides the tools to perform polynomial curve fits of fluid data, or the 
raw data can be interpolated.

Required Data:

 l Density
 l Dynamic Viscosity

Optional Data:

 l Specific Heat (required for heat transfer capabilities)
 l Thermal Conductivity (required for heat transfer capabilities)
 l Reference Temperature/Enthalpy point (required for heat transfer capabilities) - Note that 

the reference temperature/enthalpy do not need to be exact values since only changes in 
the parameters are used

 l Vapor Pressure (required if checks and warnings for cavitation are desired)

The Fluid Library window also allows you to open the Change Fluid Data window which is essen-
tially the same window as the Add New Fluid window. For easy editing, data for the fluid you wish 
to change is entered for you in the appropriate areas. The original curve fit data you entered is 
also displayed.

The Add New Fluid/Change Fluid Data windows offer cross-plotting of your custom curves 
against the curve fit data points. You can also import data from text files into these windows.
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Related Topics

Library Manager 714
Library Browser 714
Pipe Material Library 720
Junction Library 718
Insulation Library 723
Fittings & Losses Library 723
Libraries 713
Network Library Overview 729
Library Verification 733
Library Locations in General Preferences 735
Pipe Material Library References 772

Pipe Material Library

Adding Custom Pipe Materials to the Pipe Materials Library

You can open the Edit Pipe Materials panel from the Library menu. Using this panel, you can eas-
ily add to the user library the geometric information for any pipe material in the length units of 
your choice. Custom pipe materials can be selected for use in the Pipe Properties window, min-
imizing the data entry required by the user.

Pipe materials typically have a range of nominal sizes and a specific type, class, or schedule that 
describes the actual dimension. AFT Fathom works with the inner diameter of the pipe, since 
that is the parameter that directly affects the fluid mechanics.

To add custom pipe materials to the user library, choose the entry location you desire in the 
list on the left (Pipe Materials, Sizes and Types), then click the New button below. For example, 
to add an entirely new material, click the Pipe Materials item at the top of the list then click the 
New Material button. To add a new size for an existing material (say Steel), click Steel in the list 
then click the New Size button. To add a new type to the Steel 1 inch size, click 1 inch under the 
Steel material in the list then click the New Type button.

When adding a new material, you also will be asked to specify a geometry, enter a nominal size, 
type of material, diameter, friction data set, and friction value to define the first data. Optionally 
you can add in a wall thickness. From then on you can enter additional nominal sizes and types. 
The name descriptors you choose for the material, size, and type are at your discretion. They 
can contain text mixed with relevant numbers if you desire.

You can also add multiple Friction Data Sets for each pipe material. This allows you to keep, for 
example, different friction values that may apply to the same pipe under different conditions. 
These conditions could be related to the age of the pipe or the type of fluid being carried. See the 
Friction Data Sets section below for more information.

In addition to manual entry of the custom pipe materials, you also can import pipe material data 
from a file. When you click the Import From File button, a dialog box will appear explaining the 
necessary import file format. By choosing to import from a file, you will be able to have a sep-
arate copy of the data for later access.
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Friction Data Sets

Friction Data Sets are pipe friction values for a particular pipe condition.

To create a new Friction Data Set select a Pipe Material, Size, or Schedule to associate the data 
set with, then click New Data Set from the Friction Data Set tab on the right (Figure 1). Modify the 
Friction Data Set description to provide a name, then enter the Friction Model and Value.

A Friction Data Set can be associated with the entire pipe material, or with specific sizes or 
types. For instance, a friction data set associated with Steel (i.e., the top level) might be called 
"25 year usage" and have a roughness value of 0.005 inches. This data set is then available to 
all sizes and types of steel. However, if "25 year usage" is associated only with the 1 inch of 
Steel, it will apply only to the pipe schedules that are 1 inch.

You can also associate friction data sets with a specific type (i.e., schedule). For instance, you 
can make a "25 year usage" and associate it only with 1 inch schedule 40 Steel pipe and assign 
its roughness value as 0.006 inches. Then all Steel pipe would use 0.005 inches for "25 year 
usage" friction while the different value for 1 inch schedule 40 of 0.006 inches would supersede 
the value of 0.005 inches associated with all Steel pipe.

Finally, among multiple friction data sets you can specify a default data set.

Multiple friction data sets can be created for each type of pipe material. For example, there may 
be separate friction data sets for Steel pipe such as: New Pipe, 10 Year Use, 20 Year Use and 
30 Year Use. Typically, the older pipes will have higher friction.

Figure 1: Friction Data Set tab on the Edit Pipe Materials panel

Insulation Data Sets

Insulation data sets are similar to friction data sets. An insulation data set can be associated with 
the entire pipe material, or with specific sizes or types. Insulation data sets are based on 
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insulation data that has been specified in the Insulation Library. An insulation type must be 
defined first in the Insulation Library before it can be used for an Insulation Data Set.

To create an insulation data set select the pipe material, schedule, or type that will be associated 
with the data set in the list on the left, then click the Insulation Data Set tab on the right and select 
the New Data Set button. Modify the Insulation Data Set description to provide a name, then 
choose an Insulation Library from the drop-down and define an Insulation thickness value. Once 
an insulation Data Set is defined it can be selected for use in the Pipe Properties window with 
Heat Transfer enabled.

As an example, an insulation data set associated with Steel (i.e., the top level) might be based 
on insulation data in the Insulation Library called "Denver Heating Company K-Series". You 
might assign it a thickness of 1 inch and name it "Colorado Standard". Once entered, all steel 
pipe sizes would have a Colorado Standard insulation data set based on Denver Heating Com-
pany K-Series insulation that is one inch thick.

In practice, different thickness would likely be associated with different pipe sizes. To accomplish 
this, you could create insulation data sets for pipes one inch or less, call them "Colorado Stand-
ard", and make them ¼ inch thick. Pipes 1-4 inches could also have "Colorado Standard" sets, 
but would use ½ inch insulation, and pipes larger than 4 inch could have "Colorado Standard" 
and be specified as 1 inch thick. Then in the Pipe Properties window you can choose "Colorado 
Standard" insulation, and the appropriate thickness for the size you have chosen would be used.

Finally, among multiple insulation data sets you can specify a default data set.

Pipe Thermophysical Properties

The Edit Pipe Materials panel allows you to define thermophysical properties for the pipe. The 
density of the pipe can be entered as a constant, and the thermal conductivity as a function of 
temperature. The thermal conductivity is used in heat transfer calculations for pipes.

To add thermophysical properties select a Pipe Material to associate the data set with, then click 
Specify Properties from the Pipe Thermophysical Properties tab on the right. The Pipe Physical 
Properties window will be shown where the thermal conductivity data can be entered on the Pipe 
Material Property Data tab, and the density can be entered on the Density Data tab. A density cal-
culator is provided to calculate the density using the pipe weight and dimensions.

Related Topics

Library Manager 714
Library Browser 714
Fluid Library 719
Junction Library 718
Insulation Library 723
Fittings & Losses Library 723
Libraries 713
Network Library Overview 729
Library Verification 733
Library Locations in General Preferences 735
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Pipe Material Library References 772

Insulation Library
The Edit Insulations panel is accessed from the Library menu. This panel allows you to view the 
insulation data provided with AFT Fathom, or to add, edit or delete user defined insulation mater-
ials. Insulation library items are used for heat transfer calculations in pipes. 

To add a new insulation material click Add New Insulation, then enter the data in the Insulation 
Physical Properties window. The insulation thermal conductivity is entered as a function of tem-
perature, and density as a constant.

Insulation data can be applied directly to pipes, and can also be associated with the Pipe Mater-
ial Library as insulation data sets.

Related Topics

Library Manager 714
Library Browser 714
Fluid Library 719
Pipe Material Library 720
Junction Library 718
Fittings & Losses Library 723
Libraries 713
Network Library Overview 729
Library Verification 733
Library Locations in General Preferences 735
Pipe Material Library References 772

Fittings & Losses Library
The Edit Fittings & Losses panel can be accessed from the Library Menu and allows the user to 
review the Fittings & Losses data provided by default in Fathom, and to add, edit or delete user 
defined Fitting & Losses in the AFT Default Internal Library. 

Fittings & Losses can either be added by using the entry form in the window, or by importing a 
text file as described below. To enter a new Fitting/Loss item in the Edit Fittings & Losses panel 
click Create New Loss Item. Define the applicable category, type, geometry and loss model 
information then click Accept. The user-defined item will appear in the Fittings & Losses on the 
left under the relevant category/type with the source shown in parentheses as "U".

Custom fittings & losses are saved to the local user library. From there the user can move them 
to other libraries (see Library Manager).

Import From File

Fittings & Losses can be imported from a *.CSV type file, which can be created from any spread-
sheet-type software, such as Excel.
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The entries in the file should be in the order as shown in Figure 1, but with no headers in the work-
book. If a header row or a blank row is used, Fathom will present a warning, but give the user the 
option to still import the valid rows.

Figure 1: Example of import file setup for a custom elbow/bend. Headers should not be present in 
the file to import.

Valid options for each of the columns are listed below, with detailed options given in Table 1. 

 l Category - Must match one of the values from Table 1. "Other" may be used if none of the 
specific fitting/loss categories fit.

 l Type - This field is required, any name/value may be entered. Types already existing in 
the library are shown in Table 1, and may be used if desired.

 l Sub Type - This field is optional. A sub-type may be chosen from Table 1, or any other 
name/value may be entered.

 l Geometry - This field is optional. A geometry type from Table 1 must be used if a geo-
metry is entered. If the Geometry field is left blank, the Geometry Value will be ignored.

 l Geometry Value - This field is only required if a Geometry type has been entered. Any 
positive numerical value may be entered.

 l Loss Model - This field is required. The Loss Model must be either "K (constant)" or "K / 
fT (Crane)".

 l Loss Value - This field is required. Any positive numerical value may be entered for the 
loss value.

 l Reference/Notes - This field is optional. Any information may be entered here as 
needed.
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Table 1: Valid Entries for each field. The Geometry Value and Loss Value fields will accept any 
numerical entry. The Reference/Notes field will accept any entry.

Category Type Sub Type Geometry Loss Model

Elbow/Bend

Standard 
Threaded

Mitre

Smooth 
Flanged

 

 

 

 

 

 

 

 

 

 

 

3-K (Darby)

 

 

General

General

r/D=1

r/D=1.5

r/D=2

r/D=3

r/D=4

r/D=6

r/D=8

r/D=10

r/D=12

r/D=14

r/D=16

r/D=20

90 deg

45 deg

180 deg

Angle 
(degrees)

Pipe Size 
(nominal)

None

K (constant)

k / fT 
(Crane)

Valve

Angle

 

 

 

Ball

Butterfly

 

 

Type 1

Type 2

Direct flow

General

None

Plane disk - 
AR=0.92

Plane disk

Angle 
(degrees)

Open Per-
centage

L/D

Pipe Size 
(nominal)

None

K (constant)

k / fT 
(Crane)
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Cylindrical

 

Gate

 

 

 

 

 

 

 

 

Globe

 

 

 

 

 

Plug

Poppet

 

 

t/D=0.1

t/D=0.15

t/D=0.2

t/D=0.25

t/D=0.3

t/D=0.35

Type A

Type B

Type C

General

Rect. Tube

Wedge/Plug

Wedge

Disk w/o 
recess

Disk with 
recess

Disk

Wedge - Full 
Open 10 deg.

Wedge - Full 
Open 20 deg.

Sluice

Disk with 
recess

90 degree wall

45 degree wall

Standard 45 
deg. wall

Standard 90 
deg. wall

Standard
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Three-way

 

3-K (Darby)

 

 

 

 

 

Y Type

Straight-way

W/D=.035

W/D=.07

No Seat Width

Through flow

Branch flow

Angle

Globe

Plug

Gate

Ball

Diaphragm

Check Valve

Swing

 

Lift

 

Tilting disc

Stop-check

 

 

3-K (Darby)

 

90 deg. seat

45 deg. seat

90 deg. wall

45 deg. wall

General

Globe 90 deg.

Globe 45 deg.

Globe thru 
flow

Swing Check

Lift Check

Angle 
(degrees)

None

K (constant)

k / fT 
(Crane)

Orifice
Sharp

Long

None

None

Area Ratio

None

K (constant)

k / fT 
(Crane)

Entrance/Exit

Entrance

 

 

Sharp

Reentrant

Rounded 

R/D

None
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Exit
Flush

None

Other

Diff Flowmtr

 

 

 

 

Honeycomb 
cell

 

 

 

 

 

Screen

 

 

 

Tee

 

Orifice Plate

Nozzle

Venturi 7 deg.

Venturi 3 deg.

Dall Tube

L/D=2

L/D=4

L/D=6

L/D=8

L/D=10

L/D=12

Perforated 
Plate

Circular wire

Silk thread

Round wire or 
netting

Through flow 
(dead branch)

Branch flow 
(dead run)

Area Ratio

None

K (constant)

k / fT 
(Crane)

Flange Steel
150 lb.

300 lb.
None N/A

Related Topics

Fittings & Losses 217
Equivalent Length 270
Library Manager 714
Library Browser 714
Fluid Library 719
Pipe Material Library 720
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Junction Library 718
Insulation Library 723
Libraries 713
Network Library Overview 729
Library Verification 733
Library Locations in General Preferences 735
Pipe Material Library References 772

Network Library Overview
Custom libraries contain custom data generated by the user, including fluid properties, pipe 
materials, and data for junctions types such as pumps and valves. 

All custom data created by the user is kept on the local computer in a file called FTH_
USER11.DAT in the local user directory. This data is not shared and is always available to the 
local user for access or for editing.

In addition to the local user library, you can create multiple network or local custom libraries. The 
Library Manager window on the Library menu simplifies this process. See Creating an Enter-
prise-wide Network Library System for details on how to do this.

Related Topics

Benefits of Shared Libraries 729
Creating an Enterprise-Wide Network Library System 730
Libraries 713
Library Manager 714
Library Browser 714
Library Verification 733
Library Locations in General Preferences 735
Fluid Library 719
Pipe Material Library 720
Pipe Material Library References 772
Junction Library 718
Insulation Library 723
Fittings & Losses Library 723

Benefits of Shared Libraries
When the Fathom libraries are placed on a network, powerful data management procedures can 
be implemented. Specific, quality-checked data can be entered into libraries located on a local or 
wide area network of PC's. This data is not accessible to the end users through AFT Fathom 
itself, so it is guarded data.

Once the data is placed on a network, users can connect to the library in the Library Manager. 
Users can connect to as many libraries as they want.

If the user connects to a library with these files and selects to be connected to any of these con-
trol files, the model will inherit the control formatting specified in the control files. This means that 
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special report layouts, special graphical representations and colors, and other special controls 
can be decided upon by the library constructor, and those control features can be loaded into 
local models by end users. This is highly useful for creating customized reports for certain cus-
tomers or project requirements.

By way of example, assume the Output Control content was specified as coming from the "Col-
orado Springs Office Library" library.

If you uncheck the Library checkbox or change certain data in the Output Control window, the lib-
rary will remain connected but change to an inactive state. When the library is inactive, none of 
its data transfers to the model. To bring the Output Control data back into sync with the con-
nected library, recheck the Library check box in Output Control.

This entire custom library concept lends itself naturally to the idea of specific project libraries. 
Each project has differing requirements that depend on the nature of the project and the end cus-
tomer. Data for each project can be assembled into separate libraries, allowing faster and more 
accurate transmission of the controlled data and desired reporting formats to engineers.

Maintaining a network library allows commonly-used data to be controlled, which may be helpful 
in instances where quality control is strict.

Related Topics

Network Library Overview 729
Creating an Enterprise-Wide Network Library System 730

Creating an Enterprise-Wide Network Library System

Overview

Users of AFT Fathom on a network can access common libraries to simplify model verification, 
improve analysis and reporting consistency, and eliminate redundant work.

To accomplish this there is some initial setup that must be done. First, the data for components, 
materials, formats, etc., needs to be created and saved to various data files. Secondly, these 
files must be made available to the users of AFT Fathom by creating a file named 
DATABASE.LIB in the FATHOM folder. Thirdly, the users need to connect to the new libraries lis-
ted and select the sections to use. Each of these broad steps is discussed below. To maintain 
control and integrity of the data, it would be advised that one person is given the responsibility to 
create and maintain the network libraries. The discussion below will be given from the viewpoint 
of this person.

Table 1 shows the relationship between Internal Libraries and External Libraries as well as the 
library file listing that AFT Fathom uses to find these libraries. An External Library is any library 
file that is created by the user and listed in the FTH_DBUSER.LIB residing in the user’s local 
user directory. The user can make these available and unavailable, and connect and disconnect 
from these libraries using Library Manager. The library files themselves may be located on any 
local or mapped drive. These library files are also distinguished by being under the local user’s 
complete control. External Shared Libraries, on the other hand, are common to all AFT Fathom 
users on the network, therefore the local user cannot remove them from the list of available 
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libraries. However, the user can choose to connect or disconnect from these libraries using 
Library Manager. Finally, to complete the discussion, there are two special libraries, the Default 
Internal Library and the Local User Library. These files are AFT Fathom Internal Libraries which 
cannot be disconnected or made unavailable.

Table 1: Summary of the types of libraries used for the example below, note the difference between 
External and External Shared libraries is just which *.LIB file their file path is listed in

Library Groups & Filenames Library Titles Library Locations

Fathom Internal Libraries   

FATHOM#.DAT

FTH_USER#.DAT

AFT Default Internal 
Library

AFT Fathom Local User 
Library

AFT Fathom # folder, where # 
is the version number

AppData folder

External Shared Libraries 
(DATABASE.LIB)   

VailMaterials.dat Vail Resort Materials Network Location, with path lis-
ted in DATABASE.LIB

External Libraries (FTH_
DBUSER.LIB)   

VailMaterials.dat Vail Resort Materials Network Location, with path lis-
ted in FTH_DBUSER.LIB

Creating Library Files

The first thing to do is create the files that contain the information to be shared. These files will be 
referred to as library files and can contain information about pipe materials, components (e.g. 
pumps, valves, etc.), fluids, etc. The following are several ways to create library files:

 l Use the Create New Library button in the Library Manager, as described previously. Data 
can be taken from the current model or other libraries.

 l Copy and paste sections from one file into another file using a text editor.

This discussion will focus on the first and second methods. Let’s assume that the person 
responsible for the network library has already created a new pipe material. Also, assume that 
the goal is to create a network-wide library to contain this material.

The information for the material is copied from the Local User Library (Fth_User#.DAT, where # 
is the corresponding version number) to a new file using the Library Broswer in the Library Man-
ager. For the source library choose Local User Library and then select Pipe Materials. Then click 
Create New Library and enter a file name, VailMaterials.dat, for this example. Enter a description 
of the library - this description is how AFT Fathom users will refer to the library and should con-
cisely describe what is in the library (for this example we’ll use "Vail Resort Materials"). Right-
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click the pipe materials section from the Local User Library and choose Copy Content to copy the 
pipe materials to this new library file. The pipe material library file has now been created and is 
ready to be used.

Sharing Library Files Using DATABASE.LIB

Now that the library file for the Pipe Materials has been created, it needs to be made available to 
the users of AFT Fathom. Depending on the scope of use, library files can be placed into one of 
two groups. If the library is to be used locally by one user, it is put in the External Library group. 
On the other hand, if the library is to be common among many users and shared over a network it 
is put into the External Shared Library group.

Continuing the above example, the goal is to share the library file, so it will need to be an 
External Shared Library listed in the DATABASE.LIB file in the Fathom directory on the network. 
However, since Fathom does not write directly to the network files for security reasons, it is easi-
est to temporarily treat these files as local External Library files which will be listed in the FTH_
DBUSER.LIB file located in the local user directory of the local machine.

It is recommended that External Shared Library files be copied to the network server and placed 
in a subfolder of the AFT Fathom folder (e.g. AFT Products\AFT Fathom\Libraries). The files 
may, however, be located anywhere on the network that is accessible to the users. For our 
example, we are going to put the pipe material library on the network in a subfolder called Librar-
ies. It is easier to copy the file to the Libraries folder before they are made available in AFT 
Fathom. This will help establish the correct paths to the files as the files are made available using 
the Library Manager.

Once the library file is in the network location, open the Library Manager in AFT Fathom to the 
Library Browser. Each of the new library files we have created needs to be added to the Avail-
able Libraries list by clicking Add Existing Library and browsing to the file. Once you click OK, the 
description of the library you just added appears in the Available Libraries list. Once you have 
added the new library, click Close and the External Library listing file (FTH_DBUSER.LIB) in 
your local user directory is automatically updated.

Now we need to discuss how the paths should be setup. When you add a library, AFT Fathom 
will write the full path of the library to the External Library listing  (FTH_DBUSER.LIB). That 
means that if you browsed to the library file using a mapped drive letter then the path will include 
that drive letter. However, if other users try to access the libraries but have the AFT Fathom 
folder mapped to a different drive letter they will not be able to locate the library files. Other 
options include using either relative paths or the computer name in the path (e.g. \\Network 
Server\Eng Apps\AFT Products\AFT Fathom\Libraries\filename.dat). You can automatically 
have AFT Fathom use the computer name when you add the file by choosing Network Neigh-
borhood, then the computer and then browse to the library file. If you would rather use relative 
paths, you can manually edit them in the library listing file. All library files must be relative to the 
AFT Fathom folder where the executable is located.

When the pipe materials library was added it became an External Library listed in FTH_
DBUSER.LIB. Now we need to move this listing from the local machine to the AFT Fathom folder 
on the network so that all users can access the library files. Once the listing file is moved to the 
network, it must be renamed DATABASE.LIB. Once this is done, all users can now access the 
library file we have created.
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Connecting to the External Shared Libraries

Now that the libraries have been placed on the network and made available to all AFT Fathom 
users, each user must now connect to the libraries and make the sections active as needed. 
When a user opens the Library Manager, the External Shared Libraries are listed in the Library 
Browser. Make sure the checkbox is checked to make those libraries connected for use. Also 
ensure that the sections within the library are checked for use. A library can be connected 
without having any sections selected and active. Finally, to have these connections in place 
every time you start AFT Fathom, click Set As Default. To apply these settings to a model made 
previously, open the model, go to Library Manager, click User Default and, if you have set the 
default, the connections and setting will now be applied to the model.

Sharing Model Formats/Preferences

Note that the Library Manager used to provide the option to include formats/preference settings 
such as the Output Control layouts into shared libraries. These type of files can still be shared, 
but are no longer shared through the Library Manager. Instead these type of format files must be 
loaded directly through their control windows, such as loading the Output Control format being 
loaded in the Output Control window.

Related Topics

Network Library Overview 729
Benefits of Shared Libraries 729

Library Verification
The Library Verification window is displayed when you open a model or new scenario which con-
tains connected library items that have some inconsistency.

1. Library Item Not Found

You may have a library item that is not found in any currently connected library. For example, a 
pump may be connected to a library, and derive its data from that library. However, when the 
model is loaded, the source library is not available. This could be for several reasons that will be 
discussed shortly.

The pump in the model does in fact have all of the required data needed to run the model. But 
when it is not found in the library, you will be offered several options:

 l Disconnect it from the source library - This means that the model will forget the library 
the pump came from and make it a standalone pump not connected to any library.

 l Add it to a library - This means that the pump can be added to a custom library.
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 l Leave the library connection - This means that the pump will remember what library to 
which it was originally connected and connect to that library again when it is made avail-
able to AFT Fathom. If, however, you try to open the Pump Properties window, AFT 
Fathom will disconnect the pump from the library and warn you.

The pump might have lost its library connection for one of these reasons:

 l The library is no longer available because it was removed either through the Library Man-
ager or because your libraries have been changed on the network.

 l The model is being run on a different PC than where it was created, and the original lib-
raries are no longer available. This could be, for example, because you have moved the 
model onto a laptop computer to take it on travel. Or it could happen because the model 
was developed by another company which had developed libraries of its own but which 
are not available to you.

Whatever choice you make, the model will retain all its engineering data and yield the same res-
ults as it did originally.

2. Item in Model is Different from Library

You may have a library item in the model that is connected to an external library, but for some 
reason the data is not the same. For example, you may have a pump curve for the Rocky Moun-
tain Pump Company's Model 100A in your model, but it does not match the pump curve for this 
model in your library. Here you have three choices:

 l Update the items in the model to match the library - This will actually change the 
model's input data, and it might yield different results for the model.

 l Update the library (if it is local) to match the model's items - This will change the lib-
rary, but will leave the model's input data as it was. It will yield the same results as it did 
previously.

 l Disconnect it from the source library - This will leave the model as it was, and it will 
yield the same results.

The pump in the model might have a different pump curve than the one in the library for one of 
these reasons:

 l When the model was built, the pump was connected to the Rocky Mountain Pump Com-
pany (i.e., RMPC) Model 100A. But since that time, the library RMPC library has changed. 
Perhaps there was an input error in the original data, or better data has since become 
available and the library was updated. If this were the case, it would be best to update all 
your pumps to the library values.

 l The library may have been changed by an unauthorized individual, and while it was accur-
ate originally, now the data is no longer valid. In this case, it would be best to not update 
the pump in your model, and to inquire into the cause of the inaccurate data within your 
organization.

Related Topics
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Libraries 713
Library Manager 714
Library Browser 714
Network Library Overview 729
Library Locations in General Preferences 735
Fluid Library 719
Pipe Material Library 720
Pipe Material Library References 772
Junction Library 718
Insulation Library 723
Fittings & Losses Library 723

Library Locations in General Preferences
When performing an engineering analysis with or even without cost estimating, there may be 
many engineering and cost libraries that underlie the model. These libraries need to be con-
nected in the Library Manager in order to be accessible by the model. However, to know what lib-
raries are actually needed, one needs to first load the model. This creates a dilemma. 

To help alleviate the dilemma, users can create "Library Search Locations" in the User Options 
window. Figure 1 shows an example. Once specified, you can set these as your default locations 
by clicking the Set As Default button. When AFT Fathom tries to open a model that requires cer-
tain libraries, and those libraries have not been connected already, AFT Fathom looks for them 
in the locations specified in the User Options. In addition, AFT Fathom looks in the model's 
folder. If AFT Fathom finds the libraries in one of these locations, it automatically adds it to the list 
of connected libraries in the Library Manager. If it cannot find a library, it informs you once the 
model is loaded.
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Figure 1: Library Search Locations can be defined in the User Options window

Related Topics

Libraries 713
Library Manager 714
Library Browser 714
Network Library Overview 729
Library Verification 733
Fluid Library 719
Pipe Material Library 720
Pipe Material Library References 772
Junction Library 718
Insulation Library 723
Fittings & Losses Library 723
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This section focuses on the fundamental theories that are used in AFT Fathom's solution 
method. Additionally, this chapter gives information on the source material for the theories used. 
Topics include discussions on the theories that comprise the network solution, detailed inform-
ation on theory, and information on references used in the development of AFT Fathom.

Content

Nomenclature 737

Network Solution Methodology 739

References 747

Chempak Technical Information - Detailed Discussion 749

Role of Pressure Junctions - Detailed Discussion 761

Pipe Material Library References 772

Nomenclature

A cross-sectional flow area of a pipe

cp specific heat, constant pressure

CD discharge coefficient

CV valve coefficient

CHW Hazen-Williams factor

D diameter of a pipe

f friction factor

fT turbulent friction factor (used by Crane, 1988)

fL laminar friction factor

fTr transition friction factor

F error value in mass balance

Fr Froude number

g gravitational constant

h convection coefficient
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h enthalpy

H head

HGL hydraulic gradeline (same as head)

J Jacobian matrix

k thermal conductivity

K loss factor

K constant for Power Law fluid

Ksprinkler fire sprinkler loss factor

L length of a pipe

ṁ mass flow rate

n general constant

n constant for Power Law fluid

Nu Nusselt Number

P pressure, static

Ph heated perimeter

Po pressure, stagnation

Pw wetted perimeter

q heat rate to a pipe

Q volumetric flow rate

q" heat flux

r radius

r relaxation

R, R’ resistance

Rc coefficient of rigidity

Re        Reynolds Number

Rh Hydraulic radius (equal to radius divided by 2)

s pump speed

S Submergence

S Hydraulic gradeline gradient

Sy yield stress
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T temperature

U overall heat transfer coefficient

V velocity

x distance along pipe centerline

z elevation

a, m, q angle

b diameter ratio

e roughness

n kinematic viscosity

ρ density

μ dynamic viscosity

Subscripts             

i junction at which solution is sought

j junctions with pipes connecting to junction i

o stagnation

∞ infinity, far away, ambient

Network Solution Methodology
AFT Fathom makes use of standard matrix solution techniques (Jeppson 1976). The method is 
known as the H-Equation method, where H, the piezometric head, is solved for at each junction 
by forcing continuity of flow through each connecting pipe. Simultaneously, the head loss across 
each pipe is updated based on the flow balance information. The flow rate and head are solved 
in an inner-outer loop algorithm, where the flow is guessed, the head loss is calculated con-
sistent with that guess, and the flow is updated according to the new pressure drop information. 
The Newton-Raphson method is employed to refine each successive solution, resulting in a 
sparse square matrix that is solved during each solution pass.

The concepts of pressure and hydraulic gradeline (HGL, also called piezometric head) are 
related but use different frameworks for considering pipe system behavior. The HGL includes 
both the static and elevational effects of pressure. The relationship between the two is given by 
Equation 1:             

(1)
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where z is the elevation and P is the static pressure. Each concept offers certain advantages.

The solution technique makes use of the continuity and one-dimensional momentum equations. 
AFT Fathom uses pressure and mass flow rate as the unknown parameters because they are 
more fundamental in nature than the head and volumetric flow rate used by Jeppson and thus 
extend more naturally to mechanical and chemical systems.

In the following discussion, subscripts denote values at junctions. Thus, Pi represents the static 
pressure at junction i. Double subscripts denote values along pipes connecting two junctions. 
Thus, ṁij represents the mass flow rate in the pipe connecting junctions i and j.             

Application of the law of mass conservation to each junction yields:

(2)

where n is the number of pipes connected to junction i. Equation 2 states that the net mass flow 
rate into each junction must sum to zero. 

The basic equation for pipe pressure drop due to friction can be expressed with the Darcy-Weis-
bach equation:

(3)

where ΔPf is the frictional pressure loss. The total pressure change between junctions is given 
by the momentum equation in the form of the Bernoulli equation:

(4)

The static (normal), P, and stagnation (pressure if all kinetic energy were converted isen-
tropically into pressure), Po, pressures are related as follows:             

(5)

Substituting Equation 5 into 4

Solving for the frictional pressure drop for a constant area pipes yields:
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(6)

where i and j denote upstream and downstream junction values. 

The definition of mass flow rate is:

(7)

Combining Equations 3 and 6 and substituting for velocity, V, using Equation 7 gives the mass 
flow for each pipe:

(8)

where Rij' is the effective flow resistance in the pipe and the subscript ij refers to the pipe con-
necting junctions i and j.             

(9)

Note that R' is not the same as R, which is the resistance used in the Output Control window and 
is expressed by the following equation:

Substituting Equation 8 into Equation 2 results in the equation to be applied to each junction i:

(10)

where n is the number of pipes connected to junction i.

To be completely general, Equation 10 should be written for junction i:
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(11)

to allow for application of boundary condition flow rates to a boundary junction node.

Equation 11 as applied to each junction in the network represents the system of equations that 
need to be solved to determine the stagnation pressure at each junction. To solve this system, 
the Newton-Raphson method is employed. In the Newton-Raphson method, new values for 
each unknown are calculated based on the previous value and a correction that uses the first 
derivative of the function.

In this instance the function that Newton-Raphson is applied to would be of the form:

(12)

The method involves finding all the junction stagnation pressures, Po,i , that cause all of the Fi to 
go to zero, thus satisfying Equation 11 at all junctions.

When applied to a system of equations, the Jacobian matrix contains all the required derivative 
information to employ the Newton-Raphson technique. The Jacobian, JF, is given by:

The column matrix  contains the stagnation pressure at each junction, and column matrix  

contains the F values (Equation 12) at each junction. The updated solutions for  are obtained 
from the following Newton-Raphson equation:
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(13)

Traditional implementations of the Newton-Raphson method require initial guesses at the solu-
tion before the Solver can begin. This often results in the situation where you have to know the 
solution ahead of time in order to solve for it. To avoid placing this burden on the user, AFT 
Fathom uses a proprietary method for generating first guesses. This method is usually sufficient 
to get the solution going in the right direction, especially for systems that don't have highly non-
linear features.

However, there are times when AFT Fathom's first guess does not lead to a converged solution. 
In these cases, AFT Fathom provides you with the option of specifying your own initial guesses 
of flow and pressure.

Related Topics

Continuity Equation at a Branch 743
Energy Equation at a Branch 744
Network Implementation 744
Verifying Network Solutions 746
Nomenclature 737
Head loss, head rise, hydraulic gradeline and energy gradeline output does not 
have meaning for zero g systems 790

Continuity Equation at a Branch
By applying the continuity equation at branch i, we loop over all connecting pipes and get:

where ṁij is the flow rate in the pipe connecting junctions i and j.             

Related Topics

Network Solution Methodology 739
Energy Equation at a Branch 744
Network Implementation 744
Verifying Network Solutions 746
Nomenclature 737
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Energy Equation at a Branch
By applying the energy equation at a branch i, we loop over all connecting pipes and get

where hij is the enthalpy at the connection point of pipe and junction.             

Related Topics

Network Solution Methodology 739
Continuity Equation at a Branch 743
Network Implementation 744
Verifying Network Solutions 746
Nomenclature 737

Network Implementation
By applying the Continuity Equation at a Branch about junction i and branches j, we get

(1)

By applying the Energy Equation at a Branch about junction i and branches j, we get

(2)

To obtain a valid solution in a network, the stagnation pressure at each branch point will be equal 
and the mass flow and energy flow will sum to zero at the branch. Although the stagnation pres-
sures at the pipe endpoints will equal that at the connecting junction, this is not true for enthalpy 
(and temperature). The enthalpy at the end of a pipe will be that enthalpy that results from the 
heat transfer in the pipe. Once the fluid flows into the junction, the enthalpy will change to the mix-
ture enthalpy, or the average enthalpy of all inflowing pipes. 

If only one pipe flows into the branch, the branch enthalpy will equal the enthalpy coming out of 
the pipe. But if more than one pipe flows into the branch, the enthalpy will reach an averaged 
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condition. It is this averaged enthalpy that results from mixing of two or more streams at different 
enthalpies. This enthalpy is supplied to all outflowing pipes. The preceding discussion in depic-
ted in Figure 1 and follows equation 3.

(3)

where the + superscript indicates the summation applies only to positive inflows into the junction.

To provide converged solutions in the shortest time possible, matrix solution techniques are 
required. Matrix techniques allow all pipes to be solved together, which offers speed and the best 
convergence characteristics.

Figure 1: Flow weighted mixing and energy balance
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Energy Balances with AFT Standard fluids

The AFT Standard fluids do not have enthalpy data, so Fathom uses the Reference Enthalpy 
Method, described in the following equation, to calculate enthalpy:

Therefore Equation 3 can be expressed as the following:

(4)

The reference enthalpy and temperature is entered in the fluid library, and should be for a state 
that is as near as possible to the operating conditions of your model. As seen from the equation, 
the pressure dependence of enthalpy is ignored. In many cases, this assumption is acceptable.

Chempak and NIST REFPROP fluids have enthalpy data and Equation 3 can be used directly. 

Related Topics

Network Solution Methodology 739
Continuity Equation at a Branch 743
Energy Equation at a Branch 744
Verifying Network Solutions 746
Nomenclature 737

Verifying Network Solutions
As discussed previously, AFT Fathom uses a Newton-Raphson matrix method to obtain a sys-
tem level mass balance and energy. When the Solver (the part of AFT Fathom that applies the 
governing incompressible flow equations to obtain a solution to the pipe system) is finished, the 
Continuity Equation and Energy Equation are satisfied at all branching sections. Once solved, it 
is a simple matter to go back and sum up all mass flows and energy at each branch to verify that 
these equations are satisfied. In fact, AFT Fathom does just that. 

After the Solver converges, AFT Fathom loops over each junction and adds up the inflow and out-
flow of mass and energy and compares the sum to the solution tolerances. If it appears that any 
junction is out of tolerance, a warning is given in the output.
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In the Solution Balance Summary table AFT Fathom provides additional information on the bal-
ance at each junction. This table can be displayed by selecting the option in the Output Control 
window General tab. Figure 1 shows an example of the Solution Balance Summary table.

Figure 1: Solution Balance Summary table shown in the Output window offers a balance report of all 
junctions in the window

Related Topics

Network Solution Methodology 739
Continuity Equation at a Branch 743
Energy Equation at a Branch 744
Network Implementation 744
Nomenclature 737
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Chempak Technical Information - Detailed Discussion
© Copyright 1998 Madison Technical Software Inc. Used with permission.

Note: The information in this Appendix was taken from Section 8 of the Chempak Operating & 
Reference Manual, Version 4, Windows Edition, Issue: January 1998. Section num-
bering was left unchanged, and some sections that were judged not relevant were not 
included so the numbering is not sequential. Notation and references in this Appendix 
apply only to this Appendix, and are referenced at the end.

8.1 General

This section sets out the data sources, correlations and estimation methods used in the 
CHEMPAK database. In putting together the database, the methods and sources were selected 
in the following order of preference. 

·        Published experimental data 

·        Published correlations based on experimental data 

·        Specific category correlations 

·        General estimation methods 

Madison Technical Software has followed the general recommendations in Reid and in Danner 
and Daubert as far as selection of specific category correlations and general estimation methods 
are concerned. In selecting specific compound data, a combination of sources has been used 
wherever possible. Important sources of specific compound data used by CHEMPAK are: 

·        Reid et al 

·        Perry et al 

·        J Chem Eng Data 

·        Daubert & Danner 

- 749 -



Theory and References

·        ESDU publications 

·        API Technical Data Book - Petroleum Refining 

·        International Critical Tables 

·        CRC Handbook 

·        Vargaftik 

In many cases, the compound property values are a combination of published data, published 
correlations and general estimation methods. Several properties in certain compound categories 
have been estimated or adjusted by Madison Technical Software. It has been our policy to adopt 
and maintain a critical approach to available data sources and correlation methods.

The following sections set out details of the correlations and estimation methods used. In certain 
cases, the user is directed to the original references, particularly where the method is complex.

Data sources for Aqueous Solutions/Heat Transfer Liquids are published experimental data and 
correlations based on experimental data.

8.2 Physical Constants 

8.2.1 Critical Temperature 

The great majority of values are believed to be experimental. Where values had to be estimated, 
the Joback method was used. 

8.2.2 Critical Pressure 

Most of the values are experimental. In cases where experimental data were not available, the 
critical pressure was derived from the Joback method.

8.2.3 Critical Volume 

A majority of the values are experimental. A great majority of the remaining compounds for which 
experimental values were not available had accurate boiling-point volumes available from which 
critical volume estimates were derived using the Tyn and Calus correlation. For a few sub-
stances, estimates of the critical volume were derived from the Joback method. 

8.2.4 Normal Boiling Points 

All values are believed to be experimental. In some cases, the values were slightly adjusted for 
vapor pressure.

8.2.5 Freezing Points 

Where possible, quoted freezing points are experimental. No accurate method of estimation of  
compound  freezing point  is available.  In the absence of experimental data, a rough estimate 
was derived from the Joback method.

8.2.6 Acentric Factors

The acentric factor is defined as 

 w = -log10(Pvr at Tr = 0.7) - 1 

In all cases the acentric factor was derived from the vapor pressure correlation ( see section 8.8) 

8.2.7 Joback Group Contribution Method 
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The Joback method is used to derive values of Tc, Pc, Vc and Tf where no experimental data or 
other predictive method was available. 

Tc = Tb/(0.584 + 0.965 Sum(Dt) - Sum(Dt)2)

Pc = 1/(0.113 + 0.0032 na - Sum(Dp))2

Vc = 17.5 + Sum(Dv)

Tf = 122 + Sum(Df)

where na is the number of atoms in the molecule and the D contributions are given by Joback 
and by Reid et al (1987). Error magnitudes for the Joback method are as follows: 

·        Critical Temperature: average error about 1%

·        Critical Pressure: average error about 5%

·        Critical Volume: average error about 2%

·        Freezing Point: average error about 11% 

8.2.8 Tyn & Calus Relation 

Tyn & Calus showed a close (< 3% error) relation between molar volume at normal boiling point 
and the critical molar volume of the form, 

Vb = a Vcn 

a = 0.285 

n = 1.048 

8.3 Liquid Specific Volume 

Liquid specific volume rises slowly and approximately linearly with rise in temperature to about 
Tr  =  0.8. At higher temperatures, the values rise more rapidly to the critical point. 

Experimental data or correlations derived from experimental data are available for most com-
pounds. 

8.3.1 Hankinson-Brobst-Thompson Equation 

The saturated specific volume is given by, 

Vs/V* = Vr(O)(1 - wsrkVr(1))

Vr(O) = Sum{an(1 - Trn/3)}             0.25 < Tr < 0.95 

Vr(1) = Sum{bnTrn/(Tr - 1.00001)}      0.25 < Tr < 1.0

aO = 1 

a1 = -1.52816 

a2 = 1.43907 

a3 = -0.81446 

a4 = 0.190454 

bO = -0.296123 

b1 = 0.386914 
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b2 = -0.0427258 

b3 = -.0480645 

V*, wsrk and Tc are tabulated property constants. The user is referred to Hankinson, Thompson 
and to Reid et al (1987). Errors are typically about 1% with most being less than 2%. 

8.3.2 Rackett Equation 

If a reference volume (Vref at Tref) is available then  

Zra = (PcVref / RTc)n 

n = 1/(1 + (1 - Tref / Tc)m) 

m = 2/7 or other empirical constant 

The saturated specific volume is given by, 

Vs = VrefZrax

with 

x = -(1 - Tref / Tc)m + (1 - T/Tc)m 

In most cases, an experimental value of reference density was available.  Where such a value 
was not available, values were derived from the group contribution method of Le Bas or derived 
from the critical volume using the Tyn & Calus relation. Tests by Madison Technical Software on 
over 80 liquids showed  that these two methods were significantly more accurate than the Spen-
cer and Danner method for Zra.  The reader is referred to Reid et al for further  details on  these 
methods. With one or more experimental points, the Rackett equation gives errors of about 1% 
with most values less than 3%. If the reference volumes are estimated, typical errors are 3%. 

8.3.4 The Effect of Pressure on Liquid Specific Volume 

The effect of pressure on liquid specific volume is calculated when  

P > Ps + 0.1 Pc 

The correction is derived from the equation of state as follows, 

VL = VLs - VLs,es + VL,es 

VL = specific volume at T and P 

VLs = VL at T and Ps from methods of this section 

VLs,es = VL at T and Ps from the equation of state 

VL,es = VL at T and P from the equation of state

Liquid specific heat can in principle be derived from the equation of state but in practise, direct 
analytical or group contributions are preferred where experimental data are not available. 

8.4 Liquid Specific Heat 

8.4.1 Rowlinson-Bondi Method 

(CpL - Cpo)/R = 1.45 + 0.45/X + 0.25w(17.11 + 25.2X0.333/Tr + 1.742/X)

X = 1 - Tr

w = acentric factor 
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This method is generally applicable to the range from Tf to values approaching Tc. Note that CpL 
approaches infinity as T approaches Tc. 

Errors are generally less  than 5% except in the case of hydrogen-bonding polar compounds 
(e.g.   alcohols) at low temperatures. For these compounds, the Missenard group contribution 
method is preferred.

8.4.2 Missenard Method 

The Missenard group contribution method yields values of coefficients in  

CpL = a + bT + cT2 

The accuracy is usually better than 5%.  The method cannot deal with double bonds and is not 
applicable for Tr > 0.75 

a = Sum{an} 

b = Sum{bn} 

c = Sum{cn} 

The group contributions are available in Missenard. See also Reid at al.

8.4.3 The Effect of Pressure on Liquid Specific Heat

As noted above, the equations of state can be employed to estimate liquid specific heat, but the 
methods presented in 8.4.1 and 8.4.2 are more reliable. The equations of state however can be 
used to estimate the effect of pressure on liquid specific heat.   

CpLs = CpL at Ts and Ps determined by the methods of this section. 

Cpo = ideal gas specific heat at Ts 

CpL = CpL at Ts and P > Ps

The equations of state give estimates of

Ds = (CpLs - Cpo)es at Ts and Ps 

D = (CpL - Cpo)es at Ts and P 

The corrected value of the liquid specific heat is 

CpL = CpLs + D - Ds 

The correction is not applied when T is close to Tc

8.5 Liquid Viscosity 

Liquid viscosity typically varies in magnitude by a factor of 100 or more between the freezing and 
critical temperatures. No generalized method is available to estimate or represent liquid viscosity 
adequately over the entire temperature range. Corresponding states methods are applicable 
above Tr = 0.76.  From the freezing point to the boiling point, the influence of structure is strong.            

 

8.5.1 Method of Van Velzen 

The method of Van Velzen et  al is a group contribution method of some  complexity and  range  
of applicability. It is the most frequently used group contribution method. The accuracy of the 
estimation averages about 10% and most estimates are better than 20%.  Some of the lim-
itations of the method are: 

·        Larger errors found with the  first  members of  a homologous series
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·        Only normal and iso substitutions on alkyl chains can be treated    

·        Heterocyclic compounds cannot be treated 

·        Application only in the range Tf to Tb

The method is complex and the reader is directed to the original references for full details. 

8.5.2 Method of Morris 

The method of Morris is a group contribution method.  This method is useful as a comparison 
and substitute for the Van Velzen method in cases where the Van Velzen method is not applic-
able. The accuracy of estimation is of the same order as Van Velzen. The limitations of the 
method are, 

·        The method is less detailed than the Van Velzen method 

·        Applicable only in the range Tf to Tb

·        No explicit treatment  for  heterocyclics  or  esters  (apart from acetates).    

The Morris method takes the following form 

ln(v/v*) = 2.3026 J(1/Tr - 1) 

J = (0.577 + Sum(Di))0.5 

The values of v* are given for various categories of compounds. The constants v* and the group 
contributions D are given in Morris.

8.5.3 Method of Letsou and Stiel 

This is a corresponding states method with applicability over 0.76 < Tr < 1.  The method also pre-
dicts the viscosity at the critical point  (Tr =  1). The accuracy is normally better than 5% up to Tr = 
0.92 with higher errors encountered as the critical point is approached. Overall this is an excel-
lent estimation method for high-temperature liquid viscosity. The only serious limitation is the 
restricted range of applicability. 

The form of the relation is  

v = (f0 + w.f1)/A 

with 

w = acentric factor 

f0 = a0 + b0Tr + c0Tr2 

f1 = a1 + b1Tr + c1Tr2 

A = 0.176x106 Tc0.1667/M0.5Pc0.667 

a0 = 2.648               a1 = 7.425 

b0 = -3.725              b1 = -13.39 

c0 = 1.309               c1 = 5.933 

In the above relations Pc is in bar and the viscosity is in units of Pa-sec. 

8.5.4 Method of Przezdziecki & Sridhar 

In this method, the viscosity is related to changes in the specific volume. 

v = V0/E(V - V0) centipoise 

V = liquid molar volume in cc/mol 
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E = -1.12 + Vc/D 

D = 12.94 + 0.1 M - 0.23 Pc + 0.0424 Tf - 11.58 Tf/Tc

V0 = 0.0085 wTc - 2.02 + Vf / {0.342(Tf / Tc) + 0.894} 

with 

Tc = critical temperature, K 

Pc = critical pressure, bar 

Vc = critical volume, cc/mol 

M = molecular weight 

Tf = freezing point, K 

w = acentric factor 

Vf = specific volume at Tf 

The authors recommend that the volumes be estimated from the Gunn and Yamada equation.   
The reader is referred to Reid for a discussion on this method. The method is less accurate 
below reduced temperatures of about 0.55.   Errors vary widely but will normally be less than 
20% for Tr greater than 0.55. 

This method is used in CHEMPAK only where necessary. An error analysis by Reid et al indic-
ates a higher level of error associated with this method than with the Van Velzen method for 
instance.  

8.5.5 Interpolation and Extrapolation 

Two regions are typically covered well by available experimental data, experimental correlations 
and by the above relations: 

273 <  T < 0.6 Tc:  this region is normally  covered by published data or by one of the 
methods 8.5.1, 8.5.2, 8.5.4 

0.76 Tc <  T < Tc: this  region is well covered by  the method of Letsou and Stiel (section 
8.5.3) 

This leaves two regions which are often not covered by the above methods 

Tf < T  < 273: this region may be covered by extrapolation using ln(v)  versus   1/T  extra-
polation. The error due to the extrapolation in practise will not normally exceed 10% with a pos-
sible 20% error in the immediate vicinity of the freezing point. 

0.6 Tc < T < 0.76 Tc: this region may be covered by interpolation between the 273 < T  < 
0.6 Tc region and the 0.76 Tc < T  < Tc region using ln(v) versus 1/T interpolation. The errors due 
to interpolation in this case rarely exceed 5%. 

8.5.6 The Effect of Pressure on Liquid Viscosity 

The method of Lucas is applied: 

vL/vsL = (1 + B.FA)/(1 + w.C.F) 

vL = viscosity at pressure P 

vsL = viscosity at saturation pressure Ps

F = (P - Ps)/Pc

w = acentric factor 
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A = 0.9991 - 0.0004674/(1.0523/Tr0.03877 - 1.0513) 

B = 0.3257/(1.0039 - Tr2.573)0.2906 - 0.2086 

C = -0.07921 + 2.1616 Tr - 13.404 Tr2 + 44.1706 Tr3  -84.8291 Tr4 + 96.1209 Tr5 - 
59.8127 Tr6 + 15.6719 Tr7 

8.6 Liquid Thermal Conductivity 

8.6.1 Method of Latini at al 

For specified categories of compounds, the method of Latini et al gives correlations for liquid con-
ductivity for the range Tr = 0.3 to 0.8 

The correlations are in the form 

k = A(1 - Tr)0.38/Tr0.167 

A = A0TbnMmTcp 

Category                                A0             n        m          p 

Alkanes                                 0.0035       1.2    -0.5    -0.167  

Alkenes                                0.0361       1.2    -1.0    -0.167 

Cycloalkanes                         0.0310       1.2    -1.0    -0.167 

Aromatics                              0.0346       1.2    -1.0    -0.167 

Alcohols/Phenols                   0.00339     1.2    -0.5    -0.167 

Acids                                     0.00319     1.2    -0.5    -0.167 

Ketones                                 0.00383     1.2    -1.0    -0.167 

Esters                                    0.0415        1.2   -1.0    -0.167 

Ethers                                    0.0385        1.2    -1.0   -0.167 

Halides                                  0.494          0.0    -0.5     0.167  

R20,R21,R22,R23                 0.562          0.0    -0.5     0.167

Errors may be large for Diols and Glycols. The Acids equation is not applicable to Formic acid.  
The reader is referred to Reid for a discussion of the method. 

8.6.3 Method of Sato-Riedel 

This method gives the following relation: 

k = (1.11/M0.5)f(Tr)/f(Tbr) 

with 

f(X) = 3 + 20(1 - X)0.667 

This method gives poor results for low molecular weight or branched hydrocarbons.   Errors oth-
erwise are likely to be less than 15%. The method should not be applied for Tr > 0.8  

8.6.4 Method of Ely and Hanley 

The method of Ely and Hanley has application to the high-temperature liquid region (Tr > 0.8). 
There are few data available for high temperature liquid conductivities. The method of Ely and 
Hanley is probably the best method available. Error estimates are unknown. 
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This method is used in CHEMPAK for Tr  > 0.8 with caution.  It appears to give reasonable res-
ults for non-polar compounds. Errors with polar compounds can be large. 

8.6.5 The Effect of Pressure on Liquid Conductivity

The procedure derived from Missenard as presented in Danner and Daubert is employed: 

k/ks = 0.98 + 0.0079 PrTr1.4 + 0.63 Tr1.2Pr/(30 + Pr)

k = conductivity at P 

ks = conductivity at Ps

8.8 Vapor Pressure 

The vapor pressure is expressed in its reduced form 

Pvr = Pv/Pc

Reduced vapor pressure varies from very low values at freezing point to unity at the critical point. 

8.8.1 Published Correlations 

The experimental correlations are commonly given in the following formats: 

Wagner Equation 

ln(Pvr) = (aX + bX1.5 + cX3 + dX6)/Tr

with 

X = 1 - Tr

FKT Equation 

ln(Pv) = a + b/T + cln(T) + dPv /T2 

Antoine Equation 

ln(Pv) = a + b/(T + c) 

8.8.2 Gomez-Thodos Vapor Pressure Equation 

Gomez-Nieto and Thodos give the following equation: 

ln(Pvr) = B(1/Trm - 1) + G(Tr7 - 1) 

G = aH + bB 

a = (1 - 1/Tbr)/(Tbr7 - 1) 

b = (1 - 1/Tbrm)/(Tbr7 - 1) 

H = Tbrln(Pc/Pb)/(1 - Tbr) 

For non-polar compounds, 

B = -4.267 - 221.79/(H2.5exp(0.038 H2.5)) + 3.8126/exp(2272.33/H3) + D 

m = 0.78425 exp(0.089315 H) - 8.5217/exp(0.74826 H) 

D = 0

except D = 0.41815 for He, 0.19904 for H2, 0.02319 for Ne 

For polar non-hydrogen-bonding compounds (e.g. ammonia and acetic acid), 
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m = 0.466 Tc0.1667 

G = 0.08594 exp(0.0007462 Tc) 

B = (G - aH)/b

8.8.2 Gomez-Thodos Vapor Pressure Equations 

For polar hydrogen-bonding compounds (water, alcohols), 

m = 0.0052 M0.29Tc0.72 

G = (2.464.M) exp(0.0000098 MTc) 

B = (G - aH)/b 

The advantages of this method are, 

·        fit guaranteed at T = Tb and T = Tc 

·        good performance with polar compounds 

·        good performance over Tr = 0.5 to 1 

In addition, tests carried out by Madison Technical Software show the clear superiority of this 
method especially at low temperatures over the Lee-Kesler method. 

8.8.3 Lee-Kesler Vapor Pressure Equation 

Lee and Kesler give the following vapor pressure equation: 

ln(Pvr) = f(0) + wf(1) 

w = acentric factor 

f(0) = 5.92714 - 6.09648/Tr - 1.28862 ln(Tr) + 0.169347 Tr6 

f(1) = 15.2518 - 15.6875/Tr - 13.4721 ln(Tr) +0.43577 Tr6 

The characteristics of this equation are, 

·        guaranteed fit at Tr = 1 and 0.7 

·        accurate for non-polar compounds 

This equation is used in the Lee-Kesler and Wu & Stiel equations of state. 

8.8.4 Interpolation and Extrapolation 

In many cases an accurate empirical equation is known which does not extend to the critical 
point or to the freezing point. The approach taken here is to fit the Wagner equation by least 
squares to the empirical equation and use the Wagner equation to extrapolate to the freezing 
point and to the critical point. 

Extrapolation by this method to the critical method is a very accurate procedure. Extrapolation to 
the freezing point is less accurate but it does provide reasonable values. 

In CHEMPAK, the vapor pressure correlations set out in this section are used to provide the 
basic data. Empirical relations are used wherever possible. 

8.14 Notation 

C Specific Heat 

e Expansion Coefficient 
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h Enthalpy 

log Logarithm to base 10 

ln Natural Logarithm 

m Dipole Moment 

M Molecular Weight 

P Pressure 

R Gas Constant 

r Riedel Parameter 

s Entropy 

T Temperature 

v Viscosity 

V Specific Volume 

w Acentric Factor 

x Mole Fraction 

Y Wu & Stiel Polarity Factor 

Z Compressibility 

Subscripts 

b Boiling 

c Critical 

es Equation of State 

f Freezing 

ig Ideal Gas 

L Liquid 

m Mixture 

0 Low Pressure 

p Constant Pressure 

ra Rackett 

ref Reference 

r Reduced 

s Saturated 

v Vapor 

v Constant Volume 

Superscripts 

(o) Simple Fluid 
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(r) Reference Fluid 

(p) Polar Fluid 
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Role of Pressure Junctions - Detailed Discussion
In modeling a generalized pipe network, it is possible to construct models that do not have a 
unique solution. A common occurrence of this is when a model contains one or more sections 
which are completely bounded by known flow rates. A series of examples with accompanying 
explanation will clarify situations where this occurs.

Before beginning, it will be helpful to consider an aspect of the philosophy of computer modeling. 
At the risk of stating the obvious, it must be recognized by the user that a computer model cannot 
calculate anything that cannot in principle be calculated by hand. All the computer does is accel-
erate the calculation process. Some users expect the model to generate independent inform-
ation and become frustrated when the software requests additional information from them. But if 
the user was doing the calculation by hand that same information would still be required. The dif-
ference is that in the case of the hand calculation, the engineer would be forced to think through 
why the information is needed. 

However, when the engineer interacts with AFT Fathom, they do not need to think at the same 
depth as in the hand calculation. So when AFT Fathom asks for the additional information, it is 
not as apparent why it is required. This disconnect in thinking can cause frustration for the user. 
Fully understanding the concepts in this topic will greatly reduce the frustration for some users, 
and will improve the quality of models for all users.

Examples

The simplest example is the system shown in Figure 1. In AFT Fathom terms, the system has 
two assigned flow junctions. Heat transfer has no affect on the point being made here and is 
therefore ignored in all examples.

Figure 1: Model with two assigned flows. This model does not have a unique solution.
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Obviously, the flow in the pipe is known. But what is the pressure at the inlet? At the outlet? It can-
not be determined because there is no reference pressure. The reference pressure is that pres-
sure from which other pressures in the system are derived. There can be one or more reference 
pressures, but there always has to be at least one.

The model in Figure 1 can be built with AFT Fathom and if you try and run this model, AFT 
Fathom will inform you that it cannot run it because of the lack of a reference pressure. In AFT 
Fathom there are several junctions that can act as a reference pressure: the reservoir, assigned 
pressure, spray discharge, valve (with the exit valve option), orifice (with the exit orifice option), 
and exit type relief valves when open.

There are a couple other things worth noting about Figure 1. First is that the model in Figure 1 
has redundant boundary conditions. When one flow is specified in a single pipe, the other end 
must have the same flow. Thus the second known flow does not offer any new information. 
Because the conditions are redundant, there is no unique solution to the model in Figure 1. In 
any AFT Fathom model, there is always at least one unknown for each junction in the model – 
either pressure or flow rate. Sometimes there are two unknowns, such as a Pump. It is possible 
the user may not know either the flow or the pressure at the pump. In such cases the user is 
required to specify the relationship between flow and pressure. This relationship is called a pump 
curve, and by specifying the relationship between the two, effectively one of the two unknowns 
can be eliminated. Thus we always end up with one unknown for each junction.

Second, if the user was allowed to specify two flows as in Figure 1, they could specify them with 
different flow rates. Both ends of the pipe must have the same flow, so an inconsistency occurs. 
The basic reason the inconsistency is possible is because Figure 1 does not have a unique solu-
tion. 

Figure 2 a-c shows three alternate configurations for the model in Figure 1. It is not possible to 
specify inconsistent conditions for any of the Figure 2 models, and they always have a unique 
solution no matter what input is specified by the user.

Figure 2a-c: Top two models with one pressure and one assigned flow, bottom model with two pres-
sures. All of these models have a unique solution.

The four models in Figures 1 and 2 a-c contain all logical possibilities. In all four cases there are 
four things we want to know. The pressure and flow at the inlet, and the pressure and flow in the 
outlet. In each case we know two of these four. The problem is that in the Figure 1 model the lack 
of a reference pressure makes it impossible to determine the inlet and outlet pressures, even 
though we know the flow. The three models in Figure 2 a-c all have at least one pressure and 
thus all four of the desired parameters can be determined. Table 1 summarizes this. Also note in 
Table 1 that in the Figure 2c case the flow can be determined, but it is by iteration.
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Table 1: Four logical possibilities of boundary conditions for single pipe systems

As we consider multi-pipe systems, there are a host of other possibilities that present them-
selves. All other configuration possibilities which lack a reference pressure ultimately boil down 
to the same problem that exists in Figure 1.

The pipe lengths, diameters and friction factors are not included in the remaining models 
because they do not influence the main point of this topic. It is assumed that these parameters 
can be obtained for each pipe and the resulting pressure drop calculated with standard rela-
tionships.

Consider the model in Figure 3. With three boundaries having a known flow, this clearly has the 
same problem as the model in Figure 1. No unique pressures at any location can be calculated.

A pressure at any one of the three boundaries in Figure 3 would be sufficient to allow a unique 
solution of the system. It is also possible that there could be two pressures and one flow, or three 
pressures. As long as there is at least one pressure a unique solution exists.

Figure 3: Three known flows at boundaries lack a reference pressure, similar to the model in Figure 
1. This model does not have a unique solution.

Now consider the models in Figure 4. The Figure 4a model does have one reference pressure, 
but in this case there is still a problem. The Flow Control Valve (FCV) is controlling the flow to 10 
gpm, and the downstream flow is demanding 10 gpm. The section of the system before the FCV 
can be solved (because there is a pressure upstream), but the section after the FCV does not 
have a unique solution. Why? In order to obtain a unique solution, the pressure drop across the 
FCV must be known. But any pressure drop could exist and satisfy the conditions of this model. 
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It is thus not possible to determine the pressure at the outlet flow demand because it depends on 
the FCV pressure drop which is not known. The model in 4b does have a pressure downstream 
of the FCV, and thus there is a unique pressure drop across the FCV and a unique solution 
exists for the model in Figure 4b.

If you input the remaining data for the Figure 4a model and run it in AFT Fathom, you will get the 
message shown in Figure 5. AFT Fathom identifies the part(s) of the model where a known pres-
sure is needed.

Figure 4a-b: The model at the top does not have a reference pressure after the Flow Control Valve so 
the pressure drop across the FCV cannot be determined. The top model does not have a unique 

solution. The bottom model has a pressure upstream and downstream, and a unique solution exists

Figure 5: AFT Fathom message when you try to run the model shown in Figure 4a
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Sizing Pumps with Flow Control Valves

An analogous situation to Figure 4a is when the user is trying to size a pump using the Pump with 
a fixed flow. The Pump with a fixed flow is really just a reverse FCV. It controls the flow by 
adding pressure, rather than reducing it. Figure 6 shows this case and is another example of a 
model without a unique solution, requiring more than one pressure junction. If the user instead 
entered a pump curve for this model, it could be solved.

Figure 6: A pump modeled as a fixed flow behaves identically to the FCV model in Figure 4a, for 
which no unique solution exists

Increasing in model complexity, Figure 7 shows some additional examples of models without a 
unique solution. In particular, Figure 7b has a pump with a fixed flow that can add as much pres-
sure as it wants, and the downstream FCV can then take out as much as it wants. There are an 
infinite number of possible solutions. 

While it would be highly unusual for a system to have two FCV’s in series, it is worth considering 
the model in Figure 7b further. It is common to have an FCV in series with a pump. How does 
one size the pump in such a case? There are several ways to do this, one of which is to change 
the pump from a fixed flow to an actual pump curve. Trying multiple pump curves will guide you 
to the best pump.

But there is a better way. Consider for a moment the pressure drop across the FCV in Figure 7b. 
In the installed system, is any pressure drop acceptable? Usually not. It is typical to have pres-
sure drop limits based on the system design and the FCV itself. A common requirement is a min-
imum pressure drop across the FCV. If no minimum pressure drop exists, let’s say we choose a 
pump that results in the pressure drop across the FCV being 0.01 psid. If the system is built and 
the pump slightly underperforms its published curve, the FCV will not be able to control to its 
flow control point. Even if the pump does operate exactly on the published curve, eventually foul-
ing in the pipes will result in increased pipe resistance (and pressure drop) and again the FCV 
will not be able to control to its flow control point. 
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Figure 7: Neither model above has a unique solution. The top model has two flow control valves in 
series. The bottom model has a pump modeled as a fixed flow in series with an FCV. In both cases 
either a third pressure junction is needed between the two middle junctions, or one of the junctions 

must be changed from a flow controlling device.

To avoid these kinds of problems in installed systems, a minimum Cv or pressure drop across 
the FCV is typically required. This minimum pressure drop provides the key to sizing the pump in 
Figure 7b. Rather than model the FCV as a flow control valve, instead model it as a pressure 
drop control valve (PDCV) set to the minimum pressure drop requirement. Then a unique solu-
tion exists, the model will run and the pump can be sized. Once the pump is sized and an actual 
pump curve exists, the pump curve can be entered for the pump and the valve can be switched 
back to an FCV. Remember that when we use the PDCV, we are still getting the flow we want 
for the true FCV, because the pump is now providing the control.

Think for a moment what we just did. We went through a thought process that many engineers 
have gone through during their hand calculations. Specifically, we size the pump such that the 
FCV pressure drop is minimized. If the FCV has a larger pressure drop than the minimum, the 
pump must pump harder to overcome this excess pressure drop. In short, it must use more 
energy and is thus less efficient. Figure 8 depicts this process.
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Figure 8a-c: The model at the top is the same as Figure 7b and does not have a unique solution. To 
size the pump, change the model to the second one shown above, which uses a pressure drop con-
trol valve (PDCV) rather than an FCV. Once the second model is run, the pump is sized, a pump 

curve exists, and the model at the bottom can be run using an FCV.

Let’s make a slight addition in complexity to the model in Figure 8. In this case we have two flow 
control valves in parallel (Figure 9). To size this pump, we apply the process described in Figure 
8. We choose one of the FCV’s, make it a PDCV, size the pump, choose a pump with an actual 
pump curve and enter it into the model, then return the PDCV to an FCV. 

Figure 9: A pump with a fixed flow in series with two parallel FCV’s. The model in its current form 
does not have a unique solution. To size the pump, first change the FCV at J7 to a PDCV. 

This brings up the question, which FCV should one choose to turn into a PDCV? When FCV’s 
are put in parallel, frequently the pipe design has one of the FCV’s further away from the pump 
than the others. Because of the additional piping leading to this FCV, it will be the weakest link in 
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the chain of parallel FCV’s by virtue of having the lowest pressure drop across it. The most 
remote FCV should be chosen as the PDCV. If the most remote FCV is chosen, when the min-
imum pressure drop required is applied to the PDCV all other FCV’s in the parallel system will 
have greater than the minimum pressure drop — thus satisfying the pressure drop requirement 
for those FCV’s as well.

What if you do not know which FCV is the most remote? In this case make your best guess, 
change it to a PDCV at the minimum required pressure drop, run the model, then verify whether 
all other FCV’s have a pressure drop that meets or exceeds the requirement. If not, then the 
FCV with the smallest pressure drop as determined by the first run is in reality the weakest FCV. 
Choose this FCV, change it to a PDCV, and then change the original PDCV back to an FCV 
since it is not the weak link. If the pipe system leading to each FCV is truly identical and all 
FCV’s have identical pressure drops, any of the FCV’s will serve as the PDCV.

The preceding process can be extended to cases where there are three or more FCV’s in par-
allel, and also cases with more than one pump in parallel supplying the FCV’s.

In Figure 9 the most remote valve is J7, the one on the right. If the minimum pressure drop is 5 
psid, change J7 to a PDCV with a 5 psi drop. This results in the output shown in Figure 10a. 
Notice how the pressure drop across the other FCV at J6 (6.837 psid) is greater than 5 psid 
because it is closer to the pump. Also notice how the flow through J7 is still 100 gpm even though 
it is not controlling flow. Once again, the reason for this is that the pump is controlling the flow to 
200 gpm, and with the J6 FCV controlling to 100 gpm, the excess must go through J7. The pump 
is thus sized and its pump pressure rise is shown in Figure 10b (127 ft.). 

Figure 10a-b: Results from changing J7 in Figure 9 to pressure drop control valve

Using Fixed Head Rise Pumps

An alternate method of sizing pumps with FCV’s is to use the fixed head rise pump model. Here 
the pump head can be adjusted while the flow control valves can be modeled as FCV’s. This 
approach is particularly powerful when used with theGSC Module. This would entail specifying 
the pump head rise as the variable at the min Cv or pressure drop across the control valve as the 
goal. If there are multiple, parallel control valves, then a group max/min can be used.
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Pressure Control Valves

The problem of non-unique solutions can also occur when a Pressure Reducing Valve (PRV) or 
Pressure Sustaining Valve (PSV) is used. A PRV is used to control pressure downstream of the 
valve, while a PSV controls pressure at the valve inlet. One thing that PRV’s and PSV’s have in 
common with FCV’s is that the pressure drop cannot be known ahead of time. The pressure 
drop depends on the balance of the pipe system.

Consider the simple system shown in Figure 11. With the pressure controlled downstream of the 
PRV, the pressure upstream is not known. Without knowledge of the PRV’s pressure drop, the 
pressure upstream of the PRV cannot be determined and thus no unique solution exists. 

Figure 11: If a PRV is downstream of a known flow the PRV pressure drop cannot be calculated. 
This model does not have a unique solution.

Figure 12 shows the possible cases with PRVs and PSVs, while Table 2 comments on the six 
cases. In summary, at least one known pressure is always needed on the side of a pressure con-
trol valve opposite of the controlled side. 
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Figure 12a-f: Six possibilities for PRV and PSV configurations. Cases A and E do not have unique 
solutions. See Table 2 for comments.

Table 2: Summary of six possibilities for PRV and PSV configurations.

If a pump is being sized in series with a PRV or PSV, modeling the pump as a fixed flow will not 
permit a unique solution if the pump is upstream of a PRV or downstream of a PSV. The reas-
ons for this are the same as those in the previous section on FCV’s.
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In combination with the previous examples, it should be apparent how the non-unique solution 
problem can occur in more complicated systems. In all such cases, the reasoning will boil down 
to the same problems already discussed.

Closing Parts of a System

A model may be built which has sufficient information to obtain a unique solution. Then a user 
closes a pipe or junction and all of a sudden the problem of no unique solution occurs. This is 
shown in Figure 13. The top model has a unique solution and will run fine. In the bottom model 
the valve is turned off and the section of the system downstream of the valve has only known 
flows. No reference pressure exists in this section because it is isolated from the known pres-
sures in the section on the left.

Figure 13: Top model has reference pressures at J1 and J2. Bottom model has closed valve at J4 
which isolates the J5 and J6 assigned flows. There is no reference pressure for J5 and J6 and no 

unique solution exists for the bottom model.

Summary

AFT Fathom models always require one reference pressure, and may require more if the engin-
eer uses control valves, pumps with fixed flows, or closed pipes or junctions. The actual number 
of reference pressures needed depends on the model, but AFT Fathom always checks to be 
sure sufficient reference pressures exist and stops to warn the user when they do not. 

This capability is a powerful diagnostic feature that will help guide the user in building meaningful 
models.
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Pipe Material Library References
Prior to AFT Fathom 9, pipe material properties were compiled from a variety of unofficial 
sources. Many of the original sources are now obsolete. Beginning in AFT Fathom 9, pipe mater-
ial properties are taken directly from national/international standards such as: ASTM, ANSI, 
AWWA, and ASME. Several new material standards are being added. For example: DIN and 
JIS. With the addition of a significant number of new pipe material standards, the increased 
volume and scope necessitate splitting the pipe material library into several smaller independent 
libraries. All of the pipe material found in AFT Fathom 7 is still available, but is now called "AFT 
Customary". 

Maintaining several independent pipe libraries facilitates including or excluding specific stand-
ards. For example: a pipe engineer in Germany may prefer to use only ISO and DIN standards. 
The Library Browser can be used to "Connect" or Disconnect" each of the pipe material libraries. 
A list of available pipe libraries can be found below.

Note that while AFT attempts to provide this standard information to make defining pipe inform-
ation easier for the user, the prudent engineer will always verify this information against man-
ufacturer specifications. ASTM and ANSI standards exist for the thickness and diameter 
specifications for some of these materials. Furthermore, AFT attempts to source reference 
information from reputable and authoritative sources. However, data for pipe roughness and ther-
mophysical properties including density, thermal conductivity, modulus of elasticity, and Pois-
son's ratio have no single standard to follow. Thus, the user should always check that the pipe 
material inputs match the actual pipe material data for their system.    

 l Copper Pipe - ASTM - 
 l Source = ASTM B42-10
 l Additional References = Thermal conductivity data from: Piping Handbook, Nay-

yar, 7th ed, Table A3.2; Perry's chem eng Handbook, 7th ed. Table 10-33
 l Copper Tubing - ASTM - 

 l Source = ASTM B88-09
 l Additional References = Thermal conductivity data from: Piping Handbook, Nay-

yar, 7th ed, Table A3.2; Perry's chem eng Handbook, 7th ed. Table 10-31; 
www.cranecopper.com.au/sizes/astmb88.asp

 l Ductile Iron - ANSI - 
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 l Source = ANSI-AWWA C150-A21.50-08
 l Additional References = Thermal conductivity data from: Piping Handbook, Nay-

yar, 7th ed, Table A3.2
 l Fiberglass - Green Thread -

 l Source = Fiber Glass Systems product data, http://www.nov.-
com/Segments/Completion_and_Production_Solutions/Fiber_Glass_Sys-
tems/Chemical_Industrial/Green_Thread.aspx 

 l Roughness References = Fiber Glass Systems product data
 l Density References = Average value calculated based on ID, OD and Weight in 

Fiber Glass Systems product data
 l Thermal Conductivity References = Fiber Glass Systems product data
 l Modulus of Elasticity References = Fiber Glass Systems product data
 l Poisson's Ratio References = Fiber Glass Systems product data
 l Additional References = ASTM D2996 - 17

 l HDPE - AFT Customary - 
 l Source = Applied Flow Technology
 l Additional References = Thermal conductivity data from: Piping Handbook, Nay-

yar, 7th ed, Table A3.2
 l PVC - ASTM - 

 l Source = ASTM D1785-06
 l Additional References = Thermal data from: Materials Science and Engineering, 

Callister, Table C.4
 l PVDF - AFT Customary - 

 l Source = George Fischer Engineering handbook page 425
 l Additional References = Thermal conductivity data from: Piping Handbook, Nay-

yar, 7th ed, Table A3.2
 l Rectangular Duct - AFT Customary - 

 l Source = Applied Flow Technology
 l Stainless Steel - ANSI - 

 l Source = ASME-B36_19M_2004
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conduct References = Piping Handbook, Nayyar, 7th ed, Table A3.2 for 

Type 304
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ration Referenecs = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for Type 304 @ 20oC
 l Stainless Tubing - AFT Customary - 
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 l Source = Applied Flow Technology
 l Additional References = Thermal conductivity data from: Piping Handbook, Nay-

yar, 7th ed, Table A3.2
 l Steel - AFT Customary - 

 l Source = Applied Flow Technology
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1

 l Steel - ANSI - 
 l Source = ASME B36.10-2004
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - DIN 2391-1 - 
 l Source = DIN 2391-1-1994
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - DIN 2458 -
 l Source = DIN 2458-1981
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
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 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 
A3.3

 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 
for Wrought Carbon Steel, 0.23 C, 0.635 Mn

 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10216-1 (s1) - 
 l Source = BS EN 10216-1-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10216-2 (s1) - 
 l Source = BS EN 10216-2-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10217-1 (s1) - 
 l Source = BS EN 10217-1-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
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 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 
1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC

 l Additional References = ANSI 36.10, CRANE Technical Paper 410
 l Steel - EN 10217-2 (s1) - 

 l Source = BS EN 10217-2-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10217-4 (s1) - 
 l Source = BS EN 10217-4-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10217-5 (s1) - 
 l Source = BS EN 10217-5-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

 l Steel - EN 10217-6 (s1) - 
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 l Source = BS EN 10217-6-2002
 l Roughness References = CRANE Technical Paper 410, 1988 edition, A-23 for 

Comerical Steel
 l Density References = Piping Handbook, Nayyar, 7th ed, Mohinder L Nayyar, Table 

A3.3
 l Thermal Conductivity References = Piping Handbook, Nayyar, 7th ed, Table A3.2 

for Wrought Carbon Steel, 0.23 C, 0.635 Mn
 l Modulus of Elasticity References = Piping Handbook, Nayyar, 7th ed, Table A3.1
 l Poisson's Ratio References = Perry's Chemical Engineer's Handbook, 7th ed, 

1997 p.28-45 Table 28-18 for SA-35P12 @ 20oC
 l Additional References = ANSI 36.10, CRANE Technical Paper 410

Related Topics

Libraries 713
Library Manager 714
Library Browser 714
Network Library Overview 729
Library Verification 733
Library Locations in General Preferences 735
Fluid Library 719
Pipe Material Library 720
Junction Library 718
Insulation Library 723
Fittings & Losses Library 723
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Various types of messages may be given in the output when you run a model. These messages 
are intended to alert you about problems with the model or solution. There are different message 
classifications depending on the severity, but all message types should be reviewed when they 
are displayed in the output.

The links below will take you to a message list for the corresponding message type with a brief 
explanation given for each.

 1. CRITICAL WARNING - Very High Severity - The model is not accurately predicting beha-
vior, and the solution may violate the engineering assumptions of the software. These 
issues must be resolved for the model to be trustworthy, and the output should only be 
used for error resolution or troubleshooting purposes and never for engineering 
decisions.

 2. WARNING - High Severity - A serious issue with the model or results exists. For example, 
the solution has exceeded a valid data range, or potentially unrealistic behavior is occur-
ring. A real system may encounter operational problems under the conditions.

 3. CAUTION - Moderate/Low Severity - Something may be wrong with the model or of 
interest for the user to double check. Depending on the application, the results may or 
may not be affected. If results are affected, it would be to a lower degree compared to a 
Warning.

 4. INFORMATION - An Information message is intended to make the user aware that an 
advanced feature is being used in the model, or to provide comments or suggestions relat-
ing to an advanced feature. Following suggestions may achieve higher accuracy results if 
the right conditions apply, but can also cause incorrect results if not applied properly. If 
the user understands the feature then no action is required.

Any message that directly lists a pipe/junction can be double-clicked  to take you directly to the 
object on the Workspace. Whenever a Warning or Critical Warning message type is displayed, 
the General Results section will display red text.

Related Topics

Troubleshooting 799
Critical Warnings 779
Warnings 782
Cautions 789
Information 796

Critical Warnings
The model is not accurately predicting behavior, and the solution may violate the engineering 
assumptions of the software. These issues must be resolved for the model to be trustworthy, and 
the output should only be used for error resolution or troubleshooting purposes and never for 
engineering decisions.
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CRITICAL WARNINGS

FCV/PRV/PSV could not control pressure - Pressure was 
added to achieve control flow/pressure

A Critical Warning message in AFT Fathom

Full message is:

"FCV/PRV/PSV could not control pressure/flow at Junction X. Pressure was added to achieve 
control flow. See Valve Summary for more information."

A flow or pressure control valve could not control pressure or flow and the setting in the Control 
Valve Properties window is to Always Control (Never Fail). In order to achieve the control flow or 
pressure, the valve must add pressure at the junction.

The Valve Summary in the Output window gives more information.

This warning is useful for resolving operational problems in your system.

Global energy balance disabled by user in Advanced Para-
meters Panel

A Critical Warning message in AFT Fathom

The displayed results do not represent a valid converged solution because the Energy Balance 
option was disabled by the user  on the Advanced Parameters panel in the Analysis Setup win-
dow.

Related Topics

Advanced Parameters Panel 177
Global mass balance disabled by user in Advanced Parameters Panel 780

Global mass balance disabled by user in Advanced Para-
meters Panel

A Critical Warning message in AFT Fathom

The displayed results do not represent a valid converged solution because the Mass Balance 
option was disabled by the user on the Advanced Parameters panel in the Analysis Setup win-
dow.

Related Topics

Advanced Parameters Panel 177
Global energy balance disabled by user in Advanced Parameters Panel 780
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Junction X had reverse flow - Pump head could not be pre-
dicted

A Critical Warning message in AFT Fathom

This message displays for centrifugal pumps when the flowrate goes backwards through the 
pump. The pump head rise under such conditions is unknown. The dead head value is used.

Pipe sequences of zero friction exist, flow rate cannot be cal-
culated

A Critical Warning message in AFT Fathom

This message is displayed if all of the pipes in a flow path are defined as frictionless by using the 
zero-length connector option, or the "frictionless" friction model.

At least one pipe in every flow path needs to include frictional losses in order to perform hydraulic 
calculations.

Setting relaxation lower than relative pressure/flow tolerance 
gives unreliable results

A Critical Warning message in AFT Fathom

Because of the nature of relaxation and relative solution tolerance, setting the relaxation to a 
value close to or lower than relative tolerance can lead to false convergence and invalid results. 
AFT Fathom alerts the user to this when inputting data in the Tolerance panel or Iterations panel 
in the Analysis Setup window, and also alerts the user once the solution has been obtained.

These results do not represent a converged solution
A Critical Warning message in AFT Fathom

This message alerts you to the fact that you chose to have results displayed for an unconverged 
solution. You should only use the displayed results for purposes of determining the reasons for 
nonconvergence. Under no circumstances should you actually use any of the results for engin-
eering purposes.

Related Topics

Troubleshooting 799

Weir Liquid Level Convergence Problem
A Critical Warning message in AFT Fathom

This message indicates that the flow required at the weir to maintain flow continuity in the system 
is higher than the maximum flow the weir can deliver. It is recommended to review the system 
and weir inputs to resolve the issue.
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Warnings
A Warning is of High Severity, and should always be reviewed before considering the results to 
be meaningful for the system.

A serious issue with the model or results exists. For example, the solution has exceeded a valid 
data range, or potentially unrealistic behavior is occurring. A real system may encounter oper-
ational problems under the conditions.

WARNINGS

Cavitation May Exist at Junction X
A Warning message in AFT Fathom

The local static pressure at this junction was obtained using the Restricted Area, and it is below 
the vapor pressure of the fluid.

Chempak temperature and or pressure is out of range for the 
following

A Warning message in AFT Fathom

The final solution had temperature and/or pressure conditions in the specified pipes obtained 
with Chempak physical property data which were beyond Chempak's range of applicability. The 
range value is also displayed. This indicates that the results are probably not valid. It also may 
indicate an input error in the model because of the extreme temperature or pressure state.

Control valve open percentage outside valid range of 0-100% 
at Junction X

A Warning message in AFT Fathom

This is a cautionary notice that a control valve which includes open percentage data is operating 
outside the range of 0-100%. This could indicate an error in input, or an improperly sized valve.

Energy may not be balanced at Junction X (total= Y)
A Warning message in AFT Fathom

This warning alerts you to the fact that the converged energy balance results may be incorrect. 
Once a converged solution is obtained, AFT Fathom checks all junctions to ensure an energy bal-
ance exists. It compares the imbalance to the mass flow weighted enthalpy tolerance you spe-
cified, and when it appears to exceed the tolerance, it gives you this warning.

If the magnitude of the out of balance flow is close to the tolerance you specified, then it is gen-
erally safe to ignore this warning, although you may want to tighten your tolerances further and 
rerun the model.
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If the magnitude of the energy out of balance is large, then you have a converged solution that is 
incorrect. This can occur in rare circumstances. When this happens, then it is usually an indic-
ator that your model is not realistic.

You should always review each of these warnings in detail, and perform hand calculations on the 
energy balance at the affected junctions to verify whether an acceptable solution exists.

Note: This warning will usually occur when you assign isothermal boundary conditions to 
pipes in your model. If pipes are forced to flow at the isothermal temperature you spe-
cify, it is usually not possible to balance energy at the junctions. The warning can be 
ignored in such circumstances, because the energy imbalance is a natural result of the 
isothermal assumption.

Related Topics

Tolerance Panel 160
Energy Equation at a Branch 744
Verifying Network Solutions 746

FCV could not control flow at Junction X
A Warning message in AFT Fathom

This warning alerts you that the Flow Control Valve at junction X was not able to control the flow, 
and backflow may have occurred.

Flow is into system at Reservoir Junction X
A Warning message in AFT Fathom

Full message is:

"Flow is into system at Reservoir Junction X. Pipe intake elevation above the surface will supply 
gas, not liquid."

When a pipe exits above a reservoir junction liquid level it is only meaningful if it is discharging 
into the reservoir. If the pipe becomes an intake, it will not supply liquid but whatever vapor is 
above the reservoir liquid. This warning alerts you to the fact that the reservoir had a pipe above 
liquid level that was taking in fluid. AFT Fathom assumes the intake fluid is the same as the reser-
voir fluid, but that is likely to not be the case. Results are likely invalid.

Flow may not be balanced at Junction X (total= Y)
A Warning message in AFT Fathom

This warning alerts you to the fact that the converged results may be incorrect. Once a con-
verged solution is obtained, AFT Fathom checks all junctions to ensure a flow balance exists. It 
compares the imbalance to the flow tolerance you specified, and when it appears to exceed the 
tolerance, it gives you this warning.
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If the magnitude of the out of balance flow is close to the tolerance you specified, then it is gen-
erally safe to ignore this warning, although you may want to tighten your tolerances further and 
rerun the model.

If the magnitude of the flow out of balance is large, then you have a converged solution that is 
incorrect. This can occur in rare circumstances. When this happens, it is usually an indicator that 
your model is not realistic.

You should always review each of these warnings in detail, and perform hand calculations on the 
flow balance at the affected junctions to verify whether an acceptable solution exists.

Related Topics

Tolerance Panel 160
Continuity Equation at a Branch 743
Verifying Network Solutions 746

Flow rate at drop off point at Junction X
A Warning message in AFT Fathom

This warning is for jet pumps, and informs the user that the flow rate is at the edge of the curve. 
Results may not be valid.

GSC Goal may not be valid. User goal = X. Final goal result = 
Y.

A Warning message in AFT Fathom

(GSC Module Only)

This is a warning message that appears when the GSC module search was not able to meet a 
goal. The solution may still be acceptable if the final goal result is reasonably close to the goal.

HGL, EGL and head loss results may not be meaningful for 
variable density systems

A Warning message in AFT Fathom

The concepts of HGL (Hydraulic Gradeline) and EGL (Energy Gradeline) are only valid for con-
stant density systems. This warning is given when HGL, EGL or head loss results are displayed 
in the output and the system has variable density. It alerts the user that HGL/EGL and head loss 
output may not be meaningful. Unless otherwise noted, all other output is valid.

This warning can be hidden by setting all head results to not be shown using Output Control.

Junction X %BEP (Y%) is above/below the POR range
A Warning message in AFT Fathom

The calculated %BEP of Pump X is outside of the POR range as defined in Pump 
Configuration.
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Junction X exceeded runout flow rate
A Warning message in AFT Fathom

Centrifugal pump curves typically have a point at which they no longer operate on the curve. This 
may be called "end of curve" or "runout". Data defining runout for a particular pump is given by 
the manufacturer. Such data has been defined for this pump in the Pump Configuration window 
Configuration Data tab, and the system is operating past the runout flow rate. Thus the results 
are invalid, because the pump likely cannot actually operate at that point.

Junction X flow (Y gal/min) is above/below the AOR range (Z 
gal/min)

A Warning message in AFT Fathom

The calculated flow of Pump X is outside of the AOR range as defined by the user in Pump Con-
figuration.

Junction X has insufficient pump NPSH/NPSP…
A Warning message in AFT Fathom

The available pump NPSH (or NPSP) is less than the required NPSH defined for the pump. 
The pump will cavitate if changes are not made to increase the NPSH available at the pump.

Negative added pressure by pump at Junction X
A Warning message in AFT Fathom

Full Message text is:    

"Negative added pressure by pump at Junction X."

A pump junction with a fixed flow resulted in a pressure loss at the pump junction. This warning is 
meant to alert the user that the pump is not adding pressure as they may be expecting.

Pipe X temperature is equal to or greater/less than the max-
imum/minimum temperature limit of...

A Warning message in AFT Fathom

There are two variations of this Warning that are similar:

 l The following pipes had temperature equal to or less than the minimum temperature 
limit of X set in the Temperature Solver Limits panel under Steady Solution Control in the 
Analysis Setup window. Results are not reliable.

 l The following pipes had temperature equal to or greater than the maximum tem-
perature limit of X set in the Temperature Solver Limits panel under Steady Solution Con-
trol in the Analysis Setup window. Results are not reliable.

The user has specified limits in the Temperature Solver Limits panel of the Steady Solution Con-
trol in Analysis Setup (only available when Heat Transfer With Energy Balance is enabled in 
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Fluid Properties). These limits are intended to aid in convergence by restricting the search space 
while solving, and should generally be left as the AFT default values. This warning indicates that 
the final solution had one or more pipes outside the limit range, and the temperature results have 
been artificially limited by the Solver. The results are therefore not valid. To resolve this either 
remove or change the temperature limit.

Note: These limits should not be used as Design Alerts, or to approximate some physical phe-
nomenon.

PRV could not control pressure at Junction X
A Warning message in AFT Fathom

This warning alerts you that the Pressure Reducing Valve at junction X was not able to control 
pressure, and backflow may have occurred.

PSV could not control pressure at Junction X
A Warning message in AFT Fathom

This warning alerts you that the Pressure Sustaining Valve at junction X was not able to control 
pressure, and backflow may have occurred.

Static pressure lower than vapor pressure at inlet/outlet of 
pipe/junction X

A Warning message in AFT Fathom

This warning alerts the users that the static pressure is lower than the vapor pressure in the spe-
cified pipe or junction and that cavitation may occur.

Tank Junction X began overflowing at Y seconds
A Warning message in AFT Fathom

The total volume of fluid entering the tank junction has exceeded the volume of the tank.

Tank Junction X completely drained at Y seconds
A Warning message in AFT Fathom

The Finite Tank junction has run out of fluid to supply to the system. The simulation will continue 
under the assumption that fluid is still being supplied at the inlet pipe. The results past the spe-
cified time should only be used to troubleshoot the system as in reality the pipe would pull in the 
vapor is currently residing in the tank.

Temperature at inlet/exit of pipe X is above/below max/min 
fluid temperature range

A Warning message in AFT Fathom
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Full Message Text

There are several variations of this Warning:

 l Temperature at inlet of pipe X is below min fluid temperature range.
 l Temperature at exit of pipe X is below min fluid temperature range.
 l Temperature at inlet of pipe X is above max fluid temperature range.
 l Temperature at exit of pipe X is above max fluid temperature range.

Explanation

The temperature used to calculate fluid properties is being predicted outside the valid range of 
data for the AFT Standard fluid or User Library Fluid. In order to produce results the software is 
extrapolating data or using a curve fit beyond the defined range of acceptable values. The fluid 
properties may be incorrect and may affect the result accuracy. The max and min temperature 
for the fluid data can be seen by opening the Library menu, selecting Edit Fluids, selecting the 
fluid used in the model, and looking at the top of the Properties section.

Required Action

Adjust the model such that the temperatures remain within the bounds of fluid data. This could 
take on many forms depending on the goal of the analysis and what is acceptable:

 l Check for typos or incorrect inputs in the Model Data (including units), especially at the 
boundary condition junctions or any components with significant temperature changes

 l Increase or decrease the upstream boundary condition temperature (such as the tem-
perature in an Assigned Pressure junction)

 l Adjust the heat transfer in pipes such that the temperature does not drop below or rise 
above the bounds of data

 l Add more data to the custom fluid that extends the range to cover the temperatures seen 
in the model

 l Run a scenario using a different fluid library if the fluid can be found in the other Library 
sources, and compare the results

Temperature is above the saturation line for the following...
A Warning message in AFT Fathom

The solution indicates that the temperature and pressure conditions at the specified pipe are 
such that one or more gas components has reached saturation conditions. This warning only 
occurs with Chempak fluids.
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Unique solution not possible - Relief valve cycles
A Warning message in AFT Fathom

The relief valve cycles between its open and closed state. When closed, the pressure exceeds 
its cracking pressure and causes it to open. When open, the pressure drop resulting from flow 
causes the pressure to fall below the cracking pressure and so it closes. When the relief valve 
changes states, the steady-state Solver must re-run the simulation, but since the relief valve 
cycles between open and closed each time, a unique solution is not possible. Double check the 
inputs for the relief valve, the model boundary conditions, and other junction input data.

Velocity in pipe X is less than the deposition velocity
A Warning message in AFT Fathom

(SSL Module Only)

Full Message Text

Steady-State:

Velocity in pipe W is less than the deposition velocity. Results may be inaccurate. (Velocity: Y, 
Vsm: Z)

Transient with the XTS Module:

Velocity in pipe W is less than the deposition velocity at time X. Results may be inaccurate past 
this time step. (Velocity: Y, Vsm: Z)

Explanation

Engineers often want to avoid operating settling slurry systems in such a way that the bulk slurry 
velocity (Vm) is less than the deposition/settling velocity (Vsm). This warning indicates that the 
velocity is in fact less than the deposition velocity which can cause operational problems includ-
ing stationary beds or plugging of pipes. The methods available in the SSL Module cannot model 
stationary beds, and thus the results may not be accurate under these conditions. The farther the 
velocity drops below Vsm the more uncertainty in the results.

Required Action

Adjust the model such that the velocity is higher than the deposition velocity. If this is not pos-
sible, then it may indicate operational problems in the real system, or you must accept that the 
results will be incorrect.

Potential adjustments:

 l Decrease the pipe size
 l Increase the flowrate
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 l Reduce the slope of the pipe

Cautions
Something may be wrong with the model or of interest for the user to double check. Depending 
on the application, the results may or may not be affected. If results are affected, it would be to a 
lower degree compared to a Warning. While some Caution messages may be left unresolved 
without affecting model results, they should never be ignored by the user.

CAUTIONS

Check Valve closed at Junction X
A Caution message in AFT Fathom

This is a cautionary notice that a check valve closed, and the Solver will automatically re-run the 
model.

Default control valve actions at Junction X used when setpoint 
not achievable because analysis is transient

A Caution message in AFT Fathom

(XTS Module Only)

The Always Control (Never Fail) option at a Control Valve was enabled by the user but not used 
in the solution. The Control Valve could not control to its setpoint and so default actions were 
used.

Flow is negative through Junction X. Loss factors may be in 
error.

A Caution message in AFT Fathom

This caution alerts you to flow in junctions which is in the opposite direction from the connecting 
pipes' reference directions. Any loss information you specified for junctions may be in error 
because it was defined assuming flow in the other direction.

Flow solution for Junction X is above/below the max-
imum/minimum value specified for the resistance curve. Flow 
rate: Y

A Caution message in AFT Fathom

There are two variations of this Caution that are similar:
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 l Flow solution for Junction X (Junction Type) is above the maximum value specified for 
the resistance curve. Flow Rate: Y.

 l Flow solution for Junction X (Junction Type) is below the minimum value specified for 
the resistance curve. Flow Rate: Y.

This caution alerts you that the calculated flow through junction X is outside the range of the raw 
data that was entered in the Resistance Curve. The Solver will use the Curve Fit of the entered 
data for all calculations, including pressure losses at flowrates that are extrapolated beyond the 
original data.

The user should check if the curve fit is still a good approximation of the data below the minimum 
data point, or above the maximum data point.

It is good practice to have the Resistance Curve pass through the point (0,0) since zero flow will 
result in zero pressure loss. For more information, see the help topic on Troubleshooting Resist-
ance Curves.

Head loss, head rise, hydraulic gradeline and energy gradeline 
output does not have meaning for zero g systems

A Caution message in AFT Fathom

If the user sets the gravitational acceleration to zero, presumably for a space application, then 
the concept of head and gradeline lose meaning. This can be set in Analysis Setup on the Envir-
onmental Properties panel. For example see Equation 1 in Network Solution Methodology and 
see that a zero g will lead to a meaningless HGL.

Users should ignore all head loss, head rise, and gradelines displayed in the output and focus on 
pressure results.

Head rise across fixed flow pumps is referenced to system g 
level...

A Caution message in AFT Fathom

Full message is:

"Head rise across fixed flow pumps is referenced to system g level. To obtain standard head 
rise, divide the displayed head rise by the g level."

If the user sets the gravity to something other than standard earth gravity in Analysis Setup on 
the Environmental Properties panel, then the head rise at a pump is referenced to that g level 
and not 1 g.

Junction X has a density change across it
A Caution message in AFT Fathom
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Full Message Text

Junction X has a density change across it. If this is due to a moving interface and not heat input 
or output then a Volume Balance junction is recommended.

Explanation

This warning is shown when the user has selected Variable Fluid properties on the Heat Trans-
fer/Variable Fluids panel, and the density of the fluid is changing between pipes. The Solver per-
forms a mass balance at junctions, and fluids of different densities on either side of the junction 
may violate the mass conservation at a junction.

Required Action

If the change in density is due to a change in temperature across the junction, the caution mes-
sage can likely be ignored. A density change at a junction due to temperature change means the 
real system likely still has a mass balance at the junction.

If the change in density is due to a change in fluid type or moving interface, the caution message 
likely should not be ignored. An example of a change in fluid or moving interface is a pipeline car-
rying fluids of different properties such as oils of different density, or a system is being flushed 
with water. In this example, the volumetric flowrate is likely conserved across a junction in the 
real system even if mass is not conserved. The Volume Balance junction can be used at the fluid 
interface to capture this situation. However, the Volume Balance is limited in that it cannot cap-
ture the interface location changing with time, and is only applicable to steady-state.

Losses at one or more pipes or junctions may be significantly 
impacted (>25%) by laminar or non-Newtonian conditions, but 
no correction was made

A Caution message in AFT Fathom

Full Message Text

Losses at one or more pipes or junctions may be significantly impacted (>25%) by laminar or 
non-Newtonian conditions, but no correction was made. Checking the 'Laminar/Non-New-
tonian Correction Strength' output parameter is recommended. If the loss model source was 
from testing under turbulent conditions, applying a correction is recommended.
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Explanation

Flow through one or more pipes or junctions was found to be in the laminar flow regime (Reyn-
olds Number < 2300), but the "Apply Corrections" setting is disabled on the Laminar and Non-
Newtonian Corrections panel in Analysis Setup. The "Laminar and Non-Newtonian Correction 
Strength" output parameter under either the Pipes or Junctions sections of Output Control was 
calculated to be larger than 1.25 for one or more pipes or junctions. This means that if cor-
rections were applied, the resulting equivalent K factors and pressure losses would be sig-
nificantly modified (>25%) compared to if no corrections were made.

Required Action

If the loss information used in the model was based on manufacturer data that came from tur-
bulent tests, then the user should review the documentation for the Laminar and Non-Newtonian 
Corrections panel in Analysis Setup, consider enabling the setting for "Apply Corrections", and 
review the settings for which the corrections apply. Two scenarios can be compared, one with 
corrections and one without, to help determine the exact magnitude and location of the impacts. 
It is also recommended to review the documentation for the ATKF Method.

There is ambiguity in literature about if laminar corrections are required for fittings. A comparison 
of literature sources is provided, and it is up to the user to decide when/how to apply the cor-
rections.

If the loss information used in the model was based on true laminar data, then the caution mes-
sage can be disregarded.

Note: No scenarios have been set in the Multi-Scenario Output 
display

A Caution message in AFT Fathom

This caution is when multi-scenario output has been selected in Output Control but no scenarios 
have been selected. As a result, no output can be shown.

Pipe X elevation of Y is below Reservoir Z tank bottom elev-
ation...

A Caution message in AFT Fathom

(XTS Module Only)

Full message is:

"Pipe X elevation of Y is below Reservoir Z tank bottom elevation of A."

This is a warning that only occurs when running the XTS Module when using a finite tank option 
at a reservoir junction. If the user defines a pipe elevation which is below the bottom of the tank 
this warning will display.
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Pipe X length is shorter than the elevation change
A Caution message in AFT Fathom

This caution alerts you to an inconsistency with the input data due to a pipe being defined with a 
length that is shorter than the elevation change between its connecting junctions. This may be an 
input error or a result of a junction which itself has an elevation change. If it is due to the junction 
having an elevation change, you can use different inlet and outlet elevations at the junction to 
resolve this.

In this situation, pressure loss along the pipe due to friction is calculated using the pipe length the 
user has defined while static head loss is determined using the elevation change the user has 
defined.

Pipe X segment length Y is shorter than the elevation change
A Caution message in AFT Fathom

The pipe has intermediate elevations and the length along one of them is less than the elevation 
change of that segment.  In this situation, pressure loss along the pipe due to friction is calculated 
using the pipe length the user has defined while static head loss is determined using the elev-
ation change the user has defined. This can be corrected by adjusting the intermediate elev-
ations input.

Pipe X steady state Reynold’s Number is less than 100. Minor 
Losses may be significantly lower than expected.

A Caution message in AFT Fathom

When Reynolds Numbers fall to extremely low values (i.e. less than 100) the fluid enters a flow 
regime in which the system losses behave in an unintuitive fashion. Based on relationships 
depicted by the moody diagram, as the Reynolds Number decreases when below 2000, the fric-
tion factor and resulting pressure loss increases. In practice, this relationship breaks down and 
system losses will begin to decrease somewhere between a Reynolds Number of 10 and 100. 
Due to limited academic knowledge on this subject, and since the Solver is not currently able to 
model this regime, a caution message is given.

Pump X has no efficiency curve data. Nominal efficiency was 
used in viscosity correction calculations

A Caution message in AFT Fathom

This message displays for centrifugal pumps which use viscosity corrections to the performance 
curves. Typical corrections depend on efficiency data which typically depends on flowrate. No 
such data was provided by the user. However, the user did provide nominal efficiency and that 
was used in the viscosity correction calculations. Viscosity correction results are less certain in 
this case.
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Pump X has no efficiency curve or nominal efficiency data...
A Caution message in AFT Fathom

Full message is:

"Pump X has no efficiency curve or nominal efficiency data. An efficiency of 80% was assumed 
in viscosity correction calculations."

This message displays for centrifugal pumps which use viscosity corrections to the performance 
curves. Typical corrections depend on efficiency data which typically depends on flowrate. No 
such data was provided by the user. Further, the user did not provide nominal efficiency either. In 
order to perform the viscosity correction an efficiency of 80% was assumed. Viscosity correction 
results are less certain in this case.

Pump X properties were outside of the valid range for the vis-
cosity correction calculations. Results may be invalid.

A Caution message in AFT Fathom

This message displays for centrifugal pumps which use viscosity corrections to the performance 
curves. The methodology used by the Hydraulic Institute has limits which depend on flowrate, 
head rise, viscosity, and RPM. If the operating case in AFT Fathom is outside the valid range this 
warning displays.

Spray Discharge Junction X closed because inflow occurred 
and Special Condition - No Inflow was set

A Caution message in AFT Fathom

This is a cautionary notice that a Spray Discharge junction closed because the Solver determ-
ined that flow would enter the system, but the No Inflow Special Condition was set on the 
Optional tab of the Spray Discharge Properties window. Therefore, the Spray behaved like a 
Check Valve and prevented the flow from entering the system.

System Life specified in Cost Settings is different from the 
XTS time

A Caution message in AFT Fathom

(XTS Module Only)

The System Life as specified in Cost Settings is of a different length than the transient duration 
specified in the Simulation Duration panel.

The following Detailed Tee/Wye junctions have a different auto-
matic orientation than defined on the Workspace

A Caution message in AFT Fathom
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Full Message Text

The following Detailed Tee/Wye junctions have a different automatic orientation than defined on 
the Workspace:

Tee/Wye: J1, J2, J3, J4, J5, J6, J7, J8, J9, J10 and X more junctions. See the Model Dia-
gnostics window for more information.

Explanation

The listed Tee/Wye junctions are using the Detailed Loss Model with the Arrangement Type set 
to "Auto", however, the automatic pipe orientation saved for the Tee/Wye Properties window is 
not consistent with the current orientation on the Workspace. For the K factors to be calculated 
correctly, the connections for pipes A, B, and C must be defined correctly. For example, on a 90 
degree Tee, the branching flow pipe (C) in the Tee/Wye Properties window must match the inten-
ded branching pipe on the Workspace. If the branching pipe C was switched with the straight run 
pipe B, then the K factors would be switched. This can give incorrect results which may propag-
ate through the model and compound with other Tee/Wye junctions since the Detailed Loss 
Model is dependent on flows and pressures.

A full list of the affected junctions can be found on the Model Diagnostics window (Tools menu > 
Model Diagnostics > Junctions > Tee/Wye > "Tee orientation inconsistent to workspace?").

Required Action

First, it is recommended to align the pipes on the Workspace in a way that resembles the true 
geometric orientation of the junction as depicted by either the 2D or Isometric grid. If there is a 90 
degree angle, draw the pipes in a way that depicts this in the proper way. Furthermore, point the 
pipe Reference Positive Flow Direction towards the expected flow direction. The Auto Arrange-
ment Type will utilize the directions and angles between each pipe when attempting to auto-
matically configure the pipe connections. Therefore, following these modeling practices can 
increase the success rate of properly identifying and applying the K factors to the correct pipes. 
The tips below can be used to help quickly apply these principles:

 l The pipe direction can be switched by using the Reverse Pipe Direction icon on the Work-
space Toolbar or using the F3 keyboard shortcut.

 l Display the Workspace Grid and enable Snap to Grid from the Arrange menu.
 l Rotate the Tee/Wye junction icon such that it is consistent with the pipes by right-clicking 

the icon and selecting either "Auto-rotate Icon" or "Customize Icon".

Next, open each Tee/Wye Properties window listed in the Caution message or in the Model Dia-
gnostics window, configure and verify the proper pipe connections, click OK, and re-run the 
model. If needed, the Arrangement Type can be switched to "User" to guarantee that the junction 
retains the proper configuration.
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If the losses due to the Tees/Wyes are negligible compared to the total system pressure drop, 
the user can consider switching to the Simple Loss Model which assumes the junction is 
lossless. This would be equivalent to morphing the junction into a Branch.

The performance of Pump Junction X may be affected by the 
fluid viscosity

A Caution message in AFT Fathom

Full message is:

"The performance of Pump Junction X may be affected by the fluid viscosity. Apply the Viscosity 
Correction on the Pump Property window and rerun the model to assess the impact of the fluid 
viscosity."

This caution is shown if the fluid used in the model is not water, and the pump viscosity cor-
rection factors would be less than one based on ANSI/HI 9.6.7-2015. If the pump and fluid used 
in the model is in the scope of the ANSI standard it may improve accuracy to use viscosity cor-
rections at the pump.

See the Pump Viscosity Correction topic for more information.

Transient data did not extend to Stop Time at Junction X
A Caution message in AFT Fathom

(XTS Module Only)

The transient data at Junction X does not have time data that covers the entire time frame of the 
simulation as defined on the Simulation Duration panel. The final data point will be used for the 
remaining time steps of the simulation. You can enter additional time data points at Junction X to 
avoid this message.

Information
An Information message is intended to make the user aware that an advanced feature is being 
used in the model, or to provide comments or suggestions relating to an advanced feature. Fol-
lowing suggestions may achieve higher accuracy results if the right conditions apply, but can 
also cause incorrect results if not applied properly. If the user understands the feature then no 
action is required.

INFORMATION

Losses at one or more pipes or junctions were significantly 
modified (>25%) with a Laminar or Non-Newtonian correction

An Information message in AFT Fathom
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Full Message Text

Losses at one or more pipes or junctions were significantly modified (>25%) with a Laminar 
or Non-Newtonian correction. The strength of the correction can be seen by checking the Lam-
inar/Non-Newtonian Correction Strength output parameter. If the loss model source was from 
testing under laminar conditions, applying a correction is NOT recommended.

Explanation

This Information message appears when flow through one or more pipes or junctions was found 
to be in the laminar flow regime, the "Apply Corrections" setting is enabled on the Laminar and 
Non-Newtonian Corrections panel in Analysis Setup, and the resulting K factor (and pressure 
loss) was modified by more than 25% compared to uncorrected turbulent flow. Flow is con-
sidered laminar when the Reynolds Number is below 2300, and this can be checked in each pipe 
by adding the "Reynolds Number" output parameter from the Pipes section of the Output 
Control. When corrections are applied from the Analysis Setup, the equivalent K factor for the 
pipe or junction is adjusted which typically results in a larger pressure drop. Generally, this is 
intended to be more accurate compared to using a turbulent K factor in laminar flow.

This message indicates that the applied correction was fairly significant (>25%).  The "Laminar 
and Non-Newtonian Correction Strength" output parameter can be added from both the Pipes 
section and Junctions section of the Output Control. A correction strength larger than 1.0 acts as 
a multiplier that increases the equivalent K factor and pressure loss for the pipe or junction.

Required Action

If the corrections are intended, then no action is required since Information messages are simply 
courtesy notifications of advanced features being used in the model.

If the correction are NOT intended, then the user should review the Laminar and Non-Newtonian 
Corrections panel in Analysis Setup.
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This section discusses methods of troubleshooting models that are having difficulty converging. 
Topics include discussions of common issues, ideas to simplify overly complex models, and 
methods for adapting the solution methodology through either tolerance or flow relaxation.
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Getting that Stubborn AFT Fathom Model to Converge

Diagnostics Window
The Model Diagnostics window is a feature introduced in AFT Fathom 11. It is intended to help 
users check on a number of settings that may have been changed during the model-building pro-
cess and that may affect the model results.

The Model Diagnostics window can be accessed from the Tools menu.

When the Model Diagnostics window is opened all input will be checked, and the results will be 
displayed in a tabular format. Items of note will be highlighted based on the impact each iden-
tified item may have on the results. It should be noted that not all items identified by this win-
dow will have a negative impact on results. Rather, the identified items are settings that have 
frequently been incorrectly applied by other users. This is not an exhaustive list of troubleshoot-
ing items, though the most common issues are all included.

Data in the Model Diagnostics is organized by the Data Source, which is the window where that 
setting/input is defined. Any item that may negatively impact the model will be highlighted based 
on its potential to affect the model, as shown in the Potential Impact column. For pipe and junc-
tion diagnostic items, the pipe(s)/junction(s) that were identified will be listed below the dia-
gnostic item. For an example, see Figure 1 below. The Diagnostic window indicates that pipe P1 
has unusual pipe dimensions, and should be reviewed.

Figure 1: Example of the Model Diagnostics window

Related Topics

Troubleshooting 799

Use the Model Data Window
Besides its usefulness for documentation purposes, the Model Data window is a powerful tool for 
finding input errors in your model.

Look at the model in Figure 1. If you suspected an input error in one of the pipes, the task of look-
ing for the error in each individual pipe input window would be tedious. 
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Now look at the Model Data window for the pipes in Figure 2. Here it is much easier to scan down 
columns of data looking for input errors. In this case, one of the pipe lengths was accidentally 
entered in miles rather than feet.

Figure 1: Workspace layout of a pipe system with an input error in one of the pipes (error not shown)
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Figure 2: Model Data window display for the model in Figure 1. From this perspective it is much 

easier to see that one of the pipes (#107) has length data entered in miles rather than feet. This is not 
automatically an input error, as AFT Fathom accepts pipe input with mixed engineering units. 

However, more frequently than not the user intends to use consistent units, so this probably is an 
error.

Related Topics

Troubleshooting 799

Related Blogs

Having model convergence problems? Start here!

Getting that Stubborn AFT Fathom Model to Converge

Transfer Results to Initial Guesses
AFT Fathom’s iterative Solver (the part of AFT Fathom that applies the governing incom-
pressible flow equations to obtain a solution to the pipe system) takes initial guesses (also called 
initial conditions) and applies the principles of mass, momentum and energy balance to improve 
the guesses. This is called iteration. It continues to refine the solutions until agreement with the 
governing equations is obtained.

After a converged answer is obtained, you can choose to take these results and use them as the 
initial guesses for a subsequent run. This causes much faster convergence in subsequent runs 
because you are starting the solver at or very close to the actual solution.
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This feature is called Transfer Results to Initial Guess, and it is located on the Output window 
Edit menu and Toolbar.

Related Topics

Optional Input for Junctions 258
Optional Input for Pipes 239
Make Initial Flow Rate Guesses for Pipes 807
Troubleshooting 799

Poor Pump Curve Fits
The Pump Properties window allows curve fits of pump data up to fourth order. Depending on the 
number of data points entered, pump curves fits that look like the orange curve in Figure 1 are 
possible.

AFT Fathom interprets flow rates past the inflection point around 80 as acceptable operating 
points, which can lead to unusual results or non-convergence. Users should always ensure that 
their pump curves cross the flow rate axis as shown in the blue curve in Figure 1.

AFT Fathom will attempt to warn the user when a model containing a pump curve fit as seen in 
Figure 1 is run. The user can choose to run the model with this curve fit anyways, but they should 
take care that the pump is not operating to the right of the inflection point. 
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Figure 1: A good pump performance curve fit in blue and a poor pump performance curve fit in 
orange. All pump curve fits should include sufficient data such that the curve crosses the zero pres-

sure rise axis as shown in the blue curve.

Related Topics

Pump 294
Pump Configuration 300
Pump Efficiency Data 333
Troubleshooting 799

Troubleshooting Resistance Curves
Common issues with resistance curves include curves where losses do not increase with flow, 
and curves with a non-zero loss at zero flow. Figure 1 below shows examples of curves with 
potential issues compared to a correctly defined curve.
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Figure 1: Example resistance curves showing correct and incorrect curve types

These common issues create two potential problems in a model:

 1. If the system sees a constant pressure drop even at low flowrates, the iterative Solver can 
encounter difficulty converging on a solution since the system flow and pressure drop are 
no longer dependent on each other.

 2. Real equipment in a system will typically cause a higher pressure drop at larger flowrates, 
and will not provide any loss to the system at zero flow. Users should capture a single 
known pressure loss data point by defining a curve which passes through two points: the 
known pressure drop at the tested flowrate, and zero pressure drop at zero flow. The 
Resistance Curve topic gives more information on defining this type of curve.

Related Topics

Resistance Curve Loss Model 267
General Component 285
Heat Exchanger 285
Troubleshooting 799

Use the Output Window Sort Feature
If a model runs but the results look incorrect, use the Sort feature found in the Arrange menu or 
toolbar in the Output Window to look for extremes in velocity, pressure drop or other parameters. 
An input error (like incorrect diameter) may be easier to find by looking at its effect on the results.

Related Topics

Troubleshooting 799
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Tee/Wye Junction Complexity
Tee/wye junctions contain powerful and sophisticated models for determining the pressure 
losses at flow splits and converging flow streams. This power comes at the cost of additional 
model complexity, which can lead to convergence problems in models with numerous tees. Here 
are a couple of recommendations.

Tee/Wye junctions have two loss options: Simple and Detailed. The Simple loss model ignores 
losses at the tee. The Detailed model uses the correlation summarized in the Tee/Wye Loss 
topic. The potential convergence problems occur when using the Detailed loss model.

The potential problem is not with the Detailed tee model itself. Rather, it is due to multiple tees 
coupling together in such a way that AFT Fathom cannot converge on all of the flow splits. A com-
mon issue with detailed tees is having the pipes connected in the Properties window differently 
than how connections are set up in the workspace. Make sure to double check those con-
nections before running the models. 

You can quickly and easily check if a convergence problem is being caused by tees. Using the 
Global Junction Edit window, you can change all tees to the Simple loss model and rerun the 
model. If it now converges then the problem was likely due to the use of Detailed tee modeling.

Experience has shown that this problem can frequently be resolved by using absolute tolerance 
criteria on the Tolerance panel of Analysis Setup rather than relative tolerance. 

You also have the option of just using the Simple (lossless) tee model for all tees. In many sys-
tems the loss due to tees/wyes is negligible, especially for systems which see significant loss 
from other components that dominate the system.

Related Topics

Tee/Wye 346
Tee/Wye Loss Model 347
Troubleshooting 799

Related Blogs

Having model convergence problems? Start here!

Give me some details about Detailed Tees!

Lower the Flow Rate Relaxation
The Iterations panel in Analysis Setup allows you to change the numerical relaxation parameter 
for both flow rate and pressure. It is recommended that you use only 0.5 or 1.0 for pressure relax-
ation, but lower values of flow rate relaxation can be very helpful.

A good first step is to lower the flow rate relaxation to 0.05 or 0.1. By lowering the flow rate relax-
ation you improve AFT Fathom's ability to obtain convergence. The cost is slower run times. In 
some cases accepting the slower run times that come with flow rate relaxation is the only means 
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of obtaining convergence. You can lower the relaxation values as low as you want, but it is 
recommended it not be lowered below 0.01.

Related Topics

Troubleshooting 799

Try Absolute Tolerance
Most models converge more reliably with relative tolerances, which is the default on the Tol-
erance panel in Analysis Setup. However, some models converge much better with absolute tol-
erance. This most often applies to models which have very small values for flow or pressure, as it 
is much harder to meet a relative tolerance using small numbers. 

If a model will not converge with relative tolerance, you can try changing to absolute tolerance. 
Even better, try the option to converge on either absolute or relative, which will offer the most flex-
ibility.

Related Topics

Troubleshooting 799

Related Blogs

Having model convergence problems? Start here!

Make Initial Flow Rate Guesses for Pipes
If you do not provide any initial guesses, AFT Fathom will make its own guesses. Occasionally 
the AFT Fathom guesses are far away from reality. For some models providing a crude initial 
guess for all the pipe flow rates in the system can help the model converge.

The crude guesses can be as simple as selecting all the pipes and initializing all of them to 1 
lbm/sec, even though some operate at 0.1 lbm/sec and others at 10 lbm/sec. However, note that 
initial guesses that are too far from the final solution can also interfere further with convergence.

Related Topics

Optional Input for Junctions 258
Optional Input for Pipes 239
Transfer Results to Initial Guesses 802
Troubleshooting 799

- 807 -

https://www.aft.com/support/product-tips/common-convergence-tips-tricks


Troubleshooting

Review the Iteration History
The Iteration History window can be opened from the Solution Progress window. You can use 
this to see which pipes or junctions are farthest out of tolerance, which may direct your 
troubleshooting efforts towards these elements.

Related Topics

Solution Progress Window 387
Iterations Panel 163
Troubleshooting 799

Related Blogs

Getting that Stubborn AFT Fathom Model to Converge

Change Boundary Conditions
Changing the boundary pressures or flow rates can sometimes give you insight into what is giv-
ing the model trouble. For example, obtaining convergence only within a certain range of 
flowrates could indicate an issue with curve fit data being unrealistic outside of that range of 
flowrates.

Related Topics

Troubleshooting 799

Turn Off Parts of the Model
Using the Special Conditions feature, you can turn off elements in your model and in effect shut-
down entire sections. If the model runs when certain sections are closed, this could indicate a 
problem with one of the components in the closed section.
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Figure 1: The pipes in black are open to flow, while the pipes in yellow have been closed using spe-
cial conditions, meaning that Fathom will automatically set their flow solution to 0

Related Topics

Special Conditions 212
Optional Input for Junctions 258
Optional Input for Pipes 239
Troubleshooting 799

Related Blogs

Getting that Stubborn AFT Fathom Model to Converge
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Break a Large Model Into Submodels
AFT Fathom provides convenient features for deleting parts of your model and merging parts 
back in. A section of your model can be quickly deleted by selecting it on the Workspace and 
choosing Delete from the Edit menu. If the section is instead Cut, it can be Pasted into a new 
model of its own for testing or holding. At a later time the removed sections can be added back in 
to the current model by using the Merge feature on the File menu.

The advantage of breaking your model into sub-models is that you can investigate the con-
vergence characteristics of each part of your model independently. If you can get each sub-
model to converge, you should be able to get the original model to converge also. If one of your 
sub-models will not converge, it is doubtful your original model will converge either.

Related Topics

Troubleshooting 799

Identifying and Restoring Corrupted Model Files
The most common way to tell if a model file is "corrupted" is an error message that says "An error 
occurred reading the file into AFT Fathom. Can't find [TOOLBOX PREFERENCES] heading."

You may see multiple of these messages after pressing OK, and the part between the brackets [ 
] may say something else each time. This is indicating that the software is trying to read different 
sections of the file, and it is finding that there is either no data, or corrupted data. It is then show-
ing you an error for each section of the file that the software tries to read when loading the model, 
similar to Figure 1.

Figure 1: Error message indicating that some portion of the model file cannot be found

Another indicator is if the model's file size has been reduced to 0 or 1 KB. This indicates the data 
inside the file has been lost. This can be seen in the file size in the Windows File Explorer (Figure 
2).
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Figure 2: Very low file sizes can be an indication of model file corruption

What are the backup files (.bak extensions)?

AFT software will automatically generate backup versions of your model file each time you save. 
By default, these files will be located in the same directory where you have saved your model. 
These files have a specific naming convention, but generally the file extension will start with 
"*.bak" and end with three numbers. Newer versions of AFT software will have a fourth letter 
after the .bak, and it signifies which application the backup is for.

 l AFT Fathom.bakF-001
 l AFT Arrow.bakA-001
 l AFT Impulse.bakI-001
 l AFT xStream.bakX-001

The numbers signify previous versions of the model, with the 001 extension being the most 
recent backup. Of course, if your current model file is corrupted and you need to restore a 
backup, the 001 backup won't contain the most recent updates you made to the model, but it will 
be better than losing everything! The backups named 002 and 003 are the second and third most 
recent backups, respectively. Generally, you won't need to use these files unless you want to 
revert to even earlier state of the model file, or there is an issue with the 001 backup.

When you save a model file, the application will copy the previous version of the file into .bak001, 
the previous .bak001 will be copied into .bak002, and so on, creating a cascading effect. This 
way .bak001 is always the most up to date backup version of the model.

How to Restore a Backup File

 1. Close the AFT application if it is still open.
 2. In the same location as your model file, locate the file with the extension *.bak-001.
 3. Create a copy of *.bak-001. This is useful in case something goes wrong, and you need to 

try again.
 4. Rename the copied file and change the file extension to the appropriate application file 

extension below. Windows will prompt you to confirm the extension change; click Yes.
 l Fathom: *.fth
 l Arrow: *.aro
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 l Impulse: *.imp
 l xStream: *.xtr

 5. Try opening the restored file. If this didn't solve the problem, you can try the same steps 
with an earlier backup file, using .bak-002 or .bak-003 if they exist. However, note that 
doing so will revert even more changes because these are even earlier versions of the 
model from multiple saves prior.

Figure 3: The newest backup file, identifiable by file extension numbering and date modified

Figure 4: Changing file name extension to restore the backup file

Tips to Prevent File Corruption

The best way to prevent file corruption is to open, edit, and save the file locally on your PC. It is 
not recommended to edit and save files directly to a shared server, network drive, or cloud stor-
age platform like Dropbox or OneDrive.

If the connection to the network location is interrupted or cuts out while saving the model file, it 
could corrupt the file or cause data loss. This can be especially common on VPNs. If you need to 
have the file in a shared location for colleagues to access, it is recommended that you download 
the file to your local PC, edit/save the file locally on your machine, then upload the file after-
wards.

Customize Your User Settings Related to Backups

By default, only a maximum of three backups will be kept at a time. If desired, you can change 
this number in Number of Backup Files Created, which can be accessed in User Options as 
shown in Figure 5. Here, you can also choose to check the box that will automatically save your 
model in a specified time interval.
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Figure 5: The number of backup files created and options to save automatically can be customized 
in User Options

Related Topics

Troubleshooting 799
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Technical Support
This section focuses on the technical support options for AFT Products. Topics include descrip-
tions of the various support options, contact information for the AFT Support team, and links to 
external sites to assist with installation issues related to AFT Fathom.

Contents

Technical Support Options 815

Contacting AFT 816

Information on Software Installation 817

Chempak Database Installation 817

Output Files 819

Updated Fluids Library 820

Special File Control Features 821

Converting Models from Earlier Versions 822

Related Blogs

Having model convergence problems? Start here!

Technical Support Options

Support, Upgrade, and Maintenance (SUM)

This primary level of support is for assistance with specific features within the software, or resolv-
ing issues with a model such as difficult to converge models. AFT is limited in the ability to inter-
pret model results and cannot recommend specific changes in a system.

One full year of SUM is provided with the purchase of a full license. Leases have SUM coverage 
during the period of the lease. Further support after the first year requires SUM renewal.

For technical support questions falling in this category, contact AFT.
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Flow Expert Package (FEP)

The FEP is a higher level of consulting assistance for a particular project. This service will assign 
a qualified AFT engineer to assist in not only modeling your system, but also with providing oper-
ational suggestions and interpretation of results.

The intention of this service is to provide assistance to active users of AFT software and address 
questions on the appropriate use of the software for specific system requirements.

Please visit our website at: https://www.aft.com/products/aft-flow-expert-package for more 
information on our FEP services.

Flow Modeling Consulting Services

AFT's sister company, Purple Mountain Technology Group (PMTG), provides comprehensive 
consulting services utilizing experienced consulting engineers and AFT tools. PMTG offers a 
solution to a wide variety of system analysis by building and investigating the models and provid-
ing direction on system changes and appropriate operation. Visit PMTG on the web: 
https://www.pmtechgroup.com/, or call at (719) 687-9145 for more information.

Related Topics

Technical Support 815
Contacting AFT 816
Information on Software Installation 817
Chempak Database Installation 817
Special File Control Features 821
Converting Models from Earlier Versions 822

Contacting AFT
 l Telephone - (719) 686-1000
 l Fax - (719) 686-1001
 l Online - https://www.aft.com/ download the latest maintenance releases, find out what is 

happening at AFT, and get all the latest information.
 l E-mail Support - support@aft.com
 l Mail - 2955 Professional Place (Suite 301), Colorado Springs, CO 80904, USA

Related Topics

Technical Support 815
Technical Support Options 815
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Information on Software Installation 817
Chempak Database Installation 817
Special File Control Features 821
Converting Models from Earlier Versions 822

Information on Software Installation
For information on Local and Server installations of AFT software, please visit our website at 
https://www.aft.com/support/installation.

Related Topics

Technical Support 815
Technical Support Options 815
Contacting AFT 816
Chempak Database Installation 817
Special File Control Features 821
Converting Models from Earlier Versions 822

Chempak Database Installation
AFT Fathom does not include the Chempak Fluid Library by default. The Chempak Database is 
a separate product that must be downloaded and installed as an addition to AFT Fathom to 
access the Chempak Fluid Library in the software.

Chempak File Location

The Chempak Data is installed in C:\AFT Products\Chempak Data\ by default. If both AFT 
Fathom and the Chempak Database are installed to their default locations, no further con-
figuration is necessary. However, if AFT Fathom or the Chempak Database are not installed in a 
default location, AFT Fathom will need to know where to look for the Chempak Database. This is 
specified in the control.aft file, located in the same folder as Fathom.exe. If the files cannot be 
found the following message is displayed:
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Figure 1: AFT Fathom cannot find the Chempak Database

Control.aft can be edited with a text editor, and by default looks like:

Figure 2: Default control.aft file

If the Chempak Database was installed to a location other than the default, the line 
ChempakDataPath = will need to be edited to include the directory it was installed to. For 
example: ChempakDataPath = C:\My AFT Files\Chempak Data

Upgrading Chempak Database Version

When upgrading to a new version of AFT Fathom, you may receive a message that the database 
is outdated.
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Figure 3: Outdated Chempak database

To fix this issue, download the newest version of the Chempak Database from the AFT website. 
Be sure to install to the same location as the existing Chempak Database, and double check the 
control.aft file if necessary.

Related Topics

Technical Support 815
Technical Support Options 815
Contacting AFT 816
Information on Software Installation 817
Special File Control Features 821
Converting Models from Earlier Versions 822

Output Files
Numerical results and output from the Solver are saved in Output Files (*.out file extension). Out-
put Files are stored in the same location as the model file, and a unique file will exist for each 
scenario that is run, differentiated by numbers appended to the file name. The General section of 
the Output window will list which Output File is used for the current scenario.

The Output File will only remain on disk if the model file is saved after it has been run.

Changing various input data parameters for the model will invalidate the previous results, and a 
prompt will appear stating: "This action will clear all results and delete the output file for the cur-
rent scenario and any children. Do you want to continue the action?"

Renaming the model file in the Windows File Explorer will unlink the model file from any existing 
Output Files. Instead, open the model file and choose File > Save As which will rename and copy 
all Output Files. Alternatively, the Save Scenario to File options can be used from the Scenario 
Manager.

In the XTS Module, the file size will be heavily dictated by the simulation duration and time step 
specified on the Simulation Duration panel in Analysis Setup.
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Updated Fluids Library
If the data in a shared fluid library is changed outside of the model you are opening, the following 
informational message will appear when opening the file:

The following fluid(s) used in the scenario have different property data than what is currently in 
the library:

Figure 1: Update Fluids dialog window which appears if the fluid properties for the model have 
changed since it was last opened

There are a few reasons that the fluid data may have been changed:

 1. The model was defined in a previous version of Fathom using a fluid from the AFT Stand-
ard fluid library. The AFT Standard fluid library was updated in AFT Fathom 12 in order to 
standardize the reference data. If the model uses the same fluid properties for all scen-
arios, it is recommended to use the "Change to Base Scenario and update..." option to 
update the fluid properties throughout the model. If different scenarios use different fluid 
properties then it is recommended to use the "Update fluid(s) from library in the scenario" 
option to update each scenario individually.

 2. The model is defined with a custom fluid in the Fluid Library and the custom fluid was mod-
ified outside of this model. If the fluid was changed in error, then choose the "Keep using the 
fluids defined in the scenario" option or cancel loading the model and change the fluid. If the 
changes were intended then update the fluid data used in the model using the "Change to 
Base Scenario and update..." option.
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Special File Control Features

What is the Control.aft File?

Control.aft is read as AFT Fathom begins to load and instructs AFT Fathom where certain key 
files and copy protection tokens are located. Typically there is little need to change the settings, 
however this file can be used to override the internal defaults and customize your working envir-
onment.

Control.aft is typically located in the application folder. However, on networks, it may be neces-
sary to locate it in the Windows\System folder of each client. If AFT Fathom finds the file in the 
Windows\System folder it will use it and ignore any file in the application folder.

Control.aft can be edited using any text-based editor. Notepad, supplied as part of the Windows 
installation, is a good choice. Be careful to avoid changing any of the headings or key words. If 
these are changed AFT Fathom will not find the important data.

Specifying Where Chempak is Located

Before AFT Fathom can use the Chempak Fluid Database it needs to know where the data is loc-
ated. The path is specified in the control.aft file.

When Chempak is installed the setup procedure automatically updates any control.aft file spe-
cified with the path to the data.

You can manually edit the file by opening it in Notepad (or any text editor) and adding the fol-
lowing line to the [SEARCH PATHS] section (replace C:\AFT Products\Chempak Data with the 
path information based on your system):

ChempakDataPath = C:\AFT Products\Chempak Data

This will instruct AFT Fathom to look in the C:\AFT Products\Chempak Data directory for the 
data.

Also see Chempak Data Installation.

Related Topics

Technical Support 815
Technical Support Options 815
Contacting AFT 816
Information on Software Installation 817
Chempak Database Installation 817
Converting Models from Earlier Versions 822
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Converting Models from Earlier Versions
Models from earlier versions of AFT Fathom can be used with this version. In most cases, the 
model file can be opened in the newer version and automatically converted to the updated 
format. It is considered good practice to do a complete check on the model to ensure the con-
version process was complete and accurate. In some cases, especially with older models (two or 
more versions behind), the automatic conversion is not successful. If this occurs, please contact 
our support team with a copy of the original model file.

Other files such as libraries (previously called "databases") or preference files can also be con-
verted.

The Workspace Layers Import Assistant can be used for models created in versions prior to the 
existence of Workspace Layers. This tool allows views from Visual Report (which is now deprec-
ated) and customized Workspace appearance to be preserved.

Related Topics

Technical Support 815
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